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Introducción

CINELERRA-GG es un porgrama ENL, Editor No-Lineal, que provee una forma de
editar, grabar y reproducir archivos multimedia de audio o video. Además puede
ser utilizado para transcodificar multimedia de un formato a otro o para corregir
o retocar fotos. CINELERRA-GG actualmente corre en muchas distribuciones del
sistema operativos Linux.

Este manual cubre la versión CINELERRA-GG INFINITY. La información contenida
en este manual es una descripción del uso del programa CINELERRA-GG y fue
obtenida de varias fuentes para incluir diferentes canales de comunicación, correos
electrónicos, conocimiento común y escritos a medida que se añadían nuevas car-
acterísitcas. El autor original del programa CINELERRA, Adam williams, así como
muchas personas diferentes, han modificado el código fuente de CINELERRA a lo
largo de los años. William Morrow fusionó todos los cambios conocidos, siempre
que le fue posible, dentro de esta versión de CINELERRA-GG y por muchos años
han sido agregadas mumerosas características, actualizaciones y correcciones.

El software CINELERRA-GG está bajo la licencia GPLv2+. Un aviso de esto se incluye
en el software y se muestra aquí.

*
*CINELERRA
*Copyright (C) 1997-2012 Adam Williams <broadcast at earthling dot net>
*
*This program is free software; you can redistribute it and/or modify
*it under the terms of the GNU General Public License as published by
*the Free Software Foundation; either version 2 of the License, or
*(at your option) any later version.
*
*This program is distributed in the hope that it will be useful,
*but WITHOUT ANY WARRANTY; without even the implied warranty of
*MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
*GNU General Public License for more details.
*
*You should have received a copy of the GNU General Public License
*along with this program; if not, write to the Free Software
*Foundation, Inc., 59 Temple Place, Suite 330, Boston

i

https://www.gnu.org/licenses/old-licenses/gpl-2.0-standalone.html
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CINELERRA-GG Descripción general

Aquí se presenta brevemente una descripción general de CINELERRA-GG Infinity
y de la información provista en este manual. La versión GG de CINELERRA-GG
ha sido mejorada para estabilidad, modernizada para adaptarse a los estados ac-
tuales de los programas Linux, mejorada con características básicas adicionales y
enrquiecida con nuevas caracteristicas imaginadas por usuarios dedicados y de-
spués implementadas por programadores profesionales.

Sitio web https://www.cinelerra-gg.org
El sitio web del programa cinelerra-gg es un buen lugar para empezar buscando
información, ayuda y documentación. Está profesionalmente mantenido y constan-
temente actualizado con más traducciones de idiomas en curso.

Estabilidad
Los programas que simplemente funcionan son una prioridad #1 con el fin de ser
de utilidad para producir videos de calidad. Se ha invertido una gran cantidad de
tiempo en la depuración de problemas y resolución de fallos. Y en un proceso con-
tinuo para hacerlo, se ha incluído un capítulo "Resolución de problemas" con el fin
de proveer información suficientes para que el usuario capture información de los
problemas y fallos de manera que puedan ser analizados y solucionados rápida-
mente evitando la repetición de problemas.

Modernización
Se ha aplicado creatividad artística para modermizar los íconos de los complementos
de video y de audio de CINELERRA-GG, incluso para incluir los complementos de
ffmpeg. El conjunto de íconos de los complemntos Cinfinity vienen en versiones
cuadrados o redondeados, Ud. elige. En consonacia con la expectativa acutal de los
usuarios de tener un cierto aspecto y sensación, se agregaron recientemente 2 nuevos
temas, Cakewalk y Neophyte, proveyendo alternativas a los ya 9 temas existentes.
Estos 11 temas le dan al usuario la posibilidad de elegir el aspecto que mejor queda
a la vista de sus ojos.

Actual y actualizado
Para los programas de hoy, incuso las bibliotecas de terceros se mantienen actu-
alizadas de manera oportuna y el esfuerzo es realizado para utilizar siempre una
versión reciente de FFmpeg, si no es la última. Esto es un algo importante porque
hay un conjunto completo de programadores trabajando en estas bibliotecas, con-
tinua y diligentemente, para cubrir todos los formatos antiguos y los recientemente
creados. Así, programadores de CINELERRA-GG pueden estar dedicados a trabajar
únicamente en CINELERRA-GG en lugar de estar tratando de mantenerle el ritmo a
muchos formatos.

Uso integrado de FFmpeg
Mediante el uso de FFmpeg con CINELERRA-GG, está la ventaja de que los usuarios
puedern convertir videos directamente via el pre y el post porcesado, sin necesidad
de que líneas de comando tengan que ser utilizadas antes o después.

https://www.cinelerra-gg.org
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Formatos de importación y exportación
El siguiente listado son solo unos pocos de los formatos de importación y expor-
tacíon soportados:

• Varios formatos nativos estandar, como ser mpeg, ac3, flac, exr y secuencias
jpeg/png/ppm/tiff.

• Mas de 400 decodificadores y 100 codificadores de FFmpeg son accesibles
desde CINELERRA-GG para incluir: mp4, mkv, mpeg, mov, m2ts, mp3, dvd,
ogg, theora, prores, tiff, webm, flac, opus, vorbis, quicktime (div, dnxhd, jpeg,
mjpeg, mp4, rle, v308, v410), h264 & h265 usage, avc, hevc, y los reciente-
mente lanzados AV1 y WebP.

• Formatos de imágenes crudas son soportados para mas de 700 cámaras, cortesía
del DCraw de Dave Coffin.

Características estandar

• Ventanas del programa para pistas de video y aydio, navegación, navigation,
ventanas emergentes, funciones de reprocucción y búsqueda.

• Edición a través de la manipulación de pistas, ya sea con edición de arrastar
y soltar o edición de cortar y pegar.

• Patchera de herramientas: fader, gang, arm, habilitar salida, expansores, mez-
cladores y operaciones de mezcla.

• Capacidad de deshacer y rehacer para muchas funciones de edición.

• Funcionalidad de control de arrastre para Ripple, Roll, Slip, Slide, Edge y Sin
efecto.

• Soporte de fotogramas claves dinámicos con curva, conmutador de palanca,
automático, compositor y capacidades de edición.

• Soporte de edición proxy para acelerar la edición de archivos de gran formato
en ordenadores más lentos.

• Ventana del compositor con enmascarado, zoom, recorte y capacidades de
proyector y cámara.

• Ventana de Visor para una rápida vista/reporducción de audio, videos, clips o
proxys.

• Ventana de Recursos con archivos multimedia, proxy, clips y efectos/transi-
ciones de video y audio.

• Contenedores/carpetas definidas por el usuario para un proyecto.

• Efectos expandibles de video/audio para agrupar selecciones como correción
de color o complementos de movimiento.

• Mas de 400 complementos incluídos - audio y video nativos, FFmpeg, además
expandible para incluir otros.

• Soporte de complementos de audio LV2 y Ladspa.
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• Posicionar el mouse sobre los archivos de medios o carpetas proxy para obtener
5 segundos de previsualización en tiempo real.

• Renderizado simple o de múltiples archivos; renderizado en segundo plano,
renderizado por lotes, renderizado desde la línea de comandos y uso de gran-
jas de renderizado para aprovechar la ventaja de computadoras con múltiples
CPU.

• Numerosos formatos de salida predefinidos, disponibles automáticamente y
tolerancia de formatos definidos por el usuario.

• Capacidad de capturar y grabar para inlcuir grabaciones de emisiones de TV,
edicción y visualización.

• Cientos de accesos directos están definidos que se pueden ver fácilmente uti-
lizando el menú desplegable de comandos de shell.

• Las operaciones de "PorterDuff" están disponibles en la patchera de la ventana
principal de línea de tiempo para la mezcla alfa.

• Corrección de color + espacios de color de 8-bit y 10-bit.

• Soporte de video de hasta 8K.

• Funcionalidad ShuttlePro y ShuttleXpress functionality.

• Soporte de idiomas internacionales.

• Capacidad para multi-pantalla, multi-visores, multi-sesiones y multi-paneles.

• Barra de menú de comandos de shell con referencia hacia algunos agregados
manualmente o definidos por el usuario.

• Estabilizacíon de video, seguimiento de movimientos, gráficos en movimiento.

• Corte de espada/bordes duros, corte/edición rápida y arrastre rápido.

• Soporte para OpenGL así como aceleración Direct X11.

• Características avanzadas de recorte y agrupación.

• Selección de color para activos y títulos, incluyendo control deslizante para
Alfa..

• Preferencia de escalado para cualquier tamaño de monitor y HiDPI para so-
porte de monitores 4K.

Nuevas características innovadoras

• Modo inter-vista inventado a través de un esfuerzo de colaboración entre un
usuario y el desarrollador.

• Configuración de proxy para multimedia de gran formato con la codiciada
opción Scalar y cambio rápido de proxy.

• Múltiples cámaras/ Visor mezclador, limitado solo por los recursos de la com-
putadora del usuario (en un sistema grande, se sabe que 50 trabajan).

• Muy mejorada usabilidad para la creación, edición y copia de DVD/bluray no
comeriales.
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• Complemento de Título, virtualmente ilimitado, con muchos atributos cambi-
ables como tamaño, parpadeo, color.

• Movimiento de gráficos utilizando el complemento Sketcher para crear ele-
mentos como elipses, rectángulos y formas para gráficos de movimiento mas
sencillos.

• Abrir LDE para edición de clips, clips anidados y archivos XML mientras tabaja
en un proyecto.

Resumen de los capítulos

A continuación una reseña de cada capítulo, para ayudarlo a decidir a qué capítulo
prestarle mas atención para leer mas a fondo. Y qué capítulo es mas importante
para empezar a aprender a utilizar CINELERRA-GG. Al final de las descripciones
está una lista de secciones para leer por los iniciantes.

Capítulo 1 Instalación.

Si usted simplemente quiere empezar a utilizar el programa, puede saltearse
tranquilamente este capítulo y en su lugar ir a: https://www.cinelerra-
gg.org y simplemente descargar una versión linux precompilada para su
sistema operativo. Si a usted le gustaría realizar sus propias compilaciones
para siempre contar con la última, refiérase a este capítulo para aprender
cómo. Pero, si usted está familiarizado haciendo sus propias compilaciones,
usted puede referirse a este capítulo solo cuando se encuentre con algunos
inconvenientes.

Capítulo 2 Las 4+ Ventanas.

Es importante entender la configuración de las ventanas en CINELERRA-GG y
para qué son usadas cada una de ellas. Además, este capítulo cubre algunas
funciones básicas de navegación que usted necesita saber. De todos modos,
si anteriormente usted ha utilizado un ENL y no le importa experimentar
para aprender cómo ejecutar ciertas funciones, probablemente no necesite
examinar detenidamente este capítulo.

Capítulo 3 Atributos del proyecto y los multimedia.

Este capítulo es útil para la comprensión básica de la configuración de su
sesión, pero se puede omitir facilmente.

Capítulo 4 Cargar, guardar y la LDE.

Ya que esto es importante para no perder su trabajo, usted debería leer
este capítulo para algunos conceptos básicos del uso y algunas funciones
menos utilizadas que le pueden ser útiles. Además de cómo cargar y guardar

https://www.cinelerra-gg.org
https://www.cinelerra-gg.org
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archivos, también hay información sobre el uso formatos en crudo de las cá-
maras. Consejos útiles para trabajar con secuencias de imágenes, como ser
un montón de imágenes de tu cámara, todas cargadas de una vez, es un
ahorro de tiempo.

Capítulo 5 Editing.

Ahora y ocasionalmente los usuarios encontrarán necesario leer este capí-
tulo. De todos modos, usted puede decidir qué modo de edición prefiere y
concentrarse en la dectura de esa sección. Incluso los usuario experimen-
tados querrán leer este capítulo, con el fin de aprovechar ls características
que se han implementado recientemente o que pueden resultarles menos
familiares debido a su infrecuente uso. Cualquiera que quiera utilizar las
capacidades de edición que vienen con el uso de la Shuttle Jog Wheel, ini-
cialmente necesitará leer esta sección para familiarizarse con su uso.

Capítulo 6 Rendering.

Mínimamente la mayoría de los usuarios necesitarán leer la sección de ren-
derizado de archivo único para empezar; ya que, después de todo, el propósito
de usar un ENL es crear sus propios multimedia. El final de este capitulo
incluye algunos útiles escenarios específicos, lo cual puede resultarle bas-
tante útil. También es posible que desee considerar el uso de renderizado
por lotes y renderizado en segundo plano por razones de rendimiento. Y,
por supuesto, el uso de granjas de renderizado para aprovechar multiples
computadoras, puede ser un verdadero estímulo.

Capítulo 7 Keyframes.

Este es el tema mas avanzado, pero extremadamente útil de conocer. Los
fotogramas clave son valores que han sido asociados a la linea de tiempo y
que afecta la representación. Usted puede andar por años sin conocer todos
los matices, pero lo mas probable es que tarde o temprano usted los necesite
utilizar y entenderlos.

Capítulo 8 FFmpeg Interactions.

Sáltece este capitulo si ustede está recién comenzando. Sáltece este capí-
tulo si usted utiliza los formatos mas comunes que ya están configurados
para usted. Expertos podrán querer referirse a este capítulo a los efectos de
configurar sus propias opciones de archivos.

Capítulo 9 Plugins.

Utilice este capitulo como una referencia para agregar complementos de au-
dio o video a los efectos de corregir color o agregar algún efecto de lujo.
Usted no querrá leer acerca de cada uno de los complementos, la mayoría
de los cuales jamás usará. Por otro lado, repasar la sección "algunos detalles
específicos acerca de los complementos" podría resultar útil.
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Capítulo 10 Transition Plugins.

Todo aquel que no sepa sobre el uso de transiciones deberá leer este capítulo
porque querrán utilizar transiciones entre cortes en sus video para cambiar
suavemente las escenas. Es de lectura corta y facil.

Capítulo 11 Overlays Modos, mezcla alfa y Porter Duff.

Los expertos realmente pueden utilizar la información en este capítulo para
mejorar su trabajo de edición a través de algunas técnicas de tipos de mez-
clado. Un montón de información y posibilidades son descriptas aquí.

Capítulo 12 Capturing and Recording Media.

Este capítulo es útil para aprender cómo capturar y grabar desde varias
fuentes. Una sección de Usando CINELERRA-GG con emisiones de TV es es-
pecialmente útil.

Capítulo 13 DVD and Bluray Creation.

Si esto es lo que usted quiere hacer, entonces lea este capítulo. En el caso de
creación de DVD, incuye algunos ejemplos y un momtón de consejos para
verficiar sus métodos.

Capítulo 14 The 5 Multi-s.

Para utilizar múltiples cámaras en las creaciones de sus videos, este capítulo
es una lectura obligada. De lo contrario solo consulte la sección que se vuelve
pertimente a medida que se familiariza con el uso de CINELERRA-GG.

Capítulo 15 Shortcuts.

Todo el mundo querrá usar este capítulo para acelear sus sesiones de edición.
Una vez que usted se encuentra haciendo la misma cosa una y otra vez,
querrá saber si existe un atajo. Entonces mire aquí!

Capítulo 16 Configuration, Settings and Preferences.

Consulte este capítulo si usted quiere cambiar algun ajuste o preferencia.
Por otra parte, si es un usuario nuevo, usted debería asegurarse de leer la
primer página, la cual incluye información básica importante.

Capítulo 17 How some stuff works.

Solo lea este capítulo si usted está confundido acerca de algún tema cubierto
específico y sobre su funcionamiento.

Capítulo 18 Troubleshooting and Help.

Utilice este capítulo para el diagnóstico de problemas y para encontrar qué
reportar para obtener la mejor resolución o ayuda.
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Capítulo 19 Performance and other Tips.

Hay algunos consejos de rendimiento en este capítulo que le pueden resultar
útiles.

Capítilo 20 Translations.

Si usted quiere colaborar proveyendo traducciones a un idioma específico,
aquí está una completa descripción sobre cómo hacer esto y qué hacer.

Capítulo 21 Licenses.

Apéndice A QuickStart.

Aquí tiene! Si usted odia leer, solo vaya a la guía de inicio rápido o los videos
de creación en youtube y simplemente siga si camino.

Apéndice B Developer’s Section.

Alguna información extra que los desarrolladores pueden o no encontrar
útil.

Apéndice C Auxiliary Programs.

Este es un complemento para cualquier programa útil que deba incluirse,
principalmente para el análisis.

En resumen, las lecturas obligatorias para un usuario nuevo serían estos capítulos
o secciones:

• Capítulo 2 — Las 4+ Ventanas.

• Capítulo 4 — Cargar, guardar y la LDE.

• Capítulo 5 — Editing; lea todas las secciones excepto enfatizar solo Cut and
Paste Editing o Drag and Drop Editing para adaptarse a su propósito y de-
spués hojee el modo de edición que no es de su preferencia ya que algunas
operaciones funcionan en cualquier modo. Sáltece la sección ShuttlePROv2
and ShuttleXpress Jog Wheels for Editing a menos de que usted tenga una
de estar ruedas en su mano.

• Capítulo 6 — Rendering; mínimamente lea la sección Single File Rendering.

• Capítulo 9 — Plugins; lea la sección How to Use Plugins.

• Capítulo 10 — Transition Plugins.

• Capítulo 16 — Configuration, Settings and Preferences; lea al menos los
primeros párrafos.
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CHAPTER 1

Instalación

1.1 Cómo complilar CINELERRA-GG desde el reposi-
torio Git de los desarrolladores

Estas son instrucciones generales de compilación para CINELERRA-GG Infinity. Se
sabe que funciona en Ubuntu, Mint, OpenSuse, Fedora, Debian, Centos, Arch,
Slackware y Gentoo. Aún no ha sido probado en cada una de las posibles distribu-
ciones, por lo que quizás tenga que realizar algunos cambios menores. Además
funciona de forma algo limitada en FreeBSD y Windows 10, con el bsd.patch para
FreeBSD y el cygwin.patch para Windows 10.

Alternativamente, hay algunos binarios preconstruidos dinámica o estáticamente,
que se actualizan con bastante regularidad (siempre que se hayan realizados cam-
bios en el código ), disponibles en el siguiente enlace.

https://cinelerra-gg.org/download/

Hay 2 tipos de construcciones, por defecto para todosl los usuarios del sistema y
para un único usuario. Una construcción resulta en una instalación para el sistema.
La mayoría de los archivos está instalados en la ruta estandar del sistema, aunque
son posibles algunas personalizaciones. La construcción para usuario único per-
mite ejecutarlo completamente en un directorio locald el usuario, por lo tanto no
afecta al sistema.

Nosotros recomendamos la versión de único usuario cuando sea posible. Está
hecho muy fácil de instalar una nueva versión sin tener que borrar la anterior en
el caso de querer conservarla como copia de seguridad – hasta que esté feliz con la
nueva versión, pudiendo borrar completamente el directorio anterior. Otra razón
para utilizar la versión de usuario único es si usted instala una nueva versión del
sistea operativo y si usted tiene CINELERRA-GG en un espacio de disco separado
que es preservado, usted no tiene que resinstalar CINELERRA-GG. Es conveniente
iniciar la aplicación desde una ventana de terminal de línea de comandos, con el
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propósito de tener la habilidad de interrumpir o ver cualquier posible mensaje de
error, teniendo mayor control para capturar los problemas. Todo lo que decimos,
el sistema de construcciones puede ser útil en la configuración de un laboratorio de
una universidad donde hay posibilidad de múltiples usuarios o múltiples versiones.

Hay dos notables diferencias entre la visión estandar de CINELERRA-GG y esta im-
plementación para el sistema de contrucción. Ambos pueden ser configurados
durante la instalación. Las diferencias hacen posible tener instaladas algunas ver-
siones diferentes sin tener que pisar unas con otras.

1. el nombre de la aplicación puede configurarse durante la instalación y por
defecto es: cin

2. la configuración del directorio principal se puede establecer y por defecto
es: $HOME/.bcast5

1.1.1 La compilación de sistema

Para hacer una compilación a nivel sistema usted debería leer el archivo README
que está en el nivel superior del directorio tras descagar las fuentes.

• Usted necesita alrededor de 6.0 GB de espacio de almacenamiento en disco
para poder realizar la compilacion, además necesita tener instalado git.

• Obviamente, con el fin de instalarlo en el sistema, usted deberá ejecutarlo
como root.

• El paso git: tiene que descargar muchos archivos (approx 130 MB), así que
debe darle tiempo. Una vez descomprimido ocupará alrededor de 530 MB.

• Ejecute los siguientes comandos (esto lleva tiempo):

# Aqu es donde Usted necesita los 6.0GB de espacio en disco:
cd /<ruta_de_compilaci’on>/
git clone --depth 1 "git://git.cinelerra-gg.org/goodguy/cinelerra.git" cinelerra5
# Cambie al dirctorio clonado
cd cinelerra5/cinelerra-5.1

NOTA: Si usted nunca ha tenido installado CINELERRA-GG Infinity, usted de-
berá asegurarse de tener todos los compiladores y librerías necesarias. Así
que la primera vez deberá ejecutar:
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./blds/bld_prepare.sh <so> # donde <so> representa el
# Sistema Operativo de centos,
# fedora, suse, ubuntu, mint, debian.

./autogen.sh

./configure --prefix=/usr # parmetros opcionales pueden ser agregados aqu
make 2>&1 | tee log # hacer y regristar la compilacin

bld_prepare.sh no funciona para Arch Linux o Gento, por lo que deberíamos
instalar manualmente las dependencias. README.arch o README.gentoo,
los cuales contienen una lista de dependencias, pueden encontrarse en:

https://cinelerra-gg.org/download/README.arch

https://cinelerra-gg.org/download/README.gentoo

• Verificar por errors obvios de compilación:

grep "\*\*\*.*error" -ai log

Si esto reporta errores y usted necesita asistencia o cree que se pueden hacer
mejoras en las compilaciones, envíe un correo electrónico adjuntado el re-
porte de error listado a continuación a: cin@lists.cinelerra-gg.org

/<ruta_de_compilacin>/cinelerra5/cinelerra-5.1/log

• Si no hay errores de compilación, finalmente solo ejecute:

make install

• Si todo esto funciona, usted tiene todo configurado. Solo cliquee en el ícono de
escritorio de CINELERRA-GG.

1.1.2 Compilación para usuario único

Para hacer una compilación para usuario único, lea el archivo README que está en
el nivel superior del directorio donde descargó las fuentes.

1. Usted necesita al menos 6 GB de espacio de almacenamiento en disco para
realizar la compilación, además usted debe tener instalado “git”.
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2. Es recomendable que usted compile y ejecute como root, solo para evitar
inicialmente los problemas de permisos.

3. El paso git tiene que descargar muchos archivos (aprox. 130 MB), así que
debe darle tiempo.

4. Ejecute los siguientes comandos (esto toma tiempo):

# Aqu es donde usted necesita los 6.0GB de espacio en disco.
cd /<ruta_de_compilacin>/
git clone --depth 1 "git://git.cinelerra-gg.org/goodguy/cinelerra.git" cinelerra5
# directorio de nivel superior.
cd cinelerra5/cinelerra-5.1

NOTA: Si usted nunca ha tenido instalado CINELERRA-GG Infinity, usted deberá ase-
gurarse de tener todos los compiladores y librerías necesarias. Así que la primera
vez deberá ejecutar como root:

./blds/bld_prepare.sh <so> # donde <os> representa el Sistema Operativo de centos, fedora
,→ , suse, ubuntu, mint, debian.

./autogen.sh

./configure --with-single-user # el parmetro "with-single-user" lo hace as
make 2>&1 | tee log # hacer y regristar la compilacin (despus del proceso, verificar por

,→ errores)
make install

Entonces, solo iniciar la aplicación tipeando: ./cin en el subdirectorio “bin” o
agregue un ícono en el escritorio utilizando el directorio apropiado para copiar
los archivos, ejecute como root y edite para corregir la ruta del directorio. A
continuación hay un directorio genérico sobre cómo hacerlo.

cd /ruta_del_directorio_de_cinelerra
cp -a image/cin.{svg,xpm} /usr/share/pixmaps/.
cp -a image/cin.desktop /usr/share/applications/cin.desktop

Después de seguir los pasos anteriores, en el archivo cin.desktop, cambie la línea
Exec=cin para que quede Exec=<su_ruta_al_directorio>/bin/cin.

Las instrucciones anteriores para realizar una compilación para usuario único han
sido meticulosamente seguidas para compilar y correr en un recientemente instal-
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ado ubuntu 15 SIN SER ROOT, excepto para el bld_prepare.sh y la creación del
ícono de escritorio.

1.1.3 Opciones y advetencias importantes

Estos procedimientos y el software CINELERRA-GG Infinity se han ejecutado como
root en varios portátiles y computadoras de sobremesa. Esto provee la mejor opor-
tunidad de asegugarse de que todo trabaja correctamente y también permite mane-
jar los errores, otros problemas y potenciales fallos con el mayor éxito. Incluso,
en esta sección hay algunos variantes de compilación fácilemente disponibles para
compilaciones normales.

Para ver una completa lista de características, utilice:

./configure -help

La compilación por defecto es una compilación de sistema que utiliza:

./configure -without-single-user

En una compilación para usuario único, el directorio de destino es siempre cin.
Debido a que esta también es una compilación del desarrollador, se utilizan nom-
bres constantes en todo. Sin embargo, usted puede renombrar los archivos cuando
la instalación esté completa.

Si su sistema operativo tiene inconvenientes con la instalación por defecto en
/usr/local, puede que usted tenga que cambar la ubicación a /usr para una
compilación para el sistema. Además, usted tengrá que utilizar:

./configure --prefix=/usr

Si usted desea cambiar el directorio para una compilación para el sistema, usted
deberá agregar la ruta de destino del directorio en la línea make install. Por
ejemplo:

make install DESTDIR=<la ruta de su directorio de destino seleccionado>
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El mombre de la aplicacion se puede establecer durante la instalación, pero por
defecto es cin, así que el GG/Infinity puede coexistir con otras compilaciones de
CINELERRA-GG si es necesario. Para sobreescribir el mombre cin por defecto, util-
ice:

./configure --with-exec-name=cinelerra

El directorio de configuración inicial también se puede configurar, la ubicación por
defecto es $HOME/.bcast5. Por ejemplo:

./configure -with-config-dir=/minombredeusuario/.bcast5

NOTA: cuando usted especifica parámetros para configurar el programa, este creará
un archivo make en consecuencia. Ya que en un archivo make, el signo $ es un car-
acter especial, deberá ser escapado a los efectos de representar un $ como parte
de una entrada de parámetro, deberá ser tartamudeado. Esto es, usted necesita
$$ (2 signos dolar) para representar un solo signo dolar.

También puede ser necesario, en algunas distros en las que faltan librerías o están
incompletas, compilar CINELERRA-GG sin soporte para Ladspa. En ese caso, utilice:

./configure --prefix=/usr --without-ladspa-build

Note que with-ladspa-dir es la ruta de busqueda para ladspa y existen incluso si
la opción de compilar ladspa no está seleccionada. Esto le dá a usted la habiliad
de especificar una ruta alternativa de ladspa en el sistema, utilizando la variable
de entorno LADSPA_PATH (esto es, por defecto la compilación de ladspa no está
seleccionada). Note que para 32-bits de Slackware 14.2, Debian, Gentoo, Arch,
FreeBSD, antes de correr el “configure”, usted necesitará configurar lo siguiente:

export ac_cv_header_xmmintrin_h=no
export FFMPEG_EXTRA_CFG=" --disable-vdpau"

1.1.4 Notas sobre la compilación desde Git en su entorno per-
sonalizado

Conseguir que una compilación funcione en un entorno personalizado no es fácil.
Si Ud. ya tiene instaladas las librerías que normalmente están en las compila-
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ciones de terceros, conseguir que sean reconocidas significa que tiene que instalar
las versiones de desarrollo para que los archivos de cabecera que coinciden con
las interfaces de las librerías existan. A continuación se muestran una lista de
compilaciones de terceros, pero esta lista puede haber cambiado con el tiempo.

Table 1.1: Lista de compilaciones de terceros

a52dec yes
djbfft yes
ffmpeg yes
fftw auto
flac auto
giflib yes
ilmbase auto
lame auto
libavc1394 auto
libraw1394 auto
libiec61883 auto
libdv auto
libjpeg auto
opus auto
openjpeg auto
libogg auto
libsndfile auto
libtheora auto
libuuid yes
libvorbis auto
mjpegtools yes
openexr auto
tiff auto
twolame auto
x264 auto
x265 auto
libvpx auto
lv2 auto
sratom auto
serd auto
sord auto
lilv auto
suil auto
libaom auto
dav1d auto
libwebp auto
ffnvcodec auto

El yes indica una compilación forzada y auto indica que probará y usará la ver-
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sion del sistema si la operación de compliar no es estática. Para que funcione su
entorno de complilación personalizado, debe cambiar la opción de probar de las
las bibliotecas conflictivas de yes a auto, o incluso rehacer el archivo de comandos
configure.ac.

Un ejemplo de un problema que Ud. puede concontar con su instalación personal-
izada es con a52dec que tiene una línea de sondeo (CHECK_LIB/CHECK_HEADERS)
en configure.ac, pero djbfft no. En este caso, solo djbfft es compilada porque
a52dec está compilada, entonces, si su sistema tiene a52dec, establezca a52dec a
auto y fíjese si el probema se resuelve reintentado compilar con:

./confgure --with-single-user -enable-a52dec=auto .

Con persistencia Ud. puede obtener resultados, pero esto puede implicar varios
reintentos para estabilizar la complilación. Si Ud. necesita ayuda, envíe por correo
electrónico el log y el config.log, los cuales son usualmente suficientes para
determinar porqué la complilación falla.

Si Ud. ya tiene isntalado el paquete de desarrollo de libfdk_aac un su com-
putadora porque Ud. prefiere esta versión en lugar de la aac por defecto, Ud.
deberá hacer lo siguiente para una operativa alternativa. La librería libfdk_aac no
es parate de CINELERRA-GG por defecto debido a que no tiene una licencia libre.

export FFMPEG_EXTRA_CFG=" --enable-libfdk-aac --enable-nonfree"
export EXTRA_LIBS=" -lfdk-aac"
for f in ‘grep -lw aac cinelerra-5.1/ffmpeg/audio/*‘; do

sed -e ’s/\<aac\>/libfdk_aac/’ -i $f
done

1.1.5 Clonando el repositorio para una actualización rápida

Si Ud. quiere evitar tener que descargar el software cada vez que hay una actu-
alización, Ud. tiene que crear un "repositorio" local o repo. Repo es un directorio
donde hacer por primera vez git clone. Para el git clone inicial, reserve un es-
pacio local para el almacenamiento del repositorio, referido como <repo_path>.
git clone crea un repo nombrado cin5 en el directorio <repo_path>. Esto ac-
cede al rededor de 530 MB de datos del repo, entonces el dispositivo deberá tener
al menos eso disponible. La ruta de repo es siempre un perfecto clon del repo
principal.
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Configurando el clon inicial Quizás Ud. quiera agregar " --depht 1" antes de
cin5 porque clonará rápido y es pequeño, pero no tendrá historial.

cd /<repo\_path>/
git clone "git://git.cinelerra-gg.org/goodguy/cinelerra" cin5

Cloning into "cin5"...
remote: Counting objects: 20032, done.
remote: Compressing objects: 100% (11647/11647), done.
remote: Total 20032 (delta 11333), reused 16632 (delta 8189)
Receiving objects: 100% (20032/20032), 395.29 MiB | 3.26 MiB/s, done.
Resolving deltas: 100% (11333/11333), done.
Checking connectivity... done.

Actulilzar un repo existente Lo siguiente muestra cómo Ud. puede obtener las
actualizaciones.

cd /<repo home>/cin5
git pull

Comandos útiles de git Algunos otros comandos que son útiles.

git clone "git://git.cinelerra-gg.org/goodguy/cinelerra.git" cin5
git pull # trae los cambios remotos a la versin local
git status # mustra archivos modificados
git clean -i # limpieza interactiva, utilice la respuesta 1 para "limpiar"

1.1.6 Cómo compilar desde versiones GIT previas

cd /<path>/cin5_repo
git log
git checkout <version>

El comando git log genera un archivo de registro con los valores hash para las
claves commit de git. Los ID de los hash son los nombres confirmados para usar
cuando utilice git checkout. A continuación se muestra un ejemplo de la salida:
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delete stray line in last checkin

commit 4a90ef3ae46465c0634f81916b79e279e4bd9961
Author: Good Guy <good1.2guy@gmail.com>
Date: Thu Feb 22 14:56:45 2018 -0700

nested clips, big rework and cleanup, sams new icons, leaks and tweaks

commit f87479bd556ea7db4afdd02297fc00977412b873
Author: Good Guy <good1.2guy@gmail.com>
Date: Sat Feb 17 18:09:22 2018 -0700

Para git checkout <versión>, estonces teclearías la línea de abajo para los
siguientes resultados:

$ git checkout f87479bd556ea7db4afdd02297fc00977412b873

Note: checking out ’f87479bd556ea7db4afdd02297fc00977412b873’.

You are in ’detached HEAD’ state. You can look around, make experimental
changes and commit them, and you can discard any commits you make in this
state without impacting any branches by performing another checkout.

If you want to create a new branch to retain commits you create, you may
do so (now or later) by using -b with the checkout command again. Example:

git checkout -b <new-branch-name>

HEAD is now at f87479bd... more file size icon updates, and more to followend

Mas tarde, para que el repo vuelva a estar al día, se usará:

git checkout master

1.1.7 Compilación para usuario único depurable

Para compilar de las fuentes con todos los símbolos de depuración, primero com-
plile una versión estática completa (non_debug) como a continuación, pero en
lugar de utilizar /tmp, sustituya hacia una ruta permanente, si es que lo quiere
conservar.
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git clone ...
cp -a /path/cinelerra-5.1 /tmp/.
cd /tmp/cinelerra-5.1
./bld.sh

Después, para ejecutarlo como un desarrollador, en el depurador:

CFLAGS="-O2 -ggdb" make -j8 rebuild_all
cd cinelerra
gdb ./ci

1.1.8 Construcciones desagregadas

Hay algunos script básicos de complilación en el repositorio GIT de CINELERRA-
GG para usuarios que quieren hacer construcciones desagregadas con ffmpeg ya
disponibles en su sistema. Esto ha sido probado en Arch, Ubuntu 19, FreeBSD,
Wondows10 y Leap 15 (rpm) al momento en que esto fue documentado. Los mom-
bres de los script de contrucción son: arch.bld , bsd.bld , deb.bld , rpm.bld y
cygwin.bld. Esos script están en el subdirectorio blds. bsd.bld puede ser uti-
lizado con archivo bsd.patch en este mismo directorio. cygwin.bld puede ser
utilizado con el archivo cygwin.patch en este mismo directorio.

La razón de que Cin Infinity utililiza tradicionalmente complilaciones de terceros
(construcciones agrupadas) es porque hay un montón de distros diferentes con
niveles variables de ffmpeg y otras librerías de terceros necesarias. Sin embargo,
algunos usuarios prefieren utilizar las actuales en su sistema base, sin otra/difer-
ente copia de ffmpeg. Con otros difrentes niveles de liberías del usuario, pueden
surgir incertidumbres, potencial inestabilidad y problemas desconocidos cuando
ejcuta CINELERRA-GG y esto hará que, a todos los efectos prácticos, sea imposible
diagnosticar y depurar problemas o bloqueos. Puede no haya ayuda en estos ca-
sos. Se le recomienda que reporte cualquier error portencialmente originado en
Cin Infinity, pero si los datos indican el origen en una libreria alternativa, por favor
reporte los problemas a los mantenedores apropiados.

Con las construcciones desagregadas, algunas de las características pueden no es-
tar disponibles y no se ha hecho ningún intento de comentalas. Entonces, si uti-
liza un menú desplegable o elege una opción de renderizado o elige algo que no
está disponible, simplemente no funcionará. Por ejmplo, a no ser que Ud. haya
configurado opciones espciales, el complemento de audio LV2 no está disponible.
Tampoco lo hará el codec libzmpeg, el codec ac3 o el de creación de DVD.
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Toda la clase de archvivos de la vieja escuela funcionarán, pero algunos de los
formatos que vienen con ffmpeg pueden no hacerlo por la manera en que ffmpeg
está instalado en su sistema. Esto es porque el ffmpeg incluido en CINELERRA-GG es
una versión estática conocida y usualmente la última versión estable lanzada. Por
ejemplo, en el caso de Leap 15, libx264 y libx265 no están compiladas y esto puede
ser debilitante; Ud. siempre puede ejecutar ffmpeg-formats y ffmpeg-codecs
para ver si está disponible en su sistema.

1.2 Descargar CINELERRA-GG ya compilado

Figure 1.1: Captura de pantalla del sitio web, página Descargas para instalación en varios
S.O.

Si ud prefiere no tomarse el tiempo para compilar CINELERRA-GG Infinity por
Ud mismo, hay pre-compilaciones dinámicas y estáticas para varias versiones de
Ubuntu, Mint, Suse, Fedora, Debian, Centos, Arch y Slackware linux así como Gen-
too y FreeBSD. Una versión de instalación para Windows 10 está descripta en 1.3.
También están disponibles versiones 32-bits para Ubuntu, Debian y Slackware. Es-
tos se actulizan con bastante regularidad, siempre que se hayan realizados cambios
significativos en el código. Están en los subdirectorios de:

https://cinelerra-gg.org/download/tars

https://cinelerra-gg.org/download/pkgs

El directorio tars contiene compilaciones estáticas modo usuario único para distin-
tas distros. Este es el modo recomendado de utilización de CINELERRA-GG porque
todos los archivos estarán en un solo dirctorio. Generalmente, todas las librerias
necesarias están compiladas dentro de la compilación estática, pero en algunos
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Ud deberá instalar otras librerías necesarias. Para instalar la compilación para
usuario único, descargue el correspondiente tarball desde el subdirectorio ./tars
y descomprima como se indica debajo:

cd /path
mkdir cin
cd cin
tar -xJf /src/path/cinelerra-5.1-*.txz # sustituya el *por el nombre

#del tarball para su distro

NO descargue la verión LEAP 10-bit si no utiliza h265 (esta no puede renderizar
h265 8-bit).

El directorio pkgs contiene la aplicación estandar empaquetada para varias dis-
tros. Esto instalará una version dinámica para usuarios que prefieren tener los
binarios en el área del sistema para un sistema multiusuario. Además, al realizar
la instalación, comprueba la suma md5sum en el archivo md5sum.txt para ase-
gurar que el canal transmite correctament el paquete. Hay un README.pkgs en
el directorio download con instrucciones, entonces usted puede copiar y pegar y
evitar errores tipográficos; también se muestra a continuación.

Listing 1.1: README.pkgs

#Dependiendo de la distro, utilice las instruccions de debajo y seleccione
#la configuracin apropiada para instalar, actualizar o remover cinelerr-gg infinity #(24-11-2019)

,→ Para actualizar, refresque el repositorio, despus reemplace "install"
#con "update", o lo que sea.

#Envie los problemas via email a cin@lists.cinelerra-gg.org Si es un problema de
#repositorio, Usted usualmente puede realizar una instalacin usando:

#UBUNTU, MINT, DEBIAN
wget https://cinelerra-gg.org/download/pkgs/{substitute_name}/cin_5.1.<sub\_name>.deb
#e instlelo manualmente: dpkg -i cin_5.1.{substitute_filename}.deb

#ARCH
wget https://cinelerra-gg.org/download/pkgs/{substitute_name}/cin_5.1.<sub_name>.pkg.

,→ tar.xz
# e instlelo manualmente: pacman -U cin_5.1.{substitute_filename}.pkg.tar.xz

#FEDORA
wget https://cinelerra-gg.org/download/pkgs/{substitute_name}/cin_5.1.<sub_name>.rpm

# e instlelo manualmente: dnf install cin_5.1.{substitute_filename}.rpm

#LEAP, SUSE
wget https://cinelerra-gg.org/download/pkgs/{substitute_name}/cin_5.1.<sub_name>.rpm

# e instlelo manualmente: zypper install cin_5.1.{substitute_filename}.rpm
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#CENTOS
wget https://cinelerra-gg.org/download/pkgs/{substitute_name}/cin_5.1.<sub_name>.rpm

#e instlelo manualmente: yum localinstall cin_5.1.{substitute_filename}.rpm

# GENTOO -Hay tarball estticos y dinmicos para el
#lanzamiento 2.6

https://cinelerra-gg.org/download/tars/cinelerra-5.1-gentoo-20200202.x86_64-static.txz
https://cinelerra-gg.org/download/tars/cinelerra-5.1-gentoo-20200202.x86_64.txz

# descargue una de las de arriba y despus refirase al README.txt

# FREEBSD -hay un tarball basado en la versin 12.1 de FreeBSD en
https://cinelerra-gg.org/download/testing/bsdcin.tar.xz

# descargue la de arriba y despus refirase al README.txt

# FEDORA
# Reemplace el XX en fedoraXX en la siguiente lnea
#con su actual nmero de versin de S.O.
dnf install cinelerra --nogpgcheck --repofrompath cingg,https://cinelerra-gg.org/download/pkgs

,→ /fedoraXX/
#dnf erase cinelerra

# CENTOS
# Python 2 fue actualizado a Python 3 por otras distros, entonces,
#Ud, deber crear un enlace simblicio para tener la versin correcta.
#Para obtener ayuda, env un mail a cin@lists.cinelerra-gg.org
# primero cre el archivo /etc/yum.repos.d/cin_gg, con el siguiente contenido:
[cin_gg]
name=cingg
baseurl=https://cinelerra-gg.org/download/pkgs/centos7
gpgcheck=0
# end of cin_gg
yum install cinelerra
#yum erase cinelerra

# UBUNTU, reemplace ub14 con el ID de su distro: ub16,ub18
#
# Algunas descargas en ubuntu registran constantemente un estado de trabajo al 0% mientras
# se desgaga el paquete, como ubuntu 14. Toma unos pocos minutos para este paso, sea

,→ paciente.
apt install software-properties-common apt-transport-https
apt-add-repository https://cinelerra-gg.org/download/pkgs/ub14
# Nota para UBUNTU 16/18 -Se sabe que esto funciona, pero las cosas cambian rpido:
# VIP -para la primera instalacin, la lnea de arriba agrega \CGG{} a /etc/apt/sources.list pero...
# Las versiones 16/18 de Ubuntu son mas estrictas en cuanto a la licencia, as que deber editar
# el archivo /etc/apt/sources.list para agregar [trusted=yes] despus de deb y antes de https...cin

,→ ...
# Por ejemplo, la lnea deber ser: deb [trusted=yes] https://cinelerra-gg.org/download/pkgs/

,→ ub16 xenial main
# O para ub18: deb [trusted=yes] https://cinelerra-gg.org/download/pkgs/ub18 bionic main
# Nota para UBUNTU 16/18 -This has been known to work, but things change quickly:
# Adems, durante la instalacin podr\’a tener un mensaje de erro que puede ignorar ya que \CGG

,→ {}
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1.2. Descargar CINELERRA-GG ya compilado

# se va a ejecutar de todos modos, o de lo contrario (solo la primera vez) tipee en la lnea de
,→ comando:

# echo > /etc/sysctl.d/50-cin.conf "kernel.shmmax=0x7fffffff"
apt update
apt install cin
#para actualizar instalaciones previas (ignore cualquier error referido a i386, solo estn

,→ disponibles versiones 64 bit):
apt update
apt upgrade cin
##apt remove cin

# Para MINT puede utilizar el mismo procedimento que Ubuntu, pero apt-add-repository parace
,→ no funcionar,

# as que utilice el GUI UpdateManager como a continuacin:
# Administracin->Origen del software->Repositorios Adicionales->Agregar un nuevo repositorio
# (Nota: algunas version de la GUI de Mint puede estar como Sistema en lugar de Administracin

,→ )
# Para Mint18, agregue: deb [trusted=yes] https://cinelerra-gg.org/download/pkgs/mint18

,→ xenial main
# Para Mint19, agregue: deb [trusted=yes] https://cinelerra-gg.org/download/pkgs/mint19

,→ bionic main
# NOTA IMPORTANTE: si obtiene un error "malformed input", usted deber crear un archivo
# tipeando el comando: sudo touch /etc/apt/sources.list.d/additional-repositories.list
# despus espere mas o menso 10 minutos e intente utilizar GUI Update Manager otra vez.
apt update
apt install cin
# para actualizar instalaciones previas
apt update
apt upgrade cin
##apt remove cin

# Para DEBIAN utilice los mismos procedimentos bsicos como Ubuntu.
# El apt-add-repository vara entre sistemas, as que deber\’a utilizar su mejor juicio.
apt-add-repository https://cinelerra-gg.org/download/pkgs/debian8
O apt-add-repository https://cinelerra-gg.org/download/pkgs/debian9
O apt-add-repository https://cinelerra-gg.org/download/pkgs/debian10
# VIP -para la primera instalacin, la lnea de arriba agrega cinelerra /etc/apt/sources.list pero...
# Debian stretch/jessie/buster son mas estrictos con la licencia, entonces tendr que editar
# el archivo file /etc/apt/sources.list para agregar [trusted=yes] despus de deb y antes de https

,→ ...cin...
# Por ejemplo, para debian8: deb [trusted=yes] https://cinelerra-gg.org/download/pkgs/

,→ debian8 jessie main
# Por ejemplo, para deb [trusted=yes] https://cinelerra-gg.org/download/pkgs/debian9 stretch

,→ main
# Por ejemplo, para debian10: deb [trusted=yes] https://cinelerra-gg.org/download/pkgs/

,→ debian10 buster main
apt update
apt install cin
#para actualizar una instalacin previa
apt update
apt upgrade cin
##apt remove cin
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1.2. Descargar CINELERRA-GG ya compilado

# SUSE/LEAP/TUMBLEWEED
# (Nota: deber instalar versiones de libavc y libiec via zypper, si es que no estn instaladas)
# Los paquetes de cinelerra no estn firmado, as que tendr\’a que ignorar "el paquete no est\’a

,→ firmado"
# openSUSE LEAP 15
zypper ar -f https://cinelerra-gg.org/download/pkgs/leap15/ cingg
zypper install -r cingg cinelerra # o cinelerra10bit para 10 bit
# openSUSE LEAP 42
zypper ar -f https://cinelerra-gg.org/download/pkgs/leap42/ cingg
# como en SUSE 42.3 hay un nuvo requierimiento, entonces necesitar agregar
zypper mr -G cingg
zypper install -r cingg cinelerra # or cinelerra10bit for 10 bit
# openSUSE TUMBLEWEED
zypper ar -f https://cinelerra-gg.org/download/pkgs/tweed/ cingg
# como en SUSE 42.3 hay un nuvo requierimiento, entonces necesitar agregar
zypper mr -G cingg
zypper install -r cingg cinelerra
##zypper remove cinelerra # o cinelerra10bit para 10 bit
# para actualizar una versin previamente instalada (suponiendo que tiene habilitado el

,→ autorefresh, como arriba)
zypper refresh cingg
zypper up cinelerra # o cinelerra10bit para 10 bit

# SLACKWARE, sustituya slk32 por slk64 y i486-1 por x86_64-1
wget -P /tmp https://cinelerra-gg.org/download/pkgs/slk64/cin-{date}-slk64-x86_64.txz
installpkg /tmp/cin... # nombre que utiliz en el la lna superior
#para actualizar una instalacin previa
upgradepkg /tmp/cin... # nombre que utiliz en el la lna superior
##removepkg cin

# ARCH linux
# (Una lista vagamente definida de los paquetes que debe instalar primrero, se encuentran en

,→ este archivo:
# https://www.cinelerra-gg.org/download/pkgs/README.arch )
# primero edite el archivo /etc/pacman.conf, para inclur lo siguiente:
[cingg]
SigLevel = Optional TrustAll
Server = https://cinelerra-gg.org/download/pkgs/arch
# end of cingg
#
# A continuacin ejecute desde una ventana, los dos comandos siguientes;
pacman -Syu
pacman -S cin

# NOTA: la primera lnea de arriba acutaliza su sistema Arch hacia el lanzamiento acutal y la
,→ segundo

# lnea actuliza \CGG{} basado en el lanzamiento actual que estaba en vigencia el ltimo d\’ia del
,→ mes.

# Por favor, complete en orden los dos pasos de arriba, uno justo despus del otro para evitar
,→ riesgos

# de actualizaciones parciales.
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# Debido a lo imprevisibilidad de cuando las libreras de Arch son actualizadas, realizando una
,→ instalacin de

# \CGG{} en cualquier momento distinto a los siguientes del ltimo das del mes, cuando nuevos
,→ paquetes

# complipados son creados, podra llevar a la incompatibilidad de libreras. En este caso, por
,→ favor,

# en su lugar considere utilizar el archivo tar esttico para Arch.
# Para remover una intalacin previa
##pacman -R cin

1.3 Windows 10 con Cygwin para CINELERRA-GG Lim-
itado

Para ejecutar CINELERRA-GG en una computadora con Windows 10, usted necesi-
taría tener instalado Cygwin en su sistema, junto con el tar estático de CINELERRA-
GG y una librería parchada: libxbc. Esta configuración ha sido probada con la
versión 1909 de Windows 10 en una HP EliteBook 820 a 2.3 GHz.

Esta versión limintada provée funcionalidad central en este momento con el eje-
cutable estandar de FFmpg para Windows, lo que significa que las modificaciones
específicas de FFmpeg para CINELERRA-GG no están disponibles. Las capacidades
limitadas incluyen solo unos pocos formatos de renderizaciones disponibles, por
ejemplo mov, qt como mjpeg y mpeg para videos y avi y qt como s16le para audio,
pero no mkv o mp4. Esto se debe al hecho de que actualmnte varias librerias no
están compiladas para trabajar con windows.

Instalación de Cygwin

Cygwin es un entorno que corre en Windows nativamente, el cual permite que
programas Unix sean compilados y se corran en Windows. Con cygwin instalado
en su computadora con Windows 10, Ud. estará habilitado a correr CINELERRA-
GG. Antes de instalar cygwin, Ud necesita estar alertado de que el software an-
tivirus Avast mata archivos necesarios para la instalación y ejecución de cynwin,
por lo que Ud. deberá removerlo e instalar un antivirus alterantivo (el estandar
por defecto incluído con Windows 10 es Defender). Debajo están los pasos para
la instalación:

1. Descargue cygwin para su computadora d 64-bits en: https://www.cygwin.
com/

2. Generalmente, solo elija los valores predeterminados que van saliendo, pero
los siguientes pasos mustra lo que aparce.

3. Cuando aparezca una ventana de advertencia, clic en Si.

17

https://www.cygwin.com/
https://www.cygwin.com/


1.3. Windows 10 con Cygwin para CINELERRA-GG Limitado

4. Clic en Siguiente.

5. Elija la opción Instalar desde Internet y después clic en Siguiente.

6. Elija el directorio que desee haciendo clic en el botón Examinar. Elija Todos
los usuarios (Recomendado) y después clic en Siguiente.

7. Elija el dirctorio local del paquete donde le gustaría que estéen sus archivos
de instalación. Clic en Siguiente.

8. Elija Conexión Directa si Ud. está utilizando Internet con un dispositivo Plug-
Play. Clic en Siguiente.

9. Elija cualquier sitio descarga, preferentemente "cygwin.mirror.constant.com"
y haga clic en Siguiente.

10. Para obtener una lista de cosas por instalar, deje todo configurado como por
defecto excepto estos para Instalar en su lugar:
base devel
gnome graphics
system video
X11

Esta instalación lleva mucho tiempo, aproximadamente 2 horas en una Elite-
Book y requiere aproximadamente 20GB de almacenamiento.

11. Finalmente, Ud debería tener los íconos en su escritorio (ya por defecto) y
después clic en Finalizar.

Para instalar los archvivos tar de CINELERRA-GG, Ud necesita iniciar una terminal
d consola de cygwin desde el menú de inicio, como se muestra aquí: Inicio →
Cygwin → Cygwin64 Terminal

Instalando CINELERRA-GG

1. Descargar el archivo tar libxcb-bld.tar.bz2.

2. Instalar libxbc desde el archivo tar – instalar en /usr/local y requiere aprox-
imadamente 21MB de espacio de almacenamiento.

tar -C /usr/local -xJf /path/libxcb-bld.tar.bz2

La ruta de libxcb repara un error (XIOError), que para a Cinelerra.

3. Descargar el archivo tar cygcin-bld.tar.bz2.

4. Instalar cygcin desde el archivo tar - esto instala dentro el directorio home.
Note que es cygcin NO cygwin. Ud. deberá cambiar la ruta debajo por el
nombre de la ruta donde descargó el archivo tar.
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cd
tar -xJf /path/cygcin-bld.tar.bz2

Esto crea ˜/cygcin , una instalación de compilación de usuario de CINELERRA-GG
y requiere aproximadamente 400MB de espacio de almacenamiento.

Ejecutando CINELERRA-GG: Ud necesitará iniciar un escritorio de cygwin desde
el menú de inicio:

1. Inicio→ Cygwin-X → Openbox
Ud podrá iniciar una consola de contro de terminal por lo que podrá ver los
registros del programa.

2. Inicio→ Cygwin → Cygwin64 Terminal
Esto abre una ventana separada que puede sobrevivir a una caida y errores
de cygwin. Sin esos registros, es mucho mas dificil de utilizar.

3. Tipée lo siguiente dentro de esta ventana de control de consola:

export DISPLAY=:0.0

4. Cambie hacia el directorio donde está instalado CINELERRA-GG:

cd /path/cygcin (NO cygwin)

5. Finalmente tipée:

./cin

lo cual inicia sus 4 ventanas de CINELERRA-GG.

La diferencia mas notoria con las versiones para Linux, es que este CINELERRA-GG
parece correr muy lentamente en Windows 10. Ud deberá ser muy tolerante y
paciente para verlo trabajar. Sin embargo puede exibir una velicidad asombrosa
al codificar. CINELERRA-GG tiene que ser degradado significativamente debido a
la falta de interfaces, codecs (por ejemplo h264/h265)y utilidades. El único con-
trolador gráfico es X11 y el único controlador de sonido es pulseaudio. Casi todas
las omisiones configurables se aplican a esta contrucción.
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Compilación de CINELERRA-GG en cygwin desde el código fuente:

1. Descargar e instalar ffmpeg dentro de /usr/local :
descargar ffmpeg (actualmente 4.2.2)

cd /tmp
tar -xJf /path/ffmpeg-4.2.2.tar.bz2
cd ffmpeg-4.2.2
./configure
make -j
make install

2. Descargar e instalar una libxcb parcheada:

cd /tmp
rm -rf libxcb-1.13/
tar -xf /path/libxcb-1.13.tar.bz2
cd libxcb-1.13/
patch -p1 < /path/cinelerra-5.1/thirdparty/src/libxcb.patch1

patching file configure.ac
patching file src/xcb_in.c

./autogen.sh

./configure
make -j
make install

3. Descargar cinelerra-gg:

$ cd /build_path/
$ git clone "git://git.cinelerra-gg.org/goodguy/cinelerra.git"
$ cd cinelerra-gg/cinelerra-5.1

4. Aplicar el parche cygwin:

$ patch -p2 < blds/cygwin.patch

5. Ejecutar la construcción con:

$ ./blds/cygwin.bld
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Esto genera un directorio: /build_path/cinelerra-gg/cineler ra-5.1/bin
el cual ese utilizado para crear el archivo de cygcin.

Actualmente, los objetivos no se eliminan y se pueden ejecutar desde gdb. El
soporte para archivos dmp para el manjo de señales es muy limitado. Ejcutando
gdb desde dentro de una consola de escritorio (no una ventana de cygwin64)
puede cerrar cygwin (y cin) cuando llega a un punto de ruptura. Ud. deberá
ejecutar desde una ventana de consola externa para evitar este problema.

1.4 Sistema de distribución con CINELERRA-GG incluído

También hay algunos sistemas de distribución especiales completos disponibles
que incluyen CINELERRA-GG para capacidades de producción audio y video.

AV Linux es una imagen ISO compartida, descargable/instalable basada en De-
bian. Provee un método fácil al usuario para obtener una estación de trabajo de
producción de audio y video sin la molestia de tener que tipear para encontrar e
instalar todos los componentes habituales. Por supuesto, incluye CINELERRA-GG!
Está en: Click aquí para ir a la página de inicio de AV Linux.

Bodhi Linux Media es una distribución de código libre y abierto que viene con
una lista revisada de software libre para artistas digitales que trabajan con audio,
video, incluído CINELERRA-GG, juegos, gráficos, animaciones, computación física,
etc. Está en:

Clic aquí para ir a la página de inicio de Bodhi Linux.

1.5 Cinx y un “poco” de confusión

Cinx es el mismo programa que Cin. La X (x) representa el número romano 10
para 10-bits opuesta a la estandar 8-bit. Las librerías de terceros usadas para
x265 deberán ser especialmente compiladas con –bit-depth=10 a los efectos de
producir renderizados de 10-bit. Esta versión no podrá producir una profundidad
de color de 8-bit, lo que significa que Ud deberá mantener también esta versión
de Cin.

Cualquier compilación a la que esté vinculado ffmpeg determinará a qué profun-
didad de bits puede generar. Este es el porqué de tener que hacer compilaciones
separadas. Si Ud. instala ambos paquetse, Cin y CinX, Ud puede obtener conflictos
de archvivos con el mismo nombre — solo continue.

Tenga en cuenta que la versión regular de 8-bit, trabaja en bytes de 8-bit — el
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1.5. Cinx y un “poco” de confusión

estandar para para el tamaño de los caracteres en computadoras, pero la versión
de 10-bit tiene que utilizar dos caracteres para contener todos los 10 bits, por lo
que puede esperar que el renderizado sea mucho mas del doble de lento. También
hay una versión de 12-bit para considerar, pero actualmente los resultados son lo
mismo que 10-bit con el agregado para hacere 12-bits, por lo que no tiene valor.

22



CHAPTER 2

Las 4+ Ventanas

2.1 Ventana del programa

La ventana principal, llamada la ventana del Programa y frecuentemente es referida
como la línea de tiempo. Aquí es donde Usted ingresa las operaciones del menú
principal. Esta línea de tiempo consiste en un apilado vertical de pistas con el
tiempo representado horizontalmente en la pista. Es la salida de las operaciones
de renderizado y es lo que se guarda cuando ejecuta el comando Guardar desde el
menú desplegable Archivo. Inmediatamente a la izquierda de la línea de tiempo
está la pachera. La pachera contiene opciones que afectan a cada pista. Estas
opciones están descriptas en gran detalle en la sección Edición. (5.1).
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2.1. Ventana del programa

La menú despleble Windows en la ventana principal contiene opciones que afectan
a las 4 ventanas princiaples. Las 3 primeras opciones son utilizadas mostrar cada
una de las ventanas en el caso de que una sea cerrada accidentalmente. Usted
puede mover o redimensionar las ventanas como sea necesario, guardar un diseño
particular y revertir a las posiciones predeterminadas para devolver a las 4 ven-
tanas a la configuración original de la pantalla. En patanllas de doble cabeza, las
operaciones de posiciones predeterminadas utilizan un único monitor para mostar
las ventanas, pero como Usted puede ver en el menú desplegable Ventana, Usted
tiene mas opciones para cambiar esto. El uso con monitures duales está explicada
en 14.3.

2.1.1 Pistas de video y audio, y navegación

La ventana de Programa (figura 2.2) tiene muchas características para navegación
y exibición de la línea de tiempo tal como está estructura en la memoria. Las
pistas son apiladas verticalmente con movimiento horizontal sobre el tiempo. Hay
una barra vertical de desplazamiento la cual permite el movimiento a través de las
pistas y una barra de desplazamiento horizontal para escanear a través del tiempo.

Figure 2.2: Patchera | Línea de tiempo con desplegables, íconos de navegación, pistas de
Video/Audio | Panel de zoom inferior

La pista de video representa la duración de su multimedia, como si colocara viejos
rollos de película fotográfica uno tras otro sobre una mesa. Las imágenes individ-
uales que son representadas en cada pista son capuras de lo que está localizado
en este lugar en la línea de tiempo.

Las pistas de audio representan sonido de los multimedia como una forma de onda
de audio, o si Usted cambia una configuración de preferencia, una onda de audio
rectificada. Esto también parece una cinta magnética digital anticuada dispuesta
horizontalmente sobre una mesa. Utilizando los controles del Panel de Zoom, al pie
de la línea de tiempo, Usted puede ajustar cómo se muestra el tamaño horizontal
y vertical del video o de la forma de onda del audio. Cada pista en la línea de
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tiempo tiene un grupo de atributos en su lado izquierdo en la patchera, la cual es
utilizada para el control de algunas opcines de la pista en particular.

La navegación de pista se realiza seleccionando una pista de video o de audio y
desplazándose hacia cierto tiempo en la pista. Utilice la barra de desplazamiento
vertical para explorar las pistas, o mas fácilmente, puede utilizar la rueda del ratón.
Y utilice la barra de desplazamiento horizontal para explorar sobre el tiempo, o de
nuevo, puede utilizar la rueda del ratón con la tecla Ctrl.

Una vez que se familiariza con muchas de las herramientas gráficas y desplegables,
puede cambiar a utilizar mas el teclado para navegar. Muchas de las telcas equiv-
alentes se muestran a la derecha del la opción en cada uno de los desplegables
como un atajo de teclado. Todos los atajos de telcados están listados en un docu-
mento para la navegación por teclado (15.1). Esto incluye, por ejemplo, las techas
Inicio y Fin para ir al principio o al final de la línea de tiempo. Otro ejemplo es
en el modo por defecto de cortar y pegar, presiona Mayúsculas y a la vez Inicio
o Fin para seleccionar la región de la línea de tiempo entre el punto de inserción
y el de la tecla presionada.

2.1.2 Panel de Zoom

Debajo de las pistas mostradas en la lína de tiempo, puede encontrar el panel de
zoom, como puede ver en la figura 2.2. En adición a las barras de desplazamiento,
esas opciones y sus valores son otro grupo de herramientas para posicionar la línea
de tiempo. En órden de aparición en el panel de zoom, como cajas rectangulares
y ya sea el fijador con flecha o flechas arriba/abajo, la siguiente lista muestra cada
opción junto con su descripción de la erramienta, si está disponible.. Luego, mas
detalles son provistos en el siguiente párrrafo.

Zoom de la muestra Duración visible en la línea de tiempo
Amplitud Escala de la forma de onda de audio
Zoom de la pista Altura de las pistas en la línea de tiempo
(tipo) Tipo de automatización
Curva del zoom Rango máximo y mínimo de la automatización
Cambio de selección 3 recuadros, con punto de inicio, longitud y punto de finalización
Deslizador Alfa Barra deslizante para controlar el valor alfa de los recursos coloreados

Cambiando el Zoom de la muestra cambia la cantidad de tiempo mostrada en la
línea de tiempo así que puedes ver sus multimedias como cuadros individuales o
como la totalidad de la longitud del multimedia. Para ver mas cuadros, utilice un
valor mas alto. El zoom de la muestra no es una referencia absoluta del tiempo
porque se refiere a la duración visible en la línea de tiempo. Esto cambiará cuando
modifique horizontalmente la longitud de la ventana. Puede utilizar las flechas ↑
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y ↓ para cambiar el zoom de la muestra por una potencia de dos, o utilice la rueda
del ratón sobre el fijador para ampliar y reducir el zoom.

La siguiente opción es amplitud y solo afecta al tamaño de la forma de onda del
audio. Ctrl-↑ y Ctrl-↓ son los atajos de teclado usados para modificar el zoom de
amplitud como una alternativa a la flecha abajo a la derecha del tamaño numérico.

El zoom de la pista afecta a todas las pistas y determina el alto de cada pista. Si
usted cambia el zoom de la pista, el zoom de aplitud también cambiará propor-
cionalmente en las formas de onda del audio. Atajos, Ctrl-AvPág y Ctrl-RePág,
cambian el zoom de la pista.

Tipo de automatización es utilizado para seleccionar uno de los siguientes: Desvanec-
imiento de audio, desvanecimiento de video, velocidad, X o Y (X e Y son para la
cámara y proyector del compositor). Cuando una línea automática está presente
en la línea de tiempo y está siendo manipulada, un pequeño cuadrado del mismo
color que la línea será mostrada a la izquierda del Tipo de Automatización. Este
es solo un indicador para facilitar ver qué es lo que se está trabajando.

El zoom de curva afecta las curvas para el Tipo de automatización seleccionado en
todas las pista de este tipo y determina el valor del rango de estas curvas. Utilice
las flechas del marcador a la izquierda de los números para el valor mínimo y
el marcador a la derecha para el valor máximo o ingrese manualmente el rango
de esos curvas en el cuadro. Buenos valores por defecto para desvanecimiento
de audio son -40.0 a 6.0 y para desmanecimiento de video, de 0.0 a 100.0. Los
fijadores flecha cambian la amplitud de curva, pero la única forma de compensar
la curva es utilizar el botón de ajustar las curvas en la propia curva.

La selección de tiempo de inicio,longitud de selección y selección final de tiempo mues-
tran los valores actuales seleccionados en la línea de tiempo. Cuando no hay se-
lección, ambos, tiempo de inicio y final son la posición actual en la línea de tiempo
y la longitud de selección es 0. La flecha deslizador alfa para variar el valor alfa
cuando está activado colores para las pistas en sus Preferencias → Apariencia
para Color automático de recursos. No tiene efecto sin esta función activada.

Hay 3 piezas adicionales de información en la línea Inmediatamente debajo de
panel de zoom En la esquina inferior izquierda donde puede haber mensajes como
"Bienvenido a CINELERRA-GG" cuando no es necesario mostrar un mensaje de er-
ror coloreado en rojo o una línea en la que se lee "Renderizado demoró H:MM:SS"
justo después de que se haya completado el renderizado. O cuando se trabaja con
un automático, un pequeño cuadrado de color de la línea del automático estará
presente con su tipo de fotograma clave, ubicación en la línea de tiempo y su valor
actual. Esto es simplemente para un fácil reconocimiento sobre qué es está tra-
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bajando. La segunda pieza de información útil hacia la derecha que es un largo
cuadro rectangular que indica el porcentaje de renderización finalizado. Final-
mente, hay una X con el mensaje de información "Cancelar operación", utilizado
para parar la renderización en curso (la operación de cancelación pueder pare-
cer lenta debido a la cantidad de datos que quedan en el búfer al momento de la
cancelación).

2.1.3 Menú emergente de pistas

Cada pista tiene un menú emergente. Para activar el menú emergente de la pista,
Botón Derecho del Ratón (BDR) sobre la pista. El menú emergente afecta a la
pista, tanto si está amarrada a la patchera como si no. El menú de pista contiene
un número de opciones:

Adjuntar efecto abre un cuadro de diálogo con los efectos aplicables al tipo de
pista de video o de audio.

Mover arriba mueve la pista seleccionada un escalón mas arriba en la pila corre-
spondiente a su tipo - audio o video.

Mover abajo mueve la pista seleccionada un escalón mas abajo en la pila corre-
spondiente a su tipo - audio o video.

Eliminar pista elimina la pista de la línea de tiempo.

Añadir pista agrega una pista del mismo tipo que la seleccioanda, auido o video,
por encima de la pista seleccionada.

Encontrar en Recursos ese archivo multimedia será resaldado en la carpeta de
medios en la ventana Recursos. Si la ventana Recursos está cerrada, el mul-
timedia es encontarado y se resalta, pero la ventana Recursos no se muestra.

Mostrar edición señalará los puntos exactos de inicio y parada junto con la lon-
gitud de la edición acutal en esa pista, así como el nombre del multimedia,
nombre y número de pista y el número de edición.

Título personalizado es utilizado para cambiar el nombre del título. Esto es real-
mente útil para archivos con nombres largos y similares que se cortarían en la
edición. Usted puede utilizar nombres cortos para diferenciar mejor el medio
de comunicación. En le modo de edición Arrastrar y Soltar, si selecciona
múltiples ediciones, todos esos clip tendrán su nombre de título cambiado.

Color de barra permite al usuario seleccionar un color espcífico para la barra de
título. Esto ayuda a localizar mas fácilmnte una pieza de los medios de co-
municación.

Cambiar el tamaño de la pista redimenciona la pista; esto es aplicable solamente
a las pistas de video.

Ajustar al tamaño de salida redimenciona la pista para ajustarla al tamaño de
salida actual; esto es aplicable solamente a las pistas de video.
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2.1.4 Punto de inserción

El punto de inserción (figura 2.3) es la rayita vertical que atraviesa toda la línea
de tiempo en la ventana de programa - puede ser una linea sólida pero el mayor
tiempo estará parpadeando. Como el cursor en un procesador de textos, el punto
de inserción marca el lugar en la línea de tiempo donde la próxima operación
empezará. Es el punto de inicio de todas las operaciones de reproducción y es el
pundo donde una operación de pegado ocurrirá. En algunos casos, cuando se ren-
deriza, define el comienzo de la región de la línea de tiempo que se representará.

Para mover el punto de inserción, nueva el ratón sobre el área de la barra de tiempo
y cliquee con el botón izquierdo del ratón. Usted puede utilizar cualquier lugar
en la barra de tiempo para reposicionar el punto de inserción siempre que ese
punto no esté bloquado por punto de entrada/salida o una etiqueta. En el modo
de edición de cortar y pegar, usted también puede cambiar la posición del punto
de inserción con un simple clic con el botón izquierdo del ratón en la propia línea
de tiempo. Cuando nueve el punto de inserción, está alineada a los fotogramas
o alineada a las muestras. Para mejores resultados, Alinear cursor a los fotogra-
mas cuando edita pistas de video y Alinear a la muestra cuando edita audios.
Utilice el menú desplegable Ajustes→Alinear el cursor a los fotogramas
para cambiar la alineación habilitando la opción para video o deshabilitada para
audio.

Desplegables
Barra Transporte y Botones

Barra de tiempo
Título del medio

Pista de Video

Pista de Audio

Figure 2.3: El punto de inserción está en 0:00:25:10 en Hr:Mn:Sec:Fotogramas

2.1.5 Modos de edición

Hay 2 difirentes modos de edición para operaciones que afectan la manera en que
opera el punto de inserción y edición en la línea de tiempo. Es: modo arrastrar y
soltar y modo cortar y pegar. El modo modo de edición está determinado por la
selección de la flecha, o Inmediatamente a la derecha de la flecha, la Viga-I en
la barra de Transporte y Botones. En la figura 2.3 Usted puede ver a la flecha re-
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saltada en color verde, indicando que Usted está actualmente en el modo arrastrar
y soltar.

Con la flecha resaltada en modo arrastrar y soltar, un doble clic con el botón
izquierdo del ratón en la línea de tiempo, selecciona la edición sobre la que está
el puntero del ratón. Luego, arrastrando en la línea de tiempo reposiciones que
edita y esto puede ser utilizado para efectos de moviminto, cambiar el orden de
las pistas de reproducción o mover las piezas de video alrededor. Hay numerosos
métodos para cortar y pegar en el modo arrastar y soltar, estableciendo puntos de
Entrada/Salida para definir una región seleccionada o usando el Comportamiento
de Copiar y Pegar como se describe en 5.5.1. En este modo, cliqueando con el BIR
(N.delT.:Botón Izq. del Ratón) en la línea de tiempo no resposiciona el Punto de
Inseción.

Cuando está resaltada la Viga-I, usted está en el modo cortar y pegar. En el modo
cortar y pegar, cliqueando con el BIR en la línea de tiempo, reposiciona el Punto
de inserción. Doble clic en la línea de tiempo selecciona la edición sobre la que
se encuentra el cursor, es decir, esa columna. Arrastando en la línea de tiempo,
con el BIR presionado, selecciona una región y esta es la región que es afectada
por las operaciones de cortado y pegado. También es el rango de reproducción
utilizado para la operación de reproducción subsiguiente. Presionando la tecla de
mayúsculas mientras se cliquea en la línea de tiempo, extiende la región resaltada.

Figure 2.4: Viga-I + Entrada/Salida + etiquetas

2.1.6 Puntos de Entrada/Salida

Los puntos de Entrada/Salida, mostrados en la línea de tiempo por corchetes, [ y
], pueden ajustarse en cualquiera de los modos de edición para definir la selección.
En la línea de tiempo se mostrará una barra colorada entre estos 2 corchetes para
delinear mejor el área seleccionada. En el modo arrastrar y soltar, son la manera
fácil para definir una región seleccionada.

Es importante recordar que en el modo cortar y pegar y el modo arrastar y soltar,
un área resaltada sobreescribe los puntos de Entrada/Salida. Esto es, si un área
resaltada y los puntos de Entrada/Salida, ambos están establecidos, el área re-
saltada remplazada por las operaciones de edición y los puntos de Entrada/Salida
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son ignorados. Pero, si no hay área resaltada, los puntos de Entrada/Salida son
utilizados. Para evitar confusiones, utilice las áreas resaltadas o los puntos de
Entrada/Salida, pero no ambos al mismo tiempo.

Para establecer los puntos de Entrada/Salida, en la barra de tiempo muévase a
la posición donde quiere el punto de Entrada y cliquee en el ícono de Entrada o
una de las teclas [ o <. Usted puede utilizar estos mismos íconos o caracteres del
teclado para intercambiar los de Entrada/Salida en encendido o apagado.

Si usted ubica el punto de inserción en otro lugar mientras los puntos de En-
trada/Salida ya están establecidos, ese punto existente se reposicionará cuando
cliquee en los íconos de Entrada/Salida o sus teclas equivalentes. Si usted cliquea
en los puntos de Entrada/Salida mientras una región está seleccionda, el punto de
inserción será ignorado y los puntos de Entrada/Salida serán establecidos al inicio
y al final del área resaltada.

Cuando Usted selecciona el punto de Entrada o bien el de Salida en la barra de
tiempo, el punto de inserción se moverá hacia esa ubicación. Note que cuando el
punto de inserción está en la exacta posición de un punto de Entrada o Salida, el
corchete cambiará de color haciendo facil ver que está en ese punto.

Si solo está establecido el punto de Entrada, cuando cliquee el ícono de punto
de Entrada, el punto de Entrada será borrado. Si solo está establecido el punto
de Salida, cuando cliquee el ícono de punto de Salida, el punto de Salida será
borrado. Presionando la tecla de mayúsculas mientras se cliquea en los puntos de
Entrada/Salida, el área entre el punto de inserción y ese punto de Entrada/Salida
será resaltado o se extenderá a ese punto de Entrada/Salida si ya está resaltado.

Una forma fácil de apagar los puntos de Entrada/Salida, si ambos están fijados es
hacer doble clic en el ícono [. Si ya tiene fijados el punto de Entrada y el de Salida
y después mueve el punto de inserción a cualquier lugar a la izquierda del punto
de Salida, un clic con el BIR en el ícono [moverá el punto de Entrada a la posición
del punto de inserción. De la misma manera, si mueve el punto de inserción a
cualquier punto a la derecha del punto de Entrada, un clic con el BIR en el ícono
] moverá el pundo de Salida a la nueva posición. Sin embargo, si usted mueve los
puntos de inserción de Entrada o de Salida mas allá de lo que tiene sentido para
designar puntos de Entrada/Salida, el cochete que usted cliqueó será movido al
punto de inserción y el otro será eliminado. Esto obviamente es porque el punto
de Entrada debe estar primero que el punto de Salida en la línea de tiempo.

Algunas de las operaciones útiles concernientes a puntos de Entrada/salida son
listados a continuación.
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Ctrl-PadNumérico# Si está fijada Entrada/Salida, PN 2,3,5,6 + Enter, repro-
duce entre los puntos de Entrada/Salida

Mayús-Ctrl reproduce en bucle entre los puntos de Entrada/Salida

Clic Entrada/Salida mientras presiona el BIR, arrastra el puntero Entrada/Salida
hacia donde quiera arratrarlo

Mayús-Ctrl con un botón de transporte (Ej. Avance rápido) reproduce en bucle
entre los puntos de Entrada/Salida

Ctrl-t limpia ambos puntos de Entrada/Salida

2.1.7 Etiquetas

Las etiquetas son utilizadas para establecer ubicaciones exactas en la línea de
tiempo a las que quiere llegar fácilmente. Para crear una etiqueta, posicione el
punto de inserción en la ubicación y clickee en el ícono Etiqueta en la barra Trans-
porte y Botones. La nueva estiqueta es mostrada en la línea de tiempo como una
flecha hacia abajo en la ubicación, como se muestra en la figura 2.4. Siempre que
el punto de inserción está en la misma posición que la etiqueta, esta cambia de
color para enfatizar que está exactamente en ese punto. Las etiquetas lo hacen
para que Usted pueda saltar hacia atrás y adelante a los lugares exactos marcados
en la línea de tiempo. Utilice la letra minúscula “L” como un atajo para el botón
de la etiqueta.

Usted puede utilizar etiquetas para reposicionar el punto de inserción cuando una
etiqueta está seleccionada. Son especialmente útiles para moverse a lo largo de la
línea de tiempo hacia la Siguiente Etiqueta o la Etiqueta anterior con los botones en
la barra de Transporte y Botones, a la derecha del botón de Etiquetas. Cuando se
mueve a través de la línea de tiempo con los botones de Etiqueta Siguiente o An-
terior, si una etiqueta está fuera de la vista en la línea de tiempo, se reposicionará
automáticamente para que la etiqueta sea visible. Si Usted realiza una operación
de Siguiente Etiqueta y no hay más, el punto de inserción irá a la posición final.
Por el contrario, si usted realiza una operación de Etiqueta Anterior y no hay más
etiquetas, el punto de inserción irá a la posición inicial. Los atajos de teclado para
el recorrido de etiquetas son:

Ctrl-Izq mueve el punto de inserción hacia la etiqueta anterior.

Ctrl-Der mueve el punto de inserción hacia la etiqueta siguiente

Hay una carpeta de Etiquetas en la ventana Recursos que tiene una lista de cada
etiqueta y la ubicación exacta de dónde está la etiqueta. La ubicación está basada
en la marca de tiempo, número de fotograma o número de muestra, dependiendo
del Formato de Tiempo de su barra de tiempo. Usted puede editar, borrar o ir
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hacia una etiqueta cliqueando con el BDR en esa etiqueta en la ventana Recursos
lo cual traerá un menú emergente con estas opciones. Puede ser muy útil editar
la etiqueta y agregar una cadena de carateres que ayuden a identificar qué rep-
resentan las etiquetas. Adicionalmente, cliqueando con el BDR el símbolo de la
etiqueta en la barra de tiempo, despliega un cuadro de texto mostrando la cadena
de texto actual y permitiéndole cambiarla. Si a una Etiqueta se le ha dado nombre,
simplemente posicionando el ratón sobre el símbolo de la etiqueta en la barra de
tiempo, mostrará ese cadena.

Con etiquetas usted puede además seleccionar regiones:

Mayús-Ctrl-Izq resalta el área entre el punto de inserción y la etiqueta anterior.

Mayús-Ctrl-Der resalta el área entre el punto de inserción y la etiqueta posterior.

Double-clic en la barra de tiempo entre dos etiquetas, resalta el área entre las
etiquetas.

Mayús-clic en una etiqueta, resalta el área entre esa etiqueta y el punto de in-
serción. Si un área ya está resaltada, extenderá el área resaltada hasta esa
etiqueta.

Si Usted cliquea con el BIR cuando un área está resaltada, se crean etiquetas en
cada extremo del área resaltada. Cuando una etiqueta está creada, si Usted cliquea
en el ícono de Etiqueta, la etiqueta será borrada. Para borrar múltiples etique-
tas, resalte esa área, después utilice la función Editar → Limpiar → Limpiar
etiquetas para borrarlas a todas. La misma regla de procedimiento aplica a esta
operación mencionada previamente. Esto es, si ambos puntos Entrada/Salida es-
tán establecidos y hay un área resaltada tambíen fijada, se borrarán las etiquetas
de área resaltada y no las que están entre los puntos de Entrada/Salida.

Si Usted habilita Editar etiquetas en el menú desplegable Ajustes o deshabilita el
botón Bloquear Etiquetas para que no se muevan en la barra Transporte y Botones,
las etiquetas serán cortadas, copiadas o pegada junto con el área seleccionada de
la primer pista armada. En el mismo sentido, si una área seleccianda de un multi-
media se empalma desde el visor a la línea de tiempo en una posición anterior a las
etiquetas, las etiquetas serán movidas hacia la derecha en la línea de tiempo para
que las etiquetas mantiengan su posición relativa a su edición. Para prevenir que
las etiquetas se muevan en la línea de tiempo, habilite el ícono Bloquear etiquetas
y evitar su movimiento o deshabilite la opción Editar etiquetas bajo el desplegable
Ajustes.
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2.1.8 Colores de Barras de títulos y recursos

Con el fin de ayudar visualmente a localizar clips en la línea de tiempo que son del
mismo archivo multimedia, Usted los puede tener auto-coloreados. La utilización
de esta característica requiere memoria adicional y una cpu en cada redibujado de
la línea de tiempo, por lo tanto se recomienda que las computadoras mas pequeñas
lo mantengan apagado.

Para auto-color, el color debe estar en un nombre de archivo hash para que cada vez
que cargue este multimedio en particular, siempre tenga el mismo color en la barra
de título, incluso si hay proxy. Para auto-color, ir a Ajustes→ Preferencias,
pestaña Apariencia y habilite Color automático de recursos. Está desha-
bilitado por defecto. Cada multimedia tendrá un color apagado al azar y podría
haber duplicados cercanos como los generados por el algoritmo del programa.
Podría no ser totalmente negro, pero algunas sombras oscuras son posibles.

Para cambiar un clip a su propio color seleeccionado, clic con el botón derecho
del ratón (BDR) sobre ese clip y un menú emergente será desplegado. Elija la
opción Color de barra... para sacar a relucir el selector de colores y elija un color.
Usted además puede cambiar el valor alfa en el selector de colores y este alfa
tiene prioridad sobre el valor actual de la barra de desplazamiento, a menos que
el valor alfa del selector de colores se establezca en 1.0. El color solo cambiará
después de hacer clic en la marca de verificación. La opción de Color de Barra
funciona en cualquiera de lo modos de edición, Arrastrar y soltar o Copiar y pegar
y además funciona si autocolor de recursos no está establecido. En el modo de
edición Arrastrar y soltar, si Usted selecciona algunos clips y desepliga la ventana
emergente de Ediciones con el botón derecho del ratón sobre una pista, Usted
puede utilizar la opción de Color de barra para cambiarlos a todos hacia el mismo
color.

Para regresar a los colores por defecto, deseleccione Autocolor de recursos en Pref-
erencias, pero esto no afectará a los colores especialmente elegidos, ya que estos se
conservan. Para cambiar esto individual o selectivamente, utilice la opción Color
de barra del menú emergente y cliquee en Por defecto en la ventana del selector de
color. Autocolor no respeta las pistas habilitadas/deshabilitadas para edición.

¡Y esto no es todo! Hay una barra deslizante de desvanecimiento de alfa abajo, en
ventana principal, a mano derecha del panel de Zoom. Con este deslizante de
alfa, Usted puede colorizar sus pistas de video y audio, ya sea para ver solo el
color a 0.0 o ver solo la imagen a 1.0. Esta barra deslizable afecta a todas las áreas
coloreadas como el autocolor de los recursos o los colores automáticos como tales.
En el caso de que un valor alfa de edición específicamente modificado se establezca
en el selector de colores en cualquier valor excepto 1, la barra de desplazaminto
no lo afectará. Una vez que Usted utiliza la barra de desplazamiento, esta se activa
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para que se dispare por primera vez en cualquier pulsación de tecla en la ventana
principal. Usted desactiva esto simplemente haciendo clic en una parte diferente
en la ventana princial.

Mientras estamos en el tema del color, solo una nota, que Usted también puede
cambiar el color del resaldado inverso en Ajustes→ Preferencias, pestaña
Apariencia Usted puede ver esta opción en la Figura 16.1 en la Sección Color.
Este ajuste, por defecto, lo establece a blanco ( f f f f f f ) pero algunas veces esto
es un poco brillante, por lo que Usted puede poner el valor hexadecimal que mas
le convenga.

Esta imagen (figura 2.5 a) muestra un ejemplo de auto-color en recursos con valor
alfa en 0.0, por lo que Usted solo puede ver el color y no la imagen. En esta imagen
(figura 2.5 b), el alfa está puesto para que se vea la imagen y las formas de onda
con colores translúcidos. El multimedia rosado ha sido auto-coloreado en lugar
del auto-color general para que sea fácil de ver.

a) b)

Figure 2.5: Un ejemplo de auto-color de Recursos

2.1.9 Más acerca de Menúes desplgables

Los menúes desplegables de la ventana principal, como se indica en la figura 2.3
son bastente obvios en su significado y uso, por lo que aquí hay solo un resumen.

Archivo opciones para cargar, guardar y renderizar como se describenen otras
secciones (4).

Editar funciones de edición; muchas de las cuales tienen atajos de teclado y Usted
los puede aprender rápidamente (5).

Fotograma clave opciones de fotograma clave las cuales están descriptas en la
sección Fotogramas clave (7).

Audio funciones de audio como ser Agregar pista, Adjuntar Transición/Efecto.

Video funciones de video como ser Agregar pista, Transición por defecto/Agregar,
Rendezar efecto.
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Pistas mover o eliminar pista es lo mas frecuentemente utilizado.

Ajustes gran parte de esto se desrcribe en otra parte y con las mas frecuentemente
utilizadas incluyen Preferencias (16), Formato (3), Ajustes Proxy y Transcod-
ificar (19.3), así como las otras opciones.

Ver para mostrar o modificar los parámetros de los recursos e incluir valores de
despanecimiento, velocidad y cámaras.

Ventana funciones de manipulación de ventanas.

2.1.10 Disposición de las ventanas

Si a Usted le gusta utilizar disposiciones de las ventanas diferentes a las por defecto
para algunos escenarios, Usted puede establecer, guardar y cargar 4 variantes.
Primero, posicione su ventana de CINELERRA-GG donde quiera que esté y después
utilice el menú desplegable Ventana y elija Guardar diseño. Note las palabras re-
saltadas Guardar diseño en la figura 2.6a con 4 nombres mostrados a la derecha
y hacia abajo de lo resaltado. Para utilizar el nombre ofrecido por defecto para
el Diseño, cuando aparece la ventana emergente, solo haga clic en el botón verde
OK del menú emergente "Diseño". Si a Usted le gustaría un nombre específico
para su diseño para que pueda recordar cual es su mejor caso de uso, ingrese de
1 a 8 caracteres del inglés significativos para Usted (caracteres del inglés significa
que no puede utilizar la diérsis alemana o el acento francés o la eñe española).
Caracteres válidos son a-z, A-Z, 0-9, _ (caracter de subrayado) y un límite de 8 en
total. Si usted ingresa más de 8, solo serán usados los últimos 8. Para renombar
un diseño actualmente existente, utilice otra vez la opción Guardar diseño en uno
de los renombrados e ingrese un nombre diferente en el cuadro de texto o déjelo
en blanco para el nombre por defecto (figure 2.6b).

Los archivos conteniendo las coordenadas para sus diseños serán autimáticamente
guardados en el directorio $HOME/.bcast5 como layout#_rc o con el nombre
layout#_8caracteres_rc.

Para utilizar el diseño deseado, ingrese el atajo de teclado o utilice el menú desple-
gable Ventana y elija Cargar diseño y haga su elección. Es muy beneficioso apren-
der los atajos de teclado para sus diseños porque pueden ser ejecutados desde
cualquiera de las 4 ventanas en lugar de solo desde la ventana principal de la
línea de tiempo.

2.1.11 ¡Solo reproduciendo!

¿Y si solo utiliza CINELERRA-GG para reproducir multimedia y escuchar canciones?
Después de cargar su multimedia, solo tiene que pulsar la barra espaciadora para
empezar a reproducir y después otra vez para parar la reproducción.
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a)

b)

Figure 2.6: Diseño de las ventanas

Aparte de esto, utilice los botones de transporte en la barra superior de la ventanda
del programa. A continuación se describen otras formas de reproducir.

Repetir reproducción / Método de bucle

Hay 2 métodos para repetir la reproducción o en bucle en la línea de tiempo y 1
método tanto para el Compositor como para el Visor. Esto funciona en conjunto
con cualquiera de los botones de transporte o atajos del teclado ya sea hacia ade-
lante o hacia atrás, como es habitual. La excepción es que la tecla Mayúsculas no
puede ser utilizada para añadir o quitar audio dentro del área de repetición.

Método 1: Mayús-L en la línea de tiempo, repite la selección por el algoritmo que
se describe a continuación

Cuando se configura, se muestran largas líneas verdes a lo largo de todo el con-
junto de pistas que se muestran al inicio y el final del bucle.

1. La selección resaltada repite el bucle y tiene prioridad sobre las demás posi-
bilidades. Si el cursor está antes del área resaltada, se reproducirá hasta el
área y después repetirá el área de la sección resaltada. Si el cursor está de-
spués del área resaltada, la reproducción comenzará al principio hasta llegar
a la sección resaltada y luego se repetirá.

2. Cuando ambos punteros, Entrada y Salida, están establecidos, repetirá la sec-
ción entre [ y ].
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3. Si solo uno de los punteros de Entrada o Salida está fijado, reproducirá en
bucle todo el multimedia.

Motodo 2: Ctrl+Mayúst+botón de transporte en la línea de tiempo, el visor y en
el compositor.

1. Repite el multimedia entero si no están fijados los punteros de Entrada o
Salida.

2. Cuando están establecidos los punteros de Entrada y Salida, repite el área
entre punteros.

3. Solo el puntero establecido, repite desde Entrada hasta el final del multime-
dia.

Memoria de la última posición de reproducción

Cuando Usted reproduce multimedia, la posición de inicio/final de la reproducción
son guardadas como si hubieran sido hechos en etiquetas temporales. Aparecen
en la línea de tiempo como marcadores púrpura/amarillas que representan las
últimas etiquetas de inicio/fin de la última reproducción.

Ctrl← a la etiqueta antes del cursor, que es el incio de la reproducción

Ctrl→ a la etiqueta después del cursor, que es la parada de la reproducción

Ud. puede utilizar estos marcadores para re-selección. Adicionalmente, la región
de selección puede ampliarse empujando los marcadores mediante la reproduc-
ción de un solo cuadro. Utilice reverso de fotograma (4 del teclado numérico)
para empujar el marcador de inicio de la reproducción hacia atrás o utilice avance
de fotograma (1 del teclado numérico) para empujar el marcador de final de
reproducción hacia adelante.

Otra característica útil es usar la combinación de Ctrl-Mayús-flecha (izquierda o
derecha) para seleccionar el multimedia desde la posición del cursor (fina linea
roja) hacia el marcador de inicio o final saltando hacia el marcador. Por ejemplo,
saltar al principio de la región de reproducción anterior utilizando Ctrl-Mayús-
flecha izquierda para mover el cursor al principio de la última reproducción y luego
presiona Ctrl-Mayús-flecha derecha para saltar al final de la región de reproduc-
ción. Ahora Usted puede recortar/reproducir/expandir o editar la selección de
reproducción anterior.

Ctrl Mayús→ salta el cursor hacia la etiqueta a la derecha de la posición del cursor
y expande la selección
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Ctrl Mayús← salta el cursor hacia la etiquta a la izquierda del cursor y expande
la selección

Soporte de automatización de velocidad de reproducción

La automatización de velocidad hace que la tasa de muestreo de la reproducción
aumente o disminuya a un periodo controlado por la curva de automatización de
velocidad. Esto puede hacer que la reproducción se acelere o relentice de acuerdo
con la tasa de muestreo escalada, como el tiempo es multiplicado por la velocidad
(Velocidad × Unidad_Tasa). Para mas información sobre cambios de velocidad,
lea la sección Automatización de Velocidad 7.3.

Alternativa al uso del teclado numérico para reproducción

Por teclados sin panel numérico, o si Usted prefiere utilizar teclas cercanas a donde
Usted normalmente tipea, hay teclas alternativas para funciones de reproducción/-
transporte. Esas están listadas debajo.

Alt + m = para la reproducción
Alt + j = avanza un solo fotograma
Alt + k = avanza con reproducción lenta
Alt + l = avanza con reproducción normal
Alt + ; = avanza con reproducción rápida
Alt + u = retrocede un solo fotograma
Alt + i = retrocede con reproducción lenta
Alt + o = retrocede con reproducción normal
Alt + p = retrocede con reproducción rápida

+ Mayús, resulta en lo con-
trario de si se incluye o no el
audio.

+ Ctrl, resulta en que las fun-
ciones de transporte solo op-
eran entre los punteros de
Entrada/Salida.

2.2 La ventana Compositor

La ventana del Compositor (figura 2.7) es utilizada para mostrar la salida de la
línea de tiempo. Reproduciendo y moviéndose a lo largo del video en la línea
de tiempo en la ventana de programa, muestra la imagen actual en la ventana
del Compositor. Aquí es donde se realizan muchas operaciones de composición
que pueden cambiar el aspecto de la línea de tiempo. Cuando está habilitada,
Usted puede, simplemente, cliquear con el BIR en la ventana Compositor para ini-
ciar o parar la reproducción. Usted, puede acercar o alejar con el zoom para ver
pequeños detalles, desplazarse con las barras de desplazamiento, Bloquear la ven-
tana para prevenir cambios, agregar máscaras y hacer cambios con las operaciones
de las funciones del Proyecto y la Cámara. Esto será explicado con mayor detalle
en la siguiente sección.
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Figure 2.7: A mano izquierda está la barra de funciones / la barra de abajo tiene muchas
funciones de control

2.2.1 Controles del Compositor

En la parte inferior de la ventana, hay muchos de los mismos botones de transporte
y control que están en la ventana del programa. Trabajan de la misma manera que
en la ventana del programa y además tienen información sobre herramientas que
se hacen visibles cuando Usted posiciona el ratón sobre cualquiera de los íconos,
por lo que su uso es bastante intuitivo. Sin embargo, de particular importancia es
del botón "Clic para reproducir" que se describe en 2.4.1.

Junto a todos estos controles, todo el camino hacia el lado derecho, hay un menú de
zoom y una luz indicadora. El menú de zoom tiene una desplegable con diferentes
configuraciones, las cuales Usted puede elegir o utilizar las flechas del tambor a
la derecha. Generalmente cuando recién se inicia, Usted utilizará la opción por
defecto Auto. El tamaño de la ventana no cambia, sino que cambia el tamaño del
propio video. Adicionalmente, hay muchos atajos de teclado para hacer zoom que
Usted pude encontrar en el capítulo Atajos del teclado (15).

Para redimensionar completamente la ventana en lugar de solo el video, haga click
con el BDR en la ventana del compositor, del cual emergerá un menú con todos
los niveles de zoom, modo auto zoom y algunas otras opciones. Como se puede
esperar, cada vez que el video se amplia, solo una parte de la images es visible
en la ventana, automáticamente se agregan barras de despanecimiento como sea
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necesario, en la parte inferior, a la derecha o ambas. Otras opciones incluyen Reini-
ciar cámara y Reiniciar proyector, la cuales obviamente se utilizan para reiniciar la
cámara y el proyector. La opción de ocultar controles/mostrar controles es genial
para ocular la barra de herramientas de la izquierda y un conjunto de controles
inferiores para darle un aspecto mas limpio.

Al lado del tambor con flechas del zoom, está una luz indicadora que se pintará con
el mismo color (frecuentemente rojo o azul) mientras una operación de render-
ización está tomando lugar. Esto es especialente útil cuando carga un muy largo
video, entonces Usted puede saber cuando finaliza la carga. Usted deberá prestar
atención a esta luz indicadora cuando se está realizando una operación en particu-
lar que consume tiempo, para que Usted no siga ejecutando mas operaciones que
solo tienen que esperar la finalización de esa operación de uso intensivo de la CPU.
Además debería mirar si la luz está encendida antes de asumir que CINELERRA-GG
está colgado.

Cuando la ventana está desbloqueda, que significa que no está en modo Prote-
ger video de los cambios en la barra de hereramientas, cliqueando con el BCR
y moviendo el video hacia cualquier lugar, desplaza la vista. El desplazamiento
puede venir acompañado con barras de desplazamiento abajo y a la derecha.

2.2.2 Barra de herramientas del Compositor

A la izquierda de la ventana del Compositor, hay una barrra de herramientas con
varios íconos que proveen funciones de visualización y composición de video. Cada
una de estas características operacionales serán descriptas en mas detalle a con-
tinuación.

Proteger video de cambios esta opción hace posible deshabilitar cambios en la
salida del compositor cuando cliquea en la ventana Compositor. Esto per-
mite utilizar el botón Clic para reproducir (cuando está habilitado) para
simplemente inciar y parar la reproducción. Esto ayuda a prevenir que un
clic accidental haga cambios no deseados. Cuando Usted habilita esta op-
ción, cualquiera de las otras herramientas habilitadas, serán deshabiltadas
automáticamente.

Vista Zoom / lupa Cuando está habilitado, la Vista Zoom Inmediatamente resulta
en la adición de un deslizable de zoom para una visión mas precisa. El verti-
calmente orientado deslizable de zoom se muestra debajo del último ícono de
la barra de herramientas y se exiende hasta casi el final de la barra de her-
ramientas. El deslizador permite ajustar la cantidad de zoom en cualquier
nivel entre 0.01 y 100, basado en una escala logarítmica.
Cuando se utiliza el deslizador de zoom, el número por el cual la vista está
escalada, puede ser visto en la caja de texto en los controles inferiores donde
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el % de zoom se localiza. El tamaño del deslizador es en forma de tiempos,
como ×0.82 que indica que la imagen está aumentada en 82

100
avos

del tamaño
original como se ve en el menú Ajustes → Formato Una vez que Usted tiene
fijado el zoom al tamaño deseado, utilice las barras desplazadores verticales
y horizontales a la posición de la vista que necesite. Como se mencionó ante-
riormente, esta variedad de zoom solo influye en el video, no redimensiona
la ventana del Compositor. Después de utilizar esta barra de desplazamiento
para hacer zoom, es posible que Usted desee volver a Auto utilizando los
controles de la parte inferior de la ventana. Esta barra deslizable también es
mostrada cuando Usted cliquea en los ícono para Ajustar la automatización
de la cámara o Ajustar la automatización del projector.
La imagen de la ventana del Compositor en la figura 2.8 muestra la barra
deslizante del zoom con un deslizador de forma rectangular en el centro.
Note que la lupa está habilitada, por lo cual aparece automáticamente el
deslizador y se desactiva la opción de Proteger video de los cambios. Además
note que hay una barra deslizable en la parte de abajo y de la derecha de la
imagen ya que la imagen con este aumento no cabe en la ventana. La caja
de texto del control de zoom muestra un tamaño de ×0.82.

Figure 2.8: Barras de desplazaminto de zoon y barras deslizante de la ventana Compositor

Editar máscaras trae a colación un menú de edición de máscaras con muchas
versátiles opciones, descriptas mas adelante en gran detalle en la sección
(2.2.6). Además Usted tendrá que hacer clic en Mostrar información de la
herramienta para desplegar el menú, dependiendo de si anteriormente ha
descartado esa ventana o no.

Regla esta puede ser una herramienta útil para obtener las coordenadas X,Y de
un punto exacto o medir la distancia entre 2 puntos. Para utilizar la Regla
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mueva el ratón en el video hacia el punto deseado - esas coordenadas X,Y se
mostrarán en el actual cuadro de texto. Cliqueando con el BIR crea el Punto
1 y después continúe con el BIR presionado, de modo que se crea una línea
de regla entre este Punto 1 y el Punto 2 de parada. Deltas es la diferencia X,Y
entre los dos puntos; Distancia es el número de pixeles entre los dos puntos
y Ángulo es el ángulo en grados de esa línea de regla. En la figura 2.9 Usted
puede ver el menú Regla en la parte derecha de la ventana del Compositor.
Manteniendo presionada la tecla Ctrl mientras se arrastra uno de los puntos
con el BIR, asegura que la línea está siempre en un ángulo múltiplo de 45
grados. Manteniendo presionada la tecla Alt mientras arrastra con el BIR en
uno de los puntos, trasladará la línea de la regla hacia otro lugar en el video,
manteniendo su longitud y ángulo. Si Usted cierra el menú emergente Regla,
cliquee en Mostrar información de la herramienta para tener otra vez el menú
emergente.

Ajustar automatización de la cámara la cámara muestra las herramientas de edi-
ción de cámara. Habilite Mostrar información de la herramienta si el menú
emergente no aparece. Se proporcionan mas detalle del uso en la siguiente
sección 2.2.5.

Ajustar automatización del proyector el proyector muestra las herramientas de
de edición del proyector. Habilite Mostrar información de la herramienta si
el menú emergente no aparece. Se proporcionan mas detalle del uso en la
siguiente sección 2.2.5.

Recortar una capa o salida esta es una herramienta de recorte utilizada para re-
ducir el área visible de una imagen. Se proporcionan mas detalle del uso en la
siguiente sección (2.2.7). También hay un complemento Recorte & Posición
que provee un conjunto diferente de capacidades 9.9.17.

Obtener color / gotero saca el gotero utilizado para detectar el color de un punto
en particular. Habilite Mostrar información de la herramienta si el menú de-
splegable de Color no aparece automáticamente o si este menú fue acciden-
talente cerrado. Cliquee en un color específico de la salida de video con el
BIR para ver el color seleccionado. Usted pude utilizar ese valor de color
para ser aplicado en algunos efectos, dependiendo de cómo el efecto maneje
el gotero.

Mostrar información de la herramienta este botón es utilizado en conjunto con
las otras herramientas en la barra de herramientas del Compositor. Usted solo
necesita hacer clic en esta si uno de los menúes energentes de herramien-
tas no aparece o ha sido cerrado - herramientas Máscaras, Regla, Cámara,
Proyector, Recorte o Gotero. También puede utilizarlo cuando está resaltado
para descartar el cuadro de diálogo de la herramienta resaltada. Esta no
se necesita para Proteger video de cambios, Vista Zoom y Mostrar regiones
seguras ya que no tienen menús emergentes.
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Figure 2.9: Fíjese en los contornos negros que mustran las regiones seguras. También note el
menú de la regla.

Mostrar regiones seguras dibuja 2 contornos para mostrar las regiones seguras
en su video como puede ver en la Figura 2.9. En algunas TVs/monitores/-
pantallas particulares, los bordes de la imagen son cortadas y esa sección
cortada no podría ser tan rectangular como aparece en la ventana del com-
positor. Esto es especialmente útil si el dispositivo para la pantalla de salida
es un modelo de TV muy antiguo. El contorno exterior mas grande es la su-
pereposición segura de acción, mientras que el contorno interior mas pequeño
es la superposición segura del título.
Utilizando Mostrar regiones seguras no tiene efecto en la salida de render-
izado. El propósito de mostrar los bordes es para hacer mas fácil de ver
dónde podría ser cortado. Esta área fuera de la región segura se puede uti-
lizar como una raya o espacio de supresión vertical. Habilitando las regiones
seguras hacen realmente fácil para ver esos bordes, por lo tanto puede ase-
gurarse de que los títulos están dentro del contorno interior y las acciones
dentro del contorno exterior.

2.2.3 Composición

Muchas de las ediciones en CINELERRA-GG involucran "composición" que es una
combinación de elementos visuales desde diferentes orígenes dentro, de una única
imagen. Esto incluye algunas cosas como aumentar la velocidad o relentizar el
video, cambiar la resolución, crear una pantalla dividida y disolver de entrada o
de salida. Las operacions de composición se realizan en la línea de tiempo y en la
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ventana Compositor, utilizando varias oporaciones y otros atributos de composi-
ción que están disponibles en la ventana Recursos. Cuando CINELERRA-GG está
realizando una operación de composición, reproduce a travéz del motor de com-
posición, pero cuando no, utiliza el decodificador mas rápido que tiene.

2.2.4 El temporal, pistas y tamaños de salida

Esta sección explica una pocas cosas las cuals ayudan a entender la Composición
- especialemtn relacionado con la cámara, efectos y el proyector.

El temporal

Las rutinas del compositor de CINELERRA-GG utiliza un temporal, el cual es un
único fotograma de video en memoria, donde los procesos gráficos toman lugar.
El tamaño del temporal y el de la salida en la tubería de composición son difer-
entes y varían para cada fotograma en particular. Los efectos son procesados en el
temporal y como tal, se ven afectados por el tamaño del temporal. En el caso de
la cámara, su puerto de visión es el tamaño temporal. Sin embargo, el proyector
es renderizado a la salida y entonces es afectado por el tamaño de salida. Cuando
el temporal es mas pequeño que la salida, el temporal tendrá bordes en blanco
alrededor de la región en la salida. Cuando el temporal el mas grande que la
salida, será recortado.

Pistas y tamaños de salida

El Tamaño de la pista es utilizado para definir el tamaño del temporal con cada pista
teniendo un tamaño difirente. Usted puede ver o establecer el tamaño cliqueando
con el BDR en la pista y después selccionar Ajustar el tamaño de la pista para
redimensionar la pista a cualquier medida. O seleccionar Ajustar a la dimención
de salida para que la pista sea del mismo tamaño que la salida. La relación entre
la pista y el tamaño de la salida del proyecto hacen que sea posible ampliar o
reducir el tamaño de una pista con respecto a la salida final. Esta característica
significa que Usted puede crear efectos viduales como pantallas divididas, zoom y
panorámicas en el Compositor.

El tamaño de salida se puede ajustar en Archivo → Nuevo cuando crea un nuevo
proyecto o utilizando Ajustes → Formato o en la ventana de Recursos, clique-
ando con BDR en un activo de video y eligiendo Ajustar el tamaño del proyecto.
Cuando Usted Ajusta el tamaño del proyector, Usted está conformando la salida al
activo. Una vez que Usted tiene ajustado el tamaño de salida de una de estas tres
manera, cualquier nueva pista creada se ajustará al tamaño específico de salida.
Cuando renderiza, el tamaño de la salida del proyecto es el tamaño final de la pista
de video donde la tubería del temporal es renderizada.
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2.2.5 Cámera y Proyector

En la ventana del compositor, Ajustar automatización de cámara y Ajustar autom-
atización del proyector son herramientas de edición para operaciones de control
de la cámara y el proyector. En la tubería de composición de CINELERRA-GG, la
cámara determina desde qué origen es copiado hacia el temporal mientras que el
projector determina dónde, en la salida, es copiado el temporal. (figura 2.10).

Figure 2.10: Tubería de composición

En composición, cada fotograma puede ser modificado utilizando varias opciones
y complementos, como ser un complemento de corrección de color (figura 2.11).
Después de que la imagen ha sido modificada, la imagen final es proyectada hacia
el compositor, de modo que ahora tiene un original cambiado.

Figure 2.11: Balance de color el Temporal
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Cuando se edita la cámara y el proyector en la ventana de composición, la pista
afectada será la primera pista que está armada. Si hay múltiples pistas de video,
Usted puede seleccionar una pista específica para edición, cliqueando con el BIR
en el ícono Armar pista de la pista deseada. Esto se llama "solo" la pista. Para
revertir estas "soledad", cliquee con el BIR en el ícono otra vez.

Composición del Proyector

El propósito del proyector es para componer algunos orígenes desde varias pistas
en una pista de salida. El fotograma de alineación del proyector es el mismo que
el del visor de la cámara, excepto que muestra dónde poner el contenido de cada
temporal en el lienzo de salida. Para ingresar en el modo edición del proyector,
cliquee en el ícono Ajuste automatización del proyector en la barra de herramientas
del Compositor. Entonces podrá ver dos contornos rojos rodeando la imagen y
dos líneas diagonales cruzando por el medio, que se muestran en la ventada de
video. El borde rojo indica el tamaño del fotograma que será enviado a la salida.
Usted puede, fácilemente, arrastrar el cuadro con el BIR, moviendo el fotograma
en dirección x y . Cuando se mueve a largo del e je− z (p.e. el zoom, con Mayús-
Arrastrar) el cuadro sigue exactamente el movimiento y el tamaño del fotograma.
Después de que Usted posiciona el video con el proyector, a continuación Usted
querrá Ajustar automatización de cámara

El área visible

El área visible es una pantalla en la cámara que encuadra el área de la fuente de
video. El tamaño de la pista actual es utilizada para el tamaño inicial del área
visible. Un área visible pequeña, por ejemplo (640 × 480), captura un área pe-
queña, mientras que una área visible de (800×600) captura un área mas grande.
Si el área capturada es mas grande que el video de origen, los espacios vacíos se
rellenarán automáticamente con blancos. Después de que el área está definida, la
cámara necesita ser ubicada abajo a la derecha del área del área de interés en el
video de origen. Las operaciones para controlar la ubicación de la cámara son las
siguientes:

1. En la ventana del compositor, Usted puede ver la pista seleccionada.

2. Clic con el BIR en Ajustar automatización de cámara para traer el menú de
edición y las líneas verdes y amarillas de los coloreados bordes.

3. Utilice el BIR para arrastrar el video donde desee sobre la pantalla en la ven-
tana del compositor.

Cuando se arrastra sobre el área visible en la ventana del compositor, parece que
Usted está moviendo la cámara con el ratón. El área visible se mueve de la misma
forma.
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Composición de la Cámara

Seleccione el botón de cámara para habilitar el modo de edición de cámara. En
este modo, el cuadro guía muestra dónde está la posición de la cámara en relación
con el pasado y el futuro de la posición de la cámara, pero nó en relación donde
está respecto del video de origen. El marco el área visible arrastrándolo con el BIR
(moviéndola en x/y), el marco verde se mantiene fijo al tamaño original, pero el
fotograma es movido hacia una nueva posición. Un marco amarillo aparecerá a
lo largo de los bordes del fotograma para indicar el desplazamiento respecto del
marco verde; este comportamiento difiere del que se ve en el proyector. Incluso si
actuamos en el e je− z (Mayús-arrastrar, equivale a hacer zoom), el fotograma se
estrecha o se ensancha, moviéndose detrás del marco amarillo.

Menú de la cámera y del proyector

La cámara y el proyector tienen operaciones de acceso directo que no aparecen en
el menú emergente y no están representadas en las superposiciones de video. Se
accede a ellos en la ventana Mostrar información de la herramienta. La mayoría de
las operaciones en la ventana del compositor tienen una ventana de herramientas
la cual es habilitada activando el ícono con el signo de interrogación (figura 2.12).

Figure 2.12: Herramientas
de cámera y proyector

En el caso de la cámara y el proyector, la ventana de
herramientas muestas las coordenadas x , y y z. Ya sea
dando vueltas o ingresando texto directamente, la cá-
mara y el proyector pueden ser posicionados con presi-
ción. También se definen los tipos de justificación para
facilitar le acceso. Una operación de justificación popu-
lar es una proyección arriba a la izquierda luego de una
reducción de imagen. Esto se utiliza cuando se reduce
el tamaño del video con el ajuste la relación de aspecto.
En la última figura Usted puede ver las opciones de jus-
tificación como la ubicación de la línea de los 6 cuadros,
en el órden de izquierda, centro horizontal, derecha, arriba, centro vertical e infe-
rior.

Los efectos de traslación permiten la conversión simultánea de la converción de
relación de aspecto y reducción, preo es fácil de utilizar si el video reducido es
puesto arriba a la izquierda de el temporal en lugar de al centro. El tamaño de la
pista ese fijado al tamaño del video original y la cámara está centrada. El tamaño
de salida es fijado al tamaño reducido del video. Sin ningún efecto, esto produce
solo la parte central recortada del video en la salida.

El efecto de traslación se suelta en la pista de video. Las dimensiones de ingreso
del efecto de traslación se estable al tamaño original y las dimensiones de salida se
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fijan al tamaño reducido. Para poner el video reducido en el centro de la subsec-
ción que muestra el proyector requeriría compensar x e y con un cálculo compli-
cado. En cambio, dejamos x e y en 0 y utilizamos la ventana de herramientas del
proyector. Seleccionando justificación izquierda y justificación arriba, el proyector
muesta la imagen reducida desde la esquina superior izquierda del temporal en el
centro de la salida.

Restablecer valores predeterminados

En la ventana de composicíon, hay un menú emergente de opciones para la cámara
y el proyector. Clic con el botón derecho sobre la porción de video de la ventana
de composición para hacer emerger el menú:

Restablecer Cámera: causa que la cámara retorne a la posicíon central.

Restablecer Proyector: causa que el proyector retorne a la posición central.

Caso de uso: Interacción entre la cámara y el proyector 1

1. Empiece encogiendo el proyector a z = 0.500 (1
4 del fotograma original).

2. El siguiente paso es cambiar a la cámara y note que el borde verde asume
el tamaño del proyector, es decir, la caja roja. El valor de z de la cámara es
siempre igual a 1.000 (por defecto) pero el fotograma es 1

4 del fotograma
original, es decir, tiene el tamaño del proyector, que tiene z = 0.500. Este es
el tamaño actual del área visible.

3. Usted amplía la sala introduciendo z = 2.000. Usted puede ver que las dimen-
siones del área de trabajo (borde verde) no cambia, manteniendo la misma
que las del proyector. No obstante, el fotograma ha sido ampliado y esta
variación está indicada por la ampliación de la caja amarilla. Recordemos
que esto sigue los cambios hechos con la herramienta de la cámara.

4. Podemos arrastar la sala para poder centrar el fotograma a nuestro gusto.
El movimiento de la caja amarilla muestra bien la variación en comparación
con la caja verde.

5. Finalmente, Si queremos, podemos cambiar a la herramienta del proyector
para mover el fotograma de salida a la posición que queramos respecto del
tamaño del origen. Por supuesto, también podemos trabajar en z, el cual está
en 0.500 en el ejemplo, si es que tenemos decidido cambiar el tamaño de la
salida.

1Ejemplo provisto por Sam. El respectivo video esa ubicado en: https://streamable.com/
iq08i
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2.2.6 Máscaras

Las máscaras puden ser utilizadas para realizar varias tareas, pero básicamente son
utilizadas para seleccionar un área del video que va a ser mostrado u ocultado. Es-
tas pueden ser utilizadas en conjunto con otros efectos para aislar el efecto a una
cierta región. Otro uso es cuando usted retrasa ligeramente una pista de video,
copia y desenmascara un área donde una copia tiene interferencia y la otra no. O
se utiliza una máscara cuando se necesita correción de color en una de parte del
fotograma pero no en otra. Una máscara puede ser aplicada a una pequeña sec-
ción de una pista con color corregido mietras una pista plana se muestra a través.
Remover micrófonos, matrículas, personas y aeroplanos a través de máscaras es
un uso muy común.

El órden de las tuberías de composición afecta cómo se hacen las máscaras. Usual-
mente las máscaras son manejadas en el temporal, despúés de los efectos, pero
antes que el proyector. Debido a que trabaja de esta manera, múltiples pistas se
pueden combinar en una pista enmascarada y proyectarlas con la misma máscara.

El gráfico de la tubería de composición tiene una etapa de enmascaramiento. (fig-
ure 2.13).

Figure 2.13: Tubería de composición con máscara

Tubería de composición con máscaras

El menú emergerente de Máscaras puede ser abrumador en el primer encuentro.
De todas maneras, si Usted sigue los pocos pasos siguientes, podrá crear una simple
máscara sin tener que entender cada posible parámetro.

1. Para definir una máscara, en la ventana del Compositor, cliquee en el ícono
Editar Máscara para obtener el menú emergente Máscara. Si el menú no
aparece, clic en Mostar información de la herramienta.
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2. En el video, clic con el BIR en el lugar donde Usted quiere iniciar una máscara.

3. Después, click con el BIR en otro punto de la imagen para crear cada uno de
los nuevos puntos de la máscara. Cuando Usted tiene al menos 3 puntos, se
dibujarán líneas entre ellos, pero Usted puede crear algunos puntos mas como
necesite y las líneas se redibujarán para cubrir todos los puntos. Cuando
Usted crea cada punto de la máscara, se expande una curva de línea recta que
altera la forma de la máscaras. La posición de la máscara estará siempre en la
misma posición en cada imagen del video, mientras Usted no habilite Generar
fotogramas clave mientras se modifica en la barra de Transporte y Botones de
la ventana de Programa. Despúes, cuando lo habilita, Usted puede mover la
máscara a lo largo del tiempo.

4. Para que la máscara pueda o no ser vista, tiene que haber una pista de video
debajo de la pista que está viendo en el compositor. Una forma fácil de ver
el área enmascarada es solo agregando una pista vacía debajo de la pista
objetivo y arrastrar el complmento Gradiente en el área resaltada en la pista.

5. Usted puede mover los puntos existentes hacia una nueva ubicación simple-
mente utilizando el BIR en un punto para arrastrar este punto hacia una
ubicación diferente.

6. La máscara puede ser trasladada como una endidad única arrastrándola mien-
tras se presiona Alt. Para algunos entornos gestores de ventanas, como ser
Ubuntu Studio 16.4 y Arch, la tecla Alt está siendo utilizada por el Sistema
Operativo, en ese caso, Usted, en reemplazo debe utilizar Alt+Ctrl.

7. Para crear líneas curvadas en lugar de rectas entre dos puntos, utilice Ctrl
para arrastar en un punto específico. Utilizando Ctrl para arastrar, activa
manijas bezier (puntos de control) para crear esas curvas entre los puntos.
Por ejemplo, en una máscara con solo dos puntos, Usted puede crear una
romántica máscara con forma de corazón.

Hay muchas mas operaciones que Usted puede hacer utilizando el menú de Más-
caras como se muestra en la figura 2.14. Una descripción detallada se provee a
continuación. Note que la ventana de Máscara está separada en varias secciones,
para facilitar la ubicación del área de interés.

Máscaras en sección de la pista

La Pista: la caja de texto muestra las diferentes pistas de video para esta sección,
la cual inicialmente puede fijarse en la primer pista de video armada o puede
estar en blanco si no hay pistas armadas. Un desplegable a la derecha despliega
los nombres de todas las pistas de video que permiten a Usted cambiar a la pista
a la cual aplicar el enmascarado. También, Usted puede solo utilizar el tambor
arriba/abajo con el ratón para obtener la pista deseada. En la lista desplegada,
cualquier pista que tiene su nombre en color rojo, está desarmada, por lo que
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Figure 2.14: Ventana de opciones de Máscara

Usted no puede modificarla. Una pista que contiene una máscara, tiene su nombre
en amarillo para su fácil identificación. Solo cuando no hay máscaras en la pista,
Usted puede tener el color de texto por defecto. Este cuadro de texto es solo para
mostar, Uste no puede ingresar texto en él.

El botón Solo en la Máscara, en la sección Pista de la ventana de Máscaras, es muy
útil cuando trabaja con máscaras en diferentes pistas. Este muestra solo esta pista
para que veas la pista que elijas, así como las pistas detrás de ella para mostar la
parte de la máscara. El botón Solo es una comodidad para evitar tener que pasar
el ratón por la pachera.

Sección Máscaras

La Máscara: el cuadro de texto le mostrará números de máscara de 0−7 o los nom-
bres de 8 caracteres ascii que Usted tiene para designar cada númro de máscara.

51



2.2. La ventana Compositor

Hay un desplegable a la derecha para cambiar fácilmente hacia otra máscara.

El botón Borrar es utilizado para borrar la máscaca número/nombre que esté se-
leccionada. El símbolo a la derecha con la información sobre herramientas Borrar
todas las máscaras se puede utilizar para borrar todas las máscaras de la pista
actual.

Seleccionar: la fila de casillas de verificación son usadas para indicar cuál de las
máscaras es la actualmente activa para esta pista. Un tambor a la derecha permite
un rápido cambio de número de máscara mostrada.

La fila Activar de máscaras hace que Usted pueda activar todas o ninguna de las
máscaras, haciendo posible que no se vea ninguna máscara o que se vea una más-
cara sin la interferencia de las otras máscaras. El símbolo que parece un ojo puede
ser utilizado para fácilmente marcar todas o ninguna, como la información para
herramientas Mostrar/Ocultar máscaras.

Sección de figuras preestablecidas

Hay 4 figuras que están automáticamente disponibles para el uso como máscaras
- cuadrado, círculo, triángulo y óvalo. Adicionalmente, hay 3 símbolos en esta
sección para los propósitos de cargar, guardar y borrar sus propias formas per-
sonalizadas. El primer símbolo, Cargar preestablecido, traerá una lista de sus
preestablecidos guardados previamente. Cliqueando en Guardar preestablecido
le traerá una ventana emergente que le permitirá a Usted proveer un nombre
para identificar el preestablecido que Usted quiere guardar, con un desplegable
para ver el nombre de sus otros preestablecidos guardados. Cliqueando en Bor-
rar preestablecido, también traerá un cuadro con un desplegable para elegir cuál
borrar. Hay un archivo, llamado mascara_rc, en $HOME/.bcast5 que graba sus
máscaras personalizadas.

Cuando Usted cliquea en Cargar preestablecido, tenga en mente que esto escribirá
el numero que Usted tiene seleccionado, entonces, si Usted ya tiene una máscara
en esa ubicación, esta se sobreescribirá - solo haga Deshacer máscara bajo el menú
desplegable Editar de la ventana principal (atajo de teclado ’z’) para revertir a la
previa si es que Usted comete este error.

Sección Posición y Escala

Botón Centrar máscara permite el rápido centrado de la máscara en la pista de
video. Botón Normalizar máscara hace fácil normalizar el tamaño de la máscara
basado en la escala del video. Los siguientes 3 símbolos se refieren a la dirección
de traslado arrastrando una máscara, utilizando Alt+BIR, así es fácil preservar el
valor actual de X o Y cuando se desea. Para algunos entornos gestores de ventana,
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como ser Ubuntu Studio 16.4 y Arch, la tecla Alt ya está siendo utilizada por el
Sistema Operativo, en es caso Usted debrá utilizar Alt+Ctrl en su lugar.

Trasladar/Escalar x - el traslado arrastrando se restringe en la dirección X

Trasladar/Escalar y - el traslado arrastrando se restringe en la dirección Y

Trasladar/Escalar x/y - el traslado arrastrando en ambas direccionees; esto es
por defecto y después de utilizar las otras dos opciones, debe reestablecer esto
para evitar futuras confusiones mientras arrastra.

Sección Desvanecimiento & Pluma

El Desvanecimiento: cuadro de texto utilizado para tipear una valor de desvanec-
imiento; el tambor a la derecha del cuadro de texto permite incrementar o dis-
minuir este número y la barra deslizante hace rápidamente ajustable el valor de
desvanecimiento. El desvanecedor va desde −100 a la izquierda hasta +100 a la
derecha para negativo a positivo. El valor por defecto es +100. El deselizante de
desvanecimiento incluye un punto pegajoso en 0 que hace fácil para ir a 0 sin ir
demasiado lejos o no lo suficientemente lejos – de esta manera Usted no tiene que
seguir moviéndos para llegar allí.

Adicionalmente, hay un símbolo de atenuador masivo para permitir tener todos los
atenuadores de máscara la unísiono. El símbolo está rodeado por un fondo verde2

cuando está vigente. Si Usted tiene múltiples máscaras con diferentes modos,
una decisión para tomar es qué valor utilizar – es utilizado el valor máximo de
transparencia del fondo para determinar los resultados de las operaciones. Para
entender cómo trabaja esto, aquí hay un resumen:

Nota 1: El área fuera de la máscara se conoce como el fondo.

Nota 2: El resultado operativo se basa en el valor máximo de la transparencia de
ese fondo.

Caso 1, Desvanecimiento Positivo: Cuando el desvanecedor para todas las más-
caras es positivo, afectando al área interior de la máscara, todos los colores de
fondo están con valores cero de transparencia. Así que el mayor valor de trans-
parecia es 0 y todas la máscaras son dibujadas con fondos opacos, representadas
como uno esperaría.

2El verde es utilizado en el tema por defecto Cakewalk, pero el color de fondo puede diferir en
otros temas
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Caso 2, Desvanecimiento Negativo: Cuando el programa computa el color de
fondo de cada número de máscaras, esto incluye máscara(s) negativa(s), utiliza el
mayor número de transparecia como el factor determinante para el fondo. Solo 1
de las máscaras puede ser mas grande y gana el resultado de la transparencia de
fondo.

La Pluma: trabaja de una manera similar al Gradiente de fundido alineado al límite
de la máscara, pero es una función lógica en lugar de una función matemática,
así podrá ser rápida. El símbolo de la Pluma masiva también trabaja de manera
similar y está rodeada por un fondo de color dorado cuando está activa.

Sección Puntos de Máscara

Esta sección se utiliza para cambiar a un número de máscara diferente y manupular
las máscaras que Usted tiene creadas.

El Punto: las cajas de texto proveen la habilitad para cambiar con qué número de
punto de la máscara actual quiere trabajar Usted. Tiene un tambor que permite
cambiar fácilmente en número de punto. Los cuadros X: e Y: debajo, reflejan el ac-
tual valor y permiten modificar las coordenadas X/Y y también tienen un tambor.
El botón Borrar permite la eliminación del número de punto seleccionado.

Los siguientes 6 símbolos en 2 columnas representan botones Suave y Lineal. El
botón Suave utiliza un algoritmo basado en el punto anterior y el punto siguinte
para crear una línea curvada. Las operaciones de suavizado toman tres puntos, A,
B, C y organiza la pendinte en B para que sea AC mientras de nueve al siguiente
punto para esa máscara.

punto suave→ suaviza un solo punto.

curva suave→ suvaiza todos los puntos en una máscara de bordes curvados.

todo suave→ suaviza todas las máscaras activas.

Los botones Lineal de punto lineal, curva lineal y todo lineal realiza las funciones
inveresas al suavizado. Los puntos de control de vectores en los puntos finales
bezier son fijados con una magnitud cero.

Adicionalmente, hay una casilla de verificación Ver puntos y una Ver contorno que
son útiles para deshabilitar la visualización de los puntos y del contorno de la
máscara. Deshabilitando Ver puntos es muy útil cuando Usted tiene un montón de
puntos que confunden la visualización y hacen difícil de ver a la máscara actual.
Una característica útil está disponible deshabilitando Ver puntos y habilitando Ver
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contorno, lo cual resulta en que todas las máscaras estarán visibles en el visor; por
ejemplo, entonces Usted puede ver la máscara 0, máscara 1 . . . al mismo tiempo.

Un símbolo de masivo en el lado derecho de esta sección, la infomación de la
herramienta Puntos masivos es otra característica útil que hace fácil de arrastrar
a la máscara a una coordenada exacta, utilizando las cajas de texo X o Y para
ingreso numérico o los tamobres asociados. Esto funciona como el traslado con
Alt+arrastre con BIR, pero pero provee la habilidad de ser preciso.

Sección Punto de pivote

Las coordenadas X: e Y: marcan el valor de acutal Punto de pivote utilizado para
la rotación, escalado y traslado. Usted puede teclear los valores numéricos o uti-
lizar los tambores para cambiar los valores, siempre y cuando la casilla Pivote esté
marcada.

La casilla Pivote es utilizada en el caso de que Usted quiera, en su lugar, fijar
un punto diferente para pivotar en el Compositor. Y el símbolo Masivo para ro-
tar/escalar/trasladar significa que aquella operación se realizará en todos los pun-
tos de las máscaras habilitadas. El símbolo Masivo está rodeado de un color de
fondo dorado cuando está activo. Cuando se está realizando una operación de
rotado con la rueda del ratón en una máscara, la aceleración está activa – esto
significa que mas rápido rueda, mas espacio es cubierto, así no tiene que girar
docenas de veces para hacer una rotación completa. Después con giros lentos,
Usted puede obtener un ajuste fino. Tenga en cuanta que para poder rotar/escalar
alrededor del puntero, la casilla Pivote tie que estar desmarcada.

Otras secciones

Finalmente, están las casillas de verificación Aplicar máscaras antes que los com-
plementos y Deshabilitar ennascarado con OpenGL que se explican a sí mismas.

Nota: No todos los progamas OpenGL pueden soportar el método actual de en-
mascarado. Si su implementación de OpenGL no soporta Sombreado versión 4.3
o tiene problemas con esto (es realivamente nuevo para OpenGL en el momento
que se implementó), entonces esta casilla de verificación le permitirá utilizar en-
mascarado por software para evitar potenciales errores. Normalmente, OpenGL
es probado para la versión de sombreado y se utilizará automáticamente la imple-
mentación por software si es requerido.

La casilla Ayuda puede habilitarse para ver una lista de teclas utilizadas para re-
alizar varias operaciones. Si Usted no utiliza frecuentemente el enmascarado, esto
es un recordatorio valioso sobre cuáles combinaciones de tecla utilizar. Actual-
mente están las siguientes:
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Mayús+BIR mueve un punto final
Ctrl+BIR mueve un punto de control
Alt+BIR para trasladar arrastrando la máscara
Mayús+BCR fija el Punto pivote al puntero
Rueda rota alrededor del Punto pivote
Maypus+Rueda escala alrdedor del Punto Pivote
Ctrl+Rueda rota/escala alrededor del puntero

Teclas Alternativas

Nota: Para algunos gestores de ventanas, algunas teclas ya están en uso por el
sistema operativo, entonces tendrá que redefinirlas en su escritorio o utilizar difer-
entes combinaciones de teclas. Por ejemplo, al menos algunos escritorios usados
con UbuntuStudio 16.04 y Arch recogen la tecla Alt, lo que implica que se nece-
siten combionaciones de teclas alternativas. A continuación se presentan algunas
de estas alternativas.

BIR mueve/crea un punto final (para mover el punto final,el pun-
tero deberá estas sobre el punto)

Mayús+BIR mueve un punto final (el puntero deberá estrar cerca del punto,
no sobre él)

Ctrl+BIR mueve/crea un punto de control
Alt+Ctrl+BIR para trasladar arrastrando la máscara
Shift+Tecla Suprimir para borrar la máscara
Shift+BCR Fija el Punto Pivote al puntero
Alt+Rueda acerca/aleja la pantalla (disponible en Ubuntu16 pero no en

todas las distros)

Pivote tildado = destildado:

Rueda rota alrededor del Punto pivote
Mayús+Rueda escala alrededor del Punto pivote
Ctrl+Rueda rota alrededor del puntero
Ctrl+Shift+Rueda escala alrededor del puntero

Pivote tildado = destildado:

Rueda rota alrededor del Punto Pivote (“Punto pivote personalizado”)
Mayús+Rueda escala alrededor del Punto Pivote (“Punto pivote personalizado”)
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2.2.7 Recortando

El Recortado se utiliza para reducir el área visible de la imagen, cambiando las
dimensiones de salida ancho y alto en pixeles y los valores X , Y . Un ejemplo de
recorte y el menú de corte es visto en la figura 2.15. La manera fácil de utilizar el
recortado es cliquear con el BIR en el punto de inicio del recortado y mientras se
mantiene presionado el BIR, arrastar el ratón. Esto creea un área rectangular de
recortado. Para cambiar el tamaño/pisición del este área, clic en cualquira de los
4 puntos de las esquinas con BIR y arrastre. Mientras arrastra, Usted verá cambiar
automáticamente los valores de las coordenadas X1, Y1 y W para ancho y H para
alto, en la ventana emergente del menú de corte, que reflejan la posición actual.
Para una localización precisa, usted puede ingresar los valores exactos en estas
cajas de texto en lugar de utilizar la el ratón. Una vez que tiene definida el área de
recorte como usted lo desea, cliquee en el botón Aplicar para que el actual recorte
tenga efecto.

Hay 3 métodos de corte para elegir en el menú desplegable, abajo a la derecha.

1. Reformatear - Reformatear sesión de recorte y cambiar el formato de toda
la sesión. Como el formato está cambiado, esto es aplicado a todas las pis-
tas del proyecto. La parte de la imagen fuera del rectángulo será cortada
y el proyector hará que el video encaje. La ventana Ajustes → Formato
mostrará los nuevos valores de Ancho y Alto para el proyecto y la ventana de
herramientas del proyector mostrará los nuevos valores de X , Y . El tamaño
de la pista se mantiene sin cambios. Usted puede deshacer el recorte ingre-
sando las dimensiones originales en la ventana Ajustes → Formato para le
Ancho y Alto. Usted deberá utilizar la herramienta del Proyctor de la barra
de herramientas del Compositor para Ajustar automatización del proyector
cliqueando en el ícono Reestablecer.

2. Redimensionar - Redimensiona el Proyector, para deshacer esto, habilite Ajus-
tar automatización del proyector y Reestablezca.

3. Encoger - Redimensiona el Proyector y la Cámara; para deshacer esto, cada
uno de las hereramintas de Ajustar automatización de proyector y cámara una
a la vez y Restablezca en los menúes.

Una nota importante aquí, es que la relación de aspecto original será mantenida,
por lo que si su fotograma es rectangular (como muchos los son) y Usted "recorta"
bordeando la región de su interés con un cuadrado, el área recortada será mas
de lo que Usted marcó a los efectos de mantener elaspecto de región rectangular.
Las opciones de redimensionar y la de encoger, como se mencionó previamente,
las cuales aplican a todas las pistas, inlcuso si están desarmadas porque esto cam-
bia a todo el formato de la sesión. Una última nota de interés, este recorte es
fotogramaclaveable.
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Figure 2.15: El menú de recorte y el rectángulo delineado en la lado derecho

A continuación se describe un uso paso a paso fácil de seguir de la herramienta de
recorte.

• Habilite la herramienta de corte en la ventana del compositor para mostar el
menú emergente.

• Clic-arrastrar en el video para definir el área de corte, lo cual dibuja un rec-
tángulo en el video.

• Clic-arrastar en el video para iniciar un rectángulo diferente en su lugar.

• Clic-arrastar n una esquina del rectángulo para reposicionar esa esquina.

• Alt-clic en el rectángulo de corte para trasladar el rectángulo a una posición
diferente sin redimensionarla.

• El menú emergente de recorte permite el ingreoso de coordenadas (X1, Y 1)
y el ancho y alto (W, H) que definen el rectángulo de recorte.

• Elija una de las 3 opcionese, Reformatear, Redimensionar o Encoger.

• Cuando tiene el rectángulo donde Ustedd lo quiere, clic en el botón Aplicar
en el menú para realizar realmente la operación de recorte.
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2.3 La ventana Visor

La ventana Visor (figura 2.16) es conveniente para previsualizar sus multimedia
y clips. También puede ser utilizada para edición con cortes y después para op-
eraciones de pegado en la línea de tiempo o para crear un clip. Tiene botones de
transporte para utilizar de la misma manera que en las ventanas de Programa y
del Compositor o Usted puede, rápidamente, moverse sobre el multimedia arras-
trando con el BIR en la línea de tiempo sobre los botones de transporte.

Figure 2.16: Ventana Visor - note la flecha verde/blanca del "Reproducir" a la izquierda de
001484

Para poder ver los multimedia, Usted tiene que cargarmos de la siguiente manera:

1. En la ventana Recursos, resaltar la carpeta "Medios Multimedia" o la carpeta
Clips.

2. Arrastar un archivo de la carpeta hacia el Visor.

3. O doble clic con BIR en un activo multimedia.

4. O BDR en un activo resaltado para que emerjan las opciones y clic en Visor o
Ver en una nueva ventana.

Note que Usted puede tener abiertas múltiples ventanas Visor con diferentes o
con el mismo activo multimedia. Después de que el multimedia es cargado, Usted
puede utilizar los botones de transporte para reproducir, rebobinar, para parar,
etcétera, o para una rápida vista previa arrastrando con el BIR en cualquier lugar
en el deslizador de la línea de tiempo. Unas pocas opciones más disponibles en
la ventana Visor pueden ser accedidas con un clic en el BDR en la pantalla. Estas
funciones se enumerean a continuación.
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1. Cambie a pantalla completa eligiendo Pantalla completa. Para regresar, clic
otra vez con el BDR en la plantalla y elija Ventana.

2. Cambie le tamaño de la pantalla eligiendo la función Zoom para seleccionar
un nivel de acercamiento 25%, 33%, ... 300%, or 400% del tamaño original
del multimedia.

3. Para eliminar los multimedia actuales de la visualización, elija Cerrar origen

El Visor utiliza las configuraciones del tamaño del formato de salida del proyecto
para mostrar el multimedia en lugar del formato original del activo. Operaciones
realizadas en el Visor afectan a una LDE temporal o a un clip en lugar de la línea de
tiempo. Por defecto, la ventana Visor está automáticamente disponible pero si es
accidentalmente cerrada, Usted puede volver a abrirla usando el menú desplegable
Ventana → Mostar Visor para volver a desplegarla. Mas detalles de edición en
la ventana Visor con el método Edición en Dos Monitores es explicado en 5.3.

2.4 Opciones en ambas ventanas, Compositor y Vi-
sor

Las siguientes secciones describen capacidades que están disponibles en ambas
ventanas, Compositor y Visor.

2.4.1 Clic para Reproducir en Visor y Compositor

En ambas ventanas, Visor y Compositor, hay una flecha a la dercha de los otros
botones en el panel de edición como se muestra en la figura 2.16. El botón "re-
producir" puede ser conmutado encendido/apagado via esta flecha, que tiene una
información de herraminta de Clic para reproducir. Cuando está habilitada, hay
una sombra verde alrededor de la usual flecha roja.3 El propósito de habilitar esta
capacidad es para hacer realemente fácil reproducir el multimedia en la ventana
solo utilizando el botón izquierdo del ratón para iniciar o parar la reproducción.
¡La supreficie completa del lienzo principal se convierte en un gran boton de repro-
ducción! Aunque por defecto inicialemente está apagado, una buena razón para
habilitar esto, al menos temporalmente, es para que Usted pueda previsualizar
rápidamente su video antes de renderizar.

clic izquierdo avanza la reproducción o para la reproducción si se está repro-
duciendo

rueda del medio avance o retroceso de un único fotograma
3el color y el aspecto serán diferentes para otros temas distintos al tema por defecto Cakewalk
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click boton del medio reproducción en reveresa o para la reproducción si se está
reproduciendo. Tenga en cuenta que algunos ratones no adminten el clic del
medio para retroceso, pero puede averiguarlo probando desde una ventana
de terminal con el comando xev.

2.4.2 Barra de Tiempo + uso de la región de vista previa en
Compositor y Visor

El Visor y el Compositor, cada uno tiene un área de control de la barra de tiempo
con una línea indicadora debajo de la salida del video. La barra de tiempo muestra
todo el tiempo cubierto por el programa. Cuando un activo de video es cargado
en la ventana principal y se nueve en el compositor, el punto de inserción en la
ventana principal reflajará esos movimientos. Sin embargo, este no es el caso con
el visor. En el visor, solo se muestra este específico multimedia y no hay correspon-
dencia de movimientos en la línea de tiempo.

Ambos, el Compositor y el Visor soportan etiquetas y punteros de entrada/salida,
los cuales son mostrados en la línea de tiempo. Y como con los movimientos,
cuando Usted utiliza las etiquetas o los punteros de entrada/salida en la barra de
tiempo del compositor, el resultado se reflejará en la barra de tiempo de la ventana
principal. Junto con esto, por supuesto, cuando se mueve a una etiqueta o a un
puntero de entrada/salida en la barra de tiempo del compositor, irá a esta posición.

La barra de tiempo en el compositor y en el visor puede ser utilizado para definir
una región conocida como la región de vista previa La región de vista previa es la
región en la línea de tiempo a la que afecta el deslizador. Utilizando una región
de vista previa dentro de todo el programa y utilizando el deslizante dentro de
la región de vista previa, usted puede, muy precisamente y relativamente rápido,
buscar en el compositor y el visor. La región de vista previa puede ser esencial-
mente útil cuando usted tiene largas piezas de multimedia previsualizando una
sección, después moverse a la siguiente sección.

La región activa de vista previa es la zona entre las barras del borde. El rango
completo de la acción del puntero del deslizador de la ventana se reduce a la
región de vista previa activa. Para utilizar esto, ajuste la region de vista previa
activa como un periodo de interés del multimedia. Ahora el direccionamiento de
la barra de tiempo con el ratón solo funciona como si la barra de tiempo estuviera
ampliada a la escala de la zona activa de la vista previa. Esto tiene el efecto de
ampliar la zona interesante del multimedia en términos del direccionamiento del
punteero del ratón, para un ajuste fino.

Para crear y utilizar una región de vista previa, presione el botón derecho del ratón
dentro de la línea de tiempo, en cualquier extremo de la misma, cerca del borde

61



2.4. Opciones en ambas ventanas, Compositor y Visor

Figure 2.17: La flecha sobre el botón de transporte coloreado verde "reproducir hacia ade-
lante" está en la barra de tiempo.

hasta que vea el cambio tamaño del puntero. Mientras mantiene presionado el
botón derecho del ratón, arraste la flecha desde el extremo hacia la mitad de la
línea de tiempo hasta que tenga el área deseada designada. El deslizador será de
un color rojo oscuro mientras la región de vista previa seleccionada se mantendrá
en el mismo color negro. Hay un puntero que cambia de tamaño a izquierda o
derecha y Usted puede cliquear y arrastar en cualquier dirección para expandir o
contraer la región.

Figure 2.18: Una flecha hacia la izquierda, en la parte derecha de la barra deslizable azul,
usada para arrastrar la barra.

Figure 2.19: Aquí puede ver la flecha a la derecha usada para arrastrar la barra deslizable
del otro extremo. El área negra interior es la actual área de vista previa.

Usted puede desplazar la zona de vista previa hacia la izquierda o derecha pre-
sionando el botón derecho del ratón sobre la zona de vista previa donde verá una
flecha gorda de doble punta. El área seleccionada se moverá a la izquierda o
derecha según dónde la arrastre y mantendrá el mismo tamaño-

Figure 2.20: Note la flecha gorda de doble punta en el área de vista previa utilizada para
mover la selección.

Ajustes:

1. Si no hay región de vista previa fijada en la línea de tiempo, el aumento de
la longitud del multimedia, insertando o agregando, no tiene efecto en la
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región de vista previa no seleccionada. Es decir, no verá aparecer de repente
un deslizador azul de forma misteriosa.

2. Si está fijada una región de vista previa, cuando Usted reemplaza el proyecto
actual o el archivo, la región de vista previa se deshabilita automáticamente.

3. Si está fijada una región de vista previa, cuando Usted agrega datos o cambia
el tamaño del proyecto actual, la región de vista previa puede parecer que se
mueve, se encoge o crece dependiento del nuevo tamaño del multimedia en
la línea de tiempo.

4. Para deshabilitar la región de vista previa, Usted tendrá que arrastrar ambas
barras deslizables, la de la derecha y la de la izquierda, completamente hacia
su correspondiente extremo de modo que ya no hay ningún deselizador rojo
visible.

Una buena manera de tomar ventaja de la región de vista previa se describe aquí.
En el lienzo de la pista principal, desplácese hasta el principio del área de interés.
Cuando Usted hace esto, Usted verá en el compositor, la línea indicadora roja en
esta ubicación. Ahora, en la ventana del compositor, arrastre con clic derecho
desde el extremo izquierdo de la barra de tiempo para crear la barra deslizante
rojo oscuro hasta el indicador rojo. Vuelva al lienzo de la pista principal, mueva
hasta la ubicación del área donde quiera terminar ver y otra vez verá la línea roja
indicadora en el compositor. Utilice el botón derecho del ratón desde la derecha
para parar en este punto final. Utilizando este método es frecuentemente mas fácil
que el continuo movimiento de un solo cuadro que puede ser tedioso.

Una última nota interesante – algunas veces Usted puede desear ver solo un poco
mas allá del límite de la región de vista previa, ¡Y Usted pued hacerelo! En re-
alidad, puede moverse fuera del espacio de la ventana del compositor o visor, al
menos hasta llegar al hasta el final del espacio del monitor.

2.5 Ventana Recursos

Efectos, transiciones, etiquetas, clips, proxy, binarios del usuario y los activos mul-
timedia son accesibles desde aquí. La mayoría de los recursos son insertados en el
proyecto arrastrándolos fuera de la ventana de recursos. La gestión de la ubicación
de los recursos también se realiza aquí.

La ventana de recursos está dividida en dos áreas (figura 2.21). Un área lista
las carpetas y el otro área lista el contenido de las carpetas. Llendo dentro de
la lista de carpetas y cliqueando en una carpeta, actuliza el área de contenido
con el contenido de esa carpeta. Las carpetas puden ser mostradas como ícono
o texto. Hay algunas variaciones para mostrar el contenido; seleccione Mostar
texto, Mostrar íconos, Mostrar íconos empaquetados, Mostrar lista de íconos como
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Figure 2.21: Las carpetas están en la primer columna con los contenidos de estas carpetas en
el lado derecho

formas de mostrar los activos o los complementos. Utilice la letra "V" para recorrer
fácilmente a través de las opciones y ver la que prefiera. También puede tener estas
opciones desde el menú con un clic derecho en la ventana.

Una opción de Buscar está disponible para cada una de las carpetas en la ventana
Recursos (y cuando utiliza Adjuntar efecto en el lienzo de la pista principal para
los complementos). Como Usted tipea en caracateres, una coincidencia es hecha
con esta subcadena. Los nombres que no coinciden son filtrados haciendo mucho
mas fácil encontrar el ítem que está buscando. Los caracteres pueden estar en
cualquier lugar dentro de la frase y no importa si son mayúsculas o minúsculas.

Otras opciones que puede ver si Usted cliquea con botón derecho del ratón en la
carpeta de lo cual emerege el menú descripto a continuación.

Cargar archivos para la conveniencia de cargar los archivos igual que desde la
ventana principal, para no tener que mover el ratón tan lejos en el caso de
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tener varios monitores.

Mostrar texto/íconos como se describió previamente por preferencia de varia-
ciones de formato.

Seleccionar las opciones son Todo, Utilizados, No Utilizados y Ninguno. Esto le
da la capacidad de tener un grupo de contenido resaltado para facilitar su
uso y así poder ver lo que está o no resaltado.

Ordenar ítems para ordenar alfabéticamente el contenido de la carpeta. Espe-
cialmente útil si accidentalmente Usted hace un arrastre y cambia de idea o
lo suelta de repente, así este activo no luce muy bien alineado.

Copiar/Pegar lista de archivos utilizado para copiar facilmente un grupo de archivos
o pegar un grupo de archivos entre CINELERRA-GG y otros programas o sis-
temas operativos Windows.

Instantánea / Captura de pantalla utilizada para tomar una instantánea o para
capturar un área específica de la pantalla. Estas funciones son descriptas con
mas detalle en la sección 2.5.6).

Cliqueando con el botón derecho del ratón para emerger un menú en el área de
la carpeta, Usted puede además cambiar desde Mostar texto a Mostar íconos, Or-
ganizar ítems y crear, borrar y manipular las carpetas/binarios definidos por el
usuario. Seleccionar una Carpeta para crear una carpeta de usuario o modificar
una carpeta existente.

Si Usted cliquea con el botón derecho del ratón sobre un recurso resaltado/selec-
cionado, algunas opciones están disponibles dependiendo si el recurso es un efecto
o transición o una pieza de un multimedia. Usted puede resaltar algunos para mas
opciones, así esto es aplicable a todos ellos, como información. Lo listado inmedi-
atamente abajo son las elecciones disponibles para los recursos multimedia.

Info provee una información básica del Activo; detalles están descriptos mas ade-
lante en esta sección.

Mostar texto/íconos igual a lo mencionado previamente.

Ordenar igual a lo mencionado previamente.

Reconstruir índice Si Usted cambia desde/hacia utilizando ffmpeg/nativo, Usted
debería reconstruir índices. O si Usted tiene cuelgues en los multimedia o en
pistas de aspecto extraño, puede que quiera reconstruir los índices.

Ver utilice esta opción para emerger el multimedia en una ventana Visor.

Ver en una nueva ventana a los fines de no sobreescribir la ventana Visor actual,
Usted puede abrir cualquier número de ventanas Visor para ver simultánea-
mente múltiples multimedia.
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Abril mezcladores cuando Usted graba con múltiples cámaras, puede trabajar
con ellas fácilmeente utilizando el modo mezclador. Esto está descripto en
detalle.

Pegar

Ajustar... Si Usted necesita cambiar los parámetros de su multimedia, Usted puede
elegir los siguientes: Ajustar la velocidad de fotogramas, Ajustar tamaño del
proyecto, Ajustar todo.

Eliminar utilizado para Eliminar el activo del proyecto o, con precaución, para
Eliminarlo permanentemente del disco.

En el caso de los efectos o transiciones, cliqueando con el botón derecho del ratón
en una selección resaltada lleva a un botón de Info que otorga una corta línea de
descripción sobre para qué puede ser utilizado el efecto/transición. Para Etiquetas,
las opciones son Editar Etiqueta e Ir a. Para clips, Anidar, Desanidar, como se
describe mas adelante.

2.5.1 Detalle de información de activo

La ventana Info del activo también puede ser utilizada para mostar infomación
detallada acerca del archivo multimedia seleccionado/resaldado – disponibe para
cualquier multimedia cargado del tipo mpeg o ffmpeg. Esto es extremadamente
útil para determinar qué tipo de multimedia es, tamaño, resolución, formato y
tipo/número de flujos de audio. Es especialente útil para programas de múltiples
flujos. Puede hacere que la ventana de información aparezca simultáneamente en
varios de sus activos.

Entrelazado de activos es el tipo de entrelazado que los activos tienen: Si el archivo
es de tipo (H)DV, el reconocimiento y la configuración es automática. Todos los
demás tipos de multimedia se ajustarán a desconocido. Así, tendremos que ajustar
manualmente el entrelazado 4.

La figura 2.22 muestra la caja de Detalle para cliquear a la izquierda y una simple
típica salida de Detalle de Activo en el lado derecho. Además, note el multimedia
resaltado en la ventana Recursos.

2.5.2 Carpetas/Binarios del usuario

La creación de carpetas que son mas específicas para un proyecto particular, es
mas útil en la mejor organización de su trabajo. Esto puede hacerce utilizando
los archivos ya cargado en la carpeta maestra de Multimedia y Clips en la ventana

4Del correo de ubuntu de Igor
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Figure 2.22: La caja “Detallle”

Recursos. Abajo hay algunos pasos ilustrando una manera fácil de configurar una
carpeta.

1. En la ventana Recursos (figura 2.23), en la ubicación de los efectos de Video/Au-
dio y carpetas de Multimedia, emergiendo el menú desplegable Carpeta. . . al
cliquear con el botón derecho del ratón. Resaltar, despúes clic en Nuevo Mul-
timedia o Clip.

2. En el menú emergente Nueva carpeta, como se muestra abajo (figura 2.24),
tipee el nombre de su carpeta en la caja de texto. Cliquee Ok.

3. Seleccione la carpeta maestra Multimedia para ver qué archivos están actual-
mente cargados, figura 2.25. Resaltar los archivos que quiera copiar hacia la
nueva carpeta (nombrada Photos of Garden). Arratre los archivos hacia la
izquierda y cuando ve que la carpeta Photos of Garden se ilumina, entonces
los arroja ahí. Usted puede arrastrar y arrojar cualquiera de los multimedia
desde la carpeta maestra en cualquier momento. Parpadea cuando se colocan
exitosamente.
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Figure 2.23: Resaltar, después clic en "Nuevo Multime-
dia o Clip". “Modificar carpeta” puede ser usado para
cambiar el nombre de una carpeta. “Borrar carpeta” en
el menú puede ser usado para borrar una carpeta.

Figure 2.24: Tipee su nombre de
carpeta en la caja de texto. Cliquee
OK.

Figure 2.25: La carpeta “maestra” Multimedia

Agregando la tecla Mayús antes de arrojarlo, permitirá rutas relativas de archivos
en lugar de rutas absolutas. Pero tal vez quiera incluir o eliminar algunos multi-
media que existen en una de las carpetas que ya ha creado. En este caso, Usted
querá cliquear en Modificar carpeta en menú emergente. Cuando aparece la ven-
tana Modificar Carpeta, si Usted ya tiene archivos en esa carpeta, Usted verá los
filtros que fueron generados automáticamente cuando Usted arrastró y soltó.

Para borrar la lista entera de archivos filtrados, resalte la línea del filtro y presione
el botón Supr. Para agregar una nueva regla de filtro, cliquee en el botón Agregar,
el cual agrega automáticamente una línea por defecto después de cualquiera de
las líneas actuales. La línea por defecto será una línea que coincide con todo
en la carpeta maestra Multimedia, la cual es Or Patrones Iguales *. Clic con el
botón derecho del ratón debajo de la columna de encabezado para ver las opciones
disponibles para cada columna.
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Aquí está el fil-
tro que fue gener-
ado con el soltado
original

Cuando cliquea en la
parte del Valor de este
filtro, aparece todo el
conjunto de archivos
cubiertos por las reglas
del filtro. Ahora puede
resaltar un nombre de
archivo de destino que
le gustaría remover y
solo elimine la línea y
marque el botón verde
para OK.

Figure 2.26: Objeto de modificación

Las modificación no tendrán efecto mientras Usted no haga clic en el botón verde
OK o cliquee en el botón Aplicar. Pero una vez que Usted aplica, cliqueando en
el botón X rojo no de desharán sus cambios. Los filtros/reglas de búsqueda son
aplicados en el orden listado en la ventana de Modifcar carpeta. Usted puede
cambiar el órden de las reglas de filtro resaltándo la regla que quiere mover y
después arrastrar y soltar en la nueva ubicación.

La figura 2.27 de abajo muestra las opciones disponibles para cada campo.

Información acerca de las columnas y reglas para búsquedas filtradas en la sigu-
iente ventana de carpeta modificada.

Encabezado de columna:

Activar Esta columna es utilizada para designar el estado de esa regla de filtro

Off deshabilita el filtro
And estrecha su búsqueda, todos los términos buscados deben estar pre-

sentes
Or amplía su búsqueda para incluír mas valores
And Not excluye términos que no contienen el valor dado de los resultados

de búsqueda
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Figure 2.27: Las opciones disponibles para cada campo

Or Not incluye términos que no contengan el valor dado de los resultados
de búsqueda

Objetivo – esta columna designa qué atributo del activo multimedia mirar

Patrones cada línea contiene un filtro de nombre de archivo, coincide la
ruta de archivo

Tamaño de archivo cantidad de bytes en un archivo
Tiempo fecha en que fue creado el archivo
Tipo de pista tipo de pista de video, audio o audio video (para ambos)
Ancho ancho del formato
Alto alto del formato
FPS Tasa de fotogramas por segundo del video
Muestas Hz Tasa de muestreo de audio
Canales Número de canales de audio
Duración Tiempo de reproducción en segundos – utiliza el mayor en el caso

que contenga ambos, audio y video

Op – operadores boleanas para estrechar o ampliar las relaciones entre sus térmi-
nos de búsqueda.

en torno a acerca de este valor, utilice +radio para una búsqueda por rango:
[objetivo-radio. . . objtivo+radio]
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Igual == igual a
Mayor o igual >= mayor o igual a
Mayor > mayor que
No igual != no igual a
Menor o igual <= menor o igual que
Menor <Lt menor que
Iguales coincidencia exacta de las cadenas

Valor — la característica que Usted está buscando con expresiones que pueden ser
escritas con lo siguiente:

Número (se permiten puntos decimales y serán estandarizados):

inf representando el infinito
#[TtGgMmKk ] — donde # representa un número y los caracteres signifi-

can:
inf = infinito

T = 1099511627776
t = 1000000000000

G = 1073741824
g = 1000000000

M = 1048576
m = 1000000
K = 1024
k = 1000

Escalar:
Número
Número+Número

Fecha hora:

fecha = año/mes
fecha = año/mes/día
hora = hora:minuto
hora = hora:minuto:segundo

fecha_hora = fecha hora

Duración:

día = #día | #días
semana = #semana | #semanas

mes = #mes | #meses
año = #año | #años

delta = segundos
delta = mins:segs
delta = horas:mins:segs

En torno al tiempo: fecha hora+duración
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En torno a la longitud: duración+duración

Tabla mostrando el uso permitido:

objetivo: | == >= > != <= < == en torno a
++++++++++++++++++++++++++++++++++++++++++++++++++++++++

,→
patrones | <---- cadenacomparada ---------> + filtro + cercano
Tam_Arch | <---- aritmtico -------+------> + radio
Modif_en | <---- aritmtico -------+------> + radio
Tipo_pista | <---- member test ------+--------+------>
ancho | <---- aritmtico -------+------> + radio
alto | <---- aritmtico -------+------> + radio
FPS | <---- aritmtico -------+------> + radio
muestreo | <---- aritmtico -------+------> + radio
canales | <---- aritmtico -------+------> + radio
durac. | <---- aritmtico -------+------> + radio

donde en lo superior, el filtro puede ser:

filtro = lista
filtro = token
lista = [token]
lista = [token]lista

cadna = <caract>|<vacio>
token = cadena
token = cadena*token

Ejemplo con algunas advertencias primero:

1. Or generalmente incluye o añade, mientras que And generalmente excluye o
sustrae.

2. Los filtros solo funcionan con los multimedia en las carpetas; si no hay mul-
timedias, entonces no hay nada que buscar.

3. Los ejemplos a continuación no están destinados para ser ejecutados como
una lista de filtros en Modificar carpeta, son solo unas simples líneas de ejem-
plo para mostrar qué puede funcionar.

4. Ordenar por nombre de archivo base (ruta de directorio no incluídas au-
tomáticamente) excepto cuando la operación en torno a es utilizada y de-
spués es ordenada por el objetivo distancia primero y después por su nombre
de archivo.
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Table 2.1: Ejemplos

Activar Objetivo Op Valor significa

Or Patrones Coincidencias *
se incluyen todos los
archivos de la carpeta
Multimedia

And Not TamañoArchivo < 160000000
sin archivos con menor
de 160MB

Or Not Tiempo >= 2018/07/30 06:13:00
archivos no mayores o
iguales a la fecha

And Duración == 01:00
archivos incluídos
deben tener una
duración de 60 segs

Off Muestreo != 44000
apagado por ahora,
pero puede que desee
incluirlo mas tarde.

And FPS en torno a 24+1

todos los archivos in-
cluídos tienen de 24 a
25 fotogramas por se-
gundo

Or Patrones Coincide [*.mp4]
todos los archivos con
extensión mp4

Or Tiempo en torno a
2018/08/02 06:00:00
+ 02:00:00

archivos de 4AM a 8
AM

2.5.3 Vicons & Aicons – alias Íconos de Video / Íconos de Audio

Vicons son íconos de video. Aicons son íconos de audio. Por defecto, la ventana
Recursos reproducirá los primeros 5 segundos de video o audio en bucle en el
área ocupada por los íconos multimedia (figura 2.28). Esto está habilitado en
las carpetas Multimedia/Proxy en modo íconos cuando el puntero del ratón está
dentro de la ventana Recursos.

Figure 2.28: Modo "Reproducción completa" y Vicons y Aicons en la carpeta Multimedia

La forma de onda en la figura 2.29 es mostrada en la ventana Recursos en color
verde para las 3 pistas de audio. Hay una barra coloreada en la parte superior de
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cada a-icon donde el color está basado en el espectro de colores – cuanto menor
sea la duración en tiempo, mas rojo será el color, después, a medida que aumenta
la duración, el color aumentará, así pasará a verde, luego a amarillo, luego a azul,
luego a realmente oscuro, luego púrpura para los archivos de audio de 1 hora
y mas. Hay varios otros colores entre esos colores así como se ven abajo, en el
espectro de colores en la captura de pantalla. Los colores son utilizados desde la
rueda de tonos el sentido contrario a las agujas del reloj. Note esa línea horizontal
en el medio del a-icon, es amarilla/roja representando las 2 pistas de audio y es
solo roja para mono.

Rueda de tonos de colores. A modo ilus-
trativo.

Figure 2.29: Dibujos Vicons | Captura de pantalla muestra varias longitudes de archivos de
audio, rojos son mas cortos.

Note que si en Ajustes → Preferencias bajo la pestaña Apariencia, tiene sin
marcar Utilizar miniaturas en ventana recursos, Usted solo tendrá íconos por de-
fecto y no las capacidades de arriba.

2.5.4 Modo vista previa en ventana Recursos

El modo vista previa puede ser utilizado para abrir una ventana la cual dibuja
las miniaturas vicons/aicons en un tamaño mas grande. El modo vista previa o
dibujar vicons es una característica útil de CINELERRA-GG que le permite ver u oir
los primeros 5 segundos del video para propósitos identificarorios. El conmutador
de modo vista previa/reproducción está a la derecha de la etiqueta de Visibilidad
como se ve en la captura de pantalla de arriba. El modo vista previa está disponible
para los Multimedia, Proxy, Multimedia de los usuarios y Clips pero los clips son
solo 1 imagen.
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Cuando Vista previa/dibujar vicons está habilitado/activo, si Usted cliquea en uno
de los íconos de video o en un ícono de forma de onda de audio, se abre una
vista que incrementa 4 veces el tamaño del área de superficie. Esto hace fácil para
ver u oir si es el multimedia que está buscando, en caso de que tenga algunos
archivos multimedia similares. Para conservar memoria, se almacena en 8 bits por
pixel lo cual resulta en una imagen de baja resolución, mientras que el audio es de
16 bit. La razón de reproducir 5 segundos de video para un vicon es que hasta el
primer I-frame, los multimedia frecuentemente no se decodifican correctamente.
En otras palabras, muchos de los multimedia no inician en el punto de inicio y no
serán renderizados correctamente hasta que se hayan leído suficientes datos para
ensamblar una imagen. Usted puede incrementar el tamaño de la miniatura, clar-
idad de pixeles (tamaño de memoria) y modo de color pero esta toma mucha mas
memoria. Cambie estos valores en Ajustes → Preferencias, pestaña Aparien-
cia, a la derecha de la sección Diseño – tenga precaución cuando cliquee en OK,
su sesión se reinicializará. Usted también puede incrementar temporalmente la
mini-ventana de vista previa con el uso de la rueda del ratón, arriba y abajo.

Hay 4 opciones para el modo vista previa.

1. Reproducción completa es el modo por defecto. Esto significa que todos los
multimedia se reproducirán automáticamante cuando el ratón esté en la ven-
tana Recursos y Usted puede utilizar el botón izquierdo del ratón para cliquear
en un multimedia específico para verlos en una ventanita visora mas grande.
Solo los archivos de audio no se reproducen hasta que el ícono es cliqueado
y el aicon con la forma de onda entra en modo 4x mas grande. Reproducción
completa incluye las capacidades de ratón encima como se describe abajo así
como la función Src Target de la Entre-Vista.

2. El modo Sin reporducción es espcialmente útil en computadoras pequeñas
y para los usuarios que encuentran distrayente a la reporducción en bucle
constante.

3. El modo ratón encima es activado con un simple clic en uno de los vicon-
s/aicons y desactivados con otro simple clic sobre cualquiera de los íconos.
Una vez activado, en cualquier momento que nueva el ratón sobre un ícono,
este automáticamente mostrará la previsualización in tamaño incrementado.
La primera vez en su sesión que habilite esta caracterísita, tomará unos pocos
segundos para cargar todas las previsualizaciones de los íconos en memoria,
sea paciente, solo espere. El modo ratón encima hace fácil y rápido de pre-
visualizar sin tener que arrastar el multimedia hacia un visor. Puede seguir
arrastrando los multimedia igual que sin la vista previa activada.

4. El modo Src Target le da un fácil acceso a la entre-vista del objetivo origen
disponible usando el botón medio del ratón en el multimedia. Hay dos ven-
tajas en este modo – no hay reproducción en bucles de 5 segundos que ocupe
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tiempo de CPU y la ventana emergente permite el uso de la letra "f" en esta
ventama emergente para que pase a moso pantalla completa. El modo Src
Target, en cualquier escenario, nunca reproduce sonido ya que esto es un uso
sin sentido. Después del clic inicial en el multimedia en este modo, Usted
tendrá la característica ratón encima.

Para cualquiera de las opciones, excepto sin reproducción, Usted puede apagarla
tempralmente a esta opción cliqueando en el botón con el botón del medio del
ratón. Esto ayuda a evitar tener las miniaturas entre el camino de arrastar u otras
funciones. Cuando Usted lo hace, se dibujá una línea sobre el modo de vista previa
actual, para que Usted sepa que está en el modo sin reproducción hasta que vuela
a hacerle clic.

Note que si en Ajustes → Preferencias, bajo la pestaña Apariencia, Usted
tiene sin tildar Usar miniaturas en la ventana recursos solo tendrá íconos por de-
fecto y no previsualización activa.

Figure 2.30: La ubicación de los modos Vista Previa/Dibujar
íconos.

Figure 2.31: Note la línea
sobre el modo.

2.5.5 Moviendo clips/multimedia desde/hacia ventana de Re-
cursos

Si usted tiene cargados varios archivos multimedia en la ventana de Recursos en
una instancia de CINELERRA-GG y quiere cargar algunos de los mismos en otra
instancia o solo quiere listarlos para gardarlos en un archivo para usarlos mas
tarde, Usted puede realizarlo con este conjunto de pasos:

Copie o pegue una lista de archivos en la ventana de Recursos Multimedia:

1. cree una selección resaltada de los archivos multimedia deseados en la ven-
tana Recursos

2. clic con el botón dereecho en una parte no utilizada de la ventana para que
emerja el menú

3. seleccione el ítem Copiar lista de archivos y un cuadro de lista de archivos
aparecerá conteniendo la ruta completa de los nombres de archivos
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4. limpie el cuadro de texto utilizando su modo estandar de copiar/pegar para
poner la lista de archivos en memoria intermedia.

5. en otra instancia de CINELERRA-GG, elija el Pegar lista de archivos de la ven-
tana Recursos multimedia.

6. pegar la lista de archivos, otra vez, utilizando su método estandar, en el nuevo
cuadro de lista de archivos, presione OK

7. la barra de estado de la ventana principal será actualizada a medida que
la lista de archivos se cargue en la carpeta de multimedias (el propósito de
mostar el estado es simplemente para mostrar que la carga está en progreso
normalmente.).

Ovbiamente esta característica Pegar lista de archivos significa que Usted puede
crear una lista de archivos fuera de CINELERRA-GG utilizando un editor, limpiar
los nombres y después usar Pegar lista de archivos para cargarlos en la ventana de
Recursos multimedia.

Es importante tener en cuenta en los pasos de arriba, que las capacidades de copiar
y pegar en el Sistema Operativo, utilizadas en los pasos 4 y 6 son distintos a los
atajos c/v de CINELERRA-GG. Como el procedimiento varía entre las distros, Usted
tendrá que adaptarse específicamente al suyo. Por ejemplo, el uso en Ubuntu
consiste en:

4. Ctrl-c para copiar la lista de archivos, abra gedit, Ctrl-v para pegar la lista de
archivos dentro de gedit

5. Ctrl-c o la manera estandar de hacer clic con el botón derecho para copiar
esta lista desde gedit

6. Ctrl-v pega la lista de archivos en un nuevo cuadro de lista de archivos y
presione OK

En la figura 2.32, una instancia de CINELERRA-GG tiene 3 ítem en el área resaltada
Multimedia donde copiar la lista de archivos. Note cómo incluye la ruta completa.

En esta captura de pantalla, en otra instancia de CINELERRA-GG, hay solo 2 ítem
pero el cuadro Pegar lista de archivos está listo para tener los ítem insertados via el
método estandar de pegado en la caja de texto. Cuando está lista, los 6 archivos
multimedia adicionales estarán disponibles también en la otra instancia.

Otro posible uso de esta capacidad:

1. Botón derecho en la ventana Recursos Clips y utilice la opción Pegar Clip para
pegar la selección de Copia como un clip.
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Figure 2.32: Ejemplo sobre copiar una lista de archivos

2. De forma similar, resaltando un clip en la ventana Recursos y seleccionando
su ítem de menú emergente de copia, utilizando el botón derecho del ratón,
esa copia en memoria intermedia ahora puede ser cargada dentro de la línea
de tiempo.

2.5.6 Instantánea / Captura de pantalla

Para tomar una instantánea, realice los siguientes pasos:

1. estableza la marca de inserción en la línea de tiempo donde quiera la instan-
tánea – este fotograma se muestra en el compositor.

2. clic con botón derecho en un punto vacío de la carpeta multimedia y el menú
desplegable muesta Instantánea como el 5to ítem hacia abajo

3. ilumine esto y el subnemú aparecerá permitiéndole elegir png, jpg, ppm o tiff

La instantánea mostrada en la carpeta Multimedia. Es guarda por defecto en /tmp
como

snap_día-hora.ext PERO Usted puede cambiar la ruta del directorio por defecto
en Ajustes → Preferencias → pestaña Interfaz, a la derecha del sector
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Figure 2.33: Instantánea, menú y opciones
Figure 2.34: Réticula de la Captura de imá-
genes y el cuadro naranja

Edición.

Captura de Pantanlla es el 6to ítem del menú. Una retícula circular roja puede ser
movida en el área a caputurar, utilice el botón izquierdo para arrastrar para rodear
un área y clic derecho para capturar.

2.6 Otras opciones y otras ventanas

2.6.1 Controles de transporte

Los controles de Transporte son usados para la navegación y para la reproducción
de medios. Cada uno de los Visores, Compositor y ventana de Programa, tienen su
propio panel de Transporte. Todos los controles generalemente tienen una ayuda
de hereramienta coloreada de amarillo cuando Usted para el ratón sobre el control,
proveyendo una pista sobre su función y el atajo de teclado para su uso.

El panel de transporte es controlado por el teclado tan bien como con la interfaz
gráfica. Para cada una de las operaciones que lleva a cabo, la posición de inicio es
la posición del punto de inserción en la ventana de Programa y el deslizable en el
Compositor y las ventanas Visor. La posición final es el final o el comienzo de la
línea de tiempo o el final o el comienzo de la región seleccionada, si la hay.

La orientación del final o el comienzo depende de la dirección de reproducción.
Si es hacia adelante, la posición es el final de la región seleccionada. Si es hacia
atrás la posición final es el inicio de la región seleccionada. El punto de inserción
se mueve siguiendo la reproducción. Cuando la reproducción para, el punto de in-
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serción se queda donde paró la reproducción. Por lo tanto, reproducciendo hacia
atrás Usted cambia la posición del punto de insercción. La interfaz de teclado, ya
sea teclado numérico o las teclas alternativas, tienen mas velocidad con el agre-
gado de Avance lento (2) y Retroceso lento (5). Presionando dos veces cualquier
tecla en el teclado lo pone en pausa. La sección de atajos de teclado de este manual
así como Comandos de Shell desde la ventana principal de CINELERRA-GG tienen
un listado para cada una de las teclas.

Cuando se utiliza funciones de avance de fotograma, el comportamiento puede
parecer extraño. Si Usted avanza fotograma hacia adelante y después avanza
fotograma hacia atrás, el fotograma mostrado no cambia. Esto esto porque la
posición de reproducción no es el fotograma sino el tiempo entre dos fotogra-
mas. El fotograma renderizado es el área que cruza a la posición de reproducción.
Cuando Usted incrementa el tiempo entre dos fotogramas en uno y se disminuye
en uno, se cruza el fotograma ambas veces y de esa manera se muestra el mismo fo-
tograma. Hay una opción en Ajustes → Preferencias, pestaña Apariencia
para Mostrar siempre el fotograma siguiente que puede ayudar a aclarar esto para
algunos usuarios.

El comportamiento de transporte cambia si Usted mantienen presionado Ctrl al
emitir cualquiera de los comando de transporte. Esto hace que el punto de partida
sea el punto de Entrada si se reproduce hacia adelante y el punto de Salida si
se reproduce hacia atrás. Si se reproduce hacia adelante, el punto de Salida se
convierte en el punto final y si se reproduce hacia atrás, el punto de Entrada se
convierte en el punto final. Si no hay puntos de Entrada/Salida especificados, el
comportamiento recae en utilizar el punto de inserción y los límites de la pista
como puntos de inicio y final.

El comportaminto de transporte también cambia si Ustd presiona la tecla Mayús
junto con la telas del panél numérico 1–6. Si normalmente se incluye el audio en
la reproducción, será quitado y si normalmente no se incluye en la reproducción,
será agregado.

2.6.2 Barra de zoom

El compositor tiene capacidad de Zoom. El menú desplegable, abajo, en la ven-
tana del compositor, tiene un número de opciones de zoom. Cuando se ajusta a
Auto, el zoom del video es ajustado para coincidir con el tamaño de la ventana,
tanto como sea posible. Cuando el video está ampliado mas grande que el tamaño
de la ventana, Usted puede utilizar las barras de desplazamiento para explorar
alrededor o si el ícono de zoom está habilitado, el botón cental del ratón se puede
utilizar para acercar y alejar el video.
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El cambio de zoom también hace que la ventana del compositor entre en modo
zoom. En modo zoom, cliqueando en la salida del video, esta se amplia, mientras
que agregando la techa Ctrl al hacer clic en la salida, el video se reduce. Acercando
o alejando con la herramienta Zoom no modifica la salida de renderizado. Es
solamente para escudriñar el video o ajustarlo en el escritorio. Reproducir el video
en el compositor está a una escala distinta al 100%, el tamaño original, requiere
que CINELERRA-GG haga pasos extras. Esto puede afectar a la preformance en
sistemas lentos.

2.6.3 Mostrar superposiciones

Los códigos de color de las curvas de los fotogramas clave son una gran carac-
terística en la ventana de Mostrar supereposiciones porque cambiando los colores
para adapatarse al usuario, ayuda a eliminar confusiones por múltiples curvas en
el lienzo de las pistas. Ellas pueden ser vistas desde el menú desplegable de Ven-
tana→ Mostrar supereposiciones pero funcionan de la misma manera que cuando
se utilizan desde el menú desplegable Ver. Los Códigos de color de las curvas de los
fotogramas clave tienen asociados distintos colores para cada tipo para una fácil
identificación. Cliqueando con el BIR en la Bola de color a la derecha de cualquier
tipo de fotograma clave en el menú de Mostrar superposiciones, Usted tiene la ha-
bilidad de cambiar los colores al que sea que mejor funcione para su video. El
cambio de colores de las bolas hará que sean retenidos a través de las sesiones.

Hay una línea separando los primeros 4 ítem, que son solo valores configurables
del tipo no-automático, en contraposición a tipo auto de los fotogramas clave.
El color no es cambiable para los 3 ítem de Modo, Panorámica y Máscara que
simplemente muestran sus íconos simbólicos.

La figura 2.35 mustra la ventana emergente Mostrar Superposiciones con todas sus
opciones y tipos de códigos de color como ser, amarillo para Velocidad, azul para
Cámara Z. Una vez que cliquea en la bola de color asociada que está a la dercha de
cualquier tipo de fotograma clave, por ejemplo Fundido/Volumen en la captura de
pantalla, la ventana con la rueda de la paleta de colores emergerá y Usted podrá
manipular el color como lo desee.

La figura 2.36 muestra algunas líneas con código de colores para diferentes fo-
togramas claves a lo largo, con la manipulación del deslizador de desvanecimiento.
El deslizador está en el mismo color que el código de color que la línea del tipo de
fotograma clave como en la ventana Mostar superposiciones.

Superposiciones de matices de ventana:

La ventana supereposiciones es una alternativa al menú desplegable Ver del lienzo
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Figure 2.35: Ventana Mostrar superposiciones a la izquierda con la ventana de Color de bola
a la derecha para ajustar el color

Figure 2.36: Las líneas son coloreadas aquí, en la línea de tiempo como se designa en Mostrar
Superposiciones

de la pista principal y por lo tanto el orden se mantiene mayormente para que coin-
cidan entre sí. Para que sea mas fácil tener una rápida vista temporal de una opción
específica, hay un atajo de Mayús-BIR (botón izquierdo del ratón) que puede ser
utilizado en lugar de tener que desmarcar todo lo que está marcado manualmente
y luego tener que volver a marcarlo cuando haya terminado. Aquí hay una lista de
cómo trabajan. Tenga en mente que si si está habilitado el Expansor en la pachera,
aún verá la pista.

• Mayús-BIR (botón izquiredo del ratón) en la ventana Superposiciones en una
casilla de verificación desactivará todos los demás, excepto en la que Usted
está. Entonces, esta casilla con nombre tendrá un punto caliente.

• Mayús-BIR en este punto caliente se enfriará a las configuraciones previas con
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todas las casillas de verificación tildadas otra vez.

• Mayús-BIR en un punto no-caliente simplememente marcará o desmacará una
casilla y no será estado previo.

• Esto funcionará totalmente en conjunto con le menú desplegable Ver, por
supuesto sin puntos calientes.

• Salvedad #1 - Mayús-BIR en las 4 opciones de arriba, Activos, Títulos, Tran-
siciones, Complemento de Fotogramas Clave apagarán todas las casillas de
verificación debajo porque tiene sentido hacerlo.

• Salvedad #2 - Mayús-BIR en los Auto no apagarán Activos, Títulos, Transi-
ciones, Complemento de Fotogramas Clave porque Usted necesita poder ver
qué está ocurriendo.

• Salvedad #3 - La activación/desactivación de XYZ de la Cámara y el Proyector
no son afectados.

2.6.4 Ventana de medida de nivel de Sonido

Una ventana adicional, la ventana de niveles, puede ser traída a colación desde
el menú desplegable Ventana. La ventana de niveles muestra el nivel de salida de
audio después de todas las mezclas. El rango visible del nivel medidor del sonido
es configurable desde Ajustes→ Preferencias, pestaña Interfaz debajo de la sección
Operaciones.

El medidor de nivel de sonido puede ser conmutado en las ventanas visor y com-
positor con el botón Mostrar medidores. Estos además aparecen en la pachera
cuando una pista es expandida y en el monitor de grabación cuando se graba au-
dio.

Los niveles de sonido en la ventana niveles, el compositor y el visor corresponden
con los niveles de salida final antes de que sean enganchados al rango de la tarjeta
de sonido. En el monitor de grabación son los valores de entrada desde la tarjeta de
sonido. En la pachera son el nivel de sonido de cada pista después de procesados
todos los efectos y antes de mezclar para la salida. El mayor tiempo, los niveles de
audio tienen marcaciones numéricas en dB, pero en la pachera no hay suficiente
espacio.

El nivel de sonido está codificado por colores como una forma adicional de de-
terminar el nivel de sonido. Incluso sin las marcas numéricas, el color del nivel
de sonido puede distinguir entre varios rangos y sobrecargas. Mirar los códigos
de color en un medidor con marcas numéricas para ver qué color coresponde con
qué nivel de sonido. Entonces, para medidores en la pachra, en pistas de audio
expandidas, utilice los código de color para ver si hay sobrecarga.
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Figure 2.37: Ajustes origi-
nales — punto frio

Figure 2.38: Vea el punto
caliente en la caja Títulos

Figure 2.39: XYZ de
Cam/Proy alternado para
ajuste fino

Figure 2.40: Ventana Medi-
dor de Niveles de Sonido

Tenga cuidado que los niveles de sonido en CINELERRA-
GG pueden ir por debajo de 0 dB. Esto permite no solo
ver si una pista está sobrecargada, sino cuánta informa-
ción se está perdiendo en la sobrecarga. Sobrecargando
por menos de 3 dB es usualmente aceptado. Mientras
que la sobrecarga se trata como números positivos en
CINELERRA-GG, se recorta a 0 cuando se envía a una
tarjeta de sonido o a un archivo.

84



CHAPTER 3

Atributos del proyecto y los
multimedia

Cuando Usted reproduce archivos multimedia en CINELERRA-GG, los archivos mul-
timedia tienen un cierto número de pistas, tamaño de fotograma, tamaño de mues-
tras y así. No importa qué atributos tenga el archivo multimedia, es reproducido
de acuerdo con los atributos del proyecto. Así, si la tasa de muestreo de un archivo
de audio es diferente a los atributos del proyecto, será remuestreado. De forma
similar, si el tamaño de fotograma de un archivo de video es distinto a los atributos
del proyecto, el video es compuesto en un cuadro negro, recortado o bordeado de
negro.

Los atributos del proyecto son ajustados en Ajustes → Formato (figura 3.1) o
pueden ser creados en Archivo → Nuevo. Cuando Usted ajusta los parámetros
del proyecto en Archivo → Nuevo, una nueva línea de tiempo vacía es creada.
Cuando Usted ajusta los parámetros en Ajustes → Formato, los multimedia en la
línea de tiempo se mantienen sin cambios. Pero cada línea de tiempo creada desde
este momento utilizarán los mismos ajustes.

Figure 3.1: Ventana de Ajuste de Formato - Note la posición de los Canales de Audio
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En suma a los ajustes estandar para tasa de muestreo, tasa de fotograma y tamaño
de fotograma, CINELERRA-GG utiliza algunos ajustes menos tradicionales como la
posición de los canales, el modelo de color y la relación de aspecto.

La lista de decisiones de edición, la LDE almacenada en XML, guarda los ajustes del
proyecto. Los formatos que contienen multimedia pero no decisiones de edición,
solo agregan datos a la pista. Tenga en mente detalles como si la tasa de muestreo
de su proyecto es 48 kHz y Usted carga un archivo de sonido con 96 kHz, Usted
lo estará reproduciendo a 48 kHz. O si Usted carga un archivo LDE a 96 kHz y la
tasa de muestreo actual del proyecto es 48 kHz, Usted lo cambiará a 96 kHz.

La ventana del Nuevo Proyecto tiene algunas opciones que son diferentes que en
la ventana Ajustar Formato, como Usted puede ver comparando la figura de ar-
riba 3.1 con la figura 3.2. Lo mas notable son el campo para una ruta de directorio
y un Nombre de Proyecto.

Figure 3.2: Ventana de diálogo Nuevo Proyecto

La explicación sobre varios campos se describe a continuación.

3.1 Atributos de audio

Preajustes: seleccione una opción desde este menú para tener todos los ajustes
del proyecto establecidos como uno de los estándares conocidos. Algunas de
estas opciones son 1080P/24, 1080I, 720P/60, PAL, NTSC, YouTube y CD de
audio.

Pistas: (solo en menú de Nuevo Proyecto) ajustes de número de pistas de audio
para el nuevo proyecto. Las pistas pueden ser agragadas o borradas mas
tarde, pero por conveniencia esta opción está en el menú del Nuevo Proyecto.

86



3.2. Atributos de video

Muestras Hz: ajusta la tasa de muestreo del audio. La tasa de muestreo del
proyecto no tiene que ser la misma que la tasa de muestreo del multime-
dia que vaya a cargar. El multimedia es remuestreado para coincidir con la
tasa de mustreo del proyecto.

Canales: ajusta el número de canales de audio para el nuevo proyecto. El número
de canales de audio no tiene que ser necesariamente el mismo que el número
de pistas.

Posición de canales: los canales de audio actualmente habilitados y sus posi-
ciones en las cajas de panorizaciones de audio en la pachera de la pista son
mostradas en este complemento de posición de audio de la ventana Ajus-
tar Formato. Usted puede ver esta pantalla del lado izquierdo en la figura
de arriba 3.1. La posición de los canales no está en la ventana de Nuevo
Proyecto.
Los canales están enumerados. Cuando renderiza, la salida desde el canal 1
es renderizado en la salida de la primer pista en el archivo o el primer canal
de sonido de su tarjeta de sonido. Los siguientes canales son renderizados
hacia las salidas de las pistas numeradas consecutivamente. La posición de
los canales de audio corresponden con dónde cada pista de audio está local-
izada en el complemento de panoramización. La mas cercana a la posición
panorámica de una de las salidas de audio, es la que mas señal recibirá del
altavoz. Cliquee en un ícono de altavoz y arrastrelo para cambiar la posición
del canal de audio. Los altavoces pueden estar en cualquier orientación. Un
arreglo diferente de altavoces está almacenado para cada número de canales
de audio ya que no se desea una misma disposición de altavoces para difer-
ente número de canales.
La posición de los canales es el único ajuste que no afecta necesariamente a
la salida. Es simplemente una conveniencia, así, cuando son utilizados mas
de dos canales, los controles de panorámica en la línea de tiempo pueden
distinguirlos entre ellos. No tienen nada que hacer con el actual arreglo de
altavoces. Diferentes canales pueden ser posicionados juntos, muy cerca,
para hacerlos tener la misma salida.

3.2 Atributos de video

Pistas: (solamente en el menú Nuevo Proyecto) ajusta el número de pistas de
video asignadas al nuevo proyecto. Las pistas puden ser agregadas o borradas
mas tarde, pero las opciones son provistas aquí por conveniencia.

Tasa de fotogramas: ajusta la tasa de fotogramas del video. La tasa de fotogra-
mas del proyecto no tiene que ser la misma que la tasa de fotogramas de un
archivo multimedia individual que Usted carga. El multimedia será reajus-
tado para coincidir con la tasa de fotogramas del proyecto.
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Tamaño del lienzo: ajusta el tamaño de salida del video. Adicionalmente, cada
pista tiene su propio tamaño de fotograma. Inicialmente, el Nuevo Proyecto
crea pistas de video con tamaños que coinciden con la salida de video. El
tamaño de la pista de video puede ser cambiada mas tarde sin cambiar la
salida de video.

Relación de Aspecto: ajusta la relación de aspecto, esta relación de aspecto se re-
fiera a la relación de aspecto de la pantalla. La relación de aspecto es aplicada
a la salida de video. La relación de aspecto puede ser diferente a la relación

que resulta de la fórmula:
h
v

(el número de pixeles horizontales divididos

por el número de pixeles verticales). Si la relación de aspecto difiere del
resultado de esta fórmula de arriba, su salida será en un pixel no-cuadrado.

Auto relación de aspecto: si esta opción está marcada, el diálogo Ajustar For-
mato siempre recalcula los ajustes de Relación de Aspecto basado en el tamaño
del lienzo dado. Esto asegura simpre pixeles cuadrados.

Modelo de Color: el espacio de colores internos de CINELERRA-GG es X11 sRGB
sin perfil de color. CINELERRA-GG siempre cambia a sRGB cuando aplica fil-
tro o utilizando el motor de composición. Diferente es el caso para decodifi-
car/reproducir o codificar/salida; el proyecto será guardado en el modelo de
color de video que es seleccionado en el desplegable. El modelo de color es
importante para la reproducción de video porque el video tiene desventajas
de lento inicio comparados con el audio. El video es almacedado en disco en
un modelo de color, usualmente un derivado de YUV. Cuando se reproduce,
CINELERRA-GG lo descomprime directamente desde el formato de archivo ha-
cia el formato del dispositivo de salida. Si se procesan efectos, el programa
descomprime el video primero en un modelo de color intermedio y después
lo convierte en el formato del dispositivo de salida. La selección de un mod-
elo de color intermedio determina cuán rápido y preciso son los efectos. Una
lista de las actuales opciones de modelos de color, a continuación.

RGB-8 bit Asigna 8 bits para los canalese R, G y By sin canal alfa. Esto se
utiliza normalmente para multimedias descomprimidos con bajo rango
dinámico.

RGBA-8 bit Asigna un canal alfa al modelo de color de 8 bit RGB. Puede ser
utilizado para superponer múltiples pistas.

RGB-Float Asigna 32 bit flotantes para los canales R, G y B y sin alfa. Esto
es utilizado para procesado de alto rango dinámico sin transparencia.

RGBA-Float Esto agrega 32 bit flotantes para alfa al RGB-flotante. Es uti-
lizado para procesado de alto rango dinámico con transparencia. O
cuando no queremos perder datos durante el flujo de trabajo, por ejem-
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3.2. Atributos de video

plo en correción de color, extración de claves o seguiminto de movimiento.

YUV-8 bit Asigna 8 bits para Y, U y V. Esto es utilizado para operaciones de
bajo rango dinámico en los cuales el multimedia es comprimido en el
espacio de color YUV. La mayoría de los multimedia está comprimido en
YUV y esto deriva en que permite que el video sea procesado rápida-
mente con la menor degradación de color.

YUVA-8 bit Asigna un canal alfa para transparencia a modelo de color YUV
de 8 bit.

Para hacer efectos que involucran canales alfa, un modelo de color con un
canal alfa debe ser seleccionado. Estos son RGBA-8 bit, YUVA-8 bit y RGBA-
Float. Los modelos de color con 4 canales son mas lentos que los modelos
de color con 3 canales, siendo el mas lenteo RGBA-float. Algunos efectos
como desvanecimiento, trabajan alrededor de la necesidad de canales alfa,
mientras que otros efecto, como cromakey, requiere un canal alfa para ser
funcional. Así, para tener resultados rápidos, siempre es una buena idea
probar los efectos sin canal alfa para ver si funcionan antes de seleccionar un
canal alfa y hacerlo mas lento.
Cuando se utiliza material audiovisual comprimido, modelos de color YUV
son usualmente mas rápidos que colores de modelo RGB. También destruyen
menos colores que los modelos con colores RGB. Si un material audiovisual
almacenado JPEG o MPEG es procesado varias veces en RGB, los colores se
desvanecerán mientras que no se desvanecerán si se procesan en YUV. Años de
trabajo con material audivisual con alto rango dimámico han demostrado que
el punto flotante RGB es el mejor formato para alto rango dinámico. Enteros
de 16 bits que fueron utilizados en el pasado y eran con demasiada pérdida
y lentos para la cantidad de mejoras. RGB flotante no destruye información
cuando se utilza con material audiovisual YUV y además soporta brillo sobre
el 100 %. Tenga en cuenta que algunos efectos, como el Histograma, todavía
se cortan por encima del 100%̇ cuando están en punto flotante.

Modo de Entrelazado: esto es en su mayoría obsoleto en la moderna era digital,
pero puede ser necesitado por medios obsoletes como las emisiones de TV. El
entrelazado utiliza dos campos para crear un fotograma. Un campo contiene
todas las líneas impares de la imagen, la otra contiente todas las líneas pares.
Los campos entrelazados son almacenados alternando líneas para entrelazar
el material audiovisual fuente. Las líneas alternas que faltan en cada cuadro
de salida se interpolan.
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CHAPTER 4

Cargar, guardar y la LDE

Hay muchos formatos de archivos soportado que pueden ser cargados y render-
izados, esto es para decir, importados y exportados. El formato de archivo afecta
a lo que CINELERRA-GG hace con él. Algunos formatos de archivo son lentos para
mostrar en la línea de tiempo, especialmente los archivos altamente comprimi-
dos. Dibujar las miniatura de video, picons, en la línea de tiempo puede ser muy
lento. (Usted puede deshabilitar el dibujado de picons para ese archivo con el
conmutador dibujar medio en la pachera para acelerar las operaciones.

4.1 LDE — Lista de Decisiones de Edición

Cuando CINELERRA-GG guarda un archivo, guarda la LDE, Lista de Decisiones
de Edición, del proyecto actual, pero no guarda ningún multimedia. La lista
de Decisiones de Edición, mas comunmente referida como LDE, es generada por
CINELERRA-GG para el guardado de proyectos. La LDE contiene todas las configu-
raciones del proyecto y la ubicaciones de cada edición. En lugar del multimedia,
el archivo contiene punteros hacia el archivo multimedia original en disco. Los
archivos LDE son específicos de CINELERRA-GG.

Los archivos LDE generalemente tienen extensión .xml. El propósito de la LDE
es separar los multimedia de todas las operaciones de edición, así el multimedia
original se mantiene intacto. Cuando un archivo .xml es cargado, se realizan cam-
bios en los atributos del actual proyecto, basado en la LDE. La Lista de Decisiones
de Edición son archivos de texto, lo que significa que pueden ser editados en un
editor de texto. LDE y XML son usados indistintamente.

4.2 Formatos de archivo soportados

Básicamente hay 2 tipos de formato de archivo soportados, nativos y ffmpeg. Con
la adición de ffmpg, la mayoría de los formatos de archivo soportados los puede uti-
lizar a través del este paquete de terceros. Hay cientos de formatos de archivos de
ffmpeg y combinaciones de codificadores. Este conjunto de posibiliades incluyen
qt (quicktime), avi (audio-video intercalado), mp4, mp3, mov, mpeg, m2ts, ts,
wmv, mts, mpg, flv, mkv, webm, webp, ProRes y muchos mas.

90
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Los otros formatos soportados, refereridos como nativos, incluyen lo siguiente:
AC3, Apple/SGI AIFF, Sun/NeXT AU, FLAC , Microsoft WAV, Raw DV y PCM, MPEG
Audio y Video.

Imágenes fijas: JPEG/EXR/PNG/PPM/TGA/TIFF

Archivos MPEG: ¿Qué es un archivo MPEG? Un formato de archivo muy común
es MPEG porque trabaja con muchas cámaras y televisores. Video Mpeg2, una
secuencia de codec para archivos mpeg, es el formato mas cómun. Para leer este
formato, Usted necesita decodificar el flujo mpeg. Usted puede leer y escribir
mpeg nativamente. El codificado de video Mpeg es realziado separadamente de
la codificación de audio mpeg cuando se utiliza el formato nativo, lo que significa
que se requieren 2 pasadas y luego se tienen que mezclar juntos. Sin embargo,
si se utiliza ffmpeg, es renderizado en solo 1 pasada. DVD utiliza MPEG como lo
hace NTSC y Pal.

4.2.1 Trabajando con imágenes fijas

Las imágenes fijas son reproducidas desde 1 a cualquier número de veces, una y
otra vez, no tienen duración. Usted puede cargar imágenes fijas en las pistas de
video de la manera que le gusta como lo hace con los archivos de video. Una vez
cargados en la pista, utilice la fecha hacia abajo en la línea de tiempo, así Usted
puede ver un solo fotograma. Para extender el largo de la imagen, arrastre sus
bordes justo como lo hacía con un video multimedia regular. Usted puede arrastar
el borde de una imagen fija tanto como lo desee. Las imágenes en CINELERRA-
GG tienen la habilidad de ser arrastradas hasta una longitud infinita. Alternativa-
mente, Usted puede definir el largo inicial de las imágenes cargadas. El parámetro
es fijado en la sección Imágenes de la ventana Ajustes→ Preferencias→ Grabación

Mientras el material original venga de un origen digital utilizando su mejor resolu-
ción (como una cámara digital), lo primero que puede que tenga que hacer antes
de utilizarla es capturar de alguna manera los activos en un medio digital utiliz-
able. Para fotos antiguas, mapas de papel, dibujos o diagramas puede escanearlos
en un formato de archivo como PNG, TIF, TGA o JPG, utilizando un escaner digital.

Renderizar un video a una solo imagen causa que el archivo de imagen final se
sobreescriba para cada posición de la línea de tiempo. El archivo renderizado es
una única imagen fija del último fotograma del video.

4.2.2 Secuencia temporal de imágenes y animación

Las siguientes áreas cubiertas en esta sección son las siguiente: Formato de lista
de archivos como jpeglist y Image2ffmpeg.
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4.2. Formatos de archivo soportados

A los efectos de ser razonablemente rápido de utilizar, lo mas probable es que
quiera preparlos creando una secuencia de comandos y después cargarlos uti-
lizando este archivo de secuencia de comandos.

4.2.2.1 Formato de lista de archivos

Una secuencia de imágenes es una serie de imágenes fijas ordenadas; por ejem-
plo un manojo de fotos de una cámara, fotogramas de una escena animada, o
una serie de captura de fotogramas. Estas pueden ser cargadas como múltiples
archivos. Para una secuencia temporal de imágenes como el tamaño de las imáges
de la cámara se incrementan a 70 megabytes y mas, y mas imágenes pueden ser
almacenadas en una memoria portatil, mas cache, memoria y recursos del sistema
(como descriptores de archivos) son utilizados por CINELERRA-GG para cargar las
imágenes cuando Usted utiliza las estrategias de concatenar pistas o pegar en el
punto de inserción. Esto es un gran consumidor de tiempo y consumidor de recur-
sos cuando cada una de las imágenes es cargada y concatenada como ediciones,
y la reproducción es super pobre. Aquí hay una alternativa a la carga usual. Esta
técnica puedría ser muy útil justo para cargar un manojo de fotos de imágenes.

Los formatos de lista de archivos pueden ser utilizados de la misma manera para
la siguiente lista de tipos de Secuencia de archivos. La primera línea de la lista de
secuencia de archivos identifica la lista de codecs.

PNGLIST = *.png PPMLIST = *.ppm TGALIST = *.tga TIFFLIST = *.tiff
EXALIST = *.exa CR2LIST = *.cr2 JPEGLIST = *.jpg GIFLIST = *.gif

Utilizando el ejemplo de los jpeg, el tipo de archivo de secuencia de lista jpeg
es la manera fácil y rápida de acceder a una secuencia de imágenes jpeg como
un activo único. Primero, construya un archivo de secuencia jpeglist y nómbrelo
algo así como jpeglist.sh. Hay una secuencia de comandas de ejemplo sobre cómo
hacer esto en la sección Programas Auxiliares del Apéndice (C.2). Una vez que el
jpeglist.sh está construido, Usted puede correrlo de manera similar a esta línea:

$ jpeglist.sh /<ruta>/archivo.jpg /<ruta>/DSC*.jpg

Si la<ruta> es la misma en ambos archivos, entrada y salida, entonces archivo.jpg
es creado en el mismo directorio como un archivo de entrada, el directorio contiene
los activos completos y la lista de archivo utiliza rutas relativas, de lo contrario, si
el archivo.jpg está en otro directorio, el archivo de la lista contiene rutas absolutas.
Dado que esto escribe una lista de archivos como un solo activo, la memoria de-
mandada y el tiempo de acceso es mucho menos. Cuando Usted carga el archivo
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de salida en CINELERRA-GG, tendrá que ajustar Intentar con ffmpeg al último dado
que ffmpeg no trabaja con archivos de secuencia jpeglist.

Un ejemplo de archivo de salida tras correr la secuencia de comando recidiendo
en el directorio donde están los archivos DSC*.jpg, se muestra debajo.

Para utilizar esto, primero apague las pruebas de ffmpeg y abra timelapse.jpg
utilizando Archivo → Cargar archivos.

Listing 4.1: Ejemplo: timelapse.jpg

JPEGLIST
# First line is always JPEGLIST
# Frame rate:
29.970030
# Width:
6016
# Height:
4016
# List of image files follows
./DSC04948.jpg
./DSC04949.jpg
./DSC04950.jpg
./DSC04951.jpg
...(files in between)
./DSC04997.jpg
./DSC04998.jpg

4.2.2.2 Image2ffmpeg

El formato Image2file es un método alternativo para abrir una secuencia de imá-
genes via ffmpeg. Para hacer esto, cree 2 archivos en el mismo directorio como los
archivos DSC*.jpg llamados DSC0%04d.opts, and DSC0%04d.jpg. DSC0%04d.opts
deberá conterner las siguientes líneas, las cuales tendrán que ser modificada para
ajustarse a los requerimientos exactos de: duration, start_number, and frame_rate.

Listing 4.2: Ejemplo DSC0%04d.opts

loglevel=verbose
threads=auto
format=image2
codec=mjpeg
start_number=4948
frame_rate=29.97
duration=17.36
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Ejemplo del contenido del archivo DSC0%04d.jpg será solo una simple línea como
: JPEG. En este caso, asegúrese de que Probar ffmpeg primero está habilitado y
cargar DSC0%04d.jpg. Esto accederá a los multimedia utilizando ffmpeg lo cual
es lento, sea paciente.

4.2.3 Formato de imagen sin procesar de algunas cámaras dig-
itales y Orden de sondeo

Advertencia: Solo para uso de expertos. Imágenes sin procesar de las cámaras son un
tipo especial de archivo de imagen que CINELERRA-GG puede cargar. Dcraw, como
el usado por CINELERRA-GG, es un programa de computadora de código de libre
de Dave Coffin el cual lee muchos formates de imágenes sin procesar, típicamente
producidas por cámaras digitales de alta gama. Acutalmente alrededor de 700 de
los tipos de cámaras reconocidas se listan en:

https://www.cybercom.net/~dcoffin/dcraw/

Por ejemplo, está incluída la Canon Powershot SX60 (recientemente disponible
en Agosto de 2014). Debido a que ffmpeg intenta cargar cualquiera y todos los
archivos, es que está habilitado Probar ffmpeg primero. Hará primero un intento
de cargar archivos de imágenes sin procesar, antes de que cualquier otro contro-
lador de archivo tenga la oportunidad. Es posible que este dcraw pueda entrar en
conflicto con el formato estandar TIFF, ya que podría ser visto como un formato
tipo tiff-pipe. Por lo tanto es necesario específicamente habilitar CR2 y moverlo a
la parte superior o deshabilitar FFMPEG_Early y habilitar FFMPEG_late en la órden
de sondeo como se describe en otras secciones (4.3.3 and 8.1). Estos cambios de
ajustes se mantendrán entre sesiones de CINELERRA-GG en .bcast5. El modo Imá-
gen sin procesar de cámaras probablemente será utilizado por usuarios expertos
en cámaras.

La primer caputura de pantalla en la figura 4.1 como en Ajustes → Preferencias
→ pestaña ReproducciónA, el ajuste marcado por defecto de Interpolar imá-
genes CR2 y Balance de blanco imágenes CR2 los cuales muestran las imágenes sin
procesar en la manera que Usted espera. Sin embargo, puede que quiera des-
macarlas para asegurarse que ningún programa de manipulación ha modificado
sus imágenes para que pueda añadir complementos o realizar sus propias modifica-
ciones. Desmarcadas indican que las imágenes son lo mas parecido a las imágenes
sin procesar.

La segunda caputura de pantalla mostrando resaltado/habilitado CR2 para imá-
genes sin procesar en la pantalla de preferencias Órdenes.

La última captura de pantalla mostrando la información de activo en Recursos, el
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formato de archivo como Raw Camera.

Figure 4.1: Capturas para imáges RAW

4.3 Cargando Archivos

Toda la información con la que Usted trabaja en CINELERRA-GG es adquirida o
cargándola del disco o grabándola desde un dispositivo. Esta sección describe las
cargas. Para sacar a lucir la ventana Cargar, vaya al menú desplegable Archivo y
elija Cargar Archivos. (figura 4.2). A continuación Seleccionar archivo para cargar
y clic en OK (la marca verde) o Aplicar. Cuando Usted utiliza el botón Aplicar,
la ventana Cargar se mantiene activa para cargar archivos fácilmente mas tarde.
Dependiendo de la lista de cajas de los ajustes de Estrategia de Inserción, sus
archivos serán cargados directamente en la ventana Programa o en la ventana Re-
cursos multimedia. Si el archivo es una imagen estática, los atributos del proyecto
no se modifican y el primer fotograma de la pista será la imagen. CINELERRA-GG
usualmente contruye un archivo índice si es que no existe, a los fines de acelerar
su dibujado. Usted puede editar y reproducir el archivo mientras el índice está
siendo contruido.

Figure 4.2: Menú Cargar archivo. Note marca de verificación verde para OK y la opción del
medio Aplicar
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Para cargar un archivo, Usted necesitará:

1. ajustar la ruta de un directorio

2. elegir una selección de archivos

3. elegir una estrategia de selección para cargar el archivo

Una vez que Usted haya terminado de hacer sus selecciones y cliqueado OK o
Aplicar, por defecto tres cosas ocurren:

• El proyecto existente es limpiado de la pantalla.
• Los atributos del proyecto son cambiado para coincidir con los atributos del

archivo.
• Las muevas pistas de archivos son creadas en la línea de tiempo.

Veamos ahora en detalle las opciones de carga de archivos.

Estrategia de inserción CINELERRA-GG le permite cambiar lo que ocurre cuando
Usted carga un archivo. En la ventana de diálogo Cargar vaya a las cajas de
Estrategia de Inserción y seleccione una de las opciones en el menú desple-
gable. Cada una de estas opciones cargan el archivo de una manera diferente.

Reemplazar el proyecto actual: todas las pistas del actual proyecto son bor-
radas y un conjunto de nuevas pistas son creadas para ajustarse a los
archivos fuente. Los atributos del Proyecto son solo cambiados cuando se
cargan XML. Si se seleccionan múltiples archivos para la carga, CINELERRA-
GG agrega un conjunto de nuevas pistas para cada uno de los archivos.
Nuevos recursos son creados en la ventana Recursos reemplazando a los
actuales.

Reemplazar el proyecto actual y concatenar pistas: igual que reemplazar
el proyecto actual excepto que si son seleccioanados múltiples archivos,
CINELERRA-GG concatenará las pistas de cada archivo, en orden alfanumérico,
empezando en 0. Nuevos recursos son creados en la ventana Recursos,
reemplazando a los actuales. Los archivos van a través de la línea de
tiempo.

Para archivos de ffmpeg y mpeg, cuando la metodología de estrategia de in-
serción es elegida en el menú desplegable de Archivo → Cargar archivos
para Reemplazar el proyecto actual o Reemplazar el proyecto actual y concate-
nar pistas, los parámetros básicos del formato de sesión es reinicializado para
coincidir con el nuevo multimedia. Esto selecciona el activo por defecto y
determina su ancho, alto, duración, tasa de fotogramas, calcula el modelo
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de color y asume un pixel cuadrado para hacer una suposición inteligente ac-
erca de la relación de aspecto del video. Para el audio, la tasa de muestreo, la
duración del audio y el conteo de canales (mono, estereo o 5.1) son reinicial-
izados. Adicionalemente, el Tamaño de pista será computado y reinicializado
para coincidir con el nuevo multimedia cargado. Cuando utiliza tipos de es-
trategias de inserción que reemplazan, la nueva lista de activos son los únicos
multimedia en uso, de modo que esta actualización evita que el usuario tenga
que cambiar inmediatamente el formato de seción para que coincida con la
única posibilidad.

Agregar en nuevas pistas: el proyecto actual no es borrado y son creadas
nuevas pistas para los fuentes, un conjunto de pistas para cada archivo.
Son creados nuevos recursos en la ventana Recursos. Los archivos van
por las pistas.

Concatener a pistas existentes: el proyecto actual no es borrado y nuevos
archivos son concatenados a las pistas armadas existentes, insertadas en
el mismo conjunto de pistas del proyecto actual. Si el proyecto actual
tiene mas pistas que el origen, el archivo de origen será insertado en
el primer conjunto de pistas armadas. Si no hay pistas armadas, no se
insertarán los archivos. Nuevos recursos son creados en la ventana Re-
cursos.

Pegar en el punto de inserción: el archivo es pegado en la línea de tiempo
en el punto de inserción en el primer conjunto de pistar armadas. Si
múltiples archivos son seleccionados para cargar, estos serán insertados
en el mismo conjunto de pistas, una después de la otra. Nuevos recursos
son creados en la ventana Recursos.

Solo crear nuevos recursos: la línea de tiempo no es tocada y nuevos re-
cursos son creados en la ventana Recursos.

Secuencia anidada: activos anidados son agregados a la línea de tiempo
utilizando la estategia de inserción secuencia anidada. El archivo será
pegado dentro de la línea de tiempo sobre la actual selección o en el
punto de inserción. Una secuencia anidada es un multimedia que ya
está guardada en la LDE anteriormente. Vea la sección Anidando.

La estrategia de inserción es una recurrente opción en muchas funciones de
CINELERRA-GG. En cada lugar las opciones hacen lo mismo. Si Usted carga
archivos pasando argumentos de comandos de línea hacia CINELERRA-GG,
por defecto, los archivos son cargados con Reemplazar el proyecto actual.

Cargando múltiples archivos En el diálogo Cargar ir a la lista de archivos. La
selección de archivos utiliza el método de selección estilo de tema.

1. Seleccione un solo archivo resaltándolo.
2. Selecione múltiples archivos moviendose hacia otro archivo y selecciónelo

mientras presiona Ctrl. Esto selecciona un archivo adicional.
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3. O muévase hacia otro archivo y seleccionelo mientras presiona Mayús.
Esto selecciona todos los archivos entre medio.

Este comportamiento está disponibe en la mayoría de las listas. Es un método
especialmente útil cuando es usado con la estategia de inserción Concatenar
con pistas existentes para crear una presentación de imágenes o una lista de
canciones.

Cargando archivos desde el símbolo del sistema Otra vía para cargar archivos
es pasar lo nombres de los archivos como argumentos en la línea de coman-
dos. Esto inicia el programa con todos los argumentos cargados y creadas las
nuevas pistas para cada archivo. Por ejemplo:
{su_ruta_hacia_cinelerra} video1.mp4 video2.mp4

Encontrando archivos por extensión, sub-listas o con búsqueda Si hay demasi-
ados archivos en su directorio multimedia, puede resultar dificil de encontrar
el archivo que quiere. Por esta razón, la ventana Cargar permite que Usted
filtre cuáles archivos son mostrados en el listado por nombre de extensión.
Clic en el cuadro desplegable a la derecha de la caja de lista Especificar filtro
debajo de la caja de texto del nombre de archivo y seleccione la extensión
del archivo de su multimedia (por ejemplo: mp4, mov, mp3, avi, jpeg, etc).
Ahora la lista de archivos muestra solo los archivos con la extensión selec-
cionada. Quizás siempre mas fácil de usar el cuadro Buscar en la parte supe-
rior debajo de cuadro de listas Seleccionar archivos para cargar. Aquí Usted
puede tipear un caracter o una cadana para buscar.
Además puede tener una sub-lista de potenciales archivos para seleccionar.
Por ejemplo, Usted sabe que el archivo que busca empieza con la letra mayús-
cula "C". Si Usted tipea "C" en el cuadro de selección, inmediatamente debajo
de la lista de archivos, y después cliquea con el botón izquierdo del ratón, una
sub-lista de archivos comenzando con la "C" se muetran bajo el cuadro de se-
lección. Cliqueando con el botón derecho del ratón, cancela esta sub-lista.

Cargando copia de seguridad Es un archivo especial XML en el disco todo el
tiempo.
Después de cada operación de edición, CINELERRA-GG guarda el proyecto ac-
tual en una copia de seguridad en $HOME/.bcast/backup.xml. En un evento
de ruptura, lo primero que Usted debe hacer después de reiniciar CINELERRA-
GG es seleccionar Archivo → Cargar copia de seguridad a los efectos de car-
gar la copia de seguridad. Esto iniciará CINELERRA-GG en el punto de sus
operaciones de edición directamente antes de que el programa falle. Es im-
portante, después de un fallo, iniciar CINELERRA-GG sin realizar ninguna op-
eración de edición o Usted sobreescribirá la copia de seguridad. Note que el
archivo backup.xml es siempre un solo archivo, el cual supone que cuando
Usted está trabajando con dos instancias de CINELERRA-GG abiertas al mismo
tiempo, estas utilizan el mismo archivo de copia de seguridad. En este caso,
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la última operación realizada en cualquiera de las instancias sobreescribirá
la copia de seguridad.

4.3.1 Ordenar dentro de Ordenar en el diálogo Cargar Archivo

Cuando Usted utiliza el menú desplegable Archivo para cargar archivos, Usted
puede hacer un ordenamiento dentro de orden cuando cliquea en el encabezado
del cuadro etiquetado (figura 4.3). Esto es muy útil, por ejemplo, cuando Usted
quiere encontar el archivo mas pequeño con una extensión específica. En las cap-
turas de pantalla debajo, la primera ilustra el orden de Archivo por defecto; la se-
gunda muestra ahora ordenada por Tamaño; la tercera muestra cómo después de
ordenar por Tamaño, se clasifica por Extension. El orden por tamaño se mantiene
dentro del orden por extensión, así, c.d viene antes que a.d en el encabezado del
cuadro Archivo, porque el tamaño es mas pequeño.

Figure 4.3: Cargar - Ordenar por Nombre de Archivo, ordenar por Tamaño de Archivo y
dentro de Extension después de un previo orden por Tamaño

4.3.2 Formato de tamaño numérico mostrado en Cargar Archivo

Hay algunos botones de íconos en la parte superior derecha de la ventana Cargar.
Cada uno tiene una información sobre herramienta que explica para qué es. Usted
puede ver esto en la figura previa. Uno es para formato de tamaño de archivo. Hay
4 variaciones de representaciones numéricas para reportarle tamaño de archivo
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en el desplegable Archivo→ Cargar. Usted puede ver las opciones en la ventana
Cargar a la derecha de la línea superior en la que se lee Seleccionar archivos para
cargar (figura 4.4):

0 Est es el comportamiento actual y por defecto y muestra bytes al igual que el
comando ls -l.

b 3 dígitos significativos sufijador por minúsculas k,m,g,t,b para representar mang-
nitudes en 103 (1000)

B 3 dígitos significativos sufijador por mayúsculas para representar mangnitudes
en 210 (1024)

0, como la representación exacta por defecto pero con separadores de como para
una fácil lectura. Los puntos no pueden ser utilizados como separadores
debido al conflicto de localización con la codificación de ffmpeg.

Figure 4.4: Ventana Cargar con varios tamaños numéricos

4.3.3 Orden de sondeo cuando se Carga Multimedia

¿Por qué se menciona esto aquí? Se han escrito muchos programas cuyas fun-
cionalidades se superponen y es posible que Usted quiera asegurarse de que quiera
utilizar realmente se utilice. Con el tiempo, el que coincida primero, puede variar.
Ffmpeg es tan genérico que si su ajuste es Probar ffmpeg primero, este ciertamente
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intentará ser usado y dejará una pequeña chance de que otros métodos tengan
una chance. Algunos de los archivos controladores codec puede abrir una var-
iedad de multimedia y algunos de los métodos mas comunes pueden tener mas de
un archivo controlador que puede ser ser utilizado fácilmente para decodificar sus
archivos multimedia, por ejemplo Tiff. Para el uso especializado experto, cuando
Usted quiere garantizar que un método en particular ese utilizado, puede cambiar
el orden de sondeo. Utilice el menú desplegable Ajustes → Preferencias para
tener la pestaña Apariencia donde Usted puede ver una caja en la sección Opera-
ciones del lado izquierdo, llamada Orden de sondeo. Cliquee en la caja y utilice
arriba/abajo/cuadros habilitar para cambiar el orden del ítem que Usted tenga
resaltado (figura 4.5).

Arriba mueve el ítem 1 mas arriba (si el ítem es actualmente el superior, se moverá
al final)

Abajo mueve el ítem 1 mas abajo (similarmente, si es el último, se moverá al
principio)

Habilitar habrá una marca de verificación si está habilidado. Si Usted lo desha-
bilita, no será utilizado para sondear el multimedia para determinar qué es.
Doble clic con el botón izquierdo del ratón conmutará el estado del ítem
resaltado entre habilitado/deshabilitado. En ambos, FFMPEG primero/de-
spués está habilitados, el código FFMPEG podrá correr ambos si el er FFMPEG
falla (pero será el ¡2do!).

La configuración por defecto se ajusta para duplicar el comportamiento esperado
en el pasado con la excepción del método dehabilitado CR2 para imágenes sin
procesar de cámaras. Los cambios hechos en las configuraciones serán mantenidas
en el archivo .bcast5.

Figure 4.5: Tres ejemplos de la ventana Sondeo

Las capturas de pantalla muestran uno pocos primeros ítems de sondeo. Note
las flechas hacia arriba de la izquierda, significa habilitado. Llendo hacia abajo,
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mustra mustra las siguientes 2 páginas de posibles controladores de un total de
18.

El cambio de orden no tendrá efecto mientras Usted no haga clic en ambas mar-
cas de verficiación, de la ventana Probar y la ventana Preferencias. Cuando Usted
clicquea en el botón FF, el cual está en la esquina superior derecha de la página
principal para cambiar Probar FFMpeg primero/último, habilitando FFMPEG_Late
o FFMPEG_Early, conmutado de forma automática en Sondeo para coincidir con
esta elección pero no cambia su posición en la tabla. Asegúrese de solo hacer clic
en el botón FF sin tener abierta la ventana Sondeo para evitar resultados inesper-
ados. También es recomendado mantener FFMPEG_Early/FFMPEG_Late cerca de
la posiciones inicial/final. Hay un caso donde Usted querrá mantenere deshabil-
itadas todos los sondeos si Uster quiere forzar PCM – Modulardor de Código por
Pulso por su sigla en inglés. Este código siempre corre cuando todos los demás
sondeos fallan.

4.3.4 Sporte de selección de programas tras la carga.

Algunos tipos de multimedia tienen flujos de programas, como los mpeg captura-
dos desde flujos de tv. Por ejemplo, Usted puede ser capaz de sintonizar el canal
9, pero capaz de ver 9-1, 9-2 y 9-3 en su TV. Si Usted abre una captura de este
tipo de multimedia, todos los canales están presentes en la línea de tiempo. Para
seleccionar y ver solo un programa, Usted puede utilizar Alt-1 para seleccionar
el programa 1, o Alt-2 para seleccionar el programa 2, etc. hasta Alt-8. Esto
removerá todos las demás pistas relacionadas y reiniciará el formato. Esta carac-
terística puede ser utilizada siempre que haya solo un programa, presionando Alt-1
y el efecto será reiniciar el formato de la sesión hacia el formato del multimedia
sondeado. Tenga en cuenta que puede haber varios programas de audio asociados
al fujo del video, por ejemplo, puede haber diálogos en otro idioma o algún tipo
de diálogo descriptivo. Como siempre se selecciona el primer audio asociado, esto
puede que no produzca los resultados esperados.

Debajo hay capturas de pantalla ilustarando múltiples flujos de prorgama (fig. 4.6).
La captura de la izquierda es una ventana principal parcial mostrando un flujo de
multimedia/audio de una emisión de TV pre-grabada, con 3 progamas y varias
pistas de audio asociadas. La segunda captura del Detalle del activo provee infor-
mación detallada de cada uno de los flujos arrojados ejecutando la Información
Detallada tal como se explica en la sección Detalle de información de activo.

4.4 Guardando su trabajo

Usted puede guardar su trabajo como un proyecto, el cual está cargado ahora en
CINELERRA-GG, o como una exportación, la cual es todo el multimedia que Usted
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Figure 4.6: Flujo con múltiples programas e Información del Activo

necesita para reproducir el espacio de su trabajo.

4.4.1 Guardando achivos de proyectos.

Guardar archivos XML es útil para conservar el estado actual de CINELERRA-GG
antes de salir de una sesión de edición. CINELERRA-GG guarda los proyectos como
archivos XML. Hay unas pocas opciones que puede utilizar para guardar su trabajo
via el menú desplegable Archivo: Guardar, Guardar como. . . , Exportar proyecto,
Guardar copia seguridad. También puede sobreescribir un archivo existente o in-
gresar un nuevo nombre. CINELERRA-GG concatena .xml al nombre del archivo
automáticamente si es que la extensión .xml no fue dada.

Cuando CINELERRA-GG guarda un archivo, guarda la LDE del actual proyecto pero
no guarda ningún multimedia, es su lugar solo guarda punteros hacia los archivos
multimedia original. Para cada archivo multimedia, el archivo XML guarda una
ruta absoluta o solo una ruta relativa. Si le multimedia está en el mismo directo-
rio que el archivo XML, una ruta relativa es gudardada. Si está en un directorio
distinto, una ruta absoluta es guardada.

Usted deberá tener cuidado cuando mueve archivos para evitar rotura de los en-
laces a los multimedia. Usted puede mantener los multimedia y el archivo XML en
el mismo directorio por siempre y libremente mover el directorio completo, ya que
se guardan rutas relativas. Alternativamente Usted puede guardar el archivo XML
en un directorio diferente al de los multimedia, pero después no podrá mover el
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multimedia. En este caso Usted puede mover libremente su archivo XML, ya que
se guardan rutas absolutas. Si Usted guardó sus archivos XML en el mismo direc-
torio que su multimedia pero le gustaría mover la ubicación, Usted puede cambiar
las rutas de relativas a absolutas llendo a Archivo → Guardar como . . . e in-
gresando la nueva ubicación. Similarmente, si Usted guardó sus proyectos fuera
de su directorio multimedia, pero le gustaría mover su multimedia hacia otra ubi-
cación, Usted puede cambiar las rutas de absolutas a relativas llendo a Archivo
→ Guardar como . . . y guardar su archivo XML en el mismo directorio que el
multimedia.

Además pude reparar enlaces a multimedia rotos editando el archivo XML en un
editor de texto. Por cada multimedia que Usted movió, busque la vieja ruta y reem-
plácela con la nueva. Usted debería hacer una copia de seguridad de su archivo
XML antes de editarlo. Además, Usted puede remplazar la ruta de cualquier ac-
tivo del cual Usted haya movido el origen dentro el programa, ingresando la nueva
ubicación en la ventana de información del Activo. Para abrir esta ventana, botón
derecho en el activo en la ventana Recursos y elegir Info. . . en el menú desple-
gable. Directamente tipee la ruta en el pirmer campo del diálogo o clic en la lupa
de la derecha para navegar sus archivos. Operar desde la GUI1 es conveniente solo
cuando se necesitan un número muy pequeño de cambios.

Los efectos en Tiempo Real en un archivos XML tienen que ser recreados cada
vez que los reproduce. El archivo XML además contiene copia del origen de cada
activo en el disco, lo que ocupa espacio. Renderice sus proyectos a un formato
final para un almacenamiento mas persistente en la salida.

4.4.2 Exportar proyecto – Guardar o Mover el proyecto hacia
otra computadora

Una opción del menú Archivo, llamado Exportar Proyecto. . . está disponible (figura 4.7).
Aunque pude ser utilizada de la misma manera que la otra opción guardar, es muy
útil cuando es necesario mover el proyecto hacia otra computadora que tiene otra
estructura de nivel de directorio o si Usted quiere incluir subdirectorios para mejor
organización de sus archivos.

Originalmente la manera mas fácil de mantener un proyecto para moverlo a otra
computadora, fue poner todos los archivos en un único directorio sin subdirecto-
rios con el archivo de .xml de la LDE guardado. Esto es comunmente llamado una
estructura de archivo plana. Así, si el mutimedia estaba en el mismo directorio
que el archivo XML, se guardaba una ruta relativa. Si era un directorio diferente,
se guardaba una ruta absoluta.

1N.d.T. GUI=Interfaz Gráfica del Usuario
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Figure 4.7: Dialogo de Exportar Proyecto y las 3 opciones disponibles.

Definición de los campos:

Directorio del Proyecto nombre del directorio donde Usted quiere que el archivo
xml sea guardado. Solo se creará un subdirectorio en 1 nivel del directorio
definido. Tipos de opciones disponibles para guardar un proyecto:

Copiar todos los archivos son copiados al directorio del proyecto y el xml
guardado, al igual que el original plano. La opción es muy útil para
asegurarse que todos los archivos necesarios para ilustrar un problema
están disponibles para el análisis.

Simbólico son creados enlaces simbólicos para las rutas absolutas de los
multimedias en sus actuales ubicaciones.

Relatovos enlaces simbólicos son creados para rutas relativas de los multi-
media en su actual ubicación. Esta opción permite utilizar rutas relativas
sin los requerimientos de manterner una estructura de archivo plano y
lo hace fácil de mover hacia otra computadora.

Sobreescribir archivos cuado está marcado, si cualquier archivo con el mismo
nombre existe actualmente en el directorio, entonces será sobreescrito. En
cualquier caso, el llamado archivo XML siempre será sobreescrito.

Recargar proyecto cuando está marcado, después de la opción de guardar, el
nuevo proyecto guardado será cargado. Por defecto no se hace.

Recuerde mantener la integridad de su archivo xml de proyecto para un fácil
traslado a otra computadora, no borre los enlaces simbólicos. Usted querrá uti-
lizar cp -a para manterener los enlaces para moverlos a una llave USB o a otra
computadora.

4.4.3 Información acerca de Copias de Seguridad y Sesiones
Perpetuas

En un esfuerzo de minimizar pérdidas del trabajo debido a problemas del usuario,
equipo o del programa, CINELERRA-GG tiene una capacidad de hacer copias de
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seguridad automáticas.

CINELERRA-GG guarda automáticamente cada operación de edición del proyecto
acutal en el disco, continuamente en un archivo llamado $HOME/.bcast5/backup.xml.
En el improbable caso de un daño, cuando Usted reinicia CINELERRA-GG, Usted de-
berá seleccionar Archivo→ Cargar copia seguridad a los efecto sde continuar
con las operaciones que fueron grabadas antes del daño. Si Usted tiene mas de
una instancia de CINELERRA-GG corriendo, solo a última operación hecha en el
último caso, sobreescribirá la copia de seguridad.

Todavía hay 1 copia de seguridad mas que puede salvarlo. Si por alguna razón
Usted olvida utilizar Cargar copia de seguridad inmediatamente cuando reinicia
o Usted hizo una Caga con Reemplazar proyecto actual en su actual seción, Usted
tiene una segunda oportunidad de utilizar Archivo → Cargar y seleccionar $HOME/.bcast5/backup.prev
siempre y cuando no haya cargado un archivo diferente y no haya realizado ninguna
operación de edición. El mismo archivo es utilizado por múltiples instancias de
CINELERRA-GG

La Sesión perpetua es muy útil para trabajar en un proyecto por varios días,
así Usted solo tiene que salir antes de apagar y la próxima vez que Usted inicia
CINELERRA-GG volverá donde Usted dejó. Mantendrá todos sus deshacer y re-
hacer. El nombre del archivo binario es $HOME/.bcast5/perpetual.dat y siem-
pre y cuando Ajustes → Preferencias, la pestaña Apariencia tenga la bandera
Sesión Prepetua activa, esta capacidad toma efecto. Es muy importante entender
que esto no es lo mismo que la continua operación- de- edición- actualzación- del
archivo backup.xml. El archivo perpetual.dat es solo acutalizado cuando Usted
Sale de CINELERRA-GG en modo normal. Lo que supone que si Usted interrumpe
el programa o lo mata o hay un segv o fallo del sistema, el archivo perpetual.dat
solo reflejará el estado de su proyecto desde la últiva vez que inició CINELERRA-GG
y ninguna edición/deshacer/renacer fue ejecutado durante la sesión actual la cual
no terminó normalmente.

Algunas notas para recordar acerca de Sesión Perpetua son:

• Cuando Usted sale de una manera normal, no tiene que preguntarse si se
guarda o no una copia de seguridad.

• ocupa espacio de disco en el área del .bcast5 y este pude ser realmente
grande.

• después de que Usted completa un proyecto, es aconsejable que apague la
bandera de Sesión Perptua antes de salir, así cuando Usted inicia un nuevo
proyecto, puede iniciarlo con un fresco perpetual.dat encendiendo la bandera
o borre el actual archivo $HOME/.bcast5/perpetual.dat después de parar
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CINELERRA-GG.

• se hace copia seguridad solo de los datos de la sesión (no de los ajutes de
características del programa)

• los archivos backup.xml y backup.prev funcionarán igual que antes, de modo
que si hay un fallo, Usted querrá utilizar Archivo→Cargar copia seguridad
para poder continuar donde fue interrumpido.

• para iniciar CINELERRA-GG son utilizar datos de su Sesión Perpetua, utilice
ruta_hacia_su_cinelerra/cin/bin -S
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CHAPTER 5

Editing

Editing comprises both time and track space. The timeline consists of the time
certain media appear on the track going left to right and a set of tracks from the
top to the bottom. There are 2 methods of timeline editing – drag and drop editing,
also called arrow mode, and cut and paste editing or I-beam mode. Cut and Paste is
the default editing mode. An additional, but not often considered editing method
is called two-screen editing where the Viewer is used to view media and then the
desired clip from the media is transferred to the timeline.

The timeline is where all editing decisions are made (figure 5.1). This is a stack
of tracks in the center of the main window. It can be scrolled up, down, left and
right with the scrollbars on the right and bottom. It can also be scrolled up and
down with a mouse wheel, or left and right while holding down the Ctrl key and
using the mouse wheel.

Figure 5.1: Timeline editing session using the upcoming Cinfinity theme.

The active region is the range of time which is affected by editing commands on
the timeline. The active region is determined first by the presence of in/out points
on the timeline. If those do not exist the highlighted region is used. To reiterate,
highlighting is done in cut and paste mode by moving the insertion point with the
mouse in the timeline to where you want to start. Then hold down the LMB, drag
the mouse to where you want the end point to be and release the LMB. In drag
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and drop mode, the method to create a highlighted selection is to hold down the
Ctrl key and double click with the LMB with the mouse over that column.

If no highlighted region exists, the insertion point is used as the start of the active
region. Some commands treat all the space to the right of the insertion point as
active while others treat the active length as 0 if no end point for the active region
is defined.

Most importantly, editing decisions never affect source material meaning that it
is non-destructive editing. So not only does your original media stay completely
untouched, it is much faster than if you had to copy all the media affected by an
edit. Editing only affects pointers to source material, so if you want to have a
new modified media file at the end of your editing session which represents the
editing decisions, you need to render it. Saving and loading your edit decisions is
explained in the Load, Save and the EDL section and rendering is explained in the
section on Rendering.

In the following editing sections, references to common operations are scattered
within any of the modes where they seem pertinent. However, many of the editing
operations work in different modes.

5.1 The Patchbay

On the left of the timeline is a region known as the patchbay. The patchbay enables
features specific to each track as described next.

Textbox for naming the track. The default names will usually be Video #, Au-
dio #, or Mixer # if using the multi-camera/mixer operations. A # will be
designated for subsequent tracks as in 1, 2, 3 and so on.

Expander which is a down arrow on the right side, is for viewing more options on
the patchbay and for viewing the effects represented on the track. You can
just click on the expander to expand or collapse the patchbay and the track.
If it is pointing sideways, the track is collapsed. If it is pointing down, the
track is expanded. Existing effects appear below the media for the track.

Below the textbox name are several toggles referred to as attributes for different
features (currently there are 5 as shown in figure 5.2). If the toggle button is
shadowed by a color, the feature is enabled . If the toggle is the background color
of most of the window, it is disabled. Click on the toggle to enable/disable the
feature.
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Several mouse operations speed up the configuration of several tracks at a time.
Click on an attribute and drag the cursor across adjacent tracks to copy the same
attribute to those tracks. Hold down Shift while clicking a track’s attribute to
enable the attribute in the current track and toggle the attribute in all the other
tracks. Or you can:

1. hold down Shift while clicking an attribute,

2. click until all the tracks except the selected one are disabled,

3. then drag the cursor over the adjacent track to enable the attribute in the
adjacent track.

Figure 5.2: Patchbay

The attributes are described here next.

Play Track determines whether the track is rendered
or not. If it is off, the track is not rendered. For
example if you turn it off in all the video tracks, the
rendered media file will have only audio tracks. If
the track is chained to any other tracks by a shared
track effect, the other tracks perform all the effects
in this shared track, regardless of play status of the
shared track that in this particular case affects the
media output but not fade and effects.

Arm Track determines whether the track is armed or
not. Only the armed tracks are affected by edit-
ing operations. Make sure you have enough armed
destination tracks when you paste or splice mate-
rial or some tracks in the material will get left out.
In addition to restricting editing operations, the armed tracks in combination
with the active region determine where material is inserted when loading
files. If the files are loaded with one of the insertion strategies which do
not delete the existing project, the armed tracks will be used as destination
tracks.

Gang Fader cause the fader to track the movement of whatever other fader you
are adjusting by dragging either the fader or the curve on the track. It doesn’t
affect the editing made with menu controls. A fader is only ganged if the
arm track is also on. This is often used to adjust audio levels on all the tracks
simultaneously. Gang also causes Nudge parameters to synchronize across
all the ganged tracks.

Draw Media determines if picons or waveforms are drawn on the asset in the
track. You may want to disable this if you know that the media/format takes
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a long time to draw on the timeline. By default it is set to on in order to see
picons on the timeline.

Don’t send to output , more commonly called mute, causes the output to be thrown
away once the track is completely rendered. This happens whether or not
Play track is on. For example if you mute all the video tracks, the rendered
media file will have a blank video track. Mute track is represented on the
timeline with a line that has the default color of pink/orange. Use the pull-
down View → Mute to have the line displayed. It is a keyframable attribute,
but Mute track keyframing is a toggle and it has only the two values of on
or off. If a track is part of a shared track effect, the output of the track with
the shared track effect is overlaid on the final output even though it is routed
back to another track (the shared track). Mute track is used to keep the track
with the shared track effect from overlapping the output of the source track
(the shared track) where the shared track effect is not present.

Fader slider fade values are represented on the timeline with a pink curve that
is keyframable. All tracks have a fader, but the units of each fader depend
on whether it is audio or video. Audio fade values are in dB. They represent
relative levels, where 0 is the unaltered original sound level, -40 is silence, -80
the minimum value set by default. You can move fader and keyframes down
to -80 but the parameter’s curve won’t go below -40. For your convenience
you can set a different fade range with the curve zoom. Audio fader’s main
purpose is to fade out sound or to lower the sound level smoothly to silence,
or fade in to make sounds appear gradually instead of suddenly. Video fade
values are the percentage of opacity of the image in normal overlay mode,
the percentage of the layer that is mixed into the render pipeline in the other
overlay modes. Click and drag the fader to fade the track in and out. If it is
ganged to other tracks of the same media type, with the arm option enabled,
the other faders should follow. Hold down the Shift key and drag a fader to
center it on the original source value (0 for audio, 100 for video).

mixer in the expanded patchbay for that track designate the multi-camera mixer
mode.

Overlay mode in the expanded patchbay is used for porter-duff operations and is
full explained in Overlays chapter.

Nudge is in the expanded patchbay. The nudge value is the amount the track
is shifted left or right during playback. The track is not displayed shifted
on the timeline, but it is shifted when it is played back. This is useful for
synchronizing audio with video, creating fake stereo, or compensating for an
effect which shifts time, all without altering any edits (figure 5.3).
Enter the amount of time to shift to instantly shift the track. Negative num-
bers make the track play later. Positive numbers make the track play sooner.
The nudge units are either seconds or the native units for the track (frames
or samples). Select the units by right clicking on the nudge textbox and us-
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Figure 5.3: Video Overlay, audio Pan and Nudge.

ing the context sensitive menu. Nudge settings are ganged with the Gang
faders toggle and the Arm track toggle. Use the mouse wheel over the nudge
textbox to increment and decrement the value.

Pan is available in the expanded patchbay for audio tracks via a panning box.
Position the pointer in the panning box and click/drag to reposition the au-
dio output among the speaker arrangement. The loudness of each speaker
is printed on the relative icon during the dragging operation. The panning
box uses a special algorithm to try to allow audio to be focused through one
speaker or branched between the nearest speakers when more than 2 speak-
ers are used.

Press the Tab key while the cursor is anywhere over a track to toggle the track
arming status. Press Shift-Tab while the cursor is over a track to toggle the arming
status of every other track.

Automatic audio mappings Several convenience functions are provided for au-
tomatically setting the panning to several common standards. They are listed in
the Audio menu. These functions only affect armed audio tracks. They are:

Audio→Map 1:1 This maps every track to its own channel and wraps around
when all the channels are allocated. It is most useful for making 2 tracks
with 2 channels map to stereo and for making 6 tracks with 6 channels map
to a 6 channel sound card.

Audio→Map 5.1:2 This maps 6 tracks to 2 channels. The project should have 2
channels when using this function. Go to Settings → Format to set the
output channels to 2. This is most useful for down-mixing 5.1 audio to to
stereo (for more information refer to Configuration, Settings and Preferences
section 16.1.1).
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Standard audio mappings Although CINELERRA-GG lets you map any audio
track to any speaker, there are standard mappings you should use to ensure the
media can be played back elsewhere. Also, most audio encoders require the audio
tracks to be mapped to standard speaker numbers or they will not work.

In the channel position widget, the channels are numbered to correspond to the
output tracks they are rendered to. For stereo, the source of channel 1 needs to
be the left track and the source of channel 2 needs to be the right track. For 5.1
surround sound, the sources of the 6 channels need to be in the order of center,
front left, front right, back left, back right, low frequency effects. If the right tracks
are not mapped to the right speakers, most audio encoders will not encode the
right information if they encode anything at all. The low frequency effects track
specifically can not store high frequencies in most cases.

5.2 Manipulating Tracks

Tracks in CINELERRA-GG either contain audio or video. There is no special designa-
tion for tracks other than the type of media they contain. When you create a new
project, it contains three default tracks: one video track and two audio tracks. You
can still add and delete tracks from the menus. The Tracks menu contains a num-
ber of options for dealing with multiple tracks simultaneously. Each track itself
has a popup menu which affects one track.

Operations in the Tracks pulldown affect only tracks which are armed.

Move tracks up | Move tracks down shift all the armed tracks up or down the
stack.

Delete tracks deletes the armed tracks.

Delete last track deletes the last track, whether it is armed or not.

Concatenate tracks operation copies all the assets of every disarmed but playable
track and concatenates it by pasting those assets at the end of the first set of
armed tracks. They are pasted one after the other, keeping the same order
they have on the stack. If there are two armed tracks followed by two dis-
armed tracks, the concatenate operation copies the assets of the two disarmed
tracks and pastes them after the assets of the two armed tracks. If there are
three disarmed tracks instead, the assets of two tracks are pasted after the
assets of the armed tracks and the assets of the third track are pasted at the
end of the first armed track. The destination track wraps around until all the
disarmed tracks are concatenated. Disarmed tracks that are not playable are
not concatenated.

Append to project allows for creating new tracks after any existing tracks.
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Add subttl will add a track for subtitles at the top of the other tracks.

The Audio and Video pulldowns each contain an option to add a track of their
specific type. In the case of audio, the new track is put on the bottom of the
timeline and the output channel of the audio track is incremented by one. In the
case of video, the new track is put on the top of the timeline. This way, video has
a natural compositing order. New video tracks are overlaid on top of old tracks.

5.3 Two Screen Editing

This is a fast way to construct a program out of movie files (in other programs
is called three points editing). The idea consists of viewing a movie file in one
window and viewing the program in another window. Subsections of the movie
file are defined in the viewer window and transferred to the end of the program in
the program window. Two screen editing can be done simply by using keyboard
shortcuts. To get familiar with which keys to use, move the mouse pointer over the
transport panel and a tooltip appears, showing what key is bound to that button.

To begin a two screen editing session, load your media resources by using the main
menu File pulldown and choose Load files; make sure the insertion mode is set
to Create new resources only. This insertion strategy is to ensure that the timeline
stays unchanged while new resources are brought in. Go to the Resources window
and select the Media folder. The newly loaded resources will appear. Double click
on a resource or drag it from the media side of the window over to the Viewer
window.

Check to make sure there are enough armed tracks on the timeline to put the
subsections of source material that you want. Usually this would be one video
track and two audio tracks, but if there are not enough, just create new tracks or
arm more tracks.

Now to start your 2 screen editing, in the viewer window, define a clip from the
media file:

1. Set the starting point with the In pointer button. You will see a left hand
bracket on the timebar.

2. Move your cursor to the ending point of the clip you want to use.

3. Set the ending point with the Out pointer right hand bracket.

4. You will see a colored bar inside the brackets for easier viewing.

5. Drag the In/Out point with the mouse to conveniently change their position.
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These In/Out points define a clip. You can now use this in a couple of different
ways.

Splice The splice icon, or shortcut letter “v”, inserts the selected area in the time-
line after the insertion point. After the splice has taken effect, the insertion point
moves to the end of the edit ready to be used as the next splice location. This way
you can continuously build up the program by splicing. If an In point or an Out
point exists on the timeline the clip is inserted after the In point or after the Out
point. If both In and Out points are set on the timeline, the clip is inserted after
the In point. If there are edits after your chosen splice location on the timeline,
they will be moved to the right.

Overwrite The overwrite icon, or shortcut letter “b”, overwrites the region of
the timeline after the insertion point with the clip. If an In point or an Out point
exists on the timeline the clip is overwritten after the In point or after the Out
point. If both In and Out points are set on the timeline, the clip is inserted after
the In point. If a region is highlighted or both In and Out points exist they limit
the region of the overwriting and the clip may therefore be shortened. Here is a
detailed explanation to take advantage of this method.

To overwrite exactly on a precise region of the timeline:

1. Arm only tracks to change.
2. Define the destination region on the timeline with [ and ], the In and Out

points.
3. You can achieve maximum precision by setting the active region in the zoom

panel.
4. Define the clip you want to use in the viewer with [ and ], the In and Out

points.
5. Overwrite from Viewer to the timeline.

If the destination region is shorter than the clip defined in the viewer, the portion
of the clip longer than the destination region won’t be inserted and on the timeline
the following edits won’t move. If the destination region is longer than the clip
defined in the viewer, the destination region will shrink and on the timeline the
following edits will move to the left.

Clip The clip icon, or shortcut letter “i”, generates a new clip for the resource
window containing the affected region but does not change the timeline. Every
clip has an optional/default title and description.

115



5.3. Two Screen Editing

Copy The copy icon, or shortcut letter “c”, copies the selection into the copy
buffer.

5.3.1 Use Case – Working with Sequences

From the Viewer to the Timeline with the sequences imported in a Master Project.

A convenient methodology for working on a Master project along with 1 or more
previously saved Sub projects or sequences use case is described here. A sequence
is an edited assembly of audio and video clips generally consisting of a series of
videos that relate to the same activity. This use case explains how to work this way
and some things you need to be aware of.

1. First load your Master project, which you worked on and saved earlier as an
.xml file, using an Insertion strategy of Replace current project. Generally this
Master project consists of media with any of the attributes of clips, autos, pos-
sibly keyframes, and effects. You will see your project on the main timeline
and the Media files that are part of this Master project will be displayed in
the Resources window in the Media folder.

2. Previously you may have also saved a Sub project, which will now be referred
to as a Sequence, as an .xml file that may contain any of the same such
things: media, clips, autos, keyframes, effects. Second you will want to load
the Sequence using an Insertion strategy of Create new resources only. When
you do the load, this Sequence will show as a file in the Resources window
in the Clips folder. The actual media will show in the Media folder.

3. Now Drag and Drop the Sub project from the Clips folder to the Viewer.

4. Set In and Out Pointers in the Viewer to the region of interest in the Sub
project and in the Timeline of the Main window of your Master project, move
the cursor position to where you would like to insert this In/Out section.

5. Click on the Splice (v) button in the Viewer to insert this section into the Mas-
ter project timeline. All of the attributes of the selected Sub project section
will now be inserted in the main timeline to include the autos, keyframes,
effects, and labels.

6. Alternatively, if you click on the Overwrite (b) button in the Viewer, you can
see the Sub project In/Out section in the timeline, but without its autos, ef-
fects, keyframes, etc. If in the timeline there were some autos, effects, and
keyframes in that Master project, they will be in effect for the new section.

You can see the advantages of using Splice versus Overwrite to either insert (splice)
with all of the attributes of a specific section of your Sequence or to overwrite with-
out the attributes to allow for the smooth operation on the timeline by retaining
the timeline’s attributes at that point.
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NOTE: for correct operation of this use case, you should have the same (or more)
number of tracks in the Master project as you do in the Sequence. To avoid having
to know how many tracks you need, you can use the Nest feature as described in
the Nesting section (5.7.10).

5.4 Cut and Paste Editing

This is the more traditional method of editing in CINELERRA-GG and therefore is
the default. To enable the cut and paste editing mode on the timeline, select the
I-beam toggle on the control bar at the top of the main program window. You can
copy edits in the same track, copy from different tracks in the same instance, start
a second instance of CINELERRA-GG and copy from one instance to the other or
load a media file into the Viewer and copy from there.

To start editing, load some files onto the timeline. Select a region of the timeline
by click dragging on it and select the cut button to cut it. Move the insertion point
to another point in the timeline and select the paste button. Assuming no In/Out
points are defined on the timeline this performs a cut and paste operation.

Most editing operations are listed in the Edit pulldown. Some of them have a but-
ton on the program control toolbar as well as a keyboard shortcut. The keyboard
shortcut is in parenthesis here.

Split | Cut (x) Delete the selected area and put it in the cut buffer for future
pasting.

Copy (c) Copy the selected area and put it in the cut buffer for future pasting.

Paste (v) Paste the material that is in the cut buffer.

Clear (Del) Clear the selected area. If the insertion point is over an edit boundary
and the edits on each side of the edit boundary are the same resource, the
edits are combined into one edit comprised by the resource. The start of this
one edit is the start of the first edit and the end of this one edit is the end of
the second edit. This either results in the edit expanding or shrinking.

Paste silence (Shift+Space) Paste blank audio/video for the length of the selected
area. Following edits will be pushed to the right.

Mute Region (m) Overwrite blank audio/video on the selected area. Following
edits don’t move.

Trim Selection Delete everything but the selected region.

Select All (a) Select the whole timeline.

In Cut and Paste editing mode you can edit labels as well. By enabling Edit labels
in the Settings pulldown, or by disabling the Lock labels from moving button on
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the Program Control Tool Bar, labels will be cut, copied or pasted along with the
selected regions of the armed tracks.

Using labels and In/Out points are useful in editing audio. You can set In/Out
points for the source region of the source waveform and set labels for the destina-
tion region of the destination waveform. Perform a cut, clear the In/Out points,
select the region between the labels, and perform a paste.

In / Out Points The In and Out bracket placement is explained here to illustrate
their usage. Because of the shape of the markers [ and ] you may assume that they
are inclusive – that everything placed in between would be included in the clip,
such as in the case of being transferred to the timeline from the Viewer. In reality,
one of the two markers will not include the frame that was visible at the time the
marker was affixed. Depending on whether the Always show next frame option is
used or not, it is the In or Out marker that will not be inclusive.

To obtain a clip on the timeline exactly as you saw in the Viewer, you must neces-
sarily move the In mark back from the beginning before the first desired frame or
move the Out mark forward after the last desired frame, depending on the Always
show next frame setting.

Some of the confusion can be attributed to the fact that the Viewer shows frames,
while the markers determine spaces, i.e. times, that are not visible between frames.
You have to think of each frame as being delimited by two spaces – one preceding
and one following. The In mark is always placed before the displayed frame and
the Out mark is always placed after the displayed frame, while taking into account
in its calculations whether the Always show next frame option is used or not. If you
just remember that the reference of the markers is in the middle of the icon, you
will avoid confusion.

Overwrite To perform overwriting within the timeline paste on a selected region
(highlighted or between In/Out points). The selected region will be overwritten.
If the clip pasted from the clipboard is shorter than the selected region, the se-
lected region will be shrunk. Following edits will move. If the clip pasted from the
clipboard is longer than the selected region, the selected region will be overwrit-
ten with the first part of the clip and the remaining part of the clip will be written
after the overwriting. Following edits will move.

Tracks → Concatenate tracks This operation copies all the assets of every dis-
armed but playable track and concatenates it by pasting those assets at the end of
the first set of armed tracks. They are pasted one after the other, keeping the same
order they have on the stack.
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Split — blade cut and hard edges: You can cut the tracks into 2 pieces on the
timeline by putting the hairline cursor on the place you want to do a cut and then
using the character “x” or the scissors tool (figure 5.4).

Figure 5.4: Blade cut

A cut uses a non-empty selection region, where the
blade cut or split has no duration in the selection, just
a hairline. As usual the use of cut when a selection is
set, deletes/cuts the highlighted area. In the case where
an In point or an Out point exists on the timeline, the
clip is split at the location of the In/Out point since it
has priority over the cursor location. A blade cut sim-
ply splits the edit into two edits. In order to have the
video and audio aligned, it works best to have Settings
→ Align cursor on frames. When a blade cut oc-
curs, the edges are created as hard edges. These are
edges that cannot be deleted by track optimizations.
CINELERRA-GG has built-in optimization on the time-
line. So that whenever two parts on the timeline are
sequential frames, it automatically optimizes by mak-
ing them into 1 item. So if you are cutting, dragging,
editing, or whatever and somehow frame # 40 ends up right next to frame # 41,
it optimizes them together. This optimization affects many areas throughout the
program code. When you do a blade cut/split, all armed tracks will be included in
the cut and green-colored triangles will show on the bottom of the track on both
the left and the right side of the cut. This is a hard edge marker toggle, as opposed
to the soft edge designation for an ordinary edit. The hard edge marker can be
toggled off/on if so desired. In order to not interfere with the usual drag handles,
only a few pixels are used for the toggle so you have to be sure you have the cursor
right over the hard edge triangle – when in position, it will be obvious because you
can see an arrow pointing to the corner. Use Shift-left mouse button 1 to toggle
off/on the hard edge marker on all tracks simultaneously.

5.5 Drag and Drop Editing

To enable the drag and drop editing mode on the timeline, select the arrow toggle
on the control bar at the top of the main program window. Drag and drop editing
is a quick and simple way of working in CINELERRA-GG, using mostly only the
mouse. The basic idea is to create a bunch of clips, then drag them in order into
the timeline, thus building prototype media that you can watch in the compositor.
If after watching it, you wish to re-arrange your clips, set effects, add transitions
or insert/delete material, just drag and drop them on the timeline.

To simply get started, perform the following operations which are useful for work-
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ing in a drag and drop editing session. First load your media by using the main
menu File pulldown and choose Load files; make sure the insertion mode is set to
Create new resources only. This loads the files into the Resources window.

1. Create some video and audio tracks on the timeline using the Video and Audio
pulldowns.

2. Open the Media folder in the Resources window. Make sure the necessary
tracks are armed and drag a media file from the Resources window to the
timeline. If the media has video, drag it onto a video track or if just audio,
drag it onto an audio track. For a still image, drag it onto a video track.

You can also drag multiple files from the Resources window. When dropped in the
timeline they are concatenated. If you have Display Icons selected in the Resources
window, drawing a box around the files selects contiguous files. If you have Display
Text selected, Ctrl-clicking on media files selects additional files one at a time; Shift-
clicking on media files extends the number of highlighted selections. In addition
to dragging media files, if you create clips and open the clip folder you can drag
clips onto the timeline.

CINELERRA-GG fills out the audio and video tracks below the dragging cursor with
data from the file. This affects what tracks you should create initially and which
track to drag the media onto. To drag and drop a file on the Program window, you
need to create on the timeline the same set of tracks as your media file.

When you drag your chosen media from the media folder to the timeline, your
mouse pointer will drag a thumbnail and, once over the timeline, the outline of a
white rectangle, as big as the edit you are going to have appears. Drag the media
to the desired position of an empty track of the timeline and drop it. If there are
other edits on that track, when you move the white outline over an edit, you will
see a bow tie symbol ./ appearing at edit boundaries. If you drop the media there,
the new edit will start from the edit boundary indicated by the center of the bow
tie ./.

Since the mouse pointer is in the middle of the white outline, when this rectangle
is bigger than the visible part of the timeline, it is quite cumbersome to precisely
insert it for long media. Lengthening the duration visible in the timeline by chang-
ing the sample zoom in the zoom panel will reduce the size of the white rectangle,
making a precise insertion possible.

When you drag and drop edits within the timeline:

• If you drop an edit when bow ties ./ are shown, that edit will be cut and
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pasted starting at the edit boundary indicated by the center of the bow tie ./.
Following edits on the same track will move.

• If you drop an edit when there are no bow ties ./ shown, the original edit will
be muted and pasted where you dropped it. No edits will move. A silence
will appear in place of the original edit.

• If you have more armed tracks on the timeline than in the asset you are
dragging, only the following edits of the tracks affected by the drag and drop
operation will move to the right. This will cause loss of synchronization. To
restore it, disarm the tracks affected by the drag and drop operation, highlight
the just dropped edit and paste silence over it using the Edit pulldown, Paste
Silence.

Labels sometimes work differently in Drag and Drop editing mode in that you can’t
drag and drop them. They might be locked to the timebar, even with the Edit labels
option enabled. Although with the Edit labels option enabled, if a selected area
of a resource is spliced from the Viewer to the timeline in a position before labels,
these labels will be pushed to the right for the length of the selected area.

In/Out points can be used to perform Cut and Paste operations in Drag and Drop
mode as well as in Cut and Paste mode. Use the Edit pulldown to view the list and
their keyboard shortcuts.

5.5.1 Copy/Paste Behavior

There are many options for moving, copying, pasting, inserting, and deleting se-
lected edits, more commonly referred to by the user as clips, when in the Drag and
Drop (arrow) editing mode. This makes it easier to avoid constantly having to dis-
arm/arm tracks. To create a selection move the cursor over the clip and just click
the left mouse button; remove a selection by left mouse button click again. This
will mark your selection with a colored border which contains some red. The eas-
iest way to initially use the various modes is to click on the middle mouse button
when your cursor is over a track and a popup displays the modes and shortcuts.
However, for those users who prefer the addition of the Ctrl key to add multi-
ple selections as is commonly done for listbox operations, there is a preference in
Settings → Preferences → Appearance tab, called Clears before toggle that
changes the behavior.

When an edit is marked as selected, it can be cut/copied into the paste clip buffer.
The constructed clip buffer will begin with the leftmost edit and end with the
rightmost edit. The edits may contain media, or be silence, or skipped if they
are not selected. The clip tracks are copied from the first track with an active
edit selection to the last track with an active edit selection. A clip track can be

121



5.5. Drag and Drop Editing

completely empty if no selection was made on the track. The word packed means
that the silent edits and empty tracks are not included in the copy to the clip buffer,
and all of the elements are packed together, no gaps. Packing a clip buffer makes it
easier to move blobs of data around. Once the edits have moved and have a relative
relationship applied, an unpacked clip buffer allows the media to be copied with
the relative positions of the edits preserved.

The edits popup is activated on a track and a red and yellow colored reticle appears
to temporarily mark the location when you click on the middle mouse button. An
expanded explanation is provided below.

Key Operations

Drag Hold down the Ctrl key while dragging to move a single edit elsewhere.
Left mouse button Selects and highlights the edit under the cursor with a red selection box.

Left mouse button also will toggle that clip selection off if it is on.

Popup Label Key Operation

Clear Select Ctrl-Shift-A Deselect all selected edits —ones that have the red lines around
them.

Copy Ctrl-c Copy the selected edits into the copy buffer.
Cut Ctrl-x Delete the selected edits after copying them into the buffer. The

edits
Mute Ctrl-m Delete the selected edits after copying them into the buffer. The

space previously occupied by the edits will be replaced with
silence.

Copy Pack Ctrl-Shift-C Copy the selected edits into the buffer and remove any silent
sections.

Cut Pack Ctrl-z Delete the selected edits after copying them into the buffer. The
edits after the election will move left to occupy the vacated
space. The edits in the copy buffer will be packed together
within each track.

Mute Pack Ctrl-Shift-M Delete the selected edits after copying them into the buffer. The
deleted edits will be replaced with silence. The edits in the copy
buffer will be packed together within each track.

Paste Ctrl-v Paste contents of the copy buffer at the insertion point marked
by the red & yellow reticle of the popup menu or the position
of the hairline cursor. This is a splice operation which creates
space for the edits.
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Popup Label Key Operation

Overwrite Ctrl-b Paste contents of the copy buffer at the insertion point marked
by the red & yellow reticle of the popup menu or the position
of the hairline cursor. This destroys the current edits in that
space.

Overwrite Ctrl-Shift-P Pastes plugins that are in the Copy buffer to current location
but no clip. Plugins.

The copy/paste behavior respects the armed/disarmed tracks state. A paste of
audio on a video track will fail and vice versa. In addition if you attempt to paste
edits consisting of more tracks than what is available at that location it will not
allowed.

Attaching transitions to multiple selected edits via the Video or Audio pulldowns
is also available. The new transitions are attached at the start of the edits, and will
replace any existing attached transitions.

5.5.2 Grouping edits

CINELERRA-GG recognizes as a group, the edits of different armed tracks that have
aligned beginnings, regardless of whether they have the same source or aligned
ends. You can drag these edits around on the timeline to construct your movie
by rearranging scenes. If more than one track is armed, CINELERRA-GG will drag
any edits which start on the same positions the edit the mouse pointer is currently
over.
Another method of Grouping of edits is performed as follows:

1. Select each of the clips you would like to be part of a group.

2. Use the desired Copy mode as described above to get into the buffer.

3. Go to the Resources window Clip folder and right click on an empty spot.

4. Choose the Paste Clip option. Now you have a named clip of the current
selection.

A more traditional Grouping of edits which make a Permanent Group works as
described next. A temporary group is just a set of selected clips and works the
same as a single selection.

1. Create a group:
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• Select multiple clips/edits with left mouse button over the clip;
• Hold down shift and left mouse click over any of the selected clips to

create a group;
• A Group Id and color are assigned to this group making it easy to distin-

guish.

2. Move a group:

• Move your cursor over any of the clips within the group; click to select
the clip group.

• Click and Hold down the left mouse button to drag.

3. Dissolve a permanent group:
To ungroup select any of the group edits/clips and shift left mouse click to
ungroup (same as creating). The edits will be ungrouped, and the current
selection will be replaced with the ungrouped clips.

The color of the created groups are not muted and are assigned by Group Id going
sequentially through the number of 1 to 64. Therefore if you dissolve a group and
make it again, it will have a different Group Id and a different color.

5.5.3 Dragging Groups

Dragging while in Drop and Drag editing mode (arrow mode) is really easy. Just
select the clip or clips you want to drag using the left mouse button, then put
your cursor over one of them and drag while holding down the left mouse but-
ton. Keyframes, autos, labels, and plugins will also be dragged. Dragging honors
armed/disarmed tracks. When you drag there will be some possible colors as de-
fined; depends on how the edges of edits and groups interact:

• Green color means OK to drop in that position as it will fit.

• Yellow color means you can drop here and when you do it will be exactly next
to that existing edit.

• Blue color means it overlaps something and this includes overlapping itself.

• Red color means can not drop here because it will not fit in the space.

• Orange color means the track types do not match so it can not be dropped
here.

Remember: With the SHIFT key on, it will always overwrite. Without the SHIFT
key enabled, it always inserts only.

The original (older) method of dragging while in Arrow mode, lets you just left
mouse click on a single clip or aligned clips and just drag. This older method of
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dragging does not move any of its effects with it at this time. There will only
be a white outline while dragging and it will let you drop only if it fits. You can
also perform some dragging and grouping while in the Cut and Paste editing mode
(ibeam mode) by taking advantage of the Ctrl button in conjunction with the left
mouse button.

• Double click selects a column so you can move, for example, the audio and
video together by holding down the Ctrl key and dragging.

• A single clip can be dragged without any of its aligned clips, by holding down
and Ctrl key and drag.

This last section on Dragging, outlines the difference between column selection and
marking selection. Column selection is available to make it easy to still be able to
do some dragging in I-beam mode whereas Marking selection makes it easy to
drag clips together that are not columnated.

5.5.4 Selection Methods

Concerning Selection methods, the following information is partially pertinent to
all editing, but is most important to keep in mind when using Drag and Drop
Editing.

Originally, there was the column oriented timeline drag selection which can be
seen in 1 of 3 ways:

1. a highlighted vertical column

2. the colored line region between the [ in and ] out marker labels

3. a single flashing line

The selection priority works like this. When the highlighted vertical drag column
is in use (1), it has the highest precedence and is used as the selection. When
the column is a single line (2), then the fall back selection is the [in/out] marker
region, if they are set. When they are not set, and the cursor is flashing, then the
selection start=end and the selection is empty, but it does have a position on the
timeline which can be used for editing. This is input for the vertical style cut/paste
drag/drop editing.

More recently, in addition to the column oriented timeline drag selection, there
is now group capabilities which have various edit selections. These are created
in the Drag and Drop editing mode by clicking edits to toggle select/deselection.
These groups are input to a different (more modern) set of cut/paste/overwrite
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drag/drop editing. You can see this set of operations when you click on an edit
with the middle mouse button, and are also available using the shortcuts shown.
They are more like text editor commands to include ctrl+x=cut, ctrl+c=copy,
ctrl+v=paste, and so on . . . The keyboard Delete key is not hooked to these
operations, and is hooked to the original editing methods.

In this group mode, if there are In/Out markers set, they enter the selection priority
queue between the column selection and the cursor only. You can see the In/Out
markers selected region colored line across the timebar (slightly underneath where
the time, samples or frames show ) on the main timeline extending between the [
and ]. This means that when the highlighted cursor selection is empty, the In/Out
selection will be used.

5.6 Inter-View Mode / Identifying Source Targets Edit-
ing

Inter-View mode provides a mapping of a particular media file to its timeline us-
ages. It is somewhat similar to Two Screen Editing in that you make use of the
Viewer. It makes it possible to precisely trace and indicate in the media the origin
of a particular segment of the timeline and visually indicate the use and distribu-
tion that the timeline makes of a particular media. A good example usage would
be in the case of a 30 minute interview where you use a few short pieces to make
a shorter 10 minute section, find out that you have made the timeline 12 minutes
instead and need to cut out another 2 minutes.
This feature provides the following capabilities:

• You can see on the timeline all of the places where a particular piece of media
was used.

• You can see which parts of that particular media are already used so you do
not reuse that same piece again.

Figure 5.5 shows an example of the Inter-View mode mapping preview mini-window.

Explanation of how to use Inter-View mode will be described here next.

• Do your editing as usual on the timeline until you are ready to see what is
used or unused.

• Make sure you are in any of the Preview modes in the Resources window;
you enable the mode using the pulldown to the left of the word Search. The

option looks like this .
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Figure 5.5: Inter-View mode: white bar→source; red bar→timeline

• Middle mouse click on a thumbnail in the Resources window and a popup
occurs of that media with a white colored bar at the top and a red colored
bar at the bottom with black sections.

The red/white bars represent the presence and the black sections represent the
absence of where that media is used on the timeline. To get to a bigger represen-
tation, use the “f” key for a full screen. Now you can operate the following buttons
to display what you need to see and to move around. It is important to note that
locked tracks will not be represented. This makes it easy to ignore the audio track
segments if you want so there is less confusion in the display.

• Clicking on the top white or black spaces in the top time bar loads the Viewer
with the source media, and sets the In/Out [ and ] pointers to be the selection
of that edit.

• Click on a location in the bottom red or black bar, and the main cursor and
composer will re-position to the corresponding location on the session time-
line.

• Dragging on the red/black bar will correspondingly update the position in
the timeline and composer.

• Ctrl-click on the bottom bar and the timeline and composer are re-positioned
to the beginning of that edit.

• Shift-click on the bottom bar and a selection is made of that section in the
timeline and the composer is updated with that start position.
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Figure 5.6 displays Inter-View window and its relation to the timeline, viewer, and
compositor.

Figure 5.6: Inter-View mode and the timeline

The Inter-View mode works for Media, Proxy, and User Bins. When the preview
window has only black bars on the top and bottom, it means that this particular
media is not loaded in the timeline. So when you are in Proxy, meaning that
the Proxy files are loaded on the timeline, there will be only black bars for the
corresponding Media file UNLESS there is an audio track associated with the video.
Because audio tracks are not proxied, they will show for Media but not for Proxy.

5.7 Some Specific Editing Tools

This section covers some more detailed editing tools and scenarios for edit man-
agement.

5.7.1 Editing EDLs within a Project

To edit EDL that is included with your project as Clips, Nested Clips, Referenced
File, or Xml you can use the option Open EDL in the Resources window for the
highlighted media. Then with a simple button click you can return to your main
timeline project. For example, if you have a nested clip that originally had several
plugins added to it before it was nested, you can edit those plugin parameter val-
ues. Previously to make any changes to these types of EDL you had to remake the
whole clip from scratch.
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Here is how this works. In the Clip or Media folder or on a timeline EDL edit, the
option Open EDL for the highlighted clip or nested clip is available so that when
you choose this option, that EDL will be brought up on the timeline superseding
the current EDL that exists on the timeline. Now, once the clip is open on the time-
line, you can edit it however you want. The previous timeline EDL is pushed onto a
stack so it can be recalled by popping the stack with a click of the left mouse button
in the upper right hand corner of the timeline to the left of the shell cmds icon.
Initially this button displays a 0 to indicate your initial timeline/project. Then this
button will read 1 if you choose Open EDL and then back to 0 and your original
timeline with the left mouse click. You can go several levels deep so instead of 1,
it could be 2, 3, . . . but this requires some thought to avoid potential confusion.

An example of a typical set of steps to follow is:

1. Load your media using insertion strategy of Replace current project. There
will be # 0 in the upper right hand corner of the main menu with the tooltip
of Close EDL.

2. Highlight a selection on the timeline and press the To clip icon and click the
green checkmark OK.

3. In the Resources window, open the Clip folder and you will see that Clip 1 is
present.

4. Highlight Clip1 and right mouse the item to bring up available options and
select Open EDL.

5. Now you will see the timeline change from the original media to just the clip
content and the # in the upper right hand corner will change from 0 to 1.

6. Add a visible effect, like AgingTV to the timeline.

7. Click on the # 1 in the main menu bar to see he timeline restored to the
original media.

8. Drag the clip from the Resources Clip folder to the timeline and you will see
the AgingTV effect.

You can follow the same steps as above by first using the option Nest to media
in the Clip folder which nests the clip and moves it out of the Clip folder to the
Media folder. Then use Open EDL on the Nested EDL in the media folder. When
you Open EDL and edit the changes, those changes will take affect on any and
all occurrences of that nested clip on the current and/or original timeline. The
option to unnest that clip and put that back into the Clip folder is the option EDL
to clip. The nested clip is still in the Media folder. It will now have a name of the
next available Clip # but the comment contains the previous name so you can tell
where it came from.
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Instead of using the # number on the main menu to close the current EDL, both
the Media and Clip folders have Close EDL options with the left mouse button.
Clicking on the # number is quick and easy but for infrequent usage it is not
obvious, whereas if you use Open EDL you see Close EDL right below that and so
it is very obvious. In addition in the case of where you have opened a EDL, and
you no longer see that clip in the folder, the right mouse button where no media
is highlighted will also display the Close EDL option.
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Figure 5.7: Once you have an an Open EDL, there are 2 ways to close it.

In addition to the Open EDL option in the Resources menu, this option is available
on the timeline when the cursor is on an EDL-type edit. To get to this option, click
on the middle mouse button on that edit. If it is not EDL, the option will not be
shown. In summary:

Media folder of Resources window Open EDL for Nested or Referenced EDLs
Clip folder of Resources window Open EDL for clips
Track timeline Open EDL for Nested or Referenced EDLs

An aside – when nesting and unnesting clips to take advantage of this feature,
names of the media can lead to some confusion. For example, if you nest a clip,
the new name in the Media folder is the word Nested followed by an underscore
with the date and timestamp, another underscore, and then the clip name. Then
when you unnest this Media folder clip via the EDL to clip option, the name will be
changed in the Clip folder to the next available Clip #. However the comment field
will reflect the nested clip name from which it was derived. To avoid confusion
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you can easily change the name for these clips in either the Clip or Media folder
because they are not real files at this point. To do so, highlight the clip name in
Resources, click on Info and type in a new name.

For additional safety, the Open EDL feature includes additional backup capabilities.
Automatically CINELERRA-GG saves a backup when certain changes are made or
you can always use the shortcut "b" to do one yourself, although keep in mind it
will be overwritten whenever CINELERRA-GG wants to do another backup. Now
there is a shortcut for the backup shortcut "b" so you can keep your hand on the
mouse instead of the keyboard. Just click on the # in the upper right hand corner
of the main window. If # is at 0, it backs up to backup.xml, if at 1, it backs up to
backup1.xml and so on . . . up to backup9.xml.

When Open EDL is invoked, the current EDL and current undo stack are both
pushed, and the active session EDL is replaced with the target clip/nested edl. A
new undo stack is created, and the active backup.xml file name is decorated with
the stack level. So, backup.xml is backup1.xml when your edits are at stack level
1, backup2.xml at stack level 2, and so on. This means that if you load backup
at stack level 1, the session will reload from history at stack level 1, not the main
session.

5.7.2 Editing with File by Reference

It is sometimes handy to have EDL assets not as a copy, but as a reference that is
automatically updated into your project. Suppose you have several short videos
that at the end have the same credits which include the current year such as 2019.
But now it is 2020 and all of the videos would have to be individually updated
with the new date. By including a Referenced File as the EDL file type when you
create each of the videos, you can just change the one credits xml file and the next
time you load one of the videos and render it, it will now automatically have the
updated information.

The purpose of this feature is to be able to rework a smaller section of a global
master project at any time, which can be done by an "assistant" and then this work
is automatically reflected in the global master project. It is for advanced usage
only.

Up until the addition of this feature, CINELERRA-GG has always used copies and
no direct reference in order to ensure original data is never compromised. In the
usual case, subprojects as xmls are copied into a master project where subprojects
had been inserted, so that if you change something in a subproject or delete a
subproject, it would have no affect on the master project. But now with File by
Reference, any project that uses a referenced file will automatically include any
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changes made to the referenced file when loaded. At the same time, if you use the
EDL file NOT as a referenced file in a project since it is then just a copy, it will not
be updated. Because of this difference, the user needs to be very aware of what
using this feature could do.

Use with extreme caution. However, there are several built-in safety features and
a warning that should never be turned off even though it gives you the option to
do so. These include:

1. When the File, Load files menu is opened, the EDL strategy will always
be set to just EDL as default. Although, if you use Apply and leave the Load
Menu open, it will stay changed to what you selected until it is re-opened.

2. When an EDL is opened as Reference, the color of that file name in the Re-
sources Media folder is different in order to serve as a reminder that it is
special.

3. A warning message is displayed in a popup window when you load a File
by Reference that reads “Other projects can change this project and this can
become a broken link”. Although you can check the warning box to never
see this warning again, you would be well advised to not do so. It is a great
reminder of consequences and you will not want to be cavalier about the
warning. Instead just use the X to dismiss the warning.

Here is a step by step example of how you can use File by Reference:

1. Start up CINELERRA-GG and use the Title plugin to create a new credits file.
Save as credits.xml.

2. Start a New project and then load an existing master project to the timeline.

3. Load the credits file you created in step 1 with a Load Strategy of Create
Resources Only and with EDL Strategy as Reference.

4. Note the color change in the credits.xml filename and the reference comment
in the Resources Media folder.

5. Drag the credits file to an empty spot on the timeline. Save this new master
project and quit.

6. Start CINELERRA-GG up again. Load credits.xml and make a change to the
Title and save again.

7. Exit CINELERRA-GG; restart CINELERRA-GG; load your master project and now
you will automatically see on the timeline the changes you just made in the
previous step.
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5.7.3 Edit Length

To set the length of an edit in the timeline, select the region which contains the edit
to be modified. Now select the menu bar Edit → Edit Length. . . menu item to
activate the edit length popup (figure 5.8). The duration of the edit can be reset
by entering the desired edit length in seconds. Pressing OK will change all of the
selected edits (in armed tracks) to the specified length.

Figure 5.8: Edit Length window

5.7.4 Align Edits

When loading media, a common problem is that the various audio/video tracks
do not always have exactly the same lengths. For example, you might load au-
dio/video recordings from your camera and be dismayed to see that the audio for
each segment is a half second longer than the video. If you load a large set of
media clips by concatenation, the audio and video will be more skewed as more
media is loaded. Align Edits makes it possible to adjust the edits so the audio
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and/or video align by adjusting the edits so that the track lengths are consistent.
To use this feature, load all of the desired media and select a region which con-
tains all of the edits to be aligned in the timeline. Now select the menu bar Edit
→ Align Edits menu item to operate the change. The topmost armed track is
used as a template reference, and the rest of the tracks are either cut or padded
to align the edit boundaries. Besides aligning audio with the video, you can also
align video with the audio if the first armed track is audio.
The code performs the following algorithm:

• Use the first armed track as the master track (it must contain data).

• Collect the edit project start times on the selected master track. Only edits
that are 100% inside the selected area will be used.

• Set all other tracks to match the edit times of the template track, either by
putting in silence or cutting the region to align the edits on the edit times of
the master track.

The start time sequence of media and silence edits along the master track are
collected as the target alignment boundaries. All armed tracks after the master
track are modified so that if the next edit edge is too soon, it adds silence; if it is
too late, edits are shortened or deleted past the point of the next target alignment
boundary time. Align Edits works best if there are an equal number of Video and
Audio sections. Also, it is better to use cuts instead of adding silence – if there are
silence edits together, the algorithm will combine the silence edits into a single
edit and results may not be as desired.

The first two screenshots in figure 5.9 show the Before, the Highlighted Edits to be
manipulated, and the After results for the Align Edits. The third screenshot adds
silence in the second section as noted in red letters.

5.7.5 Reverse Edits

The Reverse Edits can be useful to change the order of 2 edits in the case where
you would like to put a teaser section that occurred in the middle of a movie at the
beginning instead, that is, reversed positions. To operate, highlight completely the
edit areas you would like reversed and then use the pulldown Edit → Reverse
Edits.

Figure 5.10 shows the selected / highlighted area to which Edits will be applied.
Note the first edit is 00002, followed by 00003, 00004, and 00005 in that order.

Figure 5.11 shows the results of executing Reverse Edits. Now you will see the
reversed order of 00005, 00004, 00003, and last 00002.
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Figure 5.9: Align edits

Figure 5.10: Selected area for edits aligment
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Figure 5.11: Results of the Reverse Edits

5.7.6 Shuffle Edits

The file pulldown Edit → Shuffle Edits will randomly exchange the location
of the edits. This feature can be used to change the order of the music like you
would do from your MP4 player where you have a playlist of your favorite mu-
sic. Or perhaps you are creating an advertisement background, you can randomly
change it, thus the viewer sees a different order of scenes each time shown.

Figure 5.12 illustrating Shuffle Edits of the highlighted area of the first screenshot
on the page. Note the permutation of the fragments resulting in 00003 now being
first, then 00005, 00002, and 00004 last.

Figure 5.12: Shuffle edits: the edits are permutated

5.7.7 Drag Handle Management / Trimming

With some edits on the timeline it is possible to do trimming. By trimming you
shrink or grow the edit boundaries by dragging them. In drag and drop mode
or cut and paste mode, move the cursor over an edit boundary until it changes
shape. The drag handle shows as a left or right facing fat arrow when you cursor
near the clip start or end. If the cursor faces left, the dragging operation affects
the beginning of the edit. If the cursor faces right, the dragging operation affects
the end of the edit.
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The effect of each drag operation not only depends on the behavior button but
whether the beginning or end of the edit is being dragged. When you release the
mouse button, the trimming operation is performed.

For all file formats, other than still images, the extent of the trimming operation
is limited to the source file length. Attempting to drag the start of the edit beyond
the start of the source, limits it to the source start. In all trimming operations,
all edits which start on the same position as the cursor when the drag operation
begins are affected. You have to disarm tracks in order to prevent edits from being
affected.

You have 6 different choices of which mouse button to use for specific types of
editing while using the drag handle. You change the drag handle mouse effects
by using the Settings → Preferences → Interface tab and modifying the
Editing section as shown in the next figure 5.13. The drag handle affects not only
the clip you are working on but also frequently the entire duration of all clips on
the timeline.
A description of the fundamental/common terminology for choices follows.

Figure 5.13: Default choices for mouse: Ripple for button 1; Roll for button 2; Slip for button
3

All Edits (ripple) shorten or lengthen the start or end of a single piece of media
while moving all media to the right of that clip up or down on the timeline
correspondingly. Timeline duration is modified. In a drag All Edits operation,
the beginning of the edit either cuts data from the edit if you move it forward
or pastes new data from before the edit if you move it backward. The end of
the edit pastes data into the edit if you move it forward or cuts data from the
end of the edit if you move it backward. All the following edits shift. If you
drag the end of the edit past the start of the edit, the edit is deleted.
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One Edit (roll) move the in and out point of a single clip without changing the
timeline duration. In a drag One Edit operation, nothing is cut or pasted. If
you move the beginning or end of the edit forward, the source reference in the
edit shifts forward. If you move the beginning or end of the edit backward,
the source reference shifts backward. The edit remains in the same spot in
the timeline but the source shifts.

Src Only (slip) move the in and out point of a single clip without changing the
timeline duration. In a drag Src Only operation, nothing is cut or pasted. If
you move the beginning or end of the edit forward, the source reference in the
edit shifts forward. If you move the beginning or end of the edit backward,
the source reference shifts backward. The edit remains in the same spot in
the timeline but the source shifts.

Slide a single clip is moved but retains its current in and out point; however the
out point of the clip to the left changes and the in point of the clip to the right
also changes. Timeline duration remains the same.

Edge Left / Right moves the edge of the clips.

No effect no changes are made. You might want to use this choice to prevent
accidental movements.

The next table displays the options and results with the Key Table here first.

s = src media start\\
p = proj position \\
l = length \\
c = cut distance \\
rest == p+=c: for rest of clips \\
01 = flags edits_moved, rest_moved

Drag Left Drag Right

curr s += c, l -= c; + rest ← → rest
abc12345xyz Ripple left edge 11→ abc012345xyz abc2345xyz

curr l += c; + rest ← → rest
abc12345xyz Ripple right edge 01→ abc1234xyz abc123456xyz

prev l += c; curr ps+= c, l -= c ← →
abc12345xyz Roll left edge 00→ ab012345xyz abcd2345xyz

curr l += c; next ps+= c, l -= c ← →
abc12345xyz Roll right edge 00→ abc1234wxyz abc123456yz

s -= c ← →
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Drag Left Drag Right

abc12345xyz Slip left edge 10→ abc23456xyz abc01234xyz

s -= c ← →
abc12345xyz Slip right edge 10→ abc23456xyz abc01234xyz

prev l += c; curr p+= c; next ps += c, l -= c ← →
abc12345xyz Slide left edge 10→ ab012345wxyz abcd12345yz

prev l += c; curr p+= c; next ps += c, l -= c ← →
abc12345xyz Slide right edge 10→ ab12345wxyz abcd12345yz

curr s -+= c, l += c; + rest ← → rest
abc12345xyz Edge left edge 11→ abc2345xyz abc0123456xyz

curr l -+= c; + rest ← → rest
abc12345xyz Edge right edge 01→ abc1234xyz abc123456xyz

Next, a more immediate and colorful view shows these trimming options (fig-
ure 5.14).

Figure 5.14: The 5 types of Trim: note the different lengths of the results.
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How to do a J-cut or L-cut A J-cut is a split edit film editing technique in which
the audio from a following scene overlaps the picture from the preceding scene, so
that the audio portion of the later scene starts playing before its picture as a lead-in
to the visual cut. An L-cut is a different split edit film editing technique in which
the audio from preceding scene overlaps the picture from the following scene, so
that the audio cuts after the picture, and continues playing over the beginning of
the next scene (figure 5.15). To do either a J-cut or an L-cut, you first shorten the
first or second video a little. Then you block the audio tracks from changing by
disarming the appropriate tracks. Finally use One Edit (roll) the cutting edge off
the videos. Moving to the right creates a J-cut and moving to the left creates an
L-cut.

Figure 5.15: J-cut to left and L-cut to right

5.7.8 Split View in Compositor Using the Drag Handle with Trim

The Trim Feature using the drag handle provides some good ways to view your
video while editing. The playback position in the compositor is updated live and
the view in the compositor can be split so that in the left half of the compositor
you can see the last frame of the left clip and in the right half the first frame of the
right clip. Dragging edits can not be extended past the beginning or the end.

First familiarize yourself with button operation; check your setup by executing
the following step. In the Settings → Preferences → Interface tab, Editing
section, clicking on the edit boundaries can be set for Button 1, 2, 3 as one of the
following:

Ripple; Roll; Slip; Slide; Edge or No effect
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Now to use this feature, create a track with edits that have trims on the left and/or
the right. The edit boundary can be modified using drag handles at the boundary
between the edits (figure 5.16).

Figure 5.16: Split compositor screen showing the result of the Trim feature

Left Mouse Button (LMB) usage: If you grab the edit handle from the right side,
you will see a left arrow and dragging the boundary will modify the right edit
playback starting time. If you grab the edit handle from the left side, you will
see a right arrow and dragging the boundary will modify the left edit playback
ending time. In both cases, the composer will show the edit endpoint of the
changed edit.

Shift LMB usage: The effect on the edits is the same as described above, but the
composer will show a split screen of the left and right edits as they appear at
the drag handle boundary. Dragging will only change one of the two images,
since only one edit is being changed.

Middle Mouse Button (MMB) usage: Both the left and the right edit ending/s-
tarting times are updated. The image shown in the compositor will be drawn
from the side of the drag grab, that is the left if it is grabbed from the left,
and the right if it is grabbed from the right.

Shift MMB usage: The effect on the edits is the same as described above, but the
composer will show a split screen of the left and right edits as they appear
at the drag handle boundary. Dragging will change both of the two images,
since both edits are being changed.
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Right Mouse Button (RMB) usage: The start/end point of the current edit is moved,
but the edit length is unchanged only one image changes since only one edit
endpoint is view is updated.

Shift RMB usage: The effect on the edits is the same as described above, but the
composer will show a split screen of the left and right edits as they appear at
the drag handle boundary. Dragging will only change one of the two images,
since only one edit is being changed.

5.7.9 Snapping while Cutting and Dragging

Cutting/Snapping edits cuts from an edit handle to the insert point. There are
Edit Panel buttons which normally are used to move to the previous or next edit
handle/label.
They look like tags and the letter E on the menu bar and are
oriented forward/backward. These same buttons can be used
to cut from the insert pointer to the previous or next edit/label
when the ctrl+alt keys are both pressed when the buttons are
used. They snap off the media instead of doing the standard
re-positioning. This is useful to minimize the number of operations necessary to
cut between edits/labels.

Instead of using the edit panel buttons, you can more easily use the following
keyboard shortcuts to perform the same functions:

snap_right_edit ctrl+alt+ ’.’
snap_left_edit ctrl+alt+ ’,’
snap_right_label ctrl+alt +shift ’.’ shift+period is the > sign on US keyboards
snap_left_label ctrl+alt +shift’,’ shift+comma is the < sign on US keyboards

Drag Snapping if you hold down the Ctrl + Alt keys while dragging using the
mouse, once the clip gets near to an edit, a label, an in/out pointer or the start/end
of the timeline, the dragged clip will snap next to that marker. The 2 will now be
exactly aligned with no gap and no overlap. As you drag the clip close to one of
the markers, when they are within a short distance they start to stick and stay that
way until you move further away from that distance. Also, the line will turn color
from green to yellow while in the sticky phase.

5.7.10 Nesting

Nested Assets A nested asset is an EDL session that embeds an existing EDL
session, all tracks, all plugins, editing, and effects into a media object that appears
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as one audio/video media object, no plugins, editing, or effects. It is as if the
existing EDL was rendered, and loaded in its place. This has several interesting
side effects. First, you don’t have to render the entire media file to see any portion.
Second, it requires no rendering compute time or storage. Third, it changes the
precedence of the composer so that you get more control over the projection and
automation, so that the results can be sent into another rendering step, not simply
part of the current stack. It groups the plugin stack in much the same way that an
arithmetic expression is grouped by parenthesis.

The EDL session and the rendered output are visually equivalent. Nested assets
allow for complex grouping and stacking of effects, and makes media access much
more flexible. This feature can be used recursively, that is, any number of sessions
may be stacked and referenced as an asset, as long as all of the rendering resources
are available. Nested assets are added to the timeline by using the pulldown File
→ Load files. . . on the main menu and selecting the Insertion strategy of Nest
asset. The file will be pasted into the timeline over the current selection or at the
insertion point.

It is somewhat important to note that nested assets and nested clips will have
index files automatically created. These index files can start to clutter up your
$HOME/.bcast5 directory with files named Nested_###.idx and you may want
to periodically delete any index files which are no longer in use.

Nested Clips It is also possible to create clips and convert them to nested edl. This
is done by first creating a clip using the standard cut, clipboard, paste, and/or edit
panel buttons. Now, using the resources clip folder, select a clip to be nested, and
use the right mouse button to select a clip. This activates the clip popup menu.
Select the Nest to media menu item, and the clip will be converted to a Nested: Clip.
Conversely, you can select a Nested: Clip, use the EDL to clip menu item, and the
clip will be reverted to a Clip. This works similarly to the group / un-group editing
features of many graphic design editing programs, but in this case the groups are
rendered compositions (figure 5.17).

Nested clips can be proxied and when they are, the resulting files are placed in the
user’s $HOME/Videos directory by default. This can be modified by changing

Settings → Preferences → Interface tab, Nested Proxy Path.

Usage Examples of Nested Clips

Example 1: You want to make a flashback/rewind at the end of your video that
represents a quick summary of the entire video in black and white. On he
timeline, you have 60 seconds of edits with clips, cuts, zoom in, zoom out
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Figure 5.17: Nested clips in Timeline and Resources window

and any other edits. Now you want to get this 60 seconds compressed to 10
seconds, play in reverse, and in black and white at the end of your video.
You would copy the 60 seconds in a clip, nest the clip in the Clip folder of the
Resources window and drag it to the timeline. You will see only a clean clip
without all of the edits that were used to create it because nesting display
a clip without having to actually use the Render menu. Now you can add a
Reverse effect, Color3way plugin for black and white, and use the Speed auto
to get the 60 seconds down to only 10 seconds.

Example 2: You are working on a complex project with a team in a separate lo-
cation. You create some sub projects, i.e. sequences, that you or the team
will use in the Master project to merge the sequences in the right order and
to make the final color correction steps.

In each of the examples you can see the benefit of nesting to create clean looking
timelines because of the automatic rendering capability of nesting.

5.7.11 Copy/Paste clips/medias across Multiple Instances

It is easy to copy/paste clips/media within a single instance of CINELERRA-GG or
across multiple instances. The reason this works is because there are hidden X cut
buffers and these are used to transmit EDL from 1 instance to another.

Steps to copy from a source timeline and paste to a target timeline:

1. highlight a selection on the timeline in 1 instance of CINELERRA-GG

2. use the Copy icon (shortcut c) on the main menu bar to copy into a buffer

3. move the pointer to another instance of CINELERRA-GG and set an insertion
point in its timeline

4. use the Paste icon (shortcut v) to paste the clip to that other instance selection
target
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5.8 ShuttlePROv2 and ShuttleXpress Jog Wheels for
Editing1

The ShuttlePROv2 and ShuttleXpress are affordable jog wheels which can be use-
ful for working with Cin, especially if you do a lot of playing forward/backward,
fast/slow/normal, and single frames (figure 5.18). Directions for using the Shut-
tlePROv2 and the ShuttleXpress with CINELERRA-GG are described next. These de-
vices work by sending keystrokes used in Cin, corresponding to the shuttle action,
to the keyboard buffer. The shuttle has been fully integrated into the CINELERRA-
GG code so that after the one initial setup, no further intervention is required.
The multi-speed outer wheel works the same and has the same number of S po-
sitions on both shuttles but the shuttle Xpress has only 5 keys. Since the majority
of user operations will most likely be with the use of the 2 wheels, the slightly
smaller Xpress could be a better choice with its 5 easy to reach keys. The Pro is
approximately 4× 7 inches whereas the Xpress is about 4× 4 inches.

Figure 5.18: ShuttlePROv2 and ShuttleXpress

The vendor supplied string device names for the shuttles are currently:

/dev/input/by-id/usb-Contour_Design_ShuttlePRO_v2-event-if00

/dev/input/by-id/usb-Contour_Design_ShuttleXpress-event-if00

/dev/input/by-id/usb-Contour_Design_ShuttlePro-event-if00

1credit Eric Messick

146



5.8. ShuttlePROv2 and ShuttleXpress Jog Wheels for Editing

Only 1 necessary initial setup is required due to permission settings for non-root
usage. As root, just copy a file that provides the necessary permissions to use the
shuttle, then reboot, Example copy:

\$sudo cp {cindat_path}/doc/99-ShuttlePRO.rules /etc/udev/rules.d/

then the next time after you reboot, the permissions should be correct. This file
only needs to contain one of the following lines depending on which shuttle version
you have/use, but all will be in the file.

# for newer PRO model
ATTRS{name}=="Contour Design ShuttlePro" MODE="0644"
# for older PRO model
ATTRS{name}=="Contour Design ShuttlePRO v2" MODE="0644"
# for the Xpress model
ATTRS{name}=="Contour Design ShuttleXpress" MODE="0644"
SUBSYSTEMS=="usb", ATTRS{idVendor}=="0b33", ATTRS{idProduct}=="0020", MODE="

,→ 0666"
SUBSYSTEMS=="usb", ATTRS{idVendor}=="0b33", ATTRS{idProduct}=="0030", MODE="

,→ 0666"

If you swap your shuttle, for example upgrade from an Xpress to a PROv2, just
stop Cin, unplug the original shuttle, plug in the replacement shuttle, and restart
Cin. If you start the CINELERRA-GG program and the shuttle does not function as
before, stop CINELERRA-GG and then simply unplug it and plug it in again. There
are a couple of reasons why it may stop functioning. One is because CINELERRA-
GG was not stopped with the usual Quit command and the shuttle was improperly
shut down when there was a crash. The other possibility is that a static discharge
occurred in the area.

A default shuttlerc file is automatically used when a shuttle device is plugged in
when Cin is started. This file sets up the key bindings for CINELERRA-GG to use.
You can override any default settings by having a local file in your $HOME directory,
named .shuttlerc to reflect your personal preferences.

5.8.1 How to Modify the Default Key Settings

Detailed information on how to modify your local .shuttlerc file is described next,
but if you need help you can request more information in the forum at https:
//cinelerra-gg.org. In the shuttlerc file, a # always represents a comment
and blank lines are ignored. The first thing you must do is copy the system sup-
plied shuttlerc file to your $HOME directory and rename it as .shuttlerc (with
a period).
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The shuttlerc file has sections that in the case of CINELERRA-GG, represent dif-
ferent windows allowing you to set the keys, K1-K15 for the Pro and K5-K9 for
the Xpress, the shuttle wheel positions of S0/S1/S-1 for stop, S2 through S7 for
wheeling to the right, and S-7 through S-2 for wheeling to the left for reverse.
Then there is JR to jog right (clockwise) and JL to jog left (counter-clockwise) for
the inner smaller wheel for single frame movement. See the key arrangement on
a later page for location of the keys for each of the two different shuttles.

The sections are surrounded by brackets for windows such as CINELERRA-GG (the
main window), Viewer, Composer, Resources, Load, and Default. If you want the
keys to be defined the same in every window, you can bracket each window on lines
one right after the other and then just define one set of keys. The other lines will
have the key name/shuttle position followed by its assigned value. The values you
use for the keys are usually shortcuts and have to be operationally defined within
CINELERRA-GG. For example, the shortcut “f” to go fullscreen is defined so can be
used; however the shortcut “h” is not defined so will not do anything. You can
check the file, shortcuts.html, for some options to use.

Next are a few actual examples from the default cindat_path/shuttlerc file.

The next brackets represent sections. Default, Resources, Load windows all use
the same key values.

[Default]
[Resources]
[Load]
K5 XK_Home
K6 XK_Button_1 # same as mouse button 1
K7 XK_Button_2 # same operation as mouse button 2
K8 XK_Button_3
K9 XK_End
# for example, in the Load menu, use scroll up to get to the next file name
JL XK_Scroll_Up
JR XK_Scroll_Down

Cinelerra with brackets around it next, is the section with some key definitions for
the main window.

[Cinelerra]

# Most useful functions have to be on K5-K9 because Xpress only has 5 keys
K5 XK_Home # Beginning
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K6 XK_KP_6 # Reverse, or if playing Stop
K7 XK_KP_0 # Stop
K8 XK_KP_3 # Play, or if playing Stop
K9 XK_End # End
...
S-7 REV_16 # Next 6 are reverse keys
S-6 REV_8 # the number on the end represents speed
S-5 REV_4 # number can be decimal up to 64
S-4 REV_2 # 2 means 2x or double speed
S-3 REV_1
S-2 REV_0.5 # 0.5 represents 1/2 speed
S-1 XK_KP_0 # Because the Shuttle does not generate S0, have to use S-1
S0 XK_KP_0 # Hardware does not generate S0
S1 XK_KP_0 # Because the Shuttle does not generate S0, have to use S1
S2 FWD_0.5
S3 FWD_1
...

An explanation for the above REV and FWD key symbol values is necessary to
facilitate user preferences. Obviously REV stands for reverse and FWD for forward.
You can set any speed up to and including 64x (that is, 64 times the normal speed)
on any of the S keys. First in the line is the key name such as S-3 and then the
key direction of FWD or REV followed by the symbol for underscore (_) and then
the numerical value to use. For example, if you want the 5th forward position, S5,
to play 101

2 times faster, you would use the statement S5 FWD_10.5. Integer or
decimal numbers are legal.

For the Viewer, you may want keys defined to do a Splice or an Overwrite so
define differently. Note that assignments that contain single character letters must
be enclosed in quotes.

[Viewer]
# Splice -Viewer only; may be defined differently than Composer or Cinelerra
K2 "v"
K4 "b" # Overwrite

To change any key value to an alternative value, just edit the file and make the
changes. Besides just keys and alphabetic letters of numbers, you can also use any
CINELERRA-GG value that contains the combination with Shift, Alt, and Ctrl. For
keys that are not printable characters, you can look up the symbol name to use for
a specific operation in the file called: /usr/include/X11/keysymdef.h . Some
examples:
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K10 Alt-XK_Left # Go to previous edit \\
K13 Ctrl-XK_Right # Go to next label

For sequences of one or more printable characters, you can just enclose them
in double quotes. For example in the [Composer] section, to go into or out of
fullscreen mode, automatically start playing and put a label there, you could de-
fine a key like this: K7 “f l” - that is printable character f, a space, and printable
character l.

After modifying .shuttlerc, the next time you use the shuttle, your changes will
automatically take affect without even having to stop and restart Cin. However,
the first thing to try if problems is to stop CINELERRA-GG, unplug the shuttle, wait
a few seconds, plug it in again, and then restart cin. If for some reason, the shuttle
keys still do not work after that, you may have an incorrect setup and you will have
to correct that first. For example, if you define S5 twice within the CINELERRA-GG
setup, it will fail. It is suggested that if you make changes, you should initially
uncomment DEBUG in the .shuttlerc file and start up CINELERRA-GG from a
terminal window so that you can make sure it is working and has no output errors.
An error might look like:

dupl key name: [Cinelerra]K1
shuttle config err file: /root/.shuttlerc, line:37

Keep in mind when changing the values, that the ShuttleXpress has fewer buttons
so if you define K1 it will only work for the ShuttlePro.

Any time you are having trouble with your shuttle, you can copy the default
shuttlerc file from cindat_path/shuttlerc to your local .shuttlerc file, and
edit that to switch to DEBUG mode by removing the # comment from the DEBUG
line. But you will have to have started Cin from a terminal window to see the key
values. The first time you use the shuttle or after you change the file, the current
assignments will show in the terminal window so will look something like:

[Cinelerra] # 1
K5[D]: XK_KP_0/U
K5[U]: XK_KP_0/U

When you are in DEBUG mode and are just working away, what you will see is
something like this:
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key: 0058 1
key: 0055 0

or:

shuttle: 00 00 00 00 00
key: XK_Home 0

When you change the focus from one window to another, you will see something
like this:

new focus: 04c00137
new translation: Viewer
key: 0059 1

You can also set an environment variable to temporarily use an alternative shuttle
configuration file for testing as in:

\$ export SHUTTLE_CONFIG_FILE=/tmp/shuttlerc_test

The shuttle wheel occasionally will not stop after you have wheeled it to play
forward. This is a documented known problem from the original code so you
just have to joggle it a little in the other direction and then it will stop. S0 does
not always generate a signal to do a stop and that is why S1 and S-1 have to be
used to relay the stop instead. Also, if you have a fullscreen Composer or Viewer
up and the regular one also, the fullscreen takes precedence.

5.8.2 Troubleshooting auxilliary information

In order to see if you hardware was recognized by the operating system, key in:

\$ lsusb -v -d 0b33:0030 # for the Shuttle Pro or PROv2 \\
\$ lsusb -v -d 0b33:0020 # for the Shuttle Xpress
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Note 1 Currently, the keys K14 and K15 do not function on the Contour Design
ShuttlePro but do on the Contour Design ShuttlePRO v2 due to a Report Descrip-
tor error. You can workaround this by uncommenting USB_DIRECT in your local
.shuttlerc file. This directly uses libusb rather than the generic Linux hid driver.
USB_DIRECT works for any of the currently tested shuttles.

Note 2 If you are not sure if your shuttle is fully functional, you can verify that
the hardware device has been seen by your operating system with this procedure.

1. From a terminal window as an ordinary user key in: lsusb (the first charac-
ter is a lower case L —for list). You will see something like the following
depending on which usb device you have the ShuttlePro plugged into:

Bus 003 Device 002: ID 0b33:0030 Contour Design, Inc. ShuttlePro v2

2. To make sure you have usbmon installed key in:

\$ sudo modprobe usbmon

3. Next key in the following:

\$ sudo od -tx1 /dev/usbmon3

where the last 3 is the same # as the Bus in above. If it lists Bus 002, then
use /dev/usbmon2 instead.

4. Now with focus in that same terminal window, press any shuttle key just to
see what happens and should see about 12 lines similar to these below —a
new set every time you press a single key or the wheel. The lines are usually
not important, just the fact that you get a response is. However if you have
multiple devices on the same bus, you will get responses from any and all of
them. Attempt to isolate your shuttle by temporarily unplugging unnecessary
devices on the same bus or plug the shuttle into a different usb port that has
fewer devices.

0000000 80 70 99 75 53 8c ff ff 43 01 81 02 03 00 2d 00
0000020 4e 61 5c 5c 00 00 00 00 8d 2c 06 00 00 00 00 00
0000040 05 00 00 00 05 00 00 00 00 00 00 00 00 00 00 00
0000060 01 ff 00 00 00 80 70 99 75 53 8c ff ff 53 01 81
0000100 02 03 00 2d 3c 4e 61 5c 5c 00 00 00 00 b1 2c 06
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0000120 00 8d ff ff ff 05 00 00 00 00 00 00 00 00 00 00
0000140 00 00 00 00 00 80 70 99 75 53 8c ff ff 43 01 81
0000160 02 03 00 2d 00 4e 61 5c 5c 00 00 00 00 3d d7 09
0000200 00 00 00 00 00 05 00 00 00 05 00 00 00 00 00 00
0000220 00 00 00 00 00 00 ff 00 00 00 80 70 99 75 53 8c
0000240 ff ff 53 01 81 02 03 00 2d 3c 4e 61 5c 5c 00 00
0000260 00 00 64 d7 09 00 8d ff ff ff 05 00 00 00 00 00

5. Next press the key that you want to verify is functioning — if no new lines
show up, then the key is non-functional so there is a hardware problem. If
you get output, then perhaps there is a problem with your software setup.

6. Use Ctrl-C on the terminal window when done to get back to the prompt.

Note 3 Another method for testing to make sure your model of the Shuttle does
not have different key definitions than the one that CINELERRA-GG was coded for
is to do the following.

1. Locate the shudmp.C program in your CINELERRA-GG directory.

2. Compile that with the command: c++ shdmp.C -o shudmp

3. Make the file executable with the command: chmod +x shudmp

4. Execute:

\$ sudo ./shdmp /dev/input/by-id/usb-Contour\_Design\_ShuttlePro-event-if00
,→ # substitute your shuttle

Then press your shuttle key that is having problems and check the results. They
should look like:

Listing 5.1: Example for K7

event: (4, 4, 0x90007) #The last number, 7, is the expected Key number.
event: (1, 262, 0x1)
event: (0, 0, 0x0)
event: (4, 4, 0x90007)
event: (1, 262, 0x0)
event: (0, 0, 0x0)

Listing 5.2: Example for K15

Example for K15:
event: (4, 4, 0x9000f) #The last number f is 15 in hexadecimal and is the expected Key.
event: (1, 270, 0x1)
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event: (0, 0, 0x0)
event: (4, 4, 0x9000f)
event: (1, 270, 0x0)
event: (0, 0, 0x0)

When done, you will have to Ctrl-C to get out of the program.

Note 4 For developers, if you have a pre-UEFI Secure Boot kernel it is also pos-
sible to do the following for further in depth testing:

ls /sys/kernel/debug/hid \# to locate numerical value of the shuttle, e.g. 0003:0B33
,→ .0030.0006

cat "/sys/kernel/debug/hid/0003:0B33.0030.0006/rdesc" # substitute your own
,→ numerical value

cat "/sys/kernel/debug/hid/0003:0B33.0030.0006/events" # press keys to see the results

5.8.3 Shuttle key default arrangement for CINELERRA-GG / Com-
poser / Viewer:

The following is the default setting for the ShuttlePROv2 and ShuttleXpress (ta-
ble 5.3 and table 5.4):

Table 5.3: ShuttlePROv2 key default arrangement for CINELERRA-GG / Composer / Viewer

K1 K2 K3 K4
Label Future use Future use Clip

Splice (viewer) Copy Overwrite (viewer)

K5 K6 K7 K8 K9
Home Reverse Stop Play End

Fullscreen
(viewer / compositor)

Home(Defaults) MouseBtn1(D) MouseBtn2(D) MouseBtn3(D) End(Defaults)

Shuttle Outer Wheel
Play forward (first row) or Play reverse (second row)

S1=Stop S2=1/2 S3=Normal S4=2x S5=4x S6=8x S7=16x
S-1=Stop S-2=1/2 S-3=Normal S-4=2x S-5=4x S-6=8x S-7=16x

K14 Jog Left (Inner Wheel) Jog Right K15
Toggle In Frame reverse Frame forward Toggle Out

Scroll up(Defaults) Scroll down(Defaults)

K10 K11
Previous Edit Next Edit

Future Use(Viewer) Future Use(Viewer)

K12 K13
Previous Edit Next Edit

Previous Label Next label
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Table 5.4: ShuttleXpress key default arrangement for CINELERRA-GG / Composer / Viewer

K5 K6 K7 K8 K9
Home Reverse Stop Play End

Fullscreen
(viewer / compositor)

Home(Defaults) MouseBtn1(D) MouseBtn2(D) MouseBtn3(D) End(Defaults)

Shuttle Outer Wheel
Play forward (first row) or Play reverse (second row)

S1=Stop S2=1/2 S3=Normal S4=2x S5=4x S6=8x S7=16x
S-1=Stop S-2=1/2 S-3=Normal S-4=2x S-5=4x S-6=8x S-7=16x

Jog Left (Inner Wheel) Jog Right
Frame reverse Frame forward

Scroll up(Defaults) Scroll down(Defaults)

155



CHAPTER 6

Rendering

Rendering takes a section of the timeline, performs all the editing, effects and
compositing, and creates a new media file. You can then delete all the source
assets, play the rendered file, or bring it back into CINELERRA-GG for more editing.
All rendering operations are based on a region of the timeline to be rendered.
You need to define this region on the timeline. The rendering functions define the
region based on a set of rules. When a region is highlighted or in/out points are set,
the affected region is rendered. When no region is highlighted, everything after
the insertion point is rendered. By positioning the insertion point at the beginning
of a track and unsetting all in/out points, the entire track is rendered. But you
also have the choice to render one frame.

6.1 Single File Rendering

Use the File pulldown and select Render to start the render dialog (figure 6.1).
Then choose the desired parameters.

Select a file to render to: enter the path and filename to write the rendered file
to in the textbox below.

File Format: use the down arrow to see file format options. For ffmpeg, which
has its own set of options, you will then have to select an ffmpeg file type
from the down arrow choices. The format of the file determines whether you
can render audio or video or both.

Render audio tracks: check this toggle to generate audio tracks

Render video tracks: check this toggle to generate video tracks. The Render win-
dow will sometimes automatically update the Render Audio Tracks or Render
Video Tracks checkbox as allowed by the chosen file format, but you should
always check (figure 6.2). For example, if the PNG file format is selected,
only the Render Video Tracks will be checked. Or if an ffmpeg format is cho-
sen and the file format does not render audio, the Render Audio Tracks will
be unchecked. The invalid choices will be ghosted out.
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Figure 6.1: Example of the Render menu

Figure 6.2: Audio and Video tracks automatically checked for Pro file type
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Wrench: select the wrench next to each toggle to set compression parameters. If
the file format can not store audio or video the compression parameters will
be blank. If Render audio tracks or Render video tracks is selected and the file
format does not support it, trying to render will result in an error message.
More details in the section: Extra “cin_” Options for Render with FFmpeg

Create new file at each label the option causes a new file to be created when
every label in the timeline is encountered – a separate file for each. This is
useful for dividing long audio recordings into individual tracks. When us-
ing the Render Farm (described later), Create new file at each label causes
one render farm job to be created at every label instead of using the in-
ternal load balancing algorithm to space jobs. If the filename given in the
render dialog has a 2 digit number in it, the 2 digit number is overwrit-
ten with a different incremental number for every output file. If no 2 digit
number is given, CINELERRA-GG automatically concatenates a number to the
end of the given filename for every output file. For example, in the file-
name /movies/track01.wav the 01 would be overwritten for every output
file. The filename /movies/track.wav; however, eventually would become
/movies/track.wav001 and so on. Filename regeneration is only used when
either render farm mode is active or creating new files for every label is active.

Render range: choices are Project, Selection, In/Out points, and One Frame for
single images like Tiff. For these images, Render range will have One Frame
automatically checked and all of the others ghosted since nothing else makes
sense (figure 6.3). This makes it easy to set the insertion point where you
want the 1 frame to be rendered rather than having to precisely zoom in
to set the in/out pointers. Note that whichever Render range is checked,
remains checked so that if One Frame gets automatically checked, the next
time you render it will still be checked and you will have to select a different
one if desired. That is why you should always check the settings.

Beep on done: as a convenience when a render is complete, check this box. It
gives you the chance to work on something else while waiting and still be
immediately notified when the render is complete.

Render Profile: another convenience feature to take advantage of if you use spe-
cific render formats frequently, is to save that profile for future usage without
having to set it up again.

Save Profile: after setting up your render preference formats, use the save profile
button to save it.

Delete Profile: if you want to delete a saved profile, highlight the one you no
longer want and delete.

Insertion strategy: select an insertion mode from the available choices as seen
when you click on the down arrow on the right hand side of the option. The
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Figure 6.3: Render menu displaying a PNG one frame option

insertion modes are the same as with loading files. In the case if you select
“insert nothing” the file will be written out to disk without changing the cur-
rent project. For other insertion strategies be sure to prepare the timeline to
have the output inserted at the right position before the rendering operation
is finished.
Even if you only have audio or only have video rendered, a paste insertion
strategy will behave like a normal paste operation, erasing any selected re-
gion of the timeline and pasting just the data that was rendered. If you render
only audio and have some video tracks armed, the video tracks will get trun-
cated while the audio output is pasted into the audio tracks.

6.2 Batch Rendering

Batch Rendering automates the rendering of audio/video files in that you can es-
tablish a set of job parameters, save them, and use them repeatedly. It also allows
for CINELERRA-GG to be run by external programs, with no need for the user to
manually interact with the user interface (figure 6.4).

If you want to render many projects to media files without having to constantly
set up the render dialog for each one, batch rendering is a more efficient method
of rendering. In the Batch Render menu, you specify one or more CINELERRA-GG
project XML files, the EDL, to render and unique output files for each. (The EDL is
the Edit Decision List or the set of changes to be applied to the project and media
files.) Then CINELERRA-GG loads each project file and renders it automatically.
The project XML files, combined with the settings for rendering an output file, are
called a batch. This allows a large amount of media to be processed without user
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intervention.

Figure 6.4: Example of the Batch Render menu

The first thing to do when preparing to do batch rendering is to create one or
more CINELERRA-GG projects to be rendered and save them as a normal project,
such as ProjectA.xml. The batch renderer requires a separate project file for
every batch to be rendered. You can use the same CINELERRA-GG project file if
you are rendering to different output files, as in an example where you might be
creating the same output video in different file formats.

To create a project file which can be used in batch render, set up your project and
define the region to be rendered either by highlighting it, setting in/out points
around it, or positioning the insertion point before it. Then save the project as
usual to your project.xml file. Define as many projects as needed this way. The
batch renderer takes the active region from the EDL file for rendering. If we have
not set active regions, it is better to bring the insertion point to the beginning of
the timeline to avoid possible problems with the rendering.

With all the CINELERRA-GG xml project files prepared with active regions, go to
File → Batch Render. This brings up the batch render dialog. The interface for
batch rendering is more complex than for single file rendering. A list of batches
must be defined before starting a batch rendering operation. The table of batches
appears on the bottom of the batch render dialog and is called Batches to render.
Above this are the configuration parameters for a single batch; a batch is simply a
pairing of a project file with a choice of output file and render settings.

Set the Output path, File format, Audio, Video, and Create new file at each label pa-
rameters as if you were rendering a single file. These parameters apply to only one
batch. In addition to the standard rendering parameters, you must select the EDL
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Path to be the project file (such as ProjectA.xml) that will be used in the batch
job. In this case, EDL Path is not related in anyway with the EDL files as created
by File/Export EDL. In batch render mode the program will not overwrite an
existing output file and will simply fail, so make sure that no files with the same
name as the output files exist before starting.

If the batches to render list is empty or nothing is highlighted, click New to create a
new batch. The new batch will contain all the parameters you just set. Repeatedly
press the New button to create more batches with the same parameters. When
you highlight any batch, you can edit the configuration on the top of the batch
render window. The highlighted batch is always synchronized to the information
displayed. You can easily change the order in which the batch jobs are rendered,
by clicking and dragging a batch to a different position. Hit Delete to permanently
remove a highlighted batch. In the list box is a column which enables or disables
the batch with an X meaning the batch job is enabled and will be run. This way
batches can be skipped without being deleted. Click on the Enabled column in
the list box to enable or disable a batch.

The description of each of the columns in the batch list are as follows:

Enabled: an X in this column means the batch job will be run.

Labeled: an X in this column goes hand in hand with create new file at each label.

Output: path and filename for the generated output.

EDL: the path and filename of the source EDL for the batch job.

Elapsed: the amount of time taken to render the batch if finished. If field is empty,
it did not run.

To start rendering from the first enabled batch, hit Start. Once rendering, the
main window shows the progress of the batch. After each batch finishes, the
elapsed column in the batch list is updated and the next batch is rendered un-
til all the enabled batches are finished. The currently rendering batch is always
highlighted red. To stop rendering before the batches are finished without clos-
ing the batch render dialog, hit Stop. To stop rendering before the batches are
finished and close the batch render dialog, hit Close. Or you can exit the batch
render dialog whether or not anything is being rendered, by hitting Close.

You can automate CINELERRA-GG batch renders from other programs. In the batch
render dialog, once you have created your list of batch render jobs, you can click
the button Save Jobs and choose a file to save your batch render list to. Once you
have created this file, you can start up a batch render without needing to interact
with the CINELERRA-GG user interface. From a shell prompt, from a script, or other
program, execute:
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{path_to_cinelerra} -r batchjob.xml

substituting your actual filename for batchjob.xml. When invoked with these
parameters, CINELERRA-GG will start up and perform the rendering jobs in that
list, without creating its usual windows.

6.2.1 Command Line Rendering

The command line rendering method consists of a way to load the current set of
batch rendering jobs and process them without a GUI. This is useful if you want to
do rendering on the other side of a low bandwidth network and you have access
to a high powered computer located elsewhere. Setting up all the parameters for
this operation is somewhat difficult. That is why the command line aborts if any
output files already exist.

To perform rendering from the command line, first run CINELERRA-GG in graphical
mode. Go to File → Batch Render. Create the batches you intend to render in
the batch window and close the window. This saves the batches in a file. Set up
the desired render farm attributes in Settings → Preferences and quit out of
CINELERRA-GG if you want to use the Render Farm capability. These settings are
used the next time command line rendering is used to process the current set of
batch jobs without a GUI.

On the command line run:

cinelerra -r

6.2.2 More about Save/Use EDL and Save/Load Jobs

The File → Batch Render pulldown brings up the Batch Render window to be
used for batch rendering as well as DVD/BD creation. There are some additional
buttons that can save time and mistakes. These are described next.

The Save to EDL Path and Use Current EDL buttons can be valuable tools for ad-
vanced usage or for developers doing testing. Description of how you can expect
them to work will help to illustrate how to take advantage of their capabilities.

Save to EDL Path if you have made a change to the EDL, use this button to save
the changes so that they will be used in the render operation. Although you
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can get the same results by using File → Save..., this capability was ini-
tially added to assist developers in testing the batch jobs needed to create
dvd/bluray media as it keeps the work focused in a single window and re-
tains the original job name. An example –you have everything all set up
with a new job in the Batch Render window using generic.xml for the EDL
path and with a job name of original_name.xml. Then you realize that
you forgot to cut out a section in the media that is not wanted in the final
product. You can cut that out and then Save to EDL Path so your change
will be in effect for the rendering. Without this button, you would be using
the EDL you started with and the cut would be ignored. Alternatively, if the
cut changes are saved via File → Save as. . . with a filename of new.xml
and then you use Save to EDL Path, the current highlighted job displayed in
the window as original_name.xml will be replaced with new.xml. How-
ever, it is important to note that the result will be saved with the name
original_name – that is, the new content from new.xml but with the old
name of original_name.xml.

Use Current EDL if you are working on media and still testing out the results,
you can take advantage of this click-box to quickly get results. Basically, you
change the media, save that change with another name (in order to preserve
the original name in case you don’t like the changes), and press Use Current
EDL. As an example, a user creates a new job in the Batch Render window us-
ing the current media, previously defined in generic.xml, with the EDL path
of generic.xml. The user then changes the media on the timeline, saves the
changes via File → Save as... with a new name, such as new_name.xml,
and then clicks on Use Current EDL. In this case, the EDL path listbox will be
automatically updated to the new_name.xml and the current existing high-
lighted job will be replaced with the new_name.xml in the EDL column.

Save Jobs when you have set up the batch jobs the way you want and you think
you may have to run them more than once, it is beneficial to save the jobs for
later use so you easily run them again.

Load Jobs reload a previous set of saved jobs. This can come in handy if you did
not have the time to render them when you originally set them up, if you
need to rerun, or if you got interrupted.

Warn if Jobs/Session mismatched After you set up your render and press Start,
the program checks to see if the current EDL session matches your Batch
Render job. If the EDL has been changed since the batch job was created,
it warns you so that you have the opportunity to Save to EDL path to record
those changes. Otherwise, you can dismiss that warning box, disable the
warning message by unchecking the box and use the original values. If you
never want to be warned about the mismatches, leave the box unchecked
(figure 6.5).
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Figure 6.5: Batch render with the 4 ghosted buttons on the right side + the Warning message
below

6.3 Background Rendering

Background rendering causes temporary output to be rendered constantly while
the timeline is being modified. The temporary output is displayed during playback
whenever possible. This is useful for transitions and previewing effects that are
too slow to display in real time. If a Render Farm is enabled, the render farm is
used for background rendering. This gives you the potential for real-time effects
if enough network bandwidth and CPU nodes exist.

Background rendering is enabled in the Performance tab of the Preferences win-
dow. It has one interactive function Settings → Toggle background rendering.
This sets the point where background rendering starts up to the position of the in-
sertion point. If any video exists, a red bar appears in the time ruler showing what
has been background rendered (figure 6.6).

It is often useful to insert an effect or a transition and then select Settings →
Toggle background rendering right before the effect to preview it in real time
and full frame rates (figure 6.7).

Frames per background rendering job This only works if a Render Farm is being
used; otherwise, background rendering creates a single job for the entire
timeline. The number of frames specified here is scaled to the relative CPU
speed of rendering nodes and used in a single render farm job. The optimum
number is 10 - 30 since network bandwidth is used to initialize each job.

Frames to preroll background This is the number of frames to render ahead of
each background rendering job. Background rendering is degraded when
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Figure 6.6: Settings Background Rendering

Figure 6.7: Timeline with the top red bar

preroll is used since the jobs are small. When using background rendering,
this number is ideally 0. Some effects may require 3 frames of preroll.

Output for background rendering Background rendering generates a sequence
of image files in a certain directory. This parameter determines the filename
prefix of the image files. It should be accessible to every node in the ren-
der farm by the same path. Since hundreds of thousands of image files are
usually created, ls commands will not work in the background rendering di-
rectory. The browse button for this option normally will not work either, but
the configuration button for this option works.

File format The file format for background rendering has to be a sequence of
images. The format of the image sequences determines the quality and speed
of playback. JPEG generally works well.

6.4 Render Farm Usage

Render Farm uses background rendering, a feature of CINELERRA-GG where the
video is rendered in the background, to speed up rendering significantly. Because
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rendering is memory and cpu intensive, using multiple computers on a network
via a render farm is a significant gain. With CINELERRA-GG installed on all nodes,
the master node and the clients communicate via a network port that you specify.

CINELERRA-GG can distribute the rendering tasks over the network to the other
computers of the Render Farm. The render farm software tries to process all of the
rendering in parallel so that several computers can be used to render the results.
The Total jobs to create in the setup or labels on the timeline are used to divide a
render job into that specified number of tasks. Each background job is assigned a
timeline segment to process and the jobs are sent to the various computer nodes
depending upon the load balance. The jobs are processed by the nodes separately
and written to individual files. You will have to put the files back together via a
load with concatenation, or typically by using a command line tool from a script.

6.4.1 Basic Steps to Start a Render Farm

The following steps are just a guideline to start your render farm. It is assumed that
you already have the master and client nodes communication, shared filesystem,
permissions and usernames synched.

1. On the master computer, use Settings→ Preferences→ Performance tab
to set up a Render Farm:

• check the Use render farm box;
• in the Hostname box, keyin your hostname or ip address such as 192.168.1.12

or localhost;
• enter in a port number such as 401–405 (only a root user can use privi-

leged ports) or 1025 and click on Add Nodes;
• you will see something like the following in the Nodes listbox to the right:

On Hostname Port Framerate

X 192.168.1.12 401 0.0
X 192.168.1.12 402 0.0
X 192.168.1.12 403 0.0
X 192.168.1.12 404 0.0
X 192.168.1.12 405 0.0
X localhost 406 0.0
X localhost 407 0.0

• set the Total number of jobs to create;
• click OK on the bottom of the Preferences window.

2. On the client computers (192.168.1.12), start 5 background CINELERRA-GG
tasks via:
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$ cd /{path_to_cinelerra}
$ cin -d 401
$ cin -d 402
...
$ cin -d 405

3. On the master node (localhost), start the 2 background CINELERRA-GG tasks
via:

$ cd /{path_to_cinelerra}
$ cin -d 406
$ cin -d 407

4. When your video is ready, setup a render job via File → Render or File
→ Batch Render and check OK.

5. The results will be in the shared file path/filename that you selected in
the render menu with the additional numbered job section on the end as
001, 002,003, . . . 099 (example, video.webm001).

6. When finished, load your new files on new tracks via File → Load concate-
nate to existing tracks or if you used ffmpeg, run RenderMux from the Shell
Scripts icon.

7. If you plan on doing more rendering, you can just leave the master/client
jobs running to use again and avoid having to restart them. Or you can kill
them when you no longer are using them.

6.4.2 Render Farm Menu and Parameter Description

Below we describe the Performance tab for configuring a render farm (figure 6.8).

Project SMP cpus although this field is not Render Farm specific, it is useful for
CINELERRA-GG to have the CPU count and for using multiple threads.

Use render farm check this to turn on the render farm option. Once checked ALL
rendering will be done via the farm including the usual Render (Shift-R).
You may want to turn if off for small jobs.

Nodes listbox displays all the nodes on the render farm and shows which ones
are currently enabled. The Nodes listbox has 4 columns – On, Hostname,
Port, Framerate – which show the current values. An X in the On designates
that that host is currently enabled; Hostname shows the name of the host;
Port shows the port number that host uses; and Framerate will either be zero
initially or the current framerate value.
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Figure 6.8: Settings→ Preferences, Performance tab, menu to set up your Render Farm

Hostname this field is used to edit the hostname of an existing node or enter a
new node.

Port keyin the port number of an existing or new node here. You can also type in
a range of port numbers using a hyphen, for example 1501−1505 when you
need to add many.

Apply Changes this will allow you to edit an existing node and to then commit
the changes to hostname and port. The changes will not be committed if you
do not click the OK button.

Add Nodes Create a new node with the hostname and port settings.

Sort nodes sorts the nodes list based on the hostname.

Delete Nodes deletes whatever node is highlighted in the nodes list. You can
highlight several at once to have them all deleted.

Client Watchdog Timeout a default value of 15 seconds is used here and the tum-
bler increments by 15 seconds. A value of 0 (zero) disables the watchdog so
that if you have a slow client, it will not kill the render job while waiting for
that client to respond.

Total jobs to create determines the number of jobs to dispatch to the render farm.
Total jobs is used to divide a render job into that specified number of tasks.
Each background job is assigned a timeline segment to process. The render
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farm software tries to process all of the rendering in parallel so that several
computers can be used to render the results.
To start, if you have computers of similar speed, a good number for Total jobs
to create is the number of computers multiplied by 3. You will want to adjust
this according to the capabilities of your computers and after viewing the
framerates. Multiply them by 1 to have one job dispatched for every node.
If you have 10 client nodes and one master node, specify 33 to have a well
balanced render farm.

(overridden if new file at each label is checked) instead of the number of jobs
being set to Total jobs to create, there will be a job created for each labeled
section. If in the render menu, the option Create new file at each label is
selected when no labels exist, only one job will be created. It may be quite
advantageous to set labels at certain points in the video to ensure that a key
portion of the video will not be split into two different jobs.

Reset rates sets the framerate for all the nodes to 0. Frame rates are used to scale
job sizes based on CPU speed of the node. Frame rates are calculated only
when render farm is enabled.

Framerates can really affect how the Render Farm works. The first time you use the
render farm all of the rates are displayed as 0 in the Settings → Preferences,
Performance tab in the Nodes box. As rendering occurs, all of the nodes send back
framerate values to the master node and the preferences page is updated with
these values. A rate accumulates based on speed. Once all nodes have a rate of
non-zero, the program gives out less work to lower rated nodes in an effort to make
the total time for the render to be almost constant. Initially, when the framerate
scaling values are zero, the program just uses package length – render size divided
by the number of packages to portion out the work (if not labels). If something
goes wrong or the rates become suspect, then all of the rest of the work will be
dumped into the last job. When this happens, you really should reset rates for the
next render farm session to restart with a good balance.

{cinelerra pathname} -h #displays some of the options.

6.4.3 Detailed Setup Description

CAUTION , any exact command lines worked as of 01/2018 on a Fedora system.
These can change over time and on different operating systems/levels. Always
check/verify any command line before using.

Set up CINELERRA-GG A CINELERRA-GG render farm is organized into a master
node and any number of client nodes. The master node is the computer which
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is running the gui. The client nodes are anywhere else on the network with
CINELERRA-GG installed and are run from the command line. Before you start
the master node for CINELERRA-GG, you need to set up a shared filesystem on
the disk storage node as this is the node that will have the common volume
where all the data will be stored. The location of the project and its files
should be the same in the client computers as in the master computer and to
avoid problems of permissions, it is better to use the same user in master and
clients. For example, if you have the project in /home/<user>/project-video
you must create the same directory path on the clients, but empty. Sharing
the directory of the location of your project on the master computer can be
done with NFS as described next. Alternatively, you can look up on the inter-
net how to use Samba to share a directory.

Create a shared filesystem and mount using NFS All nodes in the render farm
should use the same filesystem with the same paths to the project files on all
of the master and client nodes. This is easiest to do by setting up an NFS
shared disk system.

1. On each of the computers, install the nfs software if not already installed.
For example, on Debian 9 you will need to run: (be sure to check/verify
before using any command line):

$ apt-get install nfs-kernel-server

2. On the computer that contains the disk storage to be shared, define the
network filesystem. For example to export /tmp, edit the /etc/exports
file to add the following line:

192.168.1.0/24(rw,fsid=1,no_root_squash,sync,no_subtree_check)

3. Next reset the exported nfs directories using:

$ exportfs -ra

and you may have to start or restart nfs:

$ systemctl restart nfs

4. Each of the render farm computers must mount the exported nfs target
path. To see the exports which are visible from a client, login as root to
the client machine and keyin:
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$ showmount -e <ip-addr> #using the ip address of the storage host

5. to access the host disk storage from the other computers in the render
farm, mount the nfs export on the corresponding target path: (be sure
to check/verify before using any command line):

$ mount -t nfs <ip-addr>:/<path> <path>

where <path> is the storage host directory, and <ip-addr> is the net-
work address of the storage host. Because all of the computers must have
the same directory path, create that same directory path with the same
uid/gid/permissions on each storage client computer ahead of time.

6. To make this permanent across reboots on the client nodes, add the fol-
lowing line to /etc/fstab:

{masternode}:/nfsshare /mnt nfs defaults 0 0

You can make this permanent on the disk storage host BUT the command
lines shown, which were correct in January 2018 on Fedora, may be dif-
ferent for your operating system or in the future. In addition if your
network is not up, there may be numerous problems. If you make a mis-
take, your system may not boot. To make permanent, add the following
line to /etc/fstab:

192.168.1.12:/tmp /tmp nfs rw,async,hard,intr,noexec,noauto 0 0

You will still have to mount the above manually because of the noauto
parameter but you won’t have to remember all of the other necessary
parameters. Depending on your expertise level, you can change that.
Later, to remove access to the storage host filesystem:

$ umount <path>

Be aware that you may have to adjust any security or firewalls you have
in place. Most firewalls will require extra rules to allow nfs access. Many
have built-in configurations for this.

Configure Rendering on Master Node There is 1 master node which is running
the CINELERRA-GG gui and where the video will be edited and the command
given to start up the rendering. Any number of client computers can be run
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from the command line only, so they can be headless since no X or any graph-
ical libraries are needed. Of course, the CINELERRA-GG software must be in-
stalled on each of the client computers.

1. Assuming you already have CINELERRA-GG installed on the master node,
start CINELERRA-GG by clicking on the icon or by typing the following
command on the terminal screen: /cinelerra_path/cin.

2. Use the file pulldown Settings → Preferences, the Performance tab,
to set up your Render Farm options in the Render Farm pane.

3. Check the Use render farm option. By default, once you enable the option
of Render Farm, rendering is usually done using the render farm. Batch
rendering can be done locally, or farmed.

4. Add the hostname or the IP address of each of the client nodes in the
Hostname textbox and the port number that you want to use in the Port
textbox. You can make sure a port number is not already in use by keying
in on the command line:

$ netstat -n -l -4 --protocol inet

Next, click on the Add Nodes button and then you will see that host ap-
pear in the Nodes list box to the right. The X in the first column of the
nodes box denotes that the node is active. To review the standard port
allocations, check the /etc/services file.

5. Enter the total jobs that you would like to be used in the Total job textbox.
6. The default watchdog timer initial state is usually just fine but can be

adjusted later if needed.
7. Click OK on the Preferences window when done.

Create Workflow While working on the master computer, it is recommended that
you keep all the resources being used on the same shared disk. Load your
video/audio piece and do your editing and preparation. Add any desired
plugins, such as a Title, to fine-tune your work. You want to make sure your
video is ready to be rendered into the final product.

Start the Client Nodes To start up the client nodes run CINELERRA-GG from the
command line on each of the client computers using the following command:

/{cinelerra_pathname}/cin -d [port #] ; \#for example /mnt1/bin/cinelerra -d 401

This starts CINELERRA-GG in command prompt mode so that it listens to the
specified port number for commands from the master node for rendering.
When you start each of the clients up, you will see some messages scroll by
as each client is created on that computer, such as:
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RenderFarmClient::main_loop: client started
RenderFarmClient::main_loop: Session started from 127.0.0.1

As it completes its jobs, you will should see:

RenderFarmClientThread::run: Session finished

A quick way to start a sequence of clients is to use:

or n in ‘seq 1501 1505‘; do cin -d $n; done

Render Using Render Farm After you have followed the preceding steps, you are
ready to use the render farm. Click on File → Render. . . which opens the
render dialog. The most important point here is to use for the Output path /
Select a file to render to a path/file name that is on the shared volume that is
also mounted on the clients. Click on OK to render. The CINELERRA-GG pro-
gram divides the timeline into the number of jobs specified by the user. These
jobs are then dispatched to the various nodes depending upon the load bal-
ance. The first segment will always render on the master node and the other
segments will be farmed out to the render nodes. Batch Rendering, as well
as BD/DVD rendering, may use the render farm. Each line in the batchbay
can enable/disable the render farm. Typically, video can be rendered into
many file segments and concatenated, but normally audio is rendered as one
monolithic file (not farmed).
Another performance feature which can use the Render Farm is Background
Rendering. This is also enabled on the Preferences → Performances tab.
The background render function generates a set of image files by pre-rendering
the timeline data on the fly. As the timeline is update by editing, the image
data is re-rendered to a background render storage path. The Render Farm
will be used for this operation if it is enabled at the same time as the back-
ground render feature.

Assemble the Output Files Once all of the computer jobs are complete, you can
put the output files together by using the shell script, RenderMux (from the
menubar scripts button just above FF), if the files were rendered using ffm-
peg, or you can load these by creating a new track and specifying concatenate
to existing tracks in the load dialog in the correct numerical order. File types
which support direct copy can be concatenated into a single file by render-
ing to the same file format with render farm disabled as long as the track
dimensions, output dimensions, and asset dimensions are equal.
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6.4.4 Quick and Easy Render Farm Setup – The Buddy System
Way

These steps are for quickly setting up render farm with the least amount of addi-
tional system work, but it is non-optimal. It is useful in situations where a few
people all show up with their laptops to work together on the same video/audio
file and you don’t want to bother setting up NFS for a shared disk.

1. Make sure the CINELERRA-GG program is installed on all of the computers and
the network between the main computer and the client computers is working.
Use the same version if possible.

2. Load your video file on the master node and use File → Save as. . . to save
it to /tmp.

3. Move that same file with the same name to /tmp on all of the client computers
via rsh or sneaker net – the ONLY reason you are doing this is to avoid having
to set up NFS or Samba on the buddy client laptops that show up!

4. Edit your video/audio file to get it the way you want it and add the plugins,
such as a Title, etc.

5. Check for a set of unused ports in /etc/services file, if username is root
usually 401− 425 are available; if non-root, then 1024− 1079.

6. On the master computer, in Settings → Preferences, Performance tab:

• check the box Use render farm
• keyin localhost for the hostname or an ip address of the buddy client

node
• keyin the desired port number for each client; and use Add Node for each

host
• set total jobs to the number of client computers +1 multiplied by 3 (or

proportion to client speeds)
• check OK

7. On each buddy client, create a job for each port:

/{cinelerra_pathname}/cin -d port#

8. On the master, bring up the render menu and name the output files, for ex-
ample /tmp/myoutput.mp4.

9. The client nodes output results will be on their local /tmp filesystems so you
will have to again use rsh/ftp or usb sneaker net to move them over to the
main computer. File names will be the render job output file name with port
number tacked on (e.g. /tmp/hb.mp4001...mp4005).

10. Load the files by concatenate to existing track on the master node or use
RenderMux shell script.
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6.4.5 Multi-core Computers Render Farm Setup

If you are lucky enough to have a computer with a large cpu core count, setting
up a render farm can really take advantage of using all of the cpus. This is much
faster than the default automatic threading capability. Since you don’t need to
communicate with other computers, you will not have to be concerned about TCP
communication or shared disks/files. When you are going to be doing other work
simultaneously while rendering a large job, you will want to leave some of the cpus
available for that. Be sure to set “Project SMP cpus” in the Settings→Preferences,
Performance tab to your CPU count.

6.4.6 Troubleshooting Tips and Warnings

If you have problems running the Render Farm. Here is a list of items to check.

• CINELERRA-GG must be installed on the master node and all client machines.

• It is best to have the same username available on all nodes to avoid problems
with access rights.

• Check file permissions and ownership to ensure that the clients all have ac-
cess.

• If a node does not have access to an input asset it will not die, but just display
error messages.

• If a node can not access an output asset, the rendering will abort.

• A port in use when stopped may take up to 30 seconds to time out before you
can restart the jobs.

• Each of the port combinations have to be unique across clients, and not al-
ready in use in the network.

• CINELERRA-GG load balances on a first come, first serve basis. If the last
section of the video is sent to the slowest node, the render job will have
to wait for the slowest node to finish. It would be better to start on the
slowest node with the earlier section of the video so keep that in mind when
designating port numbers.

• If not running as root, a port number in the higher range of 1024 and above
must be used instead of the 400+ range.

• The master and client jobs on the ports do not go away so if you want to stop
them, you will have to kill them via: kill PID#.

• Check to see if there are services listening on the ports to use: netstat -n
-l -4 –protocol inet

• There is a watchdog timer in CINELERRA-GG and if there is no response from
a client in the designated number of seconds, it will kill the render job.
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• The localhost should exist as 127.0.0.1 in /etc/hosts and as the lo network
device in ifconfig.

• If the job loads become unbalanced, you may want to reset rates to start over
for new framerates.

• If jobs are split in a key section on the timeline, you may wish to use labels to
prevent this.

• For testing purposes, you may want to start a client in the foreground using
-f instead of -d.

• If one of the client computers is unavailable, check to see if there is an X to
the left of the nodename in the Nodes listbox. Check the X to disable it which
sets ON to OFF.

• A red message in the lower left hand corner of the main timeline that reads
Failed to start render farm often means that the client CINELERRA-GG pro-
grams were not started up.

• A message of RenderFarmWatchdog::run 1 killing server thread
#address# means that the client did not respond in time. You can adjust the
timer in Settings → Preferences, Performance tab.

• When you get the message RenderFarmClient::main_loop: bind port
400: Address already in use, use a different port.

• A message of RenderFarmServerThread::open_client: unknown host
abcompany means that the hostname of abcompany is not in /etc/hosts so
you will have to add it or use the ip address instead.

• There are numerous error messages associated with file open/close/status or
problems with the file that should be dealt with according to what is printed
out.

• Other illustrative messages may be shown such as: RenderFarmClientThread::
run: Session finished.

And here are a couple of more tips for making Render Farm specific for your setup.

• Because index files speed up displaying the video you may want to share these
files with the clients on a shared filesystem. More information on index files
configuration is outlined in 16.4.3.

• Or, one of the convenient features of Cinelerra is the redirection of the path
via CIN_CONFIG as in:

CIN_CONFIG=/<shared_file_pathname>/<filename_such_as_.bcast5> /<
,→ cinelerra_pathname>/cin
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This means that you can make project related configurations that do not im-
pact the default $HOME config. You can either export your default $HOME config
or the CIN_CONFIG config to use on the render farm.

Warnings If one of the render farm computers is connected to the internet, you
should use a firewall to maintain the safety of all of the computers. The ports have
to be reachable for the intranet but you do not want the ports to be open to the
outside.

6.5 Some Specific Rendering

The next few pages relate to rendering for specific common cases.

6.5.1 FFmpeg Common H.264 Rendering

Because H.264 is so widely used, the method in CINELERRA-GG Infinity is outlined
below. These setup steps make it easy to just get started.

• File→ Render

• File Format→ FFMPEG + mp4

• Video Wrench → Preset → h264.mp4 + bitrate: 6000000 (or whatever) +
OK

• Audio Wrench→ Preset→ h265.mp4 + bitrate: 224000 (or whatever) + OK

• Set your target path in: Render→ Select a file to render to

• Set your timeline in: Render→ Render range + click Project

• Set your insertion strategy: Replace project (or whatever)

• Press OK to start rendering.

6.5.2 Lossless Rendering

Lossless means that in the compression of a file, all of the original data, every single
bit, can be recovered when the file is uncompressed. This is different than lossy
compression where some data is permanently deleted so that when uncompressed,
all of the original data can not be exactly recovered. Lossy is generally used for
video and sound, where a certain amount of information loss will not be detected
by most users or the playback hardware does not reproduce it anyway – it is a
trade-off between file size and image/sound quality. The files created will be more
than 10 times larger than usual. Most players will not be able to decode lossless
as the bitrate will overwhelm the device.

177



6.5. Some Specific Rendering

For x264 lossless compression to work, the only color model allowed here is yuv420p.
Any other specification will be converted to yuv420p and the data will be modi-
fied. Also, keep in mind that the YUV color model has to be converted to RGB,
which also modifies the data.

To use x264 lossless rendering – choose File format of ffmpeg, m2ts in the Ren-
der window. Click on the Video wrench, which brings up the Video Preset win-
dow and scroll down in the Compression filebox and choose lossless.m2ts. Pre-
set=medium is the default, but can be varied from ultrafast (least amount of com-
pression, but biggest file size) to veryslow (most amount of compression, but still
HUGE) in the parameter box where you see qp = 0. This option is also available
for bluray creation.

6.5.3 Extra “cin_” Options for Render with FFmpeg

There are several special parameters that can be used in the ffmpeg options file
to pass values to the codecs that are not normally available. They’re called Global
Options. These are explained below.

cin_pix_fmt The Render menus allows you to choose the codec input pixel for-
mat (figure 6.9). The Pixels selection provides the available pixel format options
for the chosen codec type; valid choices vary for the different file types. This list
represents the formats that the codec advertises. It is not always complete, and it
may include options that are not legal with all parameter configurations.

• The Bitrate, Quality, and Pixels fields are only updated when the Video Op-
tions are reloaded. This occurs when you either change the ffmpeg file for-
mat, or video presets compression fields.

• If the video options preset has cin_pix_fmt defined, its value will be loaded
as the default. If you override the default, the value you specify will be used.

• If the video options preset does not have cin_pix_fmt, the default pixel for-
mat will be computed by ffmpeg (avcodec_find_best_pix_fmt_of_list), using
the session format as the source choice. The best is usually the format which
is most similar in color and depth.

• If no choices are available, yuv420p for video will be used.

• You can also specify ffmpeg pixel formats which are not in the list. The list is
provided by ffmpeg as input selection, but is more like suggestions than fact.
For example, the raw formats can take almost any format, but the rawvideo
codec actually specifies no legal formats.

Some option files provide cin_pix_fmt to suggest a choice for good quality output or
to prevent parameter errors when the other provided parameters conflict with the
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Figure 6.9: Render & Video Preset menus displaying Pixel choices

best pixel format. This is the case in faststart_h264.mp4 where the profile=high
parameter dictates pixel format must be yuv420p.

cin_bitrate If you specify the bitrate, you can not specify the quality.
Example: cin_bitrate=2000000

cin_quality If you specify the quality, you can not specify the bitrate.
Example: cin_quality=7

cin_stats_filename This parameter is useful for 2 pass operations.
Example: cin_stats_filename /tmp/cin_video_vp9_webm

cin_sample_fmt For audio the preset sample format default is computed in a
similar way as stated above for video or can be set with the cin_sample_fmt pa-
rameter (figure 6.10). If no choices are provided, s16 will be used.
Example: cin_sample_fmt=s16

Private Options (muxers). In the window of the wrench in addition to the View
button, which allows more global options and changes to the formats, there is
an additional Format button that allows you to modify the Private Options, i.e.
relating to specific muxing formats. More information on all these options can
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Figure 6.10: Render menu showing where Samples is

be found at: https://ffmpeg.org/ffmpeg-all.html#Format-Options sections 19
and 21.

6.5.4 Two-pass Encoding with FFmpeg

In CINELERRA-GG for two-pass, you need to run ffmpeg twice, with the same set-
tings, except for designating the options of pass 1 for the first pass and then pass
2. In pass 1, a logfile that ffmpeg needs for the second pass is created. In pass 1
the audio codec should be specified that will be used in pass 2. For more infor-
mation on ffmpeg 2-pass, check https://trac.ffmpeg.org/wiki/Encode/H.264.
Different libraries may have different requirements and you will probably have to
determine this by looking online at ffmpeg or looking directly at that code.

This 2 line ffmpeg 2-pass operation can be functionally duplicated in CINELERRA-
GG in the steps below them:

ffmpeg -y -i input -c:v libx264 -b:v 2600k -pass 1 -c:a aac -b:a 128k -f mp4 /dev/null &&
,→ \

ffmpeg -i input -c:v libx264 -b:v 2600k -pass 2 -c:a aac -b:a 128k output.mp4

1. After you have completed your editing, do a Save Session with File → Save
as. . . Before starting, be sure your session is ready for batch render. That is,
positioned at the beginning and nothing selected.

2. Bring up File → Batch Render. . . where you will do the setup.
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3. Click on the Delete box to remove old jobs highlighted in the bottom listbox.

• For the File Format choose ffmpeg and mp4 for the type.
• Set Output path to the path and filename for the render output file.
• Click on Use Current EDL to use the designated EDL Path file.
• Click on New and you will see a new highlighted job show up in the

listbox at the bottom.
• Use the Audio wrench to set bitrate to 128000 (128k as in ffmpeg exam-

ple above).
• Click checkmark OK. Open the video tools with the video wrench.
• Set the Video Compression to h264.mp4 (as seen in the example).
• Set the bitrate to 2600000 (2600k as in ffmpeg example above).
• Add the following 2 lines after the first line:

flags +pass1
passlogfile /tmp/{temporary log file name}.log

Click checkmark OK.

4. Click on New to create the second pass job. You will see this second job in the
listbox below. Use the Video wrench and change pass1 to pass2 as follows.

flags +pass2

5. Click checkmark OK.

6. Click on the Start box and watch it go!

7. You can now check the output file for results. At the time this was docu-
mented, rc=2pass will be in the output.

If you need to re-render this, the Batch Render will still be set up but you have to
click on the Enabled column in the listbox to re-enable the jobs to run which puts
an X there. Click Start again. You can reuse batch job using the save jobs and load
jobs buttons in the batch render dialog.

Render shortcuts for webm, h264, h265 are available by using the option files
that are already set up for this purpose. Use the render menu as usual, with
ffmpeg/mp4, choose h264 or h265 pass1of2_h26x for the video and passes1and-
2_h26x for the audio; with ffmpeg/webm, choose pass1of2_vp9. When that is fin-
ished, you will have to use the render menu again and this time for video, choose
pass2of2_h26x or pass2of2_vp9. The logfile is hard coded in the options file so will
write over any currently existing logfile if you do not change it before you start
the render.
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Requirements for some other libraries
(used instead of flags +pass1 & passlogfile):

x265: add this line:

x265-params=pass=1:stats=/tmp/{temporary log file name}.log

at the time this document was written, you should see in the output:
stats-read=2

libvpx-vp9, xvid, and huffyuv:

cin_stats_filename /tmp/{temporary log file name}.log
flags +pass1 (or flags +pass2 for the second pass)

NOTE: for vp9, the best Pixels is gbrp

6.5.5 Use case: High Efficiency Video Coding (HEVC)

An example of video profile based on CRF, a quality-controlled variable bitrate,
instead of fixed quality scale (ABR). HEVC (H.265) was developed as a successor
to AVC (H.264) to more efficiently compress the future large amounts of data from
2/4/8k videos. In comparison to AVC, an average saving of around 30 percent can
be assumed for the same quality. Because HEVC is not bound to any size format,
it is suitable for virtually any image size.

The following example is HD and FullHD oriented and produces a picture quality
similar to the Blu-ray with some limitations. As container Matroska (.mkv) is used,
but also mp4 and others are possible.

matroska libx265

# CRF 16 creates a balanced compromise
# between quality and file size.
crf=16

# Preset changes encoding speed and generally
# degrades the overall result. Medium (default)
# always fits.
preset=medium
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# Additional parameters that are passed on to the codec.
# me=star improves the search for very fast
# movements, but slows down the encoding.
#x265-params=me=star

# Keyint does FFmpeg automatically, otherwise
# the setting must match the frame rate.
#keyint\_min=25

# Profile does FFmpeg automatically.
#profile=high

# Source sRBG and retention of color space.
# 720/1080=bt709 if no profile set. Useful
# for formats smaller than 720 if no lossy
# conversion is desired.
colorspace=bt709
color_trc=bt709
color_primaries=bt709

# Output in 10 bit, prevents 8-bit step formation
pixel_format=yuv420p

NOTE:

A CRF of 16 delivers satisfactory results in most cases. However, if the video ma-
terial is really grainy, a CRF 16 can lead to unwanted large files. In this case, a
trial export of perhaps one minute should be performed. The resulting bit rate
can be used to correct the CRF to 17, 18, 19. . . – remember, a CRF of 0 means loss-
less, the higher the number the stronger the lossy compression. The approximate
calculation of the final file size can be extrapolated from the sample export.

The color space information must be used explicitly so that it can be included
in the video. CINELERRA-GG or FFmpeg does not write it by itself. Without this
information the players (e. g. mpv) stick to the dimensions of the video and take
the assumed color model from a table. With videos in the dimensions from 720
to 1080 this is bt709. For smaller dimensions, e. g. DVD, bt601 is assumed and
for 4k and above it is bt2020. Normally this is not a problem, but if you want to
export a FullHD without color loss to a smaller size like 576 for example, you have
to inform the encoder as well as the decoder of the player. This also applies if the
videos are to be loaded on video platforms, where they are then converted into
videos of different sizes. It is a security measure to prevent false colors, such as
the color profiles in digital photos and the copies made from them.
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The HEVC tuning has not been considered here, because it is is rarely used and
requires background knowledge.

Further links:

• x265 Documentation

• x265 Command Line Options

• x265 Presets/Tuning

6.5.6 Piping Video to a Command Line

You can pipe a video to any command line on the computer, such as ffmpeg. This
can be especially useful with raw video files. Next is an example usage.

1. on a terminal window create a named pipe file, for example:

mknod /tmp/piper.yuv p

load your video and do your editing

2. set up your Render (Shift-R), you can choose a raw format such as yuv or
rgb

3. for the filename Select a file to render to, use the named pipe as created in
step 1 (/tmp/piper.yuv)

4. for Insertion Strategy, you will want to make sure to select insert nothing

5. click for OK on the green checkmark.(the CINELERRA-GG gui will look like it
is hanging while waiting for a command line to use the pipe.)

6. on the terminal window, keyin your command, for example:

/mnt0/build5/cinelerra-5.1/thirdparty/ffmpeg-3.4.1/ffmpeg -f rawvideo -
,→ pixel_format yuv420p \ -video_size 1280x720 -framerate 30000/1001 -i /
,→ tmp/piper.yuv /tmp/pys.mov

A slightly different option can be used instead that may be more familiar to some.
In the render menu after choosing the File Format of ffmpeg, use the pulldown to
choose y4m as the file type. This choice results in putting a header on the rendered
output with some pertinent information that can be used for ffmpeg processing
thus alleviating the requirement for pixel_format, video_size, and framerate on the
ffmpeg command line. In this case the format is yuv4mpegpipe instead of rawvideo.
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An example command line would look as follows (assuming the created pipe is
called piper.y4m):

ffmpeg -f yuv4mpegpipe -i /tmp/piper.y4m -vcodec libx264 /tmp/test.mp4

6.5.7 Faststart Option for MOV type files

If you have mov video and want to be able to start playing without having to first
load the entire video, -movflags=+faststart is needed for ffmpeg to put the meta-
data, known as the moov atom, at the beginning of the file. Otherwise, ffmpeg
puts this atom at the end of the video file which means you have to wait to play
until the whole video is loaded. Or worse yet, if the file becomes damaged in the
middle and you can not get to the end, you won’t be able to play anything.

Now you can have the moov atom put on the front of the file (automatically via
a second pass). To do this, when rendering using ffmpeg & either the mp4 or qt
format/container, click on the video/audio wrenches and choose faststart_h264.
With the qt format, settings will just be the default whereas the mp4 format uses
the highest quality and lowest file size as possible, but you can easily modify these
options in the associated Video Preset textbox.
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CHAPTER 7

Keyframes

The word keyframe has at least 3 contextual meanings in the NLE environment.
First, the oldest meaning, is the I-Frame definition used in codecs algorithms.
These are key frames that begin a new sequence of pictures, and are anchor points
for repositioning (seeks). Next are the automation parameter data points. These
are usually input to primitive math forms, like translation and zoom. And last are
blobs of data that are chunks of parameters to plugins that can do almost anything.
The data can be a simple value, like a fader value, or more complex like a group of
points and colors in a sketcher plugin keyframe. The word keyframe has changed
a lot in meaning. In the context of CINELERRA-GG, keyframes are data values that
have been associated to the timeline which affect the media presentation. So a
keyframe no longer refers to a frame, but to a position on the timeline.

In CINELERRA-GG, there are two general types of keyframe data, automation keyfra-
mes (autos) which are drawn as colored lines and box icons overlayed at a point
on a media track, and plugin keyframes which are drawn as gold key symbols on a

plugin bar of a track. Auto← Keyframe→ Plugin

7.1 Automation Keyframes / Autos

The autos are created by clicking on an automation curve to establish the time
position for the new keyframe anchor point. The basic nature of these simple auto
values make them primitive operations that are easy to apply when needed.

There are many automation curve types, and most are not normally visible or click-
able. To make them visible, use the View pulldown, or open the Window → Show
Overlays. This window allows toggling of the parameters in the View pulldown
but is more convenient because you can leave the window up to change values
quickly. If all of the automation curves are turned on, the timeline will be quite
cluttered, and so usually only the parameters of interest are enabled during use.
When keyframes are selected, they are drawn on the timeline over the tracks to
which they apply. The keyframe is represented on the timeline as a little square
on the curve, for example as in fade, or as a symbol as in a mask. This square,
timeline attachment point, can be used for positioning by clicking on a keyframe
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anchor and using drag and drop to set the new position.

The automation keyframes include:

mute/play audio; camera translation x,y and zoom; projector translation x,y and
zoom; fade blending; audio panning; overlay mode; mask point sets and sampling
speed.

Except for the mask auto, the values are all simple numbers. Mute is different
from the other autos in that it is simply a toggle of either on or off. Mute keyframes
determine where the track is processed but not rendered to the output. An example
usage would be to use auto keyframes to fade in a clip by setting the transparency
to 100% at the first keyframe and adding another keyframe 5 seconds later in the
timeline with a transparency of 0%.

The Keyframes pulldown on the main timeline is used for Cut, Copy, Paste, Clear,
Change to linear, Change to smooth, Create curve type of Smooth, Linear, Tangent,
or Disjoint, Copy default keyframe or Paste default keyframe. If you right click on
a curve keyframe on the timeline, a set of options popup including the choices
keyframe type (such as Fade, Speed, etc.), Hide keyframe type, Delete keyframe,
Copy keyframe, smooth curve, linear segments, tangent edit, or disjoint edit.

Usually, the use of the keyframe values are more pleasing when the data varies
smoothly between keyframe anchors on the timeline. This is useful in many cases
that are familiar, like a video fade in/out, or audio pan between channels. To make
the auto value change smoothly as the media is played, the keyframes auto values
are points on curves that are created according to the design of the effect. Most
of the primitive types can create anchor points on curves that are piecewise linear,
smooth, sloped, or broken at the keyframe anchor points.

Curve smoothing is called interpolation and it uses keyframe point values and con-
trol values that determine how the curve will react at the time the media is played
or rendered. Interpolation uses 2 keyframes to create a set of intermediates which
are used as active values between the previous and next keyframe anchors on the
timeline. The way the intermediate data is generated depends on the type of curve
used to invent these values. CINELERRA-GG interpolates the intermediate values
making the change happen smoothly and gradually over time. The simple linear
mathematical formula for interpolation is: a × (1 − t) + b × t where 0 ≤ t ≤ 1
uniformly.
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7.2 Using Autos

The first click on the curve, creates a keyframe which you can click drag on to
reposition. The second click at a later position, generates the smoothing by cre-
ating a smooth ramp. Ctrl-dragging on a keyframe round control point handle
changes the value of either the input control or the output control. This affects
the sharpness of the curve. While the input control and the output control can
be moved horizontally as well as vertically, the horizontal movement is only for
legibility and is not used in the curve value. When you Shift-drag on a timeline
curve, the keyframe snaps to the value of either the next or previous keyframe,
depending on which exists. It will snap up or down depending on direction of
movement. This lets you set a constant curve value without having to copy the
next or previous keyframe.

To make it easier to navigate curve keyframes, since there is not much room on
the timeline for a wide range of curve values, you need to zoom the curves in
and out vertically to have any variability. This is done by 2 tools: the automation
fit button, Alt-f, and automation zoom menu which is seen at the bottom of the
main window (figure 7.1). The automation fit button scales and offsets the vertical
range so the selected curve area appears in the timeline. If a region of the timeline
is highlighted by the cursor, only that region is scaled. In/out points do not affect
the zoomed region. The automation zoom menu manually changes the vertical
scaling of the curves in multiples of 2. Click on its tumbler to change the zoom.
Alt− ↑ and Alt− ↓ change the automation zoom from the keyboard.

Figure 7.1: Automation zoom menu with tumbler

Other mouse actions have the following effects:

• Double left mouse click on a curve Fade or Speed line will create ganged
keyframes so that there is a keyframe on each of the tracks in the exact same
position.

• Left mouse click on a keyframe position will show the numerical value in a
yellow tooltip-like box.

• Right mouse click on the curve type line will bring up the option of Hide
keyframe type. This provides the same functionality as disabling the keyframe
type in the View pulldown menu. Often it helps to use this in order to be able
to see other things on the timeline once it gets cluttered.
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• Fade and speed allow for setting a specific value for the keyframe using the
following:

1. click using the right mouse button on one of the auto speed keyframes
on the timeline;

2. a popup menu comes up with speed or fade auto type as the first menu
item;

3. click on speed or fade and a colored slider bar will appear (default speed
= orange; fade = pink);

4. click the slider, press and hold the left mouse button and move the slider
to update the value or simply type in a value in the textbox followed by
pressing the Enter key or click the checkmark;

5. a tooltip shows the keyframe value;
6. release the button, the slider will be deleted from the canvas, and the

value will be updated.

You can click mouse button 3 on a keyframe box and a menu pops up with the first
menu item showing the keyframe type. The top menu item can be activated for
immediate access to update the automation keyframe value. Some keyframe types,
which have values that can be manipulated in another way than by dragging the
color coded line, now show up with a different colored background to make them
more visible. Keep in mind that Zoombar ranges/values must be set to appropriate
values when working with specific keyframe types, such as Fade or Speed. If you do
not see the auto line in the visible area of the video track, try the key combination
Alt-f or select the speed in the Automation Type drop-down menu at the bottom of
the main window. To the right of this field is Automation Range where you can set
the display ratio of these lines. Simply change the values until the lines are visible
again.

Figure 2.36 and figure 7.2 shows several color coded lines for different keyframes
and specifically the slider bar for the Fade keyframe. It is in the same color as the
color coded keyframe type line which is the same color which would be shown in
the Show overlays window figure 2.35.

In the Editing section of Settings → Preferences, Interface tab there is Keyframe
reticle with options of Never, Dragging, or Always. This is used to help in checking
edit alignment across tracks. (A reticle is a sighting line used to line up visual
items, like cross hairs in a eyepiece.) The appearance and function of sighting
lines can be changed when dragging auto keyframes. To see the effect, create
some fader autos and drag a few to see the reticles drawn — you will see some-
thing similar to the next screencast (figure 7.3). Always renders a line over all
plugins, and dragging only over the drag icon. Never draws nothing. The default
is dragging.
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Figure 7.2: Fade curve with pink colored box Keyframe and Slider bar

Figure 7.3: Fade Auto with Always set for easy to see numeric values

Figure 7.4: Fade Auto with Controls

Control points allow for setting the
slope of auto curves and then sub-
sequently adjusting that slope (fig-
ure 7.4). To modify a current keyframe
you just right mouse it and change to
either Tangent or Disjoint edit. In the
screencast to the right, the Fade Auto
has pink colored curves and control
points are seen as dashed lines next to
the keyframe box with black filled circles on each end of the line. Use the Ctrl key
with the left mouse button to modify the control point lines.

7.3 Speed / Fade Automation Usage and Auto Gang

Speed automation resamples the data at a higher or lower playback rate. Speed
automation can operate on all tracks of the same type, either video or audio, with a
single click; or all tracks, both video and audio, with a double click. The curves to
be affected must be both armed and ganged in the track patchbays to be included in
the operation. You can see the advantage of having different media types ganged
the same so that they will remain synchronized. However, if as recommended
you have Settings of Align cursor on frames set, video will always snap to a frame,
whereas audio does not. Because the smallest pieces are audio and not video,
when video is present in order to maintain synchronization be sure to do the double
click on the video track. The single/double click feature also works in the same
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manner for Fade Automation.

The conversion algorithms that calculate the duration are approximate, not exact.
Speed is not checked when inserting media on a track that already has speed ad-
justments so duration will not be corrected in that case. You can not do negative
time and you can not play backwards.

Steps to demonstrate Auto Gang of Speed/Fade on all of the audio and video tracks
are listed below:

1. Use the pulldown menu View on the main canvas and ensure that there is a
checkmark left of the Speed or Fade selection.

2. Double click and hold button 1 on any point of the Speed line on any track of
the main track canvas and drag the handle where you want it, then release
button 1.

3. Note how all video and audio boxes move together simultaneously for syn-
chronization.

4. You can adjust the sampling rate (speed/fade) at any time by doing the same
single/double click on a keyframe.

5. To move the location left or right, hold down button 1 while moving it back
and forth.

6. Use the status bar in the lower left hand corner to see position and playback
rate.

Releasing button 1 ends the current dragging operation, but single clicking on a
speed/fade keyframe handle again will restart the drag operation on tracks of the
same type. Double clicking will select all armed tracks which have handles in the
exact same cursor position. It is sometimes difficult to get the desired value for
the speed and it may take a few tries to get to the desired endpoint, but you can
use an auto slider bar to get better control for more precision. This is not ganged
so you will have to do this on each track to achieve the same value.

An easy way to get an exact position is to set the Automation range in the bottom
bar of the main window to the low and high ends of the desired range. For exam-
ple, 1.000 to 50.000, which makes it so you can drag the speed/fade handle all
the way to the left for 1.000 or all the way to the right for 50.

Figure 7.3 shows orange keyframes and lines for the ganged speed automation on
all video/audio tracks. Note the status bar numbers in the lower left-hand corner
displaying 2.17 seconds as the location and 0.38 as the playback rate. The figure
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Figure 7.5: Ganged Speed Auto on all tracks and Speed auto with orange Slider bar

also shows the orange speed slider bar triangle with the current value displayed
via the tooltip.

One other helpful item is a small colored indicator in the zoombar Automation Type
box when you have clicked on an auto line. It will be the same color as that line
so you can easily see out of the corner of your eye what that line refers to. This is
especially useful for the Camera and Projector X,Y,Z lines which are often right on
top of each other. In addition the status bar will have the colored indicator to the
left of the last auto value when that status is visible.

7.4 Plugin Keyframes

The Plugin keyframes are structured. The individual data values are named pa-
rameters to the keyframe function. For example, the hue plugin has keyframe
parameters of hue, saturation, and value. Each plugin has its own parameters,
and what they do depends on the plugin. Most of the time, it is pretty obvious
what the value controls, like the audio gain plugin with the level parameter. Some
of the plugins have a wide variety of controls, like the titler which can setup a wide
number of controls, like formats, fonts, styles, placement, and so on.

Plugins also may use interpolation to smooth the data between the keyframe para-
maters on the timeline. Just exactly how this is done varies with the plugin and
is not always easy to predict, but this is usually due to the nature of the keyframe
parameter data. For example, it does not make sense to interpolate which font is
in use.
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7.5 Default Keyframe

For plugins, there is a special hidden keyframe, called the default keyframe, that is
used when no previous keyframe exists. It is like keyframe zero on the timeline,
and it is persistent and shared on all sessions. The intent is to make a parameter
set that is likely to be reused on all initial instances of the plugin. An example may
be to color correct a set of media that was taken in low light, or needs resampling
to be played correctly. The default keyframe is off the bar on the left side of the
plugin title bar and can not be seen. It is used when there is no previous keyframe
for its default values.

It may be useful to create a default keyframe which has specific desirable values for
later use. To do this, set the timeline to position 0 and be sure to disable generate
keyframes while tweaking. This will create a default keyframe at the beginning of
the timeline which contains global parameters for the entire duration. Or if you
have copied a non-default keyframe via Keyframes pulldown copy default keyframe,
it can be stored as the default keyframe by calling keyframes → paste default
keyframe. After using paste default keyframe to convert a non-default keyframe
into a default keyframe, you will not see the value of the default keyframe reflected
until all the non-default keyframes are removed.

The keyframes → copy default keyframe and keyframes→ paste default
keyframe allow conversion of the default keyframe to a non-default keyframe.

Keyframes → copy default keyframe copies the default keyframe to the clip-
board, no matter what region of the timeline is selected. The keyframes →
paste keyframes function may then be used to paste the clipboard as a non-
default keyframe.

Typeless keyframes enabled under the Settings pulldown allow keyframes from any
track to be pasted on either audio or video tracks. Ordinarily audio keyframes can
only be pasted to another audio track and video keyframes can only be pasted to
another video track.

7.6 Keyframe Edit Params for Plugins

Keyframe values can be set using the various plugin show controls (magnifying
glass) icon on the plugin track (figure 7.6). It is possible to see all of the keyframe
data in a raw format using the Edit Params popup menu item which you will see
when you right mouse click the keyframe icon on the timeline. The keyframe data
is stored in xml format, and the edit params feature allows you to view and modify
the xml data directly. This normally should not be necessary since the plugin’s
control gui displays the intended parameters, but this will let you view and specify
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just about anything that can be specified in xml. There is no validation checking
of the modified data.

Figure 7.6: Keyframe Parameters window for a Blue Banana plugin added to the video track

7.7 Generate Keyframes while Tweaking / Automatic
Keyframe Mode

Tweaking is defined as changing a parameter while playing – it can be small
changes or small motion increments performed in a series. These changes are
recorded as a series of new keyframes on the timeline. Enable automatic keyframe
mode by enabling the automatic keyframe toggle, that is Generate keyframes while
tweaking. In automatic keyframe mode, every time you tweak a key-framable pa-
rameter it creates a keyframe on the timeline. Since keyframes affect playback,
you should enable generate keyframes just before you need a keyframe and dis-
able when your parameter changes are complete. So turn on when ready to make
changes and turn off when done!

Also, before making a change, be sure to check the View pulldown and make the
desired parameter visible with the enable checkmark. The location where the
automatic keyframe is generated is under the insertion point. If the timeline is
playing back during a tweak, several automatic keyframes may be generated as
you change the parameter. When automatic keyframe mode is disabled, adjusting
a parameter adjusts the keyframe immediately preceding the insertion point. For
example, if two fade keyframes exist and the insertion point is between them,
changing the fader changes the first keyframe.
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7.8 Compositor Keyframes

Camera and projector translation is represented by two parameters: x and y, mak-
ing it difficult to adjust with curves. CINELERRA-GG solves this problem by relying
on automatic keyframes. With a video track loaded, move the insertion point to
the beginning of the track and enable automatic keyframe mode. Move the pro-
jector slightly in the compositor window to create a keyframe. Then go forward
several seconds. Move the projector a long distance to create another keyframe
and emphasize motion. This creates a second projector box in the compositor, with
a line joining the two boxes. The joining line is the motion path. If you create more
keyframes, more boxes are created. Once all the desired keyframes are created,
disable automatic keyframe mode.

Dragging the auto curve with tweaking off, adjusts the previous keyframe. With
tweaking on, if no keyframe is at the timeline position, then a new one is created at
that position and the modification value is applied. If you are halfway between two
keyframes, the first projector box is adjusted while the second one stays the same.
The video does not appear to move in step with the first keyframe. This is because
halfway between two keyframes, the projector translation is interpolated. In order
to set the second keyframe you will need to move after the second keyframe.

Image translation, motion direction, and speed determine the results. Motion
varies based on the interpolation type that is set, for example, if set to Linear,
the result will be uniform straight line motion. Smooth is the default so that in-
terpolation will generate curved lines with control points. Ctrl-drag the endpoint
of the control handle to adjust the curved slope.

7.9 More about Editing Keyframes

Keyframes can be shifted around and moved between tracks on the timeline using
similar cut and paste operations to editing media. Only the keyframes selected in
the View menu are affected by keyframe editing operations.

An often used, keyframe editing operation is replication of some curve from one
track to the other to make a stereo pair. The first step is to solo the source track’s
record patch by Shift-clicking on the arm track icon in the patchbay. Then either
set In/Out points or highlight the desired region of keyframes. Go to keyframes
→ copy keyframes to copy them to the clipboard. Solo the destination track’s
record patch by Shift-clicking on it and go to keyframes → paste keyframes to
paste the clipboard. Another common application for keyframe modification is to
highlight a region on the timeline which contains multiple keyframes that you want
to modify. Then when you adjust a parameter or set of parameters, the change will
be applied to all keyframes within the selection instead of a new keyframe being
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created. This only works when the keyframe stores multiple parameters and only
for mask and effect keyframes. Other types of keyframes are generated as usual.

And there is an easy way to delete keyframes besides selecting a region and us-
ing keyframes → clear keyframes. Click-drag a keyframe before its preceding
keyframe or after its following keyframe on the track. This is the only way you
can simultaneously delete keyframes on ganged tracks.

7.10 Allow Keyframes Spanning

When you create a drag selection and you modify a value in a plugin then every-
thing in the selection gets modified the same. It use the previous keyframe and if
there is no previous keyframe, then the default keyframe in your $HOME/.bcast5
definitions is used.
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CHAPTER 8

FFmpeg Interactions

CINELERRA-GG uses ffmpeg for decoding and encoding media, thus there are many
opportunities available to manipulate options.

8.1 FFmpeg Early Probe Explanation

When you open media, a series of libraries and codec functions are used to probe
the data, to see if it can determine the type of file format and codec parameters
needed to correctly decode the file. If ffmpeg probes early – Try FFMpeg first is in
effect for the FF button – it will usually find some way to try to decode just about
any contemporary media file. But there are some times that the built in codecs
are actually a better choice. A lot of this may fall into the category of personal
preference. For example, some may prefer the mpeg library in the CINELERRA-GG
code over the ffmpeg code because it has more decoding capability and seems to
be more robust when the media is damaged. In that case you will want the FF
button to read Try FFMpeg last.

To summarize, if ffmpeg probes early, you will never get to use the built in libraries,
and if you want to skip over buggy old libraries, use ffmpeg early probe enabled
so that the newest code will be tried first. The FF button is located in the upper
right hand corner of the main window.

When the icon is red, ffmpeg probes early is enabled and you will see it reads
Currently: Try FFMpeg first when moving over the FF button in the upper right hand
corner of the screen. When the icon is black, ffmpeg probes early is disabled so that
ffmpeg probes late and it reads Currently: Try FFMpeg last. The initial default state
of the icon is on, that is, ffmpeg probes first. Suggestion is to leave it on except in a
few special cases where it may be better to have early probes disabled. When you
mouse over the main menu FF toggle button, the text displays ffmpeg’s Currently
set position. Just left mouse click to change to the other setting. The ffmpeg
early probe state is saved between sessions and is also affected by choices made
in Probe Order (refer to section 4.3.3). It is important to note that the various file
indexes may need to be rebuilt if you change which codec is being used to decode
the file. There is a warning popup to remind you when you change the default
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ffmpeg early probe state (unless you have checked the box to no longer show the
warning). You can easily rebuild the index for a specific media file by going to the
Resources window, right mouse click on that media, and choose Rebuild Index
from the popup choices.

Figure 8.1 shows (1) reddish colored FF in upper right hand corner of main win-
dow indicating that ffmpeg early probes is enabled; (2) Try FFMpeg last indicator
message for ffmpeg early probes enabled (note that the color is different because
you highlighted the icon); and (3) black colored FF indicates ffmpeg will be used
last and you are changing the behavior so that CINELERRA-GG warns you accord-
ingly.

Figure 8.1: The three colors of Probe

8.2 How to Create FFmpeg Options Files

This section describes how the FFmpeg options files work for decoding and encod-
ing and goes into great detail. It will make more sense if you look at CINELERRA-
GG’s ffmpeg config directory and the CINELERRA-GG menus at the same time. It
is meant to include everything necessary for complete understanding. You will be
able to personalize your own options files without knowing all of the information
included below if you know the basics. The word encoding is used interchangeably
with the word rendering. The possible combinations for ffmpeg options files are
literally combinatorial – that is a lot (factorial!). The allowed media file format
/ codec choices are much more flexible than you might realize. When the ffm-
peg design was initially added, some parameter files which describe the choices
which the program uses had to be created. There are way too many to enumerate
in the deliverable CINELERRA-GG package. Some quite detailed information for
how ffmpeg options work is given here and hopefully, enough basics for simple
understanding. It may all seem complicated at first, but will become obvious.
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8.2.1 File naming convention

In CINELERRA-GG’s ffmpeg configuration directory you will see files as listed and
described below. File type and extension names are the key for CINELERRA-GG’s use
of ffmpeg. Basically the .opts file extension represents options; .dfl represents
defaults; and all the rest are media types. For example one media type is quicktime
so that *.qt file names would be the quicktime choices. In the file names below,
ext refers to a set of files with file names matching the *.ext file extension. And
typ refers to a type of format / codec combination used, that is, the media type.

In the ffmpeg configuration directory there are a series of options files used when
encoding or decoding audio or video. They are read in the order from top to
bottom and only the files needed for the current operation are added to the active
configuration.

ffmpeg/ffmpeg.opts global ffmpeg options, always used
ffmpeg/decode.opts global decoder options, used when opening existing files for decoding
ffmpeg/encode.opts global encoder options, used when creating new files for encoding
ffmpeg/audio/audio.opts audio encoder options, used when creating audio streams
ffmpeg/video/video.opts video encoder options, used when creating video streams
ffmpeg/plugin.opts parameters for ffmpeg filters as audio/video plugins

Decoder options: Normally, only ffmpeg.opts and decode.opts are used when
reading/decoding files, but may be specialized if a <path>/media.opts exists for
a given <path>/media.ext file. For example, if you want to only fail on fatal er-
rors and to always use the video filter, edgedetect, when working with your media
file dreaming.y4m, then create a file dreaming.opts in the same directory with
the contents of loglevel=fatal on the first line and video_filter=edgedetect on the
next. These specialized settings will override the defaults. The fatal loglevel is
especially handy for lesser quality media.

Encoder Options: Within the audio/video subdirectories of the first level ffmpeg
directory, the typ.ext files are for encoder (rendering) setups.

ffmpeg/audio directory of audio encoder settings

audio.opts options used by all audio encoders
typ1.ext, typ2.ext, . . . are all *.ext type choices for encoding audio
ext.dfl contains the default selection used when ext is first

selected

ffmpeg/video directory of video encoder settings
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video.opts options used by all video encoders
typ1.ext, typ2.ext, . . . are all *.ext type choices for encoding video
ext.dfl contains the default selection used when ext is first

selected

ffmpeg/format presets needed to initialize audio / video formats

8.2.2 Option File Format / Content

For the option files a specific format must be followed in creating the file content.
In typ.ext encoder parameter files, the first line is defined as:

muxer codec
(or) muxer codec | bitstream filter [ bitstream filter options ]

where the | represents piping the codec data through the bitstream filter. The rest
of the lines in the file should look as follows:

# in column one is a comment
id1 value1

(or) id2 = value2

Only one equals sign is allowed and it is just for readability. There may be any
number of id/value pair lines in a media definition, including zero. A typical line
might be:

bitrate 4000000
(or) bitrate = 5000000

There are 4 special id’s recognized by CINELERRA-GG which cause special process-
ing. They are:

duration overrides the probe duration when opening media for decoding

video_filter adds a video stream filter, eg. edgedetect,. . . at the stream level

audio_filter adds an audio stream filter, eg. echo,. . . at the stream level
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loglevel sets the library logging level, as quiet, panic, . . . verbose, debug

All other id’s should be in the ffmpeg documentation, and correspond to the global,
muxer, and codec option names and values used by ffmpeg. For example to set the
aspect ratio to 4:3, use:

aspect 4:3

Below shows an example: decode.opts which is used when the ffmpeg decoder
is initialized.

# apply at init decode
loglevel=fatal
formatprobesize=5000000
scan_all_pmts=1
threads=auto

The encoder options you see in the CINELERRA-GG menus depend on the files in
these directories, NOT THE CODE. If you add files, you will get to use more variety.

In the CINELERRA-GG directory, which contains the ffmpeg configuration folder,
there are the choices the program uses. When you open an ffmpeg format popup
dialog, the listbox contains all of the codec types which are identified by the
file.ext extensions. Decoding has only a few options, since the ffmpeg file
probes determine most of the options by looking at the media being opened, but
encoding media requires a lot of setup. Below are some of the folders and files
used to determine the configurations used by ffmpeg to decode and encode files.

These extensions create audio / video media classes:

dvd m2ts mkv mp3 mp4 mpeg qt pro

which become the choices in the render pulldown menu.

So if you want to create a mov codec class, add two new files to the ffmpeg con-
figuration directory:

audio/aud.mov and video/vid.mov

Now you will see this as what you can choose in the rendering choices for ffmpeg.
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Inside the file you will see that the first line is special. It is the muxer and codec.
For example:

h264 libx265

The contents may be something like:

# <path>/video/vid.mov
mp4 libx265
bitrate 4000000

This will code an mp4 formatted file using the lib264 codec encoder.

For audio and video together, the mux format must agree between the aud.mov
and vid.mov files when they are to be used together. The stream muxer must be
the same for all the streams in the file being written. For example:

# <path>/audio/aud.mov
mp4 pcm_mulaw

This will create mp4 media using audio format pcm_mulaw coding.

Both the audio and the video are using mp4 mux format, and so there will be 2
streams:

1. x265 video

2. pcm_mulaw audio

When the menu popup is created, there may be many choices for that class type,
so you may want defaults. That can be specified as:

audio/<class>.dfl and video/<class>.dfl

# audio/mov.dft
aud.mov
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# video/mov.dft =
vid.mov

The above will be the default choice when the menu opens.

When you see problems in using the new options files you have created and put
into place, add the following line to ffmpeg/encoder.opts:

loglevel=verbose

sometimes that will be enough to see what has caused a failure, or even catch
unexpected results.

There is an EXCEPTION to all of the above because of a conflict between ffmpeg
and the x264 person making the detection of default ffmpeg settings terminate
with an error. If you get this error, you must workaround this termination by
including parameters that don’t match 5 or more of the normal expected values.
So you just have to change a few parameters to avoid the probe detection. Here is
an example where you will notice the x264-params line tweaking values to throw
off the detection/error termination code.

# <path>/ffmpegvideo/test.mp4
mp4 libx264
preset=slow
x264-params keyint=25:min-keyint=4:qpmin=3:qpmax=33:qp_step=4:merange=8
crf 20

For more examples, look around the ffmpeg directory for examples which may be
close to what you are trying to use, and see if the parameters look usable.

This is quite complicated, but that is because ffmpeg has a lot of parameters and
history. Good results are not that hard to create. Initially you should mostly use
the defaults. If you send any new options files to cin@lists.cinelerra-gg.org, it will
be given consideration to being added to the baseline for future deliverables.

To get a listing of the current ffmpeg supported formats and codecs that can be
made to work with CINELERRA-GG, provided there are option files added, run the
following commands. This should be done from the <build> directory substituting
the location of <build> where you have installed CINELERRA-GG on your system
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and the ffmpeg may be a different version than 4.2 as used below. Then look at
the output created in /tmp/ff-formats.txt and codecs.txt.

/<build>/cinelerra-5.1/thirdparty/ffmpeg-4.2/ffmpeg -formats > /tmp/ff-formats.txt
/<build>/cinelerra-5.1/thirdparty/ffmpeg-4.2/ffmpeg -codecs > /tmp/ff-codecs.txt

8.2.3 Complete Options File Example

For illustrative purposes, here is an example of the options files that need to be
added for using the ffmpeg ProRes 422 format. This makes it possible to transcode
to h264.mov with FFmpeg retaining 10-bit yuv422p from the source to the target
output video.

Add the file named ./ffmpeg/audio/acc256k.pro which contains the following
lines:

mov aac
strict -2
b 256000

(Note that in the example above, even though the bitrate is set here to 256000, it
can be overridden by the render menu settings).

Add the file named ./ffmpeg/audio/pro.dfl which contains the following lines:

acc256k.pro

Add the file named ./ffmpeg/video/prores.pro which contains the following
lines:

mov prores
profile=2
# lines of comments

Add the file named ./ffmpeg/video/pro.dfl which contains the following lines:

prores.pro
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Then to use and to get 10 bit depth and preserve depth from decode to encode:

1. load media

2. use settings → format to set the frame rate, sample rate/channels, aspect
ratio, color model = rgb_float or rgba_float if blending

3. press Shift-R and select FFmpeg format type pro

4. select target path

5. check OK, and watch for messages in the terminal window

8.2.4 Viewing & Modifying FFmpeg Format Options inside CINELERRA-
GG

There are thousands of options for using ffmpeg. Now it is possible to view the
available options for a particular video and audio choice by using the wrench icon
and then clicking on the view box. FFmpeg has to be the selected file format for
this feature to be visible. It makes it a lot easier since only the applicable options
show up as opposed to everything that ffmpeg can do. These options are just
Hints and some may be missing due to the way that ffmpeg options are coded –
CINELERRA-GG shows the option data ffmpeg has exposed.

As an example, instead of reading the entire 264 library information, you only have
to look at the shown available options. Both the video and the audio are browsable.
The options visible in the Audio/Video Preset textbox are the final values which are
used when rendering once you have checked OK. For assistance in choosing the
options you want, use the view popup to see the objects that go with the selected
format tool, highlight the option, modify the parameter value in the box at the top
of the Options window based on what you want, and then click apply. Updated
parameter values or new parameters will be appended at the bottom. Note that
when you highlight an option, a tooltip will show up when available in the lower
right hand corner which describes the option. Also note that the Format and Codec
types are shown on the top line of the Options window.

Parameters exist in 3 layers: ffmpeg, codec, and an interface layer. You can apply
parameters to each layer. The top 2 layers are accessed with the Kind popup menu.
The ffmpeg layer is topmost, and is selected as Kind: ffmpeg. It can specify many of
the more common parameters, such as the bitrate, quality, and so on. The middle
layer is selected as Kind: codec. These options can specialize your choices, and
frequently includes presets and profiles useful for coding well known parameter
sets, like profile=high422, preset=medium, or tune=film, etc. The interface layer
may or may not be available. It is usually accessible only by an opts parameter,
like x264-params key=value:key=value:. . . These options are passed directly to
the low level codec library.
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Figure 8.2 shows ffmpeg video as the Kind. Note the x264opts (should actually be
x264-params now) in the Video Preset window immediately below.

Figure 8.2: FFmpeg wrench, video preset and view options

Figure 8.3 shows ffmpeg video for the Kind. Note the yellow tooltip in the lower
right hand corner describing the highlighted option. Also note the allowed Range
values above the box provided for keyins.

Figure 8.3: FFmpeg wrench, audio preset and view options

8.3 The FFmpeg Image2 Streams

Another feature gained from using ffmpeg in CINELERRA-GG takes advantage of
what is being referred to as the %d trick. This trick uses the ffmpeg muxer image2
and a filename template to create a series of image files of a given type. A specific
example is described below.
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To encode a series of 48 bit tiff output image files, add a file to the CINELERRA-GG
data ffmpeg/video subdirectory as in:

# \dots/ffmpeg/video/tiff.dfl
tiff48.tif

Then create an ffmpeg video encoder parameters file in the same directory:

# \dots/ffmpeg/video/tiff48.tiff
image2 tiff
pixel_format=rgb48

This will define a new ffmpeg encoder format which is a video image file format
that uses the tiff codec for encoding, and a pixel_format of rgb48 (or a similar
equivalent such as rgb48le). Next load up your project and set up for a Render
using File → Render in the usual way. Now the tricky part; the output file name
should contain a %d which will be the frame number used in the image output
filename as in: Select a file to render to /tmp/tiff_images/img%03d.tiff. You
will get multiple files as output – one for each frame!

The resulting directory of images can be opened for reading by simply opening the
template path. As in: File → Load Files /tmp/tiff_images/img%03d.tiff.
You will notice a file named the same as the template, which has been automati-
cally created, is empty, is needed, and has to remain with the set.

8.4 Raw Input Opts File for Video/Audio

Raw video is not affected by decoding on read in. This makes it very attractive to
provide raw image data for editing and rendering media. A wide variety of raw
formats are available via the ffmpeg file interface. To load media in a raw format,
select try ffmpeg first and create an accompanying opts file. The opts files must
be in the same directory as your media, with the same base name, and the .opts
extension. The opts file contents should reflect your video setup. An example
follows:

# Video file name: /tmp/buddy.mov
# Opts file name: /tmp/buddy.opts
# Contents of opts file:
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format=rawvideo
codec=rawvideo
video_size=352x240
pixel_format=yuv420p
duration=90.25

8.5 FFmpeg Items of Note

Quality Option when rendering: FFmpeg responds variably to the quality op-
tion in the render option but seems to respond well to bitrate. The subranges
used by quality even seem to vary somewhat depending on how old the codec
is. Some use 0 to 35, some use 0 to 500 or so. The quality is supposed to cause
the codec to output data until the noise level is below a limit determined by
the quality setting. Your specific results may vary.

Previous Changes when rendering: With ffmpeg there are 2 cases that the de-
faults will be used. The first time when you have nothing set up and any
other time when you reset the render File Format in the Render Menu. Oth-
erwise with ffmpeg, if you change a video compression type for the render
(for example h264.mp4 to h265.mp4), the settings will be from the previous
session settings.

Outstanding Issues with ffmpeg: There are some problems that need to be ad-
dressed by the ffmpeg developer group that adversely affect CINELERRA-GG.
These are stated below with the hopes that that group will fix them as time
permits.

• Make all the default parameters operational. When they are not, the
CINELERRA-GG plugins can’t be initialized since the initial state of the
filter is not operational. If that is not possible, then provide a set of
nominal parameters for each plugin, so that they can be used as the
plugins initial default state.

• Make the filter config function project the new parameter data into the
filter function at any point during filter operation. This is so that contin-
uous updates can be done as the plugin operates.

• Improve seek codec restarts. The past predictor must be reset or recon-
structed after a seek. The only documented way to seek is open/seek/-
play. Reopening the format layer is very expensive.
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CHAPTER 9

Plugins

There are realtime effects – these are the most useful and probably all you will ever
need – and rendered effects. The rendered effects are discussed separately in the
Rendered Effects section. Effect plugins modify the track when played, according
to how they are set, with no permanent storage of the output except when the
project is rendered. There are many Plugins in CINELERRA-GG Infinity which are
actually quite easy to use just by experimenting with them. The plugins are shown
and selected from the Resources window (figure 9.1). They are described in more
detail later.

Figure 9.1: Screencast of the native Video plugins in the default Cinfinity icon set.

There is a choice of plugin icons which can be displayed.

In Settings→ Preferences→ Appearance tab, there is a pulldown for Plugin
icons where the user can choose between the original icons, regular or smoother,
cinfinity1 – the default modernized set, or cinfinity2 (figure 9.2).

Note that when you change the plugin icons, your session will automatically save
the backup, stop, restart, and reload (figure 9.3).

1Cinfinity /2 icon set is credited to Sam - Creative Common By – https:
//creativhecommons.org/licenses/by/3.0/
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9.1. How to Use Plugins

Figure 9.2: Cinfinity2 audio plugins

Preferences Window

Tab section

Plugin icon choices

Figure 9.3: Screencast showing the screen to change your plugin icons set

9.1 How to Use Plugins

Realtime effect plugins are listed in the Resources window as Audio Effects and
Video Effects. Effect plugins are used by dragging them from the Resources window
onto an audio track if it is an audio effect or video track if it is a video effect. You
will see a colored bar appear beneath the track with the plugin name on it. If there
is data on the destination track, the effect is applied to the entire track, unless a
region of the track is selected in which case the effect is pasted into that region
only. If there is no data on the track the effect is not added.

Plugins are layered under the track they apply to. When dragging more than one
effect onto a track, you will see the effects layering from top to bottom, on the
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9.2. Editing Effects

bottom of that track. When the track is played back, effects are processed from
top to bottom. The output of the top effect becomes the input of the bottom effect
and so on.

Instead of dragging from the Resources window, effects may be applied to a track
via a popup menu. Right click on a track and select Attach effect from the popup.
The attach effect dialog gives you more capability than just dragging and dropping.
For example, the attach effect dialog lets you attach two more types of effects:
shared effects and shared tracks which are explained in a later section. Select a
plugin from the Plugins column and hit the green colored checkmark under the
plugins column to attach it. The result is the same as if the effect was dragged
from the Resources window.

After attaching an effect to a track, it often needs to be configured. There are two
ways to get to the configuration controls. Click on the magnifying glass symbol on
the right side of the effect bar – this is the middle symbol on the bar as you can see
in the picture below. Alternatively, you can right click on the effect bar to bring up
the effect popup which has a Show option. Either method causes the GUI for the
effect to appear in a separate window. There will not be a popup if the plugin has
no GUI.

Besides the magnifying glass, for Show Controls, on the effect colored bar beneath
the track, there are two more symbols.

The rightmost knob is used to Turn Off/Turn On the
effect where the default is On. This is useful to easily
see that the plugin is doing what you expect. The leftmost symbol that looks like a
gear is for Preset Edit and its usage is described in the section Saved Plugin Presets.

9.2 Editing Effects

Many operations exist for manipulating effects once they are on the timeline. Be-
cause mixing effects and media is quite complex, the methods used in editing
effects are not as concise as cutting and pasting. Some of the editing happens by
dragging in/out points, some of the editing happens through popup menus, and
some of it happens by dragging effects.

When enabled, which is the default, and you edit tracks, the effects follow the
editing decisions. If you cut from a track, the effect shrinks. If you drag edit
in/out points, the effect changes length. This behavior can be disabled by select-
ing Settings→ Preferences→ Interface tab→ Editing section, see fig-
ure 9.4.
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Figure 9.4: Screencast of the native Video plugins in the default Cinfinity icon set.

To edit effects, you can move the timeline cursor over the effect borders until it
changes to a resize left or resize right icon. In this state, if you drag the end of the
effect, it performs an edit just like dragging an edit edge. The five editing behav-
iors of track trimming apply to effect trimming and they are bound to the mouse
buttons that you set in interface preferences as shown in the previous screencast.
Trimming simply means changes the duration dragging the edges.

When you perform a trim edit on an effect, the effect boundary is moved by drag-
ging it. Unlike track editing, the effect has no source length. You can extend the
end of an effect as much as you want. Also unlike track editing, the starting posi-
tion of the drag operation does not bind the edit decision to media. The media the
effect is bound to does not follow effect edits. Other effects, however, do follow
editing decisions made on an effect. You can disable effects from being subject to
the edit decisions by using the pulldown Settings and toggling off Edit effects. If
you drag the end of an effect which is lined up to effects on other tracks, the effects
on the other tracks will be edited while the media stays the same. When you drag
an effect in from the Resources window you can insert the effect in the portion
of the row unoccupied by the trimming operation. In some cases you will want
a trimming operation to change only one row of effects. This can be achieved by
first positioning the insertion point on the start or end of the effect. Then press
the shift key while beginning the trimming operation. This causes the operation
to change only one row of effects.

You can move effects up or down. Every track can have a stack of effects under
it. By moving an effect up or down you change the order in which effects are
processed in the stack. Go to an effect and right click to bring up the effect menu.
The Move up and Move down options move the effect up or down. When you are
moving effects up or down, be aware that if they are shared as shared effects, any
references will be pointing to a different effect after the move operation.

Finally, there is dragging of effects. Dragging effects works just like dragging edits.
You must select the arrow in the main window transport buttons line to enter
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drag and drop mode before dragging effects. Dragging a plugin causes a highlight
outline to be drawn over a targetable timeline region, and the plugin can be re-
positioned into any plugin track. The effects snap to media boundaries, effect
boundaries, and tracks. If you drag a reference to a shared effect, the reference
may point to the wrong effect afterwards. It is recommended that you re-construct
shared effect track references.

Figure 9.5 showing 5 plugins, two still plugin, two have already been dragged and
the Color 3 Way in the process of being dragged. Note the gold-colored arrow
which enables allow drag and drop editing mode.

Figure 9.5: Dragging the Color 3 way effect

9.3 Shared Effects and Shared Tracks

Two other effect types available in the Attach Effect dialog are Shared effects and
Shared tracks. In the case of a shared effect, the following conditions must be true:

• There must be other effects in the timeline.
• The other effects must be of the same type as the track you are attaching an

effect to. That is for audio tracks, effect must be audio and for video tracks,
effect must be a video effect.

• The insertion point or selected region must start inside the other effects.

In the case of a shared track, there must be another track on the timeline of the
same type as the track you are applying an effect to. If you right clicked on a video
track to attach an effect, there will not be anything in the shared tracks column
if no other video track exists. The same applies equally to audio tracks in that
another audio track must exist. Shared tracks are often used as layers for titles,
curves and keyframes.
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If shared effects or shared tracks are available, they appear in the shared effects
and shared tracks columns when you used the Attach effect option (RMB on a
track). When the green colored checkmark is clicked OK, anything highlighted in
the column is attached under the current track.

Shared effects and shared tracks allow very unique things to be done. In the case
of a shared effect, the shared effect is treated like a copy of the original effect,
except that in the shared effect the GUI can not be brought up. All configuration
of the shared effect is determined by the GUI of the original effect and only the
GUI of the original effect can be brought up.

When a shared effect is played back, it is processed just like a normal effect except
the configuration is copied from the original effect. Some effects detect when they
are being shared. These effects determine what tracks are sharing them and either
mix the two tracks together or use one track to stage some value.

When an original track has a shared track as one of its effects, the shared track
itself is used as a realtime effect. This is more commonly known as bouncing tracks
but CINELERRA-GG achieves the same operation by attaching shared tracks. The
fade and any effects in the shared track are applied to the original track. Once the
shared track has processed the data, the original track performs any effects which
come below the shared track and then composites it on the output.

In order to prevent the shared track from mixing the same data as the original track
on the output, enable the output mute toggle in the patchbay next to each track
for which you do not want to mix on the output. If you are making a video and
you do want the shared track to composite the original track’s data on the output
a second time, the video from the shared track would always appear under the
video from the original track, regardless of whether it was on top of the original
track. This is because shared tracks are composited in order of their attachment.
Since it is part of the original track it has to be composited before the original track
is.

9.4 Saved Plugin Presets

Presets and Factory Presets for Plugin settings are now combined with the Preset
Keyframe Parameters allowing you to choose, apply, delete, and edit your own Pre-
sets which can then be easily saved in the file $HOME/.bcast5/Cinelerra_presets.
In addition to your own saved presets, there are automatically available Factory
presets for some plugins, for example the Lens video plugin. The Factory presets
are preceded by an asterisk (*) and can not be modified permanently.
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Note that using this is directly changing a keyframe ob-
ject so you will only want to modify parameters you are
familiar with. Most of the data is obvious and safe to
change.

A Presets button on the plugin bar to the left of the Controls and On/Off button
allows for quick access to this feature. The symbol resembles a gear (figure 9.6).

A user preset Green

Textbox to type in the
title for the chosen
preset or name for a
new preset.

Use the Delete, Save
or Apply button for
operation.

Figure 9.6: Screencast shows 4 Factory presets as preceded by an *.

9.5 Some specific details concerning Plugins

These next few sections explain some details about the plugins that are not directly
related to actually using them but help to work with them.

9.5.1 How to see short Description of a Plugin

To get a short one or a few lines description of a plugin, right click on that plugin
in the Resources window and when the popup menu appears, select Info. Some
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of the plugins may not have any description included. An example screenshot is
next (figure 9.7).

Figure 9.7: Effect Info for Color 3 Way

9.5.2 Delete Plugins to save Resources Space or make them Un-
available

Maybe you just don’t ever use certain plugins or would prefer to only find the
ones that are useful to you. To save space in the Resources Window so you don’t
have to scroll to find the plugins you want as much, a feature to delete others is
available. If you have a System install, you will have to be root for this function to
be usable. The plugins will be permanently deleted, but only until you rebuild or
download a new set of CINELERRA-GG binaries. To delete a plugin, highlight the
plugin you no longer want in the Resources window then press Ctrl-Shift-delete.
A small window will come up allowing you to change your mind and red-X out or
check-OK to remove plugin. This feature may come in handy if you have personnel
working on media for you and you only want them to exercise certain functions.
Or maybe you can’t remember which is the good deinterlace plugin out of the
available five or so and want to delete the extras so as not to be confused. The
ffmpeg, ladspa, and lv2 plugins can not be deleted in this manner but, of course,
you can always turn them off from view by clicking on Visibility and unchecking
them (figure 9.8).

9.5.3 Updatable Icon Image Support

When running CINELERRA-GG Infinity builtin icons are loaded before the program
starts. Png files in the path:
<target_directory>picon/picon_set_name
are searched before the images loaded into memory. Override icon.png files must
be put into the path:
<target_directory>/picon/picon_set_name
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Figure 9.8: Remove Deinterlace-CV plugin

There are currently 4 sets of icons and their directory names are cinfinity (the de-
fault) and cinfinity2, original (the long-time original set), and smoother (generally
was in use by some of the themes). An example, to replace the cinfinity icon of
Blue Banana with a red apple instead, create your .png file as desired, and replace
the file in:
<target_directory>/bin/plugins/picon/cinfinity/bluebanana.png.

For most User installs, the <plugin_name>.png file will be located at:

<cinlib_path>/bin/plugins/picon/cinfinity (or cinfinity2, original or smoother)

For some System installs, the files might be located at:

/usr/lib/cin/plugins/picon/cinfinity

(or cinfinity2, original or smoother – ubuntu distros)

/usr/lib64/cin/plugins/picon/cinfinity

(or cinfinity2, original or smoother – Leap distro)

9.5.4 Details on where to put your own Plugin Icons

In order to make the icons available to all themes, which would thus be the default
when no theme-specific icon is available, put the png file in the:

<cinlib_path>/bin/plugins/picon/cinfinity (or cinfinity2, original or smoother)

The CINELERRA-GG program looks for a plugin icon in two places:
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9.5. Some specific details concerning Plugins

1. First, it tries to find a png file in <cinlib>/plugins/picon/cinfinity(2)
or original, smoother directory.

2. If there is no corresponding .png file for a plugin, the program uses a built-in
default:

• ordinary video plugins use 3 vertical color bars as a default;
• ffmpeg plugins use the words FF on yellow colored background as a de-

fault icon;
• audio and ladspa plugins use a green-colored audio wave for a default.

Keep in mind these points for newly created plugin icons:

• All included icon images become part of open source, in the public domain,
and not proprietary.

• The preferred format is 52× 52, 8 bi t /color RGB or RGBA, non-interlaced.

• Since plugin icons are used by different themes, it is recommended that a
transparent background be used. Otherwise some color background that looks
good for one theme may not for another.

• In order to test a new icon, you have to have write permission in the:
<cinlib_path>/plugins directory so you may have to become the root user
to copy the .png file to the correct location.

• If there is currently no theme-specific .png files present, it may be necessary
to first create the theme directory in <cinlib_path>plugins as <theme_name>
in order to put the .png files in that subdirectory.

• Make sure that the ownership and file permissions match the existing directory
and files.

• All ffmpeg icons must begin with ff_<plugin_name>.png (Resources win-
dow title will still be F_. . . )

• For ladspa, check in the <cin_config> directory ($HOME/.bcast5 normally)
and look for the text file $HOME/.bcast5/ladspa_plugins... for the names
of the ladspa libraries which correspond to plugin names where the needed
name is the basename of the .so file. For example phasers_1217.so would
need to have a phasers_1217.png file. There may be multiple plugins in a
single “so” file which means that you can only have 1 icon to represent all of
the plugins in that file; again as in phasers.

• Once you have placed the .png file in the correct spot, you will have to restart
CINELERRA-GG to test it.

218



9.5. Some specific details concerning Plugins

• To submit your .png file for inclusion into CINELERRA-GG Infinity for all to
enjoy, it is best to upload it to any datafilehost and notify the community via
email with any informative documentation.

9.5.5 Example of new Plugin Icon Testing

For a simple test just copy an existing <plugin_name>.png file into the cinfinity
directory with the name bluebanana.png to write over the existing file. This icon
will now show up in CINELERRA-GG and still execute the Blue Banana function.

For an ffmpeg plugin, create ff_loop.png and copy it to:
<cinlib_path>/plugins/picon/original. This icon will show up in CINELERRA-
GG if original is selected and execute the F_loop function.

For a ladspa plugin, the text line in $HOME/.bcast5/ladspa_plugins. . . as seen
below: 2 am_pitchshift_1433.so
AM pitchshifter 1504922321 01 00 10 10 10 0 indicates that you would create
the icon:
<cinlib_path>/plugins/picon/cinfinity/am_pitchshift_1433.png
For your own personal plugins, you can create a directory on your system and
put any plugin png files you like into that directory. For example, if you want a
specialized picon for F_aeval, create a picon named ff_aeval.png in:
<cinlib_path>/plugins/picon/yournamehere.

cd <cinlib>/plugins # go to the correct directory
mkdir -p picon/yournamehere # create subdirectory if does not exist
ls -l picon/* # list the picon directories

# check for existence (and permissions)
cp yourpicon.png ff\_aeval.png # Copy your example .png file

Restart cin by changing Settings→ Preferences→ Appearance and in Plugins
icons choose a directory.

9.5.6 Plugins/Effects Visibility

CINELERRA-GG contains many plugins, especially with the addition of ffmpeg, and
it is somewhat difficult to find the one you are looking for in the Resources window.
In CINELERRA-GG Infinity, the plugins have been categorized into the following
subsets in the Visibility section of the Resources window to make it easier to locate
a particular one:

Audio Effects, Video Effects, Audio Transitions, Video Transitions
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Figure 9.9: Screenshot showing on the left hand side the Visibility box with Audio Effects
highlighted.

The Visibility tool in the Resources window (figure 9.9) gives you the ability to
turn off or on any of several sets of plugins. If you left-click the Visibility box, you
will see the various categories of plugins, such as ladspa, ffmpeg, audio, lv2, and
video (figure 9.10).

Highlight the set you want to turn on and a check mark appears to show it is active.
Highlight again to toggle it off. See the next screenshot which illustrates that all
of the plugins are turned off (not visible) except for audio. There is also the ability
to add your own personal directory of plugins which will show up here. All you
have to do to have these plugins become visible is to create a directory, with some
name that is meaningful to you, and put your .png files in your:
cinelerra_path bin/plugins/<your_directory_name>.

Figure 9.10: Screenshot showing the Visibility categories of plugins with all toggled on and
audio highlighted.
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9.5.7 Expanders for Plugin Subtrees in the Resources Window

To accentuate a set of common plugins, there are expander arrows on the left side
of the Resources window. You will see these expanders only when in Display text
mode, not icon mode. CINELERRA-GG’s default setup is in the file $CIN_DAT/expan-
ders.txt but if the user wants their own specific setup and if the file in $HOME/.
bcast5/expanders.txt exists, it will take precedence. If there are recommen-
dations for other relevant categories, they can be added. The subtree structure is
applicable to any of the Video Effects/Transitions or Audio Effects/Transitions. You
can not sort once an expansion is in effect (figure 9.11).

The expanders.txt file has very specific requirements. The most specific is that
there are no blanks – you must use tabs only. A # (pound sign) can be used in
column 1 to indicate a comment. Here is a short example:

Video Effects
-Color_Correction

Blue Banana
#\qquad \qquad Color 3 Way

Color Balance
Audio Effects

-Calf
-Instruments / Generators

L2_Calf Organ
L2_Calf Monosynth
L2_Calf Fluidsynth

9.5.8 Speed-up of Ffmpeg plugin usage with OPTS files

You can speed up some ffmpeg plugins that are quite time-consuming and use
a lot of CPU. For a specific color-based example, CINELERRA-GG uses 6 primary
rendering color models. All of them have 3 components at full scale. Direct usage
of a particular ffmpeg plugin from the ffmpeg command line might handle the
planar at less than full scale chroma (yuv420), which means there is less data to
manipulate. But when cinelerra loads a video it uses full scale color models. In
other words:

• CINELERRA-GG uses yuv444
• ffmpeg uses yuv420

if using an ffmpeg plugin that uses filters and many passes over the data, the
amount of data is a big factor. If you load a file in CINELERRA-GG with a
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Figure 9.11: 5, Â =expander; "-" = options

same_directory_path_and_filename.opts

file containing the following line, the full scale color modeling upgrade will not be
performed until after any plugin, and then the render is faster:

video_filter=xxxxxx=threads=8 # where xxxxxx is the desired filter

When the file loads, however, it will initially take longer because it is running
through the video filter. The format rgb in ffmpeg uses more cpu time. For com-
parison, ffmpeg line that might be used:

ffmpeg -i /tmp/filename.mpeg -threads 15 -vf format=rgb24,xxxxxxs=threads=8 -
,→ acodec ac3 -vcodec libx265 -y /tmp/x.mp4

This converts the input to rgb before xxxxxx runs, and so it too is slower (because
there is more color data). You would ordinarily avoid this conversion by omitting
the format=rgb24 parameter. An example ffmpeg plugin that could easily take
advantage of an auxilliary opts file is nlmeans.

9.6 Audio Effects - Native
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9.6.1 AudioScope

Effect rewritten and improved. Convert input audio to video output representing
the audio power spectrum. Shows you the sound wave.

9.6.2 Chorus

It is a multitrack effect, where each track is a channel. For example if you have 4
voices per channel and 2 channels, you will have a total of 8 tracks. It is an effect
that modulates the signal, varies the pitch up and down (instead of modulating the
phases as for example in the Flanger plugin) and creates voices from the original
signal and adds them to the Output. You then get a chorus effect, with multiple
voices singing the same song but with slightly different modulations. Voices not
only modulate the original signal but also start with a certain delay. There are two
components of delay, constant delay and oscillating delay (figure 9.12).

Figure 9.12: GUI of configuration for Chorus plugin

Voices per channel : number of items we want to put in the effect. Using more
than 4 voices creates sound artifacts that lose the feel of a human voice choir,
but can still be used as an artificial sound effect.

Phase offset (ms): is the constant delay, i.e. the amount of delay of the voices
compared to the original signal.

Depth (ms): is the oscillating delay, i.e. the delay in the oscillation of the various
voices from the original signal.

Rate (Hz): is the speed at which we apply the oscillating delay. In other words,
the speed at which the oscillations occur.

Wetnwss (db): Indicates how much of the original (dry) signal is taken into ac-
count compared to delayed voices.

9.6.3 Compressor (Single Band)

The audio compressor reduces the dynamic range of the audio, not the amount of
data required to store the audio. In CINELERRA-GG the compressor actually per-
forms the function of an expander and compressor of the signal’s dynamic range.
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A third and more sophisticated use serves to highlight the voice with respect to the
sound background. It is a multitrack effect and can also be applied as a Shared
Effect. (figure 9.13).

Figure 9.13: GUI of configuration for Compressor plugin

The compressor works by calculating the maximum sound level within a certain
time period of the current position. The maximum sound level is taken as the input
sound level. For every input sound level there is an output sound level specified by
the user. The gain at the current position is adjusted so the maximum sound level
in the time range is the user specified value. The compressor has a graph which
correlates every input sound level to an output level. The horizontal direction is
the input sound level in dB. The vertical direction is the output sound level in dB.
The user specifies output sound levels by creating points on the graph. Click in
the graph to create a point. If two points exist, drag one point across another
point to delete it. Moving the point horizontally is equivalent to the makeup gain
parameter. Note that it is impossible to create a vertical curve; points would be
deleted. Put a part of the curve in horizontal means clamping the signal to the
same, unique value (as Limiter). The most recent point selected has its values
displayed in textboxes (Output and Input) for more precise adjustment. To have
the compressor reduce the dynamic range of the audio, make all the output values
greater than the input values except 0 dB. To make the compressor expand the
dynamic range of the audio, make all the output values except 0 dB less than the
input values. The algorithm currently limits all sound levels above 0 dB to 0 dB,
so to get an overloaded effect put a gain effect before the compressor to reduce all
the levels and follow it with another gain effect to amplify all the levels back over
0 dB. The volume (in Db) of the input signal is shown in the In meter on the left.
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Next to it is the Gain meter which indicates the gain added (green) or subtracted
(red) to the original signal according to our settings.

Attack secs : determines where in relation to the current position the maximum
sound level is taken and how fast the gain is adjusted to reach that peak. It is
in seconds. If the reaction time is negative the compressor reads ahead of the
current position to get the future peak. The gain is ramped to that peak over
one reaction time. This allows it to hit the desired output level exactly when
the input peak occurs at the current position. If the reaction time is positive
the compressor scans only the current position for the gain and ramps gain
over one reaction time to hit the desired output level. It hits the output level
exactly one reaction time after detecting the input peak.

Release secs : if the peak is higher than the current level, the compressor ramps
the gain up to the peak value. Then if a future peak is less than the current
peak it ramps the gain down. The time taken to ramp the gain down can be
greater than the time taken to ramp the gain up. This ramping down time is
the decay seconds.

Trigger type : the compressor is a multi-channel effect. Several tracks can share
one compressor. How the signal from many tracks is interpreted is deter-
mined by the trigger type. The Trigger type uses the value supplied in the
Trigger textbox as the number of the track to use as input for the compres-
sor. This allows a track which is not even heard to determine the loudness of
the other tracks. The maximum trigger takes the loudest track and uses it as
the input for the compressor. The Total trigger type adds the signals from all
the tracks and uses the total as the input for the compressor. This is the most
natural sounding compression and is ideal when multiple tracks are averaged
into single speakers.

Trigger : This parameter is used in conjunction with trigger type as described
previously. Normally only one track is scanned for the input peak. This track
is specified by the Trigger. By sharing several tracks and playing with the
trigger value, you can make a sine wave on one track follow the amplitude
of a drum on another track, for example.

Smooth only : for visualizing what the compressor is doing to the sound-level,
this option causes it to replace the sound wave with just the current peak
value. It makes it very easy to see how reaction secs affects the detected peak
values.

Gain : moves the curve in the vertical direction only, to change the gain of the
Output.

Clear and Reset: Reset the parameters to the default values (no compression).
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9.6.4 Compressor Multi (Multi Band)

Refer to Compressor (Single Band) for common theory and options. The normal
compressor acts over the entire frequency spectrum. The multi-band allows us
to distinguish three frequency ranges (low, med and high) on which to intervene
separately and in a more sophisticated way. In other plugins there are four bands
instead of three, but we can make very precise adjustments so the three present
are enough because they are not fixed. Finally the value of the three corrections
are added together in the Output.

Figure 9.14: GUI of configuration for Compressor Multi plugin

The three bands and their range (adjustable as desired) are shown in the frequency
graph visible below (Bandwidth:). As a first step you choose the band and adjust
its range in the Bandwidth graph, then you go to adjust the compression in the
top level graph. In this graph we can copy/paste the curve in the other bands via
RMB; so we have a similar basis on which to make the adjustments.

In figure 9.14 we can see the three bands; the one currently active (Current band:
2) presents the waveform of the sound signal. The interval goes roughly between
300 Hz and 4000 Hz, the edges are vertical because the stepness is set to zero. So
we have a clear separation between the bands, but by varying the slope we can
have some overlapping of the bands for smoother effects. In the top level graph
we can see the yellow curve of the active band, but we can also see in the violet
the soft lines of the curves of band 1 and 2.
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Solo : brings only the active band to the Output, silencing the others. So we can
make more precise adjustments without listening to the whole effect.

Bypass band : In contrast to Solo, it only brings the sound signals of the two
inactive bands to the Output.

Freq range : is used to set bandwidth limits. You act separately on the left and
right edge.

Steepness : varies the slope of the edges of the band range. Creates some overlap
in the band boundaries.

Channel : is the equivalent of the Trigger option in Compressor (single band).
Allows you to choose the channel or track to act on.

Window size : Determines the number of samples used in the compression calcu-
lation. The more they are, the higher the quality of the result, but the more
CPU usage.

9.6.5 DC Offset

Use this to remove DC Offset, which is usually an undesirable characteristic of a
recording normally caused by defective equipment. This effect works like a high
pass filter and has no controls. DC stands for Direct Current which is the average
amplitude of the waveform. It sounds best when it is absent, represented by zero,
so that there is no imbalance in the audio.

9.6.6 Delay Audio

In the Delay Audio effect you can specify the number of seconds you want to delay
the video track.

9.6.7 DeNoise

Reduce audio background noise. There is only 1 parameter which is used to reg-
ulate the level dial with a range of 0 to 1.

9.6.8 DenoiseFFT

Noise removal from audio using FFT editing. Set the Denoise Power dial in dB and
choose the number of reference samples.

9.6.9 Despike

Detect and eliminate out of range impulse values.
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Maximum level: slider to set the maximum value in dB above which the fre-
quency cutting takes place.

Maximum rate of change: to adjust peak delete in dB.

9.6.10 EQ Graphic

Graphic equalizer sets the output levels for specified frequency bands. This effect
works by setting control points when you click the left mouse button and drag to
the desired value. In the textboxes at the bottom can be seen the frequency of the
active control point, the level of the signal to be set by entering the numerical value
or by dragging the control point, and the number of samples to act on (figure 9.15).

Figure 9.15: Graphic Equalizer audio plugin

9.6.11 EQ Parametric

Parametric equalizer shows and outputs levels for frequency, quality, level, mode,
and wetness (figure 9.16).

9.6.12 Echo

Echo is reflection of sound. This plugin could be used to add echoing to video of
your canyon hike (figure 9.17).

Level represents the volume adjustment.
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Figure 9.16: Graphic Equalizer audio plugin

Figure 9.17: The 3 dials of Echo plugin

Atten is attenuation which is a general term that refers to any reduction in the
echo reflection. Sometimes called loss, attenuation is a natural consequence
of signal transmission over long distances.

Offset is the lag in the attenuated echo signal. Offset means adding a DC level to
a signal. It offsets the signal up or down in a DC sense without changing the
size of the AC part of the signal. When you add an audio clip to the Timeline,
the clip plays back from the beginning of the source audio file. The point in
the audio file where the clip starts playing is called the offset. By default, a
clip’s offset is zero, the beginning of the source audio file. You can change
the offset so that the clip starts playing from a later point in the source audio
file.

9.6.13 EchoCancel

EchoCancel is the process of removing echos from audio in order to improve the
quality. Echo cancel may be needed because an audio recording was done in a
room that led to echo generation or there was some kind of unwanted feedback.
There are many controls for the EchoCancel plugin which are defined here. How-
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ever, the first thing you will see when you bring up the plugin, is the top portion
that is black which will show a + in the middle when you mouse over it. Once you
start playing audio, you will see the cepstrum spectral data inside the window. A
cepstrum results from taking the inverse Fourier transform (IFT) of the logarithm
of the estimated spectrum of a signal. It is used to identify the period of the echo
in the audio. It is recommended to just set the Mode to On but the below defined
parameters can be utilized by professionals (figure 9.18).

Figure 9.18: GUI for EchoCancel with crosshair and mode set to ON

Normalize: audio normalization adds variable amounts of gain to an audio record-
ing to bring the average or peak amplitude to a target level (the normal
amount), on an ongoing buffer by buffer basis. This is to make the cepstrum
graphical data appear between 0 and 1. Checkmark appears if ON.

Level: scale factor used to draw the cepstrum output when normalize is not in
effect.

History: number of previous cepstrum outputs redrawn as fading graphical data.

X Zoom: X axis scale factor to magnify low frequency cepstrum graphical output.

Damp: echo envelope decay factor used to smooth the cepstrum/correlation data.

Peaks: number of maximal envelope values used in the echo gain calculation.

Cutoff Hz: low frequency cutoff value to prevent beat frequency (heterodyne)
echo canceling.
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Mode: MAN, Off, or On. When Off is selected, the plugin is not active. When
MAN is used, the only one peak is used for the echo gain envelope. It is set
by pressing mouse button 1 in the ceptstrum graphical output. The Gain and
Offset are updated as the pointer drag operation resets the indicated gain and
offset values. When On is selected, the echo gain envelope is automatically
calculated by cepstrum and auto-correlation of the input audio in the last
window size audio samples.

Windows size: parameter can be set to Default, 1024, 2048, . . . doubled values. . .
up to 262144.

Amplitude: the cepstrum value at the drag point during manual envelope selec-
tion.

Gain: echo gain setting determined by manual selection.

Offset: echo period setting determined by manual selection. The Hz (frequency),
ms (millisecond duration), and sample offset (audio samples) as determined
by manual selection.

9.6.14 Flanger

It’s a single-track effect. If you apply it to multiple tracks each will work on its own
track independently of the others. It consists of making a copy of the original sound
wave and then playing it over the original one with a certain delay. The resulting
signal (Output) will then be the sum of the two waves and will have peaks where
the two values add up and gaps where the two values compensate each other. The
result is a more evanescent and metallic sound. Much, however, depends on the
intensity of the effect. The delay introduced consists of two distinct components:
the constant delay and the oscillating delay. Their sum constitutes the total delay
of the effect (figure 9.19).

Figure 9.19: GUI of configuration for Flanger plugin

Phase Offset : it is the constant delay. Once set, its value does not change (unless
we change it, for example by use of keyframes) for the duration of the effect.

Starting phase %: is the point of oscillation where we start the oscillating delay;
basically it is the attack value at which the effect starts the calculations. Not
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to be confused with the point on the timeline where we apply the effect. It
only matches this for the 0% value. The position on the timeline where we
want to start the flanger at a given starting phase value can be chosen using
keyframes.

Depth : It is the oscillating delay. This value determines the amplitude variation
of the delayed (wet) signal phase. this oscillation will be maintained for the
entire duration of the effect unless we change it.

Rate : is the speed at which we apply the oscillating delay. Low values indicate a
lower oscillation frequency, a high value a rapid succession of oscillations.

Wetness : indicates how much of the original (dry) signal is taken into account
compared to the delayed (wet) signal.

9.6.15 Freeverb

Adds effect of multiple decaying echoes to audio signals based on a specific algo-
rithm. Common use of reverb is to simulate music played in a closed room.

9.6.16 Gain

Add gain, input level, to increase/decrease loudness.

9.6.17 Interpolate

Generate a smooth curve based on sound creating a certain softness. There are no
controls.

9.6.18 Invert Audio

Reverses the numerical sign of the digital audio. There are no controls.

9.6.19 Live Audio

The Live Audio effect reads audio directly from the sound card input. It replaces
any audio on the track so it is normally applied to an empty track. To use Live
Audio, highlight a horizontal region of an audio track or define In and Out points.
Then drop the Live Audio effect into it. Create extra tracks and attach shared copies
of the first Live Audio effect to the other tracks to have extra channels recorded.
Live Audio uses the sound driver selected in Settings → Preferences → Playback
A → Audio Out for recording, but unlike recording it uses the playback buffer
size as the recording buffer size and it uses the project sample rate as the sampling
rate. These settings are critical since some sound drivers can not record in the
same sized buffer they play back in.
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Live audio has been most reliable when ALSA is the recording driver and the play-
back fragment size is 2048. Drop other effects after Live Audio to process sound
card input in realtime. With live audio there is no read-ahead, so effects like com-
pressor will either delay if they have read-ahead enabled or playback will under-
run. A potential problem is that sometimes the recording clock on the sound card
is slightly slower than the playback clock. The recording eventually falls behind
and playback sounds choppy. Live Audio does not work in reverse.

9.6.20 Loop Audio

Loop some number of samples of audio over and over.

9.6.21 Overlay

Overlay has parameter settings of top or bottom for the track and add or multiply
for the operation.

9.6.22 Pitch Shift

Like the time stretching methods, there are three pitch shifting methods: Pitch
shift, Resample, and Asset info dialog. Pitch shift is a realtime effect which can be
dragged and dropped onto recordable audio tracks. Pitch shift uses a fast Fourier
transform (FFT) to try to change the pitch without changing the duration, but this
introduces windowing artifacts. Because the windowing artifacts are less obtrusive
in audio which is obviously pitch shifted, Pitch Shift is mainly useful for extreme
pitch changes. For mild pitch changes, use Resample instead. Another way to
change pitch slightly is to go to the Resources window, highlight the media folder,
right click on an audio file, click on Info, then adjust the sample rate in the Info
dialog to adjust the pitch. This method also requires left clicking on the right
boundary of the audio tracks and dragging left or right to correspond to the length
changes.

9.6.23 Remove Gaps

Remove silent gap (below DB threshold) which persist for more than the time
limit.

9.6.24 ResampleRT

Allows you to convert an audio file from one sample rate to another. This effect
works similarly to ReframeRT in videos.

233



9.6. Audio Effects - Native

Input / output > 1 fast rate
Input / output < 1 slow rate

9.6.25 Reverb

Reverb uses reflections of sound to add depth and fullness; the sound will seem
to come from a space that can go from a small bare room to large natural valleys,
cathedrals, etc. The reverb is made up of a group of echoes that occur at the
same time making it feel like a single effect. Basically simulates creation of a large
number of reflections, like lots of walls, which build up and then decay. You can
use the reverb plugin to mix tracks together to simulate ambiance because it is a
multitrack effect. The configuration window (figure 9.20) shows a graph of the
full band pass filter frequencies.

Figure 9.20: GUI of configuration for Reverb plugin

Initial signal level (db): Allows you to set the level of the reflected signal. At
0 you start from its maximum level. Decreasing the signal volume will give
more presence to the original signal.

ms before reflections : indicates when to start the reflected sounds in relation
to the original sound (delay).

First reflection level (db): the sound level of the reflection that starts first.

Last reflection leve (db): the level of the last reflection. It is weaker than the
first.
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numbers of refelctions : the number of reflections can be set as desired as long
as there is sufficient CPU to handle it. With a few reflections you get closer to
the Chorus effect. You can start from values of 100 - 150, up to a maximum
of 255.

ms of refelction : Sets the action time of the effect. With high values, the sound
is more clear and sharp

Low freq of bandpass and High freq of bandpass: allow you to set the fre-
quency limits (range) on which the effect acts.

Steepness of bandpass : allows you to adjust the slope of the frequency range
limits imposed by the previous items. With the value 1.00 we have a vertical
edge that clearly separates the range of frequencies on which to act from the
remaining ones (as you can see in figure 9.20). By sloping the edge we have
a certain overlap and a smoother effect.

Window : determines the number of frequency samples taken into account by the
effect for its calculations. The higher the number, the smoother the effect;
but more CPU is used.

9.6.26 Reverse Audio

Apply reverse audio to an audio track and play it backwards. The sound plays
forward. Be aware when reversing audio that the waveform on the timeline does
not reflect the actual reversed output.

9.6.27 SoundLevel

Effect rewritten and improved to handle fragments. Displays the Max/RMS sound
level in decibels.

9.6.28 Spectrogram

Effect rewritten and improved. Visual representation of the sound levels at speci-
fied frequencies as they vary with time.

9.6.29 Synthesizer

Generate synthesizer sounds; to set key data, turn on Generate keyframes while
tweaking (figure 9.21).

9.6.30 Time Stretch RT

Change the speed of an audio signal without affecting its pitch.
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Figure 9.21: GUI for Synthesizer

9.6.31 Tremolo

It serves to give various vibes and vitality to the sound by modulating the amplitude
of the sound signal and the delay (figure 9.22).

NOTE: There is often confusion between Tremolo and Vibrato, but the vibrato is
the periodic variation of the height of a note (frequency) while the tremolo is the
periodic variation of the height (amplitude) of the sound wave.

Figure 9.22: GUI of configuration for Tremolo plugin

Phase offset (%): is where the oscillation effect begins. At 0% we are at maxi-
mum volume; to lower the volume, increase the percentage.

Depth (dB): is the oscillation damping value. You can only decrease the level,
you cannot increase it.

Rate (Hz): is the speed at which the oscillations are repeated.

Waveform : you can choose waveform algorithms to use in effect calculations.
Currently available waveforms are: Sine; Sawtooth; Rev Sawtooth; Square
and Triangle.
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9.7 Audio Ladspa Effects

Ladspa effects are supported in realtime and rendered mode for audio. These
audio effects are supported since CINELERRA-GG implements the LADSPA interface
as accurately as possible. Besides the supplied LADSPA effects2, additional LADSPA
effects can be enabled by setting the LADSPA_PATH environment variable to the
location of your LADSPA plugins:

export LADSPA_PATH=/usr/lib/ladspa

9.8 Audio LV2 / Calf Plugins3

LV2 is an open standard for audio plugins using a simple interface with extensions
which add functionality to support audio software. These plugins were written by
external developers and provide additional audio effects to CINELERRA-GG audio
without having to change CINELERRA-GG every time. Because the LV2 plugins are
separate from CINELERRA-GG Infinity, if one fails or does not perform as expected,
CINELERRA-GG should stay running and you will have to contact the programmers
responsible for that plugin for a fix.

Typically, a user OS has specialized package groups installed. It is difficult to create
one build of CINELERRA-GG to accommodate all potential LV2 plugins. Specifically
for the Calf-Studio LV2 plugins, you should install the Calf Plugins package. The
user’s computer must have gtk-2-runtime installed, which seems to be automati-
cally done already for most distros. For users doing their own builds, you can build
CINELERRA-GG without LV2 support by including --without-lv2 in the configure
step. The default build is --with-lv2=yes and requires that GTK-2-devel must be
installed or the build will fail and notify you.

LV2 plugins have their own category in the Audio Plugins Visibility as lv2. There is
a simple text interface which is available via the usual Show controls button when
the plugin is attached to the audio track. This window has a Reset button to get
back to the default settings. To change a value of one of the parameters, highlight
that parameter and type in the new value in the topmost text box and then hit
Apply to take effect – the reason for requiring hitting apply is so that the audio is
not moving all over the place while you are still typing a value. More easily, you
can just move the pot dial or the slider bar which take effect automatically.

2credit Steve Harris
3Optional Feature - OS dependent
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CINELERRA-GG’s buffer size setting may cause a delay in activation of the changes
you make taking effect, so you can lessen the time by using a small buffer. Notice
that 1024 samples at 48000 samples per sec is only 1

50
th

a second. This is not a
lot of time to shuffle a bunch of stuff. Short buffers produce low latency, but no
time for complex programs or lots of stacked effects. Bigger buffers allow for more
complex setups.

To set the buffer size:

Settings → Preferences → tab Playback A → section Audio Out → variable
Playback buffer samples

However, be forewarned that due to variability in the lv2 plugin programming
code, some of the plugins only work with the minimum buffer size of 1024. In
these cases, what you will see is the main track canvas cursor just bounces back
and forth over a very small area in the timeline. This does not crash CINELERRA-
GG but you will have to remove the plugin to continue working. You can specify
a certain set of LV2 plugins to use by setting LV2_PATH as shown below before
starting CINELERRA-GG – include a colon (:) separator for multiple paths. The
default path for most operating systems is /usr/lib64/lv2. To list the system
installed lv2 plugins key in: lv2ls.

export LV2_PATH=/tmp/j/balance.lv2/usr/local/lib/lv2/:/usr/local/lv2

If there is no default LV2_PATH set automatically, the value will be $CIN_DAT/
lv2, which is a placeholder only so that no lv2 plugins will be loaded. When there
is no system LV2_PATH set it is important to note, that if you do want lv2 plugins
loaded, you must set the correct path in:

Settings → Preferences → Interface tab → Default LV2 → directory
path name

When you change this field, cin will automatically restart and load the newly spec-
ified lv2 plugins. If when switching LV2_PATH or if the lv2 audio plugins are not
displayed/usable in the Resources window, you can execute a reload via:

Settings → Preferences → Interface tab → Reload plugin index or else
before you bring up CINELERRA-GG, delete $HOME/.bcast5/Cinelerra-GG_
plugins so that the plugins get properly reloaded.

There are some lv2 plugins that display a glitzy UI (User Interface); for example
the Calf plugins. For these LV2 plugins, if you want that to automatically come up
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without having to click on the UI button on the simplified UI interface, there is a
flag to enable that. It is at:

Settings → Preferences → Operations tab

then check the Auto start lv2 gui Flag

Below is a screencast showing the auto start gui flag and the LV2_PATH default
directory path on the bottom line. Note the highlighted Reload plugin index which
will be executed if OKed (figure 9.23).

Figure 9.23: Reload plugin index in yellow and Auto start lv2 gui unchecked

There is also a blacklist that prevents known problematic-for-CINELERRA-GG lv2
plugins from loading to avoid crashes. If others are found to have problems, once
informed about them, they will be added to this blacklist. In order to determine
which lv2 plugin causes a SEGV on CINELERRA-GG startup, you can start from a
terminal window and you will see each plugin that is being loaded and the last
one shown before the crash is a bad plugin. However, many of the plugins causing
a crash are due to not having been compiled on your current system with the
current compiler so may actually work correctly on other user systems and so will
not be added to the CINELERRA-GG-wide blacklist. You can either recompile the
problematic plugin, or modify your own blacklist which you will have to maintain
and save so as not to be written over when loading a new build.

Note the UI button in the upper right hand corner above the Reset button (fig-
ure 9.24). If you click this button, a glitzy interface window comes up (if available)
for changing variable values. It is possible that a bug in the LV2 plugin causes the
glitzy window to appear as blank and then die, but in that case the original simple
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text window might still work – in either case, if the timeline movement hangs,
just detach the plugin to continue your current session. There is an environment
variable that you can set, BC_TRAP_LV2_SEGV, to get a dump of the failure which
may be helpful for debugging.

Figure 9.24: Screencast of simple text interface in the middle of the screen for a Calf LV2
plugin

When the glitzy ui is up, the simple text window remains up also since it is the
CINELERRA-GG side and keeps track of the value changes so they remain in effect
for further usage of the plugin. Changes to one or the other will occur in both with
the exception of certain features in the glitzy window which are not communicated
correctly back to CINELERRA-GG; for example a reset button – the simple interface
Reset button must be used instead. To change values in the glitzy window you use
the mouse and move up or down unlike a knob that turns! (Figure 9.25)

In order to test a particular plugin without bringing up CINELERRA-GG, especially
for ones that do not operate, it is possible to manually display an lv2ui gui with:
/cin-path/lv2ui <lv2-uri>
For example:

/tmp/cinelerra-5.1/bin/lv2ui http://calf.sourceforge.net/plugins/Flanger

9.9 Video Effects – Native

9.9.1 1080 to 480

Most TV broadcasts are received with a 1920×1080 resolution but originate from
a 720 × 480 source at the studio. It is a waste of space to compress the entire
1920× 1080 if the only resolvable details are 720× 480. Unfortunately resizing
1920× 1080 video to 720× 480 is not as simple as shrinking it.
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Figure 9.25: Screencast with a Calf plugin glitzy window that appears when clicking the
simple interface UI button.

At the TV station the original 720 × 480 footage was first converted to fields of
720 × 240. Each field was then scaled up to 1920 × 540. The two 1920 × 540
fields were finally combined with interlacing to form the 1920×1080 image. This
technique allows a consumer TV to display the re-sampled image without extra
circuitry to handle 720× 480 interlacing in a 1920× 1080 image.

If you merely deinterlace the 1920×1080 images, you would end up with resolu-
tion of 720× 240. The 1080 to 480 effect properly extracts two 1920× 540 size
fields from the image, resizes them separately, and combines them again to restore
a 1920 × 480 interlaced image. The scale effect must then be applied to reduce
the horizontal size to 960 or 720 depending on the original aspect ratio.

The tracks to which 1080 to 480 is applied need to be at 1920× 1080 resolution.
The project settings in settings → format should be at least 720× 480 resolu-
tion. The effect does not know if the first row in the 1920× 1080 image belongs
to the first row of the 720×480 original. You have to specify what the first row is
in the effect configuration. The output of this effect is a small image in the middle
of the original 1920× 1080 frame. Use the projector to center the output image
in the playback.

Finally, once you have 720× 480 interlaced video you can either apply Frames to
Fields or Inverse Telecine to further recover original progressive frames.

9.9.2 1080 to 540

Extracts two 1920× 540 fields from 1920× 1080 image, resizes them separately,
and combines them to 1920× 540 interlaced image.

9.9.3 Aging TV

This effect is the one to use if you want to achieve an old movie or TV show look. It
will put moving lines up and down the movie as well as putting snow on the video.
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Use it along with Brightness/Contrast and Color Balance to make your movie look
like a really old black and white movie. This came from https://effectv.com.

9.9.4 Alpha

Allows you to apply an alpha value (transparency) to one or more tracks or one or
more edits. Being also keyframable, it allows an excellent variety and possibility
of use in the most disparate occasions.

9.9.5 Auto Scale

Automatically scale to a specified size.

9.9.6 Blue Banana

Blue Banana4 is an HSL Qualifier (HSL= hue, saturation, lightness), one of the
basic tools of any grading software that are based on circumscribing a zone of the
frame by extracting a chromatic key and producing a matte in the alpha channel
(Secondary Color Correction). Blue Banana differs not by creating a real matte, but
by creating a selection mask exclusively for use within the plugin. The BlueBanana
plugin has a couple of useful purposes. It can be used for color transformation or
remapping – by isolating a specific color and then performing color change/correc-
tion on only that color (or color ranges). Another useful purpose is for chroma-key
filtering, using multiple BlueBanana plugins on the same track. Also, it can be used
in conjunction with the mask operation of the Compositor. Usage of BlueBanana
may seem complicated at first, but it is necessarily so in order to get enough con-
trol to produce the desired effect simply and quickly. Just changing a single color
is actually quite easy. BlueBanana is keyframable (figure 9.26).

The basic strategy for BlueBanana is to:

• Select a specific target color.

• Create a selection region by expanding color ranges around that color.

• Optionally reduce or expand the alpha plane as a regional selection mask.

• Optionally apply a color remapping or transformation to the selection.

• Optionally reset the output alpha to opaque, or pass the alpha to another
BlueBanana plugin.

4credit to Monty Montgomery programmer
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Figure 9.26: Screencast showing the BlueBanana plugin control

Just a Warning Note:

BlueBanana may use a lot of CPU and Memory because it is doing a lot of work. If
you turn off the plugin on the plugin bar below the video track in the main track
canvas it will stop using cpu when not in use. Or once you uncheck Mark Selected
Area, it will no longer be using the cpu to mark the selected color area in realtime
while drawing the diagonal animated pattern in the compositor window.

9.9.6.1 Example Usage5

If you just want to try this, follow these steps.

First — Choose your color.

1. Load your video, add the BlueBanana plugin to the track, bring up its
control window, and uncheck any checked boxes (mostly just to avoid
unexpected results).

2. In the Compositor window, choose the eyedropper color picker tool on
the left-hand side and click on the area of the image that shows the color
you want to change/correct.

3. In the BlueBanana plugin window, to the right of hue, click Pick. And if
you want to modify saturation and value, also click on the Pick button
for them. To see what it does, Pick them also.

5from original message by Rebecca
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4. Next, check the Mark Selected Areas box at the top right of the Blue-
Banana plugin window to see the selected color-matching areas which
will become marked in a diagonally striped pattern.

5. You can now manually modify your selection in the Color Selection area
in the obvious ways for hue, saturation, value and fill. The arrows to each
side of the small circle widen the selected area. Move the dot and you
move the range. The slider on top of the horizontal color strip shifts like
the amount of the strip is dedicated to that part of the color spectrum.
Fill will fill more area or less area in your selected region.

Second — Adjust your color choice.

1. There are color strips under color Adjustment which will show color
changes as you modify values.

2. Uncheck Mark Selected Areas and check the Filter Active box to the right
of Color Adjustment.

3. As needed, you can individually check and uncheck all the various pa-
rameters using the boxes to the left of each line. Again, these are intuitive
and broadly similar to the above. The arrows at the bottom widen the
range, the circle at the bottom moves the range, and the top slider, which
is an arrow this time, affects distribution. It provides a little histogram
effect to give you an idea of what you’re changing. The fade adjusts
the level of color blending. The alpha is basically the opacity of your
changes.

Definition of Wording/Checkboxes/Buttons/Operators are being described next.
Some of the commentary was adopted from information provided by Monty Mont-
gomery and from questions and answers from email by Igor Ubuntu, who did ex-
tensive testing.

Operational characteristics for the color-related adjusters:

left arrow slider operates the range minimum; the numerical value shows in the
left-most textbox.

right arrow slider operates the range maximum; resulting numerical value is in
the middle textbox.

middle circle slider below can move the current range up or down and the nu-
merical results will show in the left and middle textbox. Move the dot and
you move the range.

top pad slider operates the edge slopes (selection attack/decay) and the value
will be displayed in the rightmost textbox. Sharp edges are represented by
0; 100 represents smooth edges.

top arrow affects the distribution skew.
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Operational characteristics for Fill:

left arrow slider operates mask erosion filling. First textbox value.

center up arrow slider operates the fill skew midpoint. Second textbox value.

right arrow slider operates mask expansion filling. Third textbox value.

top pad slider operates the edge slopes. Right textbox value.

The textboxes are available so that you can directly type in numbers from the
color wheel. This could be helpful if duplicating previous work as it would be an
instantaneous exact numerical match without having to continuously fine-tune the
movement of a slider.

There are two panes separated by long horizontal lines (through the middle of
the screen) in the control window of the BlueBanana plugin, clearly visible in the
previous screencast. The top pane is first used to create/modify a selection, and
the bottom pane is used to operate a change.

Pane 1

This section is used to select the target color domain. First, a short explanation
about alpha. The alpha channel used in BlueBanana is not transparency (matte);
it is used as the Selection mask. Alpha plane is the alpha channel of the current
image. So that:

RGBA = red/green/blue color planes, alpha data plane. YUVA = luma/Cb/Cr
color values, alpha data plane.

The alpha data normally is input to the blending operations in the patchbay overlay
mode. The alpha data usually creates the appearance of stacking order, and de-
termines which color planes are visible in the rendered result. When BlueBanana
is used, the meaning of the alpha data is changed to the selection. It is useful
to think of the alpha data as more solid when it is transparency in blending, and
more selected when it is used in BlueBanana. In both cases, the greater the alpha
value, the more the effect is expressed.

Usually, alpha is normalized to a range from 0 to 1, zero = no effect, 1 = total ef-
fect, 0.5= partial effect. In both cases, alpha is what math people call an auxiliary
variable. It is needed, but is not part of the answer. In this case, the answer is the
visible rendered result. Alpha is like meta-data.

Let us now examine the instruments in pane 1:
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Combine Selection The selection is the intersection or union of two pixel masks.
Mathematically, A and B are normalized, (scaled to between 0 and 1) and
used as selection mask weights.
Intersec t ion(∩) = A× B
Union(∪) = A+ B − A× B
where A is the input alpha plane as a mask, 1=selected, 0.4=partially se-
lected, and 0=not selected; B is the color selection of trims and feathers
made by varying the sliders.
The result is a new alpha plane, which will be output (if End Mask is not set).
The 0 . . . 1 selection values are used to weight the color transformation filters
if/when they are active and operate a change. The color adjustment filters
available in Pane #2 can change red, green, blue, and remap hue, saturation,
value in the pane. There is also fade which applies to the color channels and
alpha which applies to the resulting alpha plane.
The basic plan is to either:
- reduce a selection area by intersection (Combine selection off) A× B
- increase a selection area by union (Combine selection on) A+ B − A× B

Mask Selection applies the current mask to the selection, such that the mask
clips/expands the selection. When mask selection is enabled, the result of
the and/or will be stored to the alpha result, but when mask selection is
unchecked the mask is ignored and the selection is not modified. The se-
lection is used to weight the effect of the filtering, or to control the output
alpha.

End mask only visible when Mask Selection is checked. End Mask causes the en-
tire alpha plane to be set to 1. The image becomes opaque. This is usually
only set in the last plugin of a stack (the stack may be just one plugin do-
ing only color modification). In the event that a color selection mask is used
with multiple, layered BlueBanana filters on the same track, the grouped
BlueBanana filters may share a single mask by all enabling Mask Selection,
but with only the last BlueBanana enabling End Mask. This usage pattern
gives the End Mask control its name.

End Mask as used in Color Transformation/Remapping: In many use cases
where you are just remapping color, you are still interested in seeing all
of the picture. If this is the case, then checking End Mask on the last
BlueBanana plugin will show you the entire picture. The alpha plane
may be in use as a selection mask, but it may not be wanted as part of
the result.

End Mask as used in Chroma-key Filtering: In cases where the selection is
for a chroma-key, you are interested in the alpha channel for blending,
like Normal or SrcOver. So for this usage of the BlueBanana, don’t check
the End Mask.
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Invert Selection reverse target color domain, which is 1 minus selection.

Mark Selected Areas when this box is checked, the chosen colors are presented
in an animated diagonally striped pattern.

Hue select a hue domain; click on the Pick button to select or check the box to
the left of hue or uncheck to ignore.

Saturation select a saturation domain; click on the Pick button to select or check
the box to the left.

Value select a value domain; click on the Pick button to select or check the box to
the left.

Fill will fill more area or less area of your selected region. This describes how
it works. Fill control is an automated way of doing grow and shrink on the
selected area, to fill in small holes, or get rid of scattered speckles. If none
of the Hue, Saturation, or Value sliders are active – meaning that the whole
frame is selected – the Fill slider will have no effect even when enabled. The
word fill will appear ghosted to indicate this.
The three lower handles in the fill slider correspond to Shrink (the left hand
slider), Final (the middle slider), and Grow (the right hand slider). These are
used in combination to alter the selection by first growing it by the amount
specified by the right hand Grow slider, shrinking it to the amount specified
by the left hand Shrink slider, and then growing it again to the final size
specified by the middle Final slider. The top slider then feathers the resulting
selection. Growing the selection and then shrinking it has the effect of filling
small holes in the selected area. Similarly, shrinking and then growing tends
to remove small flecks of unwanted selection. The Final slider specifies the
overall desired shrinkage or growth of the selection when finished. To specify
a pure Grow or Shrink operation, set the Final slider and the Grow/Shrink
slider to the same value and leave the other slider at zero.

Pre-erode this control reverses the order of operation to Shrink, then Grow, then
Final. The change is subtle on most images, but overall removes more small
features because it first removes flecks before filling in holes.

Pane 2

This section is used to modify the color of your selection. Descriptive commentary
for this pane.

Filter Active checkbox to indicate that the modifications will be shown.

Color Adjustment For Color Adjustment, RGB can be used as color weights while
the HSV can transform color. For the following items there are three sections
on the slider. The center section represents the nominal 0%−100% range; the
left section represents negative values, and the right section represents values
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greater than 100%. Values can be out-of-range within BlueBanana without
clipping, but they will clip once they leave the plugin.

RGB affect the color channels individually.

Red modification color; click the Reset button to revert to default. Values
are reflected in numerical textboxes on the right-hand side.

Green modification color; click the Reset button to revert to default. Values
are reflected in numerical textboxes on the right-hand side.

Blue modification color; click the Reset button to revert to default. Values
are reflected in numerical textboxes on the right-hand side.

HSV reorient the color spectrum, and affect all of the color channels simultane-
ously.

Hue a single numerical value will appear in the right-side box. Click the
Reset button for default.

Saturation for modifying the saturation; click the Reset button to revert to
default. Values are reflected in numerical textboxes on the right-hand
side.

Value for modifying the value; click the Reset button to revert to default.
Result is reflected in the numerical textboxes on the right-hand side.

Fade controls the entire color re-mapping, and does nothing if no color adjustment
is active.

Alpha controls the output alpha (this is not available when End Mask is set);
click the Reset button to revert to default. Result is reflected in the numerical
textboxes on the right-hand side.

Let’s see two examples of HowTo:

BlueBanana Use Case #1: (Color Transform/Remapping)

• Load a video track, and add the BlueBanana plugin to your video. The alpha
channel is usually all opaque. This serves as an initial full screen selection
mask.

• Open the controls, and start with all boxes unchecked. Now reduce the se-
lection using the top pane in intersection mode (that is Combine Selection is
unchecked) to begin the effect.

• Use the eyedropper on the compositor window to choose a particular color.

• Click on the 3 plugin Pick boxes on the right side of each line of HSV to get
the color selection.

• Check Mark Selected Area. The affected zones will be identified on the com-
poser.
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• Adjust the selection using the HSV and Fill sliders of the top pane. The selec-
tion mark will be updated as you operate the controls. The composer mask
striping will be strongest as the mask is nearer full selection.

• Now uncheck Mask selected area & check Filter Active to begin Color Adjust-
ment.

• Enable any needed colorspace modifiers, RGB / HSV sliders, and setup the
color changes by moving the sliders. The current output may be the desired
output.

• Enable Mask Selection and the alpha output will pass the selection mask to
the image alpha channel. This can be used as a very flexible chroma-key filter.
It also allows more plugins to be stacked and more selection information to
be added, either by intersections or unions with other selections.

• End Mask simply sets the output image alpha to opaque. This is normally
used to end a stack of BlueBanana plugins, and render the entire image with
a complex selection.

BlueBanana Use Case #2:

This case uses stacked BlueBanana plugins working like chroma-key filters. It as-
sumes you have already learned how to operate the plugin.

• Bring up 2 tracks of video media – one for foreground and one for back-
ground.

• Add 2 BlueBanana plugins on the first track. Turn off all checkboxes in both
plugins.

• On the top plugin, use the top pane to create a selection mask, using Mark
Selected Areas.

• Turn off top plugin Mark Selected Areas, and disable the top plugin via the
plugin title bar on/off.

• Create another selection using the second plugin’s mask, using Mark Selected
Areas.

• Turn on the top plugin. Make sure both plugins Mark Selected Areas is off.

• Check Mask Selection and Filter Active in both.

• Check Combine Selection on second BlueBanana to see the final results.

You will see that there is intersection of the full plane with the first chosen regions,
so the alpha = 0 everywhere but the area you picked and you see through. And
alpha = 1, where the intersection selection was 1. The Normal blend shows you
the track on top in these regions (the foreground track where alpha = 1).

249



9.9. Video Effects — Native

If you are building an alpha selection mask by first intersection and then union,
the top BlueBanana should not change the colors or the bottom plugin will need
to target the remapped colors since that is the input to the lower BlueBanana.

9.9.7 Blur

This is a Gaussian type blur. Other blur plugins – Linear, Motion, Radial, and Zoom
–are described later. This plugin is keyframable. Blur is used to blur a video track
via the following parameters:

Horizontal and vertical values are used to tell which one of the fields blurring
affects; can be both.

Radius use this dial to define the amount of blur to apply.

Alpha determines radius use alpha to define the amount of blur to apply. (ra-
dius=gray value of alpha)

Blur alpha, red, green, blue specifies which color channels is to be blurred.

9.9.8 Brightness/Contrast

To brighten a dark shot, or add light, use this plugin. Do not overuse the effect or
you risk degrading your video quality. The Brightness slider moves up or down the
values of the entire channel and corresponds to the Master Offset of the various
grading programs. The Contrast slider expands or narrows the brightness values
of the entire channel; corresponds to the use of the cursors (small triangles) in
the Histogram plugin. Clear icons are present to reset its slider to default without
affecting others. Use the effect along with keyframing to brighten a long shot that
is dark at the beginning but bright at the end. Generally you will want to change
the brightness and contrast about the same amount (for example – brightness
28, contrast 26) so that your original colors are kept intact. This effect is also
keyframable (figure 9.27).

9.9.9 BurningTV

Makes your video burn where there are small light colored patches of video. This
came from https://effectv.com.

9.9.10 C416

The C41 plugin takes a 16 bi tC41 digital intermediate negative film as input and
outputs a positive image. It became necessary because C − 41 negatives can fade
or color-shift over time which was a problem early on. It is still important today

6credit Florent Delannoy, original program code author, and Edouard Chalaron
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Figure 9.27: How it works Brightness and Contrast

because there is a large amount of documentaries, video clips, and other media
out there that was shot on super 16 film. This works for RGB-float, RGB, and also
YUV variations.

There are two sets of data – the scanned input values and your corrected values.
Simple functionality of the plugin is to compute the data, transform to get cor-
rected values, then apply that.

Basic usage strategy:

1. first time the controls come up, nothing is checked and everything is set to 0

2. check the box Compute negfix values to see the current media input values

3. check Activate processing and you see a 1− colored screen in the Compositor
due to zero values

4. check the Apply values box to see the input values on the left side propagate
to the right side

251



9.9. Video Effects — Native

5. check Apply default box if you want to make sure that the borders of the image
are not used

6. correct the output values as desired on the applied right side

It is important to note as you play or change the frame, the plugin re-computes
the data as you move along, but it is not propagated to the applied side.

Checkboxes:

Activate processing when checked, the c41 operation is used to render the im-
age.

Compute negfix values computes the current negative values of the image (in-
side the box).

Show active area draws horizontal and vertical grid lines displaying the boxed
area.

Postprocess when checked, applies contrast/brightness values as defined in coe f 1
2 .

Values:

Compute negfix values (left side) and

negfix values to apply (right side):

Min/Max R/G/B minimum and maximum values for Red, Green, and Blue.

Light value of light; a smaller number is lighter.

Gamma G/B values for gamma Green and Blue.

Contrast simple color contrast.

Brightness white brightness.

Buttons:

Apply values copies computed RGB/Light/Gamma/Contrast/Bright from negfix
to applied values.

Apply default box copies default computed Box column/row from negfix to ap-
plied values.

Shading box: The boxing option allows for calculating the inversion of the digi-
tal negatives in a given area of the frame as opposed to the entire frame. The pro-
gram will automatically calculate the columns and rows to shave from the frame
when compute negfix values is checked. A default box area is initially calculated,
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called the shaving box, based on where the min/max difference in a row/column
is less than the program defined tolerance. This row/column minimum and max-
imum difference must be greater than 0.05. The effect is to cut away the border
areas with constant color. If you check the Show active area, you can see the box
in the compositor window. The boundary search is constrained to a range of 0.1
to 0.9 times the frame dimensions, to create a 10 percent shaved margin to avoid
over-scan and negative edge bleeding. Manual adjustment of the shaving box is
controlled via the four sliders on the bottom right which move each of the left,
right, top and bottom shaving margins. The slider bar new values automatically
take effect as you move the box and you will see the right-hand side applied values
change. When you have either the rows or the columns where the minimum slider
is greater than or equal to the maximum slider, the default box will be in effect
instead.

Optional postprocessing: In order to have the values of Contrast and Brightness
take effect, you must check the Postprocess checkbox.

Contrast is the difference in brightness between objects or regions.

Brightness refers to the overall lightness or darkness of the image.

Figure 9.28 shows the C41 controls on the left and part of the Compositor window
with grid lines showing the default shading box since the Show active area box is
checked. Changes have been made to the left-hand side original computed values
as seen in the right-hand side such as Gamma G which contains the hairline cursor
and has a partial red outline value box.

9.9.11 Chroma Key

This effect erases pixels which match the selected color. They are replaced with
black if there is no alpha channel and transparency if there is an alpha channel. In
this case, you create a matte in the alpha channel, which is not visible to us. The
selection of color model is important to determine the behavior (figure 9.29).

Chroma key uses either the lightness or the hue to determine what is erased. Use
value singles out only the lightness to determine transparency. Select a center
color to erase using the Color button. Alternatively a color can be picked directly
from the output frame by first using the color picker in the compositor window and
then selecting the Use color picker button. This sets the chroma key color to the
current color picker color.

Be aware that the output of the chroma key is fed back to the compositor, so
selecting a color again from the compositor will use the output of the chroma key
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Figure 9.28: C41 - Control window and compositor window in action

Figure 9.29: Chroma Key control window
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effect. The chroma key should be disabled when selecting colors with the color
picker.

If the lightness or hue is within a certain threshold it is erased. Increasing the
threshold determines the range of colors to be erased. It is not a simple on/off
switch. As the color approaches the edge of the threshold, it gradually gets erased
if the slope is high or is rapidly erased if the slope is low. The slope as defined here
is the number of extra values flanking the threshold required to go from opaque
to transparent.

Normally threshold is very low when using a high slope. The two parameters tend
to be exclusive because slope fills in extra threshold. The slope tries to soften
the edges of the chroma key but it does not work well for compressed sources.
A popular softening technique is to use a maximum slope and chain a blur effect
below the chroma key effect to blur just the alpha.

9.9.12 Chroma Key (HSV)7

Chroma Key (HSV) (figure 9.30) replaces a color with another color or trans-
parency using HSV variables; it is frequently used to remove a color from a video
to composite with another image. This process is generally referred to as green
screen or blue screen process (because of the color that is keyed out). More infor-
mation: http://en.wikipedia.org/wiki/Chromakey

Requirements

The subject in the movie should have a good background. The lighting is crucial
and good lighting during production will save you time with much less effort than
in post-production. Here we assume that we have a good video, filmed on green
(or blue) screen that we want to use. Important: Make sure you are using a color
model that has an alpha channel, such as RGBA8, RGBAFloat, YUVA8. To change
color model, go to Settings → Format → Color Model.

Usage

As in any other effect, add it to the timeline in the main window. You can tweak
each parameter in order to improve the keying.

Start with Hue Tolerance at 10%, Min Brightness at 0, Max brightness at 100%,
Saturation offset at 0, Min Saturation at 0, In Slope at 0, Out Slope at 0, Alpha
Offset at 0 (that’s mid-way through), Spill Threshold at 0, Spill Compensation at
100%. At any time, you can check what the Mask looks like by clicking on Show
Mask. This will output a black and white image of the mask (matte).

7Credit for Plugin by Jerome Cornet http://jcornet.free.fr/linux/chromakey.html
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Figure 9.30: Keying a green screen with Chroma Key (HSV)

Key color: Select the key color (green, blue, etc) using the color wheel or the
color picker. Remember, only the Hue matters, not Saturation or Value. To
use the color picker, click on the color picker icon in the Compositor window,
then click on the color you want in the Compositor window. Finally in the
Chromakey (HSV) parameters window, click on Use Color Picker.

Hue Tolerance: Because there are slight variations in lighting, the background
will not be in a uniform key color hue. Increase or decrease the Hue tolerance
to mask out the background. If there are dark spots that are keyed out that
shouldn’t be, it can be corrected later.

Brightness: ncrease Min Brightness so that only the background is masked out,
and not parts of the foreground. You can also reduce Max Brightness if some
clear areas are keyed out (useful for very dark backgrounds).

Saturation: Increase Min Saturation so that only the background is masked out,
and not parts of the foreground. Saturation Offset can be used to change this,
but for now leave it set to 0.

Check what it looks like at this stage, your mask should be pretty clean. Toggle
Show Mask to check what it looks like, it should be OK. If not, repeat steps 1to4
to get a better key. The rest of the controls are useful to smear the mask to help
compositing later on. They will help you to make your key look much cleaner.
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Slope: For now, the mask is a full on/ full off mask that can be really harsh and
not necessarily what you are looking for. In Slope and Out Slope will help you
to smooth that key. In Slope leaves more colors in the mask, Out Slope takes
more colors out of the mask. The colors that are borderline in the mask will
see their alpha channel reduced by half instead of being completely on or off.

Alpha Offset This control offsets the whole alpha channel by some amount. Be
sure to know what you are doing if you change it from the default value of 0.

spill light control: This step helps you remove the green or blue halo around the
edges of the mask. It does so by removing the saturation of pixels that have
a similar hue to the key color (turning them into grey instead of green or
blue). Spill Compensation controls the amount of de-saturation. If you start
with Spill Compensation at 100%, slowly increase the Spill Threshold until
the remaining green or blue areas turn grey. Then reduce Spill Compensation
until the image looks good.

Now the mask is probably still very harsh, so just below the Chromakey (HSV)
plugin, add a Blur effect, and select only the Alpha channel, with a radius of 2 or
3 (more if you really want to soften the edges). This will significantly help the
keying.

9.9.13 Color 3 Way

Together with Histogram Bezier / Curves Color 3 Way is the main tool of Color
Grading because you can modify the colors of Shadows, Midtones, and Highlights
as desired. Color 3 Way is keyframable (figure 9.31).

Figure 9.31: Color 3 Way control window
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• It allows you to vary the contrast of the image using the slider Value, always
acting separately on shadows, midtones, and highlights and thus resulting in
very precise application.

• Allows you to automate the white balance by simply choosing a neutral color
in the output of the Compositing window using the Color Picker and pressing
the corresponding button in the plugin.

• Allows you to vary the Saturation with sliders in the same manner as contrast
was varied by the Value slider. For istance, to decrease the incidence of color
dominants present in the shadows or in the highlights, vary the Saturation.

• With the color wheels you can make very sophisticated adjustments to the
shades of the images, in each of the three main areas of shadows, midtones
and highlights.

• Allows you to copy exactly the setting of one zone to the other two zones
using Copy to all button.

• In addition to the three reset buttons, each slider and each wheel has its own
Clear button, to return it to the default value without affecting the others.

This plugin allows maximum control over the result and maximum precision of
adjustments when used simultaneously with the control monitors, i.e. Waveform,
RGB Parade and Vectorscope. It is important to keep in mind that the three zones
are not clearly separated, but slightly overlapping. This results in less precision but
looks better for more smooth shades. By varying the values on the color wheels
all RGB channels are affected simultaneously, which can result in unwanted color
dominance. Saturation is also affected and must therefore be monitored. To use
more precisely, drag the crosshair with the mouse in the desired area and then
adjust in steps of 0.001 using the up/down and right/left arrows on the keyboard.
The most common use cases (but can be adapted to virtually any situation) of the
plugin are:

• White balancing.

• Expand/compress contrast.

• Mitigate under and over exposure.

• Balance colors, i.e. eliminate color dominance.

• Color matching Shot to Shot.

• Create a Stylized look.

9.9.14 Color Balance

Video Color Balance is a great effect to use along with Brightness/Contrast and
Hue/saturation to try to compensate for possible errors in filming (low lighting,
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for example). It can do so much without greatly lowering the quality of the video.
With it you can change the colors being sent to output CMY (Cyan, Magenta, Yel-
low) or RGB (Red, Green, Blue). Color Balance is also keyframable.

Since complementary colors are neutralized, to eliminate a color cast, the pertinent
slider is moved in the direction of the complementary color. Clear buttons are
present to reset its slider to default without affecting others. If you Lock param-
eters you get the same Color Offset, that is the fourth color wheel in the grading
programs. The parameters of the plugin are:

CMY/RGB sliders: allows you to adjust the colors.

Preserve Luminosity: Adjusts colors while keeping the overall brightness con-
stant.

Lock Parameters: works as a Color Offset.

White Balance used in conjunction with the color picker on a neutral color of the
output, it will automatically balance the white.

9.9.15 ColorSpace

This plugin is a tool that can be used to convert your input media, such as a record-
ing from your camera, from one color space/range to another. It works for both
RGB and YUV as set by your project format. Options are BT601, BT709, or BT2020
for Color Space input and output and JPEG or MPEG for Color Range input and
output. The Inverse option checkbox is available in case your media was rendered
in the wrong color space or range so that you can fix it.

Algorithm for conversion – where equations is a 3× 3 matrix multiply

output = (input − input_zero)× equations+ output_zero

Algorithm for inverse – where equations is a 3× 3 matrix multiply

Description: invert(equations); swap(input,output); swap(input_zero,output_zero)

input = (output − output_zero)× inverse_equations+ input_zero

9.9.16 CriKey

The Chroma Interpolation Key plugin, CriKey, is a regionally based chroma key
with interpolation (figure 9.33). This is useful when you only want 1 or some
specific zones to be defined by the chroma key as opposed to the entire image. Its
most significant feature is that you can select several regions of interests and of
different colors as opposed to only 1.
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Figure 9.32: ColorSpace control window

Figure 9.33: three active point created in CriKey

To start, if not already checked, turn on drag. In the composer window select an
area of a certain color by clicking on that point with the right mouse button and
check to see that it is enabled with an ∗ in the "E" field. The color of the area
is used to define the region of interest and then you can use the threshold slider
to designate the tolerance variation. This creates a region that is the chroma key
selection and a fill will be performed in that area, but only within that region. So,
say for example, a red colored area was chosen, only the red color inside the region
is selected – not that color red in the entire image. The drag capability makes it
easy to check a point before right clicking it to see the effect. You will want to turn
off drag when you are finished with CriKey so that it does not interfere with other
compositor functions.

Draw mode: options let you use Alpha for see-thru, Edge to just outline the edges
of the region, or Mask to block. The pixels which match the selected color
are replaced by black if Mask is chosen or see-thru/transparent if Alpha.

X, Y: points coordinate.
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Buttons: New to create a new point, Up/Dn to move highlighted point up or down
Del to delete the highlighted point.

Threshold: slider goes from 0 to 1. Increasing the threshold, increases the area
to be filled or masked. You can also use the mouse wheel to scroll the slider.

Drag: for ease of use.

Reset: button to revert to only the default middle point with all others being
deleted.

ListBox: "E" for Enabled with ∗ marking that; "X" is the point’s x coordinate; "Y"
is the point’s y coordinate; "T" is the threshold value of X , Y point; Tag rep-
resents the # of the selected point.

Hints: for usage shortcuts.

Some notable caveats

1. When choosing an area that has variations of the same color within a region,
for less work and for the best results, choose an average color in that region
instead of an extreme end of that color.

2. If the threshold is set appropriately you can see the edges which is helpful.

3. The mask is computed and shows the fill region.

4. Use the Gradient plugin to substitute a different color for the selected area.

Figure 9.34 and figure 9.35 shows how moving the Threshold slider with the Point
selected blacks out the single region which has the darker brown hills in it. Because
the edge was located, any of the same color in the rest of the video would not be
blacked out.

Figure 9.34: The screenshot shows the compositor with some default settings in the controls
window.
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Figure 9.35: same screenshot with moving Threshold

Usage steps

1. Click Reset (there will be a single X , Y coordinate point that is in the middle
and not enabled)

2. Check to make sure Drag is on.

3. In the Compositor, right click on area of interest and an X , Y coordinate will
appear in the listbox.

4. Click on the E Enabled field next to this latest point and an ∗ asterisk will
show.

5. Now you will see an area turn black so use the Threshold slider to only black
out the area of interest.

6. Repeat steps 3− 5 until you have selected all of the desired areas.

7. Finally, turn off drag so as not to interfere with other compositor functions

9.9.17 Crop & Position

It allows you to obtain a rectangle from the frame, whose dimensions are fully ad-
justable by four sliders for the four sides of the frame. You can also place this rect-
angle in the canvas using two other sliders for right/left and up/down scrolling.
With the Clear buttons we can bring the slider to default values without affecting
the other parameters. Unlike the Crop tool, the original frame size is not altered
and being keyframable allows a wide variety of uses. In figure 9.36 the Crop &
Position plugin is compared with the Crop tool.

9.9.18 DeScratch

The descratch video plugin can be used to remove vertical scratches from film. It
can also be used, after image rotation, to remove horizontal noise lines that may
appear on analog VHS captures. For best results YUV should be the video format;
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Figure 9.36: Crop tool and Crop & Position plugin compared

however if your format is RGB, it will first be converted to YUV. There are many
tuneable parameters necessary to get good results for your specific film.

Figure 9.37 shows a list of the parameter descriptions:

Figure 9.37: DeScratch control window

threshold instantaneous slope value; chroma difference in numerical pixels.

asymmetry maximum asymmetry of surrounding pixels.

Mode None; Low=black; High=white; All=both; y – processing mode for luma
plane; u– processing mode for chroma u plane; v – processing mode for
chroma v plane.
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Figure 9.38: Various parameters of DeScratch

width min/max minimal scratch width in pixels and maximum scratch width in
pixels.

len min/max percent minimal scratch length and percent maximum scratch length.

len blur scaled radius of vertical blur for frame analysis.

len gap number of pixels for maximum vertical gap to be closed.

max angle maximal angle to vertical in degrees.

fade percent of how much it fades to and how much it. Uses between before
image and blurry image.

border pixel thickness of border near scratch for partial restoration.

Mark shows the potential scratch lines for ease of viewing and for debugging. It
shows chosen pixels in the color green, close but still rejected in yellow, and
extreme pixels in the color red. This makes it easy to vary some parameters
to choose more or fewer scratch lines.

Reset activating this button returns all of the parameters to their default values.

Figure 9.39 shows a before and after DeScratch scenario. With Mark set, you can
see the black lines which indicate what the program was looking at to determine
the scratches to remove.
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Figure 9.39: Original video with scratch; Option Mark selected and Final video

9.9.19 Decimate

This is used to decrease the frame rate of a video. Changing the frame rate means
eliminating a frame for any given number of frames (1inN); but if frames that
are important for visual continuity are deleted, temporal artifacts arise: flicker-
ing, slowdowns, accelerations, etc. The Decimate filter maintains a higher quality
because it first eliminates duplicate frames or frames that are most similar, thus
limiting the appearance of artifacts. It is often used after the Invert Telecine plugin
to make the video more smooth.

One use of the decimate effect can be applied to a DVD to convert the 29.97 fps
video to the 23.97 fps film rate, but the effect can take any input rate and convert it
to any lower output rate. The output rate of decimate is the project frame rate. The
input rate is set in the decimate user interface. To convert 29.97 fps progressive
video to 23.97 fps film, apply a decimate effect to the track. Set the decimate input
rate to 29.97 and the project rate to 23.97.

Keep in mind that every effect layered before decimate, processes video at the
decimate input rate and every effect layered after decimate, processes video at
the project frame rate. Computationally intensive effects should come below dec-
imate.

9.9.20 Deinterlace

The deinterlace effect has evolved over the years to deinterlacing and a whole lot
more. In fact two of the deinterlacing methods, Inverse Telecine and Frames to
Fields, are separate effects. The deinterlace effect offers several variations of line
replication to eliminate comb artifacts in interlaced video. It also has some line
swapping tools to fix improperly captured video or make the result of a reverse
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effect display fields in the right order.

9.9.21 Deinterlace-CV

Selection of deinterlacing mode for your video to eliminate comb artifacts (fig-
ure 9.40).

Figure 9.40: Pulldown menu

9.9.22 Delay Video

Delay the video by some number of seconds.

9.9.23 Denoise Video

Denoise video (figure 9.41).

9.9.24 Difference key

The difference key creates transparency in areas which are similar between two
frames. The Difference key effect must be applied to two tracks. One track con-
tains the action in front of a constant background and another track contains the
background with nothing in front of it. Apply the difference key to the track with
the action and apply a shared effect of it to the track with the background. The
track with the background should be muted and underneath the track with the
action and the color model should have an alpha channel. It’s hard to get good
results.

Pixels which are different between the background and action track are treated
as opaque. Pixels which are similar are treated as transparent. Change threshold
in the difference key window to make more pixels which are not the same color
transparent. Change slope to change the rate at which the transparency tapers
off as pixels get more different. The slope as defined here is the number of extra
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Figure 9.41: Control window of the DeNoise plugin

values flanking the threshold required to go from opaque to transparent. A high
slope is more useful with a low threshold because slope fills in extra threshold.
Use value causes the intensity of pixels (luma) to be compared instead of the color.
Applying a blur to the top track with just the alpha channel blurred can soften the
transparency border (figure 9.42).

9.9.25 DotTV

Puts various size dots over the picture to simulate TV effect. This came from:
https://effectv.com.

9.9.26 Downsample

Downsampling is the process of reducing the size of an image by throwing out
data, reducing sampling rate.

9.9.27 Edge

Display only the edges of the video throughout the image.

9.9.28 Fields to frames

See the theory description in the Frames to Fields plugin. This effect reads frames
at twice the project framerate, combining two input frames into a single interlaced
output frame. Effects preceding fields to frames process frames at twice the project
frame rate. Each input frame is called a field.
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Figure 9.42: Difference key and its problematic output

Fields to frames needs to know what field corresponds to what lines in the output
frame. The easiest way to figure it out is to try both options in the window. If
the input fields are the result of a line doubling process like frames to fields, the
wrong setting results in blurrier output. If the input fields are the result of a stan-
dards conversion process like 1080 to 480, the wrong setting will not make any
difference.

9.9.29 Flip

This effect flips a video track either vertically or horizontally.

9.9.30 Foreground

Whatever the visual content of the frame, the Foreground plugin application ap-
plies a uniform color that can be chosen by color picker; color wheel; color presets;
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the various HSV, RGB, YUV sliders or by entering the hexadecimal value. The alpha
slider is not missing either.

9.9.31 Frames to fields

Theory behind the Frames to Fields and Fields to Frames plugins

Historically, CRT-type TVs used interlaced signals to save bandwidth. An interlaced
video consists of two fields that are read and drawn on the screen one after the
other. Each field must be played at a framerate double that of the resulting video.
In two steps the complete frame will be reconstructed.

frame 1 =⇒ F1-field1 (Top or Odd), F1-field2 (Bottom or Even)

frame 2 =⇒ F2-field1, F2-field2

Interlaced video reading: F1− f 1 then F1− f 2 then F2− f 1 then F2− f 2 . . . There
may be visual problems if the Top type interlacing is read according to a Bottom
scheme. So it’s important to know if a video is Top or Bottom. Generally an HD
video is Top; a DV video (both PAL and NTSC) is Bottom; SD (PAL) is Top; SD
(NTSC) is Bottom (but not always). Instead, high-definition videos need to be
more compressed and this contrasts with the interlacing that is little and badly
compressible, so modern videos are mostly progressive.

In CINELERRA-GG

1. upload an interlaced video to the Timeline and Resources and play it for
viewing.

2. The video presents visual artifacts because PC monitors are progressive.

3. In the Resources window, open the media Info with the right mouse button.
Below you can see that the asset’s interlacing is active. It has four options
for settings interlacing type: Unknown, Top Fields first, Bottom Fields first,
and Not interlaced. If the file is (H)DV type, recognition and configuration is
done automatically. All other media types will be set unknown. We need to
set the type of interlacing, so we have to manually set the interlacing.

4. Now we can to use the Frames to Fields plugin, but we have to configure it
and act manually.

Now for the practical use of this plugin which applies the operation reverse to the
Fields to Frames plugin. It extracts the two interlaced fields stored in alternating
lines of interlaced source footage and outputs them as separate full frames. The
alternating lines missing on each output frame are interpolated.
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This plugin is only useful if its output is pulled with doubled framerate with re-
spect to the source footage. One typical usage scenario is to do masking, scaling
and translating on interlaced footage without the need to destroy the additional
temporal information contained in such source material. This is helpful if your in-
tended target format is interlaced. If on the other hand, you just want to target a
progressive display (for example, you create video for display on a computer mon-
itor solely) then it is much more convenient to de-interlace the source material
prior to any further processing.

Processing interlaced footage without deinterlacing

1. Create a new project with doubled frame rate. That is, make it 50 f ps if your
source footage is 25i. In Resources → Media → Info set the interlaced
type (or unknown)

2. Insert your source footage onto a video track in the timeline. Now, CINELERRA-
GG will playback each frame of your footage twice. There will be visual arti-
facts because the video is interlaced and the monitor is progressive.

3. Apply the Frames to Fields effect. Be sure to choose the correct field order. If
we know or believe that the original video is Top First let’s try it first, but it
doesn’t have to be the right solution. The only way is to playback and look
for visual artifacts.

4. Then apply any further effects afterwards, including translations, scaling,
slow motion, precise frame-wise masking or use of the motion tracker plugin.

5. Render your project to an intermediate clip. Be sure to choose a rather loss-
less video codec, for example Motion-JPEG-A or even uncompressed YUV if
you have plenty of storage.

6. Insert the intermediate clip into your original project. Make sure the doubled
framerate has been detected correctly by CINELERRA-GG (by looking in the
clip’s media info in the media resources folder).

7. Apply the Fields to frames effect to the intermediate clip. This will combine
two adjacent fields into one interlaced field with the original frame rate.

8. Do the final render on your original project. Now there will be no visual
artifacts on the monitor.

9.9.32 Freeze Frame

In its simplest form, highlight a region of the track to freeze, drop the freeze
frame effect on the highlighted region, and the lowest numbered frame in the af-
fected area will play throughout the entire region. Freeze Frame has an enabled
option which can be keyframed. Regions of a freeze frame effect which are en-
abled, repeat the lowest numbered frame since the last keyframe. This has unique
possibilities.
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• If a freeze frame effect has a keyframe in the middle of it set to enabled, the
frame in the middle is repeated in the entire effect.

• If a freeze frame effect has several keyframes, each set to enabled, every time
a keyframe is encountered the frame under it becomes the frozen one.

• If a freeze frame effect alternates between enabled and disabled, each time
an enabled keyframe is encountered the frame under it is replicated until the
next disabled keyframe. The disabled regions play through.

9.9.33 Gamma

Log camera images store colors in a logari thmic scale. The blacks in these images
are nearly 0 and the whites are supposed to be infinity. The graphics card and most
video codecs store colors in a l inear scale but CINELERRA-GG keeps log camera
images in their original logarithmic scale when it renders them. This is necessary
because the raw image parser can not always decode the proper gamma (γ) values
for the images. It also does its processing in 16 bi t integers, which takes away a
lot of information.

Mathematically, the gamma function is exponential (output = inputγ) and there-
fore the inverse of the logarithmic function [output = log(input)]. Actually the
formula used by the CINELERRA-GG plugin is: output = input

1
γ which allows for

a range of values 0 ÷ 1.0. The gamma effect converts the logarithmic colors to
linear colors through a gamma value and a maximum value. The gamma value
determines how steep the output curve is (i.e. the value of the gamma parame-
ter; for color space Rec709 is 2.4 (1

γ = 0.41 . . . ), for sRGB is 2.2 (1
γ = 0.45 . . . ),

etc.). The maximum value is where 1.0 in the output corresponds to maximum
brightness in the input. It serves to avoid clipped values because it allows you to
set the maximum value of the output, 1.0, whenever range adjustment is done
(see figure 9.43). It is important to adjust the two parameters accurately in order
to avoid undesired and unexpected effects, such as excessive values, unbalanced
image, incorrect linearization, etc.

The gamma effect has two more parameters to simplify gamma correction. The
automatic option causes it to calculate max from the histogram of the image. Use
this when making a preview of a long list of images since it changes for every
image. The use color picker option uses the value currently in the color picker to
set the maximum value. Note that every time you pick a color from the compositor
window, you need to click on use color picker to apply the new value.

The best use of the gamma is manually monitoring the waveform as shown in
figure 9.44.

• Look at the highest peak on the waveform and measure it with the crosshair
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Figure 9.43: settting Maximun to 0.5900

observing the numerical value at the top left.

• Set this value with the maximum slider.

• Then adjust the slider of the gamma to our liking, always checking the result
on the waveform so to be sure never to exceed the values of clipping, 0÷1.0.

Figure 9.44: Setting Maximun to 0.6100 and Gamma to 0.3300

Care must be taken when using gamma correction: if the image carries a specific
gamma value, or if it has already been corrected previously (for example auto-
matically in the camera), etc.; then a second application of the gamma leads to
excessive and artificial results. Gamma is keyframable.
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9.9.34 Gradient

The gradient effect overlays a smooth color gradient on top of every video frame. It
is useful for all sorts of background fills, for partially filtering, adding depth to the
image, or for adding moving highlights. The Gradient effect can generate linear or
circular color fills / shape. For linear fills, you can choose the angle, for circular fills
the center (X , Y ) of the created gradient pattern. You can control the slope of the
color transition by selecting a transition function (l inear, logari thmic, squared)
and by changing the start (inner) and stop (outer) radius. Note that both colors
used in this color transition can contain an arbitrary Alpha value (transparency).
All parameters can be keyed and will be interpolated between keyframes.

The first time you use the plugin it may seem complicated, but if you understand
that we have to adjust the gradient from an inner spot we choose to an outer spot
we also choose, the work will become easy and fast.

Use case (Vignette)

1. Setting the shape to radial

2. Setting the rate to Linear (or Log or Square)

3. Position X and Y to center the main figure.

4. Choose inner color=black

5. Adjust inner radius

6. Bring the inner color alpha slider to 0

7. Choose outer color=black

8. Check that the outer color alpha slider is 1.

9. Adjust outer radius

Note: The inner and outer colors are visibly mixed in the gradient area. If you
want to make a vignetting of only black, you must set the two colors to black and
then make the inner one transparent so that it does not cover the figure.

9.9.35 HistEq

Remap colors using blended histogram weights. Figure 9.45 shows the GUI and
the results in a split screen.

Histeq equalizes the colorspace through use of a histogram equalization algorithm
– a technique for adjusting image intensities to enhance contrast. Parameters are:

Gain: when set to 1, the colorspace is best effort. If the gain is set to 0, the result
is the entire regression line of the color map.
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Figure 9.45: Control window and split screen

Blend: goes between a straight and a twisted line.

Split output: diagonally shows in the compositor, the new results on the left and
old on the right.

Plot bins/lut: displays a plot of the result.

9.9.36 Histogram

The histogram allows an immediate view of the contrast amplitude of an image
with its distribution of luma and colors values. If the columns of values occupy the
whole range 0 − 100% then we have maximum contrast; if the range is smaller
the contrast is smaller. If most of the values are on the right of the histogram
you have an image with highlights at the limit with values clamped to 1.0. This
is called overexposure. However, if most of the values are moved to the left, with
the limit of the values clamped to 0, we have a lowlight image and we talk about
underexposure. Histogram is keyframble (figure 9.46).

The Histogram is always performed in floating point RGB regardless of the project
color space. The histogram has two sets of transfer parameters: the input transfer
and the output transfer. The input transfer has value on the horizontal axis of x;
it is a scale of values ranging from 0 to 255 in the case of an 8 bi t image, or it
can have normalized values in the range (0−1.0) or even be a scale in percentage
(0−100%). In the output transfer (the y ax is) is represented the number of times
(that is, y) a given value x appears. A higher column (y greater) indicates that
many pixels have the corresponding value x; a lower column indicates that fewer
pixels have that value. On the left we have the minimum value 0, which is the
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Figure 9.46: Master Histogram and RGB Histogram

black point. On the right we have the maximum value 1.0 which is the white point.
The intermediate values pass smoothly from one extreme to the other. The three
important points (including the midtones, i.e. the Master Offset) are indicated
by cursors (small triangles) at the base of the histogram. You can adjust them to
change the values of the three points if you want.

There are 4 possible histograms in the histogram viewer. The red, green, blue
histograms show the input histograms for red, green, blue and multiply them by
an input transfer to get the output red, green, blue. Then the output red, green,
blue is scaled by an output transfer. The scaled red, green, blue is converted into
a value and plotted on the value histogram. The value histogram thus changes
depending on the settings for red, green, blue. The value transfers are applied
uniformly to R, G, B after their color transfers are applied. Mathematically, it is
said that the values of x are linked to the values of y by a transfer function. This
function is represented by a line that leaves the values of x and y unchanged, but
we can intervene by modifying this line with the cursors.

You need to select which transfer to view by selecting one of the channels on the
top of the histogram. You can also choose whether to display the master, i.e. only
the values of the luma, or show the Parade, i.e. the three RGB channels. You can
switch from one to the other with the two buttons in the upper right corner. The
input transfer is defined by a graph overlaid on the histogram; this is a straight
line. Video entering the histogram is first plotted on the histogram plot, then it is
translated so output values now equal the output values for each input value on
the input graph.

After the input transfer, the image is processed by the output transfer. The output
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transfer is simply a minimum and maximum to scale the input colors to. Input
values of 100% are scaled down to the output’s maximum. Input values of 0% are
scaled up to the output minimum. Input values below 0 are always clamped to 0
and input values above 100% are always clamped to 100%. Click and drag on the
output gradient’s triangles to change it. It also has textboxes to enter values into.

Enable the Automatic toggle to have the histogram calculate an automatic input
transfer for the red, green, and blue but not the value. It does this by scaling
the middle 99% of the pixels to take 100% of the histogram width. The number
of pixels permitted to pass through is set by the Threshold textbox. A threshold
of 0.99 scales the input so 99% of the pixels pass through. Smaller thresholds
permit fewer pixels to pass through and make the output look more contrasty.
Plot histogram is a checkbox that enables plotting the histogram. Split output is
a checkbox that enables a diagonal split showing in the compositor. Reset returns
the four curves to their initial state (neutral) as well as the Value/RGB histogram
buttons.

9.9.37 Histogram Bezier / Curves

Histogram Bézier allows an immediate view of the contrast amplitude of an image
with its distribution of luma and colors values using a piecewise linear method. In
addition it uses a Bézier curve (parametric) on the histogram plot. When mapping
color spaces, it has a variety of presentations to get smoother transitions and more
pleasing output. It uses more general remapping, not just straight lines but more
contour lines. Curves are perhaps the most powerful and sophisticated tool for
color correction. For some repetitive details, see the previous description of the
Histogram plugin. Histogram Bézier is keyframable.

The input graph is edited by adding and removing any number of points. Click
and drag anywhere in the input graph to create a point and move it. Click on an
existing point to make it active and move it. The active point is always indicated
by being filled in. The active point’s input X and output Y values are given in
textboxes on top of the window. The input and output color of the point can be
changed through these textboxes. Points can be deleted by first selecting a point
and then dragging it to the other side of an adjacent point. They can also be
deleted by selecting them and hitting delete (figure 9.47).

• Master (value) and R, G, B histograms.

• Textbox for input x (input) and input y (output).

• Output min and output max: sets black or white points. If you use both points
it works as Master/Color Offset. Values can also be less than 0 and greater
than 1.0.
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Figure 9.47: Histogram Bezier / Curves

• Scale for contrast range: sets with cursors shown as little triangles.

• Automatic and Threshold: enable the Automatic toggle to have the histogram
calculate an automatic input transfer for the red, green, and blue but not the
value. It does this by scaling the middle 99% of the pixels to take 100% of
the histogram width. The number of pixels permitted to pass through is set
by the Threshold textbox. A threshold of 0.99 scales the input so 99% of the
pixels pass through. Smaller thresholds permit fewer pixels to pass through
and make the output look more contrasty.

• Reset: returns the four curves to their initial state (neutral).

• Split picture: a checkbox that enables a diagonal split showing in the com-
positor.

• Interpolation: type of algorithm for the parametric curves; linear, polynomial
and Bezier.

Curves are used by introducing control points simply with the left mouse button and
adjusting the value by dragging and dropping. If you drag along the horizontal
line only, you change the value of x and you can read this value in the input x
textbox. If you drag along the vertical line only, you change the value of y and
you can read the value in the input y textbox. This is the output value. The newly
clicked control point becomes active and is full green in color. To delete a point
we have to make it active and then press the Del key, or we can drag the point
beyond the position of another control point to its right or left or, finally, pressing
RMB. The control points corresponding to the black point and the white point are
automatically created from the beginning, to fix their values and prevent clipping.
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Curves are generally adjusted by introducing several control points, some to be
kept fixed (as anchors) to prevent curve modification beyond them, and others to
be dragged to make the desired correction. The power of the curves lies in being
able to circumscribe a small interval at will and intervene only on this without
involving the remaining parts of the frame. The precision with which you can
work is such that you can almost arrive at a secondary color correction.

Figure 9.48: Gain Up/Down; clamp; S-Shaped curve and Luma Key

The most used type of modification is to create a S curve. There can be a lot of
shapes that use the S curve; the simplest is to create a control point in the shadows,
one in the midtones (anchors) and one in the highlights. Moving the highlight
point upwards and the shadow point downwards increases the contrast, making
the image sharper and improving the color rendering. With the type of linear curve
you can make hard adjustments, similar to the result of the use of Color 3 Way,
even if this acts on the color wheel (Hue) while the curves act on individual RGB
channels.

The Polynomial and Bézier types introduce control handles that allow for more so-
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phisticated and smoother adjustments. The quality of the result is much better, but
they require more experience for their optimal use. Extending the handles away
from the control point increases the radius of the curve at that point. By vary-
ing the angle of the handles we change the tangent and thus the curvature of the
curve below. The difference between Polynomial and Bézier lies in the underlying
mathematics, but for practical purposes the use is similar.

Some examples of the use of curves to demonstrate the variety of possible inter-
ventions (figure 9.48):

• Scale the image values by increasing the white point or decreasing the white
point (gain up and gain down). You can decide the scaling value with the
formula: (Input ÷Output) = ScaleFactor

• Limit a value beyond a certain point of brightness (clamp to the value 0.587
in the figure).

• S-shaped curve to increase contrast without changing the black and white
point (i.e. without clipping).

• Make a real Luma Key by bringing a certain value of gray to 100% (white) and
lowering everything else to 0% (black). The slope of the two sides indicates
how much we want to fade the edges of the matte obtained.

9.9.38 HolographicTV

Incoming objects are projected like holovision seen in the movie Stars Wars as
in R2-D2’s video message projector of the Princess Leia. You need a movie or
background image and above it a track containing the figure on which to apply
the effect. This must have a transparent background. There are no configuration
parameters; it only has to be applied to the upper track (figure 9.49).

This effect originated from https://effectv.com.

9.9.39 Hue saturation

With this effect you can change hue, saturation and value. The parameters are
modified using 3 simple sliders. The hue control shifts the colors circularly in the
color plane, normally resulting in false colors. The saturation control can be used
to reduce color footage to black and white. The value control makes any given
colors more bright or more subdued. Clear buttons are present to reset its slider
to default without affecting others.
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Figure 9.49: Holographic messages in CinGG!

9.9.40 Interpolate Bayer

Uses a Bayer filter algorithm to interpolate (estimate) missing color information.
This is needed for some cameras where each pixel location only has an R or G or
B value instead of all R, G, and B values for each location. The algorithm creates
values for each of the three colors at every location by smearing (interpolating)
each set of partial R, G and B values to create values at every pixel location.

9.9.41 Interpolate Video

Theory

Each video has its own framerate. If we want to change it (for timelapse or slow-
motion) the best thing is to shoot the scene with suitable framerate. But even in
post production we can do something. The simplest method is to remove some
frames to speed up the movie or add some to slow it down (from now on, for
simplicity we will consider only the timelapse). Needless to say, the result is not
smooth and the viewer will notice it immediately. A better method is to use the
interpolation, mediating the pairs of frames that alternate. For example, if we
have a sequence of frames 1, 2,3, 4,5, 6,7, 8 . . . we can make a timelapse mixing
frames 1 and 2, 3 and 4, 5 and 6, 7 and 8 and so on. So we will have a new
sequence of 4 frames instead of the initial 8: 12,34, 56,78 . . . We will get 50%
acceleration but it will always be of bad quality because of the too rough blending
between the pairs of frames. Blending can be improved by weighing it differently
by 50% f rame1 + 50% f rame2, but the result is still unsatisfactory. Further im-
provements can be achieved by using logari thmic or ex ponential interpolation
instead of l inear interpolation. But the most sophisticated methods that lead to
better results are based on optical flow analysis. These analyses the movement of
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circumscribed areas over a given period of time. With this method the intermedi-
ate frames do not derive from an approximate blending, but from the calculation
of the vector of the motion between two frames that determines the displacement
(warping) of the moving figure in the new intermediate frame. Interpolate Video
works this way.

Practice

The practical use of Interpolate Video is a little different than the theory. The inter-
polate effect tries to create the illusion of a higher frame rate from source footage
of very low framerates by averaging frames over time. It averages two input frames
for each output frame. You choose a zone to be evaluated (macroblock size) and a
radius (search radius) where you can search for this macroblock in the following
frames. The Use optic flow button is activated and playback starts. The plugin will
calculate the motion vector (which can be made visible by the draw motion vectors
button) and apply it to intermediate frames. This operation is CPU intensive. Once
the analysis is done, we can scroll the video by unchecking the two buttons and
obtaining the desired result. There are two ways of specifying the input frames.
You can specify an input frame rate which is lower than the project frame rate
(imput frames per seconds). This causes input frames to be taken at even intervals.
You can also specify keyframe locations as the positions of the input frames (use
keyframes as input). In this mode the output frame rate is used as the input frame
rate and you just create keyframes wherever you want to specify an input frame.

9.9.42 Inverse Telecine

This is the most effective deinterlacing tool when the footage is a video transfer
of a film. This can be used to solve the problem, i.e., undo the damage caused by
making film into a TV broadcast. That process came about because film is at 24 fps
while TV is at 29.97 fps and fields are at 60. So the film was converted from 24 fps
to 60 fps. Roughly speaking, converting every 4 frames into 5 frames plus a slight
slow down in speed. Then the 60 fps was down-sampled to 30 fps by extracting
odd and even lines and interlacing the lines. This process is referred to as three-
two pull down (3 : 2 pull down) in filmmaking and television production for the
post production process of transferring film to video. The three-two pull down is
where the telecine adds a third video field (a half frame) to every second video
frame, but the untrained eye cannot see the addition of this extra video field. The
IVTC effect is primarily a way to convert interlaced video to progressive video. It
reverses the effect of three patterns of interlacing. In the next lines A, B, and C
represent fields.

A AB BC CD D

AB CD CD DE EF
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Automatic

The first two options are fixed patterns and affected by the pattern offset and odd
field first parameters. The last option creates several combinations of lines for each
frame and picks the most progressive combination. It is a brute force algorithm
that is trying to resample the lines. This technique does not rely on a pattern like
other techniques and is less destructive but the timing is going to be jittery because
of the lack of a frame rate reduction. In order to smooth out the timing, you need
to follow inverse telecine with a decimate effect.

9.9.43 Invert Video

Invert video is a method of reversing the colors of a video track. The four param-
eters refer to channels – Red, Blue, Green, Alpha. A very common use is to invert
the alpha channel to change transparency.

9.9.44 Lens

Create the effect of looking through a lens.

R, G, B, A Field of View: quantity of deformation of the relative fields. Often
used with Lock to simultaneously affect the 4 fields.

Aspect Ratio: determines the aspect ratio that you intentionally set.

Radius: radius of curvature of the distortion. At minimum, it is a sphere (fish eye)
and at maximum, it is a rectangle (no distortion).

Center X, Y: determines the coordinates of the center of the sphere. It can be
made visible with Draw Center.

Mode: determines the type of distortion. The choice is between sphere shrink,
sphere stretch, rectilinear shrink and rectlinear stretch.

Interpolation determines the interpolation algorithm; from the fastest and least
precise Nearest, passing through BiLinear to the better BiCubic.

9.9.45 Linear Blur

This effect acts only in one direction which can vary up to an angle of 180° with
these parameters:

Lenght: distance between original image and final blur step; corresponds to the
distance of the fields.

Angle: angle of motion in one direction for linear blur
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Figure 9.50: For clarity of presentation only 2 fields are shown

Steps: number of blur steps to be used in the calculation. Increasing the number
takes more CPU.

Channels: R,G,B,A.

Clear With the Clear buttons we can bring the slider to default values without
affecting the other parameters.

Figure 9.50 shown here has the parameters: Leng th = 19, Angle = 25, and
Steps = 2.

9.9.46 Live Video

This effect reads video directly from the capture card input. It replaces any video
on the track so it is normally applied to an empty track. Only one Live Video effect
can exist at any time on the timeline. It can not be shared by more than one track.
The configuration for the capture card is taken from the recording preferences. Go
to Settings → Preferences → Recording to set up the capture card.

In the Video In section where it says Record driver, it should be set to either Video4Linux2
or IEC 61883. Other video drivers have not been tested with Live Video and prob-
ably will not work. For live video, the selection for File Format and Video needs
to be set to a format the timeline can use. The file format must be Quicktime for
Linux and video recording must be enabled for it. Click on the wrench to set the
video compression.

The video compression depends on the recording driver. For the Video4Linux2
recording driver, the compression must be Motion JPEG A. For the IEC 61883 driver,
the compression must be DV. This gets the driver to generate output in a color
model that the timeline can use. Some cards provide color and channel settings.
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Live video takes the color settings from the values set in the Video In window. Go
to File → Record to bring up the recording interface and the Video In window.
Values set in the Video in window are used by Live Video. Any channels the cap-
ture card supports need to be configured in the Video In interface since the same
channels are used by the Live Video effect.

With the video recording configured, highlight a horizontal region of a video track
or define in and out points. Then drop the Live Video effect into it. Drop other
effects after Live Video to process the live video in realtime. For best results, you
should use OpenGL and a video card which supports GL shading language. Go to
Settings → Preferences → Playback → Video Out to enable the OpenGL
driver.

9.9.47 Loop video

Sections of video can be looped by dropping a loop effect on them. Contrary to
the settings → loop playback option, the loop effects can be rendered where
the settings → loop playback option can not be. The loop effects are also
convenient for short regions.

The loop effects have one option: the number of frames or samples to loop. This
specifies the length of the region to loop starting from either the beginning of the
effect or the latest keyframe. The region is replicated for the entire effect.

Every time a keyframe is set in a loop effect, the keyframe becomes the beginning of
the region to loop. Setting several keyframes in succession causes several regions
to loop. Setting a single keyframe causes the region after the keyframe to be looped
throughout the effect, no matter where the keyframe is. The end of an effect can
be looped from the beginning by setting the keyframe near the end.

9.9.48 Motion51

This plugin compensates for unwanted motion and stabilizes the picture. The Mo-
tion51 Plugin simplifies motion stabilization so that without a lot of tweaking you
can easily achieve reasonable results, either by using the defaults or varying a sin-
gle parameter. Since the motion in every clip is specific, there are some additional
parameters useful to adjust the settings accordingly. Alternatively, the MotionCV
and MotionHV plugins can still be used as the originals, if more control over spe-
cific parameters is needed. The Motion51 plugin uses different methods for track-
ing than the other motion plugins. Motion Stabilization is very useful if you have
jittery video, for example when taken from a car window, or while walking.

The better results require more samples. Setting the sample set size is probably the
most important setup change. Also, when computing motion compensation, the
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entire history of the image motion is important, and so it is desirable to enable the
playback setting play every frame in order to get good results. When every frame
has to be processed, it can be time-consuming. Reasonable results are possible
with small sample sets. After setup, the sample size can be increased to produce a
high quality rendered result.

Description of what the program is doing

The motion is detected by sampling the video image in a circular field. This size
and placement of the sample region defaults to most of the image area. When the
draw vectors feature is enabled, the outer line trace encloses the searched region.
The dotted circles define the target pixel set as the reference sample. The image
is sampled using the circle pattern in a grid search. The best match is used to
find the center and amount of rotation to transform the current image so that the
reference area motion is canceled.

The amount of sampling does not significantly change for smaller or larger search
areas. This means that a wide area can be searched just as easily as smaller areas.
The main parameter which determines how hard it looks at the image is the sam-
ples parameter. It represents the number of possible rotations, as well as the search
precision. More samples mean more precision, and less jitter, but the program will
run more slowly (figure 9.51).

The Samples box at the top is most often the only parameter that you may want
to vary.

Program Parameters Description follows

X11-OpenGL: setting can speed up the computation significantly in some cases
when hardware OpenGL is available.

Samples: is the number of pixels which the software will examine to stabilize the
picture. The sample set is arranged in 4 equal concentric circular sets. Each
sample dot represents content and position for a pattern matching test. Set-
ting the samples to larger values improves the match by adding lots of place-
ment possibilities. The samples/pixels that will be utilized are distributed
throughout the selected area – this is seen within the circles drawn when
Draw Vectors is enabled. See figure 9.51.

Draw vectors: demonstrates the search operation of motion stabilization. When
enabled, the outer search boundary (oval), the search grid area (rectangle),
and the reference sample (circles) are visible. 4 concentric circles show the
reference sample set (target). You will also see an arrow in the center of the
circle which shows each image displacement from frame to frame. When you
render the video using the motion plugin, these dots/lines/circles are drawn
into the rendered output. Draw vectors helps to visualize the meaning of the
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Figure 9.51: Motion51 plugin window with its default options set.

parameters to aid in setup. You should disable Draw Vectors before the final
rendering.

Sample Radius: is the radius of a circle that denotes the area of the sample loca-
tions. It is expressed as a percentage of the smallest image edge. For example,
if it is set to 50%, then the circle will overlap about 1

2 of the image. This does
not change the number of samples. It does change the area from where the
samples are gathered. If you have Draw vectors on, you can see the faint
outline of a circle used for the radius.

Center X/Y: is the center position of the sample circle, as a percentage of image
width and height. This is useful to reset the reference focal point in cases
where the important feature target is off-center. When both X and Y are set
to 50%, the samples will be used from around the center of the video.

Search W/H: determines the width and height of the rectangular area used for
the grid pattern search. Samples are taken by moving the center of the circles
in a grid pattern.
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Horiz/Vert shake limit: (Shaking refers to image translation) determines trans-
lation constraints. If the motion determined by the search exceeds the limit,
it is clipped to a value that is at the limit boundary. For example, if the match
indicates that the motion is 60% off the reference target, but the limit is 50%,
then the actual translation used will be limited to only 50%.

Shake fade: determines how fast the translation cancellation fades away, and the
image resettles to its actual appearance. Every frame that is processed ac-
cumulates the motion of the past. The amount of the past motion which is
applied is reduced by the fading factor. The current match is then added to
the fading past motion history. Fading works fast. It is applied every frame.
So if fade is 10%, and no new motion occurs in the input, the history will be
90%, 81%,73%, 66%. . . and in 30 frames only 4.2% of the past motion will
be present in the effect. Fading insures that the image will eventually settle
re-centered when the image motion ends.

Twist limit: (Twisting refers to image rotation) determines the rotation constraints.
If the rotation determined by the search exceeds the limit, it is clipped to the
limit boundary. Its operation is similar to the shake limits.

Twist fade: determines how fast the rotation cancellation fades away, and the
image resettles to its actual appearance. Its operation is similar to the shake
fade.

Enable Tracking: caches the search results in a file so that subsequent playback
does not have to be recalculated. When tracking is enabled, before a frame
is processed the frame number is used to look for cached results. If cache
data is available, it is used. If no data is available, the frame is processed
by the motion tracking search, and the results are added to the cache file. If
tracking is not enabled, the data is always sourced from the motion tracking
search and the tracking file is not updated.

Tracking file: is the name of the file which will contain the calculated values to
be saved. Note that the default is /tmp/motion51 which can be hazardous,
since a system crash or a reboot can delete /tmp files.

Reset Defaults: button is used to revert to the initial defaults built into the pro-
gram.

Reset Tracking: will delete the current Tracking file and disables tracking so that
any previously calculated values are no longer available. However, because
motion stabilization can often be cpu intensive, if the default file already
exists, it will create a file name from the loaded asset.

Play Every Frame: shows if you are Currently using: Play every frame. For best
results, set play every frame. This can be set in Settings → Preferences
→ Playback A Tab in the Video out section.
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9.9.49 Motion

The motion tracker is almost a complete application in itself. The motion tracker
tracks two types of motion: translation and rotation. It can track both simultane-
ously or one only. It can do 1

4 pixel tracking or single pixel tracking. It can stabilize
motion or cause one track to follow the motion of another track. Although the mo-
tion tracker is applied as a realtime effect, it usually must be rendered to see useful
results. The effect takes a long time to precisely detect motion so it is very slow.

Motion tracker works by using one region of the frame as the region to track
(Match Box). It compares this region between 2 frames to calculate the motion.
This region can be defined anywhere on the screen. Once the motion between 2
frames has been calculated, a number of things can be done with that motion vec-
tor. It can be scaled by a user value and clamped to a maximum range. It can be
thrown away or accumulated with all the motion vectors leading up to the current
position.

To save time the motion result can be saved in a file for later reuse, recalled from
a previous calculation, or discarded. The motion tracker has a notion of 2 tracks,
the master layer and the target layer. The master layer is where the comparison
between 2 frames takes place. The target layer is where motion is applied either
to track or compensate for the motion in the master layer.

Motion tracking parameters:

Track translation Enables translation operations. The motion tracker tracks X
and Y motion in the master layer and adjusts X and Y motion in the target
layer.

Translation block size For the translation operations, a block is compared to a
number of neighboring blocks to find the one with the least difference. The
size of the Match Box to search for is given by this parameter.

Translation search radius The size of the area to scan for the translation block.

Translation search steps Ideally the search operation would compare the trans-
lation block with every other pixel in the translation search radius. To speed
this operation up, a subset of the total positions is searched. Then the search
area is narrowed and re-scanned by the same number of search steps until
the motion is known to 1

4 pixel accuracy.

Block X, Y These coordinates determine the center of the translation block based
on percentages of the width and height of the image. The center of the block
should be part of the image which is visible at all times.

Maximum absolute offset The amount of motion detected by the motion tracker
is unlimited if this is 100. If it is under 100 the amount of motion is limited
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by that percentage of the image size.

Settling speed The motion detected between every frame can be accumulated
to form an absolute motion vector. If the settling speed is 100 the absolute
vector is added to the next frame. If the settling speed is less than 100 the
absolute vector is downscaled by the settling amount before being added to
the next frame.

Track rotation Enables rotation operations. The motion tracker tracks rotation
in the master layer and adjusts rotation in the target layer.

Rotation block size For rotation operations a single block is compared to equally
sized blocks, each rotated by a different amount. This is the size of the rota-
tion block.

Rotation search radius This is the maximum angle of rotation from the starting
frame the rotation scanner can detect. The rotation scan is from this angle
counterclockwise to this angle clockwise. Thus the rotation search radius is
half the total range scanned.

Rotation search steps Ideally every possible angle would be tested to get the ro-
tation. To speed up the rotation search, the rotation search radius is divided
into a finite number of angles and only those angles compared to the starting
frame. Then the search radius is narrowed and an equal number of angles is
compared in the smaller radius until the highest possible accuracy is achieved.
Normally you need one search step for every degree scanned. Since the rota-
tion scanner scans the rotation search radius in two directions, you need two
steps for every degree in the search radius to search the complete range.

Draw vectors When translation is enabled, 2 boxes are drawn on the frame. One
box represents the translation block. Another box outside the translation
block represents the extent of the translation search radius. In the center of
these boxes is an arrow showing the translation between the 2 master frames.
When rotation is enabled, a single box the size of the rotation block is drawn
rotated by the amount of rotation detected.

Track single frame When this option is used the motion between a single starting
frame and the frame currently under the insertion point is calculated. The
starting frame is specified in the Frame number box. The motion calculated
this way is taken as the absolute motion vector. The absolute motion vector
for each frame replaces the absolute motion vector for the previous frame.
Settling speed has no effect on it since it does not contain any previous mo-
tion vectors. Playback can start anywhere on the timeline since there is no
dependence on previous results. We talk about Keep shape and it is the most
precise way to calculate the motion vector; but it only works well when the
object to be traced does not change along the clip, remaining identical in
shape, size and without rotation.

Track previous frame Causes only the motion between the previous frame and
the current frame to be calculated (Follow shape). This is added to an abso-
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lute motion vector to get the new motion from the start of the sequence to
the current position. After every frame processed this way, the block posi-
tion is shifted to always cover the same region of the image. Playback must
be started from the start of the motion effect in order to accumulate all the
necessary motion vectors. This method is less precise because you have er-
ror propagation between frames. However, it is essential when the object
changes shape or size or rotates.

Previous frame same block This is useful for stabilizing jerky camcorder footage.
In this mode the motion between the previous frame and the current frame is
calculated. Instead of adjusting the block position to reflect the new location
of the image, like Track Previous Frame does, the block position is unchanged
between each frame. Thus a new region is compared for each frame.

Master layer This determines the track which supplies the starting frame and end-
ing frame for the motion calculation. If it is Bottom the bottom track of all
the tracks sharing this effect is the master layer. The top track of all the tracks
is the target layer.

Calculation This determines whether to calculate the motion at all and whether
to save it to disk. If it is Don’t Calculate the motion calculation is skipped. If
it is Recalculate the motion calculation is performed every time each frame is
rendered. If it is Save the motion calculation is always performed but a copy
is also saved. If it is Load, the motion calculation is loaded from a previous
save calculation. If there is no previous save calculation on disk, a new motion
calculation is performed.

Action Once the motion vector is known this determines whether to move the
target layer opposing the motion vector or following the motion vector. If it
is Do Nothing the target layer is untouched. If it is Track. . . the target layer is
moved by the same amount as the master layer. This is useful for matching
titles to objects in the frame. If it is Stabilize. . . the target layer is moved
opposite to the motion vector. This is useful for stabilizing an object in the
frame. The motion operations can be accurate to single pixels or subpixels
by changing the action setting.

Secrets of motion tracking

Since it is a very slow effect, there is a method to applying the motion tracker to
get the most out of it. First disable playback for the track to do motion tracking
on. Then drop the effect on a region of video with some motion to track. Then
rewind the insertion point to the start of the region. Set Action→ Do Nothing; Set
Calculation → Don’t calculate; Enable Draw vectors. Then enable playback of the
track to see the motion tracking areas.

Enable which of translation motion or rotation motion vectors you want to track.
By watching the compositor window and adjusting the Block x,y settings, center the
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block on the part of the image you want to track. It is advisable to choose elements
that have evident edges in the x and y directions because the calculations are made
on these coordinates. Then set search radius, block size and block coordinates for
translation and rotation.

Once this is configured, set the calculation to Save coords and do test runs through
the sequence to see if the motion tracker works and to save the motion vectors.
Next, disable playback for the track, disable Draw vectors, set the motion action
to perform on the target layer and change the calculation to Load coords. Finally
enable playback for the track.

When using a single starting frame to calculate the motion of a sequence (Keep
Shape), the starting frame should be a single frame with the least motion to any
of the other frames. This is rarely frame 0. Usually it is a frame near the middle
of the sequence. This way the search radius need only reach halfway to the full
extent of the motion in the sequence.

If the motion tracker is used on a render farm, Save coords and previous frame
mode will not work. The results of the save coords operation are saved to the hard
drives on the render nodes, not the master node. Future rendering operations on
these nodes will process different frames and read the wrong coordinates from
the node filesystems. The fact that render nodes only visualize a portion of the
timeline also prevents previous frame from working since it depends on calculating
an absolute motion vector starting on frame 0.

2 pass motion tracking

The method described above is two-pass motion tracking. One pass is used just to
calculate the motion vectors. A second pass is used to apply the motion vectors to
the footage. This is faster than a single pass because errors in the motion vector
calculation can be discovered quickly. This also allows the motion tracking to
use a less demanding colormodel like RGB888 in the scanning step and a more
demanding colormodel like RGB Float in the action step. The scanning step takes
much longer than action. This has the disadvantage of not being practical for
extremely long sequences where some error is acceptable and the picture quality
is low to begin with, like stabilizing camcorder footage.

The slower method is to calculate the motion vectors and apply them simultane-
ously. This method can use one track as the motion vector calculation track and
another track as the target track for motion vector actions. This is useful for long
sequences where some error is acceptable.
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Pre-processing the shot

1. The motion plugin uses luminance to do its own calculations, so we can edit
the clip to enhance contrast and make it easier to calculate motion vectors.
You can even create a copy of the monochrome clip and optimize it for the
plugin. It lengthens the time but minimizes errors. The saved file can then
be used for the original clip.

2. Correct lens distortion, especially if the object to be tracked moves to the
edges of the frame.

3. Study the entire shot well: if necessary, divide it into many edits, each with its
own Motion plugin. For example, if the object to be tracked leaves the frame
or is covered by some other element or changes in shape, size or rotation.
You can try to use the Offset Tracking technique described below.

Using blur to improve motion tracking

With extremely noisy or interlaced footage, applying a blur effect before the mo-
tion tracking can improve accuracy. Either save the motion vectors in a tracking
pass and disable the blur for the action pass or apply the blur just to the master
layer. You can even use a copy of the track formed only by the channels of Red +
Green, because the channel of Blue is the noisiest. Another trick is to enlarge the
Match Box to minimize the effect of noise.

Using histogram to improve motion tracking

A histogram is almost always applied before motion tracking to clamp out noise
in the darker pixels. Either save the motion vectors in a tracking pass and disable
the histogram for the action pass or apply the histogram just to the master layer.
Finally, you can use the histogram to increase contrast.

Possible sources of errors

Search radius too small: the traced object moves too fast with respect to the size
of the search box set.

Search radius too large: The search box is so large that it also collects other sim-
ilar items in the frame.

Occlusions: the traced object is temporarily hidden by some other element. Offset
tracking or splitting of the video into several homogeneous clips is required.

Focus change: you may get errors if the object changes its focus. The video must
be divided into several homogeneous clips.

Motion Blur: blurs the object making the calculation of the motion vector less
precise. Very little can be done.
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Shape change: you can use Track previous frame or the subdivision of the video
in more homogeneous clips.

Lighting change: Contrast change can produce errors. Track previous frame or
color correction can be used to return to the initial illumination.

Tracking stabilization in action

This is an explanation of how to stabilize a video as in the case of a video taken
from a vehicle.

First select on the timeline the part of the footage you want to stabilize, using the
in and out points. Then apply the motion effect on that part of the video. Select
the Previous frame same block option. That option is recommended for stabilizing
jerky camcorder footage. Its goal is not to follow an object. The block stays exactly
at the same place during all the effect length.

Enlarge the block and select almost half the size of the video. Select the Stabilize
subpixel option as it will give a finer stabilization. Reduce the Maximum absolute
offset value to limit the stabilization amplitude. You probably prefer to get a non-
perfect stabilization on some places on the video rather than having a very large
black border on one side of the picture during big shakes. Set the Translation
search steps value to 128. Increasing that value will not give a better result and
only considerably increases the rendering time. Make sure the Draw vectors option
is selected, and render the part of the video where the motion effect is applied.

If the result is good, deselect the Draw vectors option so that the block and vectors
are not drawn anymore on the video. Then, render your video to a .dv file, and
import it into your project. You will notice the video is stabilized but there are
black borders which appear on sides of the frame. You have to zoom in and define
projector keyframes to move the projector around the screen, in order to remove
those black borders. The more your footage is jerky, the more you have to zoom
in to discard the black borders. That is why the result is better with HDV footage
than with DV footage.

An interesting side note about add offset usage is explained next8

To stabilize video, the motion plugin uses a tracking frame to which to track to and
a region within that frame to track (generally an object in the background) in the
current frame. When the region is obscured, often by something in the foreground
or by leaving the screen, then the motion compensation would fail, and the video
jumps all over the place.

8credit Pierre Marc Dumuid
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You set a second region to track, and then add offset.

This shows how it is used. It works very well:

------k-------k-----------------
^ ^^
A BC

A - object1 is visible in the background up until C
B - (the frame before C) has both object1 and object2 visible
C - has only object2 visible

1. Make a keyframe and set to track object1.

2. Make a keyframe at C and track frame at B, set to track object2.

3. Set keyframe at C to add offsets that were calculated at B.

Tips

1. The motion vector is a text file located in /tmp. We can open it with a plain
editor and modify the wrong X Y coordinates, i.e. those that deviate from the
linearity, to correct the errors that always happen when we perform a motion
tracking (jumps). It can be a long and tedious job, but it leads to good results.

2. You can try tracking using reverse playback of the track. Sometimes it may
lead to a better calculation.

9.9.50 Motion 2 Point

Motion stabilization using 2 pass tracking. For theory and explanations refer to
the Motion plugin.

9.9.51 Motion Blur

Uses X/Y camera automation vectors to apply a linear blur trailing camera direc-
tion due to movement.

Length distance between original image and final blur step; corresponds to the
distance of the fields.

Steps number of blur steps to be used in the calculation. Increasing the number
takes more CPU.
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9.9.52 MotionCV

Motion tracking/stabilization from the community version of CINELERRA-GG. For
theory and explanations refer to the Motion plugin.

9.9.53 MotionHV

Updated motion tracking/stabilization of 2017 from the original author of CINELERRA-
GG. For theory and explanations refer to the Motion plugin.

9.9.54 Oil painting

This effect makes video tracks appears as a painting. It can be controlled by Radius
slider and intensity of colors can be chosen as an option.

9.9.55 Overlay

This effect can combine several tracks by using the so called Overlayer. This is a
basic internal device normally used by CINELERRA-GG INFINITY to create the dis-
solve transitions and for compositing the final output of every track onto the output
bitmap. The Overlayer has the ability to combine one or several image layers on
top of a bottom layer. It can do this combining of images in several different (and
switchable) output modes such as Normal, Additive, Subtractive, Multiply (Filter),
Divide, Max and Replace. For a detailed list refer to the on Overlays chapter –
PorterDuff.

The overlay plugin enables the use of this Overlayer device in the middle of any
plugin stack, opening endless filtering and processing possibilities. It is only useful
as a shared plugin (i.e. a multitrack plugin). To use the overlay plugin:

1. Add the effect to Track A.

2. Choose attach effect from the context menu of another track (Track B).

3. Choose Track A: Overlay as a shared plugin.

4. Manipulate the plugin parameters in Track A.

9.9.56 Perspective

The perspective plugin (aka Corner Pinning) allows you to change the perspective
of an object and is used to make objects appear as if they are fading into the
distance. Basically, you can get a different view. A transformation is used which
preserves points, lines, and planes as well as ratios of distances between points
lying on a straight line.

295



9.9. Video Effects — Native

In (figure 9.52) you can see that there are four options for the endpoints used for
the edges.

Figure 9.52: perspective control window

Default if OpenGL is being used with your graphics card, this will be the option
in effect. If no OpenGL, then it will be Cubic.

Nearest using software, nearest neighbor can look step-py.

Linear software implementation of a linear algorithm.

Cubic smoothest looking on the edges and considered the best.

Key Presses for using the Perspective plugin:

Left mouse button drags the corner that is closest to current location
Alt key + left mouse translates the perspective; drags the whole image
Shift key + left mouse zooms the perspective
Alt+Shift + left mouse translates view but does not change output

Note that the red color lines in the box show the composer boundary.
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In order to see endpoints that go off the screen, you can use the zoom slider which
changes only the zoom view and does nothing else. The slider uses a logarithmic
scale ranging from 1

100 to100.

Figure 9.53 show the results of the 4 different smoothing options.

Figure 9.53: Clockwise: Nearest; Linear; OpenGL and Cubic

9.9.57 Polar

The Polar effect bends and warps your video in weird ways. Mathematically, it
converts your video from either polar coordinates to rectangular coordinates, or the
reverse. With the Clear buttons we can bring the slider to default values without
affecting the other parameters.

9.9.58 RGB-601

For analog video or MPEG (including DVD) output, the maximum range for R,G,B
is [16,235] (8 bi t). For YUV, the maximum range for intensity (Y) is [16, 235]
(8 bi t). This range corresponds to gray levels from 6% to 92%. When rendering,
values outside of these ranges will be clipped to these limits.

To render to MPEG, add the RGB-601 effect to all video tracks where material uses
the full intensity scale (0− 100%), and enable RGB→601 compression. Consider
adding the Videoscope effect after RGB-601 to see how RGB-601 affects your dy-
namic range. To preview how your rendered MPEG would look without RGB→601

297



9.9. Video Effects — Native

compression, instead enable 601→RGB expansion and you will observe a notice-
able contrast increase. Although RGB-601 will reduce contrast in your video
tracks, the contrast will be restored during MPEG playback.

9.9.59 RGBShift

Most cameras take the light coming into the lens, and convert that into 3 sets of
numbers, one for Red (R), one for Green (G), and one for Blue (B). Some of the
older cameras were composed of 3 sensors and originally the RGB sensors were
on 3 separate planes and had to be aligned. If they were misaligned in the video,
you can use RGBShift to get them realigned. To move a specific color up/down,
modify the dy value using the slider bar in the RGBShift window. To move a color
left/right, modify the corresponding dx value. Clear buttons are present to reset
its slider to default without affecting others. Note that the current values of the
RGBShift are maintained in the .bcast5 defaults file and will be retained across
sessions. If using the YUV color space, you will want to use YUVShift instead.
Figure 9.54 showing RGB shift before and after.

Figure 9.54: Bad Misaligned color and after color aligned

9.9.60 Radial Blur

Radial blur is a Bokeh effect that creates a whirlpool which simulates a swirling
camera. You can vary the location, type, and quality of the blur.

X,Y center of the circle of movement.

298



9.9. Video Effects — Native

Angle angle of motion in one direction.

Steps number of blur steps to be used in the calculation; increasing this number
uses more CPU.

Clear to reset its slider to default without affecting others.

Figure 9.55 has the parameters: Angle = −35 and Steps = 2.

Figure 9.55: For clarity of presentation only 2 fields are shown

9.9.61 ReframeRT

ReframeRT changes the number of frames in a sequence of video directly from the
timeline. The faster method for getting the same results as this plugin is to use
the speed curve which was a later addition. But if you need very precise results,
ReframeRT is most useful. There are two ways to do this, which can be selected
from the checkboxes in the configuration GUI. The first Stretch mode changes the
number of frames in the sequence, and therefore its length, but not the framerate.
The Downsample mode instead keeps the length of the movie by varying the fram-
erate. It is important to understand that the plugin works by varying the frames,
the possible change of fps is only a side effect of the creation of new frames due to
interpolation.

Stretch

Stretch mode multiplies the current frame number of its output by the scale factor
to arrive at the frame to read from its input. The scaling factor is not entered
directly but using a number of input frames to be divided by the number of output
frames.

Scale factor = Input frames / Output frames
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1
8
⇒ scale f actor = 0.125 (slowmotion)

That is, one input frame of the original movie corresponds to 8 new output frames
originated by interpolation. It is the opposite with regard to fast play.

The stretch mode has the effect of changing the length of output video by the
inverse of the scale factor. If the scale factor is greater than 1, the output will end
before the end of the sequence on the timeline. If it is less than 1, the output will
end after the end of the sequence on the timeline. The ReframeRT effect must be
lengthened to the necessary length to accommodate the scale factor. Change the
length of the effect by clicking on the endpoint of the effect and dragging.

Although stretch mode changes the number of the frames read from its input, it
does not change the framerate of the input. Effects before ReframeRT assume the
same frame rate as ReframeRT. In stretch mode to create a fast play effect enter
a value greater than 1 to get accelerated playback. For a slow motion effect, use
ReframeRT in stretch mode with a value less than 1.

Example: you have a clip that you want to put in slow motion. The clip starts
at 33.792 seconds and ends at 39.765. The clip is 5.973 seconds long. You want
to play it at 4

10
ths

normal speed. You divide the clip length by the playback speed
(5.973÷0.4) to get a final clip length of 14.9325 seconds. You create an in point at
the start of your clip: 33.792 seconds. You put an out point 14.9325 seconds later,
at 48.7245 seconds (33.792+ 14.9325). You attach a ReframeRT effect, set it to
0.4 and stretch. You change the out point at 48.7245 to an in point. You start your
next clip after the slow motion effect at the 48.7245 out point. You can do this
without making any calculations by first applying the effect and then lengthening
or shortening the bar to where the stretched movie ends.

Downsample

Downsample mode does not change the length of the output sequence. It mul-
tiplies the frame rate of the output by the scale factor to arrive at a frame rate
to read the input. This has the effect of replicating the input frames so that they
only change at the scaled frame rate when sent to the output. It does not change
the length of the sequence. If the scale factor is 0.5 and the output frame rate
is 30 f ps, only 15 frames will be shown per second and the input will be read
at 15 f ps. Downsample is only useful for scalefactors below 1, hence the name
downsample.

Downsample mode changes the frame rate of the input as well as the number of
the frame to read, so effects before ReframeRT see the f ramerate× scale f actor
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as their frame rate. If the scale factor is 2 and the output frame rate is 30, the
input frame rate will be 60 and the input frame number will by doubled. This will
not normally do anything, but some input effects may behave differently at the
higher frame rate.

Other important points

• ReframeRT uses the fps indicated in Settings→ Format→ fps project and
not the fps of the assets.

• It can be associated with Nested Clips.

• As an alternative to ReframeRT you can use the speed curve, or change the
framerate in Resources→ info and in the Project.

• It is keyframmable.

9.9.62 Reroute

The Reroute plugin enables you to selectively transfer the Alpha channel or the
Components (RGB or YUV) or both from a source track to a target track, partially
overwriting the target’s contents. It works as a shared plugin. The typical usage
scenario is to build up a possibly animated Mask in one track and then to transfer
the Alpha channel to another content track.

9.9.63 Reverse video

Media can be reversed on the timeline in realtime. This is not to be confused with
using the reverse playback on the transport panel. The reverse effects reverse
the region covered by the effect regardless of the transport direction. The region
to be reversed is first determined by what part of the track the effect is under and
second by the locations of keyframes in the effect. The reverse effects have an
enabled option which allows you to set keyframes. This allows many possibilities.

Every enabled keyframe is treated as the start of a new reversed region and the
end of a previous reversed region. Several enabled keyframes in succession yield
several regions reversed independent of each other. An enabled keyframe followed
by a disabled keyframe yields one reversed region followed by a forward region.

9.9.64 Rotate

The Rotate filter can rotate the video in 90 degree increments or by any number
of degrees through use of the wheel and about any pivot point. It can also reverse
and flip the video.
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9.9.65 Rumbler

The Rumbler plugin can be used to create dream-like or earthquake-like noise in
the video. It creates noise by jiggling the corners through use of perspective trans-
formation at the corners. The algorithm used is:

Rumbler (value) = (value at t ime) + ampli tude× (random generator)

The random generator varies from −0.5 to 0.5. The rumble perturbs the normal
values at time points which occur rate times a second. The values used between
the rumble points are interpolated, so that the value jiggles rate times a second,
by as much as the rumble amplitude. The time unit is frames per second. The
corners are in units of percent width/height (figure 9.56).

Figure 9.56: Rumbler control window

Screencast shows:

Time jittering - 20 f ps 1 time a second. Corners jittering - 25% 5 times a second.
Using random seed 0 for a rumble sequence.

Plugin variables:

Rumbler: gain applied to random rumbler.

Rate: number of times per second.

Time: number of frames per rate times a second; if 0 has no effect on results.

Space: corners jiggling in percentage per rate times a second; if 0 has no effect
on results.

Seq: is a random seed number; any reasonable positive or negative number you
choose.
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9.9.66 SVG via Inkscape

This plugin allows the user to manipulate an SVG (scalable vector graphics) image
with Inkscape without having to leave the program. The associated CINELERRA-
GG window provides the ability to change the DPI, the Out x/y coordinates, and
the Out w/h values. For more information on use of inkscape, refer to: https:
//inkscape.org/develop/about-svg/

DPI is Dots per inch and it represents the resolution of the SVG image. Since
the image is scaled with interpolation mode linear, the edges will look blurry
when the input resolution is lower than the output resolution. You can either
set the desired DPI value in the window or use the tumbler on the integer text
box, then use the update dpi button to have the change take effect. Changing
DPI causes the entire image to be re-exported via inkscape. DPI changes
cause adjustments in the resolution, speed of re-import, and storage needed
for the image data.

Out_x/Out_y allow for changing the location of the SVG via the x or y coordi-
nates.

Out_w/Out_h The scaling is controlled by width and height as they are normal
parameters to overlay.

Figure 9.57 shows the menu options plugin window and the SVG image in the
Inkscape window.

Figure 9.57: Control window and Inkscape

9.9.67 Scale

Reduce or expand the image size depending on the ratio.

Size Height and Width in pixel; plus pulldown menu with preset.

Scale Aspect ratio

Constrain ratio Lock height to width rate
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9.9.68 Scale Ratio

With the Scale Ratio plugin you can manipulate your video to maintain the pixel
aspect ratio (proportional geometry), possibly for a different output Display device
(figure 9.58).

Figure 9.58: Many parameters of scale ratio

In R and Out R representing the current input and output aspect ratios. Use the
arrows to change to your desired values. Next you have the In W/H and the Out
W/H for Width and Height. In the middle of the plugin on the right-hand side, you
can set the Scale type of None, Scaled, Cropped, Filled, Horiz edge and Vert edge.
The top part (aspect ratio data) is used to compute the bottom part when the
Apply button is pressed. The bottom part allows you to reposition the image input
or output to customize the results. When the in/out aspect ratios are different,
the output must be cropped or filled to fit the output and maintain pixel square
appearance. Left and right sides of the bottom portion show the Source and the
Destination X, Y, W, H values. As you change the values on the left side, you can see
how this will affect the output as you observe the results in the compositor window.
For example, as you change the values for SrcY in a cropped Scale scenario, you
see up/down movement.

9.9.69 Selective Temporal Averaging

This plugin is designed to smooth out non-moving areas of a video clip (figure 9.59).

Denoise is generally done on a spatial basis, mediating the values of a group of
adjacent pixels to achieve greater uniformity. The effectiveness of Denoise can
be increased by also introducing a time average between a group of successive
frames. The union of these two phases is the basis of the plugin. In fact the
smoothing is performed by averaging the color component for each pixel across a
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number of frames. The smoothed value is used if both the standard deviation and
the difference between the current component value and the average component
value are below a threshold. The standard deviation is a mathematical index used
to estimate the variance of a group of pixels: at high values corresponds more
variation of the pixels and therefore more noise.

Figure 9.59: STA control window

The Selective Temporal Averaging plugin plays
on the homogenization of the values of a group
of pixels in a group of frames, based on a
threshold below which the original values are
left and above which the average is performed
and then the noise reduction.

The average and standard deviation are cal-
culated for each of the components of the
video. The type of components averaged is
determined by the color model of the entire
project. The average and standard deviation
of the frames can be examined by selecting the
specific radio button in the plugin options win-
dow. The region over which the frames are av-
eraged is determined by either a fixed offset or
a restart marker system. In a restart marker
system, certain keyframes are marked as be-
ginning of sections. Then for each section, the
frames surrounding the current frame are used
as the frames to average over, except when ap-
proaching the beginning and end of a section, where the averaging is performed
over the N beginning or ending frames respectively.

An example of common usage is to select the number of frames you wish to aver-
age.

1. Enter a reasonable number of frames to average (for example, 10).

2. Select the Selective Temporal Averaging method and enter 1 and 10 for all the
Av. Thres. and S.D. Thres. respectively. This basically causes all pixels to use
the average value.

3. Turn the mask for the first component on. This should make the whole frame
have a solid color of that specific component.

4. Slowly reduce the S.D. Thres. value. As you do so, you will notice that the
regions vastly different from the average will have a flipped mask state. Con-
tinue to reduce the threshold until you reach the point at which non-moving
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regions of the video have a flipped masked state. This value is known as
the noise-floor and is the level of natural noise generated by the CCD in the
camera.

5. Repeat the same procedure for the Av. Thres.

6. Turn off the mask.

7. Repeat this for all channels.

9.9.70 Sharpen

Sharpen the video, either the luminance, horizontal, or interlace. With the Clear
buttons we can bring the slider to default values without affecting the other pa-
rameters.

9.9.71 Shift Interlace

Shift the interlace lines using odd or even. With the Clear buttons we can bring the
slider to default values without affecting the other parameters.

9.9.72 Sketcher

Now you can sketch lines, curves or shapes, on your video in different colors using
various pen widths and pen type with the sketcher plugin. You can even fill
them. You can do rotations and scaling and apply two anti-aliasing modes; single
and double. Getting started is fairly easy – simply hold down the shift key while
using the left mouse button to create a bunch of points in the compositor window.
However, to do more than that you will need to understand the buttons and options
or you may end up with unexpected results.

(figure 9.60) shows the Sketcher gui and the sketch lines/curves created in the
Compositor.

In the screencast, note the Sketcher window gui Curve top section and the Point
bottom section. The pink circle sketch is id #1 in the curve section. Since id #2 is
highlighted in the Curve section, the X/Y coordinates in the Point section below
show the points used to create the blue shape. Point 6 is selected so we see a
red crosshair (Drag point) inside the rectangle. The yellow arrow on the image is
id #3 curve. Finally the cursor shows Double anti-aliasing.

Some basic rules

Uncheck Drag before rendering; if you do not uncheck, the drag points will show in
your output. Drag must be checked on to edit the data. Drag must be checked off
to use Click to play. If the drag button flickers when clicked then another window
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Figure 9.60: Sketcher control window and sketch on Compositor

has drag focus. Un-focus it first. Turn drag off to see what the sketcher figure will
look like when rendered.

Curves can be any number of points or just a single point. You must create a
new curve if you want a new string of points not connected to the current curve.
Highlight the curve id # for a specific curve to modify its values. Left mouse click
or right mouse click on an existing point on the highlighted line/curve id # will
automatically highlight the selected point in the Point section of the gui and turn
red in the image. We can drag this point to the desired position using CTRL +
LMB; or we can translate the entire selected curve using CTRL + RMB.

With the mouse wheel we can rotate our curves; the center of rotation is given
by the position of the cursor. Normally the scroll is slow to be more precise. If
you make a fast scroll you have an acceleration that allows you to make complete
rotations in a short time. Using the mouse wheel with the SHIFT key we can
instead scale the size of the curve; the fixed scaling point is still given by the
mouse position.

There will always be 1 empty curve automatically defined when you start or even
reset. You can not delete the empty default curve but you can use it for a curve.

LMB click almost anywhere on the compositor screen will automatically show, in
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the currently highlighted curve, the closest point by turning it red.

There is no undo recorded between gui updates. It is recommended that you use
the option "b" to save a backup if you get to a place where you want to make sure
you do not lose your sketch.

Table 9.1: Sketcher controls

Compositor: Mouse usage Compositor: Action Plugin GUI

shift+left mouse button create a new line point New button in Point (line)

shift+right mouse button create a new arc (curve) point New button in Point (curve)

left mouse button select a single line point Click point listbox item

right mouse button
select a single arc (curve)
point

Click curve listbox item

ctrl+left mouse button drag point

ctrl+right mouse button drag curve

alt+left mouse button drag all of the curves together

alt+right mouse button create a new curve
New button in Curve sec-
tion

ctrl+shift+left mouse button create a new fill point New button in Point (fill)

ctrl+shift+right mouse button create a new off point New button in Point (off)

Wheel mouse rotate curve

Wheel mouse + shift scale curve

delete key deletes highlighted points Del button in Point section

delete key+shift deletes highlighted curves Del button in Curve section

Other Button and Label Descriptions

Anti-Aliasing You can set Off; On or Double. Default is On.

Color refers to the current curve pen color. Click on the Color rectangle to bring
up the Color window to change any of the color values, including alpha.

Drag check to create curves and to be able to see any Off type curves. Uncheck
for render/viewing.
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Reset – in the Curve section, all of the curve lines will be deleted except for an
empty default curve; – in the Point section, all points for the highlighted curve
in the Curve section will be deleted.

Width integer width of line; width of 1 is the default; width of 0 is the smallest
size of 1 pixel.

ID is the label number of the curve or point.

Pen value can be set with the pulldown to box (a square), +, /, x or off. The
default is x.

Alpha alpha value as set in the Color window. Default is 1 which is totally opaque.

Arc Type value can be set with this pulldown, which is to the right of the Drag
checkbox, to either off, line, curve, or fill. Off is the default. If the line type is
off when you uncheck drag, you will no longer see the line/curve. Fill spec-
ifies a point be inside the region to be filled with the chosen color. Multiple
fill points can be used within a single curve.

Up moves the highlighted Curve or Point Up in the stacking order. Multiple points,
but not multiple curves, can be highlighted and moved.

Dn moves the highlighted Curve or Point(s) down in the stacking order.

X is the point’s X coordinate.

Y is the point’s Y coordinate.

ID number detailed information

Points and curves are identified by numeric ids, and not the table position. This
is so that deleting and inserting points/curves does not shift the interpretation
of which points are associated for interpolation. For purposes of this discussion,
prev refers to previous. The prev keyframe constitutes the draw list of curves and
points. The prev ids are used to access the next keyframe interpolation input data.
When next exists for prev.id the interpolation functions apply. When next does not
exist, prev is returned for the interpolation value. The keyframes may be any id
sequence; both the prev and next keyframe id sequences are arbitrary non-unique
sets. This means that if an id is specified redundantly, it causes a redundant draw
when it is the prev keyframe, and only the last item with the id in the next keyframe
is used for interpolation.

Fill detailed information

The fill point is a marker point, and not really part of the curve. That point identi-
fies the inside of the loop. It can also be used to identify the outside of the loop in
order to fill that. The loop is created by drawing a line from the last point to the
first point in the curve. The line of this last segment is from the last point of the
curve. If there are isolated loops in the curve (it is self intersecting) then you will
be able to use multiple fill points to fill these regions.
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9.9.73 Sphere Cam

Converts multiple fisheye images into a panoramic projection.

9.9.74 Swap Frames

Swap the position of two consecutive frames. There are two modes of exchange:

swap: 0-1, 2-3, 4-5. . . or swap: 1-2, 3-4, 5-6. . .

9.9.75 Swap channels

Swap R G, B, Alpha with another color channel.

9.9.76 Threshold

Threshold converts the image to pure luminance, and replaces pixels with one of
three colors based on the luminance. Pixels with luminance values in the low
range are replaced with black, pixels in the middle range are replaced with white,
and pixels in the high range are replaced with black. Color and alpha (trans-
parency) for each range are configurable with the buttons and interpolate accord-
ing to keyframes.

The threshold window shows a histogram of luminance values for the current
frame. Click dragging inside the histogram creates a range (blue) to convert to
white. SHIFT-clicking extends one border of this range. Values for the threshold
range can also be specified in the text boxes.

This effect is basically a primitive luminance key to produce a matte. A second
track above the track with the threshold effect can be multiplied, resulting in only
the parts of the second track within the threshold being displayed.

9.9.77 Time average

Time average is one effect which has many uses besides creating trail patterns of
moving objects (figure 9.61). The main use is reducing noise in still images (or
in the motionless parts of a video). Merely point a video camera at a stationary
subject for 30 frames, capture the frames, and average them using time average
and you will have a high quality print. In floating point color models, time average
can increase the dynamic range of low quality cameras.

Inside the time average effect is an accumulation buffer and a divisor. A number
of frames are accumulated in the accumulation buffer and divided by the divisor
to get the average (for 10 accumulated frames the divisor is 10). Because the time
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average can consume large amounts of memory, it is best applied by first disabling
playback for the track, dropping the time average in it, configuring time average
for the desired number of frames, and re-enabling playback for the track.

Figure 9.61: GUI for Time Average

Frames count this determines the number of frames to be accumulated in the
accumulation buffer. Ranges from 1to1024 frames.

Accumulate this outputs the accumulation buffer without dividing it.

Average this causes the accumulation buffer to be divided before being output.
This results is the average of all the frames. The result is similar to Selective
Temporal Averaging, but not configurable.

Replace (Threshold, Border): causes the accumulation buffer to be replaced by
any pixels which are not transparent. In combination with motion tracking
it allows entire sequences to be combined to form panoramas.

Restart for every frames if an effect before the time average is adjusted the time
average normally does not reread the accumulation buffer to get the change.
This forces it to reread the accumulation buffer when other effects change.

Don’t buffer frames in order to represent the accumulation of only the specified
number of frames, the time average retains all the previous frames in memory
and subtracts them out as it plays forward. It would run out of memory if it
had to accumulate thousands of frames. By disabling subtraction the previous
frames are not stored in memory and only the average function is affected by
the frame count.
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9.9.78 Timefront

Space-temporal warping enables time to flow differently at different locations in
the video (figure 9.62). This plugin divides the frame into segments (bands) whose
type, position and size can be configured at will. Each segment will move with a
different speed from the others, greater than the band that precedes it and less
than the band that follows.

Figure 9.62: Temporal
bands for Timefront

Type allows you to choose a Linear or Radial segmenta-
tion; or to make it depend on the alpha channel or on
another track (with Shared Effect). In the case of Linear
you can choose the orientation of the strips (Angle); in
the case of Radial you can choose the coordinates (X,Y)
of the center. For a more precise adjustment we can
make the bands visible with the button Show Grayscale
(for tuning).

With Inner and Outer Radius we can position the begin-
ning and end of the bands in the frame (similar to the
Gradient plugin), so you can choose the spatial range
in which to apply the effect.

With Time Range we decide the size (and therefore the
number) of the bands.

Rate allows you to choose the type of algorithm to use when switching between
the start and end bands. You can reverse the direction with the Invers button. The
three modes are: Linear, Log or Quadratic (exponential). This is a warping frame-
work plugin based on this article: http://www.vision.huji.ac.il/videowarping/
HUJI-CSE-LTR-2005-10_etf-tr.pdf

9.9.79 Title

The Titler allows you to add text from within CINELERRA-GG. The titler has stan-
dard options for font, size, and style plus many options as described next (fig-
ure 9.63).

Justify justifies the text relative to the entire frame. Once justified, the X and
Y o f f set is applied. This allows text to be justified while at the same time
letting you push it within the title safe region.

Motion type scrolls the text in any of the four directions. When using this, the
text may disappear. Make sure the speed is set to a reasonably high value (for
example 150) and move the insertion point along the timeline until the text
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is far enough along the animation to reappear. The text scrolls on and scrolls
off. Setting loop causes the text to scroll completely off and repeat. Without
loop the text scrolls off and never reappears. The speed of the animation
is determined by speed in pixels per second. Set it higher to speed up the
animation.

Smooth with Chroma Key, a shadow may show; remove by enabling this to ad-
d/remove the shadow.

Drop shadow draws a black copy of the text to the bottom right of the original
text. This is useful when drawing text over changing video to keep the border
always visible.

Fade in/Fade out are a second type of animation. If the fade seconds are 0, no
fading is done.

Color and Outline allows you to pick the color for using to draw the text or its
outline.

Stamp timecode replaces text with the current position on the timeline in sec-
onds, frames or samples.

Figure 9.63: GUI of the Title plugin

To create special effects for your title you can place it on a dedicated track and
insert other realtime video effects just under the title effect and/or use camera
and projector. With keyframing you can animate your title and make it change
position, size, color, transparency, texture, or shape over time.

For improving playback performances of titles with effects, you can reduce the size
of the dedicated track. Right click on the track and select Resize track. . . Enter the
smallest resolution that still keeps the title visible.
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To include graphical elements like logos, you may want to import your title as a
PNG image (alpha channel transparency is possible), move it with camera and
projector or add effects.

Adding fonts to the titler

The X Window system originally did not have a suitable font renderer for video.
It also is restricted to the current bit depth. It does not have a convenient way to
know which fonts work with the suitable font renderer in the desired bit depth.
The easiest way we have found to support fonts in the titler is to have a directory
for them at /usr/lib/cinelerra/fonts.

The titler supports mainly TTF, true type fonts. It supports others but TTF are the
most reliable. To add true type fonts, copy the .TTF files to the fonts directory. In
that directory run

# /usr/lib/cinelerra/fonts
ttmkfdir && mv fonts.scale fonts.dir

and restart CINELERRA-GG. The new fonts should appear. The usage of ttmkfdir
changes frequently so this technique might not work.

If the video is displayed on a consumer TV, the outer border is going to be cropped
by 5% on each side. To avoid text which is too close to the edge looking bad, you
may want to enable the title-safe tool in the compositor window. The text should
not cross the inner rectangle.

Some recently added options

Drag initial default checkbox is off so that the Title plugin will work as it always
has.

Anchors When you turn on the Drag feature, nine different anchors/han-
dles will appear on compositor window. The middle anchor allows you
to drag your title wherever you want in the compositor window (X , Y
coordinates). The other 8 handles, drawn as arrows in each corner and
in the middle of each side, let you change the size of the drag area box
so that your title is within that area if it fits and as it is directed.

W/H the values in these 2 boxes specify the size of the drag area box mea-
sured in pixels as shown in the compositor window. You can set these
manually and if you can’t see the location of your box or find your han-
dles, set them to zero because 0 sets it to the same as the width/height
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of the media. The Drag effect ignores all boundaries, including the Ti-
tle Safe Region of the Compositor so that if you drag your titles off the
screen, it will look like they disappeared completely. Reset X and Y to
reasonable values to have it reappear. The Title text, background, and
pngs are applied on a single layer so that they will drag together as an
entity. All of the Title capabilities work in conjunction with dragging so
if you want to justify the title, you can still use the Left/Center/Right/-
Top/Mid/Bottom within the drag area. Be sure to turn off Drag when
rendering or the box will show in the video; keep in mind that drag bars
do not appear until there is some text in the text box and you can not
actually drag until the Title window controls are available.

Attributes in the Text box where you type your Title information, you can now
change several attributes to give you plenty of flexibility (figure 9.64). Each
of these special attributes begin with an open angle bracket< and ends with a
closing angle bracket>. Until the closing angle bracket is keyed in, the actual
characters you type, will be seen in the compositor window. In addition, if
you do not use the exact syntax or you keyin a filename that is not available,
all of the characters will continue to show up. This helps to see what needs
to be fixed or is missing. The attributes usage is described in the table below.

Figure 9.64: Pulldown Attributes

Table 9.2: Titler attributes

Attribute name Attribute value Notes

color
color name such as RED from
<cin_path>/guicast/colors.h

Or use the hex value like
#a000a0; color-hex.com shows
examples

font exact name from Font pulldow
When you set font, bold/size
and italic will be as currently set
up
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alpha
floating-point number between
0 and 1

0 is transparent; 1 is opaque

size
+ increases the size by 5

4 , - de-
creases 4

5 or use a number > 0
but less than 2048

Examples: <size +++>,
or <size -> or <size 14.5>
(floating-point ok)

png filename of a .png file
Example, add a logo. Full path-
name needed if not in current di-
rectory

bold 1 for on (default) or use 0 for off
Font used must have bold avail-
able

italic 1 for on (default) or use 0 for off
Font must have italic already set
up

blink
a number in seconds to flash on
and off; a negative number for
fade in and out

Can be a floating-point number;
<blink> with no value is like 1

ul
underline 1 for on (default), 0
for off

caps
1 for on, 0 for off, -1 for lower
case

If no value set, treated same as
1

sup

1 for superscript; 0 ends; -1 for
subscript; positive bumps up by
1
2 of font size; negative sinks by
1/2 of current size

Size of text will be 1
3 of font size;

example: 12<sup 1>10<sup
0>; <sup> with no values, acts
like 1

fixed
number of pixels between char-
acters; fixed with no value uses
3
4 current size

A fixed font is very useful for ta-
bles; /fixed reverts to previous
fixed size

nudge

x,y to move the text by that
amount; displacement is in
number of pixels. Can be
negative or positive

Example: <nudge
8,8>abc</nudge>

smooth
add anti-aliasing to smooth
jagged edges

Turn off smooth for chroma key

These attributes stay in effect until you change them or reset them. Additional cpu
time is needed for the blink attribute because it requires redrawing every frame and
for the background option described below. Note that some Title window controls
can not be set, such as Justify and Outline color. The lines below are examples
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for testing purposes. The accompanying screenshot displays the corresponding
CINELERRA-GG output.

Examples of Title line keyins:

Figure 9.65.

<size 15>Buddy, the <color red><bold 1>bad dog</bold><color white> ate my
,→ homework !<png /tmp/buddy.png><ul 1><size +>There are<ul 0><size
,→ +>2<sup 1>10<sup 0>cats <font Action man (misc)>to chase?

Figure 9.65: Final result of the exemple

Special Characters (< > / \#) Besides the previously described <, >, and /
characters, there are two special characters: backslash “\”, and the pound sign “#”.
The backslash character is used for two things. With the advent of the attribute
name and value, your line may become quite long so you can use “\” followed by
the carriage return to continue on the next line as if it is just a single line. It also can
be used to designate that the following character does not represent the beginning
of an attribute. For example, if you want to use the opening angle character “<“
as a title character, precede it with the backslash character. The pound sign, “#”,
designates the whole line as a comment or if in the middle of the line, then the
rest of the line is a comment (this includes the carriage return).

Background in this box you can keyin the name of a file of the type that CINELERRA-
GG accepts and use that file as a background for your Title characters. This
will be seen in the compositor window on top of the video that is loaded in
the main track canvas. Besides typing in the filename, you must also check
the checkbox. This makes it easy to turn it On and Off to see what it looks
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like. Next to the background box is a Loop checkbox. If the background file
takes less time than the main track canvas video to run, you can turn on the
loop checkbox so that it runs over and over again to match the time size of
your video.

Stroker to add pen strokes to the text letters, adjust the stroke width numerically.
This looks particularly nice on certain fonts and with a negative adjustment
of the Drop shadow.

Unicode Insertion if you want to enter a special character like the mathematical
summation symbol, you can use the unicode equivalent to do so. Press Ctrl-
Shift-U followed by 2022 and a carriage return is an example of the bullet.
Refer to section 17.5 for details.

Popup Helper put your cursor where you want to add an attribute, then right
mouse will bring up a list of the available attributes for you to choose, along
with a submenu to choose from. The program will insert that attribute for
you and all you have to add is a value when required! (see figure 9.64).

Color Picker Usage

The Text Color window has several enhanced features as listed here and seen in
figure 9.66.

1. The hex value of the color you choose shows in the textbox and you can also
keyin a value there.

2. A small square next to the hex text box, is a green eyedropper color picker.
Use the left mouse button to click on the square to enable picking and you
will see it turn red to designate that it is enabled. Your cursor will switch
to a two-colored reticle. You can now move the mouse around to choose a
color anywhere on the screen and then click there to have it picked. If you
hold down the right or left mouse button while moving, you can see the color
changing in the vertical bar in the color palette area as you move to give you a
bigger view of the actual color. The eyedropper square is seen in figure 9.66.

3. A history of 16 of your last chosen colors is available to easily use again. Any
time you choose a new color in any methodology, it will become the latest
choice in the history either immediately or after checking OK/and leaving.
History shows latest color starting left to right.

4. Besides HSV, RGB, there is also a YUV color model to choose from.

5. Several of these items may have associated Tool Tips.
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Figure 9.66: Screencast showing the Color Picker menu.

Font Choice

In order to choose a font faster, you can keyin the first few characters of the font
name, being sure to use capital characters if used since it is case-sensitive. The
steps to follow are:

1. next to the font box, click on the down arrow pulldown;

2. keyin the first character(s) of the desired font and you will see the first match
become highlighted;

3. you can see the characters you keyed in the upper right corner of the fonts.

Font Addition / Font Subtraction

Some of the system fonts are automatically included in the set of fonts being used
by CINELERRA-GG. The easiest way to add additional fonts for the Title plugin’s
set, is to use ones available in specific directories on your computer as long as
they have a fonts.scale file already set up. You can run mkfontscale to create
this file within that directory. In order to include a specific directory you set an
environment variable before starting CINELERRA-GG which stays in effect until it
is unset or until the next reboot. Below is the method and an example.

export BC_FONT_PATH=<colon-separated-search-path-for-fonts>
export BC_FONT_PATH=/usr/share/fonts

The current set of fonts in CINELERRA-GG’s directory will be automatically included
and will be the default set if this environment variable is not set. Keep in mind
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that if you add a lot of fonts, it will considerably slow down the startup every time
you bring up the Title plugin.

If you want to only have a limited number of fonts set up, you can manipulate the
CINELERRA-GG directory directly at <cinelerra_install_path> /bin/plugins/fonts.
Here you will find the default set of fonts that come with the install. Copy any other
fonts you would like to include here with read permission, delete any fonts you do
not want to have, then execute mkfontscale which creates the file fonts.scale
that CINELERRA-GG will read. However, the next time you install a new version of
CINELERRA-GG, your changes will be written over so you will have to make sure to
save them elsewhere and then re-establish.

If you have problems with a specific font or set of fonts, there is a debug option
available to determine which font is an issue. When starting CINELERRA-GG, you
should set up the variable:

export BC_FONT_DEBUG=1 (default is 0 for no debug)
unset BC_FONT_DEBUG (to remove debug messages)

Then start CINELERRA-GG from a terminal window to see the fonts being loaded
and previewed in the Titler. This should point out any issues. Another debug
methodology is to remove all fonts from being used and subsequently add in the
ones that you want. For example:

export BC_FONT_PATH=: #(the : "colon" removes all automatic system and Cinelerra fonts)
export BC_FONT_PATH=:/usr/share/fonts #(remove all fonts and then add /usr/shar/fonts

,→ )

One last item of information about fonts that may lead to some confusion. The
checkbox for Bold and Italic will occasionally be ghosted out if no bold or italic
version of the selected font is available. This is no guarantee, but currently as good
as it can get due to inconsistency in the creation of fonts. It is mostly just a hint.
If boxes are checkmarked, but ghosted, you can not uncheck until you change to a
font that does not ghost out the boxes. If you use the popup helper with the boxes
checked, and attempt to keyin a font that does not have the bold/italic attribute
as checked, the font will be considered illegal. Text: chars is output and updated
to indicate the number of characters already used. The only limit to the number
of characters based on a count of single 8 bi t characters is the available resources
on the user computer available for CINELERRA-GG use. Keep in mind that unicode
or other special characters may consist of 2 to 4 8 bi t bytes. Also, newlines are
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a character and any of the attributes you use count in the total. There is now a
horizontal scroll bar as well as the vertical one in the textbox and they only appear
when there are more lines or characters that can fit in the original sized textbox.

Kerning

When using the Titler, kerning is applied in order to allow parts of a letter to go
outside the standard sized letter box. Kerning is the process of adjusting the space
between individual letters. It is not the same as proportional spacing. In kerning,
a bounding box is allowed to overlay another bounding box. The philosophy here
is to aim at the ability to have boxes overlap in order to make the letters look
more visually appealing. Bounding box and escapement are tracked separately. In
addition to adjusting individual letter spacing, the program will also expand the
render box in order to have any parts of the letter extend outside the standard
letter box. Kerning is applied to any and all fonts (figure 9.67).

Figure 9.67: Kerning in action

9.9.80 Tracer

Tracer creates an outline around an object after a few points are designated, so it
traces the object. Its operates in a similar manner to that of Gimp’s magic wand.
You can then Fill the alpha channel with a mask, like with a gradient or another
object on another track or Invert that fill. Although it works best for still images
or objects that stay in the same place on a video like a logo, you can also add
keyframes. To limit the mis-tracking that occurs when working on a moving object,
we can increase the number of points so that the tracking is more accurate and
relies on a solid foundation. Rather than points as in a mask, tracer is based on
edges to form an outline (figure 9.68). Frequently it will be desirable to use either
RGB or YUV as the color model without the -A for Alpha.

New to create a new point.
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Figure 9.68: Gui for Tracer plugin

Up/Dn to move highlighted point up or down.

Del to delete the highlighted point.

X, Y are the point’s x/y coordinate.

Invert to change the mask to outside.

Feather to sort of blur the edges (inward and outward). Feather influences the
softness of the edge. The higher the number Feather is set to, the softer the
edges become.

Radius for varying the size a little. Radius extends the area further in or out to
cover more or less area.

Drag to enable or disable moving.

Draw to draw the outline for visual.

Fill to black out the object (no alpha); figure 9.69.

Mouse wheel rotate the outline, centered on cursor. Note that this rotates the
outline around the nearest point. The slower you scroll, the more precise the
the result. If you scroll faster, an accelerator kicks in that allows you to make
complete rotations more quickly.

Mouse wheel + shift scale the outline, centered on cursor.

Be sure to uncheck Draw and Drag before rendering so that the lines do not show
in the video output.
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Figure 9.69: Rug in the top picture is traced in order to black it out or replace later

9.9.81 Translate

This effect allows displacing, cropping, and/or scaling the source video horizon-
tally and/or vertically. The In and Out parameters operate similar to the camera
and projector functions in the Compositor:

In X/Y specifies how many pixels from the left/top of the source you want to start
(camera).

Out X/Y defines where on the screen you want the output to start (projector).

In W/H defines how many pixels of the source you want to include in each direc-
tion.

Out W/H defines how many pixels on the screen you want that source to take up.

Identical values for both In and Out that are less than the source dimension will
simply crop the source. Different values will stretch (or compress if Out > In) the
source in that direction (and crop if In is less than the source dimension).

This effect supports keyframes so these parameters can change smoothly over time.
You can use this effect for many things such as having a cropped insert clip move
across the screen, or have it change size or stretch while doing so. Be forewarned
though, that for interlaced footage horizontal displacements are likely to destroy
the field order, resulting in all sort of flickering and jumping movements.
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9.9.82 Unsharp

This effect applies a traditional darkroom technique, the so called unsharp mask
to every video frame. With different parameter values, this can be used to soften
or to sharpen the image. Its parameters are:

Amount moving the slider to the right makes dark areas get darker and light areas
get lighter.

Radius this slider controls how much blurring is used in the edge-finding stage.
The practical effect of this is to specify how large a region is darkened or
lightened.

Threshold this slider controls how big a difference between a pixel in the blurred
copy and the original copy is needed before any darkening or lightening will
be applied.

Clear to reset its slider to default without affecting others.

9.9.83 Videoscope

Videoscope summarizes intensity and color on a calibrated display. The Video-
scope can be used in conjunction with other CINELERRA-GG plugins such as Color
3 Way, YUV, Brightness, Color Balance or Histogram to accurately correct video
for contrast, clarity, conformance (to normalize various videos shot under differ-
ent light settings), or for cinematic purposes. The human eye is not specialized
to match precise level of light and color, but Videoscope is. Videoscope contains
three displays: the waveform scope and the vectorscope, plus the histograms (fig-
ure 9.70).

Figure 9.70: GUI of the Videoscope. You see Histogram, RGB Parade and Vectorscope
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Waveform/RGB Parade

The Waveform Scope displays image intensity (luminance) versus image X position.
The RGB Parade Scope displays image RGB intensity versus image X position (one
graph per channel). The Waveform Scope appears on the left side or in the middle
of the Videoscope window. The display is calibrated vertically from 0% intensity
(black) at the bottom up to 100% intensity (white) at the top. Each column of
pixels in the image corresponds to one column of pixels in the Waveform Scope
(figure 9.71). Note that the height of the values of a waveform/RGB Parade corre-
sponds exactly to the values on the x ax is in the histogram. A vertical/horizontal
correspondence is therefore obtained.

Figure 9.71: Colortest 75% with RGB Parade (left) and Waveform (right)

On the left is shown RGB Parade: instead of the color shadows as in figure 9.70,
we have lines representing the color bar test at 75%. They are pure colors, so all
pixels have the same value. In fact, they are all at the level of 75% except for the
100% white band and the 0% black band. In the waveform on the right, we have
the same behavior with regard to luminance: the white band is 100%; the black
band is 0% and all the others 75%.

The Waveform scope helps correct image light levels for contrast range or for con-
forming light levels on various scenes originally shot on different light settings
(figure 9.72).

Adjusting luminance

1. Add the Brightness/Contrast, Histogram, Color 3 Way or another video adjust-
ment effect on your track/edit.

2. Add the Videoscope effect on the track below. Make sure that it is placed
below so it can see the adjustment effect’s results. If it is not, right-click and
move it down.

3. Show both the effect and Videoscope.
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Figure 9.72: Example of waveform

4. Adjust the contrast while observing the waveform to match the desired light
level.

5. Precise adjustments can be made by measuring the values on the waveform
with the crosshair (by click with LMB, and reading numeric values on top
left of the window) and reporting these numbers in the effects window (His-
togram Bézier, for example).

For instance, if you are looking for maximum contrast range, adjust the Bright-
ness/Contrast levels to align the darkest point on the scope with the 0% level and
the brightest portion with 100%. Anything above 100% is over saturated. Limits
which may be highlighted with checkbox controls.

HDTV or sRGB (ITU-R BT.709)

The maximum pixel range for HDTV or sRGB is [0,255]. This range corresponds
with levels 0% and 100%.

MPEG or Analog video (ITU-R BT.601)

For analog video or MPEG (including DVD), the maximum range for RGB is [16, 235]
(8 bi t). For YUV, the maximum range for intensity (Y) is [16, 235] (8 bi t). This
range corresponds to gray levels from 6% to 92%. Reference RGB-601 plugin.

NTSC Television broadcast

If you are producing a video for NTSC television broadcast, keep the intensity
between 7.5% and 100%. The minimum black value which can be broadcast is
IRE 7.5% (indicated by the 7.5 level), and values below this level are no darker.

326



9.9. Video Effects — Native

Vectorscope

The Vectorscope displays hue (angle on the color wheel) and saturation (radius).
Each pixel in the source image is drawn as a point on the color wheel. The distance
from the center is the color saturation. Gray values are close to the center, and
high saturation values are near the perimeter (100%). In the center there is pure
white (0%). By clicking with the mouse on the color wheel appear radius and circle
whose values of hue and saturation are shown at the top left of the window, similar
to the values of X and luminance of the Waveform and RGB Parade (figure 9.73).

Vectorscope is used as monitor with other plugins to correct color, adjust image
tint, and apply other effects for cinematic effects, image correction, or to conform
images to look the same. For example, skin tones are found along an axis (+ I-line)
between yellow and red, and between 0 and 50% saturation values. The blue of
the sky is more or less along the opposite axis to that of the skin (- I-line), with a
much wider saturation range.

Figure 9.73: Balancing a yellow dominace tint

In figure 9.73, the top image is white balanced. Vectorscope shows many pixels
in the yellow region and few in the white region. To remove the yellow tint, the
Color Balance effect is used to first shift the vectorscope plot towards magenta
(Mg), and then towards blue (B) until the region previously near the center sur-
rounds the center. In the bottom image, yellow highlights have become white
highlights (green triangles). Note that the corresponding features in waveform
also appear whiter (green triangles). The Vectorscope can also be used to verify
that the video output will display properly on various monitors. Any points along
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the inner radius will be displayed as pure white and any points above the 100%
radius, will probably not be correctly displayed on the screen.

Histogram

You can also display the 4 histograms (master or RGB) on the left of the window.
(see figure 9.70).

9.9.84 Wave

The wave effect adds waves on the image. Amplitude, Phase, and Wavelength pa-
rameters can be adjusted. With the Clear buttons we can bring the slider to default
values without affecting the other parameters.

9.9.85 Whirl

Creates a whirl (spiral) of the video around the center. With the Clear buttons we
can bring the slider to default values without affecting the other parameters.

9.9.86 YUV

Modify the Y, U, V settings. With the Clear buttons we can bring the slider to
default values without affecting the other parameters.

9.9.87 YUV411

Modify the 411 yuv to look like 420 color space instead. If the edit to which the
effect is applied is not YUV type, a red warning message will appear.

9.9.88 YUVShift

This effect is used for YUV input video from older cameras using 3 sensors. It is
possible to have misalignment of the 3 sets of numbers: Y, which represents the lu-
minance or brightness component, and for U and V representing the chrominance
(color) components. If they were misaligned in the video, you can use YUVShift
to realign. To move a specific component up/down, modify the dy value using
the slider bar in the RGBShift window. To move a component left/right, modify
the corresponding dx value. With the Clear buttons we can bring the slider to de-
fault values without affecting the other parameters. If you are using an RGB color
space, you will want to use the RGBShift effect instead.

Figure 9.74 (top) shows the blue U component aligned too far to the left. And the
red V component is misaligned too far to the right. Note the U_dx current slider
bar set to 0 as shown by the yellow box value in the YUVShift plugin window. All
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components are currently at zero. A corrected video image is shown in the bottom.
Now the red and blue colors are correctly aligned. Note how U_dx is now at +20
and V_dx is now negative to realign the image.

Figure 9.74: Before and after YUVShift adjusting

9.9.89 Zoom Blur

Blurs the video from the center outwards, like the sun’s rays, and uses a zoom
effect.

X,Y center of the origin field.

Radius Zoom on the fields.

Steps number of blur steps to be used in the calculation. Increasing the number
takes more CPU.

Clear With the Clear buttons we can bring the slider to default values without
affecting the other parameters.

Figure 9.75 shows the parameters: Radius=21 and Steps=3.

9.10 CUDA plugins

Only for Nvidia GPU and Cuda SDK

9.10.1 Mandelbrot

Produce fractal figures (figure 9.76). Use case:
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Figure 9.75: For clarity of presentation only 3 fields are shown

1. add the Mandelbrot Cuda video effect to the timeline

2. you must enable Drag in the plugin popup menu

3. drag the mouse with the RMB down and you will see the fractal change

4. enable "Generate keyframes while tweaking" and move to another spot on
the timeline and RMB drag again

5. so now when you play the video from the beginning because you have keyframes,
the fractal will be animated between keyframes.

Figure 9.76: Mandelbrot Cuda plugin
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9.10.2 N_Body

Produce animated particles (figure 9.77).

Figure 9.77: N_Body Cuda plugin

9.11 OpenCV plugins

The Find Object plugin searches a Scene for an Object, and the Object can be over-
layed with a Replacement object. It requires the thirdparty OpenCV (Open Com-
puter Vision) library and you will have to do your own build. Also, be aware that
the two useful algorithms of Sift and Surf have been removed from versions of
OpenCV after version 4.

There are some potential pitfalls with using this to include:

1. openCV code is constantly changing, making it difficult to keep the plugin up
to date

2. there is some confusion about licensing/patents for specific algorithms

3. some parts don’t work all that well and it can be slow

4. internally the colormodel is converted to greyscale, which means the color
information is not used

Because of the build size of opencv, it is not normally included in the thirdparty di-
rectory. Building opencv adds a lot of storage demand (4 GB) to the CINELERRA-GG
build tree, and the opencv compile time is significant. For these reasons, findobject
is not normally built. You can however invoke a build which adds findobject to the
CINELERRA-GG plugin library. Building findobject will configure and build opencv
into the thirdparty library build area if needed (it does not rebuild if already done).
System builds are possible, but the system compatibility of the newer opencv in-
terfaces can vary between distros. The opencv interface is rapidly changing; we
recommend the static library build and link to avoid problems.
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9.11.1 How to Build OpenCV Plugins

To build findobject and the other plugins using opencv, access the src using git:

git clone -depth 1 "git://git.cinelerra-gg.org/goodguy/cinelerra.git" cinelerra5

then configure the build, but add the --with-opencv configure parameter.

cd <path>/cinelerra-5.1
./autogen.sh
./configure <add std params, eg: --with-single-user> --with-findobect=sta
--with-opencv may be set to [<bld>][,<src>]
bld=typ sta,dyn,sys: sta=static, dyn=shared, sys=system libraries
src=typ git,tar,git=url,tar=url: git (default git_url), tar (default: tar_url)

# For example, like:
--with-opencv=sta
--with-opencv=dyn
--with-opencv=sta,tar=https://cinelerra-gg.org/download/opencv/opencv-20180401.

,→ tgz

Once thirdparty/opencv is built, it will be reused. Use target mrclean to remove
thirdparty/opencv*. Network access is required to obtain the OpenCV source,
at least once. You will need a minimum of 4 GB in the thirdparty build directory
and more time to compile.

To get opencv built in the easiest way possible (need internet access because builds
directly from the opencv github but this changes wildly):

./configure <params> --with-opencv=sta,git

9.11.2 Using OpenCV Plugins from the Automatic Builds

The OpenCV plugins are built only in the 64-bit tarball builds, both static and
dynamic. However, due to size these plugins are not included with pkgs. But it is
relatively easy to add the current 6 plugins for your distro via a simple procedure
of copying the plugins from the tarball to the cin5 install plugin path. They are:

cin/plugins/opencv/findobj.plugin
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cin/plugins/opencv/flowobj.plugin
cin/plugins/opencv/gaborobj.plugin
cin/plugins/opencv/moveobj.plugin
cin/plugins/opencv/puzzleobj.plugin
cin/plugins/opencv/stylizeobj.plugin

1. do your package install of the current build for your distro as usual;

2. look in https://cinelerra-gg.org/download/tars to see your distro name’s
static tar;

3. download the corresponding distro static tarball; for example for arch:

https://cinelerra-gg.org/download/tars/cinelerra-5.1-arch-{date}-x86_64-
static.txz

4. create a temporary directory on your computer;

5. cd that-directory;

6. tar -xf location-of-the-tarball-you-downloaded;

7. cp plugins/*obj.plugin <see below for your location>/. (note the
period on the end!)

8. Start CINELERRA-GG and look for the six plugins in Video Effects;

9. To reverse this, simply delete the six plugin files (eg.
rm /usr/lib*/cin*/*obj.plugin).

location for most User installs, this is:

<cinlib_path>/plugins/

Location for some System installs, this is:

/usr/lib/cin/plugins/ (most ubuntu distros)

/usr/lib64/cin/plugins/ (Leap distro)

9.11.3 Description of Find Object Plugin

As in the standard OpenCV FindObj program, there are 5 detector methods and 2
matcher methods which can be selected. They detect features and match them as a
rectangular projection. The matched region will be overlayed with a replacement
image if replace object is enabled. This is done using a variety of feature detectors
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and region matches. The match works by creating sets of Feature points. These
points are generated for both the source and reference object frames. Then the
two sets are matched for Homography (a regional similarity).

Matchers

FLANN Fast Library for Approximate Nearest Neighbors

BF (flann not selected) Brute Force

Detectors Algorithm

SIFT Scale-Invariant Feature Transform

SURF Speeded-Up Robust Features

ORB Oriented fast and Rotated Brief

AKAZE Accelerated Keypoint detector And descriptor Extractor

BRISK Binary Robust Invariant Scalable Keypoin

Don’t Calculate Do nothing

The CINELERRA-GG plugin has several additional features for ease of use and more
flexibility. A description of parameters is outlined below.

Mode: • Square
• Rhombus
• Rectangle
• Parallelogram
• Quadrilateral (default)

Reset: to get back to the default values.

Algorithm: detector selections as described above.

Replace object: checked if replacing the object is the desired outcome.

Use FLANN: use the Matcher, or if unchecked just use brute force.

Draw match: will display a blue line around the matching object only for the pur-
pose of verifying the placement. The starting point for the box is designated
by a white outlined circle in corner #1.

Scene/object/replace layer: number designating the attachment track of each
findobject plugin element.

After matching, the resulting projection corners are used to do reshaping. The
general procedure is:
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• Calculate centroid, translate center to 0, 0; check for bowties and rotation
direction.

• Calculate replacement object corners using mode, central angles, scale, and
aspect of the projection.

• Using the replacement, apply the inverse aspect, rotation, scaling, and trans-
lation as specified.

Selectable specifications

Aspect when set, the matching aspect ratio is applied, otherwise the original ob-
ject aspect is applied.

Scale when set, the match surface area is used for scaling, otherwise the original
surface area is used.

Rotate when set, the match orientation is used in the projection, otherwise the
original orientation is used (orthonormal).

Translate when set, the match replacement is centered to the projection center,
otherwise the original object center is used.

Once the replacement corners are calculated, the replacement object is overlayed
to the scene frame.

Scene/Object/Replace Drag only 1 can be checked on at a time (and that in-
cludes counting the Title plugin drag box). The Drag boxes are faster alter-
natives to using the column dials.

Scene/Object/Replace columns of X/Y/W/H x and y positions along with width
and height; 0÷ 100% + Replace ∆X and ∆Y deltas for the Replace column.

Draw keypoints when enabled shows the detection points created by the feature
detection and used in the matcher Algorithm calculation.

Draw scene/object/replace border displays each of the borders which helps to
determine correctness.

Object blend amount can dampen (smooth) the corner motion from frame to
frame to reduce jitters.

9.11.4 An example of how to use Find Object

The following steps were used to set up the example in figure 9.78.

1. For best results, set Play every frame in Settings → Preferences → Play-
back A.

2. Load 3 tracks of png/jpg files – this is one of the more useful working cases:
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• 1st track should be the scene; that is the output
• 2nd track is the object to find
• 3rd track is the replacement object

3. Drag the Find Object plugin onto track #1.

4. On each of other 2 tracks, click the right mouse button; choose attach effect,
highlight Find Object in the shared effect column, and click OK. All three tracks
should now have a findobj plugin effect bar. One, (probably the first one) is
the master plugin and the others are attached input tracks.

5. Check the plugin show icon on the master track to bring up the controls for
the FindObj plugin. You will see that Use FLANN is checked for using nearest
neighbors.

6. Set Output scene, Object, and Replacement object layers’ track number accord-
ingly (numbered from zero).

7. Check Draw scene border and you will see a white border in the compositor
window surrounding the whole image of the scene. This assumes default set-
tings for Scene center X,Y(at 50%), and area W,H (100%). Adjust these how-
ever you need to via the dials or more simply by checking Drag and dragging
any of the 9 drag points. As shown above this in the controls, units are in
0− 100%.

8. Turn off Play track in the patchbay on the first track so you can see track #2
in the compositor and then use the Object X,Y,W,H dials. You will see a blue-
dotted line which should then be adjusted to surround the desired object.
Since it can be a little tedious to use the dials, you will want to turn off the
previous Drag box of track #1 and check this instead to do your dragging
placement from drag points.

9. Turn off Play track in the patchbay on this track #2 so that track #3 is visible
and if necessary, adjust the dials/drag box in the same manner. The border
will have a pink-dotted line around it.

10. Turn back on all of the desired Play tracks in the patchbays.

11. Set the detector choice (should have Don’t calculate set initially), for example
use SIFT.

12. Turn off all of the Draw borders and whichever Drag box that may still be
checked.

13. Check Replace object to see the replacement overlay. At this time you may
still want to change the checkboxes of Aspect, Rotate, Scale, and Translate
and adjust DX/DY in the Replace column.

9.11.5 MoveObj, FlowObj, GaborObj, StylizeObj, PuzzleObj

MoveObj plugin moves an object and stabilizes it.

336



9.11. OpenCV plugins

Figure 9.78: Timeline; control window and compositor for FindObj

FlowObj plugin retards image motion as shown with optical flow. You can turn
on/off draw vectors.

GaborObj creates an interesting fractalius-like image effect using the Gabor filter.

PuzzleObj makes a puzzle out of an image. You can make the puzzle pieces smaller
or larger with the Pixels slider bar. The Iterations slider bar allows for varying
morphing distance (figure 9.79).

The StylizeObj plugin can be used to create some interesting edge effects using
various options (figure 9.80).

We can apply 6 different styles:
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Figure 9.79: FlowObj; GaborObj (before and after) and PuzzleObj
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Figure 9.80: Pulldown of Stylize mode on the original image

Edge Smooth / Edge Recursive

There are two edge preserving methods available – one to smooth the image edges,
and the other to not smooth the edges/color boundaries, but instead replace the
color values at a pixel by the average of the pixels around the area which have
color similar to that pixel.

Detail Enhance

This option enhances the details of an image to make it look sharper.

Pencil Sketch / Color Sketch

Pencil like line drawings – either applied to a grayscale version of the images,
which can give you thin pencil to charcoal like results, or applied to the color
input image, which will look like a colored pencil drawing. For best results you can
vary the Smoothing (the size of the surrounding area), the Edges (how dissimilar
colors in the surroundings will be averaged; a larger value results in large regions
of constant color) and the shading (simple scaling of the output image intensity
with the higher the value, the brighter the result).

Stylization

Produces output that looks like the images were painted using water colors, which
often gives the impression of cartoon-like pictures. It abstracts regions of low
contrast while either preserving or enhancing features of high contrast.
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Figure 9.81 show the images after adding the 6 various styles.

Figure 9.81: Clockwise: Edge Smooth and Recursive; Detail Enhance; Stylization; Color and
Pencil Sketch

9.12 FFmpeg Audio and Video Plugins9

CINELERRA-GG INFINITY currently comes with more than 140 of the video plugins
and 55 of the audio plugins developed by the FFmpeg project www.ffmpeg.org.
These plugins do not have a GUI with buttons like the rest of plugins, therefore to
change settings it is necessary to change the variables by hand by highlighting the
option, typing a value in the Range box, and then hitting the Apply button. Many
of these plugins provide tooltips at the bottom right corner of the window when
the option is highlighted. A slider bar and a dial for numerical values can be used
to easily vary the values which take effect immediately.

Figure 9.82 shows what an FFmpeg video plugin looks like; example is F_chromakey.

9.12.1 FFmpeg Icons and how to Replace

Currently FFmpeg audio and video plugins that do not have a personalized icon
use one of the default icons as shown below.

9credit to WPfilmmaker for the Ffmpeg info description lines taken from his contributed pdf
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Figure 9.82: GUI for FFmpeg plugins

Default Audio Icon: Default Video Icon:

If you want to replace the icon with a more descriptive picture, see a previous
section on Updatable Icon Image Support and Details on where to put Plugin Icons.

9.12.2 How to Use FFmpeg Audio/Video Plugins

Simply drag and drop the plugin on the timeline. To enter the settings option,
once you have added the plugin to the timeline, right click on the colored bar
that appears below the timeline track of the plugin and highlight the show option.
Alternatively, you can left click the magnifying glass icon that appears on the right
side of the colored bar. For the audio plugins, if the plugin is not working at all,
you will hear a trouble tone waveform to indicate that. If the value is unspecified,
it uses default. If you specify the default, the value becomes unspecified which
means that nothing gets sent into the program.

Some of the ffmpeg plugins are not usable with CINELERRA-GG INFINITY due to in-
put/output requirements. Also, some do not come with legal initial supplied values
for the parameters (ffmpeg works on filtergraph, while CINELERRA-GG works on
stack). These plugins get tested at least once and if they crash, cause problems,
or are deemed unusable, they are commented out in the plugin.opts file in the
CINELERRA-GG ffmpeg subdirectory. Generally they are not retested so if the ffm-
peg software changes them making them usable, they will still not be accessible
until the plugin.opts file is changed. You can easily retest these, by temporarily
uncommenting the copy of the plugin.opts file in the bin subdirectory and using
Settings → Preferences → Interface tab → Reload plugin index

FFmpeg’s plugin guide is at the link:

https://ffmpeg.org/ffmpeg-filters.html
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9.12.3 FFmpeg Audio Plugins

F_abench: Benchmark part of a filtergraph.
F_acompressor: Audio compressor.
F_acontrast: Simple audio dynamic range compression/expansion filter.
F_acrusher: Reduces audio bit resolution.
F_acue: Delay filtering to match a cue.
F_adelay: Delays one or more audio channels.
F_aderivative: Compute derivative of input audio.
F_aecho: Adds echoing to the audio.
F_aemphasis: Audio emphasis.
F_aeval: Filters audio signal according to a specific expression.
F_afade: Fades in/out input audio.
F_aformat: Convert the input audio to one of he specified formats.
F_agate: Audio gate.
F_aintegral: Compute integral of input audio.
F_allpass: Applies a two-pole all-pass filter.
F_aloop: Loops audio samples.
F_anoisesrc: Generates a noise audio signal.
F_aperms: Set permissions for the output audio frame.
F_aphaser: Adds a phasing effect to the audio.
F_arealtime: Slows down filtering to match realtime.
F_aresample: Resamples audio data.
F_asetrate: Change the sample rate without altering the data.
F_astats: Shows time domain statistics about audio frames.
F_atempo: Adjusts audio tempo.
F_atrim: Pick one continuous section from the input, drop the rest.
F_bandpass: Applies a two-pole Butterworth band-pass filter.
F_bandreject: Applies a two-pole Butterworth band-reject filter.
F_bass: Boosts or cuts lower frequencies.
F_biquad: Applies a biquad IIR filter with the given coefficents.
F_chorus: Adds a chorus effect to the audio.
F_compand: Compresses or expands audio dynamic range.
F_compensationdelay: audio compensation delay line.
F_crossfeed: Apply headphone crossfeed which blends the left and right channels
of a stereo audio recording. It is mainly used to reduce extreme stereo separation
of low frequencies in order to produce more speaker like sound.
F_crystalizer: Simple Expand Audio Dynamic Range filter.
F_dcshift: Applies a DC shift to the audio.
F_drmeter: Measure audio dynamic range where setting window length in sec-
onds is used to split audio into segments of equal length.
F_dyaudnorm: Dynamic Audio Normalizer. When using this plugin, be sure to
attach effect to all audio tracks by dragging the plugin to the 1st audio track and
then right mouse clicking all subsequent audio tracks which brings up an menu.
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Highlight the effect shown in the middle section and click OK.
F_earwax: Widens the stereo image. When using this plugin, be sure to attach
effect to all audio tracks by dragging the plugin to the 1st audio track and then right
mouse clicking all subsequent audio tracks which brings up an menu. Highlight
the effect shown in the middle section and click OK.
F_equalizer: Applies two-pole peaking equalization (EQ) filter.
F_extrastereo: Increases difference between stereo audio channels. When using
this plugin, be sure to attach effect to all audio tracks by dragging the plugin to the
1st audio track and then right mouse clicking all subsequent audio tracks which
brings up an menu. Highlight the effect shown in the middle section and click OK.
F_flanger: Applies a flanging effect to the audio.
F_haas: Apply Haas Stereo Enhancer for a more natural sounding pan effect or
more clarity in the center of the mix. With this filter applied to mono signals it
gives some directionality and stretches its stereo image.
F_highpass: Applies a high-pass filer with 3 dB point frequency.
F_hilbert: Generate a Hilbert transform FIR coefficients.
F_loudnorm: EBU R128 loudness normalization.
F_lowpass: Applies a low-pass filter with 3 dB point frequency.
F_mcompand: Multiband Compress or expand audiodynamic range. The input
audio is divided into bands which is like the crossover of a loudspeaker, resulting
in flat frequency response when absent compander action.
F_pan: Remix channels with coefficients (panning).
F_silenceremove: Removes silence.
F_sine: Generate sine wave audio signal.
F_stereotools: Applies various stereo tools. When using this plugin, be sure to
attach effect to all audio tracks by dragging the plugin to the 1st audio track and
then right mouse clicking all subsequent audio tracks which brings up an menu.
Highlight the effect shown in the middle section and click OK.
F_stereowiden: Applies stereo widening effect. When using this plugin, be sure
to attach effect to all audio tracks by dragging the plugin to the 1st audio track and
then right mouse clicking all subsequent audio tracks which brings up an menu.
Highlight the effect shown in the middle section and click OK.
F_treble: Boosts or cuts upper frequencies.
F_tremolo: Applies tremolo effect.
F_vibrato: Applies vibrato effect.
F_volume: Change input volume.
F_volumedetect: Detect audio volume.

9.12.4 FFmpeg Video Plugins

F_amplify: Amplify changes between successive video frames.
F_atadenoise: Apply an Adaptive Temporal Averaging Denoiser.
F_avgblur: Apply average blur filter.
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F_bbox: Compute bounding box for each frame.
F_bench: Benchmarks part of a filtergraph.
F_bitplaneoise: Measure bit plane noise.
F_blackdetect: Detect video intervals that are (almost) black.
F_blackframe: Detect frames that are (almost) black.
F_boxblur: Blurs the input video. Through the settings you are able to change the
power and the radius of the boxblur applied to luma, chroma and alpha.
F_bwdif: Deinterlaces the input image.
F_chromakey: Turns a certain color into transparency. Operates on YUV colors.
F_ciescope: Video CIE scope.
F_color: Provide an uniformly colored input.
F_colorbalance: Adjusts the color balance.
F_colorchannelmixer: Adjusts colors by mixing color channels.
F_colorkey: Turns a certain color into transparency. Operates on RGB colors.
F_colorlevels: Adjusts the color levels.
F_colormatrix: Converts color matrix.
F_colorspace: Converts color space.
F_cover_rect: Find and cover a user specified object.
F_crop: Crops the input video.
F_cropdetect: Auto-detect crop size.
F_curves: Adjust components curves.
F_datascope: Video data analysis.
F_dctdnoiz: Denoise frames using 2DDC T .
F_deband: Debands video.
F_deblock: Deblocks video.
F_deflate: Applies deflate effect.
F_deflicker: Remove temporal frame luminance variations.
F_dejudder: Removes judder produced by pullup.
F_delogo: Removes logo from input video. When using this plugin a green box
will appear on the screen, once the logo is inside the box the plugin will hide
it. Through the settings you can specify the position of the logo to hide (on a
X − Yaxis) and the size of the box (so you can adjust it to the size of the logo).
F_deshake: Stabilizes shaky video.
F_despill: Remove uwanted foregrond colors, caused by reflected color of green
or blue screen.
F_dilation: Applies dilation effect.
F_doubleweave: Weave input video fields into double number of frames.
F_drawbox: Draws a colored box on the input video. Through the settings you
are able to choose the position of the box on X/Y coordinates, the size of the box,
the color and the thickness of the lines.
F_drawgraph: Draw a graph using input video metadata.
F_drawgrid: Draws a colored grid on the input video. Through the settings you
can select the horizontal and the vertical offset, set the width and height of the grid
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cell, and the color and thickness of the lines. When using the Presets button on
the plugin bar on the timeline, you can choose a preset of rule_of_thirds. The Rule
of Thirds is a 3×3 grid on top of an image which is commonly used in filmmaking.
The concept is that you align the key elements in the image using this grid at the
intersection of the lines or along and within the vertical/horizontal lines.
F_edgedetect: Detects and draws edge.
F_elbg: Apply posterize effect, using the ELBG algorithm.
F_entropy: Measure video frames entropy.
F_eq: Adjusts brightness, contrast, gamma and saturation.
F_erosion: Applies erosion effect.
F_fade: Fade in/out input video.
F_fftdnoiz: Denoise frames using 3DF F T .
F_fftfilt: Apply arbitrary expressions to pixels in frequency domain.
F_field: Extract a field from the input video.
F_fieldorder: Set the field order.
F_fillborders: Fill borders of the input video.
F_floodfill: Fill area of the same color with another color.
F_format: Convert the input video to one of the specified pixel formats.
F_framerate: Upsamples or downsamples progressive source between specified
frame rates.
F_framestep: Select one frame every N frames.
F_fspp: Applies Fast Simple Post-processing filter.
F_gblur: Apply Gaussian Blur filter.
F_gradfun: Debands video quickly using gradients.
F_graphmonitor: Show various filtergraph stats.
F_greyedge: Estimates scene illumination by grey edge assumption.
F_haldclutsrc: Provide an identity Hald CLUT.
F_hflip: Horizontally flips the input video.
F_histeq: Applies global color histogram equalization.
F_histogram: Computes and draws a histogram.
F_hqdn3d: Applies a High Quality 3D Denoiser.
F_hqx: Scales the input by 2, 3 or 4 using the hq ∗ x magnification algorithm.
F_hue: Adjust the hue and saturation of the input video.
F_idet: Interlace detect Filter.
F_il: Deinterleaves or interleaves fields.
F_inflate: Applies inflate effect.
F_interlace: Convert progressive video into interlaced.
F_kerndeint: Applies kernel deinterlacing to the input.
F_lenscorrection: Rectifies the image by correcting for lens distortion.
F_life: Generate a life pattern.
F_limiter: Limit pixels components to the specified range. F_loop: Loops video
frames.
F_lumakey: Turns a cerai luma into transparency.
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F_lut: Compute and apply a lookup table to the RGB/YUV input video. F_lut1d:
Adjust colors using a 1D LUT.
F_lut3d: Apply a 3D LUT (lookup table) to an input video. LUTs are used to map
one color space to another and are frequently supplied with high-end cameras as
a .cube file to use as input.
F_lutrgb: Compute and apply a lookup table to the RGB input video.
F_lutyuv: Combine and apply a lookup table to the YUV input video.
F_mandelbrot: Render a Mandelbrot fractal.
F_mcdeint: Applies motion compensating deinterlacing.
F_mestimate: Generate motion vectors.
F_mpdecimate: Remove near-duplicate frames.
F_mptestsrc: Generate various test pattern.
F_negate: Negates input video.
F_nlmeans: Non-local means denoiser. Example usage is for recovery of VHS
tapes which look bad.
F_noise: Adds noise to the video. Through the settings you can select the vari-
ables of the noise (strength, flag and seed).
F_normalize: Normalize RGB video.
F_oscilloscope: 2D video oscilloscope. Useful to measure spatial impulse, step
responses, and chroma delays.
F_owdenoise: Denoises using wavelets.
F_pad: Add paddings to the input image, and place the original input at the pro-
vided x , y coordinates.
F_pal100bars: Generate PAL 100% color bars.
F_pal75bars: Generate PAL 75% color bars.
F_perms: Set permissions for the output video frame.
F_perspective: Corrects the perspective of video.
F_phase: Phases shift fields.
F_pixscope: Pixel data analysis for checking color and levels. It will display sam-
ple values of color channels.
F_pp: Filters video using libpostproc.
F_pp7: Applies Postprocessing 7 filter.
F_prewitt: Apply prewitt operator.
F_pseudocolor: Make pseudocolored video frames.
F_readeia608: Read EIA-608 Closed Caption codes from input video & write to
frame metadata.
F_readvitc: Reads vertical interval timecode and writes it to frame metadata.
F_realtime: Slows down filtering to match realtime.
F_removegrain: Removes grain.
F_repeatfields: Hard repeat fields based on MPEG repeat field flag.
F_rgbtestsrc: Generate RGB test pattern.
F_roberts: Apply roberts cross operator which performs a simple/quick 2D spa-
tial gradient measurement on the video (usually a grayscale image). It highlights
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regions of high spatial frequency which most ikely correspond to edges.
F_rotate: Rotates the input image.
F_sab: Applies shape adaptive blur.
F_scale: Scale the input video size and/or convert the image format.
F_separatefields: Split input video frames into fields.
F_setparams: Force field, or color property for the output video frame.
F_setrange: Force color range for the output video frame.
F_showpalette: Display frame palette.
F_shuffleframes: Shuffles video frames.
F_shuffleplanes: Shuffles video planes.
F_signalstats: Separates statistics from video analysis.
F_smartblur: Blurs the input video without impacting the outlines. Through the
settings you can select the radius, the strength and the threshold of luma and
chroma.
F_smptebars: Generate SMPTE color bars.
F_smptehdbars: Generate SMPTE HD color bars.
F_sobel: Applies sobel operator.
F_spp: Applies a simple post processing filter.
F_stereo3d: Converts video stereoscopic 3D view.
F_super2xsai: Scales the input by 2x using the Super2xSal pixel art algorithm.
F_swaprect: Swaps 2 rectangular objects in video.
F_swapuv: Swaps U and V components.
F_tblend: Blend successive frames.
F_testsrc: Generate test pattern.
F_testsrc2: Generate another test pattern.
F_tile: Tile several successive frames together.
F_tinterlace: Performs temporal field interlacing.
F_tlut2: Compute and apply a lookup table from 2 successive frames.
F_tmix: Mix successive video frames.
F_transpose: Transposes input video.
F_unsharp: Sharpen or blur the input videlo.
F_uspp: Applies Ultra Simple/Slow Post-processing filter.
F_vaguedenoiser: Applies a Wavelet based Denoiser.
F_vectorscope: Video vectorscope.
F_vflip: Flips the input video vertically.
F_vfrdet: Variable frame rate detect filter.
F_vibrance: Boost or alter saturation.
F_vignette: Makes or reverses a vignette effect. Through the settings you can set
the circle center position on a X − Yaxis,choose the angle, the aspect and set the
dithering of the vignette.
F_w3dif: Applies Martin Weston three field deinterlace.
F_waveform: Video waveform monitor.
F_weave: Weaves input video fields into frames.
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F_xbr: Scales the input using xBR algorithm.
F_yadif: Deinterlaces the input image.
F_yuvtestsrc: Generate YUV test pattern.
F_zoompan: Applies Zoom & Pan effect.

9.13 Rendered Effects10

Besides the Realtime effects, as has been described in the previous sections, an-
other type of effect is performed on a section of the track and the result stored
somewhere before it is played back. The result is usually pasted into the track to
replace the original data. The rendered effects are not listed in the resources win-
dow but instead are accessed through the Audio → Render effect and Video
→ Render effect menu options. Each of these menu options brings up a dialog
for the rendered effect. In the Select an effect dialog is a list of all the realtime
and all the rendered effects. The difference here is that the realtime effects are
rendered to disk and not applied under the track. Rendered effects apply to only
one type of track, either audio or video. If no tracks of the type exist, an error pops
up.

A region of the timeline to apply the effect to must be defined before selecting
Render effect. If no in/out points and no highlighted region exist, the entire region
after the insertion point is treated as the affected region. Otherwise, the region
between the in/out points or the highlighted region is the affected region. The
tracks to apply the rendered affect to, need to be armed, other tracks are ignored.
The rendered effect processes certain track attributes when it reads its input data
but not others. Transitions in the affected track are applied, but nudge and effects
are not. This allows the new data to be pasted into the existing position without
changing the nudge value.

How to use a rendered effect

• Highlight an effect in the list (Select an effect) to designate it as the one being
used.

• Define a file to render the effect to in the Select a file to render to
box. The magnifying glass allows file selection from a list.

• Select a file format which can handle the track type. The wrench allows con-
figuration specific to the file format.

• There is also an option for creating a new file at each label. For example, if
you have a CD rip on the timeline which you want to divide into different files,
the labels would become dividing points between the files if this option were
selected. When the timeline is divided by labels, the effect is re-initialized at

10This capability is going to be deleted in the future unless receive notification of need to keep
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every label. Normalize operations take the peak in the current file and not in
the entire timeline.

• Finally there is an insertion strategy just like in the render dialog. It should be
noted that even though the effect applies only to audio or video, the insertion
strategy applies to all tracks just like a clipboard operation.

• When you click OK in the effect dialog, it calls the GUI of the effect. If the
effect is also a realtime effect, a second GUI appears to prompt for acceptance
or rejection of the current settings.

• After accepting the settings, the effect is processed.

9.13.1 Rendered Audio Effects

Resample

This multiplies the number of each output sample by a scale factor to arrive at the
number of the input sample. The output file’s sample rate is set to the project
sample rate but its length is changed to reflect the scaled number of samples. It
also filters the resampled audio to remove aliasing.

If the scale factor is 2, every 2 input samples will be reduced to 1 output sample
and the output file will have half as many samples as the input sequence. If it is
0.5, every 0.5 input samples will be stretched to 1 output sample and the output
file will have twice as many samples as the input sequence.

Normalize

Time Stretch

9.13.2 Rendered Video Effects

Reframe

This does exactly the same thing as ReframeRT in Stretch mode. It multiplies the
output frame number by the scale factor to arrive at the input frame number and
changes the length of the sequence. Unlike ReframeRT, this must run from the
Video menu and render its output. Be aware Reframe does not write the scaled
frame rate as the frame rate of the rendered file. It produces a file of scaled length
and equal frame rate as the project. The new length is 1

scale f actor as big as the
original sequence.

To create a slow-motion of fast moving video:

• Select the video clip you wish to reframe and put it on a video track.

• Select the area you wish to reframe.
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9.13. Rendered Effects

• From the Video menu, select the Render Effect option.

• From the effect list, select Reframe.

• Enter the output format and insertion strategy for the new clip to be created.

• Press OK.

• At the popup menu, enter the scale factor 2 to run twice as fast, and 0.5 to
run at half speed.

CD Ripper

720 to 480
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CHAPTER 10

Transition Plugins

When playing a section of media where one edit ends and another edit begins on
the timeline, the usual result is that the first edit’s output immediately is followed
by the second edit. Transitions provide a better method whereby the first edit’s
output becomes the second edit’s output. There are several different audio and
video transitions listed in the Resources window as figure 10.1.

Figure 10.1: Resources window displaying the Video Transitions.

Note the colored bar above the Shape Wipe transition. This bar near the transition
symbol shows the position and the length of the transition.

Transitions only apply to the matching track type; that is audio transitions only
apply to audio tracks and video transitions only apply to video tracks.

An example usage of a transition follows:
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1. Load a single video file and delete a sizable section from within the video
which will result in two edits of that file. Now you should see the edit bound-
ary between the two edits on the timeline.

2. Move to the Resources window and click on the Video transitions folder. Choose
a transition by highlighting it and then drag and drop it on the second video
edit on the timeline. A colored box shows where the transition will appear
and when you release the mouse the 2nd edit applies the transition between
the 1st and 2nd edit. The beginning of the edit will be covered by the transi-
tion, if the insertion point or the In point is over an edit.

Some Transitions have parameters that can be modified. To see these, move the
pointer over the transition and right click which brings up a menu. A Show option
will pop up a window if there are parameters that you can change to different
values. An On option makes it possible to turn off the transition so that it will not
be in effect in case you want to only enable it under certain conditions. The default
value for this will be checked On. A Length option lets you adjust the length in
seconds of the time that the transition will be in play. Values modified in the Show
or Length will be saved for use the next time that transition is used until changed
again. The Detach option deletes the transition from the timeline. When you drag
and drop a different transition on top of an existing transition on the timeline, it
replaces the previous one.

There are some shortcuts to alleviate the dragging and dropping of transitions
when you want to do a lot of them in various places on the timeline. After you
have established the parameter values for a transition that you have dragged from
the Resources window, you can use "U" and "u" keys to paste the same transition;
the "U" key pastes the last video transition while the "u" key pastes the last audio
transition on all recordable tracks. Alternatively, you can add the same transition
to multiple edits when in Arrow mode (Drag and Drop editing), by selecting edits
to add the transition to and use the Video/Audio pulldown to Attach transition.
Select the desired transition and then click the checkmark OK. You can set a default
transition in the Attach transition popup box – by highlighting your choice, then
click on the button Set Default Transition, and you will see that transition become
the new default.

The way that transitions work is that two edits overlap for some length of time
and no edits are actually moved during the transitions. Instead extra frames from
the source file will be used to lengthen the first edit enough to make it overlap the
second edit for the length of the transition. The transition takes effect exactly at
the beginning of the second edit and lasts for the specific length of time you set
into the second edit. What this means is that if you set a duration of 2 seconds
for a flash transition, it will not start at the last 1 second of the first edit and
continue 1 second into the second edit. Instead the transition will start exactly
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10.1. Audio Transitions

at the beginning of the second edit and last for 2 seconds into that second edit.
This is why it is necessary that the first edit needs to have extra data after the
end boundary to provide enough fill for the transition length into the second edit.
In the case where the last frame on the timeline is the last frame of the source,
CINELERRA-GG will lengthen the first edit using only that last frame. The result
will not be what you want because the first edit will freeze into the transition.

When playing transitions, software rendering is used. This means that if you are
using hardware, as with the video driver set to OpenGL, hardware acceleration
will usually be turned off during the transition and on after the transition. Con-
sequently, you may notice small anomalies while playing this section but you can
avoid this by switching to using X11 video driver instead or just ignore it because
when you create your final render that is always done in software only.

When Info on is enabled via the right mouse button over an empty space in the
Resources window (or the shortcut of the letter “i” is used), a short description
will be provided in the lower right hand corner of that window for the current
transition that the mouse is on.

Once you have dragged and dropped a transition to the timeline, right mouse click
on the transition and a pop-up menu will appear which provides an opportunity to
make some changes. These are described next for all video and audio transitions.

Show If available, clicking on this will pop up a transition specific menu.

On Toggle on/off the transition effect so that you can see what it looks like when
played. Ordinarily this will be checked to indicate it is On.

Transition length When you click on Length, a pop-up menu will come up. Set
the length in seconds, frames, samples, H:M:S:frm or H:M:S.xxx for the tran-
sition to complete either by typing a value into the text box or using the
tumbler arrows. In addition you can use the mouse wheel to change the
length in real time. You will see the colored bar get longer or shorter as you
change the length. There is a down arrow next to the Seconds box allowing
for changing to the other dimensions of frames, samples, etc. The mathemat-
ics is automatically done for you to convert it to seconds if not already in that
dimension.

Detach Remove the transition from the timeline.

10.1 Audio Transitions
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10.2. Video Transitions

Crossfade

Creates a smooth transition from one audio source edit to another. The crossfade
has the first source fade out while the second fades in.

10.2 Video Transitions

BandSlide

Bands slide across video and you see the image slide.

BandWipe

Bands wipe across the video and you see the mask slides.

Dissolve

A soft dissolve where the In segment becomes more transparent while the Out
segment begins to gradually show in its place until fully there.

Flash

The video flashes when transitioning between segments.

IrisSquare

Video switches segments via a small rectangular view that gradually grows to full
size.

Shape Wipe

Wipe a specific shape across the video. Currently available shapes are: burst, But-
terfly, circle, Circle-h_01, Circle-h_02, Circle-v_01, Circle-v_02, clock, Clouds_01,
Clouds_02, Cross-Iris_01, Cross_01, Diagonal-Curve, Diagonal-Linear, Diamond-Iris_01,
Diamond_01, Diamond_02, Diamond_03, Double-Door-h, Double-Door-v, Gravity,
heart, Linear-h, Linear-v, Plasma_01, specks, spiral, tile2x2h, tile2x2v, Venetian-
Blinds-h-x05, Venetian-Blinds-h-x10, Venetian-Blinds-v-x05, and Venetian-Blinds-v-
x101.

The menu for Shape Wipe that popups when you click on Show has several possible
choices. First, the Shape allows for choosing from the list of shapes as outlined
previously either by typing in the textbox, using the down arrow, or clicking on

1many shapes by Igor Beg
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10.2. Video Transitions

the tumbler down/up arrows. Next, there is a Feather textbox with tumbler arrows
or a slider bar to easily change the blending amount. A reset button is conveniently
located to the right of the slider bar. There is a checkbox to Preserve shape aspect
ratio and a Direction of White to Black or Black to White.

You can add your own images to the Shape Wipe transition and there are some free
ones available to download such as under the Video → Transitions pulldown
at assistcg.com.

To include new images in the Shape Wipe Transition, simply copy the file shape.png
to the subdirectory plugins/shapes in your CINELERRA-GG directory path.

Slide

Image slides into view; you can set Left/Right/In/Out.

Wipe

Wipe the image across screen starting left or right.

Zoom

Zoom out video at X
Y magnification for some seconds.
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CHAPTER 11

Overlays

The purpose of the Overlay Modes is to control the foreground and background
stacking and use blending to reshape image object boundaries. It normally makes
use of a binary type alpha blending system for all in or all out. To use the available
operations in CINELERRA-GG, follow these steps:

1. In the main window, look at the Patchbay on the far left.

2. Click on the small arrow that points to the right, inside the panel to see it
expand.

3. A down arrow shows up with a tooltip of overlay mode.

4. Use the down arrow to get to the popup menu and choose the desired effect
from the 30 possibilities. Normal is the default.

Figure 11.1 shows the pulldown in the patchbay and the tool tip Overlay mode
which provides access to 4 types of overlays. Each will expand further as shown
in the screenshots below for PorterDuffs and graphic art.

Porter-Duff is the industry standard for alpha blending operations. Only a short
explanation follows here, but there is much more information to be found on the
internet with complete descriptions and examples. Every pixel has 3 color chan-
nels (like RGB), and may have 1 alpha channel value. If there is no alpha de-
fined for a color model, the alpha value is assumed to be 1. Regions of the image
are created with the alpha image map. These regions are manipulated using the
blending operations described below. Alpha blending is the process of combining
a foreground color with a background color which produces a new blended color.
The alpha channel describes how much opacity is present in a pixel. It may be
completely transparent, completely opaque, or any range of translucency.

Conceptually, when the foreground color is completely opaque, the resulting blended
color will be the foreground color. If it is transparent, the blended color will be
the color of the background. When the value of the alpha channel is 1, the image
is all there, if it is 0, there is no image at all, otherwise it is only partially there.
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11.1. Math algorithms

Figure 11.1: Patchbay pulldown with Porter Duff and Graphic Art overlays expanded

In other words, the alpha value goes from 0 to 1, where full transparency is 0 and
opaque is represented by 1. Alpha blending models opacity.

When blending source and destination shapes (Dst and Src), the shape boundaries
can be changed with the alpha blending effects. There are a total of 10 standard
Porter-Duff operators, but there are 30 possible overlay modes used in CINELERRA-
GG. Each is characterized by its value in the four regions: source, destination and
both, with the neither region always being blank. The source and destination re-
gions can either be blank or filled with the source or destination colors. A specific
compositing math formula is used to calculate effect. This is only applicable to
RGB; some effort has been made to accommodate YUV, but the effects are not as
predictable, and may not be useful.

Below, in figure 11.2, are the results of utilizing the 30 available operations within
CINELERRA-GG as listed on a following page. Src is the solid green rectangle and
Dst is the solid red rectangle. There are better illustrations of what alpha blending
can do, however for consistency sake, these are the results when using standards.

11.1 Math algorithms

The implementation math forms are subsequently listed, where:

Legend:
D = Destination
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11.1. Math algorithms

Figure 11.2: Normal and Arithmetic overlays

Figure 11.3: Porter Duff overlays

S = Source
a = alpha
c = chroma (color)
|| = OR (logical operator);
? : = if (true/false) ... then (conditional ternary operator)

Each line describes a pair with the left one for alpha and the right one for chroma.

Normal

NORMAL: [Sa+ Da× (1− Sa), Sc × Sa+ Dc × (1− Sa)])
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11.1. Math algorithms

Figure 11.4: Logical overlays

Figure 11.5: Graphic Art overlays

Arithmetic:

ADDITION: [(Sa+ Da), (Sc + Dc)]

SUBTRACT: [(Sa− Da), (Sc − Dc)]

MULTIPLY: [Sa+ Da− Sa× Da, Sc × (1− Da) + Dc × (1− Sa) + Sc × Dc]

DIVIDE: [Sa+ Da− Sa× Da, Sc × (1− Da) + Dc × (1− Sa) + Sc/Dc]

REPLACE: [Sa, Sc] (fade = 1)

Porter-Duff

DST: [Da, Dc]

DST_ATOP: [Sa, Sc × (1− Da) + Dc × Sa]

DST_IN: [Da× Sa, Dc × Sa]

DST_OUT: [Da× (1− Sa), Dc × (1− Sa)]
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11.2. Description

DST_OVER: [Sa+ Da− Sa× Da, Sc × (1− Da) + Dc]

SRC: [Sa, Sc]

SRC_ATOP: [Da, Sc × Da+ Dc × (1− Sa)]

SRC_IN [Sa× Da, Sc × Da]

SRC_OUT: [Sa× (1− Da), Sc × (1− Da)]

SRC_OVER: [Sa+ Da− Sa× Da, Sc + (1− Sa)× Dc]

Logical

MIN: [min(Sa, Da), M IN(Sc, Dc)]

MAX: [max(Sa, Da), MAX (Sc, Dc)]

LIGHTEN: [Sa+Da−Sa×Da, Sc×(1−Da)+Dc×(1−Sa)+max(Sc×Da, Dc×Sa)]

DARKEN: [Sa+Da−Sa×Da, Sc×(1−Da)+Dc×(1−Sa)+min(Sc×Da, Dc×Sa)]

AND: [Sa× Da, Sc × Dc]

OR: [Sa+ Da− Sa× Da, Sc + Dc − Sc × Dc]

XOR: [Sa+ Da− 2× Sa× Da, Sc × (1− Da) + Dc × (1− Sa)]

Graphical Art

OVERLAY: [Sa+Da−Sa×Da, Sc×(1−Da)+Dc×(1−Sa)+2×Dc < Da ? 2×
Sc × Dc : Sa× Da− 2× s(Da− Dc)× (Sa− Sc)]

SCREEN: [Sa+ Da− Sa× Da, Sc + Dc − (Sc × Dc)] (same as OR)

BURN: [Sa+Da−Sa×Da, Sc×(1−Da)+Dc×(1−Sa)+Sc ¶ 0 ‖ Sc×Da+Dc×Sa ¶
Sa× Da ? 0 : (Sc × Da+ Dc × Sa− Sa× Da)× Sa/Sc]

DODGE: [Sa+Da−Sa×Da, Sc× (1−Da)+Dc× (1−Sa)+Sa ¶ Sc ‖ Sc×Da+
Dc × Sa ¾ Sa× Da ? Sa× Da : Dc × Sa/(1− Sc/Sa)]

DIFFERENCE:
[Sa+Da−Sa×Da, Sc× (1−Da)+Dc× (1−Sa)+ abs(Sc × Da− Dc × Sa)]

HARDLIGHT: [Sa + Da − Sa × Da, Sc × (1 − Da) + Dc × (1 − Sa) + 2 × Sc <
Sa ? 2× Sc × Dc : Sa× Da− 2× (Da− Dc)× (Sa− Sc)]

SOFTLIGHT: [Sa+Da−Sa×Da, Sc×(1−Da)+Dc×(1−Sa)+Da > 0 ? (Dc×
Sa+ 2× Sc × (Da− Dc))/Da : 0]

11.2 Description

The previous math forms are the only truly accurate description of each blending
operation, but short descriptions are below where Source is the output from the
next track and Destination is the output from the lower track stacking. Blending
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11.2. Description

starts with new Source and combines it with the previous render stack output,
which is referred to as Destination. The new output becomes the next Destination
and the next up stack level becomes the new Source. Source is above; Destination
is below.

Note: the Graphic Art group operates principally on color, and the others operate
principally on alpha.

Normal

Normal: Normal mode is the default layer mode. The result color is the source
color. The layer on top covers the layers below it. If you want to see any-
thing below the top layer when you use this mode, the layer must have some
transparent areas. It is stacked on top. Math formula used is different than
that used by Gimp; there is no SVG equivalent.

Arithmetic Group:

Standard numerical operations.

Addition: The source is added to the destination and replaces the destination.
Addition mode is very simple - the pixel values of the upper and lower layers
are added to each other. The resulting image is normally brighter. The equa-
tion can result in color values greater than 255, so some of the light colors
may be clipped to the maximum value of 255. Math formula is the same as
that used by SVG but different than Gimp.

Subtract: Subtract mode reduces the pixel values of the upper layer by the pixel
values of the lower layer. The resulting image is normally darker. You might
get a lot of black or near-black in the resulting image. The equation can
result in negative color values, so some of the dark colors may be clipped to
the minimum value of 0. Math formula used is different than that used by
Gimp; there is no SVG equivalent.

Multiply: The source color is multiplied by the destination color and replaces the
destination. The resulting color is always at least as dark as either the source
or destination color. Multiplying any color with black results in black. Multi-
plying any color with white preserves the original color. Math formula is the
same as used by SVG and Gimp.

Divide: Divides source color by destination color. If the source color is white, the
result color is the underlying color. The resulting image is often lighter. Math
formula used is different than that used by Gimp; there is no SVG equivalent.
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11.2. Description

Replace: Replace mode will cause any existing destination to be replaced by the
source media. Mathematical formula used is the same as used by Gimp; there
is no SVG equivalent.

Porter-Duff Group

Industry standard compositing operators.

DST: The destination is left untouched. Only the destination will be present in
the output. Math formula is the same as that used by Porter-Duff and SVG;
there is no Gimp equivalent.

DST_ATOP: The part of the destination lying inside of the source is composited
over the source. The destination outside the source is dropped. You will see
the existing canvas is only kept where the shapes overlap. Math formula is
the same as that used by Porter-Duff and SVG; there is no Gimp equivalent.

DST_IN: The part of the destination lying inside of the source is displayed. This
effectively allows for cutting out the background using the current layer/fea-
ture as a mask. You will see the new shape is drawn only where both the
source and the destination overlap. Math formula is the same as that used
by Porter-Duff and SVG; there is no Gimp equivalent.

DST_OUT: The part of the destination lying outside of the source is displayed.
This is basically a reverse mask, compared to destination-in. You will see the
existing content is kept where it doesn’t overlap the source. Math formula is
the same as that used by Porter-Duff and SVG; there is no Gimp equivalent.

DST_OVER: The destination is composited over the source. Math formula is the
same as that used by Porter-Duff and SVG; there is no Gimp equivalent.

SRC: The source is copied. The destination is not used as input. Only the source
will be present in the output. Math formula is the same as that used by
Porter-Duff & SVG; there is no Gimp equivalent.

SRC_ATOP: The part of the source lying inside of the destination is composited
over the destination. The source outside the destination is dropped. You will
see the existing canvas is only kept where the shapes overlap. Math formula
is the same as that used by Porter-Duff and SVG; no Gimp equivalent.

SRC_IN: The part of the source lying inside of the destination is displayed. This
effectively allows the destination to act as a mask for the layer/feature being
shown. You will see the new shape is drawn only where both the source and
the destination canvas overlap. Math formula is the same as that used by
Porter-Duff and SVG; there is no Gimp equivalent.

SRC_OUT: The part of the source lying outside of the destination is displayed.
This is basically a reverse mask, compared to source-in. You will see the new
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11.2. Description

shape is drawn where it doesn’t overlap the destination. Math formula is the
same as that used by Porter-Duff and SVG; there is no Gimp equivalent.

SRC_OVER: The source is composited over the destination. Math formula is the
same as that used by Porter-Duff and SVG; there is no Gimp equivalent.

Logical Group

Min: The output color is the component-wise minimum value of the source and
destination colors. There is no SVG or Gimp equivalent math formula.

Max: The output color is the component-wise maximum value of the source and
destination colors. There is no SVG or Gimp equivalent math formula.

Lighten: Selects the lighter of the destination and source colors. The destination
is replaced with the source when the source is lighter, otherwise it is left
unchanged. Completely black layers have no effect on the final image and
completely white layers result in a white image. Math formula is the same as
used by SVG and Gimp’s lighten only.

Darken: Selects the darker of the destination and source colors. The destination
is replaced with the source when the source is darker, otherwise it is left
unchanged. Completely white layers have no effect on the final image and
completely black layers result in a black image. Math formula is the same as
used by SVG and Gimp’s darken only.

And: This operation intersects source and destination. If either image is not white,
it down factors the other image. Usually you will end up with a lot of darker
areas. There is no SVG or Gimp equivalent math formula.

Or This operation is the union of the source and the destination. If either image
is not black, it adds to the other image. Usually you will end up with a lot of
lighter areas. Math formula is the same as that used by “Screen” operation
in SVG; there is no Gimp equivalent.

Xor: The union of the source and destination with the intersection removed. Re-
sults in black if they are equal. Shapes are made transparent where both
overlap, and drawn normal everywhere else. Math formula used is that used
by Porter-Duff; there is no Gimp equivalent and SVG formula differs.

Graphical Art Group

Typical operations from popular paint packages.

Overlay: Multiplies or screens the colors, dependent on the destination color.
Source color overlay the destination while preserving its highlights and shad-
ows. The destination color is not replaced, but is mixed with the source color
to reflect the lightness or darkness of the destination. Dark parts on the base
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11.2. Description

layer become darker, and light parts become lighter. Math formula is same
as SVG and Gimp.

Screen: The source and destination are complemented and then multiplied and
then replace the destination. The resultant color is always at least as light as
either of the two constituent colors. Screening any color with white produces
white. Screening any color with black does not change the other layer. Using
the Screen mode is similar to projecting multiple photographic slides simul-
taneously onto a single screen. A lighter picture is the result. Math formula
is the same as used by SVG and Gimp. This is identical to OR.

Burn: Darkens the destination color to reflect the source color. Burning with white
produces no change. In photography, burning is a technique used in a dark-
room to increase the exposure in particular areas of the image. This brings
out details in the highlights. Math formula is the same as used by SVG and
Gimp.

Dodge: Brightens the destination color to reflect the source color. Dodging with
black produces no change. The result color is a lightening of the source color
to reflect the underlying layer color by decreasing the contrast. If the source
color is pure black, the result color is the underlying color. In photography,
dodging is a technique used in a darkroom to decrease the exposure in partic-
ular areas of the image. This brings out details in the shadows. Math formula
is the same as used by SVG and Gimp.

Difference: Subtracts the darker of the two constituent colors from the lighter.
This is the same as Subtract except that the absolute value is used. Subtract
colors which would be black due to clipping become visible instead. Dif-
ferencing with white inverts the destination color. Differencing with black
produces no change. Math formula is the same as used by SVG and Gimp.

Hardlight: Multiplies or screens the colors, dependent on the source color value.
If the source color is lighter than 0.5, the destination is lightened as if it were
screened. If the source color is darker than 0.5, the destination is darkened,
as if it were multiplied. The degree of lightening or darkening is proportional
to the difference between the source color and 0.5. If it is equal to 0.5 the
destination is unchanged. Using pure black or white produces black or white.
The effect is similar to shining a harsh spotlight on the destination. This mode
is useful for creating the appearance of shadows on a layer. You might use
this mode to combine two photographs and obtain bright colors and sharp
edges. Math formula is the same as used by SVG and Gimp.

Softlight: Darkens or lightens the colors, dependent on the source color value. If
the source color is lighter than 0.5, the destination is lightened. If the source
color is darker than 0.5, the destination is darkened, as if it were burned
in. The degree of darkening or lightening is proportional to the difference
between the source color and 0.5. If it is equal to 0.5, the destination is
unchanged. Using pure black or white produces a distinctly darker or lighter
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11.2. Description

area, but does not result in pure black or white. The effect is similar to shining
a diffused spotlight on the destination. A layer with pure black or white
becomes markedly darker or lighter, but does not become pure black or white.
Soft light is not related to “Hard light” in anything but the name, but it does
tend to make the edges softer and the colors not so bright. Math formula is
the same as used by Gimp; SVG formula differs.
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CHAPTER 12

Capturing and Recording Media

This section covers the areas of capturing media from the web or television by the
use of recording.

Access the Record function via File→ Record. . . The recording application really
only does one thing, capture media from some external source, and write it onto
a file in a specified way.

Path: output media file path
Start time: weekday/time of day to begin capture
Duration: hrs:mins:secs until end of capture
Source: channel/device input selection of input subsource

Mode:
timed use start time/duration
untimed use transport controls

The media file will be written using the format and codec specified in the Settings
→ Preferences → Recording tab, which you will need to set up first. See the
Settings/Preferences section for parameters. Only ffmpeg can record both audio
and video simultaneously, and some ffmpeg formats require too much cpu to do
a realtime compression. A setting which is more likely to be usable (requires less
cpu/memory for realtime encoding) is ffmpeg → qt → mp4.qt with bitrates
like audio/256000 & video/6000000.

12.1 Record Web Media in real-time

Below describes the necessary steps for recording freely available media from the
internet for your own personal use. You have to be on a system using pulseaudio,
such as ubuntu, fedora, centos.

1. Start CINELERRA-GG and select Settings → Preferences → Recording
From a terminal (with a wide text window) run: pactl list. You will see all
of the audio sources and sinks on your system. Identify the source associated
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12.1. Record Web Media in real-time

with the normal output your system uses. Example: Source #1. Locate the
source which monitors your normal audio output. For example: front stereo.

2. Choose a File Format and File Type (for example: FFMPEG & qt).

• Check Record audio tracks. Click Audio wrench tool:
– Select mp4, for example.
– Set Bitrate (256000 is a reasonable number).

• Check Record video tracks.
• Click Video wrench tool:

– Select mp4 video, for example.
– Set Bitrate 1000000− 4000000 (bigger=better, but more cpu)

• Select Audio In → Record Driver: ALSA (or whatever you have in-
stead)

– Set the Bits: 16 Bit Linear (probably, because reasonable and fast)
– Select Device: the source from above pactl list search, for example

Source #1
– Samples read from device: aprox dev buffer size (2k−16k probably)
– Samples to write to disk: 131072 (a good size)
– Sample rate for recording: 44100 (will automatically change)
– Channels to record 2 (probably)
– Uncheck Map 5.1→ 2
– Gain 1.0

• Select Video In → Record Driver: Screencapture
– Set the Display: leave blank (probably) or use ": 0.0" (default screen/dis-

play)
– Frames to record to disk at a time: 30 (a good number)
– Frames to buffer in device: (2− 6) (probably)
– Positioning: Software Timing (important)
– Uncheck: Sync drives automatically
– Size of captured frame: 720x480 (this is your choice, actual capture

size; 600x320 youtube)
This defines a screen capture rectangular area on the display.
Try to make it the size you need to cover the screen playback area.

• Frame rate for recording 23.97 f ps (a good choice, not all choices work)
• OK

When recording from the screen, a large green-colored boundary box appears to
allow you to easily frame the screen area to be recorded when you move it around
to where you want to position it. In addition there are record cursor and big cursor
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12.1. Record Web Media in real-time

check boxes which allow for also recording the cursor and for making the cursor
bigger.

Screenshot to illustrate some appropriate settings which are described above/be-
low the image (figure 12.1).

Figure 12.1: Recording window with tipical settings

3. Make sure the Compositor window is up since you will want to see the cap-
tured media later. From the main window press (lower case "r") (move win-
dows and resize if needed) Using the mouse pointer, mouse over the Video
In Recording monitor display. Press and hold the left mouse button and drag
the display until the desired target screen capture area is properly positioned
inside the record monitor Video In display. At first this may seem confusing,
but keep in mind that what you are actually doing is positioning the portion
of your monitor display you want to capture over the Video In window.

4. From the Recording window select a Path file name for the recording.

5. Select mode untimed.

6. Make sure the monitor audio is unchecked else audio becomes looped and is
very loud.

7. Press Transport start recording (red circle button).

8. Operate the playback of the media source, i.e. start playing the web video.
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9. When the media ends, stop on the playback application.

10. Press Transport stop recording button (white square button).

11. Before clicking chk-Ok, be sure to set the Insertion Strategy.

12. Press chk-Ok to review the capture, or "X" to cancel/dismiss application.

Two things are happening during recording, the data is being written, and it is
being rendered. When recording, if video and audio are not in sync, it will usually
be video behind audio as opposed to the other way around because video is more
difficult to decode. During recording, video frame and audio sample positions are
checked and efforts to maintain synchronization are used. Below is an explana-
tion for some of the less obvious settings for recording as shown in the previous
screenshot.

Frames dropped more input than cpu(s) can process. This is the number of
frames dropped when the system is too slow to keep up with the video. This value
serves as a warning that it is behind and is dropping frames to keep up. You might
want to consider stopping to make some parameter adjustments and start over to
reduce drops.

Frames behind active input buffers. This is the number of frames that the video
is behind and it will drop frames to get caught up. Frames behind depends on the
synchronization source, for example, time as the synchronization. This means that
frames are not being written as fast as they are being captured and can occur when
the system is too slow to keep up. This situation can happen with older systems
or cpus where there is more input then can be processed in a timely manner. So
that when there are Frames behind, frames will be dropped.

The algorithm for determining how many frames to drop is as follows:

• If the number of frames behind > 3, only 3 frames will be dropped before it
will then do 1 frame;

• if the number of frames behind is 2, only drop 1 frame;

• if only 1 frame behind, no frames will be dropped.

Drop overrun frames checkbox when enabled, frames will be dropped. Drops
occur when you capture a frame and there is no storage space available to save
it, usually because buffer space is exhausted. This situation can occur when there
are too many frames coming in too fast and the I/O system is not keeping up in
emptying the buffers.
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Fill underrun frames checkbox if enabled, duplicate last frame when no input
frame ready for output. As the tooltip states write extra frames when behind. This
is desirable in order to keep audio and video synched with regards to sample and
frame rates. Use underrun padding to fill frames when the input capture rate is
lower than the output frame rate. Since demand is constant, you have to output
something, so the last frame is duplicated as many times as needed to keep up.
You should stop and adjust the frame/sample rates to match the input if not filling
underruns, then start over. This situation can occur if the input stops for some
reason like lightning interrupts the signal or the internet connection is too slow.

Transport controls these control buttons mimic the functions of tape recorders
from the old days.

• Reverse button/left arrow –remnant from the past; does the same as the Start
button really.

• Red round button –this is the Start button to start recording.

• White square –this is the Stop button to stop recording.

• Red round button with white line –start recording in single frame mode. The
way this works is to just take a picture now, take a picture now. . . The reason
to use this mode is to get a still shot like you would with a camera. Some-
times input is continuous, for example looking at stars with a telescope –
surveillance goes on for hours, but you just want to take a picture now when
something of significance interest comes up

Cron The batch recording watcher, cron, is either Idle or Active. When you start
or stop batch recording at specific times, there is a cron thread watching timers to
perform the timed action. Idle/Active indicates whether the timers are running.

Position this is a timebase which tracks frames/samples when obeying frame/sam-
ple rate. When a recording starts, it resets to 0. Timing is against audio (when
available). Audio time and video time are based on position. You can select syn-
chronization time source Positioning in:

Settings → Preferences under the Recording tab.

Possible choices for time base are:

• Presentation Timestamps –use time code which is in both the audio and video
media input stream. Uses these timestamps to sync the 2 streams.

• Device Position –this is the device hardware position of where you are. It is
usually only on the audio side.

370



12.1. Record Web Media in real-time

• Sample Position –Sample # or frame # divided by frame rate tells you where
you are.

• Software Timing –usually used for things like YouTube; it just will take a pic-
ture now . . . take a picture now . . . over and over again until you tell it to stop.

Positioning & Timing needs more detailed explanation for complete understanding
and application. The overall goal is to maintain media stream timeline synchro-
nization. The reason for providing different Positioning options is that different
input media may have different timebase standards. Additionally, the input may
be damaged. Damaged data can skew the timeline during presentation. The time-
base standards make it possible to correctly resynchronize the media presentation
to the original time position. For example, the transport layer may have times-
tamps provided in it. These timestamps record audio time and video time and are
called presentation timestamps.

The kind of positioning used depends on the input device and the media format. In
the transport stream example, the media has already been coded at least once as a
stream and contains position information. In other situations, sample position or
device position can provide timeline position. If the input device provides data at a
variable or asynchronous rate, then software timers can provide timeline position.
Sample position is position from the perspective of software, and device position
is position from the perspective of hardware. The difference is buffer time. Device
position is usually more accurate, but may not be available, or may contain errors.

Examples of media which usually has a particular type of positioning is:

1. mpeg has timestamps therefore Presentation Timestamps is a good recording
choice;

2. raw media streams/screen capture have no timestamps, so tell it time via
Software;

3. a web cam may supply data at variable rates, so again you would use Software
timing;

4. an example of Device Position is audio (timestamps can come off the device);

5. if Software Positioning working for you, try Sample Position for really bad
audio.

Other Recording settings are more pertinent to capturing and editing broadcast
television with all of its many commercials. Their usage will be explained in more
detail in a later section.
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Label create a label. During capture, put a time marker at the designated spot.
When the recording gets pulled in later for review, you will see a green arrow
marking the spot that was clicked.

ClrLbls clears all of the previously set labels.

Check for ads check for commercials. In real time, labels are added when a com-
mercial that matches a previous ad is already in the database (the TDB, Traveling
Data Base).

One other noted new feature is a new choice for recording - V4L2 MPEG. Some
digital tuners now stream mpeg data for broadcast data streams. V4l2 has been
upgraded to be able to process data from these device streams. Figure 12.2 shows
the available options to include v4l2 mpeg.

Figure 12.2: new feature v4l2 mpeg

12.2 Digital Video Broadcasting (DVB)

You can do real-time capture of a full transport stream of Broadcast TV. Record tele-
vision programs using CINELERRA-GG by setting up ahead of time to start record-
ing later at the specified time. Then you can use CINELERRA-GG to watch later
and easily fast forward through the commercials or edit the program, deleting the
commercials, to watch uninterrupted. Some details may be slightly different than
what it is in the United States. There are 3 requirements you must have to take
advantage of this capability.

1. You need to have a suitable DVB Adapter such as the Hauppauge WinTV-HVR
950Q usb adapter. Make sure it is the linux version, not the new version.
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2. Your DVB adapter on your PC should connect to a broadcast antenna input.

3. For now, you may have to run as the root user.

12.2.1 Overview

There is a lot of detailed explanation below to be thorough, but an overview is
presented here.

1. Set up Record Preferences.

2. Scan the Channels.

3. Watch TV by selecting the desired channel.

4. Or set up a batch job to record a program and watch later via Ctrl-Alt-s in the
main window.

5. Or record a currently running program by using the buttons in the Record
window.

6. Load a previously recorded program.

12.2.2 Initial Setup for DVB Capture

Listed below are the steps for the initial DVB setup. Setup will be preserved until
you make changes.

1. Start CINELERRA-GG, and click Settings→ Preferences→ Recording

2. Select File Format checkbox: Realtime TOC (Table of Contents)

• It is not necessary to set File Format at this point as it will automatically
be set later.

• Check Record Audio Tracks.
• Check Record Video Tracks.

3. Select Audio In → Record Driver: DVB

• Set the adapter path = /dev/dvb/adapter0 (probably)
• Set the adapter dev = 0 (probably)
• Set the Bits: 16 Bit Linear (probably)
• Check: Follow audio config
• Samples read from device: 2048 or approximate dev buffer size (2k−16k

probably)
• Samples to write to disk: 131072 (a good size)
• Channels to record: 2
• Uncheck Map 5.1→ 2
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• Gain: 1.0
• Uncheck: Record in real-time priority

4. Select in Video In: Record Driver: DVB (note: File Format above changes
to MPEG Stream)

• Set the DVB adapter path = /dev/dvb/adapter0 (probably)
• Set the adapter dev = 0 (probably)
• Check: Follow video config
• Frames to record to disk at a time: 30 (a good number)
• Frames to buffer in device: 2 (2− 6 probably)
• Positioning: Presentation Timestamps (this is important and may not be

already set)
• Uncheck: Sync drives automatically
• Size of captured frame: 720x480 (will automatically change)
• Framerate for recording: 29.97 (will automatically change)
• Click OK

Figure 12.3 shows the Preferences window as a good example of what you should
see.

Scan the channels once the devices are setup by performing the following.

From the main window pulldown use: File → Record (lower case r) & resize
windows.

• Two windows appear – the Recording and the Video In. The Recording win-
dow should have Monitor video checked and Monitor audio unchecked. Re-
member to check the Monitor audio later when you want to listen to a TV
program.

• On the Video In toolbar, click the antenna button (Edit channels tool tip).

• When the Channels window opens, click scan – Scan confirm window appears.

• Make sure Freq table NTSC_DVB, Norm NTSC, and input0 are chosen auto-
matically.

• Click OK and then wait for scan to end which may take several minutes.

Figure 12.4 on the left shows the Channels window and the popup waiting for scan
confirmation. On the right side is the usual Recording window with the Video in
window hidden behind.
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Figure 12.3: Example of the Recording settings

Figure 12.5 shows scanning in progress. Note the Video In with the antenna icon
(3rd symbol).

Any time after the channels have been scanned, you can edit them from the Record-
ing window channel selection dialog (shown on left of screenshot above, such as
Sort). You do not have to scan the channels every time as they are saved in a
database referred to as the channel-db.

• Click chk-OK when done scanning channels and making any edits you want.

After the channel-db is ready, you can watch any of the selectable channels.

12.2.3 Watching TV using CINELERRA-GG

If you have setup for DVB capture as outlined in the section above, just start here
to watch TV.
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Figure 12.4: Clockwise: Channels window; Video In (behind); Recording and Scan confirm

Figure 12.5: Scanning in progress (6%)
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• From the main window use File → Record to request the Recording appli-
cation.

• In the Video In window, press the down arrow on the left to see the channel
pulldown.

• Select the desirable channel, and watch TV. You will have to enable the audio
by checking the Monitor audio in the Recording window for sound.

Helpful hints: for any computer that you might choose to use that is a little slower,
you can improve the available resources for watching TV by unchecking Audio
meters, checking drop overrun frames, and checking fill underrun frames. Also,
uncheck Realtime TOC in the references → Recording window.

Dismiss the Recording window with chk-OK, or "X" to cancel when finished.

12.2.4 Recording TV to Capture at some Future Time via Batch

After the initial setup and channel scan completion, with the Recording application
down (so that the /dev/dvb/adapter0 hardware is not in use) you can scan the
DVB channel program data by pressing Ctrl-Alt-s from the main window. It can
take a minute or two to scan the channels. The resulting display is a large array
of program buttons, with tooltips which are the TV program info text.

Figure 12.6 shows Channel Info window after the Ctrl-Alt-s completes scanning TV
program data.

Figure 12.6: Channels Info window with many TV channels buttons
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Now if you mouse over a program button, you see the TV program’s info. Each
of the programs is represented by a button. If you press a button, it preloads the
program recording information into the batch record box below. In the bottom
right corner box, you should set the Directory path of where to write the recording
before pressing a button, so that the files will be written to an area of sufficient
size to handle the recording (9.5Gb/hr). The two little spinboxes on the Duration
line in the right bottom corner are leadin/leadout times to start recording a few
minutes early, and end a few minutes late to prevent losing program endpoints.
Instead of setting it to the original default of 0, you might want to start 3 minutes
(−3.00) before and stop 3 minutes after (+3.00). Also, be sure your computer
has the correct time or it will miss. Check to make sure the Start Cron option is
checked (default). The batch job will start monitoring the channel to be ready for
capture once you chk-OK and you will see the Recording window and the Video In
window come up. The computer will power off after completion if the Poweroff
checkbox is selected (not default). The job line of the active capture in the batch
bay will flash continuously once the recording is started.

In the Channel Info window, lower left hand corner above, there is a Find button
which brings up a textbox so you can type in a TV program. When you double
click on that program name, the cursor moves to the center of that program name
in the list of programs in the window, highlights that program, and the characters
that were white on black, turn yellow.

12.2.5 Recording Immediately to Capture a current TV program

If you have setup for DVB capture as outlined in the first section above, just start
here to record a TV program that is currently playing and stop it whenever you
want. Media files can be directly captured from the Recording window to include
Start, Stop, and then loaded via chk-OK.

• Bring up the Recording window via the main window File → Record (lower
case "r").

• Set the Path to the write file Path; be sure there is enough disk space (9.5Gb/hr).

• Set Mode pulldown to Untimed found in the upper left corner area of the
window.

• Press transport start recording button (red round button).

• Path will flash and update in batch window and remain flashing while record-
ing.

• Press transport stop recording button (white square button).

• Before clicking chk-OK, be sure to set the Insertion strategy.

• Pressing chk-OK attempts to load any newly recorded media data for review.
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• Or press X-cancel to terminate and dismiss the Recording application.

Figure 12.7 shows the recording of a currently running broadcast TV program
weather report.

Figure 12.7: Recording in real-time a tv weather report

12.2.6 Record “on the fly” Table of Contents (TOC)

If the Settings → Preferences → Recording tab is selected, and the video
Record Driver is changed to DVB, the file format is switched to MPEG Stream auto-
matically (note that the audio Record Driver must also be set to DVB for broadcast
recording). This kind of record stream can be captured by simply writing the hard-
ware capture stream directly to the record capture asset file path. But by checking
the Realtime TOC in the Preferences → Recording window, it is possible to
scan the stream data on the fly on its way to being written while the asset is be-
ing captured . The scan is used to generate a TOC – Table of Contents file in the
$HOME/.bcast5 directory. This file is used by the mpeg library to view the stream.
This avoids the need to scan the file on first open since the TOC builder can run in
realtime.

Figure 12.8 shows the red-checked Realtime TOC for the Record Driver of DVB.

12.2.7 Watching a Previously Recorded TV program

If you have setup for DVB capture as outlined in the section above, just start here
to watch a previously recorded TV program. Use the following steps.
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Figure 12.8: Realtime TOC check red button

• In the main window choose File → Load files and select the desired media
file to watch.

• Broadcast transport streams may consist of multiple programs that all run
together on one channel (for example 9−1, 9−2, and 9−3 are all on channel
9). Therefore when you play the recorded program back all of these programs
will play simultaneously and that is a jumble. In order to select just the one
you want, press Alt-1 in the main window to select Asset Program 1 (or "Alt-
1...8" to select the desired asset program number) which removes all of the
unrelated audio/video tracks except for the selected program. It also resets
the session to match the media.

• Move timeline to where you would like to start watching.

• Be sure the Compositor window is up and you will see the pre-recorded pro-
gram there. Use either the keyboard, a remote control that has been set up,
or Android device for controls. To toggle between fullscreen or original size,
press "f" in the Compositor window.

To watch on a large TV screen or monitor which you have connected, you will have
to setup for Dual Screen Mode as explained in the next section. In addition, you can
either use a Remote Control hardware device or special key setup for manipulating
the playback.

12.2.8 Dual Screen Mode

Dual screen mode is useful for displaying CINELERRA-GG video/project on a large
screen digital Television set or for watching a previously recorded broadcast TV
program via CINELERRA-GG. The physical configuration results in one screen (an
Xwindow) on one monitor and the other screen on the other monitor or TV screen.
Before the mode is usable for CINELERRA-GG, X has to be configured in dual screen
mode — that is, you must first split the configuration into 2 displays to operate
Dual Screen Mode. On some systems, you may be able to get to the dual screen
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mode by using Xinerama allowing for use of 2 physical displays to act as 1 virtual
display.

The main menu pulldown, Settings → Preferences → Playback A and B Tabs,
must be properly configured in order to take advantage of the Dual Screen Mode
capability.

In the main menu Window pulldown there are Tile left and Tile right options for
the 2 monitors. If you have only 1 monitor, you will see no change upon activating
these options. Tiling is possible due to the existence of one long horizontal screen
display buffer. Tile left takes CINELERRA-GG and moves all of its windows to the
2nd monitor/TV and Tile right puts it back to the 1st monitor. The left and right
monitors are the left part or right part of a Playback A/B Xwindow host referenced
in the Video Config Playback A/B for separate X screens. Shortcuts for Tile left and
Tile rights are the letters a and b on the keyboard once you have set Remote Control
mode. Below is a summary of the configuration letters:

a select playback a and tile windows left (all on monitor or laptop)

b select playback b and tile windows right (all on 2nd monitor or TV)

c select playback c and tile windows left, but composer right (TV mode) This op-
tion has the effect of taking the Compositor window and moving it to the 2nd

monitor/TV without the surrounding borders interfering with the video.

Since Dual Screen Mode is most widely used for either a demonstration or watch-
ing TV, you will want to take advantage of Remote Control mode as described in a
following section. In the camera shots below, note the square red box that shows
up in the upper left hand corner of the Viewer window (arrow pointing to it but
it looks more orange than red) which denotes that the Application/Menu key was
used to get into Remote Control mode.

Figure 12.9 shows 2 monitors (could just as well be a big-screen TV for the second
monitor) with Tile left where all of the CINELERRA-GG windows are on the left
most monitor. The big red arrow points to the little red square box indicating that
Remote Control mode is in effect.

Figure 12.10 shows 2 monitors with Tile right (b key) where all of the CINELERRA-
GG windows are on the right monitor. The left monitor shows the Suse distro logo
and a couple of xterm type windows.

Figure 12.11 shows 2 monitors with Compositor window on the 2nd monitor
which was obtained through use of the “c” keypress available when in Remote
Control mode.
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Figure 12.9: Dual screen - initial

Figure 12.10: Dual screen - CINELERRA-GG and desktop on different screens

Figure 12.11: Dual screen - CINELERRA-GG compositor on own screen windowed

Figure 12.12 shows 2 monitors with Compositor window on the 2nd monitor in
Fullscreen mode so that no CINELERRA-GG borders are visible to distract from the
picture. The big red arrow points to the little red square box indicating that Remote
Control mode is in effect.

12.2.9 Remote Control for DVB

CINELERRA-GG DVB recording/playback can now easily be done in couch potato
mode using a remote control. This comes in handy when you want to playback on
a big TV screen for multiple person viewing. You can use the Application/Menu
key on the keyboard to toggle between standard CINELERRA-GG usage or a Dis-
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Figure 12.12: Dual screen - CINELERRA-GG compositor on own screen full screen

patcher methodology through use of a remote control, an Android programmed
device such as a tablet, or keyboard. The Application/Menu key on most key-
boards is between the Alt and Ctrl keys on the right hand side bottom and depicts
a menu on it either with or without a pointer (see image below). An ati-x10 Re-
mote Control device (figure 12.13) is currently working with CINELERRA-GG and
other remote controls may work but have never been tried. The red/orange box
on the top left main screen of CINELERRA-GG indicates Dispatcher Method access
is activated which allows for keyboard grab which routes all key strokes until tog-
gled off. Below are the currently defined operations.

Remote Control Keys (Application/Menu key toggle for ati-x10 remote)
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up arrow = forward 1 minute
down arrow = forward single frame
left arrow = forward slow playback
right arrow = forward normal playback
d = toggle channel scan menu
f = toggle full screen
a = select playback a and tile windows left (all on laptop)
b = select playback b and tile windows right (all on TV)
c = select playback c and tile windows left, but composer right (TV

mode)
0–9 = select timeline by 1/10s from beginning to end
a = toggle audio mute
m = toggle audio meters
keypad / = display mpeg ts stream program data
keypad * = display mpeg ts stream channel schedule date
keypad + = change channel, next
keypad - = change channel, prev
keypad . = start channel change by numeric entry
keypad .. = clear channel entry
book key = toggles channel scan (always available)
hand key = terminates CINELERRA-GG (always available)

Figure 12.13: Ati-x10 Re-
mote

Plus usual Transport keys:

e = ??
f = toggle full screen
« = fast reverse
> = toggles normal playback
» = fast forward
red o = slow reverse
square = stop
2 lines = fast reverse

The Application/Menu key is used to get
into remote control mode, even if there is no remote
control hardware device in use, allowing for use of the
same defined remote control keys to work on the key-
board. Once the Application/Menu key enables remote
mode, the remote control keys don’t allow the standard
CINELERRA-GG keys to work.
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12.2.10 Android Remote Control for DVB

CINELERRA-GG INFINITY has Android remote interface
code (figure 12.14). Any device, such as a tablet or
a phone, can be used as long as it is running the An-
droid operating system. Programming an Android Re-
mote Control for DVB is a bit complicated at first, but
becomes pretty simple after a bit.

1. The Android Remote Control requires you to
download and install the Android CineRmt app
package (apk). To install it simply download it (any way you can) to your
phone or tablet and click it to install, if it doesn’t run automatically.

2. In CINELERRA-GG, open Settings → Preferences
→ Interface tab, and enable Android Remote Con-
trol in the Operation section using the checkbox.
The default port 23432 and default PIN value cinel-
erra are OK.

3. After you install the new phone/tablet app in step
1, start it up from your apps menu.

Figure 12.14: Interface tab shows Android Remote Control

Before you can use it, the Android device must have the ip address of your com-
puter entered into the configuration menu. The PC you are running CINELERRA-GG
on and the Android device have to be on the same network. You can tell it is in
communication by tapping the Power (menu) button. When the remote is oper-
ated with the Power (menu) button, there is a little orange box on the upper left
corner of the display to indicate the remote state is active. If you do not see the
little orange box when the menu key is tapped, the communication is broken and
must be fixed before proceeding. Follow the directions in the paragraph below.
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BIG NOTICE: the firewalls in your computer and wifi router can stop this thing
dead. Re-configuring a firewall is tricky and varies from distro to distro. If possible,
during setup it is suggested that you disable the firewall temporarily. For those with
advanced skills, use tcpdump or wireshark to look for udp messages from the IP
address of the device.

SECTION NOT COMPLETE – (manualandroid)

Figure 12.15 shows an Android Tablet that can be used as a Remote Control for
CINELERRA-GG Recording and Playback.

Figure 12.15: A Tablet with Android Remote Control

12.2.11 Setup a Remote Control Device

SECTION NOT DONE !! This section explains how you can take your own brand of
remote control and set it up to easily work the way you want with CINELERRA-GG.
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12.3 The commercial DB

While watching broadcast television, it is possible to use CINELERRA-GG to auto-
matically mute commercials being aired during a broadcast capture. Visual mut-
ing as well as sound muting is done! You can NOT use ffmpeg for the format
when working with the commercial DB. This database that was added is a novel
architecture shared memory database, a Traveling Data Base (TDB). With TDB you
have direct access to the shared database presence (instead of having to go to the
server).

Basically it works as follows, but there are a few differences in just how it goes
about it:

1. Identify a zone in a timeline as a commercial.

2. Characterize it concisely, in the audio and video timeline.

3. Store the characterization in a database.

Then, when capturing media or building a table of contents for an mpeg transport
stream (broadcast capture DVB):

1. Characterize each I-Frame (a few frames per sec).

2. Search the database in real-time to identify the image.

3. If a match is identified, automatically press the mute button.

4. Unmute if the pattern match fails, or the commercial ends.

It mostly works, but it takes more time to setup and maintain the database as the
advertisements change frequently or vary by a small amount. It would take a small
set of personnel to keep the database current and some finessing of the code.

Currently, to activate the commercial database (db) methods you must do the fol-
lowing as root:

cd <cin-path>/bin
mkdir /cinelerra #yes, currently only in the / filesystem
./cin_db /cinelerra/media.db #to create a new empty commercial capture database
export BC_USE_COMMERCIALS=1 #in the command shell that is starting \CGG{}

This activates the gui tools and database access. As of yet, all of the requisite per-
mission changes necessary to run as non-root have not been worked out (initially
just easier to run as root).
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When a commercial is cut, the following occurs:

1. transmits the capture timeline fragment to /tmp

2. scans the snip to characterize it statistically

3. creates a miniature b/w movie of the beginning and end

4. stores all of this into the media.db

There are 2 ways currently to identify a commercial:

1. Load mpeg3 transport media, highlight select the commercial in the timeline,
and press cut commercial on the toolbar.

2. Use the remote control interface to indicate the boundary in/out cut points
in the realtime capture timeline, and operate a cut command.

The cut command creates a popup to let you know that it is processing the captured
data. This can take several seconds depending on the size and media format. The
results from the scan are stored in a new record in the media.db.

The stats are somewhat disappointing. Image recognition is way past zero, it is not
100 percent. Broadcast streams have tons of minor variances which hamper dig-
itally perfect reproduction from instance to instance of commercial presentation.
This puzzle remains to be solved.

To review media stored in the media.db, and delete old expired commercial data
records, press (Shift-M) from the main window. This will create a media-db win-
dow which shows the various captured samples stored there.

Currently, only a customized ati-x10 (kernel mod required) radio remote control
works. But this can quite readily be modified for other remote control models.

12.4 Transfer VHS/DVD Media into CINELERRA-GG

If you want to transfer the data on a VHS tape or DVD disc into CINELERRA-GG,
you can do so by playing the media and recording while playing. This captures
the media, which you are able to view as it plays, and writes it to a file so it can be
played directly or edited. Because there is so much variation in hardware on both
the Computer side and the Media Player side, these how to directions are only a
guideline. You will most likely still have to do some experimentation and testing
to see what works for you.
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12.4. Transfer VHS/DVD Media into CINELERRA-GG

The basic strategy consists of 3 operations: connect the relevant outputs to rep-
resentative inputs, configure the capture card to match the video, and start the
Record monitor. Each of these may have to be experimented with to get them
correct for your hardware setup.

Step 1: Connect both audio and video from your player hardware to the sound
board and/or the capture card of your computer. Sometimes the capture card
handles both audio and video but oftentimes audio and video are hooked up sep-
arately.

For example in a test case using the CX23418 capture card (an older/unusual single
chip MPEG-2 encoder with integrated analog video/broadcast audio decoder), one
end of an S-Video cable was plugged into the back of a DVD player and the other
end plugged into this computer’s Capture card; the audio was plugged into the
line in on the computer sound card.

Step 2:Setup CINELERRA-GG and it might be best the first time if you start with a
default .bcast5 file by using a command line from a window of
CIN_CONFIG=$HOME/bcast6 cinelerra_path/bin/cin

• Choose Settings → Preferences → Recording tab in the Preferences
menu (figure 12.16).

• Choose a File Format – a common suggestion is ffmpeg with a file type of
mp4. In some cases depending on your capture card, the File Format will
be set to MPEG stream capture. Some formats support MPEG stream capture
technique, otherwise the data has to be decoded first and then encoded.

• Check that the Audio In section has the Record Driver set to Alsa with Device
set to default as the Capture Source. If you are using something besides Alsa,
change that selection accordingly. This may not always be default and you
may have to change to something else based on your specific hardware. It
has to match up what you see in our Control Panel on your computer. So for
example, if your device is HDMI, than the default could be HDMI. . . instead.

• In the Video In section, change the Record Driver to whatever makes sense for
your capture card. The test case for the CX23418 would use Video4Linux2
MPEG. If unknown what your card uses, you should experiment with Video4Linux2
or Screencapture as good possibilities.

• Also, Device path should be verified to be correct in case you have more than
1 device.

Step 3: Next use the File pulldown to choose Record and then the Recording menu
will popup (figure 12.17).
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12.4. Transfer VHS/DVD Media into CINELERRA-GG

Figure 12.16: Example of the Preferences menu with the Recording tab highlighted

• Click on the Antenna icon (3rd icon from the left on the left side of the right
hand screen window).

• In the popup Channels menu, click on Add which brings up the Edit Channel
menu.

• Use the down arrow in the Input box to display the available options. In the
test case, and very likely your case too, S-Video 1 should be picked.

• In the Recording menu, be sure to designate a complete path and filename
in the Path: textbox which will be used to record/write the playing media.
Remember you must have the media on a file in order for CINELERRA-GG to
load it on the timeline for editing purposes.

• Then highlight S-Video in the Channels Menu. Again, the choice in the Chan-
nels Menu might not be S-Video – choices could vary widely. Start recording
in your Recording menu by clicking on the second icon from the left, next to
the Transport label (it is usually a round red colored button).

• Next press play on your media hardware device. If on the Video In side win-
dow you see only noise, then S-Video or something else was an incorrect
choice and you will have to perform some tests to find correct choices.
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12.4. Transfer VHS/DVD Media into CINELERRA-GG

Figure 12.17: Example of the Recording, Video In, and Channels, along with the Add option,
menus.

There are many more parameters that you may want to vary in the Recording
menu or for more details on various items, please refer to the section Record Web
Media in real-time. The Transport buttons are well defined there also.

Step 4: When the media has finished playing, use the Stop icon on the Recording
menu – the fourth icon next to the Transport label - to stop the recording (fig-
ure 12.18).

Now you can Load the file that you played and recorded via the Insertion strategy
choices on the bottom of the Recording menu and edit the file as usual. Note, that
the audio and video may have started at slightly different times so you might have
to initially line them up at the beginning using nudge. Generally once they are
correctly aligned they will stay that way. Nudge is in the expanded patchbay. The
nudge value is the amount the track is shifted left or right during playback. The
track is not displayed shifted on the timeline, but it is shifted when it is played
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12.4. Transfer VHS/DVD Media into CINELERRA-GG

Figure 12.18: Recording menu and Video In screen while capturing media. Note the Transport
stop option.

back.
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CHAPTER 13

DVD and Bluray Creation

This section describes how to create a blu-ray DVD, or BD referring to a Blu-ray
DVD, and a regular DVD, or SD referring to a Standard DVD. The DVDs (plural us-
age of DVD means either BD or SD) created are unencrypted, unlike commercially
available movie DVDs. This CINELERRA-GG version conceivably can create differ-
ent variations of DVD/Blu-ray media but for the casual user the most standard
usages are readily usable and will be described here.

Some preliminary information follows. For NTSC, SD media is almost always 720×
480 interlaced (the format in the United States, US). For PAL, SD media is almost
always 720 × 576 interlaced (Europe, EU, and most of the world). An SD can
conceivably be created with a lower resolution – for example 352× 240 MPEG-1
– but it is not useful. Aspect ratio for either NTSC or PAL can be 4 : 3 or 16 : 9.

Frames per seconds is usually 29.97 for NTSC and 25 fps for PAL. The standard SD
dvd generally uses the MPEG-2 program stream with a filename extension of m2v.
BD blu-ray media is not normally interlaced, but you can leave it interlaced. Blu-
ray uses the MPEG transport stream which contains 1 or more program streams
with a default filename extension of m2ts.

Requirements for creating DVDs is the hardware device to write the media on and,
obviously, the blank media for either BD or SD. When generating SD media, you
will have to install dvdauthor and for BD media, install udftools if they are not
on your system. Also, keep in mind that to mount filesystems for creating files
and to burn DVDs, you will have to be root since you have to have privileges,
unless special permissions have been provided for a non-root user. It is also highly
recommended to run the CINELERRA-GG startup from a terminal window, instead
of the icon, in order to see informative messages of how to actually write the output
(at prompt: keyin <install_directory_path/bin/cin).

A warning here – writing blu-ray BDs and regular SDs can take a large amount of
clock time. Keep in mind that a blu-ray can contain 25 hours of viewing, so would
take multiple hours to just write one.

The max disk space needed is a little over 100GB for 50GB Double Layer (DL)
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media or 50GB for a single layer BD blu-ray. A standard SD of 4.7GB needs about
10GB disk space. You probably can get by with much less if the render for blu-ray
is less than 25 hours of media. You will need twice as much disk space as the
media holds to ensure you have sufficient space for working and copying.

The most important thing you need to know about in order to get started is For-
mat and Scale in the Create dvd or bd window. Format settings shown in the Set
Format window are set accordingly to an algorithm. Basically, it will take whatever
you say in the asset format. It matches that against the known Presets available
so that is what will be shown. If the asset format doesn’t match any of the Presets
default formats, then that will be shown as the User Defined format. In addition
when you load media, the format is initially set to same as source so matches the
source input and if that matches a known preset, then that is what is shown. The
PAL versus NTSC only comes into play when there is no known correct matching
format when you attempt to create a DVD Render batch job. It is applied when
you click OK. For example, if you load up a YouTube video, it will not match any
known format and will choose PAL or NTSC based on time zone.

Figure 13.1 shows pulldown Presets in Set Format window:

Figure 13.1: When choose PAL, values get changed in window to reflect PAL

A quick set of basic steps to create DVDs is immediately below and usually just
using the defaults will get you something. However there is a serious issue with
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interaction between the Operating System and bdwrite when creating a BD/blu-
ray that requires automount to be turned off. Refer to the details and more specific
explanations below the following steps for how to do this.

1. If not logged in as root, you will get an error message in order to avoid doing
a lot of work and then failing out because root is required for automount and
to write on DVD hardware.

2. Load your input source media via: File → Load files.

3. Choose PAL or NTSC for SD/dvd or 1080P/24 for blu-ray in Settings →
Format.

4. For blu-ray, choose BD Render or for PAL/NTSC, choose DVD Render in File
menu.

5. Designate a work path with sufficient disk space and then Chk-OK.

6. When the Batch Render window comes up, click on Start and the batch jobs
will run.

7. Read the final messages echoed to the screen to see the command for burn-
ing. . . OR:

8. Use the provided directory name to:
cd /<target directory>bd_(or dvd_)<date-time>

9. Load your media, format if needed, note device name to substitute for <bd>
or <dvd>

• If rewritable blu-ray, use
dd if=./bd.udfs of=/dev/<bd> bs=2048000

• If write-once blu-ray, use
growisofs -dvd-compat -Z /dev/<bd>=./bd.udfs

• If any DVD media, use
growisofs -dvd-compat -Z /dev/<dvd> -dvd-video ./iso

Any problems encountered will require that you read more information in this
section to include specific details, helpful hints, and problem resolution.

Details and specific explanations to create blu-ray or regular DVD are provided
here. It is very advantageous to startup CINELERRA-GG from the command line
prompt instead of the icon. Also, please be root or your hard work will be lost
when the automount is issued and fails for bluray udfs mounting.

The general design of the DVD/blu-ray generation operations is to first render
media using batch rendering and then terminate CINELERRA-GG to start a script
which creates the target device filesystem data. These scripts are the dvd.sh and
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bd.sh scripts written into the target directory. For DVD, the general plan is to
write a directory <target>/iso with the dvd filesystem via dvdauthor and then
generate an iso9660 filesystem and write it to a dvd via growisofs.

For blu-ray, the filesystem generation is slightly harder. First, it creates an empty
filesystem image <target>/bd.udfs using mkudffs which makes a big hole for
the filesystem data. The hole is made just a little bigger than the data written
by bdwrite so that you don’t have to write an entire 25GB or 50GB disc even if
no data exists. This empty filesystem is loopback mounted to make it writable,
and the linux kernel manages the filesystem image. The bdwrite program applies
the blu-ray structure to the UDF filesystem by creating the needed BDMV blu-ray
filesystem, which the kernel stores onto the image file bd.udfs. When udfs is
unmounted, the kernel finalizes the disk image on bd.udfs. The bd.udfs image can
be written directly to a blu-ray disk via dd or growisofs.

NOTE of IMPORTANCE: there is a serious situation with the interaction between
the Operating System (OS) and bdwrite when creating blu-ray, that requires auto-
mount to be turned off. The blu-ray automatic script unmounts the blu-ray/UDF
filesystem but the system has not finalized the directories so the OS creates a new
loop file device and the data is loaded and cached for use by the new loop but it is
stale. Consequences is that not all of the data is written where it should be. The
solution is for the OS not to mount this second mount so we have to make sure
it doesn’t. There are 2 methods to fix this. The first and easiest is by using the
following command to disable automount:

gsettings set org.gnome.desktop.media-handling automount false

This can be reversed when you have completed the blu-ray generation via:

gsettings set org.gnome.desktop.media-handling automount true

A different and more complicated method you can use to turn off automount is to
download and install the dconf-editor. Automount is a system parameter and only
needs to be done once unless you do not want automounts to always be disabled.

1. run: dconf-editor

2. select: org → gnome → desktop → applications → media-handling

3. uncheck: automount

4. close dconf-editor window
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Immediately below are the detailed steps with explanations for creating SD or BD
media.

Step 1: Construct a session with the desired presentation:

• Format frame rates choices are 29.97 or 25 for SD, based on the user’s time-
zone, with NTSC 29.97/US or PAL 25 /EU. For BD, the media input will be
analyzed to automatically pick the default format or if unknown, the user’s
timezone will be used to default to 1920/29.97i for US or 1920/25i for EU.
Be sure to set the rendering parameters in the settings → format menu.

• Choose audio stereo or 5.1, again depending on your media.

• Target Geometry will be 720× 480 (US) or 720 (EU) for SD.

Step 2: From the main window, select file → BD Render or select file → DVD
Render (figure 13.2). Then:

BluRay (scale pulldown) DVD (format pulldown)

Figure 13.2: BD Render and DVD Render

(Note: both the BD and the DVD windows above, show insufficient space, disk
space: in red)

• Select desired features, check/un-check as appropriate.

• Click OK check button. It is very important to realize that when you check
OK, the EDL will be saved and that will be used for batch job rendering.
If you bring up the Batch Render and then change some parameters, they
will not take effect UNLESS you remember to either check Save to EDL Path
or Use Current EDL in the Batch Render window. You will get a reminder
automatically if warn if jobs/session mismatched is checked.

Explanation of the choice boxes as seen in figure 13.2 for both SD and BD menus is
given below. Many of them are plugins which allow you to further manipulate the
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settings for best results. They are just suggestions set by the program automatically
based on your input media, and can be reset to suit your needs. These are listed
in the next 4 points.

1. If the media does not match the DVD target geometry, and the scale plugin is
not already in use, then the scale plugin is applied with scaling set to fit the
media dimensions to the DVD format target geometry.

2. If the video height is at least twice the DVD height and the input media is
interlaced, then the deinterlace plugin is applied with odd line sampling.

3. Audio 5.1 will automatically be set to the wide-audio if you have 6 tracks of
audio.

4. To allow video data to be accessible and overlay properly, the track buffers are
resized to the largest track frame size in use (Resize Tracks). The theory behind
this is to make sure to have enough memory to cover the entire presentation
for transcoding.

All of the current choice boxes are further defined immediately following.

Deinterlace remove the interlace. Interlacing is a video scanning system in which
alternating lines are transmitted so that half a picture is displayed each time
the scanning beam moves down the screen. You lose a lot and the quality
is bad when you view interlacing on a progressive TV. You might not really
want to use deinterlace, because if you deinterlace non-interlaced media, it
will look awful.

Scale alter the spatial mapping of an image to increase or reduce the size; mod-
ifies the picture. When some programs scale from 4 : 3 to 16 : 9 they will
automatically cut off the appropriate section of the image for you. It is nec-
essary to keep in mind, that square pixels is the true end goal of scaling, not
the aspect ratio which could result in squished or stretched output. More
information about scaling will be provided on a subsequent page with usage
of the Scale Ratio plugin.

Histogram remaps the color space. The color space ranges from 0−255 for 8-bit
color values. You can use this tool to remap the color space to use the entire
space or for stretching the contrast. Also, it lets you perform global color-
correction on the image. You can use this to correct for color screens that are
too blue, or for color Televisions that produce brownish output, or whatever.
In addition to color-correction, you can use the RGB modification tool to add
color to images that didn’t have color to begin with. For instance, you can
pseudo-color greyscale media.

Inverse Telecine the reverse of 3 : 2 pulldown where frames, which were du-
plicated to create 60-fields/second video from 24-frames/second film, are

398



removed. MPEG-2 video encoders usually apply an inverse Telecine process
to convert 60-fields/second video into 24-frames/second encoded video. The
encoder adds information enabling the decoder to recreate the 60-fields/second
display rate. Telecine, i.e. 3 : 2 pulldown, is used to transfer film to video.
That’s where the 3 : 2 ratio comes in. To ensure that there will consistently
be 60 frames per second, the first frame is displayed on the TV screen 3 times
and the second frame is displayed 2 times. The following frame is repeated
3 times, the next one 2 times, etc. throughout the film. For inverse telecine,
you show 2 of the film frames for 3 of output frames. Only check Inverse
Telecine if you have film or something that is 24 f ps and want to project to
30 f ps (most likely this will never be necessary).

Audio 5.1 6 channel surround sound. For most home systems, uses five full band-
width channels and one low-frequency effects channel. Could automatically
get set as explained previously.

Aspect Ratio aspect ratio may be automatically set to 4 : 3 or 16 : 9. Aspect ratio
would better be defined as the size of the display, monitor, or TV which will be
used to view the output. If you measure your old TV, which supposedly is 4 : 3
and your latest digital TV, which is supposedly 16 : 9, you will see that those
ratios aren’t always correct anyway. Then measure your laptop monitor, your
desktop monitor, and your neighbor’s, and lo and behold, the ratios don’t fit
either of the purported standard aspect ratio. Maintaining square pixels via
scaling is more important in the long run.

Use FFMPEG this is user’s choice; it is recommended and faster but more difficult
to modify due to numerous options. For blu-ray, ffmpeg must be used and is
not an available option.

Resize Tracks change track width and height as explained previously. The size is
adjusted to the largest frame size needed.

Chapters at Labels without this checked, chapters markers are automatically in-
serted every 5 minutes. The chapter labels can then be skipped to when play-
ing the DVD. If instead, you want to put labels in at opportune times, you
will have to run dvdauthor outside of CINELERRA-GG and mark the chapter
labels yourself by hand. In that case, you should checkbox Chapters at Labels
so that the automatic 10-minute labels are not created. This checkbox is not
currently available for blu-ray.

Figure 13.3 shows on the upper right side the Create DVD window with Deinterlace,
Histogram and Resize Tracks checked. Also Scale is set to Scaled. Once the green
checkmark is clicked, the Batch Render window comes up and in the main window
you will see the 3 plugins below the video track on the main window. By clicking
on the magnifying glass that appears on the rightmost side, the controls for each
will popup and you can make any necessary adjustments. Note the numerous
choices for Deinterlace; the Value, Red, Green, and Blue for color adjustments
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Figure 13.3: check Deinterlace; Histogram and Resize Tracks

in the Histogram window; and Scale Ratio popup menu for numerical settings
control.

The Scale parameter gives you a lot of flexibility. A default based on your input
media is provided for you but possible choices are None, Scaled, Cropped, Filled,
Horiz Edge, and Vert Edge. You will have the opportunity to manipulate the desired
results in the Scale Ratio window. Values for W (width), H (height), and X/Y
coordinates are the number of pixels. For example, if video is 720× 432, that is
obviously 720 pixels by 432 pixels and this would be the values for Dst W and for
Dst H. So if you have some media that is off center you can crop by changing the
SRC Y value AND then change DST X/Y to non-zero. It will become the output
origin. To see what it does, change them from 0.0 to 400.0 and you will see big
changes in the compositor window.

For example, if you have the Cropped choice for the Scale, you will want to ma-
nipulate the ScaleRatio plugin (the magnifying glass on the main window video
track) which brings up the Scale window. For cropped top instead of crop both top
and bottom, modify the Src Y. As you change the Y scale, you will see the cropping
take place in the Compositor.

Scaling options are provided in order to preserve image aspect ratio. To determine
which scaling option to use, it is important to correctly identify your source/des-
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tination video aspect ratios. Next is a short explanation of possible options.

None do not do any scaling. The destination output matches the source input.
There is no resizing.

Scaled do not use uniform scaling on X and Y. Just make it fit and you will might
end up with squishing/stretching in one direction or the other in order to do
that. This happens when the input aspect ratio is different than that displayed
on the output.

Cropped removes outer edges of a source image in order to fit the image on the
output display. This is done in order to maintain uniform geometry scale
on the destination display without being affected by the particular factor of
original media aspect ratio. Since cropping omits image area, and the areas
which you wish to view may not be viewed when the image is centered, you
can pan the image source using the Src X/Y to modify which area is in view.
You can also think of this as scaled up.

Filled the entire output display will be filled with image content but in order to
do so, some of the image may have had to be cut. Any mismatch between
the two will be filled with black. Centering of the image can be modified by
using the Dest X/Y variables in the Scale Ratio controls. You can also think
of this as scaled down.

Horiz Edge this indicates preserving of the Horizontal edge.

Vert Edge this option preserves the Vertical edge.

Horizontal and Vertical are duplicates or restatement of same functionality as
Cropped or Filled but are provided as options to accommodate different ways of
thinking. In any case, you can choose which outer edges of the image to crop by
using the Show Controls of the Scale Ratio plugin. For example, you can ensure
that no action is lost by displaying the center of the screen only or making sure
that any textual information on the bottom is not lost by cutting only the top off.

Step 3: Batch render menu appears with m2ts format selected for blu-ray or dvd
format selected for regular/standard DVD when File Format selected is ffmpeg in
the previous Create DVD menu. It will work just fine without selecting ffmpeg for
DVD and may be advantageous not to. Using the audio/video wrench tools (you
will have to have the video batch job highlighted to manipulate the video or audio
batch job for audio).

• Setup the audio bitrate (192000 recommended). Data rate is 192K default.

• Setup the video bitrate (6000000− 12000000 recommended). 10M b/sec is
the current default.
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• Click OK check button.

The default bitrate is the largest value possible. The actual target bitrate is cal-
culated based on a formula from the blu-ray/DVD code. It divides the media size
(in bits) by the video time (in seconds) to find the bitrate that will just fit on the
target media. This could create a weird bitrate if the media is large, and the video
time is small, so the default/target bitrate is limited to 10M b/s.Batch jobs are then
built and appended to the job list. Once these batch jobs are built, if you make
any changes, you have to start over. You will see listed the batch jobs that are
created to perform the rendering/tasks – 2 jobs for blu-ray, one for audio/video
processing and one for the scripts. There will be 3 batch jobs created for DVD when
not using ffmpeg to include one each for audio and video and then one more for
the scripts. When you click on start, it fires off those jobs and you will see the
rendering main window progress bar in the bottom corner reflecting the fact that
it is currently processing. Be aware that the CINELERRA-GG program will be to-
tally shutdown AFTER the batch jobs finish. Screenshot below shows BD blu-ray
creation with 2 batch jobs queued up and ready to go.

Figure 13.4 for DVD and Figure 13.5 for BD shows a creation render ready to
be started. Note that because it is not ffmpeg, the processing of video is done
separately from audio. If you need to modify the video tracks, which you can see
is ghosted out, you need to highlight the first batch job listed. Be sure to highlight
the first batch job before pressing Start so it runs all of the jobs and be sure the X
for job enabled is set.

Figure 13.4: Batch render for DVD creation
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Figure 13.5: Batch render for BD creation

When you click on start, it fires off those jobs and you will see the rendering main
window progress bar in the bottom corner reflecting the fact that it is currently
processing. Be aware that the CINELERRA-GG program will be totally shutdown
after the batch jobs finish and you will be at the command line prompt.

This will produce a new directory in your target path which contains a filesystem
image file. For example:
/TargetDirectory/bd_20150820-093747
Directory and file names should not be changed at this time because the scripts
and programs rely on the given names in order to proceed. You can change them
later for your own purposes.

If bluray to test the filesystem you just created, use the command line interface;
loopback mount the filesystem image which was generated in the target directory.
For example if blu-ray:

cd /TargetDirectory/bd_20150820-093747/
mount -o loop,ro ./bd.udfs ./udfs
#check the media using a compatible media rendering tool like ffplay
umount ./udfs...

To burn blu-ray media you will need to run from the command line interface.
In the examples below, /dev/bd represents your blu-ray writer device (for exam-
ple: /dev/sr1) and /dev/dvd represents your dvd writer device (for example:
/dev/sr0).
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Blu-ray Media

For rewritable blu-ray (recommended) (BD-RE):

Note: unwritten (virgin) media must be formatted first using:

dvd+rw-format /dev/bd #only done once and does not take very long

To write or rewrite rewritable blu-ray media:

cd /TargetDirectory/bd_20150820-093747/
dd if=./bd.udfs of=/dev/bd bs=2048000 #the growisofs command below also works

To write blu-ray write-once media: (BD-R) (no pre-formatting needed):

cd /TargetDirectory/bd_20150820-093747/
growisofs -dvd-compat -Z /dev/bd=./bd.udfs

DVD Media

For rewritable DVD (DVD+RW):

Note: unwritten (virgin) media must be formatted first using:

dvd+rw-format /dev/dvd #only done once and does not take very long

To write a DVD, load blank media and run the following from the command line
(requires dvdauthor):

cd /TargetDirector/dvd_20160404-175416
growisofs -dvd-compat -Z /dev/dvd -dvd-video ./iso

Figure 13.6 shows the availability of 4:2 :2 for a Batch Render seen by clicking on
wrench icon.

Figure 13.7 shows the availability of 10-bit high quality 4:2 :2 for a Batch Render
seen by clicking on wrench icon. You need specially compiled CINELERRA-GG in
order to use the x265 10-bit as opposed to 8-bit.

404



Figure 13.6: Video options for bluray yuv422p

Figure 13.7: Video options for bluray yuv422p10
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13.1. Output Terminal Messages from Creating DVDs

13.1 Output Terminal Messages from Creating DVDs

Below are examples of what the batch jobs generate and you will see on the termi-
nal screen if you started the CINELERRA-GG program in the recommended manner
from a terminal window. It is just informational but will let you know if errors.
In looking at any of the output, you can safely ignore the errors that read Unsup-
ported codec with id 100357 for input stream 0 – this comes from nav-data (navi-
gation data). The first 2 examples are seen from running the batch jobs; the last
2 are from the single line execution which records the media output to the DVD
hardware.

SD Example: Partial Output during CINELERRA-GG run

...
FFMPEG::open_decoder: some stream times estimated
Render::render_single: Session finished.
FFMPEG::open_decoder: some stream times estimated
Render::render_single: Session finished.
running /tmp/dvd_20160407-113530/dvd.sh 1 /tmp/dvd_20160407-113530
INFO: [mplex] mplex version 2.1.0 (2.2.7 $Date: 2012/11/17 01:55:16 $)
INFO: [mplex] File /tmp/dvd_20160407-113530/dvd.m2v looks like an MPEG Video

,→ stream.
. . .
INFO: [mplex] MUX STATUS: no under-runs detected.
DVDAuthor::dvdauthor, version 0.7.1.
Build options: gnugetopt graphicsmagick iconv freetype fribidi fontconfig
Send bug reports to <dvdauthor-users@lists.sourceforge.net>

INFO: default video format is NTSC
INFO: dvdauthor creating VTS
STAT: Picking VTS 01

STAT: Processing /tmp/dvd_20160407-113530/dvd.mpg...
STAT: VOBU 32 at 15MB, 1 PGCs
INFO: Video pts = 0.133 .. 22.789
INFO: Audio[0] pts = 0.133 .. 22.789
STAT: VOBU 46 at 21MB, 1 PGCs
CHAPTERS: VTS[1/1] 0.000
INFO: Generating VTS with the following video attributes:
INFO: MPEG version: mpeg2
INFO: TV standard: ntsc
INFO: Aspect ratio: 16:9
INFO: Resolution: 720x480
INFO: Audio ch 0 format: ac3/6ch, 48khz drc, ’en’
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13.1. Output Terminal Messages from Creating DVDs

STAT: fixed 46 VOBUs
INFO: dvdauthor creating table of contents
INFO: Scanning /tmp/dvd_20160407-113530/iso/VIDEO_TS/VTS_01_0.IFO
To burn dvd, load blank media and run:
growisofs -dvd-compat -Z /dev/dvd -dvd-video /tmp/dvd_20160407-113530/iso

BD Example: Partial Output during CINELERRA-GG run

...
FFMPEG::open_decoder: some stream times estimated
Render::render_single: Session finished.
+ PATH=/usr/lib64/ccache:/usr/local/sbin:/usr/local/bin:/usr/sbin:/usr/bin:/root/

,→ bin:/mnt0/build5/cinelerra-5.1/bin
+ mkdir -p /tmp/bd_20161224-162059/udfs
++ du -sb /tmp/bd_20161224-162059/bd.m2ts
++ sed -e ’s/[ ].*//’
+ sz=19811904
+ blks=13769
+ mkudffs /tmp/bd_20161224-162059/bd.udfs 13769
start=0, blocks=16, type=RESERVED
start=16, blocks=3, type=VRS
start=19, blocks=237, type=USPACE
start=256, blocks=1, type=ANCHOR
start=257, blocks=16, type=PVDS
start=273, blocks=1, type=LVID
start=274, blocks=13238, type=PSPACE
start=13512, blocks=1, type=ANCHOR
start=13513, blocks=239, type=USPACE
start=13752, blocks=16, type=RVDS
start=13768, blocks=1, type=ANCHOR
+ mount -o loop /tmp/bd_20161224-162059/bd.udfs /tmp/bd_20161224-162059/udfs
+ bdwrite /tmp/bd_20161224-162059/udfs /tmp/bd_20161224-162059/bd.m2ts
+ umount /tmp/bd_20161224-162059/udfs
+ echo To burn bluray, load writable media and run:
To burn bluray, load writable media and run:
+ echo for WORM: growisofs -dvd-compat -Z /dev/bd=/tmp/bd_20161224-162059/bd.

,→ udfs
for WORM: growisofs -dvd-compat -Z /dev/bd=/tmp/bd_20161224-162059/bd.udfs
+ echo for RW: dd if=/tmp/bd_20161224-162059/bd.udfs of=/dev/bd bs=2048000
for RW: dd if=/tmp/bd_20161224-162059/bd.udfs of=/dev/bd bs=2048000

SD Example – Partial Output during writing disc media
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growisofs -dvd-compat -Z /dev/sr0 -dvd-video /tmp/dvd_20161224-160756/iso
WARNING: /dev/sr0 already carries isofs!
About to execute ’mkisofs -dvd-video /tmp/dvd_20161224-160756/iso | builtin_dd of

,→ =/dev/sr0 obs=32k seek=0’
I: -input-charset not specified, using utf-8 (detected in locale settings)
75.62% done, estimate finish Sat Dec 24 16:09:51 2016
Total translation table size: 0
Total rockridge attributes bytes: 0
Total directory bytes: 4096
Path table size(bytes): 42
Max brk space used 1a000
6624 extents written (12 MB)
/dev/sr0: "Current Write Speed" is 4.1x1352KBps.
builtin_dd: 6624*2KB out @ average 0.7x1352KBps
/dev/sr0: flushing cache
#

BD Example – Partial Output during writing disc media

growisofs -dvd-compat -Z /dev/sr0=/tmp/bd_20161224-155658/bd.udfs
Executing ’builtin_dd if=/tmp/bd_20161224-155658/bd.udfs of=/dev/sr0 obs=32k

,→ seek=0’
/dev/sr0: "Current Write Speed" is 2.0x4390KBps.
1605632/24524800 ( 6.5%) @0.0x, remaining 1:39 RBU 100.0% UBU 0.0%
1605632/24524800 ( 6.5%) @0.0x, remaining 2:22 RBU 100.0% UBU 100.0%
1605632/24524800 ( 6.5%) @0.0x, remaining 3:05 RBU 100.0% UBU 100.0%
5865472/24524800 (23.9%) @0.3x, remaining 0:54 RBU 100.0% UBU 33.3%
11829248/24524800 (48.2%) @0.4x, remaining 0:21 RBU 75.8% UBU 37.5%
17858560/24524800 (72.8%) @0.4x, remaining 0:08 RBU 39.8% UBU 79.2%
23789568/24524800 (97.0%) @0.4x, remaining 0:00 RBU 4.5% UBU 4.2%
builtin_dd: 11984*2KB out @ average 0.2x4390KBps
/dev/sr0: flushing cache

13.2 Debugging DVDs Creation

This section contains helpful hints, how to initially check the results, and some
information on determining what might have gone wrong and how to address it.

1. For first time users, taking the defaults seem to work very well when running
as root.

2. You may want to use rewritable media to see how it goes before using per-
manent media.
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3. Until you are familiar with the procedure, start with shorter input in order
not to waste time.

4. Test the generated output with a compatible media rendering tool before
burning DVDs.

5. Check the list of files and file sizes after the batch jobs are complete before
burning DVDs.

For blu-ray creation, cd /workpath/bd_date-time directory and look for similar
files:

bd.jobs bd.m2ts bd.sh bd.udfs bd.xml

udfs directory which is used as a loopback mount point

Note that the size of bd.udfs should be larger than bd.m2ts because this is the final
file which is actually going to be written to the disc media. It contains contents of
bd.m2ts and all of the required disc structure.

For DVD creation, cd /workpath/dvd_date-time directory and look for similar
files:

dvd.ac3 dvd.jobs dvd.m2v dvd.mpg dvd.sh dvd.xml
iso directory with VIDEO_TS and AUDIO_TS subdirectories of non-zero size.

Note that there will be no files in the actual AUDIO_TS directory.

6. The bd.sh and dvd.sh files are script files that you can carefully run manually
from some start point to determine where the failure occurred. You must
BE CAREFUL and know what you are doing and what directory you are in
because dvd.sh contains an rm command and will delete files. The script takes
a command line parameter of the directory where the file was rendered to
and which is usually the directory where dvd.sh or bd.sh was created.

7. There is also a file in the same directory, called bd.jobs. It was the information
that was used in creating the batch jobs and may be helpful in determining
what parameters were actually used if there are any resulting problems. With
enough background knowledge, you can make changes and rerun.

8. For blu-ray check to make sure you do not have any spurious loopback disks
mounted that may interfere with the correct generation. Use the df command
to check this and then the umount command to unmount these. Also, check
to make sure you have used the gsettings command to disable automount.

9. For blu-ray loopback mount the <target>/bd.udfs image, and see if it has
the BDMV filesystem written to it, and in particular a subdirectory named
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STREAM. Look at the results in ./udfs and check for the stream file which
should exist in ./udfs/BDMV/STREAM/00000.m2ts and should have the same
size as ./bd.m2ts.

mount -o loop <target>/bd.udfs <target>/udfs
ls -lR <target>/udfs
du -sc <target>/udfs
umount <target>/udfs

Checklist for Troubleshooting

• Are you logged in as root? This is required in order to loopback mount files
for bluray and to write media on /dev/hardware. See section 13.7 for a
workaround for normal user mode.

• Did you startup CINELERRA-GG from a terminal window so you can see infor-
mative messages?

• Is udftools installed for BD and dvdauthor installed for SD?

• Do you have loopback not enabled for bluray? At least temporarily, disable
automount via:

gsettings set org.gnome.desktop.media-handling automount false

• Did you have sufficient disk space for working/writing files? In the Create
window, the disk space will be displayed in green if sufficient, but in red if
less than what fits on the disc media.

• Did you use /tmp as the work device, then rebooted the computer, which
deleted files on /tmp?

• If the input media is interlaced, did you check the Deinterlace option to elim-
inate interlacing?

• Did you change the output name in the Batch Render window after the batch
jobs were already created? These filenames have already been written to
disk. If you want to change either the Title or the Work_path, you have to
start over.

• Have you selected a Title in the Create window that is a directory that already
exists? The program attempts to create that directory and will give you an
error message if it exists.

• Did you replace the /dev/bd or /dev/dvd on the command line with your
hardware device name?
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• If a warning was issued in the Create BD/SD window of * non-standard format
and your bluray reader could not play the disc, did you change to a standard
format instead?

• Did you correctly interpret the frame rate if using interlaced format to be 1
2

due to interlacing?

13.3 Subtitles

DVD (not blu-ray... yet) subtitles are added by using the main window pulldown
File → Subtitle which brings up a window allowing you to type the filename
of a previously generated text file containing the desired words/lines, the script.
After entering the filename, click Load to read in your script. By creating a script
file ahead of time, it lets you easily add dialog that was already written out and
carefully edited for spelling and proper grammar.

The format of the script/text input file has specific requirements as listed below:

• Lines can be any length but they will be broken up to fit according to some
criteria below.

– Running text used as script lines will be broken into multiple lines.
– The target line length is 60 characters.
– Punctuation may be flagged to create an early break.
– Single carriage return ends an individual script line.
– Double carriage return indicates the end of a entry and helps to keep

track of where you are.

• The "=" sign in column 1 indicates a comment seen in the script text to assist
you in location.

• An "*" at the beginning of the line is a comment and not a script line.

• Whitespace at either the beginning of a script line or the end will be removed.

Figure 13.8 shows the Subtitle window you will see.

To put the subtitles onto your media, first add a subtitle track via the pulldown
Track → Add Subttl. In the Subtitle window, note that there are 2 major textboxes.
There is the Script Text textbox showing the current entry of text from your input
file and there is the Line Text textbox showing the currently active text. In your
subtitle track, select a timeline region (in/out or drag select with hairline cur-
sor/highlight) to indicate the region where you want the active Line Text to be
pasted. Then click the Paste button in the Subtitle window to paste the line onto
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Figure 13.8: Subtitle window

the subtitle track. Silence will be added to the subtitle track in the places in the
media where there are gaps.

Editing in the Line Text box can be used to change the active script line. By double
clicking the timeline over the subtitle track, you can reselect the active script line.
The subtitle text will be reloaded into the Line Text box and can be edited and re-
pasted as the new active subtitle text. You can also highlight multiple lines in the
Script Text box and paste them (using the usual window paste methodology) into
the Line Text box. After pasting to the timeline, the Line Text box will be updated
with the next script line. In addition, if you triple click a line in the Script Text box,
it will automatically become the current line in the Line Text box.

When you are finished, before clicking Save, you must supply a legitimate filename
in the Path box; your current directory will be used if only a filename but no
directory path is supplied. The filename used will automatically have a "–" after
it followed by the track label and then udvd extension added; any extension in
the filename will be removed.. If you click OK before saving, the subtitle script
position is saved with the session. This is convenient for continuing where you
left off.
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To reposition the script, use the slider or tumbler buttons:

Slider bar to move through the text entries quickly.

Prev or Next buttons to go to the previous or next script line.

Figure 13.9 shows what the pasted subtitle script looks like in a portion of the
main window.

Figure 13.9: Subtitles on timeline

13.4 Dvd Interlaced Chroma

CINELERRA-GG uses 4:4:4 colorspace to edit, so it is necessary to convert interlaced
4:2:0 video to 4:4:4. But you can run into problems, referred to as the chroma bug,
which you see in DVD media displayed on higher resolution monitors – streaks or
spiky horizontal lines are visible in the chroma channel, especially on diagonal
edges. The Chroma Bug is specific to MPEG and 4:2:0 encoding.

Now you can use the YUV420P DVD Interlace Mode when rendering DV directly to
mpeg2 through a yuv4mpeg stream and when using video effects on HDV video.

With this option enabled, improved chroma results will be obtained from your
DV or HDV source. Editing DV or HDV and rendering it back to the same format
does not require any special handling. In order to perform colorspace conversions
correctly in CINELERRA-GG and avoid Chroma errors for interlaced 4:2:0 video,
check the box as follows:

Settings → Performance → YUV420P DVD Interlace Mode

This option maintains the interlacing in Chroma sample addressing, which ordi-
narily would be deleted because the upsampling of interlaced chroma fields is
normally done using a progressive algorithm. With this mode enabled, the MPEG
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decoder uses a different algorithm for interlaced frames so that the 4:2:0 format
chroma interlacing is preserved.

13.5 MPEG utility programs

There are 2 utility programs that come in handy when dealing with DVD media
for creating or reading previously written DVDs.

zmpeg3cc2txt convert closed captioning data to subtitle data.

This program can be used to scan captured broadcast data streams and convert the
closed captioning text data into subtitle track data. The result can be used to add
subtitles to DVDs created from the captured media using the text collected from
the closed captioning.

usage:

./zmpeg3cc2txt [-c cc_service ] [-s start:length, ...] [ -t track ] [-v verbose ] [-w wdw
,→ mask ] [-x file.xml ] [-o file.udvd ] file.ts

cc_service = closed caption service id
start:length = start:length frames (comma separated list)
track = video track number
verbose = verbose level
wdw mask = bit mask for windows (-1 = all)
file.xml = filename for edl xml format subtitle data
file.udvd = filename for udvd format subtitle data
file.ts = filename for transport stream

To use this program, the input file must be a transport stream (broadcast video)
which contains closed captioning services. The service id defaults to one, and the
default video track is zero. Either -o or -x must be specified to indicate the output
file format desired. If the output file name is a ’-’ then stdout is selected as the
output file. For example:

zmpeg3cc2txt -o -/dvb_data/channel5.ts
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zmpeg3ifochk check DVD ifo file for usable features.

For some time, DVD manufacturers have been employing a variety of measures
to make reading a DVD difficult on a computer. One technique which is widely
deployed is to add a bunch of extra program data, so that correct playback is only
likely if you can read the DVD virtual machine data and decode a maze of program
data to find the undamaged stream definitions. Only a few streams are created
which are machine usable, and dozens are created as decoy streams. The decoy
streams fail or introduce errors. This program scans the IFO (info file) playlists
and verifies the contents of the stream that does not contain obvious damage. The
result is a list of program ids which can be entered into the playback preferences
to select a program which qualifies.

13.6 HDV on a Blu-ray Disc Without Re-encoding

An MTS file is a video file saved in the high-definition (HD) MPEG Transport
Stream video format, commonly called AVCHD. It contains HD video compatible
with Blu-ray disc format and is based on the MPEG-2 transport stream. MTS files
are often used by Sony, Panasonic, Canon and other HD camcorders. Legal in-
put for Video – MPEG1VIDEO, MPEG2VIDEO, H264; Audio – MP1, MP2, AC3,
AC3PLUS, DTS, TRUHD.

For creating a blu-ray disc, if you have HDV MPEG-2 media that is in blu-ray for-
mat, you can save the original quality of your work, rather than rendering it to an-
other format. Follow the steps below directly instead of going through CINELERRA-
GG. It has been tested on 10 different MTS files.

du -sb /yourHDVfile.MTS # Determine the size of your file in bytes.
blocks=((size-in-bytes/2048 + 4096)) # Convert bytes into blocks + a little more.
mkudffs /tmp/newfilename.udfs blocks # Create a file with that \# of blocks + some extra.
mount -o loop /tmp/newfilename.udfs /mntX # Use a mount point like mntX that is not in

,→ use.
/<cinelerra_installed_path>/bin/bdwrite /mntX /tmp/yourHDVfile.MTS # Substitute \

,→ CGG{} path.
umount /mntX # You must unmount the udfs filesystem
growisofs -Z /dev/bd=/tmp/newfilename.udfs # Replace /dev/bd with your bluray

,→ hardware device.
OR dd if=/tmp/newfilename.udfs of=/dev/bd bs=2048000 # if using rewritable blu-ray;

,→ replace bd.
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13.7 Blu-ray Workaround for Mount/Umount

Creating BD images to be written to media requires usage of mount and umount
which typically can only be done by the root user due to security. If you want to
avoid running CINELERRA-GG as root, you can implement a workaround by adding
a line in /etc/fstab (must be root to edit the file initially) and by creating a
directory in your home area, called bluray. You only have to do this once unless
you upgrade the Operating System and it wipes out the line in /etc/fstab. Now
the CINELERRA-GG program will automatically do the mount and umount for you
each time you execute BD Render and you can run as an ordinary user.

The line to add to /etc/fstab will look something like the following, assuming
your username is name and your groupid may be users or name. If you do an ls
-l in your home directory, the 3rd and 4th fields shown will be your uid or name
and gid or groupid which you must substitute in the line below.

/home/name/image /home/name/bluray udf noauto,loop,rw,user,uid=name,gid=
,→ groupid 0 0

Also, be sure to do a mkdir bluray in your /home/name directory as this is a re-
quirement (owned by you; uid=gid=name). When the actual image to be written
to disc media is created, it will first d any current /home/name/image file. Warn-
ing – make sure you do not already have a file called image that you want to
save as it will be automatically deleted every time you initiate a BD Render. So
you will want to burn a bluray disc after CINELERRA-GG creates the image since it
will written over on the next rendition. The actual writing to your bluray burner
(something like /dev/sr0) is done outside of CINELERRA-GG at a terminal prompt
and requires root privilege usually. You can either use sudo for 1 line or create user
wheel group to get around this.

13.8 Blu-ray from Multiple CINELERRA-GG Output

Writing prepared multiple CINELERRA-GG output files, bd.m2ts, to a single bluray
disc is relatively easy to do but is not done automatically. You can render all of
the desired files via the Create BD menu, save each individual bd.m2ts file with
a unique name, construct a Menu Title that reflects the contents of each of these
files, then manually use a few commands to create a udfs file to be written to BD.

Usage of the final preparation taken from the bdwrite program comments:
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./bdwrite <tgt_dir_path> <playlist-0> <sep> <playlistp1> <sep> ... <sep> <playlist
,→ -n>

<sep> == -<pgm_pid> | --<pgm_pid> | ---<pgm_pid>
<pgm_pid> may be empty string, or a numeric pgm_pid for current title clip
<pgm_pid> defaults to first pgm probed
<playlist-x> == <clip-0.m2ts> <clip-1.m2ts> ... <clip-n.m2ts>

One title is built for each playlist; playlist-0 is used as first-play item. The sepa-
rators (<sep> represented by the dash character) have unique roles. The double
“−−” means stop after playing, and the triple “−−−” means pause.

For example:

./bdwrite /tmp/dir /path/menu_titles.m2ts ---/path/clip0.m2ts --/path/clip1.m2ts --/
,→ path/clip2.m2ts

The basic idea is to use playlist-0 as a menu or directions to use the bluray player
remote control to select the desired Title and start the play, avoiding the need for
a menu system. Planning in advance to get the desired results is necessary. The
following steps provide an outline to get started.

1. Create all of the bd.m2ts files that you want to put on the Bluray.

2. Using CINELERRA-GG, design your Title page using a few seconds of video
and the Title plugin.

3. Use BD Create to render your short Title video.

4. Next is the most complicated part which is to run mkudffs with a sufficient
amount of disk space to hold all of the bd.m2ts files plus a little more! To
calculate this, you can record the sizes from having run BD Create mkudffs.
This number is displayed on the terminal screen when using the command
line interface each time and add them together. Or recalculate the size of
each bd.m2ts using the formula below and adding them all together. This is
the number of blocks used to make a bluray image space for bdwrite to use.
For many files, this could require a huge amount of space, so check first.

Total size = File0 size in bytes / 2048 + 4094 "+" File1 size in bytes / 2048 +
,→ 4094 "+" ...

Now create the image file via: mkudffs image <Total size> where image
or udfs is the image name.
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5. Loop mount the disk image (refer to Section 13.7).

6. Then actually write your multiple bd.m2ts type files onto the image where
<cin_path> is the location of the CINELERRA-GG binary bdwrite file and <path>
is your directory path. Below is a single line that wrapped around with 4 Ti-
tles.

<cin_path>/bin/bdwrite image /<path>menu_titles.m2ts ---/<path>/bd1.
,→ m2ts --/<path>/bd2.m2ts --/<path>/bd3.m2ts --/<path>bd4.m2ts

Note that the 3 dashes after the menu_titles.m2ts lets the bluray player
know to pause after playing the few seconds video which contains the index
to the rest of the files. The 2 dashes after each of the bd.m2ts signify stop.
That is when you will have to use your remote to Search Titles in order to play
the next one you want to see. In addition, if for some reason you just want
to play all, you will have to add another line to the Title menu as a choice
and list all of the 4 files in a row at the end of your bdwrite line without any
dashes in between.

7. Umount the loopback disk.

8. Use your favorite dd or growisofs tool to write to a formatted bluray disc.

Figure 13.10 demonstrates an example of setting up a Title menu on a 5 second
video. There is a list of 4 menu title options that can be searched via remote control
using the Title search option for your player.

Figure 13.10: Title menu for DVD/BD
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13.9 Use Case: DVD

Example of Video Source with 4:3 Aspect Ratio, Being Transcribed to 16:9 and
Creating a DVD to be Displayed on a Digital TV. Illustrated steps to take source
input with 4:3 aspect ratio and convert to 16:9, with the bottom of the image
being cropped in order to preserve top of video so nobody’s head gets cut off are
provided here.

1. In order to write to a DVD writer hardware device, you must be root!!

2. Start CINELERRA-GG to bring up the 4 usual screens with main track canvas
in the lower left corner.

3. Load media via the pulldown File → Load files. . . by choosing the direc-
tory path with the desired file.

4. Bring up the Create DVD window using File → DVD Render.

5. Choose Format: PAL or NTSC with 16x9 aspect ratio for today’s digital TV as
in below screenshot. figure 13.11.

Figure 13.11: Choose NTSC or PAL for DVD creation

6. Modify the Work path: parameter to a disk that has sufficient disk space and
you will see the amount of disk space in green letters (/tmp is default, but is
often deleted so may be a bad choice).

7. Note that in the following screenshot, Scale of Cropped has been chosen (fig-
ure 13.12).

8. Click the green checkmark on the bottom left side of the window to close it
and proceed.
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Figure 13.12: Set Scale Ratio to Cropped

9. Now the Batch Render window will appear along with the Scale Ratio brown-
colored line below the video in the main track canvas as seen in the screenshot
below. Note that in this screenshot the top right most corner of the shot
displays the bottom portion of the Compositor window.

10. Next, right mouse click the gold-colored magnifying glass, which is on the
right hand side of the brown-colored line. This will bring up the Scale Ratio
window that you can see below. Note in the Compositor window, the blue
legs are only showing up to the knees.

With the Scale Ratio plugin you can manipulate your video so that it will look the
way you want it on a different output Display device. In this case we are going to
create a DVD for playing on a Digital TV screen.

In figure 9.58, the left side shows the Input Ratio, Width, and Height of input. The
top right half shows desired output values. In this particular case, the input was a
YouTube video which was not quite 4 : 3 aspect ratio.

Left and right sides of the bottom portion show the Source and the Destination X,
Y, W, H values. As you change the values on the left side, you can see how this
will affect the output as you observe the results in the compositor window. For
example, as you change the values for SrcY in a cropped Scale scenario, you see
up/down movement.

Keep in mind that the monitor you are using is NOT the intended output display
device – your digital TV is, which most likely will have different looking aspec-
t/pixels, etc.
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Figure 13.13: Scale Ratio plugin

11. In order to crop the bottom of the video in order to preserve all of the image
on the top, modify the Src Y value on the bottom of the left hand side in the
Scale Ratio plugin. Src Y which was 21 has now been changed to −18. You
will see in the Compositor window how the bottom dark colored border is
now gone so that none of the top portion which contains a person’s head will
be chopped off. Compare figure 13.14 to figure 13.12 and note the blue legs
can be now seen to the waist.

Figure 13.14: Better scale on compositor

12. Click the Apply box in the Scale Ratio window.

13. Click the Save to EDL Path in the Batch Render window for creating a DVD.
If you do NOT do this, you will get a Warning box as seen in figure 13.15,
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to remind you to Save because you have changed the EDL by modifying the
scaling parameters in the Scale Ratio window.

Figure 13.15: Error in Batch Render

13. Next, make sure you have the Timeline set in the Main window at the begin-
ning of where you want to start rendering. Also, make sure the first line in
the Batches to render section is highlighted as you can see above by the blue
highlighting. Click on the Start box in the Batch Render window and you will
see the video playing in the Compositor window.

14. CINELERRA-GG program will be stopped when done rendering; you will be at
the terminal prompt where you will see it has printed out some informational
messages (or errors if problems), the last 2 are:

To burn dvd, load blank media and run:
growisofs -dvd-compat -Z /dev/dvd -dvd-video /mnt0/dvd_20161027-

,→ 131723/iso

15. Load a blank or rewritable DVD into your DVD writer device, which will be
similar to /dev/dvd as in the growisofs line above – something like /dev/sr0
on your computer.

16. Keyin the growisofs line, substituting your actual writer device name. Again,
you must be root.

17. When back at the terminal prompt, and if there are no errors, keyin eject
/dev/dvd substituting.

18. Play it on your DVD player connected up to your Digital TV screen.
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CHAPTER 14

The 5 Multi-s

This chapter is simply a conglomeration of multiple usage possibilities.

14.1 Multi-Camera / Mixer

Use the Mixer Viewer to see multiple media playing simultaneously in re-sizable
mini-viewers. This can be used in various ways and is useful to edit videos shot by
multiple cameras from different viewpoints that were simultaneously recorded in
order to create a single good video. Everything will have to be initially synced so
you can decide which one of the camera angles is best suited at any time.

The number of cameras/mixers you can have is generally limited to the available
resources on your computer. Currently, the number of File Descriptors available
in the OS limits cameras to about 50. If you have many mixer viewers you will
probably want to use proxy mode whenever possible. Also, in the Settings →
Playback A tab Video Out section, uncheck play every frame and choosing a Video
Driver of X11 with use direct X11 render if possible checked, will provide better
performance.

Figure 14.1 shows 9 media sources in the left corner, the composed video in the
right corner, the timeline with the top video track with pieces of the 9 overwrites,
and the choice in Resources of Mixed.

Easiest Method to Getting Started

1. This method assumes all of your media or cameras are aligned the way you
want them already.

2. From the File pulldown, create a New project with the desired format for Audio
and Video output (or you can just use the default).

3. File → Load the media files you want to work with using Create new re-
sources only.

4. In the Resources window, with the Media folder, highlight the list of media
you want to Mix. This is done using a ctrl or shift mouse button press as you
would in a standard listbox selection.
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14.1. Multi-Camera / Mixer

Figure 14.1: Using Mixer capability in Cin for multiple cameras

5. Right click the mouse on the media selection and choose open mixers. This
opens multiple mixer viewer windows, one for each media item that was
highlighted. You can do them 1 at a time instead. This also adds the source
media tracks to the main window.

6. Now use the timeline to play and you will see all viewers/cameras playing.
Stop when you get to the end of the good camera playback.

7. Simply double click the good mixer viewer and from where you first started
playing to the playback insertion pointer is the source section, which will be
pasted in the destination video/audio tracks at the top of the new project.

8. Repeat steps 6-7. Start playing again, stop when you want, double click the
desired mini-viewer!

Some Hints and Caveats

• You can easily overwrite a section of the new track by selecting a section on the
timeline, then double click on one of the mini-viewers to overwrite/replace
that section.

• If you edit the output tracks, it only edits output tracks, and the input tracks
may no longer be lined up.

• You can add a silent section by selecting past a section and start overwriting
that section from then on.

• If you use the cursor hairline to create the selection endpoint, it must be past
the end of the destination.
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14.1. Multi-Camera / Mixer

• The compositor shows composed media. This is the media that will be ren-
dered.

• The program always uses overwrite as the paste operation.

• Use the timeline edit handles to move the start and end points of that section.

• Only middle mouse drag handle operations should be used normally.

• Other drags will displace the media source/destination timeline correspon-
dence.

• To re-tile the mixer windows after you have resized and moved them around,
you can use the Window pulldown of Tile mixers or the shortcut of Alt-t.

But, I want to use only the first set of audio tracks. . .

There are many cases where you may want to compose using media from several
different tracks while using the the same audio tracks as associated from a specific
viewer. Since mixer source tracks can be updated any time by using a mixer toggle,
this makes it possible to do this.

Procedure to update the mixer audio source track list:

1. Single click to highlight the mixer window you want to re-associate to the
audio track.

2. In that audio track’s patchbay click the expand toggle, the arrow on the right
side.

3. In the expanded pane that appears, there is another arrow on the left side.
This icon has the tooltip Mixer. Click this and because in step #1 you high-
lighted the mixer window, it will now be toggled on. Once you click the mixer
icon it will then point up.

4. Now, disassociate any audio that is unwanted by expanding its patchbay and
toggling off the mixer.

Expert Usage

When you double click a mixer viewer window, it operates an overwrite paste op-
eration. This moves src (source) track edits to dst (destination) track edits over
the same selected timeline region.

• Src tracks should be not playable and not armed in the main window patchbay
gui.

• Dst tracks should be playable and armed in the main window patchbay gui.
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14.1. Multi-Camera / Mixer

Each mixer viewer maintains a list of the tracks which will be used as src. This
list is made visible selecting the window with the left mouse button. When the
mixer viewer is selected, a highlight is drawn around the media image. All track
patchbay mixer toggles are updated to reflect the src tracks included in the selected
viewer src track list. The track patchbay toggles can be used to manage the list.

• Turning on a toggle (pointing up) includes the track in the src track list.
• Turning off a toggle (pointing right) removes the track from the src track list.

New Mixer viewers can be created using the main menu Window → Mixer Viewer,
or with a shortcut of Shift-M. When a new viewer is created, the currently en-
abled patchbay mixer toggles are used to create the viewer source track list. The
toggles are cleared after the window is created. This is to improve the work flow.
Use the following list of steps to create individual mixer viewers.

To create a list of mixer viewers:

1. Setup the session settings → format, width, height, frame rate, color
model, aspect ratio.

2. Create dst tracks using the a/v track pulldowns (or use shortcuts "t" / "T"),
armed and playable.

3. Append src tracks using file → open → append tracks, or the resource
window using pasting.

4. Using the track patchbay, disarm editing and disable playback of the au-
dio/video src tracks.

5. Using the track patchbay, mark the new tracks as mixer source to be added
to the viewer.

6. Create a mixer viewer using the main menu pulldown, or the shift "M” short-
cut.

7. Repeat steps 3− 6 for each mixer viewer needed for the session editing.

When you single click a mixer window, it becomes selected and highlighted and
all of the patchbay mixer toggles are updated to reflect the state of the viewer’s src
tracks. Tracks that will be src are shown as enabled. If you change a toggle, the
src tracks for the selected window will be modified. This means you can associate
or dis-associate any media track to any mixer window.

When you double click a mixer window, an overwrite paste is invoked. The mixer
viewer’s src tracks are overwritten to the dst tracks. The timeline region for both
the source and destination are the same for the overwrite paste function. The
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selection region is used if it is active. If the selection is empty, that is it is a hairline,
the selection region is from the end of the destination playable edits to the selection
cursor hairline. The hairline must be past the end of the playable edits on the
destination tracks.

The mixer viewer configuration is saved with the session data. When a saved
session is loaded in replace project or replace project and concatenate tracks, the
mixer viewer will be reopened.

Using Proxy with Open Mixers

The best way to use proxy with your multiple cameras is to follow the steps below:

1. Load media with insertion strategy of create resources only.

2. Highlight the media in the Resources window and right click on this to choose
open mixers.

3. Use the Settings → Proxy settings. . . to bring up the proxy menu.

4. Choose the size and other options you want and click the checkmark OK. If
you choose the option Beep when done you will hear a short beep if all media
is already proxied or a longer beep when all proxies have been created.

5. When your editing is complete, use Settings pulldown and proxy to original
size.

Instead of Open Mixers, you can Insert Mixers with new tracks at the timeline
insertion point.

14.1.1 Mixer Align by Audio

Multi-camera footage of a single event can have various shots starting and ending
at different times. So when the footage start times are different, you can use
the mixer audio to synchronize the clips on the timeline. The program algorithm
attempts to find and align automatically the waveforms of the media.

Synchronizing multiple camera videos based on audio tracks can be done with
CINELERRA-GG easily enough with the Window → Mixers. . . → Align mixers
option. Align mixers brings up a window displaying your mixers, the currently
selected Master Track, and a list of all of the Audio Tracks (figure 14.2). There is
a limit of 32 audio tracks per each mixer (that should be enough!)

Two different methods of aligning the audio for mixers are available. They are
most easily referred to by the button that is pressed – Match and Match All. There
are also 2 methods of activating the alignment – Apply and Move.
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Figure 14.2: Align Mixers window

Match consists usually of the next set of steps to take advantage of this feature:

1. Load your camera media with insertion strategy of resources only

2. Highlight in the Resources window, all of the media you want to mix.

3. Right mouse button on one of the media and click on Open Mixers; all mixer
windows come up.

4. Provide a small target audio pattern on the Master Track for syncing by mark-
ing with the In/Out points ([ and ]).

5. Make a selection on the timeline in which to look for the pattern. Left mouse
click, then drag select and highlight a search time domain.

6. Use the Window → Mixers. . . → Align mixers to bring up its dialog win-
dow.

7. Highlight in the first listbox, the Mixer number you want to align. Click on
Match. This will take a few seconds so watch the rendering time percentage
on the lower right hand side zoom panel. The buttons will be ghosted out
until finished. Now note the changed values in the Audio Tracks listbox.

8. If you are satisfied with the calculated Nudge values – that is they are very
close to 1.0 – in the Audio Tracks listbox and the audio track selected as the
Master Track in the Master Track listbox, hit the Apply button.

9. If you plan on performing more alignment tasks, click on Checkpoint so you
can go back to a previous step in case you make a mistake.

10. Last, click on the OK green checkmark or to cancel click on the red X. Or just
close the gui.
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Reset is used to start over with the current session data, not an undo. This
means you can use the match repeatedly to refine alignments. All of the Audio
Tracks listbox values will be reset.

Checkpoint provides a method to create checkpoints that save the current state.
This is especially helpful while learning or doing more complicated operations
where you might make a mistake or do not like the results and need to get back
to a previous state.

Undo is used to put the media back to a previous state on the timeline. If you
choose start over the session will reload with the original, before any changes were
applied. You can also go back to any of your previous checkpoints that you created
earlier which are listed there, such as chkpt 1.

Match All is used when you have several mixers, instead of only picking 1 to
match, it picks the best match for EACH of the mixer tracks based on a single
master track. So when you hit Apply, each track might move differently. You do
not set In/Out points but you have to make a selection within which to match.

Apply button will apply the nudges that were generated during the Match or
Match All execution (figure 14.3).

Move is very handy when you are using mixers, if you have an edit somewhere
that you need to fix specifically without moving any of the other track pieces. In
this case you have to select a section (like you do a group, but do not make a
group), generate a match, and then you can just Move that set only – everything
else stays where it is at its current location (figure 14.4).

Figure 14.3: Aligned mixer window after "Match". Note the Nudge amounts above.
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More detailed information follows about how this all works and the information
in the dialog window. It is important to know that the result of the calculation is
best match but you can still override the selections if you decide there is a better
one. The dialog window is split into 3 sections:

1. Mixers lists the mixers that are active by highlighting them all initially. You
can decide that you do not want 1 or more mixers to be used in the correlation
calculation by un-highlighting the one(s) that should not be used. In some
cases you have to have at least 2 in order to align audio.

2. Master Track lists each of the audio tracks currently loaded for all of the mix-
ers. You can decide to highlight a different audio track to be used as the
master for correlation, but only 1 can be used.

3. Audio Tracks lists each of the mixer audio tracks. Again, you can highlight a
different set of which mixer audio tracks that you want to use for the wave-
form correlation. Any audio tracks that are not highlighted, that is turned off,
will not be considered in the correlation calculation.

The corresponding input position is determined by track input correlation.

The letter "R" in the Audio Tracks listbox represents the correlation value. R= 1.0
designates that if both the pattern and the matching section were in the highlighted
area, they are completely correlated – this is a good self-test to check. Nud ge = 0.0
means just that.

The header pos stands for the timeline position. When the Apply button is pressed,
only the Mixers listbox is relevant at that time.

The Mixer with the master track generally does not move, everything else will be
lined up (figure 14.5).

Match All option basically consists of the following steps:

1. Highlight the Mixer to use in the Mixer listbox.

2. Highlight the Master Track you want to use in the Master Track listbox.

3. On the timeline, mark your selection on the Master Track.

4. Click on the Match All button.

5. Note the nudge values to see if they make sense, and if so, press Apply.

Match option basic steps (just for comparison with Match All):
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Figure 14.4: Match setup for aligning by audio. Note that [ ] are set over a sample waveform
highlighted selection that includes that.

1. Set the In/Out points [ ] of the target.

2. On the timeline, mark your selection.

3. Click on the Match button.

4. Note the nudge values to see if they make sense, then press Apply (or Move
when doing a group).

14.1.2 Recover Mixer Windows

It is a hazard that you might accidentally undo (z) too far and lose your mixer
windows. Here are the steps to recover. It is recommended that you make a
backup of your project before performing the recovery steps just in case there are
other problems.

In the patchbay box to the left of the main timeline, there is a right pointing arrow
on the right side. This is called the Expander (figure 14.6). When you click on each
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Figure 14.5: An audio Match is complete. Note the waveform is aligned.

expander, another line appears below that expander arrow and the timeline track
height is slightly increased. If you Shift-click on a single expander, the patchbay
will expand for all of the tracks.

1. Expand all of the patchbay lines, either one by one, or Shift-click on one to do
them all. This is so you can see the mixer right pointing arrow on the second
expanded line.

2. Use the Window pulldown and choose Mixer Viewer to bring up a new mixer
window. Now you will be making an association between the mixer viewer
and the track’s video.

3. Click on the new mixer window to make sure it is highlighted with a white
border. This designates it as the in use mixer viewer.
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14.2. Multi-Pane Support

4. Set your play to the beginning of the video using the Home key or Home
transport button.

5. In the patchbay for a video track click on the mixer arrow on the expanded
2nd line which is a right facing arrow. Now the arrow will point up. If there
are audio tracks with that video, click on each of its audio tracks mixer arrow
until they point up also.

6. Next move your insertion pointer on the timeline where there is video. Some
of the time this just helps so that the new mixer viewer window gets redrawn
and you can see that the images appear; but the image may not appear until
the program does a redraw later. Now the mixer viewer should be correctly
associated. Note if you have large video, give it some time to update. You
may have to click on the mixer viewer window if the image does not show.
You can always start over with that mixer if you encountered any problems.

7. Click the arrows that are pointing up in that video and its audio so they go
back to pointing right. That mixer viewer is complete so you need to do this
to make sure the mixer arrows are off.

Figure 14.6: Mixer patchbay

Repeat steps 2 through 7 for each of the mixer viewers
you need going down the patchbay starting on step 2
first with Mixer 1, then 2 to 7 steps for Mixer 2, then
again run 2 to 7 for Mixer 3 and so on.

Sometimes the association does not stick initially. If
not, highlight the mixer viewer with the problem,
change the mixer arrows to point up, and reassoci-
ate.

14.2 Multi-Pane Support

The main CINELERRA-GG edit window holds the Track
Canvas which can be divided into 4 panes of track
data: 1 or 2 vertical panes and/or 1 or 2 horizontal
panes. To split the track, use the Window pulldown,
and then click on Split X or Split Y depending on how
you wish to split the track. Alternatively, the canvas
pane types can be changed using keys <Ctrl-1> for
toggle split horizontal or <Ctrl-2> for toggle split vertical. Or the track can be
split into panes by using the + widget in the lower right hand corner of the track
canvas. Once the track has been divided, you can use the + widget shortcut or the
drag bars to change the size of the panes.
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Multi-Pane, or split screen, allows you to look at the first part of a movie at the
same time as a part that is a long ways away on the timeline which would have
been off the screen. By having multiple panes, you can see the 2 parts you want
to look at simultaneously and drag/drop easily between the 2. Also, the X pane
split is extremely convenient for laptop users and computer monitors with small
screens since it can be used with horizontal scrolling with the mouse wheel + Ctrl.
The Y-pane split makes it easy to see 2 simultaneous drag and drop zones when
you have lots of tracks (figure 14.7).

Figure 14.7: Shown are 4 panes that have split the main track canvas for some editing
scenarios

14.3 Multi-Screen / Playback Configuration

CINELERRA-GG supports 2 separate preferences for the playback configuration.
CINELERRA-GG can be operated in a single or dual screen configuration, both by
using Xinerama or dual screen configuration of X windows. It will take some setup
using Xconfig to make this work.

The Settings → Preferences menu has Playback A and Playback B tabs. The
target display and audio device configuration can be separate, to support up to 2
display and/or audio device stations. The active configuration displays an aster-
isk (*) in its selection tab and the selected tab will be made active when OK is
pressed. For example: you may have a dual screen monitor system with the left
screen showing the CINELERRA-GG main window and the right screen showing the
composer. Another setup might use a monitor for the left screen and an HDTV
as the right screen displaying the composer. When a playback configuration is
selected, the audio/video device configuration is switched to the playback selec-
tion. The active playback setup can be changed through use of the menu pulldown
of Settings → Preferences or via the remote control menu selection (see the
section Remote Control for DVB for more detail).
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Yes, you can watch TV on CINELERRA-GG instead of CINELERRA-GG on TV.

Figure 14.8 shows partial window of *Playback A selected and the second tab for
Playback B. Note that on the bottom right of the window, Default B Display: is set
to : 0.1, representing the setting for Screen 1. On the unseen Playback A window,
the Default A Display: will be set to : 0.0 meaning for Screen 0. Otherwise, the
default would be nothing there or just <empty>.

Figure 14.8: Multi-screen Playback example useful for watching CINELERRA-GG run on the
big screen

14.4 Multi-Session

You can run as many sessions of CINELERRA-GG as your computer resources allow.
However, if you are using the same $HOME/.bcast5, changes you make for one
may impact the others. You can always create and rename a new .bcast5 from:
Settings → Preferences → Interface → Index files: and press Index
files go here
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14.5 Multi-Viewer Window Support

You can create as many Viewer windows as you want in CINELERRA-GG. These are
handy for users who are adept at working with a lot of different clips simultane-
ously. By bringing up multiple Viewer windows, each clip can be edited in its own
area, making it easy to see all of the separate pieces. After you have loaded some
media files, to start another Viewer window, right click on one of the pieces of
media in the Resources window. This brings up a menu of several options, one of
which is view in new window. Choose this option and that media will come up in
a new Viewer window for you to work (figure 14.9).

Figure 14.9: Shown here are 3 Viewer windows and the View in new window popup
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CHAPTER 15

Shortcuts

Almost every CINELERRA-GG INFINITY command has its own keyboard and mouse
shortcuts. Here they are listed organized by window and type. If a desktop win-
dow manager and operating system is already using a specific key for its own
purpose then that key will not be available for use as a shortcut in CINELERRA-GG.
An example might be the Alt key. Some specific alternatives are listed in 2.2.6 in
the "Key Alternatives" paragraph.

15.1 Main window

The Main window (also called the program window) consists of pulldown menus,
buttons and keys.

Main menu pulldowns

Main window menu pulldowns
Identifier Items Shortcuts Description

File New n Create new project.
Load files. . . o Load file(s).
– load tool Ctrl-a Selects all files.
– load tool Ctrl-z Deselects any highlighted

files.
Save s Save project.
Save As. . . Shift-S Save a project for easy mov-

ing.
Export Project Alt-s Save a project for easy mov-

ing.
Record. . . r Open record window.
Scan. . . Ctrl-Alt-s Open dvb scan window.
SubTitle. . . Alt-y Open subtitle script window.
Render. . . Shift-R Open render window.
Export EDL. . . Shift-E Open export EDL window.
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Main window menu pulldowns
Identifier Items Shortcuts Description

Batch Render. . . Shift-B Open batch render window.
BD Render. . . Ctrl-Shift-D Open create bluray disk win-

dow.
DVD Render. . . Alt-D Open create dvd disk window.
Quit q Quit the program.
Dump EDL Write current EDL to stdout.
Dump Plugins Write defined Plugins to std-

out.
Load Backup Load auto-backup file

“backup.xml".
Save Backup b Save auto-backup file

“backup.xml".

Edit Undo clear z Undo from history previous
operation.

Redo Shift-Z Redo from history next opra-
tion.

Cut x Copy selection to cut buffer
and delete.

Split x Split edit into 2 sections at
hairline cursor.

Paste v Insert selection from cut
buffer.

Clear Del Delete selection.
Paste Silence Shift-Space Paste empty edit at selection

or frame if none.
Mute Selection m Replace selection with empty

edit.
Trim Selection Replace track with selection.
Select All a Toggle select all/none.
Shuffle Edits Randomly reorder track edits.
Reverse Edits Reverse track edits.
Edit Length. . . Change selected track given

duration.
Align Edits Change selected corresp.

track edits to start/end same.
Trans. Length. . . Change selected track transi-

tions to given duration.
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Main window menu pulldowns
Identifier Items Shortcuts Description

Detach trans. Remove selected track transi-
tions.

Clear labels Delete selected timeline label
markers.

Cut ads Remove selected region, add
to commercial trking db.

paste subttl y Replace selected subtitle edit
text w/ subtitle script text.

Keyframes Cut Keyframes Shift-X Copy selected keyframes to
cut buffer and delete.

Copy Keyframes Shift-C Copy selected keyframes to
cut buffer.

Paste Keyframes Shift-V Paste keyframes in cut buffer.
Clear Keyframes Shift-Del Delete selected keyframes.
Change to linear Change keyframe auto curves

to piecewise linear.
Change to smooth Change selected keyframes

auto curves to bezier.
Create curve type Set new keyframe type:

smooth,linear,tangent,disjoint.
Copy default key Alt-c Copy default keyframe to clip-

board.
Paste default key Alt-v Paste clipboard keyframe into

default keyframe.

Audio Add track t Append new empty audio
track.

Default Trans. u Insert default audio transition
at selected edit boundary.

Map 1 : 1 Setup audio mixing output =
input.

Map 5.1 : 2 Setup audio mixing stereo =
5.1.

Attach Trans. Open audio transition select
for insert at edit boundary.

Attach Effect. . . Open audio selection menu for
insert at edit boundary.

439



15.1. Main window

Main window menu pulldowns
Identifier Items Shortcuts Description

Render Effect. . . Open audio render select to
render from select as pcm.

Video Add track Shift-T Append new empty video
track.

Default Trans. Shift-U Insert default video transition
at selected edit boundary.

Attach Trans. Open video transition select
for insert at edit boundary.

Attach Effect. . . Open video effect selection for
insert at edit boundary.

Render Effect. . . Open video render select to
render from select as pcm.

Tracks Move tracks up Shift-Up Circulate tracks up.
Move trks down Shift-Down Circulate tracks down.
Delete tracks Delete all tracks.
Delete last track Ctrl-d Delete last track.
Delete first track Shift-D Delete first track.
Concatenate trks Concatenate tracks together.
Append to Proj. Shift-N Add set of tracks.
add Subttl Shift-Y Add subtitle track.

Settings Format. . . Shift-F Open render format setup
menu.

Preferences. . . Shift-P Open preferences setup menu.
Proxy Settings Alt-r Bring up Proxy settings win-

dow.
Transcode Alt-e Bring up the Transcode menu.
Align cursor. . . Ctrl-a Align cursor on frames.
– Edit labels Toggle labels follow edits.
– Edit effects Toggle plugins follow edits.
– Keyfrs fol. edits Toggle keyframes follow edits.
– Typeless keyfrs Toggle typeless keyframes

mode.
Save settings Ctrl-s Save CINELERRA-GG_rc.
Loop Playback Shift-L Set loop playback region to se-

lection/all.
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Main window menu pulldowns
Identifier Items Shortcuts Description

Set bkg render Shift-G Toggle background rendering.

View – Show assets 0 Toggle show asset data.
– Show titles 1 Toggle show asset title.
– Show trans. 2 Toggle show transition effects.
– Fade 3 Toggle show fade auto curves.
– Mute 4 Toggle show mute auto

curves.
– Overlay Mode 5 Toggle show mode auto

curves.
– Pan 6 Toggle show pan auto curves.
– Plugin Autos 7 Toggle show plugin

keyframes.
– Mask 8 Toggle show mask auto

keyframes.
– Speed 9 Toggle show speed auto

curves.
– Camera X Ctrl-Shift-X Toggle show camera X auto

curves.
– Camera Y Ctrl-Shift-Y Toggle show camera Y auto

curves.
– Camera Z Ctrl-Shift-Z Toggle show camera Z auto

curves.
– Projector X Alt-Shift-X Toggle show projector X auto

curves.
– Projector Y Alt-Shift-Y Toggle show projector Y auto

curves.
– Projector Z Alt-Shift-Z Toggle show projector Z auto

curves.

Window – Show Viewer Toggle show view window.
– Show Resrs. Toggle show resources win-

dow.
– Show Compos. Toggle show compositor win-

dow.
– Show Overlays Toggle show auto overlay win-

dow.
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Main window menu pulldowns
Identifier Items Shortcuts Description

– Show Levels Toggle show audio levels win-
dow.

– Split X pane Ctrl-1 Toggle 1
2 horiz track timeline

window panes.
– Split Y pane Ctrl-2 Toggle 1

2 vert track timeline
window panes.

Mixer Viewer Shift-M Bring up a Mixer Viewer win-
dow.

Tile mixers Alt-t Tile mixer windows to original
position/size.

Default Positions Ctrl-p Reset window positions/size
to defaults.

Tile Left Set window positions/sizes to
tile left screen.

Tile Right Set window positions/size to
tile right screen.

_._ shell cmds Top rt. Cor-
ner

Run scripts (setup in interface
preferences).

Main menu buttons

Main window menu buttons
Identifier Items Shortcuts Description

Transport Rewind home Jump to beginning.
Fast reverse KP + / Alt-p Double speed reverse play.
Normal reverse KP 6 / Alt-o Normal speed reverse play.
Frame reverse KP 4 / Alt-u Render previous frame.
Stop KP 0 / Alt-m Stop playback.
Frame forward KP 1 / Alt-j Render next frame.
Normal forward KP 3 / Alt-l Normal speed forward play.
Fast forward KP Enter/A-; Double speed forward play.
Jump to end end Jump to end.
(No button) KP 5 / Alt-i Slow speed reverse play.
(No button) KP 2 / Alt-k Slow speed forward play.
(No button) Shift-KP 1 Render next frame and audio.
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Main window menu buttons
Identifier Items Shortcuts Description

(No button) Shift-KP 2 Slow speed forward play with-
out audio.

(No button) Shift-KP 3 Normal speed forward play
without audio.

(No button) Shift-KP 4 Render previous frame and
audio.

(No button) Shift-KP 5 Slow speed reverse play with-
out audio.

(No button) Shift-KP 6 Normal speed reverse play
without audio.

Ctrl-KP# If [ ] set, “KP 2,3,5,6,+,enter”
between in/out.

+Shift w/Alt Shift with Alt+x above,
adds/removes audio.

+Shift w/Ctrl Loops play, all or between In-
/Out.

Edit
Modes

Auto Gen. Keys j Generate keyframes while
tweeking.

Lock Labels Lock labels from moving.

Edit Op-
erations

In point ’[’ or ‘<’ Toggle In point timeline
marker.

Out point ’]’ or ‘>’ Toggle Out point timeline
marker.

Ctrl-t Clear both In and Out point-
ers.

To clip i Copy selection and create clip.
Split x Split edit into 2 sections at

hairline cursor.
Cut x Copy selection to cut buffer

and delete.
Copy c Copy selection to cut buffer.
Paste v Insert selection from cut

buffer.
Toggle label l Toggle label at current posi-

tion.
Previous label Ctrl← Move to label before cursor.
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15.1. Main window

Main window menu buttons
Identifier Items Shortcuts Description

Next label Ctrl→ Move to label after cursor.
Next label select Ctrl-Shift→ Select from cursor to next la-

bel.
Prev label select Ctrl-Shift← Select from cursor to previous

label.
Next keyframe k Move to next keyframe.
Previous
keyframe

Ctrl-k Move to previous keyframe.

Next keyframe se-
lect

Shift-K Select from cursor to next
keyframe.

Previous keyfr se-
lect

Ctrl-Shift-K Select from cursor to previous
keyframe.

Next auto Alt-a Move to next auto.
Previous auto Ctrl-Alt-a Move to previous auto
Next auto select Alt-Shift-A Select from cursor to next

auto.
Previous auto se-
lect

Ctrl-Alt-Shift-
A

Select from cursor to previous
auto.

Previous edit Alt← Move to previous edit.
Next edit Alt→ Move to next edit.
Cut left label Ctl-alt-shift-

’<’
Cut from insert pointer to pre-
vious label.

Cut right label Ctl-alt-shift -
’>’

Cut from insert pointer to next
label.

Cut previous edit Ctrl-alt- ’,’ Cut from insert pointer to pre-
vious edit.

Cut next edit Ctrl-alt- ’.’ Cut from insert pointer to next
edit.

Fit f Fit time displayed to selection.
Auto Fit Alt-f Fit the max/min range of all

automation types.
Auto Fit Ctrl-alt-f Fit the max/min range of cur-

rent automation types.
Undo z Undo from history previous

operation.
Redo Shift-Z Redo from history next opera-

tion.
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15.1. Main window

Main window menu buttons
Identifier Items Shortcuts Description

Manual Goto g Jump to time selected by
popup.

Drag/Drop
Edits

Clear Selec Ctrl-Shift-A Delselect all selected edits.

Copy Ctrl-c Copy selected edits into copy
buffer.

Cut Ctrl-x Delete selected edits/put in
buffer/collapse.

Mute Ctrl-m Delete selected edits/put in
buffer/insert space.

Mute Backspace Delete selected edits/put in
buffer/insert space.

Copy Pack Ctrl-Shift-C Copy selected edits and pack
together.

Cut Pack Ctrl-z Delete selected edits/put in
buffer/collapse.

Mute Pack Ctrl-Shift-M Delete selected edits/put in
buffer/insert space.

Paste Ctrl-v Paste (splice) buffer at inser-
tion point or reticle.

Overwrite Ctrl-b Paste (overwrite) buffer at in-
sertion pt/reticle.

Ctrl / LMB Toggles selected of
group/edit.

LMB If “Clear before toggle”, only
select this edit/group.

LMB If not “Clear before toggle”,
toggle edit/group.

Double click Only select this edit/group.
Double click-
Ctrl

Selects column and highlights.

LMB Shift Group/ungroup selected edit-
s/group.

LMB Ctrl + Drag Column drag.
LMB Drag Clip drag.
LMB Drag Drag unselected edit under

cursor.
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15.1. Main window

Main window menu buttons
Identifier Items Shortcuts Description

FFMpeg
probes
ear-
ly/late

FFMPEG early Top rt. Cor-
ner

Run ffmpeg open probes first /
last.

Main menu Keys

Main window menu keys
Identifier Key Qualifier Description

Key e Toggle editing mode: from
cut&paste or drag&drop.

1 through 9 Toggle auto mode settings as
in main menu shortcuts.

1 through 8 Alt Select asset pgm 1 − 8; reset
format (remove other trks).

← (left arrow) Scroll window timeline dis-
play left (not insertion pt).

← (left arrow) Ctrl Move cursor to label left of
cursor (main shortcuts).

← (left arrow) Alt Move cursor to edit boundary
left of cursor position.

← (left arrow) Shift-ctrl Move cursor to label left of
cursor, expand selection.

← (left arrow) Shift-alt Move cursor to edit boundary
left of cursor&expand.

→ (right arrow) Scroll window timeline dis-
play right (not insertion pt).

→ (right arrow) Ctrl Move cursor to label right of
cursor (main shortcuts).

→ (right arrow) Alt Move cursor to edit boundary
right of cursor position.

→ (right arrow) Shift-ctrl Move cursor to label right of
cursor, expand selection.

→ (right arrow) Shift-alt Move cursor to edit boundary
right of cursor&expand.

, (comma) Scroll window timeline dis-
play left (not insertion pt).
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15.1. Main window

Main window menu keys
Identifier Key Qualifier Description

, (comma) Ctrl Move cursor to label left of
cursor (main shortcuts).

, (comma) Alt Decrease auto curve limits
(zoombar selected curve).

. (period) Scroll window timeline dis-
play right (not insertion pt).

. (period) Ctrl Move cursor to label right of
cursor (main shortcuts).

. (period) Alt Move cursor to edit boundary
right of cursor position.

↑ (up arrow) Increase timeline duration
(zoom out timeline).

↑ (up arrow) Ctrl Increase audio sample wave-
form scale.

↑ (up arrow) Alt Increase auto curve limits
(zoombar selected curve).

↑ (up arrow) Ctrl-alt Increase all auto curve limits.
↓ (down arrow) Decrease timeline duration

(zoom in timeline).
↓ (down arrow) Ctrl Decrease audio sample wave-

form scale.
↓ (down arrow) Alt Decrease auto curve limits

(zoombar selected curve).
↓ (down arrow) Ctrl-alt Decrease all auto curve limits.
PGUP (page up) Scroll current track vertical

window pane up.
Mouse wheel UP Scroll current track vertical

window pane up.
PGUP (page up) Ctrl Increase track scale geometry

(zoom in track data).
PGDN (page
down)

Scroll current track vertical
window pane down.

Mouse wheel Down Scroll current track vertical
window pane down.

PGDN (page
down)

Ctrl Decrease track scale geometry
(zoom out track data).

Home Move insertion point to begin-
ning of timeline.
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15.1. Main window

Main window menu keys
Identifier Key Qualifier Description

End Move insertion point to end of
timeline.

Mouse wheel Shift + up Zoom out view without resiz-
ing the window.

Mouse wheel Shift + down Zoom in view without resizing
the window.

Mouse wheel Ctrl + up Move left on the timeline with-
out resize.

Mouse wheel Ctrl + down Move right on the timeline
without resize.

Ctrl + down Move right on the timeline
without resize.

Shift+click Over edit causes highlight sec-
tion to extend to cursor.

Shift+click Over boundary of effect, trims
only that effect.

Shift+click Over Hard Edge of Blade Cut,
toggles marker.

Toggle single trk Tab Toggle single track arming sta-
tus.

Toggle other trks Shift-tab Toggle all of the other tracks
arming status.

Double click On plugin title bar, selects that
area.

Double click On an edit, selects that area.
Double click On subtitle track, displays text

in Line text.
Double click On fade/speed, synch

video/audio ganged.
Shift While dragging auto, turns of

gang.
Double MMB On auto or keyframe, select

that position.
U Paste the last Video transition.
u Paste the last Audio transition.
r Ctrl Proxy quick switch.
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15.2. Compositor window

Main window menu keys
Identifier Key Qualifier Description

F1 Shift Toggle on/off all XYZ of cam-
era.

F2 Shift Toggle on/off all XYZ of pro-
jector.

F1 Ctrl+Shift Use window layout #1.
F2 Ctrl+Shift Use window layout #2.
F3 Ctrl+Shift Use window layout #3.
F4 Ctrl+Shift Use window layout #4.

Timebar LMB Ctrl Changes to the next time for-
mat.

MMB Ctrl Change to the previous time
format.

LMB Moves cursor position on the
timeline.

Click label Hold LMB Drag label to elsewhere.
Click In/Out Hold LMB Drag In/Out pointer else-

where.

Patchbay Shift/Move Hold LMB On Fade slider bar, sets gain to
100% or 0d b.

15.2 Compositor window

Compositor buttons

Compositor window buttons
Identifier Items Shortcuts Description

Tools Protect video F1 Disable changes to the com-
positor output.

Zoom view F2 Zoom in view without resizing
the window.

Edit mask F3 Brings up the mask editing
tool.

+ Edit mask Shift-drag pt. Hold down shift+left mouse to
drag a point.

+ Edit mask Ctrl-drag pt. Hold down Ctrl+left mouse to
move control pointers.
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15.2. Compositor window

Compositor window buttons
Identifier Items Shortcuts Description

+ Edit mask Alt-drag mask Hold down Alt+left mouse to
translate mask.

+ Edit point Shift-set pivot Hold down Shift+middle
mouse to set Pivot point.

+ Rotate mask Wheel-rotate Wheel middle mouse to rotate
around Pivot.

+ Scale mask Shift+Wheel Hold down Shift+Wheel
mouse to scale around pivot.

+ Rotate/Scale Ctrl+Wheel Hold down Ctrl+Wheel to ro-
tate/scale around pointer

+ Delete mask Shift + Del Hold down Shift+ click Delete
button to delete mask.

Ruler F4 Brings up the ruler for usage.
+ ruler hotkey Ctrl Lock ruler to nearest 45 de-

gree angle.
+ ruler hotkey Alt Translate the ruler.
Adjust camera F5 Brings up the camera editing

tool.
Adjust projector F6 Brings up the projector editing

tool.
Crop layer/outpt F7 Crop a layer or output.
+ crop tool Click-drag In video, starts a new rectan-

gle.
+ crop tool Click-drag Over rectangle to reposition.
+ crop tool Alt-click In cropping rectangle to trans-

late.
Get color F8 Detects color at current spot &

stores temporary.
Show tool info F9 Works with editing/cropping

buttons.
Show safe regs. F10 Draws safe regions in the

video output.
p Turn on/off Click to Play.
Shift+w/Ctrl With transport btn. loops

play; all or with [ ].

Transport (plus 3 below) Same as in Main window.
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15.2. Compositor window

Compositor window buttons
Identifier Items Shortcuts Description

Edit (plus 3 below) Same as in Main window.

Compositor keys

Compositor window keys
Identifier Key Qualifier Description

Keypresses Mid. click+drag Pans the view/moves the im-
age.

Middle mouse Shift Returns to Auto zoom.
RMB Brings up zoom%/auto;reset

cam/proj;hide ctrls.
LMB Zoom Zooms in.
Mouse wheel up Zooms in.
LMB Zoom Ctrl Zooms out.
Mouse wheel dn Zooms out.
LMB Zoom Shift-alt Zooms out.
’+’ or ‘=’ Zooms in video output.
’-’ Zooms out video output.
f Toggle on/off fullscreen.
F11 Reset camera.
F12 Reset projector.
LMB Shift Camera enabled - vertical mo-

tion zooms in/out
LMB Shift Projector enabled - vertical

motion zooms in/out
F1 Ctrl+Shift Use window layout #1.
F2 Ctrl+Shift Use window layout #2.
F3 Ctrl+Shift Use window layout #3.
F4 Ctrl+Shift Use window layout #4.
Click label Hold LMB Drag label to elsewhere.
Click In/Out Hold LMB Drag In/Out elsewhere.

Timebar LMB Ctrl Changes to the next time for-
mat.

MMB Ctrl Change to the previous time
format.
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15.3. Viewer window

Compositor window keys
Identifier Key Qualifier Description

LMB Moves cursor position on the
timeline.

Click label Hold LMB Drag label to elsewhere.
Hold LMB Drag In/Out pointer else-

where.
Hold LMB Preview region drag on blue-

colored bar.

Transport LMB Only Protect enabled,
start/stop forward play.

Edit MMB Only Protect enabled,
start/stop play reverse.

Middlewheel Only Protect enabled, plays
forw/rev 1 frame.

p Turns on/off Click to Play but-
ton.

15.3 Viewer window

Viewer buttons

Viewer window buttons
Identifier Items Shortcuts Description

Transport Rewind home Jump to beginning.
Fast reverse ’KP +’ /Alt-p Toggle double speed reverse

play.
Normal reverse ’KP 6’ / Alt-o Toggle normal speed reverse

play.
Frame reverse ’KP 4’ / Alt-u Render previous frame.
Stop ’KP 0’ / Alt-m Stop playback.
Frame forward ’KP 1’ / Alt-j Render next frame.
Normal forward ’KP 3’ / Alt-l Toggle normal speed forward

play.
Fast forward ’KP Enter’/A-; Toggle double speed forward

play.
Jump to end end Jump to end.
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15.3. Viewer window

Viewer window buttons
Identifier Items Shortcuts Description

(No button) ’KP 5’ / Alt-i Toggle slow speed reverse
play.

(No button) ’KP 2’ / Alt-k Toggle slow speed forward
play.

’KP#-Shift’ Shift added to KP #, adds or
subtracts audio.

’Ctrl-KP#’ If [ ] set, “KP2,3,5,6,+,enter”
play between ptrs..

+ Shift w/Alt Shift with Alt+x above,
adds/remove audio.

+ Shift w/C-
trl

Loops play; all or between In-
/Out.

Left click Start or stop play forward.
Middle click Start or stop play reverse.
Middle wheel Play forward or reverse 1

frame.
p Turns on/off Click to Play but-

ton.

Edit In point ’[’ or ‘<’ Toggle In point timeline
marker

Out point ’]’ or ‘>’ Toggle Out point timeline
marker.

Ctrl-t Clear both In and Out point-
ers.

Splice v Create splice.
Overwrite b Overwrite.
To clip i Copy selection and create clip.
Copy c Copy selection to cut buffer.
Splice ’v’ + Shift Create splice of the entire clip.
Overwrite ’b’ + Shift Overwrite using the entire

clip.
To clip ’i’ + Shift Copy all and create clip.
Copy ’c’ + Shift Copy entire clip to cut buffer.
Show meters Toggle show meters.
Toggle label l Toggle label at current posi-

tion.
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15.4. Resources window Keys

Viewer window buttons
Identifier Items Shortcuts Description

Previous label ’Ctrl←’ Move to label before cursor.
Next label ’Ctrl→’ Move to label after cursor.
Manual Goto g Jump to time selected by

popup.

Mixer Double click On mixer window, pastes into
timeline

Viewer Keys

Viewer window keys
Identifier Key Qualifier Description

Keypresses Right click Brings up fullscreen/zoom/-
close menu.

F1 Ctrl+Shift Use window layout #1.
F2 Ctrl+Shift Use window layout #2.
F3 Ctrl+Shift Use window layout #3.
F4 Ctrl+Shift Use window layout #4.

Timebar LMB Moves cursor position on the
timeline.

Double click If between labels, selects that
section.

Click label Hold LMB Drag label to elsewhere.
Click In/Out Hold LMB Drag In/Out pointer else-

where.
Fat arrow end Hold LMB Preview region drag on blue-

colored bar.

15.4 Resources window Keys

Resources window keys
Identifier Key Qualifier Description

Keypresses Drag Mouse Shift Hold down Shift and drag to
move text icon.
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15.5. Other windows

Resources window keys
Identifier Key Qualifier Description

Double click Draw vicons off- loads media
in Viewer.

Single click Draw vicons on- bigger
thumbnail plays or stops.

Middle click Draw on – brings up Inter-
View modeling.

Wheel move Draw on – increase/decrease
preview size.

Mouse over Draw on – instantly brings up
thumbnail.

v Switch to next Display option.
i Switch on/off info for effects.
o Opens Load files. . . menu.
- load tool Ctrl-a Selects all files.
- load tool Ctrl-z Deselects any highlighted

files.
DEL key Resources/Media, deletes

highlighted from project.
DEL key Shift Resources/Media, deletes

highlighted from disk + OK.
DEL key Ctrl+Shift Resources/plugin, deletes

highlighted from disk + OK.
F1 Ctrl+Shift Use window layout #1.
F2 Ctrl+Shift Use window layout #2.
F3 Ctrl+Shift Use window layout #3.
F4 Ctrl+Shift Use window layout #4.

15.5 Other windows

Other Buttons

Buttons in other windows
Identifier Items Shortcuts Description

An Event Double click On mixer window, pastes into
timeline.
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15.5. Other windows

Buttons in other windows
Identifier Items Shortcuts Description

Record Start/pause space bar Start and pause recording of
current batch.

Label l Toggle label at current posi-
tion.

Double click On channel in window, pops
edit ch window.

Channels Select Select a channel.
Add. . . Add another channel.
Edit. . . Edit the wording associated

with the channel.
Move up Move the channel up in the se-

lection.
Move down Move the channel down in the

selection.
Sort Sort all of the channels numer-

ically.
Scan Scan the available channels.
Delete Delete the selected channel.
Picture. . . Select the device picture.

Double click In Find window, cursor moves
to hilite program.

Double click On batchbay line, selects and
loads ch info.

Remote MENU Toggle remote control state
(grabs/ungrabs keys).

KPTV Open or close the record win-
dow.

KPBOOK Start/stop dvb channel scan.
KPHAND Quit CINELERRA-GG program.

Commercial Shift-A Edit commercial

Other Keys

456



15.5. Other windows

Keys in other windows
Identifier Key Qualifier Description

Most
windows

ESC Cancels operation if no one
grabs first.

ENTER Cancels operation if no one
grabs first.

Overlays LMB Shift Turns off all else, or reverts to
previous state.

Textboxes Tab Move cursor to the next
textbox.

Tab Shift Move cursor to the previous
textbox.

Esc Cancels any active sugges-
tions.

Left arrow with ibeam Backs up 1 character.
Left arrow Ctrl Backs up to beginning of

word/next word.
Left arrow Shift Selects/Deselects previous

character highlight.
Left arrow Ctrl-Shift Selects/Deselects previous

word highlight.
Right arrow with ibeam Moves forward 1 character.
Right arrow Ctrl Moves to beginning of next

word.
Right arrow Shift Adds selection highlight to the

next character.
Right arrow Ctrl-Shift Expands highlight to the next

word.
Up arrow Move up to next line, same po-

sition.
Down arrow Move down to next line, same

position.
Up arrow Shift Selects/Deselects up to the

previous line X-coord.
Down arrow Shift Select/Deselect down 1 line

from the X-coord.
PGUP (page up) Goes to the beginning of the

page.

457



15.5. Other windows

Keys in other windows
Identifier Key Qualifier Description

Pgdn (page
down)

Goes to the end of the page.

PGUP (page up) Shift Highlights selection above
Ibeam to page start.

Pgdn (page
down)

Shift Highlights selection below
Ibeam to page end.

End Cancels selection and goes to
end of line.

End Shift Selects to end of line.
Home Goes to the beginning of the

line.
Home Shift Highlights from ibeam to be-

ginning of line.
Backspace Deletes the character in back

of the ibeam.
Delete Deletes the next character.
Ctrl-c (also+’Shift’) Copies selection to the 2nd cut

buffer.
Ctrl-v (also+’Shift’) Pastes selection from the 2nd

cut buffer.
Ctrl-x (also+’Shift’) Copies selection to 2nd cut

buffer and delete.
Double click On word in textbox, highlites

that word.
Double click On highlighted Probe order,

enables/disables.
Triple click In subtitle script text, loads

line into line text.

Unicode Ctrl-U Shift Go into Unicode enter mode.
Enter Fires the Unicode.
Esc Cancels Unicode state.
Backspace Deletes previous character.
A-F, 0-9 Enters the hex code.
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CHAPTER 16

Configuration, Settings and
Preferences

Figure 16.1: Settings of default Preferences with the Appearance tab selected

The user’s default settings, preferences, and other helpful files are retained across
sessions in a hidden file, called .bcast5, in the user’s $HOME directory. Initially when
CINELERRA-GG is launched there is an empty project and there are program default
settings, and from then on the .bcast5 directory will contain the settings that were
set when quitting. If you need to revert to the default settings, delete the .bcast5
directory contents and restart CINELERRA-GG. Or you may want to rename it tem-
porarily if you think you might want it back later. Although the location defaults
to $HOME/.bcast5, you can use the CIN_CONFIG variable to override this location.
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16.1. Playback A / Playback B

For example: export CIN_CONFIG=/tmp/.bcast5 will use a temporary setup for
testing purposes. It is also useful for multiple users sharing the same home di-
rectory who would like to have different configuration/preferences settings data.
And if you are experiencing inexplicable errors or crashes in CINELERRA-GG, they
may be due to a problem with .bcast5 in which case taking it out of the picture
can at least eliminate this as the cause.

Several ways exist to change CINELERRA-GG’s operational characteristics. A lot of
variations can be made to settings and preferences by using the Settings pulldown
from the main window and choosing Preferences.

16.1 Playback A / Playback B

16.1.1 Audio Out section

The audio drivers are used for both recording and playback. The Audio Out set-
tings affect the outcome when you play sound on the timeline.

Playback buffer samples for playing audio, small fragments of sound are read
from disk and processed sequentially. A larger value here causes more latency
when you change mixing parameters but yields more reliable playback. Some
sound drivers do not allow changing of the fragment, so latency is unchanged
no matter what the value. Since different stages of the rendering pipeline can
change the rate of the incoming data, it would be difficult to disconnect the
size of the console fragments from the size of the fragments read from disk.

Audio offset (sec) the ability to tell the exact playback position on Linux sound
drivers is poor. The audio offset allows users to adjust the position returned
by the sound driver in order to reflect reality. The audio offset does not affect
the audio playback or rendering at all. It merely changes the synchroniza-
tion of video playback. The easiest way to set the audio offset is to create a
timeline with one video track and one audio track. Expand the audio track
and center the audio pan. The frame rate should be larger than 24 f ps and
the sampling rate should be greater than 32000. The frame size should be
small enough for your computer to render it at the full framerate. Highlight a
region of the timeline starting at 10 seconds and ending at 20 seconds. Drop
a gradient effect on the video track and configure it to be clearly visible. Drop
a synthesizer effect on the audio and configure it to be clearly audible. Play
the timeline from 0 and watch to see if the gradient effect starts exactly when
the audio starts. If it does not, expand the audio track and adjust the nudge.
If the audio starts ahead of the video, decrease the nudge value. If the audio
starts after the video, increase the nudge value. Once the tracks play back
synchronized, copy the nudge value to the audio offset value in preferences.
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16.1. Playback A / Playback B

Note: if you change sound drivers or Disable hardware synchronization, you
will need to change the audio offset because different sound drivers are un-
equally inaccurate.

View follows playback this causes the timeline window to scroll when the play-
back cursor moves. This can slow down the X Server or cause the timeline
window to lock up for long periods of time while drawing the assets.

Disable hardware synchronization most sound cards and sound drivers do not
give reliable information on the number of samples the card has played. You
need this information for synchronization when playing back video. This
option causes the sound driver to be ignored and a software timer to be used
for synchronization.

Audio playback in realtime priority (root only) for really old computers, this
setting allows uninterrupted playback during periods of heavy load. It forces
the audio playback to the highest priority in the kernel. Today, it is most use-
ful for achieving very low latency between console tweaks and sound card
output. You must be root to get real-time priority. Only experts might want
to use this because it interferes with ordinary time-share scheduling and can
lock up the system. When this is enabled, audio gets the first shot and burns
audio until audio lets go. To explain, there are 2 kinds of scheduling, time-
sharing which is the default, and real time where the scheduled task must
explicitly request scheduling to allow other tasks to execute. Time-share in-
terrupts when you use up your allocated time slice. Realtime priority audio
will execute audio decode until it finishes, which may slow down other types
of processing like video decoding. Most decoders use a policy that video may
be downsampled to accommodate scheduling, but will never skip audio be-
cause it creates a much more obvious defect. This feature helps to make sure
audio gets priority over video during decode. Be sure to check apply in order
for this feature to take effect.

Map 5.1→2 playback 5.1→ 2 driver downmix maps 6 tracks to 2 channels when
checked, that is mixes 5.1 down to stereo on the output device side. This is
different from the patchbay and menubar functions which reset the pan/mix
levels of the input channels. In this way, you can render 5.1 media, and use
stereo speakers to listen in the same session setup. This downmix only occurs
if the playback is 5.1 (6 channels) and the device config is stereo (2 channels).

Gain set audio gain to a different value than the default of 1.0 This feature, device
level gain, corrects for hardware conditions which some devices may need
to be useful. For example, you may need to increase the gain for a weak
microphone or a noisy speaker, since it affects rendering when you crank up
or down the audio via use of the patchbay. With the audio H/W gain support,
you have the ability to fine tune the audio volume by some numerical value
for the scale. You are adjusting the scaling of data into the audio driver –
H/W scaling is done before it goes into or out of the driver. This is a one time
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16.1. Playback A / Playback B

linear multiplication of the sample values, and may offer better control than
the logarithmic DB gain controls of the application.

Audio driver there are many sound drivers for Linux. This allows selecting one
sound driver and setting parameters specific to it. The currently available
possibilities are listed next.

ALSA is the most common sound driver these days and supports almost all
sound cards. ALSA is frequently updated but is very stable.

OSS was one of the first Linux sound drivers and has an open source imple-
mentation with many sound cards supported.

OSS Envy24 is the commercial version of OSS with a variant for 24bi t96KHz
sound cards. This variant required changes to the way the sound drivers
were used and so needed a different driver.

Raw 1394, DV 1394, IEC 61883 are older audio drivers used by camcorders
and not much else.

Pulseaudio Extends the functionality of ALSA. It is a more modern and highly
supported driver.

Device with the down arrow, you can see the device choices on your computer.

Bits 8, 16 or 24 Bit Linear are the current choices for the number of bits of preci-
sion CINELERRA-GG should set the device for. The meaning of the number of
bits can be misleading. Some sound drivers need to be set to 32 bits to per-
form 24 bit playback and will not play anything when set to 24 bits. Other
sound drivers need to be set to 24 bits for 24 bit playback.

Stop playback locks up this ALSA only checkbox is needed if stopping playback
causes the software to lock up. This has worked some time ago, but may no
longer work as expected

16.1.2 Video Out section

The video drivers are used for video playback in the compositor and the viewer.
These determine how you will see video on the timeline.

Play every frame this causes every frame of video to be displayed even if it means
that the playback of the video tracks fall behind. Most likely you will want
this enabled because, after all, in order to edit you want to see each frame.
However, if you are just watching a big video, you can switch to not play
every frame so that you can at least not be distracted by slowness.

Framerate achieved the number of frames per second being displayed during
playback. This is updated during playback only. The goal is to get as close to
the frame rate as possible, even if Play every frame is not enabled.
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16.1. Playback A / Playback B

Scaling equation Enlarge / Reduce – this algorithm is used when video playback
involves scaling or translation (only X11 video driver). This does not affect
1 : 1 playback. Choices available are:

Nearest Neighbor / Nearest Neighbor low quality output with fast playback.
Often produces jagged edges and uneven motion.

Bicubic / Bicubic Bicubic interpolation is used for both enlarging and reduc-
ing, enlarging blurs slightly but does not show stair step artifacts.

Bicubic / Bilinear High quality output with slow playback. Bicubic interpo-
lation is used for enlarging, which blurs slightly but does not show stair
step artifacts. A bilinear interpolation is used for reduction, which pro-
duces very sharp images and reduces noise. Bilinear reduced images can
be sharpened with a sharpen effect with less noise side effects than a
normal sized image.

Bilinear / Bilinear when slight enlargement is needed, a bilinear enlarge-
ment looks better than a bicubic enlargement. Bilinear uses less CPU
than either Bicubic or Lanczos.

Lanczos / Lanczos is not necessarily a general purpose upscaler, but is in-
tended for low resolution sources. However many people like the sharp-
ening effects. More quality from Lanczos does take more CPU.

DVD subtitle to display DVD IFO files usually contain subtitle tracks. These must
be decoded with the MPEG decoder. Select Enable subtitles to enable subtitle
decoding. There are usually multiple subtitle tracks indexed by number and
starting from 0. Enter the index number of the subtitle track to be decoded
in the DVD Subtitle to display text box or use the tumbler to increase the
index value. Go to the asset corresponding to the MPEG file in the Resources
window and right click. Click on Info. The number of subtitle tracks is shown
at the bottom.

Enable subtitles/captioning for broadcast TV ??

Label cells ??

TOC Program No Table of Contents program number used in DVB ??

Interpolate CR2 images enables interpolation of CR2 images. Interpolation is
required since the raw image in a CR2 file is a Bayer pattern. The interpola-
tion uses dcraw’s built-in interpolation and is very slow. This operation can be
disabled and the Interpolate Pixels effect used instead for faster previewing

White balance CR2 images this enables white balancing for CR2 images if in-
terpolation is also enabled. This is because proper white balancing needs
a blending of all 3 primary colors. White balance uses the camera’s matrix
which is contained in the CR2 file. Disabling white balancing is useful for
operations involving dark frame subtraction. The dark frame and the long
exposure need to have the same color matrix. If you disable Interpolate CR2
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Images and use the Interpolate Pixels effect, be aware the Interpolate Pix-
els effect always does both interpolation and white balancing using the cam-
era’s matrix, regardless of the settings in Preferences. Dark frame subtraction
needs to be performed before Interpolate Pixels.

Video driver normally video on the timeline goes to the compositor window dur-
ing both continuous playback and when the insertion point is repositioned.
Instead of sending video to the Compositor window, the video driver can be
set to send video to another output device during continuous playback. How-
ever, this does not affect where video is routed when the insertion point is
repositioned. Options are listed next.

X11 this was the first method of graphical display on Unix systems. It just
writes the RGB triplet for each pixel directly to the window. It is useful
when graphics hardware can not handle very large frames. And when
X11 is usled with the associated checkbox enabled of use direct x11 render
if possible it can be a really good playback method to speed up playback
for large frames.

X11-XV this was an enhancement to X11 in 1999. It converts YUV to RGB in
hardware with scaling. In some cases it may be the preferred playback
method, but it can not handle large frame sizes. Maximum video size for
XV is usually 1920× 1080.

X11-OpenGL the most powerful video playback method is OpenGL. With this
driver, most effects are done in hardware with the graphics board in-
stalled in the computer. OpenGL allows video sizes up to the maximum
texture size, which is usually larger than what XV supports, depending on
the graphics driver. OpenGL relies on PBuffers and shaders to do video
rendering. Plugins or transitions that do not have handle OpenGL in the
code will use software instead of hardware and this will slow down play-
back. OpenGL does not affect rendering. It just accelerates playback.
X11-OpenGL processes everything in 8 bit color models, although the
difference between YUV and RGB is retained. The scaling equation set
in the preferences window is ignored by OpenGL – it always uses linear
scaling. Camera and projector operations use OpenGL, but some of the
effects may not support OpenGL acceleration.

Raw 1394, DV 1394, and IEC 61883 are for old camcorders.

Default A/B Display the interface is intended for dual monitor displays. Depend-
ing on the value of Display, the Compositor window will appear on a different
monitor from the rest of the windows.

16.2 Recording

The parameters here expedite the File → Record. . . function by allowing the
user to pre-configure the file format and the hardware used for recording, since
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the hardware generally determines the supported file format. Once set, the file
format is applied to all recordings.

16.2.1 File Format section

File Format this determines the output file format for recordings. It depends
heavily on the type of driver used. The menu selections are the same as
those of the rendering interface.

Record audio tracks toggle must be enabled to record audio.

Record video tracks toggle must be enabled to record video. The wrench button
left of both the audio and video tracks toggle, opens a configuration dialog in
order to set the compression scheme (codec) for each audio and video output
stream. The audio and video is wrapped in a container format defined by the
File Format menu. Different wrappers may record audio only, video only,
or both. Some video drivers can only record to a certain container. If the
video driver is changed, the file format may be updated to give the supported
output. If you change the file format to an unsupported format, it may not
work with the video driver.

Realtime TOC setup for DVB recording to automatically generate a Table of Con-
tents. This will scan the stream data on the fly on its way to being written
while the asset is being captured. ??

16.2.2 Audio In section

Record Driver is used for recording audio in the Record window. It may be con-
figured the same as the Record Driver for video if the audio and video are
wrapped in the same stream. Available parameters vary depending on the
driver. The drivers are the same as described in Playback A/B with the addi-
tion of DVB and V4L2 MPEG but no Raw 1394.

DVB Adapter name of a suitable DVB adapter for linux that is usb connected to
your computer and has a connected broadcast TV antenna.??

dev your DVB adapter device number, which is usually 0.

Bits same as described in Playback A/B audio section.

Follow audio config ??

Samples read from device a good value is 2048 or approximate dev buffer size
(2k − 16k probably). Samples to write to disk – at a time. First, audio is
read in small fragments from the device. Then, many small fragments are
combined into a large fragment before writing to disk. The disk writing pro-
cess is done in a different thread. The value here determines how large the
combination of fragments is for each disk write. A good starting value is
48000 but this will will most likely automatically change, probably to 44100
if necessary.
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Sample rate for recording regardless of what the project settings are, the value
set here will be the sample rate used for recording. The sample rate should
be set to the highest value the audio device supports.

Channels to record usually set to 2.

Map 5.1→2 eave unchecked to record all possible channels.

Gain usually leave at default of 1.0, but this device level gain corrects for hard-
ware conditions on some devices which need help. This gives you the ability
to fine tune the audio volume by some numerical value for the scale. It is
useful as better explained for the Gain in the Playback A/B Audio section
discussed previously.

Record in realtime priority (root only) – only experts might want to use this be-
cause it interferes with ordinary time-share scheduling and can lock up the
system. When this is enabled, audio gets the first shot and burns audio until
audio lets go.

16.2.3 Video In section

Record driver used for recording video in the Record window. It may be con-
figured the same as the Record Driver for video if the audio and video are
wrapped in the same container. Available parameters vary depending on the
driver. The drivers available are as follows.

• Video4Linux2
• JPEG webcam
• YUYV webcam
• Video4Linux2 JPEG
• Video4Linux2 MPEG
• Screencapture
• DV1394
• IEC61883
• DVB

DVB Adapter name of a suitable DVB adapter for linux that is usb connected to
your computer and has a connected broadcast TV antenna.??

dev your DVB adapter device number, which is usually 0.

Follow video config ??

Frames to record to disk at a time frames are recorded in a pipeline. First, frames
are buffered in the device. Then, they are read into a larger buffer for writing
to disk. The disk writing is done in a separate thread from the device read-
ing. For certain codecs the disk writing uses multiple processors. The value
set here determines how many frames are written to disk at a time.
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Frames to buffer in device the number of frames to store in the device before
reading and this determines how much latency there can be in the system
before frames are dropped.

Positioning if set to Software timing, use software for positioning information.
Video uses audio for synchronization, but most sound cards do not give accu-
rate position information so selecting this option makes CINELERRA-GG cal-
culate an estimation of audio position in software instead of hardware for
synchronization. You can also choose Presentation Timestamps, Device Posi-
tion, or Sample Position.

Sync drives automatically for high bitrate recording, the disk drives you use may
be fast enough to store the data but your operating system may wait several
minutes and stall as it writes several minutes of data at a time. This forces
the operating system to flush its buffers every second instead of every few
minutes to produce slightly better real-time behavior.

Size of captured frame is the size of the recorded frames in pixels. It is indepen-
dent of the project frame size because most video devices only record a fixed
frame size.

Frame rate for recording the frame rate recorded is different from the project
settings. This sets the recorded frame rate.

16.3 Performance

16.3.1 Performance section

The main focus of the performance section is rendering parameters not available
in the rendering dialog with the obvious gain of perhaps better performance.

Cache size to speed up rendering, several assets are kept open simultaneously.
This determines how many are kept open. A number too large may exhaust
your memory rapidly. A number too small may result in slow playback as
assets need to be reopened more frequently.

Seconds to preroll renders some effects need a certain amount of time to settle
in. Checking this option sets a number of seconds to render without writing
to disk before the selected region is rendered. When using the render farm,
you will sometimes need to preroll to get seamless transitions between the
jobs. Every job in a render farm is prerolled by this value. This does not affect
background rendering because background rendering uses a different preroll
value.

Force single processor use CINELERRA-GG tries to use all processors on the sys-
tem by default, but sometimes you will only want to use one processor, like
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in a render farm client. This forces only one processor to be used. The oper-
ating system usually uses the second processor for disk access. The value of
this parameter is used in render farm clients.

Project SMP cpus to restrict the number of processors utilized, change the count
number. This number will be used for the plugin per load balance operation
cpu limit, which uses smp-cpus to stripe your data. It does not affect the
number of cpus used in any other CINELERRA-GG operation besides plugins.
On large cpu systems, it can come in handy to downgrade the number of cpus
used for some plugins; otherwise it uses all of the processors and splits up
the program into too many pieces which may add considerable overhead in
high cpu count systems.

16.3.2 Background Rendering section

Use background rendering checking this box, enables automatic background ren-
dering. This works in conjunction with the interactive function Settings
menu → Toggle background rendering which sets the point where back-
ground rendering starts up to the position of the insertion point.

Frames per background rendering job his only works if a render farm is being
used; otherwise, background rendering creates a single job for the entire
timeline. The number of frames specified here is scaled to the relative CPU
speed of rendering nodes and used in a single render farm job.

Frames to preroll background the number of frames to render ahead of each
background rendering job. Background rendering is degraded when preroll is
used since the jobs are small. When using background rendering, this number
is ideally 0. Some effects may require 3 frames of preroll.

Output for background rendering background rendering generates a sequence
of image files in a certain directory. This parameter determines the filename
prefix of the image files. It should be on a disk, accessible to every node in
the render farm by the same path.

File format the file format for background rendering has to be a sequence of im-
ages. The format of the image sequences determines the quality and speed
of playback. JPEG is a good choice usually.

Video wrench this has the single option of use alpha. It is by default unchecked.

16.3.3 Render Farm section

In the Render Farm Section are many options that are explained in detail in the
Rendering chapter of this manual. Just make sure if you do not intend to use a
render farm, that Use render farm is not checked.
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16.4 Interface

16.4.1 Editing section

Clicking on edit boundaries (trimming) CINELERRA-GG not only allows you to
perform editing by dragging edit boundaries, but also defines five separate
operations that occur when you drag an edit boundary. Here you can se-
lect the behavior of each mouse button. The usage of each editing mode is
described in great detail in the Editing chapter.

Keyframe reticle the options are Newer, Dragging, or Always. This is used to help
in checking edit alignment across tracks. Always renders a line over all plug-
ins, and dragging only over the drag icon. Never draws nothing.

Snapshot path designates the default directory path for snapshot and grabshot
generated output.

16.4.2 Operation section

Probe Order clicking on this box brings up a popup allowing you to change the
probe order usually for media that is raw camera output but it is also helpful
if you want to ensure that a specific driver is used for certain media; for
example you may want tiff files to be read natively instead of by ffmpeg.

trap sigSEGV always enable this so that if CINELERRA-GG crashes, a dump will be
generated for analysis.

trap sigINT always enable this so that you can use Ctrl-c to interrupt the program
if it appears to be hanging. This will often generate some useful information
for analysis.

Use yuv420p dvd interlace format for DVD media this option maintains the in-
terlacing in Chroma sample addressing, which ordinarily would be deleted
because the upsampling of interlaced chroma fields is normally done using
a progressive algorithm. With this mode enabled, the MPEG decoder uses
a different algorithm for interlaced frames so that the 4:2:0 format chroma
interlacing is preserved.

Min / Max DB for meter Min DB is useful because some sound sources have a
lower noise threshold than others. Everything below the noise threshold is
meaningless. This option sets the meters to clip below a certain level. Max
DB sets the maximum sound level represented by the sound meters. This
value is presented merely to show how far over the limit a sound wave is. No
matter what this value is, no sound card can play sound over 0 dB.

Import images with a duration of # seconds when you load single images, like
png or jpeg, automatically load for # number of seconds. This makes it easier
to see an image on the timeline. If you just want the single frames, uncheck
this option.
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Auto start lv2 gui some lv2 plugins display a glitzy UI (User Interface); for exam-
ple the Calf plugins. For these LV2 plugins, if you want that to automatically
come up without having to click on the UI button on the simplified ui inter-
face, this is the flag to enable that.

Android Remote Control check this to enable using an android device as a re-
mote control for broradcast TV.

Port default port 23432 is used for the android remote control.

Pin default PIN Cinelerra is used for the android remote control.

Shell Commands this button brings up the controls for setting up your own shell
commands or editing previously set up commands. See the section on Menu
Bar Shell Commands for information.

Reload plugin index execute this reload command when you have modified plug-
ins and want to make sure your changes take effect.

Nested Proxy Path designates the default directory path for Nested Proxy files.

Default LV2_Path when there is no system LV2_PATH set, if you want lv2 plug-
ins loaded, you must set the correct directory path name here. When you
change this field, cin will automatically restart and load the newly specified
lv2 plugins.

16.4.3 Index Files section

Screencast below shows part of the Preferences menu where you can change the
index files setup (figure 16.2).

Figure 16.2: Index file setup for your preferred configuration for Render Farm sharing or
anything

Index files go here index files exist in order to speed up drawing the audio/video
tracks. This option determines where index files are placed on the disk.

Size of index file determines the size of an index file. Larger index sizes allow
smaller files to be drawn faster, while slowing down the drawing of large
files. Smaller index sizes allow large files to be drawn faster, while slowing
down small files. The default is currently 4kB for average size files.
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Number of index files to keep to keep the index directory from becoming very
large, old index files are deleted. This determines the maximum number of
index files to keep in the directory.

build ffmpeg marker indexes improves ffmpeg seeks in certain cases although
not clear which ones.

Scan for commercial during toc build used for working with broadcast TV com-
mercial removal.

Delete existing indexes when you change the index size or you want to clean out
excess index files, this deletes all the index files.

Delete clip thumbnails as clip thumbnails accumulate over time, you may want
to delete them to get the disk space back.

16.5 Appearance

16.5.1 Layout section

Theme CINELERRA-GG supports 11 different themes to suit the preferences of
different users (figure 16.3). When you change the theme, CINELERRA-GG auto-
matically saves your session and restarts exactly where you were. The Themes
User Interface are described in more detail next. Akirad themes are all available
in Cin-GG with major thanks to the Cinecutie project for all of their hard work.
These modifications provide alternative User Interface environments and allows
you to choose your favorite look. Be aware that when you change your theme,
CINELERRA-GG will automatically shutdown and restart for it to take effect. The
theme you choose is preserved across sessions.

Theme choices available:

• Blond
• Blond-cv
• Blue
• Blue Dot
• Bright
• Cakewalk (default)
• Hulk
• Neophyte
• Pink Lady
• S.U.V.
• UnFlat

How To Change your Theme:
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Figure 16.3: Shows the Cakewalk theme (courtesy Olaf )on Preferences window with list of
themes

To change a Theme in the main window pulldown, select:

Settings → Preferences;

then in Preferences window, click on the Appearance tab. In the Editing section
in the lower left hand corner, click on the down arrow next to Theme to see your
choices. Click on your desired choice from the list given. Check OK, CINELERRA-GG
will automatically shutdown and restart.

Plugin Icons here are currently 4 choices for different plugin icons to include the
old original.

Layout Scale allows for setting up scaling for your 4K monitors or any monitor
where you would like the text and icons to be just a little bigger or a lot
bigger. This scale setting is automatically saved across sessions. When first
using CINELERRA-GG, or if Layout Scale has never been set, the initial value is
0.0. This means an automatic probe of the biggest monitor in use will be used
for the setting. The advantage of this is that "new users" with a 4K monitor
will not immediately be discouraged with too small text/icons. Leaving it at
0 instead of 1 is what most people will do and is probably preferable so that
if you move to a different monitor with different dimensions/resolution, it
will automatically probe. If a user wants to prevent the automatic scaling,
Layout Scale should be set to 1.0 to avoid the smaller characters that might
result due to the probe of a non-1080p monitor.
For testing or when you are using a different sized monitor and want to ensure
the expected size for larger text/fonts before you start the application from
a window, you can keyin:
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BC_SCALE=2.0 {your Cinelerra path}/bin/cin

The scaling size would only be in effect for that run of CINELERRA-GG. This is
particularly useful in the case where the user makes a mistake in setting the
Layout Scale and CINELERRA-GG becomes unusable. Then the environment
variable, BC_SCALE, can be used to overcome the bad setting so that you can
get back into CINELERRA-GG and fix the scaling parameter. For example, if
you accidentally set Layout Scale to 112.6, keyin the following and then when
you get back into CINELERRA-GG, fix Layout Scale value in Preferences.

BC_SCALE=1.0 {your Cinelerra path}/bin/cin

View thumbnail size you can increase or decrease the thumbnail size – larger
size uses more cpu.

Vicon quality increase the quality used for thumbnails to get more clarity of pixels
– this will use more memory.

Vicon color mode modify the color mode to Low, Medium, or High for the thumb-
nails – High will look the best but takes more memory.

16.5.2 Time Format section

Various representations of time are given so that you can select the most convenient
one for you. The time representation can also be changed by Ctrl-clicking on the
timebar in the main window.

• Hours : Minutes : Seconds : xxx
• Hours : Minutes : Seconds : frames
• Frames
• Feet-frames [frames per foot . . . ]
• Seconds

16.5.3 Color section

Highlighting Inversion color modify the selection area color; default is ffffff which
is white. When you make a selection, that area becomes an inverse image
which by default becomes a whitish color. You can set it to a different color
by modifying the hex value in the box next to Highlight inversion color. Keep
in mind that if you set the value to a low value, you will not be able to see
the outlined selected area (for example the hex value "f" is not readily visi-
ble and leads to confusion). A leading 0 or blank is not allowed and will be
automatically changed to ffffff.
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YUV color space default is BT601; others BT709 (high definition), BT2020 (ultra
high definition).

YUV color range JPEG [0− 255] and MPEG [16− 235]

16.5.4 Flags section

This section contains many useful options to cater to the various preferences of
individual users.

Show tip of the day if checked, a tip will be displayed in a popup box when start
up CINELERRA-GG.

Autocolor assets to make it visually easier to see your clips on the timeline that
are from the same media file, you can have them automatically colored. Use
of this feature requires additional memory and cpu on every timeline redraw,
therefore smaller computers may not want this checked on.

ffmpeg probe warns rebuild indexes this warning is very important for switch-
ing from using ffmpeg to using native formats, such as in the case of MPEG,
so that you are reminded to rebuild indexes. If you do not rebuild the in-
dexes, seeking on the timeline back and forth could very well be problematic,
meaning it might not go to the right place. Notification about rebuilding the
indexes will appear by default as shown in the figure 16.4 when you click on
the FF icon in the main timeline in the upper right hand corner. Once you
click on Don’t show this warning again you will no longer be warned and this
flag will no longer be enabled.

Figure 16.4: Default warning when you click on FF icon in main window

EDL version warns if mismatched in the case of a Batch Render, it is often help-
ful to be warned if the EDL has been changed so that you are aware that what
is going to be rendered is different than your current EDL session.

Create Bluray warns if not root if checked and you are not logged in as root, you
will get an error message in order to avoid doing a lot of work and then failing
out because root is required for automount and to write on DVD hardware.

Warn on creating file references if checked, you will always be warned when
using "File by Reference", that is when an EDL is opened as Reference. This is
best left checked to ensure that you are aware of the fact that when changes
are made to this file and rendered, any other uses of the same file will be
affected and modified also.
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Popups activate on button up this is the default but if unchecked, popups acti-
vate on button down.

Set Input Focus when window entered this is checked on by default because on
some operating system distros, when you move your mouse to a different
window, nothing happens and you are left wondering why you can not en-
ter information. When checked this causes the input focus to shift to any
CINELERRA-GG window when the cursor enters an exposed region of the win-
dow which eliminates the need to switch input focus by tabbing.

Click to activate text focus Click to activate text focus

Click to deactivate text focus if checked, you will have to click to deactivate text
focus.

Always show next frame in this mode the insertion pointer reflects the same as
the Compositor so that for playing forward, the result is what looks like 1
was added to the frame displayed in the Compositor window. This is fully
explained in another section (Playing is Different than Seeking/Positioning!).

Use thumbnails in resource window the Resource Window displays thumbnails
of assets by default, but drawing asset thumbnails can take more time and
CPU so you may want to uncheck this.

Perpetual session is very useful for working on a project over many days so you
can just quit before shutting down and the next time you start up CINELERRA-
GG you will be right back where you left off. You will retain all of your undo’s
and redo’s.

Clears before toggle when using copy/paste in drag and drop mode some users
prefer to resort to the addition of the Ctrl key for adding multiple selections.
By checking this flag, the user retains usage as is commonly done for listbox
operations.

Timeline Rectify Audio for displaying rectified audio on the timeline instead of
a standard audio waveform, check this flag. The waveform is cut on the zero
line, thus making the silent areas more visible and the waveform is stretched
more over the entire height of the audio track, which improves the visibil-
ity of certain areas. This only affects the timeline and not any other audio
waveform displays.

16.6 About

This section gives you information about the CINELERRA-GG program and version
you are running. The original author’s copyright and name are first and foremost.
Next is a textbox with additional information and a summary of the monthly new
features of note. Below that is a summary of the GPL License and the fact that it
is provided without any warranty. Then the licensing verbage is the item that you

475



16.7. Environment Variables for Customization

may need to refer to most often – the built date and time in case you need to know
which version you are currently running.

16.7 Environment Variables for Customization

Environment variables are global variables in the shell which all applications can
read. They are set with a command like set VARIABLE=value or export VARIABLE=value.
Environment variables can be viewed with a command like env. The values set
can be removed with unset VARIABLE.

The following exported variables can be set to customize your environment.
The CIN_CONFIG variable could be extremely useful for testing purposes or for
multiple users sharing the same home directory who would like different default
preference settings.

CIN_BROWSER name of browser to use by Shell Cmds options

CIN_BROWSER configuration data; defaults to $HOME/.bcast5

CIN_DAT location of data files, such as documentation, models, tip of the day

CIN_LADSPA LADSPA directory path; use colons to separate multiple paths; this is
convenient to define an alternate directory if you share the same executable
directory among computers via NFS.

CIN_LIB location of library programs, such as bdwrite

CIN_LOCALE locale text domain path to use for translating text

CIN_PLUGIN plugin directory path

CIN_RENDER complete filename with path, that was used for select file to ren-
der to in the current session’s last successful Render job; this is used in the
RenderMux defined Shell Cmds and is available for any user-defined script
inside CINELERRA-GG

CIN_PKG used to set your text domain, that is the locale path pointing to the
cin.mo language file

CIN_XSYNCH (for Developers only) set to 1 helps debugging for windows primi-
tives to execute immediately and not be buffered up so you can see what is
happening

One example:

export CIN_BROWSER=chrome #would override default firefox for Shell Cmds.
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Another example:

export CIN_CONFIG=/tmp/.bcast5 #use a temporary setup for testing purposes.

BC_USE_COMMERCIALS=1 to activate the commercial database (db) methods.

BC_TRAP_LV2_SEGV to get a dump of the failure of an LV2 plugin for help in de-
bugging.

BC_FONT_SCALE=1.2 for changing the default size of the characters to be twice
as big.

BC_ICON_SCALE=1.1 for changing the default size of the icons to be bigger; can
change # to any. You can increase the size of the characters in the fonts and
icons on your CINELERRA-GG system. This will make it easier to read the
characters if you have trouble seeing the default small letters, which have
been auto-scaled based on the window geometry. The user-friendly font/i-
con scaling default is 1 but you can set it to any decimal value. To defeat
default auto scaling and get any size characters/fonts, override the setting
via the previous 2 listed shell environment variables. This is very sensitive,
meaning that even a small increase in the numeric value can vary the size
quite dramatically.

BC_FONT_PATH=<colon-separated-search-path-for-fonts> to add additional font sets
for the Title plugin or to remove all fonts set to : (colon). An example:
export BC_FONT_PATH=/usr/share/fonts.

BC_FONT_DEBUG=1 debug for determining which font is causing problems. 0 for
no debug.

BC_SCALE=1.2 for setting up scaling for your monitor where you would like the
text and icons to be bigger where 1.2 is a # chosen accordingly; in this case
the text and fonts will be 1.2 times the normal size of 1. Refer to the previous
Appearance section, Layout Scale for more details.

LADSPA_PATH specify an alternate set of ladspa plugins or include the default with
the use of a colon separated list of directories to search for LADSPA plugins.
This is always used first and if it does not exist, then the value for CIN_LADSPA
becomes LADSPA_PATH.

LV2_PATH specify a certain set of LV2 plugins to use. Separate multiple paths with
colons.

LANG CINELERRA-GG can be localized to display menus and messages in many
languages. Currently there are 16 languages in addition to English, of vary-
ing quality. Some information on these is in the Translations chapter. Lan-
guage settings are normally read from your Linux O/S locale settings. The
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CINELERRA-GG program checks environment variables to determine your set-
tings to use as the language. First it checks the value of LANGUAGE and will
use that if set. If that is not set, then it checks LC_ALL and finally if that is not
set either, it will use the value of LANG. You can check the current settings
from a window by looking at the output of the printenv command.
To run on a language different than the one selected on your system just
change the LANG environment variable before starting up CINELERRA-GG like
this:

export LANG=2 letter language code_2 letter country code.UTF-8
For example, from a window type:

export LANG=es_ES.UTF-8
then startup CINELERRA-GG and you will have translations in Spanish. If you
started CINELERRA-GG from that same window using {cinelerra_path}/bin/cin
you will see a message in that window something similar to:

lang changed from en_US.UTF-8 to es_ES-UTF-8
However, although generally LANGUAGE is not set, it is possible that an-
other progam that was run may have set it so you may have to substitute
LANGUAGE for the word LANG above.
Depending on your Operating System and Desktop application, there may
be other ways to accomplish a language change. For example, on Fedora
with the Gnome desktop, the simplest method of switching your language to
German and immediately starting CINELERRA-GG is to use:

LANGUAGE=de {cinelerra_path}/bin/cin

SHUTTLE_CONFIG_FILE alternate shuttle configuration file.
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CHAPTER 17

How some stuff works

This section describes in detail some areas of CINELERRA-GG to help explain how
things work.

17.1 Copy/Paste and Highlight Usage

There are 3 types of copy/cut and paste methods which exist in X windows, and
most modern programs use 2 of them. The 3 cases are:

cut_buffers 0-7 these are obsolete but they still work and are the simplest to use.

highlighting called primary selection; almost all clipboard programs only use this.

copy and paste called secondary (or clipboard) selection. Some more modern
programs use Ctrl-C/Ctrl-X and Ctrl-V for this (some use other keys or quali-
fiers, like Shift).

How it works:

All of the methods use window properties to attach data, called a selection, to a
source window. The program advertises the selection by using the X server. The
window property used determines which selection type is set/advertised by the
new selection.

When a paste is used in a target window, the target program requests the ad-
vertised selection data. This may access one of two buffers depending on which
type of load/paste action is used. The user loads a cut buffer via Drag select or
Ctrl-C/Ctrl-X, and pastes a cut buffer via middle mouse press or Ctrl-V.

CINELERRA-GG cut and paste:

1. Text cut and paste operations

To use a text selection, create a drag selection in textboxes by pressing and holding
left mouse button with the pointer over the beginning of the text selection, then
move the pointer over the desired selection to the selection end, then release the
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17.1. Copy/Paste and Highlight Usage

mouse button. This continuously reloads the primary clipboard buffer and high-
lights the text selection. It can then be pasted to most programs by pressing the
middle mouse button with the pointer over the text insertion point. Some exam-
ples of these programs are xterm, gnome-terminal, cinelerra, and browser input text
boxes. After you create a text selection, if you then press Ctrl-C the selection will
also be copied to the secondary (or clipboard) selection buffer. This second paste
buffer can be used for a more lasting save effect, since it will not be lost until you
again press Ctrl-C (copy). Using Ctrl-V (cut) will also copy the selection to the
secondary clipboard buffer, and then delete the selection from the textbox. If you
press Ctrl-V (or paste) in a target window, the secondary selection will be inserted
at the target window cursor. If a text selection exists in the target window, it is
replaced by the pasted text.

2. Media cut and paste operations

To create a media selection, highlight a region on the CINELERRA-GG media time-
line, then use the main menubar or compositor/viewer edit panel to operate the
clip cut, copy, or copy-keyframe menu buttons. This selection can then be pasted
to a target selection on the timeline using the main menubar or compositor/viewer
edit panel to operate the clip paste or paste-keyframe operation. Also, by using
the resource window you can select the Clips folder and right mouse the resources
list box, then use the Paste Clip menu item to paste the selection to a named clip.
Additionally, these methods work between running instances of CINELERRA-GG,
which means you can move media clips between the CINELERRA-GG program in-
stances. The clip data is also copied to the secondary clipboard buffer. This makes
it possible to examine the clip content directly if so desired.

3. The older cut_buffer method

• For text, if there is an active selection when a window closes, it uses cut_buffer0.
Normally when a paste is performed, the target window notifies the selection
owner to send it now when you do a paste, but if the window has closed there
is no source window, so no pasting. Some programs, like CINELERRA-GG, use
cut_buffer0 as a fallback. This makes it possible to paste data from a closed
window.

• To move media clip, data cut_buffer2 is used because it does not require
the selection owner interface, and works simply and reliably. This buffer is
not normally in use by other programs.

Final note

When a text selection is set, the selected text is redrawn using selected-highlight
color when the textbox loses focus. This convenience feature shows the active text
selection as you move the pointer to the new target window. When a new selection
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is set anywhere else on your screen, the current text selection will be redrawn
using the inactive-highlight color as the textbox loses selection ownership. In most
CINELERRA-GG themes, the drag selection text-highlight color is BLUE (#0000F F),
the selected-highlight color is SLBLUE (#6040C0) – really sort of purple, and the
inactive-highlight color is MEGREY (#AFAFAF).

17.2 Playing is Different than Seeking/Positioning!

17.2.1 Playing/Seeking

Seeking targets and displays the next frame. The next frame is targeted because
frame zero has no previous. When you seek, you reposition to just before the
target frame, and since the play direction has not been established (there is no
direction when seeking) it shows you the next frame. This produces the expected
behavior when you seek to frame zero; you see the first frame. Seeking displays in
the compositor what you are getting ready to work with/edit/etc; always showing
the next frame in relation to the cursor. Technically, since seeking just resets the
position, it would be correct not to update the compositor, but it is best to seek
and show the next frame to confirm that it is the frame you expected to see.

Playing shows you what has just been played in the compositor window. It is
not the same as seeking. When you use Keypad 1 to play frame forward, then
the 1st frame that is played and shown in the compositor window is frame zero
(which was already displayed). The position is incremented to 1. Press Keypad
1 yet again, and the next frame displayed is 1, and the new position is 2, and
so on. According to the implemented strategy, the insertion point moves to track
playback. When playback stops, the insertion point stays where playback stopped.
Thus, with playback you change the position of the insertion point.

Simple explanation of what you will be seeing in the compositor when playing:

Play forward the frame to the right of the cursor in the timeline gets displayed.

Play backward the frame to the left of the cursor in the timeline gets displayed.

The reason behind this play methodology is that you want to know what you just
played so that you know what matches what you just saw/heard in case that is
the desired stuff. You don’t want the compositor to show you what you have not
yet played – you need to see this frame to analyze/check to see if it is what you
want. This behavior applies to any playing operation, such as the keypad or Frame
forward / Frame reverse buttons. You can still easily see the actual insertion point
in the zoombar at the bottom of the timeline – sixth button over or 3rd button
from the right side. Also note the following:
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Blinking insertion point on the timeline seeking/positioning was the last oper-
ation.

Solid non-blinking insertion point on timeline playing was the last operation.

Example and explanation

1. open a small example of 10 numbered frames (or use the Title plugin to
add a timestamp)

2. press "f" to fit the timeline

3. make sure settings → align_cursor_on_frames is set

4. seek to frame 4 by clicking on the timeline at position 4, compositor shows
the 5th frame, since the media counts from 1 and the timeline counts from
0. This is correct behavior.

5. press KP1 to play next frame. According to playback strategy: When play is
forwards, the next unit is displayed, and the position is advanced one unit. So
the next frame is 4, (shows the 5th frame) it is displayed. The position is
advanced from 4 to 5. This is correct behavior.

6. press KP4 to play the previous frame. According to playback strategy: When
play is in reverse, the previous unit is displayed, and the position is reduced one
unit. So the previous frame is 4, (shows the 5th frame) it is displayed. The
position is reduced from 5 to 4. This is correct behavior.

If you watch the zoombar (bottom of main window) position, it shows the current
position is just before the next frame to be displayed when going forwards, and
just after the frame to be displayed when going backward.

To recap, position is usually set in the program as a location that is between a
previous and next frame/sample unit such that the next unit equals the seek target.
After position is reset using a seek operation, the next unit is displayed, which is
the seek target. When play is forward, the next unit is shown, and the position is
advanced one unit. When play is in reverse, the previous unit is shown, and the
position is reduced one unit. At the beginning, there is no previous, and at the
end, there is no next, but silence is rendered at the end.

17.2.2 Always Show Next Frame

Since some users prefer the insertion pointer to reflect the same as the Compositor
a choice is available. For playing forward, there is a preference option which re-
sults in what looks like 1 was added to the frame displayed in the Compositor win-
dow. To enable this mode, check the box Always show next frame, and this will
be saved to .bcast5. The option checkbox is in the Settings → Preferences
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→ Appearance tab and when checked, any forward plays in the Compositor win-
dow show the same frame as you would with a seek. Reverse plays and plays using
a selection or In/Out pointers (with Ctrl) work the same as without this prefer-
ence set. But you will no longer see the odd behavior where if you frame advance
forward and then frame advance backward, the displayed frame does not change
– instead it will change and look more natural. A color indicator that shows in the
main track canvas timeline and the compositor timeline reminds the user which
mode is currently active. The cursor in the compositor turns red for default mode
and white for Always show next frame mode. The top portion of the insertion cursor
in the track canvas mirrors this, with red for default and white otherwise.

Figure 17.1 using the default playing method where the frame in the compositor is
the one that was just played; in this case play was in the forward direction. Note
that the insertion pointer in the main track canvas shows 01:20 but the compositor
show 01:19 so you know what you last saw. Also, the cursor/cursor tops in both
windows is red.

Red cursor in Compositor
red cursor in Timeline

Figure 17.1: "Default" mode with red cursors

Figure 17.2 using the Always show next frame method where the frame in the
compositor is the same one that would have shown with a seek; in this case play
was in the forward direction. Note that the insertion pointer in the main track
canvas shows 01:20 and the compositor shows 01:20. Also, the cursor/cursor
tops in both windows is white.

17.2.3 Seeking Issues

If you have an issue playing a video and not seeing it in the Compositor (just see a
black screen), it is most likely due to the media not being designed to be editable.
It is most likely not damaged. Generally it just does not have keyframes which
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White cursor in Compositor
White cursor in Timeline

Figure 17.2: "Always show next frame" mode with white cursors

are needed for seeking which is what is done when you move around the media
and start playing in the middle. The media plays just fine in the compositor if you
always play from the beginning because then you don’t need keyframes to seek.
You can get around this problem if you proxy the media. A good choice to use for
the proxy would be use scalar, ffmpeg/mp4 and size of 1

2 . The proxied media can
then seek and you will see it play in the compositor because keyframes exist.

17.3 Color Space and Color Range Affecting Play-
back

Playback single step and plugins cause the render to be in the session color model,
while continuous playback with no plugins tries to use the file’s best color model
for the display (for speed). This can create a visible effect of a switch in color in
the Compositor, usually shown as grayish versus over-bright.

The cause of the issue is that X11 is RGB only and it is used to draw the re-
fresh frame. So single step is always drawn in RGB. To make a YUV frame into
RGB, a color model transfer function is used. The math equations are based on
color_space and color_range. In this case, color_range is the cause of the gray off-
set. The YUV mpeg color range is [16..235] for Y, [16..240] for UV, and the color
range used by YUV jpeg is [0..255] for YUV.

The mpeg YUV color range [16..235] looks sort of like an old TV if it is viewed on
a display with jpeg range [0..255]. A common expression for the short mpeg color
range is compressed color range. If you are using color compressed data with no
display decompression, or using uncompressed data and the display is configured

484



17.4. Automatic "Best Model" Media Load

to use compression, the color range will appear squished or stretched, as too gray
or too much contrast.

Figure 17.3: Color space and Color range

The use X11 direct when possible pref-
erence with X11 as your video driver,
generally means that you value speed
over color range. When you use this
feature and the color range preference
is mismatched, the color switch offsets
will still appear. This is a personal
choice solely for improved speed.

There is now program code to look
for RGB versus YUV color model mis-
matches. You can override the default
setup, which mirrors the original code, via the following.

Settings → Preferences → Appearance tab in the lower left hand corner
(Figure 17.3):

YUV color space default choice is BT601, alternate is BT709 (High Definition),
BT2020 (UHD)

YUV color range default choice is JPEG, alternate is MPEG

17.4 Automatic "Best Model" Media Load

When you load media with the insertion strategy of replace current project, the
program code will automatically use the "best model" for the render based on
the media’s codec. The best model is pretty much going to be what works well
for television. This automation was added to facilitate easy use of CINELERRA-
GG. Which is to say that it is difficult for a new or occasional user to set all of
the necessary parameters as best as possible so the program does it for you. This
means you do not have to conform your project which ordinarily would have to have
been done in the Resources window with RMB click on the highlighted media and
choosing Match project size.

However, this automatic method leads to the dilemma of where you have a 10-
bit media file and it would get loaded as RGBA-8 when you would prefer it to
be RGBA-Float. So instead of using replace current project when loading your
media, you would have to make sure the project is first set to your desired For-
mat. This could be done with the File→New project and then setting your Color
Model to RGBA-Float and whatever other parameters you want. Next when doing
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a File→Load, use Append in new tracks or Create resources only. This avoids using
the "best model" technique and uses instead what you have designated so that if
you set the Color Model to RGBA-Float that will be in effect.

It is important to note that even when using the "best model" no bits are lost if the
input media is 10-bit and the Color Model is RGBA-8. This is because the media
will be loaded using the "case BC_RGB16161616" where 16 stands for 16 bits. It
fills the other 6 bits not used for 10 bits with zeros.

17.5 Simple Animation (Festival)

This functionality was added to CINELERRA-GG by the original author to create
simple animation. The file type for this animation is Scene.

To get started making a simple animated movie copy from the directory:
<cin_path>/cinelerra/tests the text2movie and text2movie.xml.
You can see what this does via File → Load...→ text2movie.xml. The file
text2movie acts like a normal asset, except changes to it are immediately reflected
on the timeline without reloading and the length is infinite. You can just edit the
text2movie file to change the script. If the length of the movie increases, drag the
right edit handle to extend the edit or use the pulldown Edit → edit length.
There is one audio channel created for every character. The frame rate, sample
rate, frame size, and camera angles are fixed. To see these values, right click on
the asset and look at the Asset info.

Currently the functionality that is implemented focuses on dialog between two
people. The models are defined in model files saved in CINELERRA-GG’s exe-
cutable directory (for example, /opt/cinelerra/models). The character model
and voice is selected separately in the script. The model files have the same name
that appears in the script and are usually saved in the directory the script is in, but
there is a defined search path, if not. You can create new models for the script with-
out affecting the entire system. These models define the total size of the model
along with the images used – the model images are 2D png images because all
the animations are baked. Since there is no 3D renderer, no custom movement is
supported.

There are currently 2 actions implemented:

1. Character2 can cut off character1 if character1’s dialog ends in “. . . ”

2. Inserting “[pause]” anywhere causes the character to pause. This is useful
for adjusting the timing of dialog.
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This is simple animation so you can expect speech synthesis not to be that good.
And you will have to adjust punctuation and spelling based on the sound. Since
the dialog is rendered on-demand, there is a delay when each character starts to
speak but you can split dialog into shorter blocks to reduce the delay.

17.6 Textbox Non-std Character / Unicode Insertion

If you want to enter a special character – like a bullet, an accent grave charac-
ter, or a mathematical summation symbol – you can use the unicode equivalent in
a textbox to do so. In the textbox, keyin Ctrl-Shift-U which puts you into single
character unicode mode, then keyin the numerical value for the intended single
character followed by the carriage return. For a voluminous list of possible spe-
cial characters, you can go to https://unicode-table.com/en/ on the internet to
choose by highlighting a character to get its numerical equivalence. For example,
U + 2022 is a bullet. If you make a mistake, you can use the backspace key or if
you want to exit unicode-insert-mode, use the ESC key. This feature is especially
useful with the Title plugin and for naming Tracks in the main window.

However, it is worth mentioning that some special characters are available via
the compose key in the current distribution. https://en.wikipedia.org/wiki/
Compose_key
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CHAPTER 18

Troubleshooting and Help

You can report potential problems, bugs, and crashes to the CINELERRA-GG website
at:

https://www.cinelerra-gg.org

Here you can log the problem into the MantisBT bugtracker, or use the forum Q&A
for help from other users, or email the problem using the address:cin@lists.cinelerra-
gg.org It is usually more helpful if instead of starting CINELERRA-GG from its appli-
cation icon, start from a window so that if there are error messages related to the
problem, they can be captured from the screen and emailed or logged. The com-
mand to run from a window is: <directory_path of where you installed
cinelerra>/bin/cin – for example if installed in /mnt0/build5/cinelerra-5.1,
you would execute the following command to start the program:
/mnt0/build5/cinelerra-5.1/bin/cin
The problem you are experiencing may be as simple as an error due to the settings
in your $HOME/.bcast5 subdirectory so you may want to first rename your current
.bcast5 in order to start with default settings. By renaming the directory instead
of deleting it, you will be able to put it back and not lose all of your preferences.

However, there are some easy things to do to fix errors that may have resulted from
media problems, computer problems, or operational missteps so you can proceed
without having to wait for help. These are outlined in 18.3 - be sure to read
down through Common Problems where some exact error messages are mentioned
along with their cause or solution. Other troubleshooting help is included in other
sections of this manual for specific features.

18.1 What to Include in Problem Reports

For the best help, if you have a reproducible problem and can provide the following
list of materials for analysis, it is usually possible to figure out what the problem
is and how to fix it. It may be a simple usage or setup mistake or a real bug which
a programmer would like to fix rather quickly. Although it is not always necessary
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18.1. What to Include in Problem Reports

to provide this much information, it eliminates the try this or did you do this? and
a lot of guessing rather than heading straight for a solution. Even if you can not
provide all of this information, please report the problem in case other users are
having the same issue.

Basically we need to see what you see with the input, output, and session file.
Here is a list of the items that will most likely help to resolve the problem, but all
of them will not necessarily be needed.

• Provide a detailed description of the problem and the last operation per-
formed if you remember it.

• Supply a small representative sample of the original input that exhibits the
issue.

• If possible, also provide the rendered output, again using that representative
sample.

• Save a session file used with that same sample which will contain a lot of
setup parameters; the best method to do this is to use the File → Export
Project. . . with the Copy option. That way all of the files will be in 1 location
and easily loaded onto any other computer.

• To make sure that the same rendering setup is used, it may be necessary to
send an additional session file at the definition point just before rendering
starts.

• Include the Operating System name and version number and version of Cin
that you are running. You can find the date and time built in the Settings
→ Preferences, About tab, bottom left corner.

It is better to upload any files to a drop site as some of them can be quite large.

How to create a session file: from the menubar pulldown File → Save_as. . .
and choose a filename, for example /tmp/beforerender.xml Do this after you
have the situation setup so can see values in use. As just stated, Export Project
option provides the most inclusive session information, but size could make it very
large and cumbersome to upload or download.

How to create a representative small sample:

1. open the input media, set up the scenario as you normally would to start the
project render;

2. select 5-15 seconds of media using the edit mode left mouse button drag
highlighting on the timeline;

3. start the render dialog (Shift-R), set the filename path, and set Render range
to Selection;

4. recommended Insertion strategy is Replace current project; then press the check-
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mark OK. The result will load replace the current project for you to review to
ensure the error still occurs. If this small sample does not create the error,
try a different section or upload the entire input media.

18.2 Crash Dumps for Analysis

If you get a SEGV crash and can explain what steps you took, a /tmp/cinelerra_<pid>
.dmp file is very useful for analysis. You can also use Ctrl-c in the controlling
window to force an INTR signal interrupt when you think the program is hung
up. You can only perform one Ctrl-c as the second Ctrl-c quits out of the pro-
gram. It is best to upload the .dmp, input files and other files to datafilehost or
similar temporary site as they may be quite large. The .dmp filename looks like
/tmp/cinelerra_<pid> .dmp Log a bug report or email all helpful information
on the crash, location of uploaded files, and list of setup steps that illustrate the
problem to cin@lists.cinelerra-gg.org

1. Use the latest version of CINELERRA-GG as you want to make sure the problem
has not been fixed.

2. Be sure gdb is installed (usually installed but if not, it is easy to do so).
3. Run as root if at all possible (this enables using gdb to create a full /tmp/cinelerra*

.dmp file).
4. Be sure Settings → Preferences → Interface → trap SEGV and trap

INTR are checked.
5. Invoke the error. This should create the file /tmp/cinelerra-<pid>.dmp

For those who can not run as root or can not create the problem while running as
root, another method to create a dump is available. Here are the steps to do so –
you should also have gdb installed.

1. Temporarily login as root and key in:
echo 0 > /proc/sys/kernel/yama/ptrace_scope
This opens up ptrace, used by gdb (the debugger). You will want to reverse
this when done.

2. Run CINELERRA-GG as an ordinary user from a window using the command
line and try to create the problem. If the program crashes, this should produce
a file named /tmp/cinelerra*.dmp where * is a number. The dump usually
takes about 30 seconds or so to complete after the failure invokes the crash
handler, so be patient.

3. Email the output that shows in the window from where you started up CINELERRA-
GG and upload or directly email the /tmp/cinelerra*.dmp file (this file may
be too large for the Mailing List).
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4. After you are finished creating/testing the problem, reverse the previous set-
ting while logged in as root by keying in:
echo 1 > /proc/sys/kernel/yama/ptrace_scope

Even if you are not logged in as root or have ptrace enabled, if you have a .dmp file
and know what the last thing you did is, please provide the .dmp file for analysis.
There is a low probability that the dump will prove useful, but if the problem can
be recreated it can usually be fixed!

18.3 When things go wrong

Sometimes things go wrong and there are some ways to continue your work with-
out much trouble. Below is a list of items to try before abandoning your session.

1. If your computer or the program crashed, you can use the File pulldown
choice of Load backup to get back to the last automatically saved session. It
will most likely not include the last few operations that were done though.
But if you forgot to Load backup when you restarted Cinelerra, you have a
second chance to use File → Load and select $HOME/.bcast5/backup.prev
as long as you only loaded a different file and have performed no editing
operations.

2. If you accidentally destroyed your current project by a Load with Replace
current project when you should have changed the Insertion strategy, and
you had not saved a recent backup, this is another time when it is useful to
use File → Load and select $HOME/.bcast5/backup.prev as long as you only
loaded a different file and had performed no editing operations.

3. If you suddenly get errors or hangs on media or strange looking tracks, you
might want to rebuild indexes. You can do this in the Resources window with
a right mouse click on the media to get a pulldown with the Rebuild index
option. For an easy way to rebuild for all of your media use Settings →
Preferences, Interface tab, Index Files section, Delete existing indexes.
Over time, as you load media, the indexes will automatically be recreated
so each load takes a little longer, but this quite often is all that is needed to
repair a media problem.

4. On an older computer, if you are playing media and it can not keep up, you
can turn off Play every frame in the Video Out tab of Settings → Preferences,
Playback tab. You will then see the video jump as it skips frames in order to
stay caught up.

5. The Cache size can be lowered to 1048 if playback seems choppy or if you have
problems with lv2 plugins, or you can increase the Cache size for better flow.
This can be changed in Settings → Preferences, Performance tab.
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6. After saving your session and settings and exiting CINELERRA-GG, you might
want to rename your current $HOME/.bcast5 directory and start with the
default setup. This will eliminate your settings as the potential cause of a
problem; however, all of your preferences will be lost until you go back to
your original .bcast5.

7. You can also temporarily rename just CINELERRA-GG_rc in your $HOME/.bcast5
directory, so that a new file with the original name will be created with orig-
inal defaults. You will lose your preferences, but it is just for testing and
you can move back the renamed CINELERRA-GG_rc over the new one if that
is not the cause of the problem. Be sure to stop and restart CINELERRA-GG
whenever you rename this file.

8. Some media has only a single keyframe at the beginning of the file so that
moving anywhere on the timeline results in just a black image in the com-
positor. CINELERRA-GG needs more keyframes to determine position. You can
temporarily use Settings → Proxy to 1

2 size to put in keyframes. How to
use Proxy is explained in Proxy settings and Transcode.

9. If you have enabled an Automation Curve such as Fade or Speed on your track
but it does not show, it could simply be because the range minimum and
maximum are incorrectly set in the zoom bar. Set them to more reasonable
values until you see the lines appear. Just as a reminder, the zoom bar is on
the bottom of the main window (figure 7.1).

10. If the rate at which frames are captured during Recording is much lower
than the framerate of the source, the video will accumulate in the recording
buffers over time and the audio and video will become out of sync. Decrease
the number of frames to buffer in the device in Settings → Preferences,
Recording tab so that the excess frames are dropped instead of buffered.

11. If loading files locks up, this might be because CINELERRA-GG is building pi-
cons/vicons for the Resources window. If you load a large number of images
it needs to decompress every single image to build a picon/vicon. Go into
Settings → Preferences, Appearance tab and disable Use thumbnails in
resource window to skip this process. Keep in mind though, that it only has to
create these thumbnails the first time a new piece of media is loaded or the
values are changed.

12. For an older computer with less CPU power, in Settings → Preferences,
Appearance tab, be sure that Autocolor assets is disabled; set View thumbnail
size & Vicon quality& Vicon color mode to lower values or switch to No Play
instead of Full Play in the Resources window (this is to the right of the word
Visibility in the left hand side of that window). You will then have more CPU
and more memory available to do actual editing.

Some Helpful User Readable Text Dumps
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On the File pulldown, there is a Dumps option with a submenu of dump EDL,
Plugins, Assets, and Undo. In all cases, you will have to have started CINELERRA-
GG from a window instead of from an application icon and the text results will be
shown in that window.

• Dump EDL will display your current EDL state on the screen in the window
from where you started Cin. This can be useful to see information concerning
a specific edit or a file path.

• Dump Plugins will show the names of the currently loaded plugins.
• Dump Assets displays the media assets that you have loaded and various per-

tinent details on each, such as samplerate, width, and height.
• Dump Undo will dump the last 32 edits on the undo stack exactly as kept,

which can be useful if you are looking to see how far back in the undo to go
to get to a specific spot.

Common Problems

Some messages you may see in the startup window may or may not be errors.
Some examples are:

FFMPEG::open_decoder: some stream times estimated: /your directory/filename

This is not a problem. Basically, when you open a file if a stream has a known
duration, there is no message. If the duration is unknown, it is estimated by using
the File Size and Bitrate to estimate the duration. This may just indicate that the
stream number CINELERRA-GG uses versus ffmpeg may be counted differently.

AudioALSA::write_buffer err -32(Broken pipe) at sample #

This indicates that there is something wrong with the audio. Some reasons for this
are:

• You simply stopped playing in CINELERRA-GG while the audio is in progress.
• Running on a computer where there is no sound card.
• Incorrect setup of the audio parameters in the Settings → Preferences,

Playback tab.
• Your sound system is already in use by another program, like when playing

tunes outside Cin.

Playback does not keep up so you hear the audio ahead of the video.
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When this occurs, it most likely means that there is not enough CPU power to keep
up. You can go into Settings → Preferences, Playback tab and uncheck Play
every frame. Not playing every frame means that as it plays, if it can not keep up
with doing all it has to do to change the frame into a vframe and then draw it, the
program just notes that it is falling behind so skips frames to catch back up. This
does not affect rendering. A different solution is to use Background Rendering as
described in Rendering.

CINELERRA-GG will not start and produces error message on the startup window.

There can be various reasons that CINELERRA-GG does not come up. Some of the
recent reasons are listed here. Please notify the www.cinelerra-gg.org website when
you have any unknown startup issues.

• Cin doesn’t come up in Debian with compiz window manager running. Workaround
is to use a different window manager or bring up cin first and then compiz.
There is also a report that Compiz leads to single frame problems after a cer-
tain amount of time in the case where you switch to fullscreen mode and than
back to normal node – cin stops working and so you will have to restart cin.

• When a library goes from one version to a later version, sometimes a pre-built
Cin binary will fail because it was created at a different version than the one
the user has on their computer. This seems to happen more frequently on
Arch distros because Arch has continuous releases and is usually kept up to
date. An example of the error message you might see in your startup window
would be:
cin: error while loading shared libraries: libvpx.so.5:
cannot open shared object file: No such file

You can usually install the required library to fix the problem. A temporary fix
may be to create a symlink but this must be done with extreme caution as it may
create an unstable condition. A better workaround is to use a tarball to install the
software instead of the package build until the libraries are in sync between the
build and your Operating System install.

Loading a very large number of media files, for example 500 clips, crashes CINELERRA-
GG with messages similar to the following that are displayed in the window from
where you started Cin:

BC_DisplayInfo::init_window: cannot open display "".
BC_DisplayInfo::init_window: cannot connect to X server.
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unjoined tids / owner 42
00007feb27fff700 / 00007feb8f496700 9MainError
00007feb267fc700 / 00007feb7affd700 18FFMPEGScanProgress
...

This usually indicates that you are out of Operating System file descriptors. You
can increase the amount easily with the following command line: ulimit -n
4096 where 4096 is a size suggestion but can be increased. You can include this
command line in your .bashrc or .profile file for the user login which gets
run every time you login, or modify the Operating System limit for everyone in
the system file, which for Fedora is /etc/security/limits.conf. Alternatively,
you can reduce the number of file descriptors needed by going into Settings
→ Preferences, Appearance tab and unchecking the flag use thumbnails in re-
source window.

Masking Feather is not working and produces error messages on the startup window
similar to:

0:1(10): error: GLSL 4.30 is not supported. Supported versions are: 1.10, 1.20,
,→ 1.30, 1.40, 1.00 ES, and 3.00 ES

Playback3D::print_error:
#version 430 // vertex shader
in vec3 in_pos;
void main000() \{
gl_Position = vec4(in_pos-vec3(0.5,0.5,0.), .5);
}
void main() \{
main000();
}

In the mask window, check the box Disable OpenGL masking to use software instead
of OpenGL.

18.4 Menu Bar Shell Commands

In order to provide some types of help, the Menu Bar Shell Commands are available
for customization purposes. In the main window on the top line containing the
File, Edit, . . . Window pulldown menus, all the way to the right hand side is the
shell cmds icon. You might see a small gold-color bordered box with the> _._ inside
and if you mouse over it, the tooltip says shell cmds. This is a configurable popup
which gives you the ability to see a table of Shortcuts in html format, refer to the
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reference manual or execute a pre-defined script to perform a specific task, such
as some type of post processing which you plan on performing on a repeat basis.
Unless redirected elsewhere, the output from executing any script-type commands
will be displayed in the window from where you started CINELERRA-GG.

The Shell Cmds popup menu items are configured in:

Settings → Preferences → Interface → Shell Commands

This runs a dialog that lets you Add/Del/Edit the scripts in the main menu popup.
Possible options are:

1. Add a new menu item/script:

• click on the Add button
• in the Label box, change the word new to the desired menu label (for

example: Graphics Editor)
• in the Commands box, type the command lines to be included in the

script (for example: gimp)
• click the green checkmark for OK in the Commands window
• click the green checkmark for OK in the Shell window
• click on OK or Apply in the Preferences window

2. Del to delete an existing menu item

• select to highlight an entry in the CINELERRA-GG: Shell listbox
• click on the Del button
• click the green checkmark for OK in the Shell window
• click on OK or Apply in the Preferences window (the entry is now deleted)

3. Edit an existing menu item:

• select to highlight an entry in the CINELERRA-GG: Shell listbox
• click on the Edit button (the Commands window appears)
• set the label and/or commands to the new desired values
• click on the green checkmark for OK in the Commands window
• click on the green checkmark for OK in the Shell window
• click on OK or Apply in the Preferences window

Next time you click on the shell cmds icon, you will have the changes you made in
effect.

Both the Add and Edit options have checkboxes in the Commands window for the
following:
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• OnExit notify choose Always, Never, or On error to get a popup window
notify

• run path/script.sh + argvs to run a particular script with argvs ($1,
$2,. . . arguments)

When modifications to the Shell Cmds are included in a new CINELERRA-GG re-
lease, they are not added to your Preferences file automatically unless you create
a new one. But if you have added no custom scripts, you can update your cur-
rently existing $HOME/.bcast5/ Cinelerra-GG_rc file to delete the lines that are
all grouped together that begin with the letters: SHBTN (the entire line – these are
the SHell BuTtoNs). You should first Quit out of CINELERRA-GG, edit the file, and
then when you restart CINELERRA-GG, it will create the new default buttons in that
same file.

There are 2 specific CINELERRA-GG file names that have unique characteristics that
allow for usage from a user-defined script. The first one is an environment variable,
CIN_RENDER which is used in the RenderMux shell command that is already setup.
It contains the complete path and filename of the file in your session that you
selected as Select a file to render to when you ran a Render operation.

The second one concerns usage of the Resource window assets to use as argvs in
shell scripts. The added command line can ONLY be a script. Then if your script
refers to $1, $2 and $3 and you highlight 3 files in the Media folder, their full path
name will be used as the argvs to your script. For example, if you added a shell
commands script /workspace/script.sh that contains the following lines:

cp ‘‘\$1’’ /tmp/temporary_copy
cp ‘‘\$2’’ /tmp/new_copy
cp ‘‘\$3’’ /tmp/file_to_upload

and you highlight 3 files in the Resources window called ABC.mp4, 123.mp4, and
Final.mp4 and execute your added script from the Shell Cmds icon, you will be
copying those 3 highlighted files to the new names on /tmp.

There are some Help features currently included in the Shell Cmds menu. Those
available are:

1. Current Manual in PDF format from cinelerra-gg.org or automatically down-
loaded.

2. Setting Shell Commands how to which explains how to configure your own
commands.
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3. Shortcuts html file for easily looking up a particular shortcut.

4. RenderMux shell script to use ffmpeg concatenate to copy files such as look.mp4001,
look.mp4002, look.mp4005. . . that were rendered using Create new file at
each label or with the Render Farm.
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Figure 18.1: Some windows used to manipulate Shell Commands scripts

18.5 CINELERRA-GG Command Line -h

To see the command line parameters available to use with CINELERRA-GG, key in:

<your Cinelerra-GG directory path>/bin/cin -h

What will be shown in the window where this line was entered is:

Usage:

./cin [-f] [-c configuration] [-d port] [-n nice] [-r batch file] [filenames]

-d = Run in the background as renderfarm client. The port (400) is optional.
-f = Run in the foreground as renderfarm client. Substitute for -d.
-n = Nice value if running as renderfarm client. (19)
-c = Configuration file to use instead of /root/.bcast5/Cinelerra_rc.
-r= batch render the contents of the batch file (/root/.bcast5/batchrender.rc) with
no gui. batch file is optional.
-S = do not reload perpetual session
-x = reload from backup
filenames = files to load
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CHAPTER 19

Performance and other Tips

Performance of CINELERRA-GG is related to the software and video format being
used in conjunction with your computer system hardware – the number of CPUs
and its speed, I/O bus speed, graphics card, and amount of available memory. A
basic, less powerful system will be sufficient for users working with audio only or
lower resolution video formats. Higher end computers will be needed when play-
ing and working with higher resolution formats, like 1080p or 4k. Adding effects
and multiple tracks will require more cpu, memory, and various other resources to
perform at an acceptable level.

Perhaps the easiest method for determining if your performance could be improved
is to look at the numerical value displayed as Framerate achieved. Good perfor-
mance means that when Play every frame is set in Settings → Preferences,
Playback A tab, the frames/second (frames per second or fps) in playback might
be almost always at the maximum rate of your project setting and/or video frame
rate. You can check this in Settings → Preferences, Playback A, by watch-
ing Framerate achieved while playing forward. A higher number is better, up to the
format frame rate of the video.

Some computer hardware factors to consider for better performance are listed
here:

• Multi-core and more SMP processors greatly improve CINELERRA-GG speed
by making use of threads.

• A large amount of free memory available can help speed up operations by
avoiding unnecessary disk swaps and keeping videos easily accessible in mem-
ory.

• Video editing is almost always I/O intensive. To create longer running videos
at high resolution you will want to have a lot of disk space available on fast
access disks.

• CINELERRA-GG benefits from OpenGL hardware acceleration. A good graph-
ics card is worthwhile to have.

• Multiple monitors really come in handy to increase productivity as you can
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see more information and in bigger windows so you do not have to keep
moving windows around.

Besides the above hardware recommendations, this section covers tips for perfor-
mance improvements and tips on how to perform some specific tasks, often for
older media.

19.1 Hardware video acceleration

With certain newer, more powerful graphics boards and newer device drivers,
there is the potential for enhanced decode and encode performance. Decode refers
to loading and playing video in CINELERRA-GG. The GPU, Graphics Processing Unit,
on the graphics board is accessed via one of the following libraries: vdpau or vaapi.
The hardware acceleration done by the graphics card increases performance by ac-
tivating certain functions in connection with a few of the FFmpeg decoders. This
use makes it possible for the graphics card to decode video, thus offloading the
CPU. Decode operations are described here next. Encode refers to rendering video
and is described at the end of this section under GPU hardware encoding.

VDPAU, Video Decode and Presentation API for Unix, is an open source library
to offload portions of the video decoding process and video post-processing to the
GPU of graphics boards, such as Nvidia. It may also apply to Nouveau and Amdgpu
boards (by wrapper), but that has not been verified.

VA-API, Video Acceleration API, is an open source library which provides both
hardware accelerated video encoding and decoding for use mostly with Intel (and
AMD) graphics boards.

Currently only the most common codecs, such as MPEG-1, MPEG-2, MPEG-4, and
H.264 /MPEG-4, are accelerated/optimized by the graphics card to play these par-
ticular video formats efficiently. The other formats are not optimized so you will
see no performance improvement since the CPU will handle them as before, just
as if no hardware acceleration was activated. There are many different graphics
cards and computer systems setup, so you will have to test which specific set-
tings work best for you. So far this has been tested at least with Nvidia, Radeon,
and Broadwell graphics boards on some AMD and Intel computers; depending
on the graphics card, two to ten times higher processing speeds can be achieved.
However, most graphic operations are single-threaded so that performing the op-
erations in the hardware may actually be slower than in software making use of
multiple CPUs, which frequently multi-thread many operations simultaneously.
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19.1.1 GPU hardware decoding

1. Verify that you have installed libva-dev or libva on your operating system.

2. Verify that you have installed libva-intel-driver on your operating system

3. Verify that you also have libvdpau-dev or libvdpau installed.

4. Verify Settings → Preferences, Playback tab, Video Driver is set to X11
– or X11-OpenGL if that produces better results for your configuration.

5. Before starting CINELERRA-GG, you can set an environment variable that can
be easily reversed and then, to run from the CINELERRA-GG installed directory,
key in:

CIN_HW_DEV=vdpau ./cin # for computers with Nvidia and some other graphics cards
CIN_HW_DEV=vaapi ./cin # mostly for computers with Intel or AMD specific graphics

,→ hardware

If you find that the environment variable setting is advantageous for your CinGG
usage and you want to always use it, you can add it in your $HOME directory
.profile file which takes effect every time you log in. The line you would add
would look something like this:

export CIN_HW_DEV=vdpau
or
export CIN_HW_DEV=vaapi

It might be more difficult to analyze problems as a result of using the GPU be-
cause of the wide variation in hardware. When you do not set the CIN_HW_DEV
environment variable, the code will work exactly as before since this feature is
self-contained.

There is also a Settings → Preferences, Performance tab, Use HW device flag
with a pulldown to set up none, vdpau, vaapi, or cuda. To ensure it takes effect, it
is best to set it the way you want, quit out of CINELERRA-GG and then restart. Its
current purpose is for flexibility, but there is a possibility that it might eventually
take the place of CIN_HW_DEV – both are not needed.

Precedence of the decode hardware acceleration settings are:

– yourfile.opts is checked first so is of the highest priority; special .opts usage
is described below
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– environment variable CIN_HW_DEV is checked next

– preferences Use HW device settings is of the lowest priority

Hardware decoding in CINELERRA-GG

There are 4 phases during CINELERRA-GG’s handling of hardware acceleration.
These first 2 steps occur just before the first read.

1. Check to see if Hardware Acceleration is enabled, usually indicated by CIN_HW_
_DEV being set to vaapi or vdpau. If enabled, try to activate the decode device,
and if that fails revert to software.

2. The next step is to send some data to decode to see if that works. If this does
not work, you will see an error message of HW device init failed, using SW
decode.

These next 2 steps occur during any read. Now there is no turning back to software
so if the hardware gets an error, that video will not be handled correctly.

3. Read the media and send the raw stream data to the device for processing.

4. Read the device to receive the decoded data, and convert it to the session
color model. If the GPU can not convert the data, you will see the error
message of Error retrieving data from GPU to CPU.

Due to variations in user’s computer hardware configuration, it is often suggested
that you refer to your startup window to check for error messages. Since your sit-
uation is unique, the error may not have been seen by anyone else and is probably
unknown/undocumented. For debugging problems, modify in the CINELERRA-GG
ffmpeg subdirectory, the file: decode.opts by temporarily changing the line from
loglevel =fatal to loglevel =verbose and restarting CINELERRA-GG.

Possible improvements or differences

1. The Frames Per Second (FPS) in playback might usually be at the maximum
rate. You can check this in Settings → Preferences, Playback A, look-
ing at Framerate achieved; the higher, the better.

2. Percent of the CPU used should be less, thus saving more CPU for other op-
erations.

3. Some users get the the impression that playing seems smoother.

4. The CPU fan noise may go down as the CPU is used less.
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5. The GPU graphics fan noise may go up as the GPU is used more.

Using the GPU is going to react differently depending on your hardware, software,
and the number of files loaded. A good way to determine how well it is performing,
is to watch the CPU load from another window running the command line routine
top. Consider the following possibilities:

• If you only use smaller videos occasionally and then use other codecs than the
ones mentioned previously as being the optimized set, it is usually a better
idea to stay with the default settings without all the hardware tests.

• If you have 4 cores or less, but a really good gaming card, using vaapi/vdpau
could be a big help.

• If you load only a couple of files, the GPU vaapi/vdpau should be faster de-
pending on your graphics board and how capable it is.

• If you load 10 camera Mixers of H.264 format, it always seems to work a lot
better playing them.

• If you have an epyc AMD chip with 128 CPUs and load 50 files, without
vaapi/vdpau may be better.

Special .opts file

The situation may arise where you have enabled hardware acceleration and after
loading several files for a project, you find that a file had some kind of error result-
ing in a black video instead of an image or you see an error message pop up which
states something like Error retrieving data from GPU to CPU or err: Unknown er-
ror occurred. Because the CIN_HW_DEV environment variable is either all or none,
ordinarily in order to correct the non-working video you would have to turn off
hardware acceleration for the entire project/session. However, there is a way to
continue working on your project without having to reload all of your files. You
still use the environment variable and it will be effective for all of the formats it
is able to handle, but you make an exception for any of the files that erred out.
To do this you simply create a file in the same directory with the same name as
the erring file with the different extension of .opts. The contents of this .opts file
would just be the one line of:

cin_hw_dev=none

Conversely, if you have a bunch of files in your project, like dnxhd format, that are
not hardware accelerated, but you have an accompanying large file of type .mp4
for which you would like the hardware acceleration, you can leave the CIN_HW_DEV
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variable unset (that is, do not use it) and just create an .opts file containing the
line:

cin_hw_dev=vdpau

For example your file, test.mp4, would have a side-kick called test.opts that
will use the GPU for decoding/playing and the other files will just use the soft-
ware. This is of some advantage because the ones that can not use the GPU if
the environment variable is enabled, will not have to even check which saves a
minuscule bit of time.

It is important to note that if using the .opts file to override the default ffmpeg
/ decode.opts file, you will most likely see more warnings (not really errors)
in the CINELERRA-GG startup window because the standard decode.opts file has
loglevel = fatal whereas the default is loglevel = error. To avoid seeing all of the
extra warnings, you can simply add the line loglevel=fatal to your .opts file.

To verify hardware acceleration

Probably the easiest way to tell if hardware acceleration is working, is just to look
at the messages in the window from where you started Cin (not available if start
using the application icon). For example load a png, dnxhd, or some other non-
supported format file and you will see messages similar to those below. The line
HW device init failed, using SW decode indicates that the vdpau/vaapi HW (hard-
ware) decode is not available so will use SW (software) decode instead.

Failed to get HW surface format.
HW device init failed, using SW decode.
file:/tmp/media/aer_zypr.mp4
err: Success

or

Decoder dnxhd does not support device type vdpau.
HW device init failed, using SW decode.
File:/tmp/media/test.gxf
err: Success

or

HEVC with NVIDIA, VDPAU driver is buggy, skipping
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If you would like to see more information on what is occurring, you can modify
in the CINELERRA-GG ffmpeg subdirectory, the file: decode.opts by temporarily
changing the line from loglevel=fatal to loglevel=verbose and restarting CINELERRA-
GG. Then you will see messages in the startup window like:

[AVHWDeviceContext @ 0x7fc9540be940] Successfully created a VDPAU device
(NVIDIA VDPAU Driver Shared Library 390.116 Sun Jan 27 06:28:58 PST 2019) on X11

,→ display :0
[h264 @ 0x7fc950159380] Reinit context to 1920x1088, pix_fmt: vdpau
[h264 @ 0x7fc92c3dd4c0] Reinit context to 1920x1088, pix_fmt: yuv420p

Again, to measure the performance run top from another window to check the
CPU usage which will go lower as more work is offloaded to the GPU graphics
card instead (it may go down by 2 to 10 times) or check the Framerate achieved
while playing.

Some mixed preliminary results that have been reported are provided below.

Case 1:

X11 Video Driver set in Settings → Preferences, Playback A tab:

CIN_HW_DEV=off ./cin CPU 58%
CIN_HW_DEV=vdpau ./cin CPU 32%
CIN_HW_DEV=vaapi ./cin CPU 82%

X11-OpenGL Video Driver set in Settings → Preferences, Playback A tab:

CIN_HW_DEV=off ./cin CPU 48%
CIN_HW_DEV=vdpau ./cin CPU 12%
CIN_HW_DEV=vaapi ./cin CPU 80%

Best is the least amount of CPU usage. Note that in this Case 1, using the X11-
OpenGL video driver is better than using the X11 video driver.

Case 2:

X11 Video Driver set in Settings → Preferences, Playback A tab:
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CIN_HW_DEV=off ./cin CPU 60%
CIN_HW_DEV=vdpau ./cin CPU 11%
CIN_HW_DEV=vaapi ./cin CPU 60%

X11-OpenGL Video Driver set in Settings → Preferences, Playback A tab:

CIN_HW_DEV=off ./cin CPU 67%
CIN_HW_DEV=vdpau ./cin CPU 60%
CIN_HW_DEV=vaapi ./cin CPU 67%

Best is the least amount of CPU usage. Note that in this Case 2, using the X11
video driver is better than using the X11-OpenGL video driver.

Older graphics cards or non-performing graphics cards will probably bring only a
small amount of improvement or no speed advantage at all. You can check to see
if vdpau is implemented for your specific Nvidia board at:

https://download.nvidia.com/XFree86/Linux-x86_64/304.137/README/supportedchips.
html

And, you can see what your specific hardware and software might support by run-
ning either vainfo (available in the libva-utils package) or vdpauinfo (available
in the vdpauinfo package) from the command line. For example which "Profiles"
your hardware can handle is listed in the output such as Main and High. Partial
examples of each are shown below.

# vainfo
vainfo: VA-API version: 1.4 (libva 2.4.0)
vainfo: Driver version: Intel i965 driver for Intel(R) Broadwell -2.4.0.pre1 (2.3.0-11-

,→ g881e67a)
vainfo: Supported profile and entrypoints
VAProfileMPEG2Simple
...
VAProfileH264Main
VAProfileH264High
...
VAProfileH264MultiviewHigh
VAProfileH264StereoHigh
...
VAProfileVC1Simple
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...
VAProfileVP8Version0_3

# vdpauinfo
display: :0 screen: 0
API version: 1
Information string: G3DVL VDPAU Driver Shared Library version 1.0
...
Decoder capabilities:

name level macbs width height
----------------------------------------------------
MPEG1 ---not supported ---
MPEG2_SIMPLE 3 65536 4096 4096
MPEG2_MAIN 3 65536 4096 4096
H264_BASELINE 52 65536 4096 4096
H264_MAIN 52 65536 4096 4096
H264_HIGH 52 65536 4096 4096
VC1_SIMPLE 1 65536 4096 4096
VC1_MAIN 2 65536 4096 4096
VC1_ADVANCED 4 65536 4096 4096

One last item of note, nvdec is also enabled in the ffmpeg build, but at this time it
is not known how this decode option on Nvidia graphics boards works or does not
work in conjunction with vdpau.

19.1.2 GPU hardware encoding

Encoding using hardware acceleration of your graphics board GPU is included in
CINELERRA-GG but it is of limited availability and works only with a specific set of
hardware graphics boards, a certain level of graphics driver versions and only with
certain ffmpeg formats. The encoding is done via vaapi (libva installed), which is
known to work with Intel HD graphics boards and some others or via nvenc as
developed by Nvidia for Nvidia graphics boards.

Broadcom, Intel HD, AMD

To use hardware acceleration for rendering (that is, encoding) you do not have to
set a preference or an environment variable, as was required for decoding. To use
this feature you use an ffmpeg render options file which specifies a vaapi codec,
such as h264_vaapi. You must include this line in that options file to trigger the
hardware probe: CIN_HW_DEV=vaapi
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There are currently 4 options files available in the Render menu already set up for
you that you see when you select the Video wrench and use the down arrow on
the first line in the menu. These are:

h264_vaapi.mp4 known to work on Intel computer with Intel Broadwell graphics
driver

mpeg2_vaapi.mp4 known to work on Intel computer with Intel Broadwell graph-
ics driver

mjpeg_vaapi.mp4 error message of open failed with mjpeg_vaapi. . . on above
computer

hevc_vaapi.mp4 error message of open failed with hevc_vaapi. . . on above com-
puter

Other option files can be added as needed for your specific hardware if it is known
to work for you, such as VP8 and VP9. An example of the included CINELERRA-GG’s
ffmpeg/video/h264_vaapi.mp4 file (figure 19.1):

mp4 h264_vaapi
cin_hw_dev=vaapi
profile=high

According to an online wiki, hardware encoders usually create output of lower
quality than some software encoders like x264, but are much faster and use less
CPU. Keep this in mind as you might want to set a higher bitrate to get output of
similar visual quality.

Results of a particular test case performed on a Intel, 4-core computer, with Broad-
well Graphics using an mp4 input video/audio file with dimensions of 1440x1080/29.97 f ps
is shown next (note, filename is tutorial.mp4). This may very well be a best case
scenario! But clearly, at least on this computer with only 4 cores, the hardware
acceleration seems to be quite advantageous. A comparison of the 2 output files
using ydiff as described in the Appendix (C.1) shows no obvious defects.

CPU usage Render Time File Size File

none 388% 100 secs 36,862,542 h264.mp4
vaapi 150% 19 secs 74,522,736 h264_vaapi.mp4
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Figure 19.1: Render menu setup to encode using GPU with vaapi

Nvidia graphics boards

To use hardware acceleration for rendering (that is, encoding) you do not have to
set a preference or an environment variable, as was required for decoding. To use
this feature you use an ffmpeg render options file which specifies the nvenc codec,
either h264_nvenc.mp4 or nvenc.mp4. There are several requirements in order
for this to work on your computer as listed here:

1. Nvidia graphics board at or above a certain hardware level. For h265, newer
boards are required.

2. Software drivers for your graphics board must be installed on your computer.

3. The driver must support at least API version 9.0 – minimum required Nvidia
driver for nvenc is 390.25 or newer. You will see error messages on the startup
window if you are on lower versions.

If you try to render using h264/h265_nvenc.mp4 formats and do not have an
Nvidia graphics card or this feature was not built in, you will see in the win-
dow from where you started CINELERRA-GG, the error message: Cannot load
libcuda.so.1
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A small test using 2 minutes from the 4k version of Big Buck Bunny shows using
nvenc can be about 4 times faster. The test was done on a 4 core Intel laptop with
an Nvidia 950M graphics board.

CPU usage Render Time File Size File

none 388% 20 mins 18 secs 156,517,069 h264.mp4
nvenc 252% 5 mins 44 secs 42,052,920 h264_nvenc.mp4

Of note in this test, 388% CPU usage with only 4 cores shows that there is probably
slow down because there is no more CPU power available. Therefore, using the
GPU hardware acceleration with nvenc provides a significant speed-up. Also, note
the larger file size without making use of the GPU – this probably indicates that
there is a big difference in bitrate or quality parameter settings used in the options
file and this should be taken into consideration.

Important Tip

There is one last potentially significant graphics speedup when using the X11-
OpenGL driver for users with Nvidia graphics boards who are seeing frames/sec
achieved lower than what the video format is set to. You may want to disable sync
to vblank (an option for OpenGL) in NVIDIA X Server Settings for the proprietary
drivers. This could increase your frames per second on playback.

19.1.3 Effects (OpenCL, Cuda)

CUDA® is a parallel computing platform / programming model developed by
Nvidia that provides big increases in computing performance through use of the
GPU. It was first introduced in about 2006 for applications in computationally
intense fields such as astronomy, biology, chemistry, and physics.

At the time this was written, the use of Cuda is not going to improve the playing and
rendering of video in CINELERRA-GG except in the case where you use a specific
Cuda-enabled plugin that is computationally intense – sadly, most of what Cin
does, Cuda will not help. Cuda is mostly a block oriented algorithm which works
well for such things as a flock of birds all flying next to each other.

The same as for vaapi and vdpau, you can enable Cuda in the:
Settings → Preferences, Performance tab, Use HW Device
but it will not affect anything unless you have Cuda installed on your system and
have built CINELERRA-GG yourself with Cuda build enabled. To install it on your
computer, you will need to do the following:
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1. Make sure you have the Nvidia proprietary library drivers for your graphics
board already installed and up to date.

2. Go to the Nvidia Cuda development website and choose one of the available
operating system’s such as Fedora, OpenSuse, CentOS, Ubuntu, . . . at https:
//developer.nvidia.com/

3. You will be installing repositories by package – this will be around 3 GB.

4. Also, install the Fusion repo, although it is unknown if necessary or not.

There is a very good set of directions on the website to just follow. Once you
have installed the Cuda software on your computer, you must build CINELERRA-
GG yourself – the default flag for a build in the configure script for cuda is auto.
For Arch, and possibly other distros, you may have to supply the CUDA_PATH if it
is not in the standard place. This would be something like:

env CUDA_PATH=/opt/cuda
#OR if using the bash shell:

export CUDA_PATH=/opt/cuda

For all distros you will need to add to the ./configure line in your build script, the
following:

--with-cuda
#so your configure line will look something like this:

./configure --with-single-user --with-booby --with-cuda

There are currently 2 available plugins for show and tell that take advantage of the
hardware acceleration of Cuda – N_Body and Mandelbrot (see CUDA plugins).

An error you may see on your CINELERRA-GG startup window when you have Cuda
installed and try to run one of the 2 plugins is cudaErrorInsufficientDriver. This in-
dicates CUDA 10 (the current version at the time of this writing) is not compatible
with the driver version on your computer. You can either:

1. Upgrade the driver if your board supports newer nvidia builds.

2. downgrade the cuda development package to a version that works for your
board.
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19.1.4 Final Note

In wrapping up this Hardware Acceleration section, you may want to refer to the
following to determine the current supported formats:

https://wiki.archlinux.org/index.php/Hardware_video_acceleration

19.2 Optimized Playback – X11 Direct

Normally, when CINELERRA-GG reads a video frame, it is copied into a Vframe.
This frame may also need other actions performed on it, such as a color model
change. In addition, ffmpeg and libzmpeg can_scale_input. So the read can be
color transformed and scaled just by asking the library to do that. This means
that if the compositor is in a good state with no zoom, the VFrame read can be
done in the fastest render color model, and already scaled to the correct size for
the compositor. In reality, this is not what you need for editing, but quite often
the virtualconsole is not used because the render is media only – that is just data.
If no data transforms are needed and the input scaling can be done, the vrender
program detects this, and tells the codec to transmit the data in a compatible way
to the compositor canvas. This is the X11 direct data path.

With the X11 video driver choice, large format files such as 4K, will playback faster
than either X11-XV or X11-OpenGL. However, you still have the option to turn off
the X11 direct data path if you use Settings → Preferences, Playback A tab
set video driver to X11 and uncheck use direct X11 render if possible.

19.3 Proxy Settings and Transcode

Working with videos that have large image geometry can greatly impede editing.
Instead you can substitute proxies which will create smaller video image files from
the original file that can then be edited more quickly. When you are done working
on this smaller scale, you will need to bring up the Proxy settings menu again, and
change the Scale factor back to the Original size so that all of your edits/work take
affect on that original higher quality video on the timeline.

To use this feature, select Settings → Proxy settings and change the Scale
factor from Original size to your downsized choice. You can choose ffmpeg as the
File Format and a choice of various codecs associated with that. A good choice
is the default of mpeg which can usually be quite fast. In addition, to modify
values for that codec, click on the wrench icon. When you have completed your
choices, just click OK, and then the video tracks will be rendered. This may take
some time, but previous proxy renders will be reused. The proxy videos will be
added to your assets in a separate Proxy folder, and the video track edits will
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19.3. Proxy Settings and Transcode

use the proxies. The assets in both the Media folder and Proxy folder will look
proxied when dragged to the Viewer although the scale may be different. Proxy
downsizing renders all loaded tracks, but only work on the 1st video layer of any
multi-layer media. Rendered proxy media is saved in the same directory as the
original media. However, if you proxy your session, the clips do not get proxied
to the Proxy folder, but if you Drag and Drop the clip from the Clip folder to the
Viewer or the Timeline, you will see that it too is proxied. As usual, you can delete
proxy files from the project or disk in the Resources window if you no longer want
to retain them. And you can save your project either as proxied or not.

You can also nest clips while in a proxied state, but you can not drag the prox-
ied nested clips to the viewer or the timeline. If you create proxies for Nested
clips they will be saved in $HOME/Videos unless you modify that in Settings →
Preferences, Interface tab, Nested Proxy Path.

There are two ways that the proxy files can be used, with or without input scal-
ing. When the proxy is done without rescaling, the Mask, Camera and Projector
automations are re-scaled accordingly. In this situation, the entire project will be
re-sized so that the session is in the resized geometry. Not all plugins are useful
when the project is rescaled, because the keyframe data must be in the original
geometry. In this case, you can use the rescaler, by enabling Use scaler (FFMPEG
only). This has the added advantage that the project size does not change and the
proxy media is down-scaled as usual and up-scaled on read-in, which means the
project editing is done in full scale. Since decoding is done on smaller video, there
is a time savings, but all rendering is done full scale. The main reason for using
scaler is that it does not change the image coordinate data, so that automation and
plugin parameters will be in the original project geometry. This is not as fast as the
first option, but is a performance gain, and may be needed if you are using plugins
that need coordinate data such as the Title plugin. As noted, the scaler only works
on ffmpeg video formats.

In the upper right hand corner of the main window, there is a toggle button to
easily switch back and forth when you have a proxied file on the timeline. The
icon is to the left of the FF icon. It will have the letter “P” as the icon for Proxy

or if Using Scaler, the letter “S”. This quick switch is especially useful
when editing and you need to see a better image temporarily.

Screencast in figure 19.2 shows the Use scaler checked so you can still use plugins
and the original project size is kept. The Scale factor pull-down gives you available
size options. Note the new media dimensions shown (partially covered). If the size
is an odd number, 1 is added to make the dimensions both even numbers.

In the case of the scaler checkbox, it will retain that setting for ease of use.
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Figure 19.2: Proxy settings dialog

There is also a convenient Beep on done volume dial included so that you can work
on other tasks until there is an audible notify of completion. The default volume
is set to 0 for no audible notify.

A good choice for proxy settings with 1080p source video is:

Scale Factor: 1/4
Use Scaler: unchecked
File Format: FFMPEG -mpeg
Video Preset:
Compression: mpeg.mpeg
Bitrate: 1800000
Quality: -1
Pixels: yuv420p

If you get errors for some videos, such as those with strange variable bit rate
or some types of files made on a smartphone, a usually reliable alternative is to
change the following parameters:

File Format: FFMPEG -mov
Video Preset:
Compression: mov.mov
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Or if you want small files with high image quality, a File Format of m2ts is optimal.
For example a 1 GB file can be reduced to 50 MB with scale 1

2 .

Checking the Auto proxy/scale media loads results in any additional media loads to
be automatically proxy scaled. However, single frame media such as PNG or JPEG
stills, can not be scaled to stream media. If this type of media exists, you should
use scaler.

If you get error messages when creating proxies, check the Video wrench settings.
These usually default to values that are expected to work correctly for the File
Format and codec you selected but they can be changed and may result in errors.
If you get an error message of check_frame_rate failed followed by Error making
proxy in the popup Errors window, do just that and check the Frame rate value
by going to the Resources window, Media folder, and use the right mouse button
for the Info option for that specific media in question. You can change the frame
rate in this window to a more codec acceptable value. Different codecs may have
different legal values.

More specific information on which plugins need to use scaler is provided here
next. If the keyframe data uses coordinate data that is absolute, then the scaler
should be used. If the data is normalized (like always 0− 100%) then the proxy
can be done without the scaler. The session geometry format, shown in Settings
→ Format as wid th×height, is changed if the scaler is not used to cause all of the
data to be in the reduced format. If this affects the plugin operation, then scaler
should be used. Examples of plugins that need the scaler are: Title, AutoScale,
Scale, ScaleRatio, and Translate. Most others are safe to use without scaling.

This makes its so that you can save your project either as proxied or not.

Transcode, an option under the Settings pulldown right next to the Proxy settings
option, is a type of full resolution 1:1 Proxy. The process of transcoding works
directly from the resource; it is independent of the timeline. All of the loaded asset
media will be converted, that is, rendered in the selected format and loaded onto
the timeline. Menu choices besides the usual File Format and File Type include:
Tag suffix (to add to media filename), Remove originals from project, Into Nested
Proxy directory (an option to have the file saved here instead of the location of the
original media), and Beep on done volume.

The settings of the project have an effect, for example the dimensions are taken
into account. The resulting files are also larger than if they were created directly
with ffmpeg. Transcode works for videos with or without audio and even single
frame files, like png’s. If you have a video file that also contains audio, and you
convert only the video, the original audio will stay on the timeline if do not check
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Remove originals from project. Or vice versa if audio converted and not video.
Multiple stream media will only transcode the first stream (this would be like the
TV channel recordings in the United States). You will get an error message if you
already have a transcoded file in the selected format with the same suffix name
and try to transcode it again with a different selection made – you will have to
delete that file first. An example would be an already converted file that has both
video and audio and now you request video only.

The BIGGEST gain from using this is if you have media that is not seekable, that is,
you can play it from the beginning but can not move to another spot and have the
audio or video play correctly. A video file with no keyframes makes seeking next
to impossible, but then a Transcode generally adds these keyframes.

19.4 Some Settings Parameter Values

Cache in Settings → Preferences, Performance tab is used to store images
on the timeline. One 1080p frame uses about 10 MB. The default setting is 256 and
this is enough for testing and running. However, why not use more memory if it is
available. To experiment for testing a good number tuned to the way you use your
computer, set the cache to 0, start up CINELERRA-GG, load a typical media file, play
it and run top on the command line in another window to see how much memory
is being used. In the top display, look at free memory. Whatever your computer
is not using, is a good number to use for cache. If you start other programs, or
change the design of the session so that it uses a lot of frame storage, you may
need to experiment again later and resize accordingly.

For system swap, 1 GB seems to be more than sufficient. If the amount of memory
being used by the program is close, then swap might save you but often if swap-
ping becomes necessary, it presents more problems and you end up killing the
CINELERRA-GG process anyway.

19.5 Tips for Improving Smaller Computers Use

A list of items to check for smaller computers that will help to use less cpu/mem-
ory/resources follows:

• For large media files, use proxy to do your main editing.

• In Settings → Preferences, Appearance tab, uncheck Use thumbnails in
resource window.

• In Settings → Preferences, Appearance tab, uncheck Autocolor assets.
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• Speed-up certain time-consuming FFmpeg plugins through use of a carefully
selected .opts file.

• For large media files, in Settings → Preferences, Playback A, Video
Driver set use direct X11 render if possible.

• For the Video Driver in Settings → Preferences, Playback A, if using a
good graphics card, choose X11-OpenGL.

• Set CIN_HW_DEV=vdpau or vaapi to use the graphics GPU for certain ffmpeg
media decoding.

• If you have multiple cpus or multiple computers, even if slow, take advantage
of using Render Farm.

• When editing, background rendering causes temporary output to be rendered
constantly while the timeline is being modified. The temporary output is
displayed during playback whenever possible so it does not have to be recal-
culated – very useful for transitions and previewing effects that are slow.

• In Settings → Preferences, Playback A, uncheck Play every frame which
means frames will be skipped as playback of the video falls behind.

• Adjust Cache size in Settings → Preferences, Performance tab, to not
exhaust the memory and yet still provide decent playback.

19.6 General Crash Handling Tips

This section is a handy guide for describing various kinds of software computer
system failures. Only some of these various lockups or crashes can be dealt with.
Hopefully, it will help to have some hints to know what kind of failure it is, or to
save your work or to avoid future problems. For most of this, your user name must
be root, although you can certainly try to see if it works for you when not root.

System lockups: When the system locks up, it is usually a system problem. Nor-
mally an application program cannot lock up the system. It is a major goal of
system design to prevent an application (app) from failing a system interface.
This does not mean an app can not cause a system lockup, but it is unusual.

CINELERRA-GG crash: This is covered in Crash Dumps for Analysis. Just a re-
minder that for best results you should be root and by providing a crash dump
and as much other information as possible, you will be helping the developer
to analyze the problem and fix it so that it can be avoided in the future.

X Server crash: Keyboard does not respond, screen is frozen, caps lock may op-
erate LED light. Sometimes using Ctrl-Alt-F1 . . . Ctrl-Alt-F7 (etc.) will allow
you to regain control of a VT console. You can use this to login and check
logs: eg. /var/log/Xorg.0.log, dmesg, journalctl . . . etc. If you have an-
other computer, make sure a terminal server is configured (for example: rsh,
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ssh, or telnet), then remote login via this other computer and check the logs.
Most important is to immediately note the current software state, and the
very last thing that preceded the crash, i.e. last button click, last keystroke,
. . . or whatever.

Kernel crash: The machine goes completely dead. The keyboard caps lock LED
will probably be flashing. Most likely the only way to see anything after the
kernel crashes is to use a serial port console log and usually kdb, the kernel
debugger, and special cabling. This requires a lot of setup, and is normally
reserved for experts. Login from another computer will not work. Pinging
the ip address will not respond since the network stack is part of the kernel.
There are some virtual machine setups that will let you debug a guest kernel,
but this also requires a lot of setup, and affects which kernel is currently
under test. The kdb route is preferable.

Keyboard grabs, Server grabs, and Deadlocks: A grab is an X-server state where
all events are forced to just one window event stream. This forces the user
to respond to the dialog. Things seems to be working, but no keypresses
do anything useful. The system clock and other programs will still be work-
ing. The network will work for remote logins. Grabs can be canceled if the
/etc/X11/xorg.conf X config contains special setup as shown below:

Section "ServerFlags"
Option "HandleSpecialKeys" "Always"
Option "AllowDeactivateGrabs" "True"
Option "AllowClosedownGrabs" "True"

EndSection

Section "InputDevice"
Identifier "Keyboard"
Driver "evdev"
...
Option "XkbOptions" "terminate:ctrl_alt_bksp"
Option "XkbOptions" "grab:break_actions"

EndSection

or to $HOME/.xinitrc, add:

# xkb terminate/grab actions disabled in xorg.conf, use:
setxkbmap -option "grab:break_actions"
setxkbmap -option "terminate:ctrl_alt_bksp"
ctrl-alt-bksp = terminate the X-server, may restart automatically
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Modal forms (always on top, and usually ptr/kbd grab) dialog boxes can lock a
system by putting a form over another form holding a grab. This means the form
that needs input may never get any because you can not get to it, and the result is
a deadlock. Usually you will have to restart X (Ctrl-Alt-Bksp).

Window Manager issues: The desktop window manager can intercept and mod-
ify all kinds of user input. Mostly, this is a good thing, but can be a nuisance.
If user keypresses can be programmed to trigger actions, then they may be
useful to send KILL or INTR to an app that seems to be holding X’s attention.
For example:

killall -INTR cinelerra,
killall -9 cinelerra,
killall X,
# but you must run as root to be able do this

The ALT and META keys may be intercepted by the window manager, and
this can cause unexpected interface operations.

19.7 Tips for Specific Operations

19.7.1 Generating a 440 Hz tone

To create a specific 440 Hz tone, follow these steps. You can vary the length, use
more channels, or change the frequency to a different desired value (figure 19.3).

1. Make sure there is an armed audio track on the timeline, get into Cut and
Paste mode, and highlight a selection or define In/Out points where you want
to insert the audio tone.

2. Go to Audio → Render effect. Rendered effect usage is described in Ef-
fect Plugins. This brings up a menu where you will select the desired effect
which in this case is F_aeval. Also Select a file to render to, a File Format,
and Insertion strategy of Paste at insertion point.

3. Click on the green OK checkmark which will popup the F_aeval effect so that
you can set the parameters.

4. Highlight the exprs option and key in a specific audio filter expression which
for 440 Hz would be: sin(2πt × 440). Then hit the Apply button.

5. Next when you hit the green OK checkmark on the CINELERRA-GG: Effect
Prompt popup, you will have your 440 Hz tone on the timeline plus in the
select file that you chose to render it to.
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6. To use 2 channels instead of 1, in the F_aeval menu highlight the chan-
nel_layout option and change that to 1C|2C instead of the usual default of
1C.

Figure 19.3: Use Audio→Render effect to set render parameter values and then that effect
can be varied.

19.7.2 Camera supplied LUTs

A LUT, acronym for Look-Up Table, is a mathematically precise way of taking spe-
cific RGB image values from a source image and modifying them to new RGB val-
ues by changing the hue, saturation and brightness values of that source image.
In other words, LUTs are used to map one color space to another. Some high-end
cameras supply a .cube file to use as input. There are several different ffmpeg
plugins included with CinGG for using Lut’s. These are:

F_lut: Compute and apply a lookup table to the RGB/YUV input video.

F_lut1d: Adjust colors using a 1D LUT.

F_lut3d: Apply a 3D LUT to an input video.

F_lutrgb: Compute and apply a lookup table to the RGB input video.

F_lutyuv: Compute and apply a lookup table to the YUV input video.

For example, to use a 3dlut simply load your video, drop the F_lut3d plugin on
that track, and bring up the lut3d controls window, highlight the file option, key
in your file name (whit path), and hit apply to have the lut take effect. To easily
adjust, move the fader slider in the patchbay for that video track.
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19.7.3 Encoding into Dolby Pro Logic

Dolby pro logic is an easy way to output 6 channel audio from a 2-channel sound-
card with degraded but useful results. Rudimentary Dolby pro logic encoding can
be achieved with usage of some effects.

1. First, create the front left and right channels. Create 2 audio tracks, each
carrying either the left or right channel. Pan the left channel to the left and
the right channel to the right with the pan control.

2. Now create the rear left and right channels. Create another 2 audio tracks
as above – the left channel panned left and the right channel panned right.
Then apply invert audio to both new channels and the signals will come out
of the rear speakers.

3. Next, create the center channel by creating a single audio track with monaural
audio from a different source. Center it with the pan control and the signal
will come out of the center speaker.

• If a copy of the signal in the back speakers is desired in any single front
speaker, the signal in the back speakers must be delayed by at least 0.05
seconds and a single new track should be created. Pan the new track to
orient the signal in the front speakers.

• If the same signal is desired in all the speakers except the center speaker,
delay the back speakers by 0.5 seconds and delay either the front left or front
right by 0.2 seconds.

• If you want to hear something from the subwoofer, create a new track, select
a range, drop a synthesizer effect, and set the frequency below 60Hz. The
subwoofer merely plays anything below 60Hz or so.

Other tricks you can perform to separate the speakers are parametric equalization
to play only selected ranges of frequencies through different speakers and lowpass
filtering to play signals through the subwoofer.

19.7.4 Improving Analog TV Quality

The picture quality on analog TV is not always good but you can modify parameters
in CINELERRA-GG to make it look more like it did in the studio.

First, when capturing the video, capture it in the highest resolution possible. For
Europeans this would be 720× 576 and for North Americans, 720× 480. Do not
adjust the brightness or contrast in the recording monitor, but you might want to
max out the color. Capture the video using MJPEG or uncompressed Component
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Video if possible; if not possible, then capture it using JPEG preferably or RGB if
that is all that will work. Now on the timeline use Settings → Format to set a
YUV colorspace, drop a Downsample effect on the footage and set it as follows:

Horizontal: 2
Horizontal offset: 0
Vertical: 2
Vertical offset: 0

red
x green
x blue

alpha

Use the Camera in the compositor to shift the picture up or down a line to remove
the most color interference from the image. If you have vertical blanking infor-
mation or crawls which constantly change in each frame, block them out by using
a Mask. This improves compression ratios. More invasive quality improvement
techniques involve removing the interlace via deinterlacing.

19.7.5 Remove Interlacing

Interlacing often exists on older video sources, such as camcorders, and was pre-
viously used in broadcast television. Playing this video results in jagged images on
a computer monitor, but with CINELERRA-GG you can use deinterlacing effects to
solve this. After some experimentation, it has been determined that the FFmpeg
F_kerndeint plugin seems to produce the best results with the least amount of fid-
dling. But some of the parameters described next are pertinent to other potential
plugin usage.

Line Doubling: done by the Deinterlace effect when set to Odd lines or Even lines.
When applied to a track it reduces the vertical resolution by 1

2 and gives you
progressive frames with stairstepping. This is only useful when followed by
a scale effect which reduces the image to half its size.

Line averaging: the Deinterlace effect when set to Average even lines or Average
odd lines does exactly what line doubling does except instead of making
straight copies of the lines, it makes averages of the lines. This is actually
useful for all scaling.

Inverse Telecine: this is the most effective deinterlacing tool when the footage is
an NTSC TV broadcast of a film. It is described in Effect Plugins (9.9.42),
chapter 10.

Time base correction: the previously discussed three tools either destroy footage
irreversibly or do not work at times. Time base correction may be a better
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tool to use because it leaves the footage intact. It does not reduce resolution,
perceptually at least, and does not cause jittery timing.

Frames to Fields effect: converts each frame to two frames, so it must be used
on a timeline whose project frame rate is twice the footage’s frame rate. In
the first frame it puts a line-averaged copy of the even lines. In the second
frame it puts a line-averaged copy of the odd lines. When played back at
full framerate it gives the illusion of progressive video with no loss of detail.
This effect can be reversed with the Fields to Frames effect, which combines
two frames of footage back into the one original interlaced frame at half the
framerate. However, keep in mind that Frames to Fields inputs frames at half
the framerate as the project. Effects before Frames to Fields process at the
reduced framerate. The output of Frames to Fields can not be compressed
as efficiently as the original because it introduces vertical twitter and a super
high framerate. Interlaced 29.97 fps footage can be made to look like film
by applying Frames to Fields and then reducing the project frame rate of the
resulting 59.94 fps footage to 23.97 fps. This produces no timing jitter and
the occasional odd field gives the illusion of more detail than there would be
if you just line averaged the original. It is described in Effect Plugins (9.9.31),
chapter 10.

HDTV exceptions: 1920×1080 HDTV is encoded in a special way. If it is a broad-
cast of original HDTV film, an inverse telecine works. But if it is a rebroadcast
of a 720×480 source, you need to use a time base and line doubling algorithm
to deinterlace it.

19.7.6 Making video look like film

With an older camcorder video which has low quality video, you can improve the
results by turning it into progressive 24 fps output as close as possible. Only do
this for low quality video.

1. Set project framerate to twice the video framerate.

2. Apply a Sharpen effect. Set it to sharpness: 25, no interlacing, and horizontal
only.

3. Drop a Frame to Fields effect on the same track. Set Average Empty Rows to
on and play through the video a few times to figure out which field is first. If
the wrong field is first, the motion is shaky. Any editing in the doubled frame
rate may now damage the field order. It is not clear which is the easiest way
to support warnings for field glitches but you should go back to the normal
framerate to do editing or play test to make sure the fields are right.

4. Render just the video to the highest quality file possible.
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5. Import the video back to a new track. Set the project framerate to 24. The
new track should now look more like a file with sharper images than the
original footage.

This entire procedure could be implemented in one non-realtime effect, but the
problem with that is you will most often want to keep the field based output and
the 24 fps output for historical purposes. A non-realtime effect would require all
that processing just for the 24 fps copy.

19.7.7 Clearing out haze

If you photograph a lot of haze instead of blue sky, these horizon shots will usually
need more depth. You can use the gradient effect to improve your video. Drop
the gradient effect on hazy tracks and set the following parameters:

Angle: 0
Inner radius: 0
Outer radius: 40
Inner color: blue 100% alpha
Outer color: blue 0% alpha

It is important to set the 0% alpha color to blue even though it is 0% alpha. The
color of the outer alpha is still interpolated with the inner color. This is a gener-
ally applicable setting for gradient. Some scenes may work better with orange or
brown for an evening feel.

19.7.8 Making a ringtone for a cell phone

1. Go to File → Load files. . . and load a sound file with Insertion strategy:
Replace current project.

2. Go to Settings → Format change Channels to 1 and Samplerate to 16000
or 22050.

3. Highlight a region of the timeline to use for the ringtone. To improve sound
quality on the cell phone, you need the maximum amplitude in as many parts
of the sound as possible.

4. Right click on track Audio 1 and select Attach effect. Highlight the Compressor
effect and hit Attach in the attachment popup.

5. Make sure the insertion point or highlighted area is in the region with the
Compressor effect.

6. Right click on track Audio 2 and select Attach effect.
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7. Highlight Audio 1 Compressor and hit Attach.

8. Click the Audio 1 Compressor’s magnifying glass to bring up the compressor
GUI.

9. Set the following parameters:

Reaction secs: -0.1
Decay secs: 0.1
Trigger Type: Total
Trigger: 0
Smooth only: No

10. Click Clear to clear the graph. Click anywhere in the grid area and drag a
new point to 0 Output and -50 Input. The graph should look similar to the
figure 19.4.

11. Go to File → Render. Specify the name of an mp3 file to output to. Set
the file format to MPEG Audio. Click the wrench for Audio and set Layer to
III and Kbits per second to 24 or 32. Check Render audio tracks and uncheck
Render video tracks. Hit OK to render the file.

Figure 19.4: Using the Compressor plugin graph to create a ringtone

The resulting .mp3 file can be uploaded to a web server and then the phone’s web
browser can download the .mp3 file directly from the URL. There may be a size
limit on the file.
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19.7.9 Time stretching audio

It may appear that time stretching audio is a matter of selecting a region of the au-
dio tracks, enabling recording for the desired tracks, going to Audio → Render
Effect, and applying TimeStretch. In actuality there are 3 audio effects for time
stretching: Time Stretch, Resample, and Asset info dialog.

Time Stretch applies a fast Fourier transform to try to change the duration without
changing the pitch, but this introduces windowing artifacts to the audio. It is
only useful for large changes in time because obvious changes in duration make
windowing artifacts less obtrusive.

For smaller changes in duration, in the range of 5%, Resample should be used.
This changes the pitch of the audio but small enough changes are not noticeable.
Resample does not introduce any windowing artifacts, so this is most useful for
slight duration changes where the listener is not supposed to know what is going
on.

Another way to change duration slightly is to go to the Resources window, highlight
the media folder, right click on an audio file, click on Info. Adjust the sample rate
in the Info dialog to adjust the duration. This method also requires left clicking on
the right boundary of the audio tracks and dragging left or right to correspond to
the length changes.

19.7.10 Pan and zoom: still images

CINELERRA-GG’s powerful keyframe features allow you to use pan and zoom effects
on still pictures.

1. Load and create a clip from a still image. Make the clip 10 seconds long.

2. Activate the automatic generation of keyframes.

3. Using the transport controls, go to the beginning of the clip.

4. Using the compositing camera control set the clip’s initial position.

5. Using the transport controls, move forward a couple of seconds on the clip.

6. Dragging on the compositing camera, move the camera center to a new po-
sition further along.

7. Next go to the beginning of the clip and play it.

You can see that the camera smoothly flows from keyframe point to next keyframe
point, as CINELERRA-GG automatically adjusts the camera movement in straight
lines from point to point.
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CHAPTER 20

Translations

There are several po files for various languages to make CINELERRA-GG more usable
for non-English countries. These are listed below along with the po file name with
the translations, the frequency of updates, and date of last update as of this writing.

English cin.po Baseline (en_US)
French fr.po Updated often Last update 2019 May
German de.po Updated often Last update 2019 December
Russian ru.po Updated often Last update 2019 October
Spanish es.po Updated often Last update 2020 February

Basque eu.po From CV with Google Translate Last update 2016 October
Italian it.po From CV with Google Translate Last update 2016 October
Norwegian nb.po From CV with Google Translate Last update 2016 October
Portuguese pt.po From CV with Google Translate Last update 2016 October
Slovenian sl.po From CV with Google Translate Last update 2016 October

Chinese zh.po Only Google Translate 2016 October
Greek el.po Only Google Translate 2016 October
Hindi hi,po Only Google Translate 2016 October
Japanese ja.po Only Google Translate 2016 October
Korean ko.po Only Google Translate 2016 October
Ukrainian uk.po Only Google Translate 2016 October
Vietnamese vi.po Only Google Translate 2016 October

A program, xlat.C, assists in providing several variations of text files that can be
used in order to allow anyone to help make meaningful translations. All of the po
files are located in CINELERRA-GG’s /po subdirectory. There are 3 different ways
to proceed described below.

Because CINELERRA-GG frequently is changing, it is a good idea to start by build-
ing a new cin.po file which contains the latest messages/words in English to be
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translated, along with a comment line of the routine name and line number. To
create this, run the following lines from a window:

cd /{your top level cinelerra directory}
./po/xlat.sh > /tmp/cin.po

Method 1 use the freely-available poedit program to provide translations to the
current xx.po where xx is your language such as fr.po, de.po, ru.po, etc.
The drawback to this is that xx.po files are not recreated monthly so they do
not have all of the newest phrases included.

Method 2 using msgmerge is probably the simplest method for user translation.

To use the msgmerge command after creating a new cin.po as suggested previ-
ously:

cd /{your top level cinelerra directory}
./po/xlat.sh > /tmp/cin.po # use /tmp as a temporary place
cp /{your cinelerra directory}/po/xx.po /tmp/xx.po # substitute your language for x
msgmerge -U /tmp/xx.po /tmp/cin.po # xx.po will be overwritten to include updates

Then use any editor or poedit to provide messages/words translations in the new
xx.po file.

Method 3 using xlat.C program is the most versatile with a variety of features.
When a non-existent language translation is first set up, you would want to
use this methodology to get started.

To use the xlat.C program, first compile it with c++ xlat.C. You can see the usage
help here:

./a.out
list csv ./a.out csv < data.csv > data.po
list po ./a.out po < data.po > data.csv
list po ./a.out dups < data.po
list po ./a.out nodups < data.po
get strings ./a.out key < xgettext.po
gen xlation ./a.out xlat xgettext.po xlat.csv
gen xlation ./a.out xlat -text,xlat ... < xgettext.po
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This program has 6 commands where the desired command is the first parameter
to a.out.:

1. csv = comma separated value file; to recreate a po from a csv file.

2. po = convert po to csv data; for example, what you need to convert ru.po to
ru.csv. You can even open the resulting *.csv in LibrOffice and update the key
→ value replacements (fields separated by "," only and check quoted fields as
text during import). These results can be Saved As a csv file, and then used
by xlat.C to reformulate a po.

3. dups = list only key/value items where either the key=value or value=" ".

4. nodups = list only key/value items where key 6=value and value6=" ".

5. key = list cin.po key set.

6. xlat = overlay translation. This is the most important use and is described
next.

The xlat command line parameters specify a new cin.po template, usually created
with xlat.sh, and a list of key/value files which are used to build a mapping for
the desired translation. The mapping files are added to the mapping in the or-
der they appear on the command line, and any existing key is replaced with the
newest definition; so typically the newest key/value data is last in the command
parameters. Once the mapping is built, the first parameter which is the new po
template is scanned and the keys it contains are used to find the latest mapping
in the key/value files. The new value replaces the existing value in the template.
For example, to overlay a new map onto an existing po using the Spanish es.po
file and where cin.po represents the latest english words:

c++ xlat.C
./a.out po < es.po > /tmp/es.csv
./a.out po < cin.po > /tmp/cin.csv
./a.out xlat cin.po /tmp/es.csv > /tmp/new_es.po

The first run preserves the existing mapping of es.po, the second creates new
mappings from cin.po, and the third merges the original and new mappings to
create a po with new included/overriding es.po.

NOTE: some words and abbreviations can lead to ambiguous language trans-
lations. Therefore, the usage of C_ and D_ in the program code was added to
represent Contextual and Definitional exceptions to the usual _ and N_ . You will
see the following:
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C_(“msgstr”) is translated to D_(“qual#msgstr”) by xlat.sh, and invokes gettext
with msgid = “qual#msgstr”

When no po translation is supplied, the qual# is removed, and only the default
msgstr text is displayed. If a po translation is defined for the current locale, then
the translated msgid = “qual#msgstr” is used to access the translated msgstr.

The default MSGQUAL is the basename of the C source file. For the file src_file.C,
the default MSGQUAL is:

# define MSGQUAL “src_file”

It is used to define the qualifier needed to transform:

C_(“str”) to D_(“src_file#str”)

The resulting xlat.sh’d source is scanned by xgettext to create the initial cin.po. In
other words:

_(s) does normal international text translation as always -

The msgid line is: msgid “s”

C_(s) makes it appear as if you used D_(“src_file#” s) -

The msgid line is: msgid “src_file#s” If it does not translate, the default ms-
gtext is “s”, not “src_file#s”

D_(qual#s) tries to look up _(qual#s) -

This msgid line is: msgid “qual#s”, If it does not translate, the default msgtext
is “s”, not “qual#s”

531



CHAPTER 21

Licenses

CINELERRA-GG codebase is licensed GPLv2+

GREYcstoration plugin is licensed CeCILL v2.0

Google SHA1 implementation is licensed BSD 3-clause

Cinfinity icons are licensed Creative Commons CC-BY 4.0

Neophyte theme is licensed Creative Commons CC-BY 4.0

OpenCV is licensed 3-clause BSD License

freeverb components and the Tapeworm font are in the public Domain

License: GPLv2+ and CeCILL and BSD and CC-BY and Public Domain

GPLv2+ GNU General Public License version 2

CINELERRA-GG codebase is licensed GPLv2+

See: https://www.gnu.org/licenses/old-licenses/gpl-2.0-standalone.html

Creative Commons Attribution 4.0 International License

Cinfinity icons (c) by "Sam"; Neophyte and Cakewalk themes by "Olaf" are licensed
under a Creative Commons Attribution 4.0 International License.

see: http://creativecommons.org/licenses/by/4.0/

License Agreement for OpenCV
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For Open Source Computer Vision Library

(3-clause BSD License)

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

• Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

• Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

• Neither the names of the copyright holders nor the names of the contribu-
tors may be used to endorse or promote products derived from this software
without specific prior written permission.

This software is provided by the copyright holders and contributors as is and any
express or implied warranties, including, but not limited to, the implied warranties
of merchantability and fitness for a particular purpose are disclaimed. In no event
shall copyright holders or contributors be liable for any direct, indirect, incidental,
special, exemplary, or consequential damages (including, but not limited to, pro-
curement of substitute goods or services; loss of use, data, or profits; or business
interruption) however caused and on any theory of liability, whether in contract,
strict liability, or tort (including negligence or otherwise) arising in any way out
of the use of this software, even if advised of the possibility of such damage.
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APPENDIX A

QuickStart

A.1 CINELERRA-GG Quick Start Guide

CINELERRA-GG is a software program NLE, Non-Linear Editor, that provides a way
to edit, record, and play audio or video media on Linux. It can also be used to
color correction, retouch photos, motion tracking, watch TV, and create DVDs.

A.1.1 Install the Software

On the internet, click on the Download page at:

https://cinelerra-gg.org/downloads/

Here you will see several Operating System distro packages that are already built
for you to download. Click on your preference and read the specific instructions
for usage.

However, if you want to get going as quickly as possible, just do this so that every-
thing is in 1 place:

• Download your Operating System’s tar file from https://cinelerra-gg.org/
download/tars/ to /tmp.
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A.1. CINELERRA-GG Quick Start Guide

• Key in: cd /name-of-directory-where-you-want-the-software (for example,
cd /software)

• Key in: mkdir cin
• Key in: cd cin
• Key in: tar -xJf /tmp/cinelerra-5.1-*.txz (if you put the tar in /tmp

AND replace * with full name)

A.1.2 Start CINELERRA-GG

Depending on how you installed the software, you can log in as root or as a user
if you used a package.

• Key in: /your-software-directory-path/bin/cin
• Or if you installed using the pkg method, click on the Cin icon.

You will now see 4 separate windows appear. The top 2 windows from left to
right are the Viewer which is most useful for previewing clips and media and the
Compositor which displays the current working frame at the timeline position. The
bottom 2 windows are the CINELERRA-GG Program, also called the timeline, which
is where the real work gets done and the Resources window showing a selection
of media or effects.

Figure A.1: Clockwise: Viewer; Compositor; Resources and Main/Program/Timeline

Any of these windows can be resized to better suit your needs. Note that if your
system’s native language is not English, some of the words you see on the screen
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A.1. CINELERRA-GG Quick Start Guide

will be correctly translated for you, others will be in english, and some will have
not very good translations.

It is important to know that CINELERRA-GG does not directly change your media.
It writes all changes to what is called the EDL, Edit Decision List. This way you
original media remains completely intact.

A.1.3 Load Media

On the main timeline program window are many pulldowns, the first of which is
File.

Figure A.2: Load media window – note the icons top right for more options

1. Click on File for a list of available options and note that in the right hand
column are shortcuts for many of the options that will come in handy if you
use CINELERRA-GG often.

2. Next click on the second one down – Load files. . . – which brings up the Load
menu.

3. Below Select files to load on the top left side is a textbox and if you look all
the way to the right side of the textbox, there is a down arrow which you use
to navigate your file system. Highlight the desired file system and you will
see that directory name appear in the textbox and the files below.
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4. Scroll to the media file you would like to work on and highlight that file.
When you do, you will see that filename also appear in the textbox below
the listing of files. You could have directly keyed in that file in that textbox
instead.

5. On the bottom of the Load menu, is a box called Insertion strategy. For getting
started the default of Replace current project is sufficient. But you can click
on the down arrow to see what is available for future use.

6. Now click on the green colored checkmark on the bottom left hand side to
actually load the file and see it appear on the timeline in CINELERRA-GG’s
main window and a single frame in the Compositor. The first track will most
likely be video thumbnails and the next tracks may be audio waveforms.

7. Press the space bar in the main Program window and your video will start
playing and press the space bar again to stop the play. While playing, you
should see the video in the Compositor window in the upper right hand side
of your screen and if you have your audio hooked up, you will hear the sound.
To get back to the beginning of the video, hit the home key on your keyboard.

A.1.4 Choose Output Format

You can skip this step if you want the format of your output to be the same as your
input. However, to create output media that is widely viewable on many platforms,
to include phones and television, you should set your format accordingly.

1. On the main timeline, use the Settings pulldown (about the 7th pulldown
from the left side top) and click on Format which is the first option in that
list.

2. A Set Format menu will appear that shows what the current format is for your
loaded media in an Audio and a Video tab. In the United States, the Video
Frame rate is usually expected to be 29.970 and usually the Color model is
only changed if you have a personal preference.

3. The Canvas size is probably the only thing you will want to change here in
order to get to the most commonly viewable settings. On the right hand side
of the Width parameter is a down arrow. Left click the down arrow to see
your options.

4. Highlight 1280× 720 HD for a good common option.

5. Click OK to have this option take effect. When you do, the Compositor win-
dow may change to fit this option and may look wrong sized.

6. If the video now looks too small or too large in the Compositor, you will
want to autoscale it to look correct when the new media is created. To do
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Figure A.3: Format menu to change settings

this, mouse over to the Resources window in the lower right hand corner and
under the word Visibility, highlight Video Effects to see some plugins.

7. Mouse over the Auto Scale icon, left click to highlight the words underneath
the icon, and mouse drag the icon to the timeline video track. When you see
a white colored outline show on that track, drop the Auto Scale icon there
and you will see that the video may now automatically scale to a new value.
Click on the magnifying glass icon on the brown colored line beneath the
main timeline video which opens a new window. In that window, again use
the down arrow to choose 1280× 720 HD, then dismiss this window.

8. If not needed, to remove the Auto Scale plugin, right mouse on the brown
line and choose Detach.

A.1.5 View and Listen

1. On the second line, below the pulldowns, are transport buttons to move back
and forth on the timeline and play forward or reverse, fast or slow, or a single
frame. When you mouse over one of these buttons, a yellow colored tooltip
appears to tell you its function along with a key shortcut inside of parenthesis.
When you left click the mouse on the transport button it starts the play and
click again to stop it. As you use these buttons, watch the Compositor to
watch your video.
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Figure A.4: Effect brown bar with magnifier

Figure A.5: Menu pulldowns at the top with Transport buttons below. Note the yellow tooltips
too.

2. On the timeline, you only see thumbnails and not every single picture. You
may want to use your keyboard’s down arrow to expand the thumbnails and
the up arrow to unexpand them – on United States keyboard, the arrow keys
are generally together on the lower right hand side of the keyboard, a little
to the right of the space bar. This is a more cpu intensive operation and for
very large video can be time-consuming.

A.1.6 Edit/Compose

There may be sections of your media that you want to delete, or audio that is hard
to hear and needs to be enhanced, or there is a need for a descriptive title that you
want to add. Here are a few basics. But first be sure that you are in cut and paste
mode (this is the default) by checking to verify that you see a gold color around
the “I” i-beam mode icon as in the figure above. If the arrow to the left is gold, you
are in drag and drop mode so switch to cut and paste by clicking on the “I” instead.

1. You should look at the Edit pulldown - 2nd from the upper left on the main
timeline to see the most common options to use. The first option in the list is
Undo followed by a terse comment of the last operation that you performed
that can be undone.

2. To delete a section of video/audio is described next. Various ways to do
that are available but the easiest is to move your mouse and left click at the
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Figure A.6: From left to right: Audio 1 is disarmed – BandSlide transition in Video 1 – A
highlighted section.

beginning of the section you want to delete on the timeline and while holding
down the left mouse button, drag to the end of the section to be deleted.
When you do this, a white colored highlighted section becomes visible. Use
the edit pulldown and choose the split/cut option to cut out the highlighted
area (note the shortcut of "x"). Remember if you cut the wrong thing out you
can always use the Edit pulldown to Undo that.

3. To add a transition where there is deleted section which may make your video
look disjointed, do the following. Go back to the Resources window in the
bottom right hand corner. Change to Video Transitions by highlighting that
underneath the word Visibility. Highlight a transition like BandSlide with the
left button mouse click, hold down and drag to the video track and when you
see a white colored box around the area that you deleted above, drop the
icon. Right mouse click the icon on the track to vary some parameters like
length.

4. To insert another clip from a different video, first you have to load the other
video on another track. Go to File pulldown again and choose the Load files
option. Type in a directory at the top again and erase any specific file that you
may have chosen previously in the bottom 2 textboxes. It is very important to
now change the Insertion strategy to Append in new tracks or you will write
over your current work. But if you make this mistake, you can use the Edit
pulldown and Undo that!

a) Once the new video is on the track below your current work, you want
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to work with only this new track, so disarm your other tracks by looking
to the left of each track’s timeline and click the 2nd button beneath the
track name, for example Video 1 or Audio 1. The track name textbox
will turn red to remind you that the track has been disarmed. The boxed
area is called the patchbay.

b) Move to the area you want to make a clip of on your newly loaded track,
hold down the left mouse button and drag the area to be made into a
clip which will turn the color white. Remember, you disarmed the other
tracks so only this track is relevant at this time. On the second line of
the main window to the right of the transport buttons, are action buttons
and as you mouse over them a yellow colored tooltip explains its purpose.
Find the one that says To clip which is on the right hand side of the right
bracket symbol.

c) Click on To clip and a small window comes up which you can comment
in, but you do not have to, so just click on the green checkmark and now
you will have a clip.

d) Disarm that new track and re-arm your original tracks so you can go back
to working on them

e) Move your cursor to the spot in your original video where you want to
insert the clip. Make a Split with the Split | Cut option.

f) Go to the Resources window and under the word Visibility, highlight Clips
so you can see your recently created clip in the box to the right. Highlight
that clip and drag it to where you did the blade cut and drop it in.

5. To add a Title or any wording you will use the Title plugin. In the Resources
window, under the word Visibility, highlight Video Effects. In the box to the
right, many plugin icons appear. Scroll to the right using the scroll bar at the
bottom of the Resources window to locate Title. Highlight the Title icon and
drag/drop to your video track. By now your video track may be in sections as
you deleted, added blade cuts, and inserts so where you drop the Title icon
will be surrounded with a white colored box. It will take effect in that entire
area so you may want to highlight a section as usual with left mouse click on
the timeline and drag to the end of the desired area.

a) Right click on the brown colored bar that appeared below your video
track to get to options and then left click on Show to get the Title window
to appear.

b) Now for the fun part. First type in some words in the bottom large text
box just to see what it does. There are so many variable parameters here
and they are a lot of fun to play around with.

c) You can dismiss the Title window when finished BUT be sure to leave
the brown colored Title bar on the track. And if you enabled the drag
feature, you should disable it so you do not forget.
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Figure A.7: Compositor + Title menu for setting parameters + the Color Picker.

d) Right mouse click on the bottom Text box to see many more interesting
parameters.

A.1.7 Back up your work

At this time, or even earlier if you think you might make a mistake or if you are
concerned about computer crashes, you should save your work. Use the File pull-
down, and you can use Save as to designate a directory and filename. Then click
the green checkmark. You are saving the EDL which is the set of changes that you
have made – this file is separate from your original media.

A.1.8 Create your new media

1. Once again in the main Program window, click on the File pulldown and
highlight/click the Render option which is about the 9th option down from
the top of the list. A CINELERRA-GG Render menu will appear.

2. First key in the first textbox the file to render to under Select a file to render
to.

3. For the File Format, click on the down arrow and select FFMPEG (because
this is the most commonly used format; later you may want to experiment
with others). To the right of that box, click on the down arrow and highlight
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mp4 – again because this is common. When you click on mp4, notice that if
there is an extension to your filename in the file to render to above, it may
change it to mp4 and if there is none, it will add .mp4 because that is what
is expected.

4. Make sure there is a red colored checkmark next to the words Audio and
Video right below if you have/want both audio and video. To the left of that
checkmark box, is a symbol that looks like a wrench. Click on this for Audio
just to see the default Preset options which are just fine so dismiss the menu.
Then click on the wrench for Video and check Pixels by using the down arrow
to the right to be yuv420p – this is most commonly usable option. And click
on the green checkmark.

5. Check the Insertion Strategy in the Render Menu window. You might want to
change that to a different strategy than the default of Append in new tracks.
If not, then when the Render is done, your new video will automatically be
loaded in another set of tracks below your work tracks. Click on the green
checkmark in the lower left corner to start the render.

6. As the render is running, you will see the video play by in the Compositor.
Rendering is usually slow, especially with plugins added.

A.1.9 Play your new media

The file you created in the Render step should now be playable. You can test this
in CINELERRA-GG most easily by going to the Resource window in the lower right
corner, clicking on the Media folder, and dragging and dropping the last video to
the Viewer window. There is a separate set of transport buttons on the bottom on
that screen to use for playing.

A.2 YouTube with CINELERRA-GG

To create a youtube or dailymotion video, you can easily follow the steps below.
You will have to learn a lot more about CINELERRA-GG to take full advantage of its
capabilities and make some really special videos, but this is just to get a start and
to see the possibilities.

1. Start CINELERRA-GG; usually you can do this by clicking on CINELERRA-GG
icon or key in cin_path/bin/cin.

2. In the Program window on the lower left side of your screen, left mouse click
the File pulldown.

3. You will see Load files as the second choice so left mouse click this and find
your video file to load, highlight it, and check the green checkmark in the
lower left hand corner to get it loaded.
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4. Edit your video in the Program window using the basic commands of:

• play and then stop using the space bar
• move the mouse and then left click to move the insertion (location)

pointer
• cut a section out by holding down the left mouse and drag, then key in

“x” to cut or “c” to copy
• paste a copy or cut section by moving the insertion pointer, then key in

“v”

5. Add a title by highlighting the Video Effects in the right hand side Resources
window; then highlighting the Title icon and dragging it to the Program win-
dow video track and dropping.

6. Click on the middle icon button (looks like a magnifying glass) on the brown
colored Title bar to bring up the Title window bottom text box and key in a
title.

7. Use the File pulldown to select Render to create the desired video. In the Ren-
der window just next to the empty box to the right of the ffmpeg file format,
click on the down arrow shown there to see the choices and pick youtube.
Then move back up to key in the path and filename to render to. It will
pick all of the defaults automatically for you so then just click on the green
checkmark to have it start. There is a progress bar in the main window, very
bottom of the right hand side.

8. Key in “q” in the main window to get out of CINELERRA-GG and yes or no to
save your edit session.

Youtube will allow the upload of the resulting rendered file as named. However,
Dailymotion requires that the file be named with an acceptable extension so you
must rename the output file to have the extension of .webm instead of .youtube

There are currently 6 specific variations within the ffmpeg (file format) / youtube
(file type) for different video options. You see these when you click on the wrench
to the right of the word Video and then the Compression down arrow in the Video
Preset window. The first 3 are based on Webm/Vp91 and contain basic comments
of usage and where to find more information.

The first 3 below, plus any of the VP9 files under the file type of webm are the
recommended options to use because they are freely usable in any circumstance.

1credit by Frederic Roenitz
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sd.youtube Standard Definition use with default au-
dio/Opus stereo.youtube

hd.youtube High Definition “ “
uhd.youtube Ultra High Definition “ “

Alternatives based on h264 and for non-commercial use are listed below. For Dai-
lymotion, these must be renamed to have a different extension of .mp4 instead of
.youtube before uploading.

sd_h264.youtube Standard Definition – must change to audio
stereo_with_h264.youtube

hd_h264.youtube High Definition - “ “
uhd_u264.youtube Ultra High Definition - “ “
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APPENDIX B

Developer’s Section

B.1 How Builds Really Work and Even More Options

This section describes how builds really work if you want to know more about
making changes or understanding the process; probably only for a developer or
system administrator.

Builds occur in 4 basic steps:

1. unpack/patch source code
2. configure build
3. make build targets
4. installation

So, an example of what happens in 4 steps for a single-user build would be as
follows:

1. unpack/patch source code:
git clone –depth 1 “git:/.../target” cinelerra5
./autogen.sh

2. configure build:
./configure –with-single-user

3. make build targets:
make 2 > &1 | tee log

4. installation:
make install

A lot of things can be tweaked to change the results. Mostly these changes are
parameters to the configure step, which can change important build related items,
like the application name, or where and what the target system directories should
be. This makes it possible to have several versions at the same time on the same
computer if needed. To see what it is that the makefiles use to build CINELERRA-GG,
look at the resulting top-level global_config file which is created by the ./configure
step.
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Building CINELERRA-GG requires many thirdparty libraries, and it is recommended
that you use the static build version included in the git repo. Some of them are
patched, and fix significant bugs. It is important to note that because system instal-
lation historically has been with as many shared objects as possible, the defaults
are that any system library detected during configuration setup will be used, when
the package is built --without-single-user, which is the default build. To build with
static thirdparty libraries for system install to the system /usr area, use:

.configure --enable-static-build –prefix=/usr

Sometimes, additional package parameters and variables are needed during third-
party builds. These optional values occur before and after the configure and make
commands during a build. A presentation of the format of the package qualified
variable names and how they appear in the build procedure are:

pkg.cfg_vars prepended to configure
pkg.cfg_params appended to configure
pkg.mak_vars prepended to make
pkg.mak_params appended to make
pkg.cflags added as CFLAGS+=$(cflags) to pkg.vars
pkg.cppflags added as CPPFLAGS+=$(cppflags) to pkg.vars

These steps are done for EACH of the packages in the thirdparty build:

<pkg.cfg_vars> ./configure <pkg.cfg_params>

<pkg.mak_vars> make <pkg.mak_params>

The thirdparty Makefile has a set of default vars and params used to build each of
the needed thirdparty packages, but you can specify new or overriding values for
these Makefile substitutions. These thirdparty build config changes are specified
in the top-level file: cin_config. By using this file, you can save the configuration
changes made for the current build to use the next time you do a new build. For
example, to add an include file path to the giflib build, add this line to cin_config:

giflib.cflags := -I/usr/local/include/giflib5

To have a param/var change apply to all thirdparty builds, use:

CFG_VARS, CFG_PARAMS, MAK_VARS, MAK_PARAMS

CFLAGS, CXXFLAGS and LDFLAGS are forwarded to the thirdparty build environ-
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ment via:

CFLAGS=-ggdb ./configure --with-single-user

However, there is no guarantee that the thirdparty build will honor the environ-
mental flags.

Finally, there are build controls, which enable/disable and set build features.

A few of the more useful ./configure --parameters are:

--with-jobs=n where n=number of build jobs; defaults to 1.5*cpus+2
--enable-static-build build all 3rd party libs; defaults to yes if single-user, else no
--with-single-user build installs to <build_path>/bin; no system installation

The ./configure command builds global_config. The global_config is read by the
thirdparty/Makefile to create the recipes and definitions used by the thirdparty
build.

There are a lot of different options. Thirdparty library build control is available in
the configure step of the build. Thirdparty libraries are built on a demand basis.
So if you use:

--enable-libname=auto the static-build enable, or the lack of a system library causes a
build

--enable-libname=yes this forces the thirdparty build
--enable-libname=no this forces no thirdparty build

FFmpeg is a strongly connected component in the build linkage and widely influ-
ences the CINELERRA-GG library demands. It is possible to make small additions to
the ffmpeg configuration step using the environment variable FFMPEG_EXTRA_CFG.
For example, to eliminate the use of libvdpau (an nvidia support library) in the
ffmpeg configuration step after you have determined that it is causing an error,
use:

make clean
autogen.sh
export FFMPEG_EXTRA_CFG=" --disable-vdpau"
./configure . . .

Specific information on using the current ffmpeg GIT repository follows. You have
to supply the actual URL location of the ffmpeg git as you can see in this example
?bld.sh? script:
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#!/bin/bash\newline
() ./autogen.sh\newline
./configure --with-single-user --with-booby --with-git-ffmpeg=https://git.ffmpeg.org/

,→ ffmpeg.git
make && make install ) 2>1 | tee log
mv Makefile Makefile.cfg
cp Makefile.devel Makefile

Since the procedure for obtaining the latest ffmpeg version is not always kept up-
to-date and the line numbers will always change, you may have to create that patch
first. Generally those line numbers are only updated by a developer when a new
stable version with worthwhile features is actually included in the CINELERRA-GG
build. FFmpeg is constantly changing and many times the git version is not as
stable as desired.

B.2 Configuration Features

A listing of the current configuration features as of January 11, 2020:

‘configure’ configures \CGG{} to adapt to many kinds of systems.

Usage: ./configure [OPTION]... [VAR=VALUE]...

To assign environment variables (e.g., CC, CFLAGS...), specify them as
VAR=VALUE. See below for descriptions of some of the useful variables.

Defaults for the options are specified in brackets.

Configuration:
-h, --help display this help and exit

--help=short display options specific to this package
--help=recursive display the short help of all the included packages

-V, --version display version information and exit
-q, --quiet, --silent do not print ‘checking ...’ messages

--cache-file=FILE cache test results in FILE [disabled]
-C, --config-cache alias for ‘--cache-file=config.cache’
-n, --no-create do not create output files

--srcdir=DIR find the sources in DIR [configure dir or ‘..’]

Installation directories:
--prefix=PREFIX install architecture-independent files in PREFIX

[/usr/local]
--exec-prefix=EPREFIX install architecture-dependent files in EPREFIX

[PREFIX]
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By default, ‘make install’ will install all the files in
‘/usr/local/bin’, ‘/usr/local/lib’ etc. You can specify
an installation prefix other than ‘/usr/local’ using ‘--prefix’,
for instance ‘--prefix=$HOME’.

For better control, use the options below.

Fine tuning of the installation directories:
--bindir=DIR user executables [EPREFIX/bin]
--sbindir=DIR system admin executables [EPREFIX/sbin]
--libexecdir=DIR program executables [EPREFIX/libexec]
--sysconfdir=DIR read-only single-machine data [PREFIX/etc]
--sharedstatedir=DIR modifiable architecture-independent data [PREFIX/com]
--localstatedir=DIR modifiable single-machine data [PREFIX/var]
--libdir=DIR object code libraries [EPREFIX/lib]
--includedir=DIR C header files [PREFIX/include]
--oldincludedir=DIR C header files for non-gcc [/usr/include]
--datarootdir=DIR read-only arch.-independent data root [PREFIX/share]
--datadir=DIR read-only architecture-independent data [DATAROOTDIR]
--infodir=DIR info documentation [DATAROOTDIR/info]
--localedir=DIR locale-dependent data [DATAROOTDIR/locale]
--mandir=DIR man documentation [DATAROOTDIR/man]
--docdir=DIR documentation root [DATAROOTDIR/doc/cinelerra]
--htmldir=DIR html documentation [DOCDIR]
--dvidir=DIR dvi documentation [DOCDIR]
--pdfdir=DIR pdf documentation [DOCDIR]
--psdir=DIR ps documentation [DOCDIR]

Program names:
--program-prefix=PREFIX prepend PREFIX to installed program names
--program-suffix=SUFFIX append SUFFIX to installed program names
--program-transform-name=PROGRAM run sed PROGRAM on installed program names

Optional Features:
--disable-option-checking ignore unrecognized --enable/--with options
--disable-FEATURE do not include FEATURE (same as --enable-FEATURE=no)
--enable-FEATURE[=ARG] include FEATURE [ARG=yes]
--enable-silent-rules less verbose build output (undo: "make V=1")
--disable-silent-rules verbose build output (undo: "make V=0")
--enable-dependency-tracking

do not reject slow dependency extractors
--disable-dependency-tracking

speeds up one-time build
--enable-a52dec build a52dec (yes)
--enable-djbfft build djbfft (yes)
--enable-audiofile build audiofile (no)
--enable-encore build encore (no)
--enable-esound build esound (no)
--enable-ffmpeg build ffmpeg (yes)
--enable-fftw build fftw (auto)
--enable-flac build flac (auto)
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--enable-giflib build giflib (yes)
--enable-ilmbase build ilmbase (auto)
--enable-lame build lame (auto)
--enable-libavc1394 build libavc1394 (auto)
--enable-libraw1394 build libraw1394 (auto)
--enable-libiec61883 build libiec61883 (auto)
--enable-libdv build libdv (auto)
--enable-libjpeg build libjpeg (auto)
--enable-opus build opus (auto)
--enable-openjpeg build openjpeg (auto)
--enable-libogg build libogg (auto)
--enable-libsndfile build libsndfile (auto)
--enable-libtheora build libtheora (auto)
--enable-libuuid build libuuid (yes)
--enable-libvorbis build libvorbis (auto)
--enable-mjpegtools build mjpegtools (yes)
--enable-openexr build openexr (auto)
--enable-tiff build tiff (auto)
--enable-twolame build twolame (auto)
--enable-x264 build x264 (auto)
--enable-x265 build x265 (auto)
--enable-libvpx build libvpx (auto)
--enable-lv2 build lv2 (auto)
--enable-sratom build sratom (auto)
--enable-serd build serd (auto)
--enable-sord build sord (auto)
--enable-lilv build lilv (auto)
--enable-suil build suil (auto)
--enable-libaom build libaom (auto)
--enable-dav1d build dav1d (auto)
--enable-libwebp build libwebp (auto)
--enable-ffnvcodec build ffnvcodec (auto)
--enable-static-build build static ([auto])
--enable-x264_hidepth build x264 10bit ([no])
--enable-x265_hidepth build x265 10bit ([no])

Optional Packages:
--with-PACKAGE[=ARG] use PACKAGE [ARG=yes]
--without-PACKAGE do not use PACKAGE (same as --with-PACKAGE=no)
--with-jobs parallel build jobs (auto)
--with-exec-name binary executable name (cin)
--with-single-user to install cin in bin (no)
--with-ladspa-build build ladspa library (yes)
--with-lv2 lv2 library support (yes)
--with-cinlib cinelerra library path (auto)
--with-cindat cinelerra share path (auto)
--with-plugin-dir plugin install dir (auto)
--with-ladspa-dir ladspa install dir (auto)
--with-config-dir .bcast config dir ($$HOME/.bcast5)
--with-nested-dir nested proxy dir ($$HOME/Videos)
--with-browser cin_browser path (firefox)
--with-git-ffmpeg git ffmpeg using url (no)
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--with-noelision use noelision/libpthread (auto)
--with-booby window lock trace booby trap (no)
--with-libzmpeg build libzmpeg (yes)
--with-commercial enable commercial capture (yes)
--with-thirdparty use thirdparty build (yes)
--with-shuttle shuttle device (yes)
--with-wintv usb 2040:826d wintv device (yes)
--with-x10tv usb 0bc7:0004 X10 remote device (yes)
--with-vaapi video acceleration api (yes)
--with-vdpau video decode+presentation api for unix (yes)
--with-nv nvenc/nvdec ffnvcodec api (yes)
--with-cuda nv cuda plugins (auto)
--with-clang use clang instead of gcc/g++ (no)
--with-gl use opengl (auto)
--with-oss use OSS audio (auto)
--with-xft use libXft (auto)
--with-alsa use libasound/alsa (auto)
--with-firewire use firewire (auto)
--with-dv use dv (auto)
--with-dvb use dvb (auto)
--with-video4linux2 use v4l2 (auto)
--with-xxf86vm use xf86vmode (auto)
--with-esound use esd (auto)
--with-shuttle shuttle dev support (auto)
--with-shuttle_usb use libusb-1.0 (auto)
--with-lv2 use lv2 (auto)
--with-cuda build cuda plugins (auto)
--with-dl system has libdl (auto)
--with-opencv opencv=sys/sta/dyn,git/tar=url (auto)
--with-numa system has libnuma (auto)
--with-openexr use openexr (auto)

Some influential environment variables:
CC C compiler command
CFLAGS C compiler flags
LDFLAGS linker flags, e.g. -L<lib dir> if you have libraries in a

nonstandard directory <lib dir>
LIBS libraries to pass to the linker, e.g. -l<library>
CPPFLAGS (Objective) C/C++ preprocessor flags, e.g. -I<include dir> if

you have headers in a nonstandard directory <include dir>
CCAS assembler compiler command (defaults to CC)
CCASFLAGS assembler compiler flags (defaults to CFLAGS)
CXX C++ compiler command
CXXFLAGS C++ compiler flags

Use these variables to override the choices made by ‘configure’ or to help
it to find libraries and programs with nonstandard names/locations.

Report bugs to <mail@lists.cinelerra-gg.org>.
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B.3 Thirdparty Parallel Build

The Makefile in the thirdparty build directory employs a set of macros used to
create a build rule set of thirdparty library build dependencies. The standard build
sequence of [source, config, build] is used to prepare thirdparty products as static
libraries. Build package dependency can be specified in the Makefile std-build
macro call. These Makefile macro calls define the rules used for each thirdparty
build. The expanded rule definitions may be viewed by using:

make -C thirdparty rules

Individual package libraries can be rebuilt, via:

make -C thirdparty <pkg>-clean; make -C thirdparty <pkg>

The rule targets create the set of thirdparty packages which are built from local
source archive copies of thirdparty source code and patches, if needed. The build
rule set of dependencies allows for compiling multiple thirdparty programs simul-
taneously using maximum computer resources. This parallel build speeds up the
process considerably. For example, these are full static build timings on the pro-
duction build machine (full build includes building all thirdparty programs as well
as all of CINELERRA-GG):

1 cpu = 61 mins
12 cpus = 7.5 mins
24 cpus = 2 mins

B.4 Find Lock Problems with Booby Trap

A Booby Trap is used in CinGG for setting a trap to catch lock problems that might
have been missed. It will trap boobies only if compile by adding --with-booby on
the configuration command line. This is the default if you compile using ./bld.sh
from the GIT repository. It should not interfere with normal execution.

If you have the time and inclination, enable --with-booby and send any trap output
that you find. Maybe you will catch some boobies and if you do, send a snapshot
of any boobies you find.

There are 2 potential traps:

• If you try to unlock a lock when it is not locked
• If you execute a drawing operation without holding the window lock
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The trap prints the following in the controlling terminal window:

BOOBY! <backtrace>

An example backtrace is below along with a hint below on how to analyze:

/home/cin5/bin/./cin(_Z5boobyv+0x3f) [0x557069fa9b2f] /home/cin5/bin/./cin(
,→ _ZN13BC_WindowBase9draw_lineEiiiiP9BC_Pixmap+0x3b)0x557069fb9a9b]

/home/cin5/bin/./cin(\_ZN10BC_ListBox11draw_borderEi+0x73)[0x557069f7dc73]
/home/cin5/bin/./cin(+0x9707fb) [0x557069f7e7fb]
/home/cin5/bin/./cin(\ZN10BC\ListBox16center\selectionEv+0x4e)[0x557069f7f2ae]
/home/cin5/bin/plugins/video/sketcher.plugin(_ZN17SketcherCurveList6updateEi+0

,→ x1a0)[0x7f1b8002a4c0]
/home/cin5/bin/plugins/video/sketcher.plugin(

,→ _ZN18SketcherCurveColor17handle_done_eventEi+0x76)[0x7f1b8002a5f6]
/home/cin5/bin/./cin(_ZN15BC_DialogThread3runEv+0xd8)[0x557069f6fb78]
/home/cin5/bin/./cin(_ZN6Thread10entrypointEPv+0x45)[0x557069fc5995]
/usr/lib/libpthread.so.0(+0x7a9d) [0x7f1b91b4ea9d]
/usr/lib/libc.so.6(clone+0x43) [0x7f1b90accb23]

To see which routine is reporting the booby key in:

c++filt

And then the 2nd line in the backtrace above:

_ZN13BC_WindowBase9draw_lineEiiiiP9BC_Pixmap

It comes back with the routine as:

BC_WindowBase::draw_line(int, int, int, int, BC_Pixmap*)

B.5 Valgrind Support Level

Valgrind is a memory mis-management detector. It shows you memory leaks,
deallocation errors, mismanaged threads, rogue reads/writes, etc. CINELERRA-GG
memory management is designed to work with Valgrind detection methods. This
assists in developing reliable code. Use of Valgrind points out problems so that
they can be fixed. For example, when this version of CINELERRA-GG shuts down, it
deallocates memory instead of just stopping, thus making memory leak detection
possible.
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The best way to compile and run valgrind is to run the developer static build. This
takes 2 steps and you must already have gdb and valgrind installed:

1. The standard static build:
cd /path/cinelerra-5.1
make clean
./bld.sh

2. run the incremental rebuild for debug objs:
CFLAGS=-ggdb make -j8 rebuild_all

Now your CINELERRA-GG obj has all of the debug stuff. Next run valgrind as root
for the most useful results:

cd /path/cinelerra-5.1/cinelerra

valgrind --log-file=/tmp/log --leak-check=full
--num-callers=32 ./ci

This runs CINELERRA-GG under the control of valgrind, and produces a log file in
/tmp which will list information about any leaks, usually clearly identifiable. Be
sure to Quit out of CINELERRA-GG normally instead of Ctrl-C or a SEGV otherwise
the program does not have a chance to cleanup and there will be some false alarms.
But it runs very slowly, and is basically single threaded, which means that race
conditions may be impossible to catch. . . like one thread deletes memory that
another thread is currently using. But overall it is a big help and if you test any
new features, please email the log output. A lot of effort when writing the code
was put into trying to be sure that all of the object constructors have matching
destructors so that the leaks can be identified. There are already several libraries
that create predictable memory leaks and valgrind does a good job for most of
these.

It is impossible to test everything with valgrind because some things are just too
big and slow for a practical test. Occasionally you can find a leak or an illegal
memory access. There are several false alarms that are difficult to avoid Condi-
tional jump messages, and unhandled DW_OP_, but anything with the word illegal
in the message is important. Memory leaks that originate in CINELERRA-GG are
good to find and fix, but are usually not deadly.

B.6 CFLAGS has -Wall

When compiling CINELERRA-GG Infinity a CFLAGS option used is Wall where the
"W" represents warnings and "all" means all. This causes the compile to check for
simple mistakes that can be detected automatically and issue warnings when the
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code is questionable. It can also detect situations where the compiler will gener-
ate incorrect code, like type-punned pointer. By turning on this flag, when new
code is vetted for predictable mistakes, the code can be corrected before becoming
manifested in the application.

B.7 Prof2 – A Profiler

Frequently there is a problem with a program running slow and you do not know
why. You need a thumbnail analysis of where the program is spending most of
its time without all of the overwhelming details. This is when a Profiler comes in
handy.

There are many different profilers available – this particular one does not do any-
thing special and is fairly ordinary in that it just characterizes frequency of execu-
tion of various regions in the program. However, it has some pretty good strengths
as listed next.

1. It takes very little or no preconditioning, i.e. setup
2. The effect it has on the running program is minimal
3. It runs almost at full speed, which is really nice
4. It is not particularly thread aware
5. Reports where it is executing at intervals of 100 times a second

B.7.1 Setup

This profiler works on x86_64 systems and you must be root to compile and run it.
Also, you must install your operating system’s iberty – for example, which would
be binutils-devel for Fedora or libiberty-dev for Ubuntu 18.

Go to the top level CINELERRA-GG directory.

Key in: prof2

Key in: make clean all install

Later, if you wanttitle to remove this from the system,

key in: make uninstall

B.7.2 How to use

The program you are profiling should be compiled debuggable with stack frame
and symbols enabled.
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To see help, key in: prof -h

usage: -h [-o path] [-d] [-e] [-p libpath] [-012] [-u #] cmd args...

-o profile output pathname, -=stdout, --=stderr
-d debug otitleutput enabled
-e child debug output enabled
-p specify path for libprofile.so
-0 usr+sys cpu timer intervals (sigprof)
-1 usr only cpu timer intervals (sigvtalrm)
-2 real time timer intervals (sigalrm)
-u profile timer interval in usecs

To execute the profiler, key in:

prof -o /tmp/prof_list.txt ./cin

where /tmp/prof_list.txt is the output file and in this case cin is the CINELERRA-
GG binary file. The pid of this command will be displayed on the startup window.
This comes in handy in the use case where there is a lot of initial load and possible
configuration setup inside of CINELERRA-GG and you want to profile plugins and
not necessarily all of the setup steps. Then you can use the following command in
another window to continue running CINELERRA-GG and obtain the more useful
information:

kill -USR1 pid

Running this command refreshes the memory maps used for profiling. When you
are profiling a plugin, you want to run this AFTER the plugin loads.

B.7.3 Results

There are 3 sections in the resulting output file of this stochastic quick analysis.

1. The first section is a histogram of the timer intervals of that sample set. Each
function occupies a region of addresses. One hundred times a second, the
profiler samples the program address in the region of execution.

2. In the second section, there is another histogram of the cumulative frequency
of all things in the call stack and this should point out who is the culprit. For
example, a codec calls a bunch of subroutines, the cost of the subroutines is
accumulated to the codec parent caller. This makes the actual cpu user much
more apparent.
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3. The last section is for the library spaces. Each library occupies a region and
the profiler adds up the time spent in each of the libraries by frequency.

On the very bottom is a 1 line summary which shows you if there is a bad guy and
who it is.

B.7.4 Sample output

— profile start —

1020 ticks 43 modules 81412 syms
0.010s 0.1% Autos::copy(long, long, FileXML*, int, int) /mnt0/build5/cinelerra-

5.1/bin/cin
0.010s 0.1% BinFolders::copy_from(BinFolders*) /mnt0/build5/cinelerra-

5.1/bin/cin
0.010s 0.1% cstrdup(char const*) /mnt0/build5/cinelerra-5.1/bin/cin
0.010s 0.1% XMLBuffer::encode_data(char*, char const*, int)

/mnt0/build5/cinelerra-5.1/bin/cin
0.010s 0.1% XMLBuffer::encoded_length(char const*, int)

/mnt0/build5/cinelerra-5.1/bin/cin
0.010s 0.1% PluginClient::send_configure_change() /mnt0/build5/cinelerra-

5.1/bin/cin
0.010s 0.1% UndoVersion::scan_lines(UndoHashTable*, char*, char*)

/mnt0/.../cin
0.010s 0.1% UndoStackItem::set_data(char*) /mnt0/build5/cinelerra-

5.1/bin/cin
0.010s 0.1% UndoStack::load(_IO_FILE*) /mnt0/build5/cinelerra-5.1/bin/cin
0.010s 0.1% BC_Bitmap::cur_bfr() /mnt0/build5/cinelerra-5.1/bin/cin
0.010s 0.1% YUV::init_tables(int, int*, int*, int*, int*, int*, int*, int*, int*, int*,

int*, int*, int*, int*, int*) /mnt0/build5/cinelerra-5.1/bin/cin
. . .
. . .
— profile calls —
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0.010s 0.1% AutoConf::save_xml(FileXML*) 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
0.010s 0.1% Automation::copy(long, long, FileXML*, int, int) 1.0 /mnt0/.../cin
0.010s 0.1% AWindow::run() 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
0.010s 0.1% Canvas::stop_single() 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
0.010s 0.1% ColorPicker::new_gui() 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
0.010s 0.1% ColorWindow::create_objects() 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
0.010s 0.1% PaletteWheel::draw(float, float) 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
0.010s 0.1% PaletteHex::update() 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
0.010s 0.1% CWindowGUI::draw_status(int) 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
0.010s 0.1% CWindowCanvas::status_event() 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
. . .
. . .
0.990s 9.7% BC_Xfer::xfer_slices(int) 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
1.880s 18.4% DirectUnit::process_package(LoadPackage*) 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
1.880s 18.4% DirectUnit::rgba8888() 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
3.910s 38.3% __init_array_end 1.1 /mnt0/build5/cinelerra-5.1/bin/cin
5.450s 53.4% LoadClient::run() 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
7.890s 77.4% Thread::entrypoint(void*) 1.0 /mnt0/build5/cinelerra-5.1/bin/cin
7.890s 77.4% start_thread 1.0 /lib64/libpthread-2.28.so
—
—
0.010s 0.1%/ 0.0% /lib64/libm-2.28.so
0.010s 0.1%/ 0.0% /lib64/libexpat.so.1.6.8
0.020s 0.2%/ 0.1% /lib64/libXext.so.6.4.0
0.020s 0.2%/ 0.1% /lib64/libXft.so.2.3.2
0.020s 0.2%/ 0.1% /lib64/libxcb.so.1.1.0
0.040s 0.4%/ 0.2% /lib64/ld-2.28.so
0.050s 0.5%/ 0.2% /lib64/libpng16.so.16.34.0
0.130s 1.3%/ 0.6% /lib64/libX11.so.6.3.0
0.180s 1.8%/ 0.8% /lib64/libz.so.1.2.11
0.200s 2.0%/ 0.9% /lib64/libfontconfig.so.1.12.0
0.380s 3.7%/ 1.8% /lib64/libpthread-2.28.so
1.660s 16.3%/ 7.7% /lib64/libc-2.28.so
7.480s 73.3%/34.7% /mnt0/build5/cinelerra-5.1/bin/cin

10.200t 0.001u+0.000s 21.566r 47.3%
— profile end —

The summary line above in Bold represents the User time, System time, Real time
and the percentage is how much Timer time elapsed over Real time so in this case
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the measurement covers 47.3% of time.
So why use a Profiler? Because it is the “ls” for executable functions!!
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APPENDIX C

Auxiliary Programs

C.1 Using Ydiff to check results

Delivered with Infinity CINELERRA-GG and in the CINELERRA-GG path, there is a
file ydiff.C This program compares the output from 2 files to see the differences
. Do: cd cin_path and key in make ydiff.

Figure C.1: Exact match

Figure C.2: "Giraffe" artifacts on 2 files
spaced differently

You can now use this to check the quality differences of various outputs. For ex-
ample, in this same directory key in:

./ydiff /tmp/yourfile.mp4 /tmp/yourfile.mp4

Since you are comparing a file to itself, you will see a clean looking white win-
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dow in the left-hand corner and columns 2,3,4 will be all zeros. Run this same
command with a 3rd spacing parameter of -1 as shown below, and you will see
artifacts of comparing 2 files starting in a different position.

./ydiff /tmp/yourfile.mp4 /tmp/yourfile.mp4 -1

Now render yourfile using different quality levels and run ydiff to compare the
2 results. You will see only noise difference which accounts for the quality level.
Columns 2,3,4 might no longer be exactly zero but will represent only noise dif-
ferences. The ydiff output is debug data with lines that show frame size in bytes,
sum of error, and sum of absolute value of error. The frames size is sort of useless,
the sum of error shows frame gray point drift and the abs error is the total linear
color error between the images. At the very end is the total gray point drift and
total absolute error on the last line.

C.2 Image Sequence Creation

Example script to create a jpeglist sequence file is next:

#!/bin/bash
out="$1"
dir=‘dirname "$out"‘
shift
geom=‘jpegtopnm "$1" | head -2 | tail -1‘
w=‘(set -$geom; echo $1)‘
h=‘(set -$geom; echo $2)‘
exec > $out
echo "JPEGLIST"
echo "# First line is always JPEGLIST"
echo "# Frame rate:"
echo "29.970030"
echo "# Width:"
echo "$w"
echo "# Height:"
echo "$h"
echo "# List of image files follows"
while [ $# -gt 0 ]; do

if [ x‘dirname "$1"‘ = x"$dir" ]; then
f=./‘basename "$1"‘;
else
f="$1";
fi
echo "$f"
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shift
done

Example usage of this script follows:

jpeglist.sh outfile infiles*.jpg

C.3 Webm /Vp9 Usage and Example File

VP9 is a video codec licensed under the BSD license and is considered open source,
the WEBM container is based on MATROSKA for video and OPUS for audio. There
are some common VP9 rendering options files that support creation of video for
YouTube, Dailymotion, and other online video services.

YouTube easy startup steps are documented in the Appendix (A.2). These same
steps have been verified to work for creating Dailymotion videos – however, the
created files must be renamed before uploading to change the youtube extension
to webm instead for Dailymotion.

Below is one of the VP9 rendering options file with documentation for specifics:

webm libvpx-vp9

(20171114-2203)

from https://developers.google.com/media/vp9/settings/vod/

1280x720 (24, 25 or 30 frames per second)

Bitrate (bit rate)

VP9 supports several different bitrate modes:

mode:
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Constant Quantizer (Q) Allows you to specify a fixed quantizer value; bitrate will
vary

Constrained Quality (CQ) Allows you to set a maximum quality level. Quality may
vary within bitrate parameters

Variable Bitrate (VBR) Balances quality and bitrate over time within constraints
on bitrate

Constant Bitrate (CBR) Attempts to keep the bitrate fairly constant while quality
varies

CQ mode is recommended for file-based video (as opposed to streaming). The
following FFMpeg command-line parameters are used for CQ mode:

FFMpeg:

-b:v <arg> Sets target bitrate (e.g. 500k)
-minrate <arg> Sets minimum bitrate.
-maxrate <arg> Sets maximum bitrate.
-crf <arg> sets maximum quality level. Valid values are 0-63, lower

numbers are higher quality.

Note 1: Bitrate is specified in kbps, or kilobits per second. In video compression a
kilobit is generally assumed to be 1000 bits (not 1024).

Note 2: Other codecs in FFMpeg accept the -crf parameter but may interpret the
value differently. If you are using -crf with other codecs you will likely use different
values for VP9.

bitrate=1024k
minrate=512k
maxrate=1485k
crf=32

Tiling splits the video into rectangular regions, which allows multi-threading for
encoding and decoding. The number of tiles is always a power of two. 0=1 tile;
1=2; 2=4; 3=8; 4=16; 5=32
tile-columns=2

(modified from https://trac.ffmpeg.org/wiki/EncodingForStreamingSites)

To use a 2 second GOP (Group of Pictures), simply multiply your output frame rate
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× 2. For example, if your input is -framerate 30, then use -g 60.
g=240

number of threads to use during encoding
threads=8

Quality may be set to good, best, or realtime
quality=good

Speed: this parameter has different meanings depending upon whether quality is
set to good or realtime. Speed settings 0-4 apply for VoD in good and best, with
0 being the highest quality and 4 being the lowest. Realtime valid values are 5-8;
lower numbers mean higher quality
speed=4

C.4 Details about .bcast5 Files

The following extensions of files in CINELERRA-GG’s .bcast5 directory are ex-
plained below.

.dat represent saved data for perpertual sessions and color palettes;
maybe others

.idx original index files that were created for loaded video to speed
up seeking

.mkr ffmpeg specific marker index file that is created for each video
to aid seeks

.rc rc stands for run commands so basically represents a script

.toc toc is table of contents file for MPEG video files (a type of index)

Cinelerra_plugins a list of the currently loaded plugins available in your CINELERRA-
GG session

Cinelerra_rc the user’s preferences and settings are saved in this file to be
used on startup

ladspa_plugins. . . list of currently loaded ladspa plugins for each version of CINELERRA-
GG being used

layout#..._rc user-defined window layout setup with the layout name as part
of the file name

.xml used for various backups or for the current settings of plugins
that you have used

.png thumbnails of files in Resources so they do not have to be cre-
ated over and over
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